Inhalt

Willkommen! 14

Technischer Support ................................................................. 15
Über dieses Handbuch .................................................................. 16
Systemvoraussetzungen .............................................................. 16

Installation und Programmstart 17

Installation unter Windows ................................................................ 17
Installation unter macOS ................................................................... 17
Installation unter Linux .................................................................. 18
Installation auf Android-Geräten ..................................................... 19

Der Arbeitsbildschirm 20

Titelleiste .................................................................................. 20
Menüleiste .................................................................................. 21
Funktionsleiste ........................................................................... 22
Formatleiste ............................................................................... 22
Ribbon (Menüband) ..................................................................... 22
Registerkarten für Dokumente ...................................................... 23
Linealleiste ............................................................................... 24
Dokument ................................................................................... 24
Seitenleiste ............................................................................... 24
Statuszeile .................................................................................. 25

Grundlagen 27

Text eingeben ............................................................................ 27
Schreibmarke bewegen ............................................................... 27
Text löschen ............................................................................... 28
Änderungen rückgängig machen ................................................... 29
Einfügen oder Überschreiben? ....................................................... 29
Neues Dokument beginnen .......................................................... 29
Dokument öffnen ....................................................................... 31
Dokument drucken ..................................................................... 32
Dokument speichern ................................................................... 33
Arbeit beenden ........................................................................... 33

Die TextMaker-Tour 34

Ein Übungsbrief ......................................................................... 34
Speichern des Übungsbriefs ......................................................... 36
Einfache Formatierungen ............................................................. 37
Wenn mal etwas schiefgeht ......................................................... 38
Datei öffnen ............................................................................... 39
Briefkopf erstellen ..................................................................... 39
Absatzausrichtung ..................................................................... 41
Tabulatoren ............................................................................... 42
Datum und andere Felder eingefügen .......................................... 44
<table>
<thead>
<tr>
<th>Thema</th>
<th>Seitenzahl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fußzeilen</td>
<td>46</td>
</tr>
<tr>
<td>Linien und Umrandungen</td>
<td>47</td>
</tr>
<tr>
<td>Drucken des Übungsbriefs</td>
<td>49</td>
</tr>
<tr>
<td>Fertig!</td>
<td>50</td>
</tr>
<tr>
<td><strong>Arbeiten mit Markierungen</strong></td>
<td>51</td>
</tr>
<tr>
<td>Markieren von Text und Objekten</td>
<td>51</td>
</tr>
<tr>
<td>Markieren in der Windows-, Mac- oder Linux-Version</td>
<td>51</td>
</tr>
<tr>
<td>Markieren in der Android-Version</td>
<td>52</td>
</tr>
<tr>
<td>Verschieben, Löschen und Kopieren</td>
<td>53</td>
</tr>
<tr>
<td>Inhalte einfügen</td>
<td>54</td>
</tr>
<tr>
<td>Dokument einfügen</td>
<td>54</td>
</tr>
<tr>
<td><strong>Zeichenformatierung</strong></td>
<td>56</td>
</tr>
<tr>
<td>Schriftart und Schriftgröße</td>
<td>57</td>
</tr>
<tr>
<td>Textauszeichnungen</td>
<td>57</td>
</tr>
<tr>
<td>Schriftfarbe</td>
<td>59</td>
</tr>
<tr>
<td>Hochstellen und Tiefstellen</td>
<td>60</td>
</tr>
<tr>
<td>Laufweite und Zeichenbreite</td>
<td>60</td>
</tr>
<tr>
<td>Kerning (Unterschneidung)</td>
<td>60</td>
</tr>
<tr>
<td>Format übertragen</td>
<td>61</td>
</tr>
<tr>
<td>Verbergen von Text</td>
<td>62</td>
</tr>
<tr>
<td>Schützen von Text</td>
<td>63</td>
</tr>
<tr>
<td>Zeichenformatierung zurücksetzen</td>
<td>63</td>
</tr>
<tr>
<td>Standard-Zeichenformatierung ändern</td>
<td>64</td>
</tr>
<tr>
<td><strong>Absatzformatierung</strong></td>
<td>65</td>
</tr>
<tr>
<td>Einzüge</td>
<td>66</td>
</tr>
<tr>
<td>Zeilenabstand</td>
<td>67</td>
</tr>
<tr>
<td>Abstände oberhalb/unterhalb eines Absatzes</td>
<td>69</td>
</tr>
<tr>
<td>Absatzausrichtung</td>
<td>70</td>
</tr>
<tr>
<td>Zeichenformat gesamter Absätze ändern</td>
<td>71</td>
</tr>
<tr>
<td>Tabulatoren</td>
<td>71</td>
</tr>
<tr>
<td>Tabulatoren verwenden</td>
<td>71</td>
</tr>
<tr>
<td>Tabstopps löschen und verschieben</td>
<td>73</td>
</tr>
<tr>
<td>Verwendung der Linealleiste</td>
<td>73</td>
</tr>
<tr>
<td>Aufzählungen mit Bullets</td>
<td>74</td>
</tr>
<tr>
<td>Initialen</td>
<td>78</td>
</tr>
<tr>
<td>Schattierung</td>
<td>79</td>
</tr>
<tr>
<td>Umrandung und Linien</td>
<td>80</td>
</tr>
<tr>
<td>Gliederungsebene</td>
<td>83</td>
</tr>
<tr>
<td>Umbruch vor dem Absatz erzwingen</td>
<td>84</td>
</tr>
<tr>
<td>Typografie</td>
<td>84</td>
</tr>
<tr>
<td>Zeilennummern unterdrücken</td>
<td>85</td>
</tr>
<tr>
<td>Zeilenumbruch - manuell einfügen</td>
<td>85</td>
</tr>
<tr>
<td><strong>Seitenformatierung</strong></td>
<td>87</td>
</tr>
</tbody>
</table>
Inhalt

Manuelle Seitenumbrüche einfügen ........................................................................................................ 87
Seite einrichten ...................................................................................................................................... 88
Kopfzeilen und Fußzeilen ...................................................................................................................... 90
  Kopf- und Fußzeilen erstellen und bearbeiten .................................................................................. 90
  Seitennummer, Datum etc. einfügen .................................................................................................... 91
Verwenden von Ausrichtungstabulatoren ............................................................................................. 92
Eigenschaften von Kopf- und Fußzeilen ändern .................................................................................... 93
Unterschiedliche Kopf- und Fußzeilen auf der ersten Seite ................................................................. 94
Unterschiedliche Kopf- und Fußzeilen links/rechts ............................................................................ 95
Kopf- und Fußzeilen entfernen ............................................................................................................. 95
Masterseiten .......................................................................................................................................... 95
  Masterseite bearbeiten ......................................................................................................................... 96
Aufteilen eines Dokuments in Kapitel .................................................................................................. 97
  Kapitel einfügen und entfernen ........................................................................................................... 98
  Kapitel auffinden ................................................................................................................................. 98
  Kapitel und die Seitenformatierung .................................................................................................... 98
  Kapitelformatierung ............................................................................................................................ 99
  Seitennummern formatieren ............................................................................................................... 101
Seitenhintergrund ändern ....................................................................................................................... 102

Formatvorlagen ...................................................................................................................................... 104
Zeichenvorlagen ................................................................................................................................... 105
  Zeichenvorlagen erstellen .................................................................................................................. 105
  Zeichenvorlagen anwenden ................................................................................................................ 107
  Zeichenvorlagen ändern ....................................................................................................................... 108
  Geltungsbereich von Zeichenvorlagen ............................................................................................. 109
  Zeichenvorlage Normal ....................................................................................................................... 109
  Verknüpfte Zeichenvorlagen erstellen ............................................................................................ 110
  Zeichenvorlagen und die Seitenleiste .................................................................................................. 111
Absatzvorlagen ...................................................................................................................................... 112
  Absatzvorlagen erstellen .................................................................................................................... 112
  Absatzvorlagen anwenden .................................................................................................................. 114
  Absatzvorlagen ändern ......................................................................................................................... 115
  Geltungsbereich von Absatzvorlagen ............................................................................................... 116
  Absatzvorlage Normal ........................................................................................................................ 117
  Verknüpfte Absatzvorlagen erstellen ............................................................................................... 117
  Absatzvorlagen und die Seitenleiste ................................................................................................... 118
Formatvorlagen verwalten ....................................................................................................................... 119
Dokumentvorlagen .................................................................................................................................. 120
  Dokumentvorlagen erstellen ................................................................................................................ 121
  Dokumentvorlagen anwenden ............................................................................................................. 122
  Dokumentvorlagen ändern .................................................................................................................. 122
  Dokumentvorlage Normal.tmvx .......................................................................................................... 123

Mehrspaltendruck ................................................................................................................................... 124
  Ändern der Spaltenzahl eines Textabschnitts .................................................................................... 124
  Was sind Bereiche? ............................................................................................................................. 127
Inhalt

Suchen und Ersetzen  128
Suchen .................................................................................................................... 128
Ersetzen ................................................................................................................ 129
Suchen/Ersetzen wiederholen .............................................................. 130
Erweiterte Suchfunktionen .............................................................. 130
Suchen/Ersetzen von Formatierungen .................................................... 132
Textmarken ........................................................................................................ 133
Gehe zu .............................................................................................................. 134
Navigieren mit der Seitenleiste .............................................................. 135

Felder  137
Feld einfügen ........................................................................................................ 137
Datum und Uhrzeit als Text einfügen ............................................................ 141

Sonderzeichen einfügen  143

Automatische Nummerierung  145
Einfache Nummerierungen .............................................................................. 145
Nummerierungslisten ...................................................................................... 149
  Nummerierungslisten erstellen .............................................................. 150
  Nummerierungslisten anwenden .......................................................... 154
  Nummerierungslisten ändern ................................................................. 155
Nummerierung von Überschriften ............................................................. 156
Nummerierung mit Auto-Nummern ............................................................. 156
Zeilenummern anbringen .............................................................................. 157

Tabellen  159
Tabellen einfügen .............................................................................................. 160
Tabellen ausfüllen ............................................................................................ 160
Tabellenzellen und -inhalte markieren ......................................................... 161
Tabelleninhalte löschen, kopieren, verschieben ........................................ 161
Tabellenzellen löschen und einfügen .......................................................... 161
  Tabellenzellen löschen ......................................................................... 162
  Tabellenzellen einfügen ....................................................................... 162
Tabellenzellen teilen oder verbinden .......................................................... 163
  Tabellenzellen teilen .......................................................................... 164
  Tabellenzellen verbinden ..................................................................... 164
Tabellen teilen ............................................................................................... 165
Tabellen verbinden ....................................................................................... 165
Tabellen formatieren ..................................................................................... 165
  Zeilen und Spalten gleichmäßig verteilen .......................................... 166
  Zeileneigenschaften ändern .................................................................. 166
  Zelleneigenschaften ändern .................................................................. 168
Allgemeine Eigenschaften von Tabellen ändern ...................................... 170
Tabellenvorlagen ......................................................................................... 172
Inhalt

Tabelle in Text umwandeln .......................................................................................................................... 173
Text in Tabelle umwandeln .......................................................................................................................... 174
Tabellen sortieren ........................................................................................................................................ 175
Text sortieren ................................................................................................................................................ 177
Tipp: Verwenden der Tabellenleiste ............................................................................................................. 178

Grafiken 180

Grafiken in den Text einfügen ......................................................................................................................... 180
Grafiken einscannen ......................................................................................................................................... 181
Grafiken aus der Galerie/Kamera einfügen (Android) .................................................................................. 182
Position und Größe von Grafiken ändern ..................................................................................................... 183
Eigenschaften von Grafiken ändern .............................................................................................................. 183
Verwenden der Grafikleiste .......................................................................................................................... 185

Diagramme 187

Diagramme einfügen ....................................................................................................................................... 187
Diagramme über PlanMaker einfügen ........................................................................................................... 188
Diagramme manuell einfügen ......................................................................................................................... 189
Diagramme bearbeiten .................................................................................................................................... 190
Daten eines Diagramms eingeben/bearbeiten ............................................................................................... 191
Diagrammelemente bearbeiten ..................................................................................................................... 193
Eigenschaften von Diagrammen ändern ....................................................................................................... 194
Diagramme als Grafik speichern ................................................................................................................... 198

OLE-Objekte 199

OLE-Objekte einfügen ..................................................................................................................................... 199
OLE-Objekte bearbeiten .................................................................................................................................. 201
Verknüpfungen von OLE-Objekten bearbeiten ........................................................................................... 201
Position und Größe von OLE-Objekten ändern .............................................................................................. 202
Eigenschaften von OLE-Objekten ändern ....................................................................................................... 202
Verwendung des SoftMaker Formeleditors .................................................................................................. 204

Rahmen und Zeichnungen 206

Rahmen – Allgemeines ..................................................................................................................................... 207
Rahmen einfügen ............................................................................................................................................... 207
Selektieren von Objekten ................................................................................................................................. 208
Der Objektmodus .............................................................................................................................................. 208
Position, Größe und Ränder von Objekten ändern ......................................................................................... 210
Position von Objekten ändern ........................................................................................................................ 210
Größe und Ränder von Objekten ändern ......................................................................................................... 211
Änderungen an Position und Größe verhindern ............................................................................................. 212
Rotieren und Kippen von Objekten ................................................................................................................. 212
Ausrichten und Verteilen von Rahmen ........................................................................................................... 213
Duplizieren von Objekten .................................................................................................................................. 213
Eigenschaften von Objekten ändern ................................................................................................................ 214
Objekt-Eigenschaften, Karteikarte Layout .................................................................................................... 214
Objekt-Eigenschaften, Karteikarte Format .................................................................................................... 218
<table>
<thead>
<tr>
<th>Inhalt</th>
<th>Seite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objekt-Eigenschaften, Karteikarte Füllung</td>
<td>219</td>
</tr>
<tr>
<td>Objekt-Eigenschaften, Karteikarte Linien</td>
<td>220</td>
</tr>
<tr>
<td>Objekt-Eigenschaften, Karteikarte Schatten</td>
<td>221</td>
</tr>
<tr>
<td>Objekt-Eigenschaften, Karteikarte 3D</td>
<td>222</td>
</tr>
<tr>
<td>Objekt-Eigenschaften, Karteikarte Effekte</td>
<td>222</td>
</tr>
<tr>
<td>Objekt-Eigenschaften, Karteikarte Eigenschaften</td>
<td>223</td>
</tr>
<tr>
<td>Zusätzliche Karteikarten</td>
<td>224</td>
</tr>
<tr>
<td>Standardeinstellungen für Objekte ändern</td>
<td>224</td>
</tr>
<tr>
<td>Rahmen – Fortgeschrittene Funktionen</td>
<td>225</td>
</tr>
<tr>
<td>Konvertieren zwischen Rahmen und eingebettetem Objekt</td>
<td>226</td>
</tr>
<tr>
<td>Verbergen von Objekten</td>
<td>226</td>
</tr>
<tr>
<td>Reihenfolge von Rahmen ändern</td>
<td>226</td>
</tr>
<tr>
<td>Gruppieren von Rahmen</td>
<td>227</td>
</tr>
<tr>
<td>Namen von Objekten ändern</td>
<td>227</td>
</tr>
<tr>
<td>Textrahmen</td>
<td>228</td>
</tr>
<tr>
<td>Textrahmen einfügen</td>
<td>229</td>
</tr>
<tr>
<td>Eigenschaften von Textrahmen ändern</td>
<td>230</td>
</tr>
<tr>
<td>Textrahmen verbinden</td>
<td>231</td>
</tr>
<tr>
<td>Grafikrahmen</td>
<td>232</td>
</tr>
<tr>
<td>Grafikrahmen einfügen</td>
<td>232</td>
</tr>
<tr>
<td>Eigenschaften von Grafikrahmen ändern</td>
<td>233</td>
</tr>
<tr>
<td>OLE-Objektrahmen</td>
<td>235</td>
</tr>
<tr>
<td>OLE-Objektrahmen einfügen</td>
<td>236</td>
</tr>
<tr>
<td>Eigenschaften von OLE-Objektrahmen ändern</td>
<td>236</td>
</tr>
<tr>
<td>Zeichnungen</td>
<td>238</td>
</tr>
<tr>
<td>Zeichnungen einfügen</td>
<td>238</td>
</tr>
<tr>
<td>Text zu AutoFormen hinzufügen</td>
<td>241</td>
</tr>
<tr>
<td>Eigenschaften von Zeichnungen ändern</td>
<td>241</td>
</tr>
<tr>
<td>Karteikarte AutoFormen (nur bei AutoFormen)</td>
<td>242</td>
</tr>
<tr>
<td>Karteikarte Innentext (bei AutoFormen, denen Text hinzugefügt wurde)</td>
<td>242</td>
</tr>
<tr>
<td>Karteikarte Text (nur bei TextArt-Objekten)</td>
<td>243</td>
</tr>
<tr>
<td>Karteikarte Deformation (nur bei TextArt-Objekten)</td>
<td>244</td>
</tr>
</tbody>
</table>

**Formulare** 245

| Formulare ausfüllen                                               | 246  |
| Formulare erstellen                                               | 248  |
| Arten von Formularobjekten                                        | 248  |
| Formularobjekte einfügen                                          | 249  |
| Formularobjekte bearbeiten                                        | 250  |
| Beispielformular anfertigen                                       | 250  |
| Formularobjekte im Detail                                         | 253  |
| Textfelder                                                        | 253  |
| Bedienung von Textfeldern                                         | 253  |
| Eigenschaften von Textfeldern ändern                              | 253  |
| Textrahmen                                                        | 255  |
| Kontrollkästchen                                                  | 255  |
| Bedienung von Kontrollkästchen                                   | 255  |
| Eigenschaften von Kontrollkästchen ändern                        | 255  |
Inhalt

Kontrollkästchenrahmen ................................................................. 256
Auswahllisten .................................................................................. 256
   Bedienung von Auswahllisten .................................................. 257
   Eigenschaften von Auswahllisten ändern ................................. 257
Ausذلكlisentreihmen ................................................................. 258
   Bedienung von Bezeichnungen und Gruppenfeldern .................. 259
   Eigenschaften von Bezeichnungen und Gruppenfeldern ändern 259
Formulare – fortgeschrittene Funktionen ................................... 260
   Tab-Reihenfolge ändern .......................................................... 260
   Inhalt von Formularobjekten schützen ................................. 260
   Formulare schützen ............................................................. 261
   Berechnungen mit Formularobjekten .................................... 262

Sprachwerkzeuge 263
Sprache einstellen .......................................................................... 264
   Einstellen der Standardsprache ............................................. 264
   Formatieren von Text in einer anderen Sprache ...................... 265
   Anwendungsbeispiele ............................................................ 265
Rechtschreibprüfung ...................................................................... 266
   Rechtschreibprüfung nachträglich ......................................... 266
   Rechtschreibprüfung im Hintergrund ...................................... 268
   Umsetzung auf die neue deutsche Rechtschreibung .................. 269
      Aktivieren der Umsetzung auf die neue Rechtschreibung .... 270
      Korrigieren von Wörtern in alter Rechtschreibung ............. 271
      Der Befehl Infos der Rechtschreibprüfung ......................... 271
   Benutzerwörterbücher bearbeiten ........................................... 272
Silbentrennung .............................................................................. 273
Thesaurus ..................................................................................... 276
Duden-Korrektor ........................................................................... 277
   Duden-Rechtschreibprüfung verwenden ............................... 278
   Duden-Silbentrennung verwenden ......................................... 278
   Duden-Grammatikprüfung verwenden .................................... 279
   Duden-Korrektor konfigurieren ............................................. 281
Duden-Wörterbücher zum Nachschlagen ...................................... 283
Langenscheidt-Übersetzungswörterbücher .................................... 285
Textbaustein ............................................................................... 285
   Textbaustein anlegen .......................................................... 286
   Textbaustein abrufen .......................................................... 287
   Textbaustein bearbeiten ....................................................... 288

Datenbank 289
Datenbank öffnen ........................................................................... 290
Datenbankmodul verwenden ......................................................... 290
   Das Arbeitsfenster des Datenbankmoduls ............................ 291
   Listen und Formularansicht ............................................... 293
   Blättern zwischen Datensätzen ............................................. 293
   Datensatz anhand seiner Satznummer aufrufen .................... 294
Datenbank durchsuchen ................................................................. 294
Datensätze bearbeiten und neue anlegen ......................................... 296
Datensätze löschen und wiederherstellen ........................................ 296
Datenbank sortieren ........................................................................ 297
Datenbank schließen ...................................................................... 298
Übernahme von Einzeladressen ....................................................... 298
Dokumentvorlage erstellen ............................................................. 299
Dokumentvorlage anwenden .......................................................... 299
Listen und Aufkleber herstellen ..................................................... 302
Briefumschläge bedrucken .............................................................. 306
Anlegen neuer Datenbanken .......................................................... 309
Ändern der Struktur von Datenbanken ............................................. 311
Thunderbird-Adressbuch importieren .............................................. 312

**Serienbriefe**

Dokumenten eine Datenbank zuordnen ........................................... 315
Datenbankfelder einfügen ............................................................. 316
Testdatensatz im Text anzeigen lassen .......................................... 316
Übungsbrief .................................................................................. 317
Datensätze für den Serienbriefdruck wählen ................................... 318
Manuelles Selektieren einzelner Datensätze .................................. 319
Selektion nach Satznummern ......................................................... 320
Selektion anhand einer Bedingung ............................................... 320
Serienbriefe ausgeben .................................................................. 322

**Berechnungen im Text**

Einfügen von Berechnungen .......................................................... 324
Variablen in Berechnungen ........................................................... 325
Tabellenzellen in Berechnungen .................................................... 328
Datenbankfelder in Berechnungen ................................................ 329
Objekte in Berechnungen ............................................................. 330
Berechnungen formatieren und runden ......................................... 331
Berechnungen aktualisieren ........................................................ 332
Bedingter Text ............................................................................. 332
Einfache Berechnungen auf Knopfdruck ........................................ 333
Rechenformeln und -funktionen ...................................................... 334
Der Aufbau einer Rechenformel .................................................... 334
Operatoren .................................................................................. 336
Übersicht Rechenfunktionen ......................................................... 337

**Arbeiten mit umfangreichen Dokumenten**

Gliederungen .............................................................................. 340
Gliederungsansicht verwenden ...................................................... 342
Gliedergungsebene von Absätzen ändern ..................................... 342
Anzuzeigende Gliederungsebenen auswählen ................................. 343
Anzeige einer Überschrift erweitern/reduzieren .............................. 343
Bearbeiten von Text in der Gliederungsansicht ............................... 344
| Überschriften formatieren .......................................................... | 345 |
| Profi-Tipp: Überschriften über Absatzvorlagen verwalten ............... | 346 |
| Gliederungen in der Praxis ......................................................... | 346 |
| Überschriften nummerieren ....................................................... | 347 |
| Gegliederte Dokumente und Kapitel ............................................. | 349 |
| Verzeichnisse (Inhalt, Stichwörter etc.) .................................... | 349 |
| Stichwortverzeichnisse ............................................................... | 350 |
| Stichwortverzeichnis vorbereiten ............................................... | 350 |
| Stichwortliste bearbeiten .......................................................... | 351 |
| Stichwortverzeichnis erstellen .................................................. | 352 |
| Inhaltsverzeichnisse ..................................................................... | 354 |
| Beschriftungen und Abbildungsverzeichnisse ................................ | 355 |
| Beschriftungen für Bilder und andere Objekte einfügen .................. | 356 |
| Abbildungsverzeichnis erstellen ................................................ | 358 |
| Bibliografien .............................................................................. | 360 |
| Schritt 1: Bibliografie-Datenbank erstellen und bearbeiten .......... | 360 |
| Schritt 2: Bibliografie-Datenbank zuweisen .................................. | 362 |
| Schritt 3: Verweise auf Quellen einfügen .................................... | 362 |
| Schritt 4: Literaturverzeichnis erzeugen ...................................... | 363 |
| Verzeichnisse aktualisieren ........................................................ | 364 |
| Verzeichnisse bearbeiten und formatieren .................................... | 365 |
| Querverweise ............................................................................... | 366 |
| Querverweise einfügen ............................................................... | 367 |
| Querverweise bearbeiten und aktualisieren .................................. | 368 |
| Vorlagenverweise ........................................................................... | 368 |
| Fußnoten ..................................................................................... | 370 |
| Fußnoten einfügen und bearbeiten .............................................. | 371 |
| Fußnotenformatierung ändern ...................................................... | 372 |
| Fußnotenoptionen ........................................................................ | 373 |

**Überarbeiten von Dokumenten**

| Kommentare verwenden .......................................................... | 376 |
| Kommentare einfügen ............................................................... | 377 |
| Kommentare bearbeiten .......................................................... | 377 |
| Kommentare löschen ............................................................... | 378 |
| Kommentare anzeigen und drucken .......................................... | 378 |
| Kommentare auffinden ............................................................. | 379 |
| Einstellungen zu Kommentaren ................................................. | 379 |
| Änderungen an einem Dokument verfolgen .................................. | 381 |
| Schritt 1: Aktivieren der Funktion Änderungen verfolgen ............ | 382 |
| Schritt 2: Durchführen der gewünschten Änderungen ................... | 382 |
| Schritt 3: Akzeptieren/Verwerfen von Änderungen ..................... | 382 |
| Einstellungen zur Funktion Änderungen verfolgen ..................... | 384 |

**Internet-Funktionen**

| HTML-Dokument öffnen ............................................................. | 386 |
| HTML-Dokument bearbeiten ...................................................... | 386 |
| Seitenformatierung .................................................................... | 387 |
Inhalt

Grafiken in HTML-Dokumenten ................................................................. 387
Tabellen in HTML-Dokumenten ............................................................... 388
Horizontale Linien .................................................................................. 388
Hyperlinks verwenden ............................................................................ 389
HTML-Dokument speichern ..................................................................... 390

Ausgeben von Dokumenten ................................................................... 392
Druckvorschau ......................................................................................... 392
Drucken eines Dokuments ....................................................................... 394
Drucken eines Serienbriefs ..................................................................... 396
Exportieren eines Dokuments als PDF-Datei .......................................... 397
Exportieren eines Dokuments als EPUB-Datei ......................................... 401
Versenden eines Dokuments per E-Mail .................................................. 404

Dokumentverwaltung ............................................................................. 405
Schnellwahlpfade .................................................................................... 405
Schnellwahlpfade anlegen ....................................................................... 406
Verwenden von Schnellwahlpfaden ......................................................... 406
Schnellwahlpfade bearbeiten und löschen .............................................. 407
Dokumentinfos ....................................................................................... 408
Dateimanager ......................................................................................... 409
Schaltflächen im Dateimanager .............................................................. 409
Suchen mit dem Dateimanager .............................................................. 410
Sicherungskopien .................................................................................. 412

Dokumentschutz .................................................................................... 415
Dokumentschutz aktivieren .................................................................... 415
Dokumentschutz deaktivieren .............................................................. 417

Fremdformate ......................................................................................... 418
Speichern und Öffnen von Fremdformaten .............................................. 418
Anmerkungen zum Textformat ............................................................... 420

Arbeiten mit arabischem Text ................................................................. 422
Aktivieren der Unterstützung für arabischen Text .................................. 422
Ändern der Schreibrichtung von Absätzen .............................................. 422
Ändern der Richtung von Tabellen ......................................................... 423
Ändern der Richtung von mehrspaltigen Bereichen ............................... 424
Ändern der Schriftart für arabischen Text .............................................. 424
Einfügen von arabischen Datumsangaben ............................................. 425

Scripts (BasicMaker) .............................................................................. 426

Mehrere Dokumente gleichzeitig bearbeiten ........................................ 427
Dokument neu anlegen oder öffnen ...................................................... 427
Inhalt

Wechseln zwischen geöffneten Dokumenten ................................................................. 428
Dokument schließen ........................................................................................................ 428
Dokumente auf dem Bildschirm anordnen ................................................................. 429

Anpassen von TextMaker 430

Einstellungen von TextMaker ändern ........................................................................... 431
Einstellungen, Karteikarte Ansicht ............................................................................. 431
Einstellungen, Karteikarte Allgemein ........................................................................ 433
Einstellungen, Karteikarte Bearbeiten ..................................................................... 435
Einstellungen, Karteikarte Aussehen ........................................................................ 438
Einstellungen, Karteikarte Sprache .......................................................................... 442
Einstellungen, Karteikarte Dateien .......................................................................... 445
Einstellungen, Karteikarte System ............................................................................ 447
Einstellungen, Karteikarte Schriften ........................................................................ 450
Dokumenteigenschaften ändern .................................................................................. 450
Dokumenteigenschaften, Karteikarte Infos ............................................................... 451
Dokumenteigenschaften, Karteikarte Ansicht ............................................................ 451
Dokumenteigenschaften, Karteikarte Farben ............................................................ 454
Dokumenteigenschaften, Karteikarte Statistik ............................................................ 455
Dokumenteigenschaften, Karteikarte Schutz .............................................................. 456
Dokumenteigenschaften, Karteikarte Formular ........................................................ 456
Dokumenteigenschaften, Karteikarte Überarbeiten .................................................. 457
Dokumenteigenschaften, Karteikarte Schriften ........................................................ 457
Bildschirmdarstellung ändern ...................................................................................... 458
Vergrößerungsstufe ändern ........................................................................................ 459
Vollbildansicht .............................................................................................................. 460
Symbolleisten anpassen .............................................................................................. 460
Symbolleisten anzeigen/verbergen .............................................................................. 461
Symbolleisten auf dem Bildschirm positionieren ....................................................... 462
Symbolleisten verwalten ............................................................................................. 463
Symbole einer Symbolleiste anpassen ...................................................................... 465
Verwenden des Symbolleisten-Menüs ...................................................................... 468
Ribbon (Menüband) anpassen ..................................................................................... 469
Ribbon anzeigen/verbergen ....................................................................................... 470
Position der Schnellzugriffsleiste ändern ................................................................. 471
Symbole im Ribbon anpassen .................................................................................... 472
Symbole der Schnellzugriffsleiste anpassen .............................................................. 475
Benutzerdefinierte Symbole erstellen ....................................................................... 476
Tastenkürzel anpassen ............................................................................................... 477
Gitter verwenden ....................................................................................................... 479
Hilfslinien verwenden ............................................................................................... 480
Installieren zusätzlicher Wörterbücher .................................................................... 483
Installieren zusätzlicher SoftMaker-Wörterbücher .................................................. 483
Installieren von Hunspell-Wörterbüchern ................................................................. 484
Wählen eines anderen Wörterbuchs für eine Sprache ............................................... 484

Anhang 486

Menübefehle und entsprechende Ribbonbefehle ...................................................... 486
Inhalt

Tastenbelegung .......................................................................................................................... 498
Tastenkürzel in der Windows-Version und der Linux-Version ........................................ 498
Tastenkürzel in der Mac-Version ....................................................................................... 501

Index ........................................................................................................................................... 506
Willkommen!

**Hinweis:** Das Handbuch enthält bislang nur grundlegende Informationen zur Bedienung des Programms über die neue Menüband-Benutzeroberfläche ("Ribbons"). Ausführlichere Informationen dazu werden in einer späteren Auflage nachgereicht.

Tipp: Eine Tabelle, die zeigt, welcher Menübefehl welchem Ribbonbefehl entspricht, finden Sie hier: Menübefehle und entsprechende Ribbonbefehle.

Willkommen bei TextMaker! Mit TextMaker haben Sie eine Textverarbeitung erworben, die Benutzerfreundlichkeit mit einem praxisorientierten Leistungsumfang verbunden – und dies zu einem unverschämten niedrigen Preis! Mit TextMaker werden Sie Ihre Schreibarbeiten künftig schnell und komfortabel erledigen.

**Einige Features von TextMaker**

- Erhältlich für **Windows, Mac, Linux** und **Android**.
- Durchdachte und ergonomische **Benutzeroberfläche** – wahlweise mit modernen "Ribbons" oder klassischen Menüs und Symbolleisten
- **Praktische Dokumentvorlagen** zum Erstellen neuer Dokumente: fertig ausgefüllte Briefköpfe, Faxformulare etc. im Handumdrehen.
- **Erweiterte Absatzformatierungen** wie automatische Nummerierung, Bullets, Umrandungen, Schattierungen, Muster
- **Absatz- und Zeichenvorlagen**, mit denen Sie Text auf Knopfdruck mit Ihren Lieblingsformatierungen versehen können
- **DTP-Features** wie "Masterseiten", Initialen, Kapitälchen, Kerning, regelbare Zeichenabstände und -breiten
- **Einbinden von Grafiken** in zahlreichen Formaten, umfangreiche Zeichenfunktionen, **Textart-Modul** für Schrifteffekte
- **Leistungsfähige Tabellenfunktionen**, sogar mit Rechenfunktionen
- **Dateimanager** mit Suchfunktionen
- **Inhalts- und Stichwortverzeichnisse, Fußnoten, Gliederungsansicht** (Outliner)
- **Ausgezeichnete Rechtschreibprüfung und Silbentrennung, großer deutscher Thesaurus**
- **Integrierte Adressdatenbank**
  ...

TextMaker wird ständig weiterentwickelt. Falls Sie beim Arbeiten einmal ein Feature vermissen sollten oder andere Anregungen haben, schreiben Sie uns – wir wollen, dass TextMaker den Wünschen der Anwender entspricht!
Zusätzliche Features in SoftMaker Office Professional

Nur für Windows, Mac und Linux erhältlich:

Im noch leistungsfähigeren SoftMaker Office Professional ist eine erweiterte Version von TextMaker enthalten, die folgende Funktionen zusätzlich bietet:

- **Duden-Korrektor** vom Dudenverlag (Rechtschreibprüfung, Silbentrennung, Grammatikprüfung)
- **Original Duden-Wörterbücher** zum Nachschlagen: Das deutsche Universalwörterbuch und Das große Fremdwörterbuch.

**Android-Version**

TextMaker ist auch für Android-Geräte erhältlich und enthält praktisch alle Funktionen der Windows-Version.

---

**Technischer Support**

Wenn Sie Fragen haben, hilft Ihnen unser technischer Support gerne weiter. Sie können diesen wie folgt erreichen:

**Website**

Auf unserer Website finden Sie die neuesten Updates für Ihre Programme, Tipps und Tricks, kostenlose Downloads und vieles mehr.

Besuchen Sie uns auf: [www.softmaker.de](http://www.softmaker.de)

**Supportforen**

In unseren Supportforen können Sie technische Fragen stellen und mit anderen Anwendern kommunizieren.

Sie finden diese unter: [forum.softmaker.de](http://forum.softmaker.de)

**Anfragen an unseren Support**

Bei Problemen mit unserer Software helfen wir Ihnen gerne weiter.

Sie können Ihre Fragen hier eingeben: [www.softmaker.de/supportassistent](http://www.softmaker.de/supportassistent)
Über dieses Handbuch

TextMaker besitzt sehr viele Funktionen – aber keine Sorge: Sie müssen nicht alle davon beherrschen! Nutzen Sie am Anfang nur die Möglichkeiten, die Sie benötigen. Wenn Sie später einmal fortgeschrittene Funktionen in Anspruch nehmen möchten, können Sie die entsprechenden Stellen im Handbuch immer noch nachlesen.

Dieses Handbuch ist wie folgt aufgebaut:

- Das Kapitel **Installation und Programmstart** beschäftigt sich mit der Installation von TextMaker. Sie erfahren weiterhin, wie das Programm gestartet wird.
- Im Kapitel **Der Arbeitsbildschirm** werden die einzelnen Bestandteile des Programmfensters beschrieben.
- Im Kapitel **Grundlagen** lernen Sie die wichtigsten grundlegenden Funktionen von TextMaker kennen. Ideal für Einsteiger!
- Das Kapitel **Die TextMaker-Tour** befasst sich praxisbezogen mit dem Thema Textverarbeitung und führt Sie anhand einiger praktischer Beispiele in die Bedienung von TextMaker ein.

Systemvoraussetzungen

Zum Einsatz dieser Software benötigen Sie folgende Hard- und Software:

**Windows-Version**
- Windows 10, Windows 8/8.1 oder Windows 7 (32 oder 64 Bit)

**Mac-Version**
- macOS oder OS X ab Version 10.10 ("Mavericks")

**Linux-Version**
- Beliebiges x86-Linux (32 oder 64 Bit)

**Android-Version**
- Android 5.0 oder höher
- ARM-kompatible CPU
Installation und Programmstart

In diesem Kapitel erfahren Sie, wie Sie TextMaker installieren und wie Sie das Programm starten.

Das Kapitel ist nach Betriebssystemen aufgeteilt:

- Installation unter Windows
- Installation unter macOS
- Installation unter Linux
- Installation auf Android-Geräten

Lesen Sie bitte bei dem Abschnitt für Ihr Betriebssystem weiter.

Installation unter Windows

Download

Wenn Sie die Software als Download aus dem Internet bezogen haben, finden Sie Instruktionen zur Installation in der E-Mail, die Sie beim Kauf automatisch erhalten haben.

CD-ROM

Wenn Sie die Software auf CD-ROM bezogen haben, starten Sie nun bitte das Installationsprogramm im Hauptverzeichnis der CD. Folgen Sie dann den Anweisungen des Installationsprogramms.

Starten der Programme


Installation unter macOS

Informationen zur Installation der Software finden Sie in der E-Mail, die Sie beim Kauf automatisch erhalten haben.
Installation und Programmstart

Fehlermeldung beim Starten des Installationsprogramms?

Abhängig von den Einstellungen Ihres Systems erhalten Sie beim Starten des Installationsprogramms mögli-
cherweise folgende Fehlermeldung:

Dies passiert, wenn in den Sicherheitseinstellungen Ihres Systems festgelegt ist, dass nur Programme ausge-
führt werden dürfen, die aus dem App Store heruntergeladen wurden.

Wie Sie das Installationsprogramm dennoch ausführen können, verrät ein Klick auf das Fragezeichen in der
linken unteren Ecke der Meldung. Es erscheint ein Hilfenster, das folgende Vorgehensweise empfiehlt:

1. Schließen Sie die Fehlermeldung.
2. Halten Sie die ctrl-Taste gedrückt und klicken Sie auf das Installationsprogramm.
3. Es erscheint ein Kontextmenü. Wählen Sie darin den Befehl Öffnen.
4. Es erscheint eine Meldung, in der nachgefragt wird, ob Sie das Programm wirklich öffnen möchten. Be-
stätigen Sie das, indem Sie auf die Schaltfläche Öffnen klicken.

Das Installationsprogramm wird nun gestartet.

Starten der Programme

Nach erfolgter Installation erscheinen Symbole für die installierten Programme sowohl im Launchpad als
auch im Dock am unteren Bildschirmrand. Um eines der Programme zu starten, klicken Sie einfach sein
Symbol an.

Installation unter Linux

Informationen zur Installation der Software finden Sie in der E-Mail, die Sie beim Kauf automatisch erhal-
ten haben.

Starten der Programme

Bei den meisten Linux-Distributionen legt das Installationsprogramm automatisch Verknüpfungen für alle
SoftMaker Office-Applikationen im Menü an. Mit diesen können Sie die Programme bequem per Mausklick
starten.
Als Alternative werden außerdem Skripte zum Starten der Programme angelegt:

- **textmaker18** startet TextMaker
- **planmaker18** startet PlanMaker
- **presentations18** startet Presentations

Sie können diese Skripte beispielsweise in einer Shell aufrufen.

_Adresseingabe beim ersten Start:_ Wenn Sie TextMaker zum ersten Mal starten, werden Sie aufgefordert, Ihren Namen, Anschrift, Telefonnummer etc. anzugeben. Diese Angaben dienen _nicht_ der Registrierung. Sie werden vielmehr für das automatische Eintragen Ihrer Adressdaten in die mitgelieferten Dokumentvorlagen für Briefe, Faxe usw. benötigt. Sie können diese Angaben später jederzeit wieder ändern (siehe dazu Abschnitt _Einstellungen, Karteikarte Allgemein_).

---

**Installation auf Android-Geräten**

**Bei Kauf im Google Play Store**

Der Arbeitsbildschirm

Auf den nächsten Seiten stellen wir Ihnen die einzelnen Komponenten der Benutzeroberfläche von TextMaker vor.


Titelleiste

In der obersten Zeile des Programms finden Sie die Titelleiste.

Diese zeigt den Programmnamen und den Namen des Dokuments an, das Sie gerade bearbeiten.
Der Arbeitsbildschirm

Falls das Dokument Änderungen enthält, die noch nicht gespeichert wurden, wird ein Sternchen hinter seinem Namen angezeigt.

### Menüleiste

Unter der Titelleiste befindet sich die **Menüleiste**.

<table>
<thead>
<tr>
<th>Datei</th>
<th>Bearbeiten</th>
<th>Ansicht</th>
<th>Format</th>
<th>Einfügen</th>
<th>Objekt</th>
<th>Tabelle</th>
<th>Weitere</th>
<th>Fenster</th>
<th>Hilfe</th>
</tr>
</thead>
</table>

Diese enthält sämtliche Befehle von TextMaker in Form von übersichtlichen *Menüs*. Klicken Sie auf einen Menüeintrag, um ein Menü zu öffnen und darin einen Befehl aufzurufen.

### Kontextmenü

Es gibt außerdem noch ein weiteres Menü: das sogenannte **Kontextmenü**.

Dieses enthält je nach Situation unterschiedliche Befehle. Wenn Sie beispielsweise etwas Text markieren und dann das Kontextmenü öffnen, bietet dieses Befehle zum Ausschneiden, Kopieren und Formatieren dieses Textes an.

Um das Kontextmenü zu öffnen, markieren Sie üblicherweise erst etwas im Dokument und klicken das Markierte dann mit der **rechten** Maustaste an.

**Android:** Bei der Android-Version können Sie das Kontextmenü auch mit dem Finger öffnen: Tippen Sie dazu auf den Bildschirm und halten Sie den Finger für etwa eine Sekunde gedrückt.
**Funktionsleiste**

Unter der Menüleiste wird die *Funktionsleiste* angezeigt. Diese enthält Symbole für die gebräuchlichsten Befehle von TextMaker.


*Tipp:* Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), erscheint ein Infotext, der die Funktion des Symbols angibt.


*Ssymbolleisten selbst gestalten:* Sie können die vorgegebenen Symbolleisten nach Belieben verändern und auch eigene Symbolleisten erstellen. Informationen dazu finden Sie im Abschnitt *Symbolleisten anpassen*.

---

**Formatleiste**

Die *Formatleiste* finden Sie unterhalb der Funktionsleiste. Sie können damit die gebräuchlichsten Textformatierungen (Schriftart, Fettdruck, Kursivschrift usw.) sowohl ablesen als auch ändern.

Markieren Sie zuvor einen Textabschnitt, wirken sich Änderungen an der Formatierung nur auf den markierten Text aus. Ansonsten ist der Text betrifft, den Sie anschließend eintippen.

Um beispielsweise eine andere Schriftart auszuwählen, klicken Sie auf das kleine Pfeilchen rechts neben der Schriftart, um die Liste zu öffnen, und wählen dann eine Schriftart aus.

Andere Symbole in der Formatleiste sind wiederum Schalter, die Sie durch Anklicken ein- und ausschalten können – zum Beispiel das *F* für Fettdruck.

---

**Ribbon (Menüband)**

Wenn Sie in den Einstellungen ausgewählt haben, dass Sie statt klassischer Menüs und Symbolleisten lieber ein *Ribbon* (also ein *Menüband*) verwenden möchten, sieht der oberste Bereich des Programmfensters bei Ihnen etwa folgendermaßen aus:
Ribbons sind eine moderne Art von Benutzeroberfläche, die Menüs und Symbolleisten ersetzen soll, indem sie diese kombiniert. Dies soll den Umgang mit der Software vereinfachen.

Wie Sie sehen, verfügt das Ribbon über mehrere Karteikarten, deren Karteikartenreiter ganz oben angezeigt werden (Datei, Start, Einfügen etc.). Jede dieser Ribbon-Karten enthält Symbole zu einem bestimmten Aufgabenbereich. Um zu einer bestimmten Ribbon-Karte zu wechseln, klicken Sie auf ihren Reiter.

**Tipp:** Sie können auch über die Tastatur zwischen den Ribbon-Karten wechseln: Mit \text{Strg+F12} bewegen Sie sich zur nächsten Karte und mit \text{Strg+Umschalt+F12} zur vorherigen Karte.

Unter dem Ribbon wird die *Schnellzugriffsleiste* angezeigt. Diese bietet eine Auswahl an besonders häufig benötigten Befehlen.

**Hinweis:** Das Handbuch enthält bislang nur grundlegende Informationen zur Bedienung des Programms über das Ribbon. Ausführlichere Informationen dazu werden in einer späteren Auflage nachgereicht.

**Tipp 1:** Eine Tabelle, die zeigt, welcher Menübefehl welchem Ribbonbefehl entspricht, finden Sie hier: \text{Menübefehle und entsprechende Ribbonbefehle}.

**Tipp 2:** Sie können auch vom Ribbon aus auf das klassische Menü zugreifen: Klicken Sie einfach auf das Symbol \equiv in der *Schnellzugriffsleiste*, um dieses zu öffnen.

**Tipp 3:** Die Benutzeroberfläche lässt sich jederzeit zwischen *Ribbon* und *klassischen Menüs mit Symbolleisten* umschalten. Rufen Sie dazu im Menü den Befehl \text{Weiteres > Einstellungen} auf (beziehungsweise im Ribbon den Befehl \text{Datei > Einstellungen}). Wechseln Sie in dem Dialog auf die Karteikarte \text{Ausschnitte} und klicken Sie darin auf die Schaltfläche \text{Benutzeroberfläche}. Es erscheint ein weiterer Dialog, in dem Sie die gewünschte Art von Benutzeroberfläche wählen können.

## Registerkarten für Dokumente

Unter den Symbolleisten beziehungsweise dem Ribbon sehen Sie eine Leiste mit *Registerkarten*. Darin wird für jedes momentan geöffnete Dokument jeweils eine Registerkarte angezeigt.

Mit den Registerkarten lassen sich folgende Aktionen durchführen:

- Um ein Dokument zum aktiven Dokument zu machen, klicken Sie mit der *linken* Maustaste auf seine Registerkarte. So können Sie blitzschnell zwischen den geöffneten Dokumenten hin- und herwechseln.
Um ein Dokument zu schließen, klicken Sie mit der *mittleren* Maustaste auf seine Registerkarte.

Alternativ können Sie auch mit der linken Maustaste auf das \( \times \)-Symbol klicken, das ganz rechts in der Registerkarte angezeigt wird.

Dokumente können bei Bedarf übrigens auch in einem neuen Programmfenster geöffnet werden. Details zum Arbeiten mit mehreren Dokumenten finden Sie im Kapitel *Mehrere Dokumente gleichzeitig bearbeiten*.

---

**Linealleiste**

Oberhalb des Dokuments selbst finden Sie das *horizontale Lineal*, im weiteren Verlauf des Handbuchs meist *Linealleiste* genannt. In dieser Leiste werden die Einzüge und Tabulatoren für den aktuellen Absatz (beziehungsweise alle derzeit markierten Absätze) angezeigt.

Einzüge und Tabulatoren werden dort aber nicht nur angezeigt, sie lassen sich mit der Maus auch ändern. Wie das geht, können Sie in den Abschnitten *Einzüge* und *Tabulatoren* nachlesen.

---

**Dokument**

Den größten Teil des Programmfensters nimmt das Dokument selbst ein.

Informationen zum Bearbeiten von Dokumenten finden Sie im Rest dieses Handbuchs, beginnend mit dem Kapitel *Arbeiten mit Markierungen*.

Einsteigern wird empfohlen, sich zuvor das Kapitel *Grundlagen* anzusehen. Tipp: Das Kapitel *Die TextMaker-Tour* lädt Sie außerdem zu einer praktischen Einführung in die grundlegenden Funktionen von TextMaker ein.

---

**Seitenleiste**

Die Leiste rechts neben dem Dokument wird *Seitenleiste* genannt. Sie ist ein besonders nützlicher Helfer:

Sie können in der Seitenleiste beispielsweise eine Liste aller Überschriften in einem Dokument anzeigen lassen, um besser im Dokument navigieren zu können. Ein Doppellklick auf eine der Überschriften genügt, und TextMaker springt sofort zu der entsprechenden Überschrift in Ihrem Dokument.

Über die kleine Symbolleiste oberhalb der Seitenleiste können Sie auswählen, was in der Seitenleiste angezeigt werden soll (Navigator, Zeichenvorlagen oder Absatzvorlagen).

Sie können die Seitenleiste jederzeit ein- oder ausschalten. Rufen Sie dazu den Menübefehl *Ansicht > Seitenleiste* auf und wählen Sie, ob die Leiste links, rechts oder überhaupt nicht angezeigt werden soll.
Der Arbeitsbildschirm

Weitere Informationen zur Seitenleiste und ihren einzelnen Funktionen finden Sie in folgenden Abschnitten:

- Navigieren mit der Seitenleiste
- Zeichenvorlagen und die Seitenleiste
- Absatzvorlagen und die Seitenleiste

## Statuszeile

Am unteren Ende des Programmfensters befindet sich die *Statuszeile*.

**Hinweis:** Wenn Sie die Statuszeile nicht sehen sollten, müssen Sie die Einstellungen dafür ändern, wie im Abschnitt Einstellungen, Karteikarte Aussehen beschrieben.

Wenn Sie mit der Maus auf eines der Symbole einer Symbolleiste oder eines Ribbons zeigen, wird in der Statuszeile eine kurze Erläuterung zur Funktion dieses Symbols ausgegeben.

Darüber hinaus werden in der Statuszeile folgende Informationen angezeigt:

<table>
<thead>
<tr>
<th>Beispielen</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ze 37 Sp 8</td>
<td>Die Schreibmarke befindet sich in der Zeile 37 und Spalte 8 der aktuellen Seite.</td>
</tr>
<tr>
<td>Bereich 1</td>
<td>Die Schreibmarke befindet sich in Bereich 1 des Dokuments (siehe dazu Kapitel Mehrspalten­druck).</td>
</tr>
<tr>
<td>Kapitel 1</td>
<td>Die Schreibmarke befindet sich in Kapitel 1 des Dokuments (siehe dazu Abschnitt Aufteilen eines Dokuments in Kapitel).</td>
</tr>
<tr>
<td>Seite 1 von 2</td>
<td>Die Schreibmarke befindet sich auf Seite 1 eines Dokuments mit insgesamt 2 Seiten.</td>
</tr>
<tr>
<td>1 Seite*</td>
<td>Die Schreibmarke zählt 1 markierte Seite. Markieren Sie nach Belieben mehrere Seiten, um die Seitenanzahl eines von Ihnen gewählten Abschnitts zu zählen.</td>
</tr>
<tr>
<td>Deutsch</td>
<td>Der Text, in dem sich die Schreibmarke gerade befindet (oder der momentan markierte Text) ist in der Sprache &quot;Deutsch&quot; formatiert (siehe dazu Abschnitt Sprache einstellen).</td>
</tr>
<tr>
<td>EINF</td>
<td>Zeigt an, ob der Einfügemodus (EINF) oder der Überschreibmodus (ÜB) aktiv ist:</td>
</tr>
<tr>
<td><strong>EINF:</strong></td>
<td>Der Einfügemodus ist aktiv – neu eingebeterer Text wird also vor dem bestehenden Text eingefügt.</td>
</tr>
<tr>
<td><strong>ÜB:</strong></td>
<td>Der Überschreibmodus ist aktiv – neu eingebeterer Text überschreibt also den bestehenden Text.</td>
</tr>
</tbody>
</table>

Die Standardeinstellung ist EINF. Mit der Taste Einfg können Sie zwischen diesen beiden Modi umschalten.

* Diese Information erscheint standardmäßig nicht in der Statuszeile. Sie können aber diese Schaltfläche zu Ihrer individuellen Benutzeroberfläche hinzufügen. Wählen sie hierzu die Schaltfläche "Seiten zählen" aus (siehe Abschnitt Symbolleisten anpassen).
Darüber hinaus enthält die Statuszeile einen Zoomregler, mit dem Sie die Vergrößerungsstufe für das Dokument ändern können:

Ziehen Sie dazu entweder an dem Schieber in der Mitte, oder klicken Sie auf das Minus- oder Plussymbol. (Siehe auch Abschnitt Vergrößerungsstufe ändern)
Grundlagen

Dieses Kapitel stellt Ihnen einige grundlegende Funktionen von TextMaker vor.

Wir empfehlen Ihnen, sich anschließend die TextMaker-Tour im nächsten Kapitel anzusehen, die Sie anhand praktischer Beispiele Schritt für Schritt in das Programm einweist.


Text eingeben

Wenn Sie TextMaker starten, wird automatisch ein neues, leeres Dokument geöffnet. Sie können also sofort mit dem Tippen beginnen.

Hinweis: Folgendes sollten Sie dabei beachten: Wenn Sie eine Zeile vollgeschrieben haben, drücken Sie bitte nicht die Eingabetaste, um eine neue Zeile zu beginnen. TextMaker übernimmt das letzte Wort in einer Zeile automatisch in die nächste, wenn es nicht mehr hineinpasst.

Betätigen Sie die Eingabetaste nur in folgenden Fällen:

- am Ende eines Absatzes
- zum Einfügen von Leerzeilen

Lassen Sie also innerhalb eines Absatzes einfach TextMaker für den korrekten Umbruch der Zeilen sorgen.

Schreibmarke bewegen

Beim Bearbeiten von Text sehen Sie stets einen blinkenden Strich. Dies ist die sogenannte Schreibmarke. Wenn Sie etwas tippen, erscheinen die Buchstaben genau dort, wo sich diese Schreibmarke gerade befindet.

Sie können die Schreibmarke zwischen Textanfang und -ende frei bewegen. Hierfür sind die Richtungstasten auf der Tastatur vorgesehen. Die Pfeiltasten ← und → bewegen die Schreibmarke beispielsweise ein Zeichen nach links oder rechts.

Insgesamt gibt es folgende Richtungstasten zum Bewegen der Schreibmarke:

<table>
<thead>
<tr>
<th>Taste</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Ein Zeichen nach links</td>
</tr>
<tr>
<td>→</td>
<td>Ein Zeichen nach rechts</td>
</tr>
</tbody>
</table>
Grundlagen

Eine Zeile nach oben
Eine Zeile nach unten
Zum Zeilenanfang
Zum Zeilenende
Zum Anfang des aktuellen Absatzes; bei erneutem Betätigen: zum vorherigen Absatz
Zum nächsten Absatz
Zum Anfang des Dokuments
Zum Ende des Dokuments

Darüber hinaus können Sie auch eine beliebige Textstelle mit der Maus anklicken, um die Schreibmarke dorthin zu setzen.

Android: Bei der Android-Version können Sie die gewünschte Position natürlich auch einfach mit dem Finger antippen.

Text löschen

Gelegentlich macht jeder Tippfehler und möchte diese wieder löschen. Hierzu gibt es in TextMaker zahlreiche Möglichkeiten:

Zeichen löschen: Um ein Zeichen zu löschen, verwenden Sie die Rücktaste, die sich über der Eingabetaste befindet. Diese Taste löscht das Zeichen links der Schreibmarke. Der nachfolgende Text rückt automatisch nach.

Sie können auch in die entgegengesetzte Richtung löschen: Die Taste Entf ("Entfernen") macht dies. Sie löscht nicht das Zeichen links, sondern das rechts der Schreibmarke.

Wort löschen: Wenn Sie die Schreibmarke vor den ersten Buchstaben eines Wortes setzen und dann Strg+Entf drücken, wird dieses Wort gelöscht. Befindet sich die Schreibmarke inmitten des Wortes, löscht diese Tastenkombination nur die Buchstaben bis zum Ende dieses Wortes.


Lange Textstücke löschen: Obige Löschtasten sind gut geeignet zum Entfernen kurzer Textstücke, aber viel zu umständlich für größere "Löscharbeiten". Deshalb gibt es noch eine weitere Löschmethode, bei der Sie Text erst markieren und dann z.B. durch Drücken der Taste Entf komplett löschen. Mehr dazu im Kapitel Arbeiten mit Markierungen.
Änderungen rückgängig machen

Mit dem Menübefehl **Bearbeiten > Rückgängig** können Sie die zuletzt an einem Dokument durchgeführten Änderungen widerrufen. Formatieren Sie beispielsweise Text in einer anderen Schrift, brauchen Sie nur **Bearbeiten > Rückgängig** aufzurufen, und schon wird dies wieder aufgehoben.

Dies funktioniert nicht nur bei Formatierungen, sondern bei praktisch allen Textänderungen – so können Sie beispielsweise auch das Eintippen oder Löschen von Text rückgängig machen.

Der Befehl **Rückgängig** lässt sich bei Bedarf auch mehrmals hintereinander anwenden. Rufen Sie ihn zum Beispiel fünfmal auf, werden die letzten fünf Änderungen widerrufen.

Wiederherstellen von widerrufenen Aktionen

Es gibt auch ein Gegenstück zum Befehl **Rückgängig**: den Menübefehl **Bearbeiten > Wiederherstellen**. Erstellt die zuletzt von Ihnen widerrufene Aktion wieder her. So können Sie also das Widerrufen von Textänderungen widerrufen.

Auch dieser Befehl lässt sich mehrmals hintereinander aufrufen. Rufen Sie also beispielsweise fünfmal den Befehl **Rückgängig** auf, werden die letzten fünf Textänderungen widerrufen. Rufen Sie anschließend fünfmal den Befehl **Wiederherstellen** auf, erhalten Sie wieder den ursprünglichen Text.

Einfügen oder Überschreiben?

Das Eingeben von Text funktioniert ganz einfach. Sie bewegen die Schreibmarke an die gewünschte Stelle im Dokument und beginnen zu tippen.

Bei TextMaker ist der **Einfügemodus** voreingestellt. Wenn Sie in diesem Modus ein Zeichen tippen, wird es in den bestehenden Text eingefügt und schiebt den übrigen Text vor sich her.

Sie können aber auch in den **Überschreibmodus** umschalten. In diesem Modus überschreibt der eingegebene Text den nachfolgenden Text.

In der Statuszeile wird stets angezeigt, welcher Modus gerade aktiv ist: Erscheinen dort die Buchstaben EINF, so ist der Einfügemodus aktiv. Wird ÜB angezeigt, arbeiten Sie im Überschreibmodus.

Mit der Taste **Einf** können Sie zwischen den beiden Modi hin- und herschalten.

Neues Dokument beginnen

Wenn Sie ein neues Dokument beginnen möchten, rufen Sie den Menübefehl **Datei > Neu** auf.
Es erscheint ein Dialogfenster, in dem Sie die Dokumentvorlage für das neue Dokument auswählen können. Wenn Sie einfach nur ein neues Dokument beginnen und sich mit Dokumentvorlagen im Moment nicht weiter befassen möchten, wählen Sie die Standardvorlage Normal.tmvx. Sobald Sie mit OK bestätigen, wird das neue Dokument angelegt.

### Verwenden von Dokumentvorlagen

**Vorlage:** Neben der Standardvorlage Normal.tmvx sehen Sie auch einige Ordner, die sich per Doppelklick öffnen lassen. Diese enthalten vorgefertigte Dokumentvorlagen für Briefe, Faxe usw. Sie müssen sie nur noch ausfüllen.

**Sprache:** Wählen Sie hier die Sprache aus, für die Dokumentvorlagen angezeigt werden sollen.

**Neuer Standard:** Ändern Sie die Standardvorlage, indem Sie eine Vorlage anklicken und auf die Schaltfläche Neuer Standard drücken.

**Tipp:** In der rechten Hälfte des Dialogs wird eine kleine Vorschau der momentan ausgewählten Vorlage präsentiert. Sie können diese Vorschau über die Schaltflächen >> und << jederzeit ein- oder ausschalten.

Ausführliche Informationen zum Arbeiten mit Dokumentvorlagen finden Sie im Abschnitt Dokumentvorlagen.

### Option "Neues Programmfenster"

Die Option Neues Programmfenster hat folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint das neue Dokument in einem eigenen Programmfenster. Ist sie ausgeschaltet, wird das Dokument im bestehenden Programmfenster mit einer neuen Registerkarte angelegt. (Hinweis: Diese Option steht in der Android-Version nicht zur Verfügung.)
Dokument öffnen

Um ein bestehendes Dokument zu öffnen, rufen Sie den Befehl Öffnen im Menü Datei auf.

Es erscheint ein Dialogfenster, das beispielsweise wie folgt aussehen kann:

Je nach Betriebssystem ist dieses Dialogfenster etwas anders gestaltet, seine Funktion ist aber immer die gleiche: Über diesen Dialog teilen Sie TextMaker mit, welches Dokument geöffnet werden soll.

Dazu könnten Sie einfach den Namen der zu öffnenden Datei von Hand eingetippen. Über die Auswahlliste mit den Dateien geht dies allerdings komfortabler, denn hier werden alle Dateien im aktuellen Ordner aufgelistet und können bequem ausgewählt werden.

Option "Neues Programmfenster"

Die Option Neues Programmfenster hat folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint das Dokument in einem eigenen Programmfenster. Ist sie ausgeschaltet, wird das Dokument im bestehenden Programmfenster mit einer neuen Registerkarte geöffnet. (Hinweis: Diese Option steht in der Android-Version nicht zur Verfügung.)
Vorschau auf ein Dokument

Wenn die Option **Vorschau** eingeschaltet ist, erscheint rechts neben dem Dialog eine kleine Vorschau auf den Inhalt des momentan selektierten Dokuments.

Andere Dateiformate öffnen

TextMaker kann nicht nur seine eigenen Dokumente, sondern auch Dateien anderer Textverarbeitungen öffnen. Sie müssen dazu lediglich das gewünschte Format in der Liste der Dateitypen auswählen.

Weitere Informationen dazu finden Sie im Kapitel **Fremdformaten**.

Schnellwahlpfade verwenden

Über die Schaltfläche **Schnellwahlpfad** können Sie **Schnellwahlpfade** anlegen und abrufen, um beim Öffnen oder Speichern von Dateien blitzschnell in einen bestimmten Ordner wechseln zu können.

Weitere Informationen dazu finden Sie im Abschnitt **Schnellwahlpfade**.

Dateimanager

Über die Schaltfläche **Dateimanager** können Sie den integrierten Dateimanager aufrufen. Dieser zeigt eine Liste Ihrer Dokumente an und lässt Sie diese nicht nur öffnen, drucken, ansehen oder löschen, sondern auch durchsuchen.

Weitere Informationen dazu finden Sie im Abschnitt **Dateimanager**.

Liste der zuletzt geöffneten Dateien

**Tipp:** Am unteren Ende des Menüs **Datei** finden Sie eine Liste der zuletzt geöffneten Dateien. Um eine dieser Dateien erneut zu öffnen, klicken Sie sie einfach an.

**Dokument drucken**

Wenn Sie das aktuelle Dokument ausdrucken möchten, rufen Sie den Menübefehl **Datei > Drucken** auf.

Es erscheint ein Dialogfenster, in dem Sie einstellen können, welche Seiten und wie viele Exemplare gedruckt werden sollen. Voreingestellt ist der Druck eines Exemplars des gesamten Dokuments.

Ausführliche Informationen zum Ausgeben Ihrer Dokumente finden Sie im Kapitel **Ausgeben von Dokumenten**.
Dokument speichern

Wenn Sie ein Dokument fertiggestellt haben, sollten Sie dieses speichern, um es dauerhaft zu erhalten. Rufen Sie dazu den Menübefehl Datei > Speichern auf.

Sollte das Dokument noch keinen Namen besitzen, fordert TextMaker vor dem Speichern automatisch auf, einen Dateinamen zu vergeben.

Speichern unter einem anderen Namen oder an einem anderen Ort

TextMaker verfügt außerdem über einen Menübefehl namens Datei > Speichern unter. Dieser sichert Ihr Dokument ebenfalls, jedoch können Sie ihm zuvor einen anderen Dateinamen geben oder einen anderen Ordner zum Speichern wählen.

Speichern in einem anderen Dateiformat

Sie können ein Dokument mit dem Menübefehl Datei > Speichern unter auch im Dateiformat eines anderen Programms speichern. Wählen Sie dazu das gewünschte Format in der Liste Dateityp (siehe Kapitel Fremdformate).

Alle geöffneten Dokumente speichern

Haben Sie mehrere Dokumente gleichzeitig geöffnet, können Sie den Menübefehl Datei > Alles speichern verwenden, um diese alle auf einmal speichern zu lassen. TextMaker prüft dabei nach, ob die Dokumente seit dem letzten Speichern geändert wurden, und speichert nur diejenigen Dokumente, bei denen dies der Fall ist.

Arbeit beenden

Wenn Sie TextMaker beenden möchten, rufen Sie den Menübefehl Datei > Beenden auf.

Wurde eines der geöffneten Dokumente seit seiner letzten Speicherung verändert, fragt TextMaker automatisch nach, ob Sie es zuvor noch speichern möchten.
Die TextMaker-Tour

Willkommen bei der TextMaker-Tour!

Auf den nächsten Seiten werden wir Ihnen einige Grundfunktionen von TextMaker anhand praktischer Beispiele vorstellen.

Scheuen Sie sich beim Durcharbeiten der Übungen nicht, mit den neu kennengelernten Befehlen zu experimentieren! Selbst wenn einmal etwas völlig danebengeht – das macht überhaupt nichts. Für jeden neuen Lektionsabschnitt wird ein fertiges Beispieldokument mitgeliefert, das Sie öffnen und als Basis für den nächsten Abschnitt verwenden können.


Ein Übungsbrief

Bereit für die erste Übung? Dann starten Sie jetzt TextMaker.


Sie werden jetzt vielleicht sagen: "Das kann ich doch viel einfacher haben, indem ich den Menübefehl Datei > Neu aufrufe und eine der vorgefertigten Briefvorlagen auswähle". Natürlich – aber Sie lernen dabei nichts. Wenn Sie diese Tour mitmachen, müssen Sie ein wenig Zeit investieren, beherrschen danach aber die wichtigsten Funktionen des Programms und können sofort damit beginnen, die mitgelieferten Vorlagen nach Ihren Wünschen anzupassen!

Lassen Sie uns also beginnen. Tippen Sie zunächst den nachfolgenden Beispieltext ab. Sie müssen sich nicht genau an die Vorgabe halten und können gerne auch einen anderen Brieftext eingeben – der Inhalt spielt keine Rolle.

Anmerkung: Betätigen Sie dabei die Eingabetaste nur an den Stellen im Text, die mit dem Symbol gekennzeichnet sind.
Sehr geehrte Damen und Herren,

in diesem Jahr haben wir ausnahmsweise nicht nur für Sie, sondern auch für uns gebaut. Der neue "Escher-Komplex", eines der gewagtesten Bauvorhaben Deutschlands, soll unsere neue Heimat werden. Zum Richtfest möchten wir Sie hiermit herzlich einladen.

Die Feierlichkeiten finden am kommenden Samstagnachmittag in der Lindenstraße 38-42 statt. Für Ihr leibliches Wohl ist bestens gesorgt, und unser Rahmenprogramm wird Ihnen einen unvergesslichen Nachmittag bescheren.

Bringen Sie Ihre Familie einfach mit - wir bauen auf Ihr Kommen!


Wenn Sie sich an die Vorlage gehalten haben, sollte Ihr Dokument schließlich etwa folgendermaßen aussehen:

Als nächstes braucht unser Brief eine Anschrift, die wir oberhalb des gerade eingegebenen Textes einfügen:

Um zum Beginn des Dokuments zu gelangen, betätigen Sie zunächst die Tastenkombination Strg+Pos1. Drücken Sie dann siebenmal die Eingabetaste, um Leerzeilen einzufügen. So schaffen wir Platz für unsere eigene Anschrift, die aber erst später eingegeben werden soll. Übrigens können Sie versehentlich eingefügte Leerzeilen ebenfalls mit der Rücktaste wieder entfernen.

Anschließend drücken Sie die Taste ↑, um die Schreibmarke in die leere Zeile oberhalb des Brieftextes zu setzen.

Tippen Sie jetzt ein, an wen der Brief geschickt werden soll, zum Beispiel:
Fügen Sie abschließend durch zwölfmaliges Drücken der **Eingabetaste** einige weitere Leerzeilen ein, um Abstand zwischen Anschrift und Brieftext zu schaffen.

Die wichtigsten Grundelemente eines einfachen Briefs haben wir jetzt vorliegen und möchten diesen erst einmal speichern.

### Speichern des Übungsbriefs

**Hinweis:** Ausführliche Informationen zu diesem Thema finden Sie im Abschnitt **Dokument speichern**.

Um ein Dokument zu speichern, verwenden Sie den Menübefehl **Speichern** im Menü **Datei** (in Zukunft schreiben wir dafür einfach: **Datei > Speichern**). Rufen Sie diesen Befehl folgendermaßen auf:

**Maus:** Klicken Sie in der Menüleiste auf den Eintrag **Datei**. Das Datei-Menü öffnet sich, und Sie können den Befehl **Speichern** per Mausklick aufrufen.

**Tastatur:** PC-Anwender können alternativ die unterstrichenen **Kennbuchstaben** in den Menüs verwenden. Tippen Sie diese bei gedrückter Alt-Taste – zum Speichern **Alt+D** für **Datei** und dann **S** für **Speichern**.

Vielleicht ist Ihnen beim Betrachten des Menüs aufgefallen, dass rechts neben dem Befehl **Speichern** "Strg+S" angezeigt wird. Dies ist das **Tastenkürzel** für diesen Befehl. Das bedeutet: Sie können auch **Strg+S** drücken, um diesen Befehl aufzurufen, Ihr Dokument also zu speichern.

Auch für Mausnutzer gibt es eine Abkürzung für das Speichern: In der Funktionsleiste finden Sie Symbole für die am häufigsten benötigten Befehle.

Um Ihr Dokument zu speichern, klicken Sie auf das Diskettensymbol in der Funktionsleiste (das dritte Symbol von links).

**Tipp:** Wenn Sie mit der Maus auf eines der Symbole in der Funktionsleiste zeigen (ohne zu klicken), erscheint ein Infotext, der die Funktion des Symbols angibt.

Falls die Funktionsleiste nicht angezeigt wird, wurde sie vermutlich deaktiviert. Rufen Sie den Menübefehl **Ansicht > Symbolleisten** auf und klicken Sie auf das Kästchen vor **Standard**, um sie wieder einzuschalten.

### Das Dialogfenster beim Speichern

Nachdem unser Dokument noch keinen Namen hat, erscheint beim Aufruf des Menübefehls **Datei > Speichern** automatisch ein Dialogfenster, das Sie zur Angabe des Dateinamens auffordert.

Tippen Sie darin bei **Dateiname** einen beliebigen Namen für das Dokument ein oder wählen einen Namen aus der Dateiliste, falls Sie eine bestehende Datei überschreiben möchten.

Geben wir dem Dokument den Namen **brief**. Geben Sie bei **Dateiname** also "brief" ein und klicken Sie auf **OK** oder betätigen Sie die **Eingabetaste**, um Ihre Eingabe zu bestätigen. TextMaker speichert die Da-
Die TextMaker-Tour

Bei der Speichern-Operation geht das Dialogfenster unter dem angegebenen Namen und hängt automatisch die Namenserweiterung .tmdx an. Der vollständige Dateiname lautet also brief.tmdx.


Sie hätten das Dialogfenster übrigens auch verlassen können, ohne den Befehl Speichern auszuführen. Dazu hätten Sie statt auf OK auf die Schaltfläche Abbrechen geklickt oder Esc gedrückt. Dieser "Fluchtweg" steht Ihnen in allen Dialogfenstern zur Verfügung.

---

**Einfache Formatierungen**

Kommen wir nun zu den interessanteren Funktionen – zum Beispiel dem Formatieren von Text, also dem Verwenden von Schriftarten, Textauszeichnungen (Fettdruck, Kursivschrift, Unterstreichen etc.), Einzügen usw.

Fügen wir als erstes über der Adresse eine Zeile mit unserem Absender ein, wie dies bei Briefen, die in Fensterumschlägen verschickt werden sollen, üblich ist.

Setzen wir die Schreibmarke also zwei Zeilen über die Adresse (Zeile 5) und tippen die Anschrift für unser Architekturbüro. Zwischen Name, Straße und Ort können Sie dabei gewöhnliche Bindestriche setzen.

---

Die Anschrift für unser Architekturbüro

---

Escher - Bauhausstraße 6 - 10719 Berlin

---

Für das Sichtfenster eines Fensterumschlags ist diese Zeile allerdings viel zu breit, weswegen wir die Schriftgröße etwas verringern möchten. Damit kommen wir zu einem wichtigen Thema: dem Markieren.

Erst markieren, dann formatieren

*Hinweis:* Ausführliche Informationen zum Markieren finden Sie im Kapitel Arbeiten mit Markierungen.

Um die Formatierung eines Textabschnitts nachträglich ändern zu können, müssen Sie diesen erst markieren, damit TextMaker weiß, welcher Bereich überhaupt geändert werden soll.

Um die Zeile mit der Anschrift zu markieren, gehen Sie wie folgt vor:

**Maus:** Ziehen Sie den Mauszeiger bei gedrückter Maustaste vom Anfang zum Ende des zu markierenden Textes. Zum Markieren kompletter Zeilen gibt es übrigens eine Hilfe: Klicken Sie links neben der Zeile in den Seitenrand. Sofort wird die komplette Zeile markiert.

**Tastatur:** Wenn Sie lieber mit der Tastatur arbeiten, nehmen Sie Markierungen durch Bewegen der Schreibmarke bei gedrückter Umschalttaste vor. In unserem Fall markieren Sie die Zeile mit der Anschrift also, indem Sie die Schreibmarke mit Pos1 vor das erste Zeichen der Anschrift setzen und die Tastenkombination Umschalt+↑ drücken.

**Android:** Falls Sie die Android-Version verwenden, beachten Sie bitte, dass das Markieren von Text dort etwas anders funktioniert. Siehe Abschnitt Markieren von Text und Objekten.

Wenn Sie die Zeile mit der Anschrift markiert haben, können Sie nach Belieben die Schriftgröße ändern. Verwenden Sie dazu die Formatleiste, die alle häufig benötigten Formatierungsbefehle von TextMaker anbietet. Falls die Formatleiste nicht sichtbar sein sollte, rufen Sie den Menübefehl Ansicht > Symbolleisten auf und klicken auf das Kästchen vor Format, um sie zu aktivieren.
Die Formatleiste

_Hinweis:_ Ausführlichere Informationen zur Formatleiste finden Sie in den Kapiteln [Zeichenformatierung](#) und [Absatzformatierung](#).

Rechts neben der Schriftart wird die Schriftgröße des markierten Textabschnitts angezeigt – momentan sind 10 Punkt eingestellt. Klicken Sie mit der Maus auf das Pfeilchen rechts neben der "10". Es öffnet sich eine Liste mit den gebräuchlichsten Schriftgrößen. Wählen Sie "8" aus der Liste.

Wählen Sie nun zusätzlich eine andere Schriftart. Klicken Sie dazu auf den Pfeil rechts neben der Schrift und wählen Sie aus der Liste die Schrift MicroSquare. Sollten Sie diese Schrift nicht installiert haben, können Sie auch eine beliebige andere wählen.

Die Formatleiste sollte nach Ihren Änderungen folgendes anzeigen:

---

Die Schrift MicroSquare in der Größe 8 Punkt wurde eingestellt.

Absender und Anschrift sehen dementsprechend nun also etwa wie folgt aus:

---

Wenn mal etwas schiefgeht ...

_Hinweis:_ Ausführlichere Informationen zu diesem Thema finden Sie im Abschnitt [Änderungen rückgängig machen](#).

In TextMaker gibt es eine sehr praktische Einrichtung: Mit dem Menübefehl _Bearbeiten > Rückgängig_ können Sie beliebig viele der zuletzt durchgeführten Änderungen widerrufen. Formatieren Sie einen Textabschnitt beispielsweise in einer anderen Schriftart – und stellen fest, dass Ihnen diese überhaupt nicht zusagt, brauchen Sie nur den Befehl _Rückgängig_ aufzurufen, und schon wird es wieder aufgehoben.

Dies funktioniert nicht nur bei Formatierungen, sondern bei praktisch allen Textänderungen – auch das Eintippen oder Löschen von Text lässt sich rückgängig machen.
Der Befehl **Rückgängig** lässt sich auch mehrmals hintereinander anwenden. Rufen Sie ihn beispielsweise fünfmal auf, werden die letzten fünf Änderungen widerrufen.

Es gibt übrigens auch ein Gegenstück zum Befehl **Rückgängig**: den Menübefehl **Bearbeiten > Wiederherstellen**. Er stellt die zuletzt von Ihnen widerrufene Aktion wieder her. So können Sie also das Widerrufen von Textänderungen widerrufen.

### Datei öffnen

**Hinweis:** Ausführlichere Informationen zu diesem Thema finden Sie im Abschnitt [Dokument öffnen](#).

Öffnen wir nun die mitgelieferte Beispielsdatei `tour1.tmdx`. Sie enthält den aktuellen Stand unseres Übungsbriefs.

Zum Öffnen von Dokumenten dient der Menübefehl **Datei > Öffnen** auf. Rufen Sie diesen nun auf, worauf ein entsprechender Dialog erscheint.

Wechseln Sie dann in den Ordner mit den Beispieldokumenten von SoftMaker. Je nach Betriebssystem finden Sie diesen wie folgt:

- **Windows:** Navigieren Sie zu Ihrem **Dokumente**-Ordner und öffnen Sie darin den Ordner **SoftMaker\Beispiele**.
- **macOS:** Navigieren Sie zu Ihrem Benutzerordner und öffnen Sie darin den Ordner **SoftMaker/Beispiele**.
- **Linux:** Navigieren Sie zu Ihrem Home-Verzeichnis und öffnen Sie darin den Ordner **SoftMaker/Beispiele**.
- **Android:** Navigieren Sie zu dem Ordner **SoftMaker/Beispiele** auf Ihrer SD-Karte.

Finden Sie dort die Datei `tour1.tmdx` und führen Sie einen Doppelklick auf diese Datei aus, um sie zu öffnen.

### Briefkopf erstellen

Unser Brief braucht natürlich noch einen ansehnlichen Briefkopf mit dem Firmennamen in einer größeren Schrift und vielleicht noch einer Zeile, die Aufschluss darüber gibt, was unsere Firma anzubieten hat.

Machen wir uns ans Werk! Bewegen Sie die Schreibmarke mit **Strg+Pos1** an den Beginn des soeben geöffneten Dokuments `tour1.tmdx`. Dann tippen Sie:

```
Architekturbüro Escher
Entwurf und Planung von Bauvorhaben aller Größenordnungen
```

Der Firmenname darf ruhig etwas größer erscheinen: Markieren Sie die erste Zeile, formatieren Sie diese mit Hilfe der Formatleiste in der Schrift MicroSquare, wählen Sie eine Schriftgröße von 32 Punkt und schalten Sie Fettdruck ein.

Sie könnten sogar Schriftgrößen mit einer Nachkommastelle angeben (zum Beispiel 11,6 Punkt), um Text exakt in den zur Verfügung stehenden Platz einzupassen.

Die Formatleiste sollte schließlich folgendermaßen aussehen:

\begin{center}
\includegraphics[width=0.8\textwidth]{erstellen/erfassen/01_schriftgrae.png}
\end{center}

MicroSquare 32 Punkt fett wurde gewählt


Es öffnet sich ein Dialogfenster, in dem alle Formatierungsmöglichkeiten für Zeichen auf einen Blick angeboten werden.

\begin{center}
\includegraphics[width=0.8\textwidth]{erstellen/erfassen/02_dialogfenster.png}
\end{center}

\subsection*{Hinweis:} Ausführlichere Informationen zu diesem Dialogfenster finden Sie im Kapitel \textit{Zeichenformatierung}.

Die Einstellungen in diesem Dialogfenster sind auf mehrere \textit{Karteikarten} aufgeteilt, zwischen denen Sie wechseln können, indem Sie oben auf den gewünschten Karteikartenreiter klicken. Wie Sie sehen, hat dieser Dialog Karteikarten für \textit{Schrift}, \textit{Abstand} und \textit{Hyperlink}. Nachdem wir nur die Schrift verändern möchten, können wir auf der Karteikarte \textit{Schrift} verbleiben.


Klicken Sie dann auf OK, um die geänderte Formatierung anzubringen. Speichern Sie anschließend das Dokument.

Absatzausrichtung

Als Absatzausrichtung bezeichnet man die Art und Weise, wie TextMaker den Text zwischen den Rändern auffüllt.

Sie ändern die Absatzausrichtung über den Menübefehl Format > Absatz. Wenn Sie diesen Befehl aufrufen, erscheint ein Dialogfenster. Öffnen Sie darin die Liste Ausrichtung auf der Karteikarte Absatz. Wählen Sie dann die gewünschte Absatzausrichtung aus dieser Liste.

Schneller geht dies übrigens über die Formatleiste, denn diese enthält vier Symbole, mit denen Sie die Ausrichtung per Mausklick ändern können:

- Linksbündig
- Zentriert
- Rechtsbündig
- Blocksatz

Der Firmenname soll nun zentriert ausgerichtet werden. Bewegen Sie die Schreibmarke dazu vor ein beliebiges Zeichen im Firmennamen "Architekturbüro Escher" und klicken Sie auf das Symbol für "Zentriert" in der Formatleiste.

**Hinweis:** Absatzformatierungen – also alle Formatierungen, die Sie mit dem Menübefehl Format > Absatz vornehmen können – betreffen stets komplette Absätze. Möchten Sie also das Absatzformat eines einzelnen Absatzes ändern, brauchen Sie diesen nicht erst zu markieren, sondern bewegen die Schreibmarke einfach an eine beliebige Stelle innerhalb des Absatzes.

Möchten Sie hingegen die Formatierung mehrerer aufeinanderfolgender Absätze abändern, müssen Sie diese zuvor markieren. Die Markierung darf dabei an einer beliebigen Stelle innerhalb des ersten Absatzes beginnen und irgendwo im letzten Absatz enden.


Ihr Arbeitsbildschirm sollte schließlich etwa folgendes Aussehen haben:
Die TextMaker-Tour

Eigentlich könnten wir jetzt unser "Mit freundlichen Grüßen" unter den Brief setzen und ihn losschicken. Es gibt aber sicher noch einiges, was man an diesem Briefkopf verschönern könnte. Beginnen wir also mit etwas Feinarbeit.

Tabulatoren


**Hinweis:** Tabulatoren fügen Sie durch das Drücken der Tabulatortaste ein. Obwohl diese Taste bei den meisten Tastaturen mit zwei Pfeilen beschriftet ist, wird in diesem Handbuch zur besseren Unterscheidung von den Richtungstasten die Beschriftung Tab verwendet.

Bewegen Sie die Schreibmarke jetzt an den Beginn der 17. Zeile und tippen Sie folgende Zeile ein:

<table>
<thead>
<tr>
<th>Ihr Zeichen: [Tab]</th>
<th>Ihr Schreiben vom: [Tab]</th>
<th>Unser Zeichen: [Tab]</th>
<th>Unser Schreiben vom: [Tab]</th>
</tr>
</thead>
</table>

Formatieren Sie diese Zeile anschließend in der Schrift MicroSquare, 8 Punkt.

Sie haben jetzt Tabulatoren in den Text eingefügt, ihre genaue Position aber noch nicht bestimmt. Dazu setzen Sie Tabstopps. Als Vorgabe macht TextMaker zwar automatisch alle 1,25 cm einen Tabstop, diese Voreinstellung aus der Schreibmaschinenzeit sollten Sie aber im Allgemeinen nicht übernehmen.

Tabstopps können über den Menübefehl **Format > Tabulator** gesetzt werden – oder direkt über die **horizontale Linealleiste**, die über dem Dokument angezeigt wird.

*Die horizontale Linealleiste*
Die TextMaker-Tour

Falls die Linealleiste nicht sichtbar sein sollte, müssen Sie diese erst über den Menübefehl **Ansicht > Linealleiste** einschalten.

Mit der Linealleiste setzen Sie Tabstopps wie folgt:

1. **Markieren Sie die Absätze, in denen Tabstopps gesetzt werden sollen.**
   Wenn Sie die Tabstopps für *mehrere* Absätze gleichzeitig einrichten möchten, müssen Sie diese Absätze wie üblich erst markieren.
   
   Für unser Beispiel markieren Sie jetzt bitte die gerade eingegebene Zeile *und* die Zeile unter ihr, denn wir möchten die Tabstopps auch gleich für die nächste Zeile festlegen, die erst später ausgefüllt werden soll.

2. **Wählen Sie den gewünschten Tabulatortyp.**
   Klicken Sie dazu auf das Symbol links vom horizontalen Lineal. Mit jedem Mausklick auf das Symbol wechselt der Tabulatortyp. Folgende Typen gibt es:
   
   - **Linksbündiger Tabulator**
   - **Zentrierter Tabulator (Text wird an der Tabulatorposition *zentriert* )**
   - **Rechtsbündiger Tabulator (Text *endet* an der Tabulatorposition)**
   - **Dezimaltabulator (Zahlen werden am Dezimalkomma ausgerichtet)**
   
   Klicken Sie dieses Symbol jetzt so oft an, bis *linksbündige* Tabulatoren ausgewählt sind.

3. **Klicken Sie die gewünschten Tabulatorpositionen im Lineal an.**
   Klicken Sie nun mit der Maus in der Linealleiste (ungefähr) auf die Positionen 3,5 cm, 7 cm, 10 cm und 14 cm, um dort Tabstopps zu setzen. Beobachten Sie, wie sich der Text entsprechend ausrichtet.

   Der umgekehrte Weg wäre übrigens auch möglich gewesen: Sie hätten, **bevor** Sie die Zeile mit "Ihr Zeichen" usw. tippen, die Tabstopps anlegen und den Text mitsamt den Tabulatoren erst dann tippen können.

   Linealleiste und Text sollten jetzt etwa wie folgt aussehen:

   ![Tabstopps sind jetzt gesetzt und werden in der Linealleiste angezeigt.](image)

   Sollte Ihnen die Position eines Tabstopps nicht gefallen, können Sie ihn direkt in der Linealleiste verschieben: Markieren Sie nötigenfalls erst die zu ändernden Absätze, nehmen Sie den Tabstopf in der Linealleiste mit der Maus, ziehen Sie ihn bei gedrückter Maustaste an eine andere Position und lassen Sie die Maustaste wieder los. Übrigens: Wenn Sie einen Tabstopf nach unten aus der Linealleiste herausziehen, wird er gelöscht.

   Es gibt noch eine alternative Vorgehensweise zum Setzen von Tabulatoren. Lassen Sie die beiden Absätze markiert und rufen Sie den Menübefehl **Format > Tabulator** auf. Es öffnet sich ein Dialogfenster, das Ihnen die Positionen der gerade gesetzten Tabstopps genau anzeigt. Dieser Dialog wird folgendermaßen bedient:
### Aktion

<table>
<thead>
<tr>
<th>Vorgehensweise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setzen neuer Tabstopps</td>
</tr>
<tr>
<td>Löschen von Tabstopps</td>
</tr>
<tr>
<td>Verschieben von Tabstopps</td>
</tr>
<tr>
<td>Ändern der Ausrichtung</td>
</tr>
</tbody>
</table>

Zurück zu unserem Beispielbrief:

Nachdem die Tabstopps sowohl für die Zeile "Ihr Zeichen", "Ihr Schreiben vom" usw. und auch die Zeile darunter richtig gesetzt wurden, wollen wir in die zweite Zeile etwas eintragen.

Bewegen Sie die Schreibmarke an den Beginn dieser Zeile (Zeile 18) und tippen Sie beispielsweise folgendes:

```
MB[Tab]29.10.16[Tab]HG[Tab]25.10.16
```

Sie sehen: Da diese Zeile beim Setzen der Tabstopps ebenfalls markiert war, gelten die Positionen der Tabstopps auch hier.

Was jetzt natürlich noch fehlt, ist das heutige Datum. Dieses lassen wir TextMaker im nächsten Abschnitt automatisch einfügen und lernen dabei ein sehr praktisches Feature von TextMaker kennen: die *Felder*.

### Datum und andere Felder einfügen


Drücken Sie dazu hinter dem gerade Eingegebenen noch einmal die Tabulatortaste **Tab** und rufen Sie den Menübefehl **Einfügen > Feld** auf.
Das Dialogfenster von Einfügen > Feld

Wählen Sie in der Liste **Gruppe** das Feld "Druckdatum" aus. In der Liste **Datumsformat** können Sie bei Bedarf noch festlegen, in welcher Schreibweise das Datum eingefügt werden soll. Wählen Sie darin das gewünschte Format und klicken Sie auf **Einfügen**.

TextMaker fügt nun das aktuelle Datum in den Text ein, und unser Briefkopf sieht etwa folgendermaßen aus:
Felder sind ein sehr praktischer Helfer. Zum einen haben Sie sich gerade die Mühe erspart, das aktuelle Datum per Hand einzutippen. Darüber hinaus ist das Feld "Druckdatum" nicht einfach ein starrer Wert, sondern steht symbolisch für das aktuelle Datum. Es wird automatisch aktualisiert, wenn Sie das Dokument ausdrucken. Drucken Sie den Übungsbrief also morgen aus, erscheint an der gleichen Stelle das Datum von morgen.

Mit Hilfe von Feldern können Sie nicht nur das Datum einfügen, sondern zum Beispiel auch die aktuelle Seitennummer oder den Dateinamen Ihres Dokuments ausgeben lassen – und vieles mehr.

Weiterhin lassen sich über Felder Datenbankfelder aus einer Datenbank einsetzen, was beispielsweise für Serienbriefe benötigt wird.

**Fußzeilen**

Bevor Sie fortfahren, können Sie die Datei tour3.tmdx öffnen. Sie enthält den aktuellen Stand des Übungsdokuments.

Für jedes Dokument können Sie Kopf- und Fußzeilen einrichten – Kopfzeilen werden am Beginn und Fußzeilen am Ende jeder Seite gedruckt.

Für Fußzeilen rufen Sie den Menübefehl Einfügen > Fußzeile auf. Es passiert eigentlich nicht viel: die Schreibmarke wird in den unteren Seitenrand gesetzt. Das ist der Bereich, in den Sie Fußzeilen eingeben können.

Diesmal wählen wir schon vor dem Tippen die Schrift MicroSquare in 8 Punkt. Stellen Sie diese Schrift also mit Hilfe der Formatleiste ein. Wenn jetzt Text eingegeben wird, erscheint dieser gleich in der gewählten Schrift.

Tippen Sie als Fußzeile beispielsweise die Adresse unseres Architekturbüros ein. Darunter können Sie auch noch Dinge wie die Bankverbindung, Geschäftsführer, Handelsregistereintrag usw. angeben. Sie müssen sich natürlich nicht genau an das nachfolgende Beispiel halten, wenn Ihnen das zu viel Tipparbeit ist:

Architekturbüro Escher - Bauhausstraße 6 - 10719 Berlin - Telefon: 030/246810 - Telefax: 030/246811
Geschäftsführer M.C. Escher - AG Berlin HRB 0815

Zentrieren Sie die beiden Fußzeilen anschließend mit dem Symbol in der Formatleiste (die Fußzeilen vorher markieren!), so dass sich die Fußzeilen auf dem Bildschirm letztlich etwa folgendermaßen präsentieren:

Um nach dem Erstellen der Fußzeile wieder zurück in den normalen Text zu gelangen, klicken Sie mit der Maus einfach eine beliebige Position im Text an. Möchten Sie später die Fußzeilen erneut bearbeiten, genügt wiederum ein Mausklick auf eine der Fußzeilen.
Probieren Sie es aus: Klicken Sie im Text in die Zeile unter "Bringen Sie Ihre Familie einfach mit..." – schon sind Sie wieder im Text.

Bei dieser Gelegenheit können wir gleich die Grüßformel unter das Textende setzen. Fügen Sie dort mit . eine Leerzeile ein und tippen Sie:

```
Mit freundlichen Grüßen,
,
,
,
Architekturbüro Escher,
M.C. Escher,
```

Damit ist unser Brief eigentlich fertig. Im letzten Abschnitt möchten wir nur noch eine Linie über die Fußzeilen setzen, um diese besser abzuheben.

---

**Linien und Umrandungen**

*Hinweis:* Ausführlichere Informationen zu diesem Thema finden Sie im Abschnitt [Umrandung und Linien](#).


Um eine Umrandungslinie oberhalb der Fußzeile anzubringen, klicken Sie in die erste Zeile der Fußzeile und rufen dann den Menübefehl **Format > Umrandung** auf.

Es erscheint ein Dialogfenster, das etwa wie folgt aussieht:
Für die Bedienung dieses Dialogs gibt es eine einfache Regel: Erst auswählen, *was* für eine Art von Linie man möchte – dann bestimmen, *wo* diese Linie überall angebracht werden soll.

Um also eine einzelne Linie oberhalb des Absatzes anzubringen, gehen Sie wie folgt vor:

1. Wählen Sie zuerst aus, *welche* Art von Linie angebracht werden soll. Hierfür bietet der Dialog folgende Einstellmöglichkeiten:
   - **Linienstil** (einfache Linien, doppelte Linien oder gestrichelte Linien)
   - **Liniendicke** (die Stärke der Linie)
   - **Farbe** (die Farbe der Linie)

   In unserem Beispiel möchten wir folgende Art von Linie verwenden: eine einfache Linie, 1 pt dick, in der Farbe Schwarz.

   Wie praktisch: Genau diese Werte sind die Standardwerte und deshalb schon voreingestellt. Sie können den ersten Schritt hier also überspringen.


   Um eine Umrandungslinie anzubringen, klicken Sie einfach – direkt in dieser Vorschau – auf die entsprechende Linie.

   Alternativ können Sie hierfür auch die Schaltflächen um dieses Vorschaufeld herum verwenden. Jede Schaltfläche steht für eine bestimmte Linie, zu erkennen an dem Symbol auf der Schaltfläche.
Bringen Sie nun also eine Linie oberhalb des Absatzes an, indem Sie die oberste Linie in der Vorschau (oder die entsprechende Schaltfläche) anklicken.

Sie könnten nun noch weitere Umrandungslinien hinzufügen, indem Sie in der Vorschau auf weitere Linien klicken – aber wir benötigen in unserem Beispiel ja nur eine Linie oben.

3. Bestätigen Sie mit OK.

Der Absatz sollte nun mit einer dünnen schwarzen Linie über ihm versehen sein.

Auf die gleiche Weise lassen sich nicht nur Absätze in Fußzeilen, sondern auch normale Textabsätze mit Linien versehen. Auch bei einigen Arten von Objekten funktioniert dies – zum Beispiel bei Tabellenzellen.

Drucken des Übungsbriefs

Wenn Sie möchten, können Sie Ihr erstes Werk nun einmal zur Kontrolle auszudrucken. Rufen Sie dazu den Menübefehl Datei > Drucken auf.

![Druckfenster von Datei > Drucken](image)

In dem Dialogfenster "Drucken" können Sie unter anderem festlegen, wie viele Exemplare und welche Seiten gedruckt werden sollen. Standardmäßig wird das Dokument in einem Exemplar gedruckt. Bestätigen Sie also mit OK.

**Tipp:** Bevor Sie etwas tatsächlich ausdrucken, können Sie den Menübefehl Datei > Druckvorschau verwenden, um eine Vorschau des Ausdrucks auf dem Bildschirm zu erhalten. Dies erspart Ihnen unnötige Probedrucke.
Fertig!

Unsere TextMaker-Tour endet hier. Sie kennen jetzt viele grundlegende Funktionen des Programms und sollten sich erst einmal etwas Zeit nehmen, diese weiter zu erforschen.

Eine gute Übung wäre beispielsweise, den Brief anderes zu formatieren, mit schöneren Schriftarten zu versehen etc. Sie finden das fertige Beispieldokument unserer TextMaker-Tour übrigens in der Datei tour4.tmdx.

Anschließend können Sie sich mit dem Rest des Handbuchs beschäftigen. Dieses wurde bewusst so aufgebaut, dass Sie nur die Kapitel zu lesen brauchen, die Sie wirklich benötigen. So können Sie sich Schritt für Schritt in die Funktionen einarbeiten, mit denen Sie sich als nächstes befassen möchten.

In diesem Sinne: Viel Spaß mit TextMaker!
Arbeiten mit Markierungen


Im ersten Kapitel des Referenzteils geht es um das Arbeiten mit Markierungen. Wenn Sie einen Teil eines Dokuments nämlich löschen, kopieren oder verschieben möchten, dann müssen Sie den betreffenden Textabschnitt erst markieren. Dies gilt auch für Objekte (Grafiken, Zeichnungen etc.).

Weiterhin müssen Sie bei vielen Formatierungsbefehlern erst den zu ändernden Textabschnitt markieren. Markieren Sie beispielsweise ein Wort und wählen dann eine andere Schrift, wird nur dieses Wort in der anderen Schrift formatiert.

Ausführliche Informationen zum Arbeiten mit Markierungen finden Sie auf den nächsten Seiten. Folgende Themen werden darin behandelt:

- Markieren von Text und Objekten
- Verschieben, Löschen und Kopieren
- Inhalte einfügen
- Dokument einfügen

Markieren von Text und Objekten

Bei manchen TextMaker-Befehlen können Sie vor deren Ausführung einen Textabschnitt (oder ein Objekt) markieren. Der Befehl wird dann nur auf dieses Textstück beziehungsweise Objekt angewandt.

Je nachdem, unter welchem Betriebssystem Sie das Programm einsetzen, unterscheidet sich die Vorgehensweise zum Markieren etwas. Deshalb enthält dieser Abschnitt folgende zwei Teile:

- Markieren in der Windows-, Mac- oder Linux-Version
- Markieren in der Android-Version

Markieren in der Windows-, Mac- oder Linux-Version

In der Windows-, Mac- oder der Linux-Version von TextMaker können Sie folgendermaßen etwas markieren:

Markieren mit der Maus

Um etwas mit der Maus zu markieren, gehen Sie wie folgt vor:
Markieren von Text

Um einen Textabschnitt zu markieren, positionieren Sie den Mauszeiger am Beginn des zu markierenden Textes, drücken die linke Maustaste und ziehen die Maus (bei weiterhin gedrückter Maustaste) bis zum Ende des gewünschten Textabschnitts.

Um ein Wort zu markieren, führen Sie einen Doppelklick auf dieses Wort durch.

Um eine komplette Zeile zu markieren, klicken Sie links dieser Zeile in den linken Seitenrand. Wenn Sie die Maus im linken linken Seitenrand nach unten oder oben ziehen, können Sie auch mehrere Zeilen markieren.

Um einen kompletten Absatz zu markieren, führen Sie links von diesem Absatz einen Doppelklick im linken Seitenrand durch.

Um das gesamte Dokument zu markieren, halten Sie die Taste Strg gedrückt und klicken (bei einem beliebigen Absatz) in den linken Seitenrand.

Markieren von Objekten

Um ein Objekt (zum Beispiel eine Grafik oder Zeichnung) zu markieren, klicken Sie dieses mit der Maus an. Es erscheint dann ein Rahmen um das Objekt, um anzuzeigen, dass es nun markiert ist.

Markieren mit der Tastatur

Alternativ können Sie auch die Tastatur verwenden. Gehen Sie dabei wie folgt vor:

Markieren von Text

Bewegen Sie die Schreibmarke an den Beginn des zu markierenden Textes. Betätigen Sie dann die Umschalttaste, halten Sie diese gedrückt und bewegen Sie die Schreibmarke mit den Richtungstasten in eine beliebige Richtung.

So können Sie beispielsweise mit Umschalt+← und Umschalt+→ einzelne Zeichen markieren, mit Umschalt+Bild↑ oder Umschalt+Bild↓ ganze Bildschirmseiten auf einmal markieren etc.

Um das gesamte Dokument zu markieren, können Sie entsprechend erst die Tastenkombination Strg+Pos1 und dann Strg+Umschalt+Ende drücken. Das Gleiche erreichen Sie alternativ auch mit dem Menübefehl Bearbeiten > Alles markieren.

Markieren von Objekten

Objekte können nur mit der Maus markiert werden (siehe oben).

Markieren in der Android-Version

Auf Android-Geräten funktioniert das Markieren teilweise etwas anders. Sie können dabei wahlweise den Finger oder eine Maus verwenden. Gehen Sie wie folgt vor:

Markieren von Text

Das Markieren eines bestimmten Textabschnitts geht mit folgender Methode am einfachsten:

Tippen Sie doppelt auf das Wort, mit dem die Markierung beginnen soll. Das Wort sollte nun markiert sein. Sie erkennen das daran, dass große "Greifer" davor und dahinter erscheinen:
Arbeiten mit Markierungen

Diese Greifer stehen für den Anfang und das Ende der Markierung. Um die Markierung auf weiteren Text auszuweiten, ziehen Sie die beiden Greifer einfach an die gewünschten Positionen.

- Markieren von Objekten

Um ein Objekt (zum Beispiel eine Grafik oder Zeichnung) zu markieren, tippen Sie einfach darauf. Es erscheint dann ein Rahmen um das Objekt, um anzuzeigen, dass es nun markiert ist.

---

Verschieben, Löschen und Kopieren

Alle von TextMaker unterstützten Betriebssysteme verfügen über eine äußerst nützliche Einrichtung: die Zwischenablage.


Alle hierzu nötigen Befehle finden Sie im Menü Bearbeiten:

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kopieren</td>
<td>Der Menübefehl Bearbeiten &gt; Kopieren kopiert den Inhalt der Markierung in die Zwischenablage.</td>
</tr>
<tr>
<td>Einfügen</td>
<td>Um den Inhalt der Zwischenablage in den Text einzufügen, verwenden Sie den Menübefehl Bearbeiten &gt; Einfügen. Setzen Sie die Schreibmarke an die gewünschte Textstelle und rufen Sie diesen Befehl dann auf. Sie können den Inhalt der Zwischenablage auch mehrmals einfügen.</td>
</tr>
</tbody>
</table>

Dies funktioniert auf die gleiche Weise auch mit Objekten wie Grafiken oder Zeichnungen und für Tabelleninhalte, lesen Sie dazu auch den Abschnitt Tabelleninhalte löschen, kopieren, verschieben.

Verschieben und Kopieren von Text mit der Maus ("Drag and Drop")

**Hinweis:** Dieses Feature ist in der Android-Version nicht verfügbar.

Sie können Textabschnitte auch mit der Maus markieren und sie dann direkt an eine andere Stelle ziehen und dort ablegen. Mit dieser "Drag and Drop" ("Ziehen und Ablegen") genannten Technik lässt sich Text besonders schnell verschieben oder kopieren.
Arbeiten mit Markierungen

Gehen Sie dazu folgendermaßen vor:

1. Markieren Sie den Textabschnitt.
2. Zeigen Sie mit der Maus auf diese Markierung.
3. Drücken Sie die linke Maustaste und halten Sie diese gedrückt.
4. Ziehen Sie die Maus bei weiterhin gedrückter Maustaste an die gewünschte Zielstelle.
5. Wenn Sie nun die Maustaste loslassen, wird der Inhalt der Markierung an die Zielstelle verschoben.
   Tipp: Wenn Sie beim Loslassen der Maustaste die Taste Strg auf der Tastatur gedrückt halten, wird der Text nicht verschoben, sondern kopiert.

Inhalte einfügen


Hintergrund:

Wenn Sie mit den Befehlen Ausschneiden oder Kopieren Informationen in der Zwischenablage ablegen, werden diese dort in mehreren Formaten gleichzeitig gespeichert. Hatten Sie beispielsweise Text markiert, erscheint dieser in der Zwischenablage sowohl in formatierter Form als auch unformatiert.


Beim Aufruf dieses Befehls erscheint ein Dialogfenster mit einer Liste aller Formate, in denen die momentan in der Zwischenablage befindliche Information gespeichert ist. Wählen Sie ein Format aus und bestätigen Sie mit OK, wird der Inhalt der Zwischenablage im gewählten Format eingefügt.

Dokument einfügen

Mit dem Menübefehl Einfügen > Dokument können Sie ein komplettes TextMaker-Dokument in das aktuelle Dokument einfügen.

**Hinweis:** Objektrahmen (Textrahmen, Grafikrahmen etc.) werden dabei nicht importiert.

Gehen Sie folgendermaßen vor:

1. Setzen Sie die Schreibmarke, an die Stelle des Dokuments, an der das andere Dokument eingefügt werden soll.
2. Rufen Sie den Menübefehl Einfügen > Dokument auf.
3. Es öffnet sich ein Dialogfenster, in dem Sie das einzufügende Dokument auswählen.
4. Bestätigen Sie mit **OK**.

Das gewählte Dokument wird nun eingefügt.
Zeichenformatierung

Mit Hilfe des Menübefehls Format > Zeichen können Sie das Aussehen einzelner oder mehrerer Zeichen im Text ändern.

Das angezeigte Dialogfenster verfügt über mehrere Karteikarten, zwischen denen Sie wechseln können, indem Sie mit der Maus oben auf einen der Karteikartenreiter klicken:

- **Karteikarte Schrift**
  - Schriftart und -größe, Textauszeichnungen (z.B. fett, kursiv, unterstrichen), Farben und Sprache wählen
- **Karteikarte Abstand**
  - Hoch- und Tiefstellen, Laufweite und Zeichenbreite verändern und Kerning (Unterschneidung von Zeichen) ein-/ausschalten
- **Karteikarte Hyperlink**
  - Hyperlinks (Verknüpfungen) anbringen und bearbeiten. Informationen dazu finden Sie im Abschnitt Hyperlinks verwenden.

Zeichenformatierung ändern

Es gibt zwei Methoden, um die Zeichenformatierung zu ändern:
Zum nachträglichen Ändern der Zeichenformatierung markieren Sie den gewünschten Text, rufen den Menübefehl Format > Zeichen auf und nehmen die gewünschten Änderungen vor.

Um die Zeichenformatierung gleich beim Eintippen von neuem Text zu ändern, wählen Sie mit Format > Zeichen beispielsweise eine andere Schriftart und tippen dann einfach weiter. Text, den Sie jetzt eingeben, erscheint nun in der gewählten Schrift – bis Sie wieder eine andere Schrift wählen.

Ausführlichere Informationen zum Thema Zeichenformatierung folgen auf den nächsten Seiten.

### Schriftart und Schriftgröße

Um die Schriftart oder -größe von Text zu ändern, gehen Sie wie folgt vor:

1. Markieren Sie den gewünschten Text.

   **Android:** Falls Sie die Android-Version verwenden, beachten Sie bitte, dass das Markieren von Text dort etwas anders funktioniert. Siehe Abschnitt Markieren von Text und Objekten.

2. Rufen Sie den Menübefehl Format > Zeichen auf.
3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte Schrift, falls nötig.

   Nun können Sie die gewünschte Schriftart und -größe einstellen:

   - Um die **Schriftart** zu ändern, öffnen Sie die aufklappbare Liste **Schriftart** durch einen Mausklick auf das Pflechlein rechts daneben und wählen die gewünschte Schrift.
   
   - In der aufklappbaren Liste **Größe** werden die gebräuchlichsten **Schriftgrößen** angeboten. Sie können aber jederzeit andere Werte von Hand eingeben – Schriftgrößen wie 12,7 sind also auch zulässig.


### Verwenden der Formatleiste

Sie können die Schriftart und -größe auch über die Formatleiste ändern.

![Die Formatleiste](image)

Dazu markieren Sie den gewünschten Text, öffnen die aufklappbare Liste mit den Schriftarten beziehungsweise -größen in der Formatleiste und wählen darin die gewünschte Schriftart/-größe per Mausklick.

### Textauszeichnungen

Als **Textauszeichnungen** werden Zeichenformatierungen wie Fettdruck, Kursivschrift, Unterstreichen etc. bezeichnet.
Es gibt bei TextMaker folgende Textauszeichnungen:

- **Kursiv**: Eine schräg liegende Variante der Schrift.
- **Fett**: Eine kräftigere ("fettere") Variante der Schrift.
- **Unterstreichen**: Der Text wird unterstrichen (wahlweise einfach, doppelt, wortweise einfach, wortweise doppelt etc.).
- **Kapitälchen**: Anstelle von Kleinbuchstaben werden verkleinerte Großbuchstaben ausgegeben.
- **GROSSE BUCHSTABEN**: Alle Zeichen werden in Großbuchstaben ausgegeben.
- **Durchstreichen**: Der Text wird durchgestrichen.
- **Verborgen**: Der Text erscheint nicht mehr auf dem Bildschirm und/oder im Ausdruck (siehe Abschnitt Verbergen von Text).
- **Geschränkt**: Der Text kann nicht mehr editiert werden (siehe Abschnitt Schützen von Text).
- **Hochstellen** (z.B. r^2) und **Tiefstellen** (z.B. H_2O): Diese Textauszeichnungen sind auf der nächsten Karteikarte zu finden (siehe Abschnitt Hochstellen und Tiefstellen).
- **Schriftfarbe** und **Hintergrundfarbe**: Darüber hinaus lässt sich auch die Farbe von Text ändern (siehe nächstes Karteikarte).
- **Sprache**: Bei Bedarf können Sie außerdem die Sprache des Textabschnitts einstellen (nur erforderlich, wenn Sie mehrere Sprachen in einem Dokument verwenden – siehe Abschnitt Sprache einstellen).

### Anbringen von Textauszeichnungen

Um Text mit Textauszeichnungen zu versehen, gehen Sie wie folgt vor:

1. Markieren Sie den gewünschten Text.
2. Rufen Sie den Menübefehl Format > Zeichen auf.

Weitere Textauszeichnungen finden Sie in der Sektion **Auszeichnungen**. Diese lassen sich dort per einfachem Mausklick ein- oder ausschalten.

Textauszeichnungen können (nahezu) beliebig miteinander kombiniert werden.

### Verwenden der Formatleiste

Die gebräuchlichsten Textauszeichnungen lassen sich auch über die Formatleiste anbringen.

Klicken Sie dazu das Symbol für die Textauszeichnung an, die ein- oder ausgeschaltet werden soll: Das **F** steht für Fettdruck, das **K** für Kursivschrift und das **U** für einfaches Unterstreichen.

### Tastenkürzel

**Tipp**: Für einige Textauszeichnungen sind außerdem Tastenkürzel verfügbar:
### Schriftfarbe

Sie können sowohl den Text selbst als auch seinen Hintergrund einfärben.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie den gewünschten Text.
2. Rufen Sie den Menübefehl **Format > Zeichen** auf.
3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte **Schrift**, falls nötig. In der Liste **Schriftfarbe** können Sie nun die gewünschte Farbe für den Text auswählen.

Über die Liste **Hintergrundfarbe** können Sie außerdem die Hintergrundfarbe ändern. Wählen Sie hier anstelle der Standardeinstellung **Transparent** eine andere Farbe, wird der Text mit dieser Farbe hinterlegt.

### Anmerkungen


- Die Standardfarbe namens "Auto" hat ein besonderes Feature: Text, der in dieser Farbe formatiert ist, wird normalerweise in Schwarz dargestellt. Setzen Sie die Hintergrundfarbe des Textes jedoch auf eine sehr dunkle Farbe, wechselt diese Farbe automatisch zu Weiß (damit der Text auch weiterhin lesbar bleibt).

- Die Schriftfarbe lässt sich auch über das Symbol 🔄 in der **Formatleiste** ändern:

  Dazu markieren Sie den gewünschten Text, klicken auf das Pfeilchen rechts neben diesem Symbol (also nicht auf das Symbol selbst). Dann wählen Sie die gewünschte Farbe aus der Liste, die sich daraufhin öffnet.

  Tipp: Um weiteren Text in der gleichen Farbe zu formatieren, markieren Sie diesen und klicken dann einfach auf das Symbol selbst.

- Rechts neben dem Symbol für die Schriftfarbe bietet die Formatleiste außerdem ein Symbol für die **Textmarker**-Funktion an. Dieses Symbol funktioniert genauso, versieht den markierten Text allerdings mit einem farbigen Hintergrund – genau wie ein Textmarker.

  Hinweis: Hierbei handelt es sich nicht um die oben erwähnte Hintergrundfarbe, sondern um eine zusätzliche Farbe (die nur über diese aufklappbare Liste angebracht werden kann). Dies ist nicht unbedingt logisch, aber Microsoft Word bietet dieses Feature auf genau diese Weise an, weshalb es aus Kompatibilitätsgründen in TextMaker genauso implementiert wurde.
Hochstellen und Tiefstellen

Sie können Text hochstellen (z.B. $r^2$) oder tiefstellen (z.B. $\text{H}_2\text{O}$).

Dazu markieren Sie den Text, rufen den Menübefehl Format > Zeichen auf, wechseln auf die Karteikarte Abstand und schalten Hochstellen beziehungsweise Tiefstellen ein.

Auf Wunsch lässt sich zusätzlich bei Position angeben, um wie viel Prozent der Text hoch- beziehungsweise tiefgestellt werden soll. Weiterhin können Sie durch eine Prozentangabe im Feld Größe bestimmen, wie stark die Schriftgröße vermindert werden soll. Geben Sie beispielsweise 100 Prozent ein, wenn die Schrift nicht verkleinert werden soll.

Laufweite und Zeichenbreite

Sie können bei Bedarf auch die Laufweite und die Zeichenbreite von Text ändern.

Die Laufweite bezeichnet den Abstand zwischen den Zeichen. Bei Werten kleiner als 100% rutschen die Zeichen enger zusammen, bei Werten größer als 100% weiter auseinander.

Wenn Sie die Zeichenbreite ändern, wird nicht der Abstand zwischen den Zeichen, sondern die Breite der Zeichen selbst verändert – die Zeichen werden also verzerrt.

Um diese Einstellungen zu ändern, rufen Sie den Menübefehl Format > Zeichen auf, wechseln auf die Karteikarte Abstand und tragen die gewünschten Werte bei Laufweite beziehungsweise Zeichenbreite ein.

Hinweis: Manche Drucker unterstützen das Ändern der Zeichenbreite bei druckerinternen Schriften nicht. Die Schrift erscheint dann zwar auf dem Bildschirm breiter oder schmaler, nicht jedoch im Ausdruck.

Kerning (Unterschneidung)


Die folgende Abbildung illustriert, was gemeint ist:
Zeichenformatierung

Beim oberen Text (ohne Kerning) sieht man, dass die Buchstaben "V" und "A" normalerweise zu weit aus-einander stehen. Beim unteren Text (mit Kerning) wurde dies korrigiert.

Dieser Ausgleich findet vollautomatisch statt. Sie müssen das Kerning lediglich aktivieren. Dazu markieren Sie den gewünschten Text, rufen den Menübefehl Format > Zeichen auf, wechseln auf die Karteikarte Abstand und schalten die Option Kerning verwenden ein.

TextMaker korrigiert dann selbstständig den Zeichenabstand von allen Buchstabenpaaren, bei denen dies zu einer Verbesserung des Schriftbilds führt.


Format übertragen

Mit dem Menübefehl Format > Format übertragen können Sie das Zeichenformat (Schriftart und -größe, Textauszeichnungen etc.) von einem Zeichen blitzschnell auf andere Zeichen übertragen.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie zuerst das Zeichen, dessen Zeichenformat Sie übertragen möchten. Sie können auch meh-rere Zeichen selektieren; diese sollten jedoch alle das gleiche Zeichenformat haben.

2. Rufen Sie den Menübefehl Format > Format übertragen auf.
   Der Mauszeiger ändert sich daraufhin zu einem Pinsel: 

3. Ziehen Sie die Maus nun bei gedrückter Maustaste über alle Zeichen, auf die das Format übertragen wer-den soll.
   Tipp: Wenn Sie dabei die Taste Strg gedrückt halten, wird nicht nur das Zeichenformat, sondern auch das Absatzformat übertragen.

4. Falls Sie das Format noch auf weitere Textstücke übertragen möchten, wiederholen Sie Schritt 3. belie-big oft.

5. Wenn Sie fertig sind, rufen Sie den Menübefehl Format > Format übertragen erneut auf oder drücken einfach die Taste Esc.
Verbergen von Text

Sie können Textabschnitte bei Bedarf verbergen. Verborgener Text wird normalerweise nur auf dem Bildschirm angezeigt, aber nicht ausgedruckt.

Anwendungsgebiet: Verborgener Text ist ideal, um Anmerkungen oder Notizen im Dokument unterzubringen, die beispielsweise nur auf dem Bildschirm zu sehen sein sollen, nicht jedoch im Ausdruck.

Text verbergen

Um Text zu verbergen, gehen Sie wie folgt vor:
1. Markieren Sie den gewünschten Text.
2. Rufen Sie den Menübefehl Format > Zeichen auf.
3. Wechseln Sie auf die Karteikarte Schrift.
4. Schalten Sie die Option Verborgen ein.

Der Text ist nun verborgen. Er erscheint normalerweise zwar auf dem Bildschirm, nicht jedoch im Ausdruck.

Verborgenen Text anzeigen/drucken

Standardmäßig ist verborgener Text zwar auf dem Bildschirm zu sehen, er erscheint jedoch nicht im Ausdruck. Über die Dokumenteigenschaften können Sie jedoch selbst bestimmen, ob verborgene Textabschnitte tatsächlich sichtbar sein sollen und ob sie ausgedruckt werden.

Rufen Sie dazu den Menübefehl Datei > Eigenschaften auf und wechseln Sie auf die Karteikarte Ansicht. In der Rubrik Verborgener Text finden Sie folgende Optionen:

- **Verborgenen Text anzeigen**
  Diese Option bestimmt, ob verborgener Text auf dem Bildschirm angezeigt werden soll.
  Standardmäßig ist sie eingeschaltet. Verborgener Text ist also sichtbar. Zur Kenntlichmachung, dass es sich um verborgenen Text handelt, wird er mit einer gepunkteten Unterstreichung dargestellt.
  Schalten Sie die Option aus, wird der verborgene Text auf dem Bildschirm unsichtbar.

- **Verborgenen Text drucken**
  Die Option Verborgenen Text drucken bestimmt, ob verborgener Text beim Drucken des Dokuments ausgegeben werden soll.
  Standardmäßig ist diese Option ausgeschaltet. Verborgener Text ist im Ausdruck also nicht zu sehen.
  Möchten Sie, dass auch alle verborgenen Textabschnitte gedruckt werden, müssen Sie diese Option einschalten.

Die Formatierung "Verborgen" wieder entfernen

Möchten Sie die Formatierung Verborgen wieder aufheben, gehen Sie folgendermaßen vor:
1. Stellen Sie sicher, dass die Option **Verborgenen Text anzeigen** in den Dokumenteigenschaften eingeschaltet ist (siehe oben), damit Sie den Text sehen können.

2. Markieren Sie den verborgenen Text, rufen Sie den Menübefehl **Format > Zeichen** auf und schalten Sie die Option **Verborgen** auf der Karteikarte **Schrift** wieder aus. Der Text ist nun nicht mehr verborgen.

---

**Schützen von Text**

Sie können einen Textabschnitt *schützen*, um zu verhindern, dass er verändert oder gelöscht werden kann.

**Text schützen**

Um Text zu schützen, gehen Sie wie folgt vor:

1. Markieren Sie den gewünschten Text.
2. Rufen Sie den Menübefehl **Format > Zeichen** auf.
3. Wechseln Sie auf die Karteikarte **Schrift**.
4. Schalten Sie die Option **Geschützt** ein. Der betreffende Text kann nun nicht mehr editiert werden. Wenn Sie die Schreibmarke in diesen Text setzen und versuchen, etwas einzugeben oder zu löschen, hat dies keinerlei Wirkung.

**Wichtiger Hinweis:** Wenn Sie einen ungeschützten Textbereich markieren, der einen geschützten Textabschnitt enthält, lässt sich dieser dennoch löschen! Es wird nur das Editieren und Löschen innerhalb des geschützten Textes verhindert.

**Die Formatierung "Geschützt" wieder entfernen**

Um das Attribut "Geschützt" wieder zu entfernen, markieren Sie den geschützten Textabschnitt, rufen den Menübefehl **Format > Zeichen** erneut auf und schalten die Option **Geschützt** auf der Karteikarte **Schrift** wieder aus.

Der Text ist nun nicht mehr geschützt, kann also wieder normal editiert werden.

---

**Zeichenformatierung zurücksetzen**

Einmal angebrachte Zeichenformatierungen lassen sich jederzeit wieder entfernen.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie den betreffenden Textabschnitt.
2. Rufen Sie den Menübefehl **Format > Standard** auf.
TextMaker entfernt nun alle Zeichenformatierungen, die Sie manuell an diesem Textabschnitt angebracht haben.

Absatzformatierungen oder die Zeichenformatierung aus Absatzvorlagen bleiben hingegen erhalten.

**Hinweis:** Auch die Zeichenformatierungen *Verborgen* und *Geschützt* werden hierbei entfernt. Verborgener Text wird also wieder sichtbar, und geschützter Text lässt sich wieder editieren.

---

### Standard-Zeichenformatierung ändern

Die Standardeinstellungen für die Zeichenformatierung lassen sich jederzeit ändern. Dies ermöglicht Ihnen, beispielsweise eine andere Schriftart als Standardschrift festzulegen.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl **Format > Zeichen** auf.
2. Stellen Sie in dem Dialog das Zeichenformat (Schriftart, Schriftgröße etc.) ein, das Sie als neue Standardeinstellung speichern möchten.
3. Jetzt kommt der entscheidende Schritt: Klicken Sie nicht auf **OK**, sondern auf die Schaltfläche **Als Standard verwenden**.
4. TextMaker fragt nach, ob Sie die Standardeinstellungen nur für das aktuelle Dokument oder für alle Dokumente ändern möchten:
   - **Nur in diesem Dokument ändern:** Wenn Sie diese Option wählen, gilt die Änderung nur im aktuellen Dokument.
   - **Für alle neuen Dokumente ändern:** Wenn Sie diese Option wählen, wird die Änderung nicht nur im aktuellen Dokument durchgeführt, sondern auch in der Standard-Dokumentvorlage (Normal.tmvx). Das bewirkt, dass künftig *alle* Dokumente, die Sie neu anlegen, diese Einstellungen verwenden.
5. Treffen Sie eine Wahl und bestätigen Sie mit **OK**.

Die Standardeinstellungen für die Zeichenformatierung wurden nun entsprechend geändert.

*(Anmerkung für fortgeschrittene Anwender: Technisch gesehen passiert hierbei nichts anderes, als dass TextMaker diese Einstellung auf die Zeichenvorlage "Normal" anwendet. Siehe auch Abschnitt **Zeichenvorlage Normal**)*
Absatzformatierung

Mit dem Menübefehl Format > Absatz bestimmen Sie die Absatzformatierung von Absätzen.

Zu den gebräuchlichsten Absatzformatierungen gehören:

- Einzüge
- Zeilenabstand
- Abstände oberhalb/unterhalb eines Absatzes
- Absatzausrichtung
- Zeichenformat gesamter Absätze ändern
- Tabulatoren

Darüber hinaus bietet TextMaker folgende erweiterte Absatzformatierungen:

- Aufzählungen mit Bullets (oder Nummerierungen)
- Initialen
- Schattierung
- Umrandung und Linien
- Gliederungsebene
- Trennhäufigkeit der Silbentrennung (siehe Abschnitt Silbentrennung)
- Umbruch vor dem Absatz erzwingen (Seitenumbruch, Spaltenumbruch)
- Typografie (bestimmte Absätze zusammenhalten etc.)
- Zeilennummern unterdrücken

Details dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Absatzformatierungen beziehen sich immer auf komplette Absätze. Befindet sich die Schreibmarke also in einem bestimmten Absatz, wirken sich Änderungen an der Absatzformatierung immer auf den gesamten Absatz aus. Markieren Sie mehrere Absätze, sind alle markierten Absätze betroffen.

Ändern der Absatzformatierung

Sie können die Absatzformatierung auf zwei unterschiedliche Methoden ändern:

- Zum nachträglichen Ändern der Absatzformatierung markieren Sie die betreffenden Absätze, rufen den Menübefehl Format > Absatz auf und nehmen die gewünschten Änderungen vor.

- Um die Absatzformatierung gleich beim Eintippen von neuem Text zu ändern, stellen Sie mit dem Menübefehl Format > Absatz die gewünschte Formatierung ein, ohne zuvor etwas zu markieren. Der aktuelle Absatz wird nun entsprechend umformatiert. Weiterhin wird jeder neue Absatz, den Sie nun mit der Eingabetaste \( \text{J} \) beginnen, genauso formatiert – solange, bis Sie die Absatzformatierung erneut ändern.
Absatzvorlagen (für fortgeschrittene Anwender): Eine besondere Arbeitserleichterung bei der Absatzformatierung sind die Absatzvorlagen. Mit deren Hilfe können Sie Absätzen blitzschnell eine zuvor definierte Absatzformatierung zuweisen. Informationen dazu finden Sie im Kapitel Formatvorlagen.

Maßeinheiten: In den Dialogen von TextMaker lassen sich Werte nicht nur in Zentimetern, sondern auch in anderen Maßeinheiten angeben. Tippen Sie dazu hinter der Zahl einfach eine der folgenden Maßeinheitenein:

<table>
<thead>
<tr>
<th>Einheit</th>
<th>Bemerkung</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm</td>
<td>Zentimeter</td>
</tr>
<tr>
<td>in</td>
<td>Inch (Zoll) – 1 in entspricht 2,54 cm.</td>
</tr>
<tr>
<td>pt</td>
<td>Punkt – 72 pt entsprechen 1 in.</td>
</tr>
<tr>
<td>pi</td>
<td>Pica (Zeichen)</td>
</tr>
</tbody>
</table>

Tippen Sie als Position für einen Tabulator also beispielsweise "3 in" ein, weiß TextMaker, dass 3 Zoll (7,62 cm) gemeint sind.

### Einzüge

Mit Hilfe von Einzügen können Sie den linken und rechten Rand von Absätzen vorübergehend ändern, um Text ein- oder auszurücken. Der Einzug für die erste Zeile eines Absatzes lässt sich dabei getrennt einstellen.

Einzüge werden immer relativ zu den Seitenrändern angegeben. Wenn der linke Seitenrand beispielsweise auf 2 cm gesetzt ist und Sie den Einzug Von links auf 3 cm setzen, beginnt der Text bei 5 cm.

**Hinweis:** Die Seitenränder selbst stellen Sie nicht über Einzüge, sondern mit Hilfe des Menübefehls Datei > Seite einrichten ein.

Um Einzüge zu verwenden, setzen Sie die Schreibmarke in den gewünschten Absatz oder markieren mehrere Absätze. Dann rufen Sie den Menübefehl Format > Absatz auf und wechseln auf die Karteikarte Absatz.


Sie können auch negative Werte eingeben, wenn Sie Text beispielsweise nicht ein-, sondern ausrücken möchten.

### Verwenden der Linealleiste

Mit der Maus können Sie Einzüge auch direkt in der Linealleiste ändern, die über dem Dokument angezeigt wird (sofern sie nicht mit dem Menübefehl Ansicht > Linealleiste ausgeblickt wurde).

Absatzformatierung

Die Linealleiste (Greifer für Einzüge eingefärbt)

Um einen Einzug zu ändern, ziehen Sie einfach den entsprechenden Greifer (siehe Abbildung) bei gedrückter Maustaste an die gewünschte Position.


Tastenkürzel

Sie können auch die Tastatur verwenden, um Einzüge zu vergrößern oder zu verkleinern. Es gibt hierfür folgende Tastenkürzel:

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Windows/Linux</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Einzug Von links vergrößern</td>
<td>Strg+M</td>
<td>Cmd+M</td>
</tr>
<tr>
<td>Einzug Von links verkleinern</td>
<td>Strg+Umschalt+M</td>
<td>Cmd+Umschalt+M</td>
</tr>
<tr>
<td>Hängenden Einzug* vergrößern</td>
<td>Strg+T</td>
<td>Cmd+T</td>
</tr>
<tr>
<td>Hängenden Einzug* verkleinern</td>
<td>Strg+Umschalt+T</td>
<td>Cmd+Umschalt+T</td>
</tr>
</tbody>
</table>


Zeilenabstand

Der Zeilenabstand bestimmt den Abstand zwischen den einzelnen Zeilen eines Absatzes.

Um den Zeilenabstand zu verändern, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke in den gewünschten Absatz (oder markieren Sie mehrere Absätze).
2. Rufen Sie den Menübefehl Format > Absatz auf.
3. Wechseln Sie auf die Karteikarte Absatz.

   Die Optionen zum Ändern des Zeilenabstands finden Sie in der Rubrik Zeilenabstand:

5. Tragen Sie dann rechts daneben das gewünschte Maß ein.

Wenn Sie mit OK bestätigen, wird der Zeilenabstand entsprechend geändert.
Methoden zum Festlegen des Zeilenabstands

In der aufklappbaren Liste **Zeilenabstand** können Sie dabei wählen, welche Methode zum Festlegen des Zeilenabstands verwendet werden soll.

Die Liste hat folgende Einträge:

- **Einfach**
  Einfacher automatischer Zeilenabstand.
  
  Hier wird der optimale Zeilenabstand *automatisch* ermittelt:
  
  Wenn Sie beispielsweise die Schriftgröße in dem Absatz erhöhen, wird auch der Zeilenabstand entsprechend vergrößert.

  Reduzieren Sie die Schriftgröße, wird der Zeilenabstand hingegen automatisch verkleinert.

- **Mehrfach**
  Mehrfacher automatischer Zeilenabstand.

  Entspricht der Option **Einfach**, liefert also ebenfalls einen automatischen Zeilenabstand. Allerdings können Sie diesen bei Bedarf einfach vergrößern oder verkleinern, indem Sie in dem Eingabefeld rechts von dieser Option die gewünschte Anzahl an Zeilen angeben.

  Beispiele:

  Tragen Sie bei **Zeilen** "1,5" ein, um anderthalbfachen automatischen Zeilenabstand zu erhalten.

  Tragen Sie "2" ein, um zweifachen automatischen Zeilenabstand zu erhalten.

  Tragen Sie "1" ein, um einfachen automatischen Zeilenabstand zu erhalten (entspricht dem Wählen der Option **Einfach**).

- **Genau**
  Fester Zeilenabstand.

  Hier können Sie den Zeilenabstand auf einen *festen* Wert in Punkt setzen. Der Zeilenabstand wird dann **nicht** mehr automatisch an die Schriftgröße angepasst.

  Tipp: Die Faustregel für einen optisch ansprechenden Zeilenabstand lautet:

  \[
  \text{Zeilenabstand} = \text{Schriftgröße} \times 1,2
  \]

  Bei einer 10 Punkt-Schrift wäre also in der Regel ein Zeilenabstand von etwa 12 Punkt angebracht.

- **Mindestens**
  Mindest-Zeilenabstand.

  Diese Einstellung entspricht der Option **Einfach**, verhindert jedoch, dass der angegebene Mindestwert unterschritten wird.

  Tragen Sie als Mindestwert also 12 Punkt ein, verwendet das Programm normalerweise einen einfachen automatischen Zeilenabstand. Unterschriften dieser jedoch 12 Punkt (weil Sie eine sehr kleine Schrift verwenden), wird stattdessen ein fester Zeilenabstand von 12 Punkt verwendet.

  Standardmäßig ist der Zeilenabstand auf **Einfach** gesetzt.
Absatzformatierung

Tastenkürzel

Tipp: Für die gebräuchlichsten Einstellungen gibt es hierbei folgende Tastenkürzel:

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Windows/Linux</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Einfacher automatischer Zeilenabstand (1 Zeile)</td>
<td>Strg+1</td>
<td>Cmd+1</td>
</tr>
<tr>
<td>Anderthalbfacher automatischer Zeilenabstand (1,5 Zeilen)</td>
<td>Strg+5</td>
<td>Cmd+5</td>
</tr>
<tr>
<td>Zweifacher automatischer Zeilenabstand (2 Zeilen)</td>
<td>Strg+2</td>
<td>Cmd+2</td>
</tr>
</tbody>
</table>

Abstände oberhalb/unterhalb eines Absatzes

Neben dem Zeilenabstand können Sie auch festlegen, wie viel Platz oberhalb der ersten Zeile und unterhalb der letzten Zeile eines Absatzes freigehalten werden soll.

Um diese Einstellung zu ändern, rufen Sie den Menübefehl Format > Absatz auf und wechseln auf die Karteikarte Absatz.

In der Rubrik Abstände finden Sie dazu folgende Optionen:

**Oberhalb**

Hier können Sie den Abstand einstellen, der oberhalb eines Absatzes freigehalten werden soll.

Genauer gesagt legen Sie damit den Abstand zwischen der letzten Zeile des vorherigen Absatzes und der ersten Zeile des aktuellen Absatzes fest.

**Unterhalb**

Hier können Sie den Abstand unterhalb eines Absatzes einstellen.

Genauer gesagt legen Sie damit den Abstand zwischen der letzten Zeile des aktuellen Absatzes und der ersten Zeile des nächsten Absatzes fest.

**Bei Absätzen mit der gleichen Absatzvorlage unterdrücken**

Diese Option wurde in erster Linie aus Gründen der Kompatibilität zu Microsoft Word implementiert, wo es diese ebenfalls gibt.

Wenn Sie die Option einschalten, hat das folgende Auswirkungen:

- Falls der aktuelle Absatz und der vorherige Absatz die gleiche Absatzvorlage verwenden, wird der Abstand Oberhalb automatisch unterdrückt.
- Falls der aktuelle Absatz und der nächste Absatz die gleiche Absatzvorlage verwenden, wird der Abstand Unterhalb automatisch unterdrückt.

Standardmäßig ist diese Option ausgeschaltet.
Absatzformatierung

Absatzausrichtung

Textabsätze können auf folgende Arten ausgerichtet sein:

- Linksübündig
- Zentriert
- Rechtsübündig
- Blocksatz (hier werden die Wörter gleichmäßig auf den zur Verfügung stehenden Platz verteilt)

Um die Absatzausrichtung von Absätzen zu ändern, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke in den gewünschten Absatz (oder markieren Sie mehrere Absätze).
2. Rufen Sie den Menübefehl **Format > Absatz** auf.
3. Wechseln Sie auf die Karteikarte **Absatz**.
4. Wählen Sie die gewünschte Ausrichtung in der Liste **Ausrichtung**.

Wenn Sie mit **OK** bestätigen, wird die Absatzausrichtung entsprechend geändert.

Verwenden der Formatleiste

Sie können die Absatzausrichtung auch mit Hilfe der Formatleiste ändern. Klicken Sie dazu auf eine der folgenden Schaltflächen:

- Linksübündig
- Zentriert
- Rechtsübündig
- Blocksatz

Tastenkürzel

Tipp: Es gibt außerdem folgende Tastaturkürzel zum Ändern der Absatzausrichtung:

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Windows/Linux</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linksübündig</td>
<td>Strg+L</td>
<td>Cmd+L</td>
</tr>
<tr>
<td>Zentriert</td>
<td>Strg+E</td>
<td>Cmd+E</td>
</tr>
<tr>
<td>Rechtsübündig</td>
<td>Strg+R</td>
<td>Cmd+R</td>
</tr>
<tr>
<td>Blocksatz</td>
<td>Strg+J</td>
<td>Cmd+J</td>
</tr>
</tbody>
</table>
Zeichenformat gesamter Absätze ändern

Im Dialogfenster des Menübefehls **Format > Absatz** finden Sie auf der Karteikarte **Absatz** auch eine Schaltfläche namens **Zeichen**. Mit deren Hilfe können Sie die Zeichenformatierung (Schriftart, Textauszeichnungen etc.) für komplette Absätze ändern. Dies ist besonders nützlich bei Formatvorlagen (näheres dazu im Abschnitt **Absatzvorlagen**).

Um die Zeichenformatierung ganzer Absätze zu ändern, markieren Sie die gewünschten Absätze, rufen den Menübefehl **Format > Absatz** auf und klicken auf diese Schaltfläche. Es erscheint ein Dialogfenster, das dem des Menübefehls **Format > Zeichen** entspricht (Beschreibung siehe Kapitel **Zeichenformatierung**).

Tabulatoren


Um mit Tabulatoren zu arbeiten, sind zwei Schritte erforderlich:

1. Zuerst setzen Sie über den Menübefehl **Format > Tabulator"Tabstopps". Dadurch legen Sie fest, an welchen Positionen sich Tabulatoren befinden sollen.
2. Ist das erledigt, können Sie im Text jederzeit die Tabulatorleiste **Tab** verwenden, um Tabulatoren einzufügen – sprich: um die Schreibmarke auf den jeweils nächsten Tabstopp springen zu lassen.

Ausführlichere Informationen zum Arbeiten mit Tabulatoren finden Sie auf den nächsten Seiten.

Tabulatoren verwenden

Standardmäßig sind Tabstopps für alle 1,25 cm voreingestellt. Diese voreingestellten Tabstopps sind allerdings nur ein Relikt aus der Schreibmaschinenzeit, und Sie sollten die Möglichkeit wahrnehmen, eigene Tabstopps zu setzen.

Nachdem Tabulatoren zu den Absatzformatierungen zählen, können Sie für jeden Absatz des Dokuments andere Tabstopps setzen.

Um Tabstopps zu setzen, gehen Sie folgendermaßen vor:

1. Setzen Sie die Schreibmarke in den gewünschten Absatz (oder markieren Sie mehrere Absätze).
2. Rufen Sie den Menübefehl **Format > Tabulator** auf.
3. Geben Sie unter **Tabulator** die gewünschte Position relativ zum linken Seitenrand ein – der linke Seitenrand entspricht also "0".

4. Wählen Sie gegebenenfalls eine andere **Ausrichtung** und ein anderes **Füllzeichen** für den Tabulator (siehe unten).

5. **Nicht vergessen:** Klicken Sie auf die Schaltfläche **Setzen**.

6. Richten Sie bei Bedarf auf die gleiche Art weitere Tabstopps ein, bevor Sie das Dialogfenster mit **OK** verlassen.

Sind einmal Tabstopps gesetzt, können Sie die Tabulatorfunktion **Tab** verwenden, um im Text einen Tabulator bis zum jeweils nächsten Tabstopp einzufügen.

Über den Wert **Standardbreite** können Sie in dem Dialog außerdem festlegen, welchen Abstand die eingangs erwähnten vordefinierten Tabstopps voneinander haben sollen (normalerweise 1,25 cm). Wenn Sie in einem Absatz jedoch eigene Tabulatoren definieren, werden die vordefinierten Tabulatoren außer Kraft gesetzt.

**Tabulatorausrichtung**

Mit der Option **Ausrichtung** in obigem Dialog können Sie die Ausrichtung eines Tabstopps bestimmen.

Verfügbare Optionen:

<table>
<thead>
<tr>
<th>Ausrichtung</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Links</td>
<td>Ein normaler &quot;linksbündiger&quot; Tabstopp. Der Tabstopp bestimmt hier also, wo der nachfolgende Text beginnt.</td>
</tr>
<tr>
<td>Zentriert</td>
<td>Der Text hinter dem Tabulator wird zentriert an der Tabulatorposition ausgerichtet. Der Tabstopp bestimmt also die Mitte des Textes.</td>
</tr>
<tr>
<td>Rechts</td>
<td>Hier wird der Text hinter dem Tabulator rechtsbündig ausgerichtet. Der Tabstopp bestimmt also, wo dieser Text endet.</td>
</tr>
</tbody>
</table>
Dezimal

Für das Schreiben von Zahlenkolonnen. Zahlen werden so ausgerichtet, dass ihre Dezimalkommas bündig untereinander stehen.

Tipp: Um die Ausrichtung eines vorhandenen Tabstopps zu ändern, rufen Sie den Menübefehl Format > Tabulator auf. Selektieren Sie dann einen der gesetzten Tabstopps, ändern Sie dessen Ausrichtung in der Liste Ausrichtung und klicken Sie auf Setzen.

Tabulatorfüllzeichen

Mit der Option Füllzeichen können Sie außerdem ein Füllzeichen für einen Tabstopp festlegen. Dieses wird dann verwendet, um den Raum auszufüllen, den der Tabulator überspringt.

Verfügbare Optionen:

Keines Tabulator ohne Füllzeichen
Unterstriche _____ Tabulator mit Unterstrichen als Füllzeichen
Bindestriche ------- Tabulator mit Bindestrichen als Füllzeichen
Punkte ................. Tabulator mit Punkten als Füllzeichen (wird häufig in Inhalts- und Stichwortverzeichnissen verwendet)
Punkte (mittig) ····· Tabulator mit mittigen Punkten als Füllzeichen

Tipp: Um einen bereits vorhandenen Tabstopp mit einem Füllzeichen zu versehen, rufen Sie den Menübefehl Format > Tabulator auf. Selektieren Sie dann einen der gesetzten Tabstopps, wählen Sie in der Liste Füllzeichen das gewünschte Zeichen und klicken Sie auf Setzen.

Tabstopps löschen und verschieben

Einmal angelegte Tabstopps können jederzeit nachträglich verändert werden: Markieren Sie dazu die Absätze, deren Tabstopps bearbeitet werden sollen, und rufen Sie den Menübefehl Format > Tabulator auf.


Verwendung der Linealleiste

In der horizontalen Linealleiste werden alle im aktuellen Absatz gesetzten Tabstopps angezeigt.

Die horizontale Linealleiste (nach dem Setzen einiger linksbündiger Tabulatoren)
Tabstopp lassen sich über diese Leiste aber auch bequem setzen, verschieben und löschen.

Um einen Tabulator zu setzen, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke in den gewünschten Absatz (oder markieren Sie mehrere Absätze).

2. Wählen Sie den gewünschten Tabulatortyp.

   Klicken Sie dazu auf das Symbol links vom horizontalen Lineal. Mit jedem Mausklick auf das Symbol wechselt der Tabulatortyp:

   - Linksabhängiger Tabulator
   - Zentrierter Tabulator (Text wird an der Tabulatorposition zentriert)
   - Rechtsabhängiger Tabulator (Text endet an der Tabulatorposition)
   - Dezimaltabulator (Zahlen werden am Dezimalkomma ausgerichtet)


Um einen Tabstopp zu verschieben, klicken Sie ihn in der Linealleiste mit der Maus an und ziehen ihn bei weiterhin gedrückter Maustaste an eine andere Position.

Um einen Tabstopp zu löschen, ziehen Sie ihn nach unten aus der Linealleiste heraus.

---

**Aufzählungen mit Bullets**

Aufzählungen, bei denen jeder Aufzählungspunkt in einem eigenen Absatz steht und mit einem Aufzählungszeichen versehen ist, sind meist übersichtlicher als durch Kommata getrennte Aufzählungen.

Solche Aufzählungszeichen (in der Regel kleine Klötzchen, Kreise, Pfeilchen etc.) bezeichnet man als *Bullets*.

Das Anlegen von Aufzählungen mit Bullets ist für TextMaker-Anwender ein Leichtes: TextMaker kann Absätze auf Knopfdruck mit Bullets versehen und automatisch einrücken.
Sie können sogar Aufzählungen erstellen, bei denen statt Bullets Nummern angebracht sind. Die Absätze werden dabei automatisch mit 1., 2., 3. etc. durchnummeriert. Informationen dazu finden Sie im Kapitel Automatische Nummerierung.

**Bullets anbringen**

Um eine Aufzählung mit Bullets zu beginnen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Format > Bullets und Nummerierungen auf.
2. Wechseln Sie auf die Karteikarte Bullets und einfache Nummerierungen.
3. Wählen Sie bei Typ die Option Bullet.

5. Bestätigen Sie mit OK.


**Aufzählung beenden oder Bullets entfernen**

Um die Aufzählung zu beenden oder vorhandene Bullets wieder zu entfernen, schalten Sie die Bullets folgendermaßen wieder ab:

1. Drücken Sie am Ende des letzten Absatzes der Aufzählung die Eingabetaste, um einen neuen Absatz zu beginnen.
   
   **Oder:** Markieren Sie alle Absätze der Aufzählung, falls Sie die Bullets für diese Absätze wieder komplett entfernen möchten.

2. Rufen Sie den Menübefehl Format > Bullets und Nummerierungen auf.

3. Wechseln Sie auf die Karteikarte Bullets und einfache Nummerierungen.

4. Schalten Sie die Bullets aus, indem Sie bei Typ die Option Keine wählen.
5. Bestätigen Sie mit OK.

**Optionen des Dialogs**

Auf der Karteikarte **Bullets und einfache Nummerierungen** im Dialogfenster des Menübefehls **Format > Bullets und Nummerierungen** können Sie folgende Einstellungen zu den Bullets vornehmen:

- **Typ**
  Hier können Sie bestimmen, ob die Absätze mit einem **Bullet** oder einer **Nummerierung** versehen werden sollen. Wählen Sie hier also die Option **Bullet** aus. (Informationen zur Option **Nummerierung** finden Sie im Abschnitt **Einfache Nummerierungen**.)

  Wenn Sie den Typ auf **Keine** setzen, werden vorhandene Bullets oder Nummern entfernt.

  Sie können übrigens jederzeit eine Aufzählung mit Bullets in eine Aufzählung mit Nummern umwandeln, indem Sie einfach den Typ auf **Nummerierung** ändern. Der umgekehrte Weg ist natürlich ebenfalls möglich.

- **Standard** und **Benutzerdefiniert**
  Hier können Sie das zu verwendende Bullet auswählen. In der Reihe **Standard** werden vorgefertigte Bullets angeboten, in der Reihe **Benutzerdefiniert** können Sie benutzerdefinierte Bullets anlegen (siehe unten).

- **Farbe** (nur bei Standard-Bullets)
  Über die aufklappbare Liste **Farbe** lässt sich eine andere Farbe für das Bullet wählen. Neben den hier angebotenen Farben können Sie jederzeit neue Farben definieren (siehe Abschnitt **Dokumenteigenschaften, Karteikarte Farben**).

  **Tipp:** Wenn Sie die Farbe auf "Auto" setzen, verwendet TextMaker automatisch die Schriftfarbe des Absatzes rechts des Bullets.

- **Größe** (nur bei Standard-Bullets)
  Hier können Sie bei Bedarf die Größe des Bullets (in Punkt) ändern.

  **Tipp:** Wenn Sie hier die Option "Automatisch" wählen, verwendet TextMaker automatisch die Schriftgröße des Absatzes rechts des Bullets.

- **Schaltfläche Zeichenformat** (nur bei benutzerdefinierten Bullets)
  Bei benutzerdefinierten Bullets erscheint statt der obigen zwei Optionen die Schaltfläche **Zeichenformat**. Klicken Sie diese an, können Sie das Zeichenformat (Größe, Farbe, Textauszeichnungen etc.) des Bullets ändern.

  **Tipp:** Wenn Sie an diesen Einstellungen nichts verändern, verwendet das Bullet automatisch das Zeichenformat des Absatzes rechts des Bullets (bis auf die Schriftart).

- **Abstand zum Text**
  Bestimmt, wie weit der Text nach rechts eingerückt soll, um Platz für die Bullets zu schaffen.

- **Vertikaler Versatz**
  Bestimmt die vertikale Position des Bullets. Bei einem negativen Wert wird das Bullet tiefer, bei einem positiven Wert höher positioniert.
Absatzformatierung

- Karteikarte **Nummerierungslisten**

  Diese Karteikarte enthält eine erweiterte Möglichkeit zum Erzeugen von Aufzählungen mit Bullets oder Nummern: die **Nummerierungslisten**. In diesen lassen sich Aufzählungen speichern und immer wieder anwenden. Außerdem sind über Nummerierungslisten auch hierarchische Nummerierungen (1., 1.1., 1.1.1. etc.) möglich.

  Informationen zu Nummerierungslisten finden Sie im Abschnitt [Nummerierungslisten](#).

---

**Benutzerdefinierte Bullets verwenden**

Wenn Ihnen keines der im obigen Dialog angebotenen Bullets gefällt, können Sie jederzeit ein beliebiges anderes Zeichen als Bullet verwenden.


Gehen Sie dazu wie folgt vor:

2. Betätigen Sie die Schaltfläche **Ändern** rechts daneben.

   **Tipp für Windows-Anwender:** Zahlreiche für Bullets geeignete Zeichen sind in den Symbolschriften **Symbol** und **Wingdings** enthalten.

4. Wählen Sie das gewünschte Zeichen per Doppelklick.

**Hinweis:** Das Dialogfenster verfügt über insgesamt sechs Schaltflächen für benutzerdefinierte Bullets. Sie sind deshalb aber nicht auf sechs verschiedene Bullets beschränkt; vielmehr lassen sich diese Bullets – auch innerhalb desselben Dokuments – beliebig oft umdefinieren.

---

**Initialen**

Als eine **Initiale** bezeichnet man einen großen Zierbuchstaben am Beginn eines Absatzes.

TextMaker ist in der Lage, einen solchen Zierbuchstaben automatisch aus dem ersten Zeichen eines Absatzes zu erzeugen. Der restliche Text des Absatzes umfließt die Initiale dabei automatisch.

**Hinweis:** Initialen können nur bei Absätzen verwendet werden, deren Absatzausrichtung auf **linksbündig** oder **Blocksatz** gesetzt wurde.

Um Initialen zu verwenden, gehen Sie folgendermaßen vor:

1. Setzen Sie die Schreibmarke in den Absatz, der mit einer Initiale versehen werden soll.
2. Rufen Sie den Menübefehl **Format > Initialen** auf.
3. Wählen Sie bei der Option **Initialen** die gewünschte Art von Initialen.

4. Wählen Sie die gewünschte **Schriftgröße**. Falls die Initialen zusätzlich in einer anderen Schrift dargestellt werden sollen, klicken Sie auf die Schaltfläche **Zeichen** und stellen die gewünschte Zeichenformatierung ein.

5. Ändern Sie gegebenenfalls die **Ränder** für die Initialen.

Sobald Sie mit **OK** bestätigt haben, stellt TextMaker den ersten Buchstaben des Absatzes als Initiale dar. Der Inhalt des Absatzes lässt sich weiterhin wie gewohnt bearbeiten.

**Initialen entfernen**

Um Initialen wieder zu entfernen, rufen Sie den Menübefehl **Format > Initialen** erneut auf und setzen die Option **Initialen** auf **Keine**.

---

**Schattierung**

Mit dem Menübefehl **Format > Schattierung** können Sie Textabsätze mit einer farbigen Schattierung oder einem Muster hinterlegen.

![Schattierung Fenster](image_url)

Dazu markieren Sie die gewünschten Absätze, rufen den Menübefehl **Format > Schattierung** auf und gehen dann wie folgt vor:
Ein Raster anbringen

Ein Raster ist eine Farbschattierung, die aus der gewählten Vordergrundfarbe und Hintergrundfarbe gemischt wird.

Um ein Raster anzubringen, wählen Sie bei Typ die Option Raster und nehmen dann die gewünschten Einstellungen vor:

Stellen Sie zuerst die gewünschte Vordergrundfarbe und Hintergrundfarbe ein. (Für die Hintergrundfarbe ist Weiß voreingestellt.)

In der Rubrik Raster werden nun verschiedene Mischungen dieser beiden Farben vorgeschlagen. Wählen Sie einen dieser Vorschläge aus. Alternativ können Sie auch in das Eingabefeld unter Raster die gewünschte Mischung in Prozent eintippen. Zulässig sind Werte zwischen 0 (100% Hintergrundfarbe) und 100 (100% Vordergrundfarbe).

Ein Muster anbringen

Um ein Muster anzubringen, klicken Sie auf eines der Muster in der Rubrik Muster.

Weiterhin können Sie die Vordergrundfarbe und Hintergrundfarbe für das Muster auswählen.

Raster oder Muster entfernen

Möchten Sie ein vorhandenes Raster oder Muster wieder entfernen, wählen Sie bei Typ die Option Keine.

Bestätigen Sie dann mit OK.

Umrandung und Linien

Mit dem Menübefehl Format > Umrandung können Sie (unter anderem) Textabsätze mit einer kompletten Umrandung oder einzelnen Umrandungslinien oben, unten, links oder rechts versehen.

Der Befehl öffnet ein Dialogfenster, das etwa wie folgt aussieht:
Ein ähnlicher Dialog erscheint auch bei Objekten, die sich mit Umrandungslinien versehen lassen (zum Beispiel Textrahmen oder Tabellenzellen). Die Bedienung ist jeweils identisch.

Kurz zusammengefasst wird dieser Dialog wie folgt bedient:

1. Erst legen Sie fest, *was* für eine Art von Umrandungslinie angebracht werden soll (Linienstil, Liniendicke, Farbe).


Sehen wir uns die einzelnen Schritte einmal etwas genauer an.

Um beispielsweise Textabsätze mit Umrandungslinien zu versehen, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke in den gewünschten Absatz (oder markieren Sie mehrere Absätze).

2. Rufen Sie den Menübefehl **Format > Umrandung** auf.

3. Legen Sie als erstes fest, *was* für eine Art von Umrandungslinie angebracht werden soll. Hierfür gibt es folgende Einstellmöglichkeiten:

   - **Linienstil** (einfache Linien, doppelte Linien oder gestrichelte Linien)
   - **Liniendicke** (die Stärke der Linie)
   - **Farbe** (die Farbe der Linie)

4. Legen Sie dann fest, *wo* Sie diese Art von Umrandungslinie anwenden möchten (oben, unten, links, rechts, etc.).
Absatzformatierung

Hierfür finden Sie in der rechten Hälfte des Dialogs einen Kasten mit einer Vorschau auf das Ergebnis, umgeben von einigen Schaltflächen. Verwenden Sie diese wie folgt:

A) Klicken Sie in der Vorschau in der rechten Hälfte des Dialogs einfach direkt auf alle Linien, an denen eine Umrandungslinie angebracht werden soll.

B) Alternativ können Sie hierfür auch die Schaltflächen verwenden, die links und unterhalb der Vorschau angezeigt werden. Jede Schaltfläche steht für eine bestimmte Linie (siehe Symbol auf der Schaltfläche).

C) Die Schaltflächen oberhalb der Vorschau sind nützliche Abkürzungen:
   Die Schaltfläche Kontur wendet die eingestellte Umrandungslinie auf *alle* äußeren Linien an.
   Die Schaltfläche Gitter macht das Gleiche für alle inneren Linien (z.B. bei Tabellenzellen).
   Die Schaltfläche Keine entfernt alle Umrandungslinien auf einmal.

5. Wenn Sie möchten, können Sie noch weitere Linien anbringen, indem Sie einfach Schritt 4. wiederholen.

   Dabei können Sie die Einstellungen für die Linie (Stil, Dicke, Farbe) jederzeit ändern (Schritt 3.), bevor Sie diese anbringen (Schritt 4.).

6. Wenn alles passt, bestätigen Sie mit OK.

Weitere Informationen zu den einzelnen Optionen in diesem Dialog finden Sie weiter unten.

**Vorhandene Umrandungslinien bearbeiten oder entfernen**

Sie können Linienstil, -dicke und -farbe von vorhandenen Umrandungslinien jederzeit ändern beziehungsweise Linien wieder entfernen. Rufen Sie den Dialog dazu erneut auf und gehen Sie wie folgt vor:

- **Ändern**: Um das Aussehen einer Linie zu ändern, nehmen Sie zuerst die gewünschten Einstellungen vor (Linienstil, Liniendicke, Farbe). Dann klicken Sie in der Vorschau auf die Linie (oder ihre Schaltfläche), auf die Sie diese Einstellungen anwenden möchten.

- **Entfernen**: Um eine Umrandungslinie zu entfernen, klicken Sie in der Vorschau *zwei* Mal auf diese Linie (oder auf ihre Schaltfläche). Einmaliges Anklicken bringt die Umrandungslinie an, nochmaliges Anklicken entfernt sie wieder.

   Tipp: Die Schaltfläche Keine oberhalb der Vorschau entfernt *alle* Linien.

**Optionen des Dialogs**

In dem oben beschriebenen Dialogfenster für Umrandungslinien können Sie folgende Einstellungen vornehmen:

- **Linienstil**

- **Liniendicke**
   Bestimmt die Strichstärke der Linie.

- **Farbe**
   Hier können Sie die Farbe der Linien ändern.
Neben den hier angebotenen Farben können Sie jederzeit neue Farben definieren (siehe Abschnitt Dokumenteigenschaften, Karteikarte Farben).

### Vorschaufeld

In der rechten Hälfte des Dialogs sehen Sie einen Kasten mit einer Vorschau. Diese stellt dar, wie die Umrandungslinien in etwa aussehen würden, wenn Sie den Dialog mit **OK** verlassen.

Das Vorschaufeld dient aber auch zum Anbringen und Entfernen von Linien:

Wenn Sie eine der Linien in dieser Vorschau anklicken, wird die entsprechende Linie eingeschaltet – beziehungsweise bei erneutem Anklicken wieder ausgeschaltet. Dabei werden die derzeit im Dialog gewählten Einstellungen (Linienstil, Liniendicke, Farbe) verwendet.

Alternativ können Sie hierfür auch die Schaltflächen links und unterhalb der Vorschau verwenden. Jede steht für eine bestimmte Linie. Welche das ist, können Sie an dem Symbol auf der Schaltfläche erkennen.

Die Schaltflächen oberhalb der Vorschau sind als Abkürzung gedacht: **Keine** entfernt alle Linien, **Kontrur** fügt Linien für alle äußeren Ränder hinzu, **Gitter** macht das Gleiche mit den inneren Linien (z.B. bei Tabellenzellen).

### Breite der Umrandung

Nur bei Textabsätzen: Bestimmt, wo die Linien beginnen und enden sollen:

- **Seitenränder**: Die Linien reichen vom linken bis zum rechten Seitenrand.
- **Absatzränder**: Die Linien reichen vom linken bis zum rechten Einzug der Absätze. Dies ist die Standardeinstellung.
- **Text**: Die Linien werden so breit wie der Text, den sie umfassen.

### Abstand vom Text

Nur bei Textabsätzen: Bestimmt den Abstand der Umrandungslinien zum Text.

---

**Gliederungsebene**

Lange Dokumente (wie zum Beispiel Handbücher) versieht man in der Regel mit einer **Gliederung**.

Zum Anlegen und Bearbeiten der Gliederung eines Dokuments bietet TextMaker eine eigene **Gliederungsansicht**. Hier können Sie normalen Text zu einer Überschrift "ernennen" und die Gliederungsebene von vorhandenen Überschriften höher- oder tieferstufen.

**Hinweis**: Normalerweise sollten Sie die Gliederungsebene von Überschriften nicht über den Menübefehl **Format > Absatz** von Hand ändern, sondern diese Arbeit über die Schaltflächen der Gliederungsansicht erledigen.

Sollten Sie die Gliederungsebene einmal doch manuell ändern wollen, rufen Sie den Menübefehl **Format > Absatz** auf, wechseln auf die Karteikarte **Absatz** und wählen die gewünschte Ebene über die Option **Gliederungsebene**.

Detaillierte Informationen zum Gliedern von Dokumenten finden Sie im Abschnitt **Gliederungen**.
Umbruch vor dem Absatz erzwingen

Sie können TextMaker anweisen, vor dem aktuellen Absatz stets eine neue Seite oder Spalte beginnen zu lassen. Rufen Sie dazu den Menübefehl **Format > Absatz** auf, wechseln Sie auf die Karteikarte **Textfluss** und schalten Sie dort die Option **Seitenumbruch** beziehungsweise **Spaltenumbruch** ein.

TextMaker macht nun vor diesem Absatz stets einen Seiten- beziehungsweise Spaltenumbruch – selbst dann, wenn Sie den Absatz an eine andere Stelle verschieben.

Typografie

Auf der Karteikarte **Textfluss** im Dialogfenster des Menübefehls **Format > Absatz** können Sie unter anderem Einschränkungen für den automatischen Seitenumbruch festlegen, um unästhetische Seitenumbrüche zu verhindern.

Verwenden Sie dazu die folgenden Optionen in der Rubrik **Typografie**:  

- **Absätze zusammenhalten**  
  Wird diese Option aktiviert, verhindert TextMaker, dass der aktuelle Absatz durch einen automatischen Seitenumbruch vom darauf folgenden Absatz getrennt werden kann. Der Seitenumbruch erfolgt dann stattdessen bereits vor dem aktuellen Absatz.

  Haben Sie dabei mehrere Absätze markiert, werden diese *und der nächste* Absatz hinter der Markierung zusammengehalten.

  Anwendungsbeispiel: Schalten Sie **Absätze zusammenhalten** bei einer Überschrift ein, können Sie beispielsweise vermeiden, dass eine Seite Ihres Dokuments mit der Überschrift endet und der dazugehörige Text auf der nächsten Seite beginnt.

- **Kein Umbruch im Absatz**  
  Schalten Sie diese Option ein, wird ein Seitenumbruch inmitten des Absatzes verhindert. TextMaker macht den automatischen Seitenumbruch dann stattdessen vor dem Absatz, so dass dieser komplett auf der nächsten Seite landet.

  Das Gleiche gilt für Spaltenumbrüche (bei mehrspaltigem Text).

- **Schusterjungen vermeiden**  

  Aktivieren Sie diese Option, wird der Seitenumbruch in einem solchen Fall automatisch dargestellt korrigiert, dass mindestens zwei Zeilen des Absatzes auf jeder Seite erscheinen. Ist das nicht möglich, weil der Absatz beispielsweise nur aus zwei Zeilen besteht, wird der komplette Absatz auf die nächste Seite übernommen.
"Geschütztes" Leerzeichen

Es gibt noch eine weitere Methode, den Textfluss zu beeinflussen:

In bestimmten Fällen müssen zwei durch ein Leerzeichen getrennte Wörter innerhalb einer Zeile bleiben. TextMaker weiß davon nichts und verteilt sie beim automatischen Umbrechen der Zeilen möglicherweise auf zwei Zeilen.

Ein Beispiel: Sie möchten, dass der Preis "EUR 29,80" stets zusammenhängend gedruckt wird. Dies können Sie erreichen, indem Sie zwischen "EUR" und "29,80" ein sogenanntes geschütztes oder nicht-trennendes Leerzeichen einfügen. Drücken Sie dazu statt der Leertaste die Tastenkombination Strg+Umschalt+Leertaste.

Ausgedruckt wird das nicht-trennende Leerzeichen als ganz normales Leerzeichen. Nur wird sich TextMaker davor hüten, die Wörter, zwischen denen es steht, auf zwei Zeilen zu verteilen.

Zeilenummern unterdrücken

Die Option Zeilenummern unterdrücken im Dialogfenster des Menübefehls Format > Absatz, Karteikarte Textfluss, hat folgende Funktion:

Mit Hilfe des Menübefehls Format > Bereich, Karteikarte Zeilenummern, können Sie erreichen, dass im linken Rand der Seite Zeilenummern erscheinen. Möchten Sie, dass diese bei einem bestimmten Absatz nicht erscheinen, dann schalten Sie für diesen Absatz einfach die Option Zeilenummern unterdrücken ein.

Ausführliche Informationen zu Zeilenummern finden Sie im Abschnitt Zeilenummern anbringen.

Zeilenumbruch - manuell einfügen

Als Alternative zum Einsatz der Absatzmarke (mit der Eingabetaste .) gibt es eine Möglichkeit zur nächsten Zeile zu springen, ohne dabei einen neuen Absatz zu beginnen: Setzen Sie einen manuellen Zeilenumbruch über den Menübefehl Einfügen > Umbruch > Zeilenumbruch oder über die Tastenkombination Umschalt+¿.

Der manuelle Zeilenumbruch entspricht dem automatischen Zeilenumbruch, der die Schreibmarke am Zeilenende zur nächsten Zeile springen lässt. Aber der manuelle Zeilenumbruch kann an einer beliebigen Stelle der Zeile eingesetzt werden.

Was ist der Unterschied zur Absatzmarke: Während beim Einsatz der Absatzmarke auch die Formatierungen des Absatzes greifen (zum Beispiel die eingestellten Abstände vor und nach dem Absatz), bewirkt der Zeilenumbruch lediglich einen Sprung in die nächste Zeile. Man bleibt dabei immer noch im selben Textblock innerhalb des Absatzes.
**Tipp:** Wenn Sie in einer Liste mit Aufzählungszeichen (Bullets) eine neue Zeile umbrechen wollen, ohne dass dabei ein neues Aufzählungszeichen entsteht, so verwenden Sie einfach den manuellen Zeilenumbruch. Die nächste Zeile erscheint dann als Fließtext.
Seitenformatierung

In diesem Kapitel erfahren Sie alles, was Sie zum Formatieren von Seiten in TextMaker wissen müssen. Das Kapitel enthält folgende Abschnitte:

- **Manuelle Seitenumbrüche einfügen**
  Wenn Sie eine neue Seite beginnen möchten, bevor der Text das Ende der aktuellen Seite erreicht hat, können Sie jederzeit einen *manuellen Seitenumbruch* einfügen. In diesem Abschnitt erfahren Sie, wie das geht.

- **Seite einrichten**
  Mit dem Menübefehl *Datei > Seite einrichten* legen Sie das *Seitenformat* des Dokuments fest. Dazu zählen Einstellungen wie Papiergröße, Seitenausrichtung (Hochformat oder Querformat) und Seitenränder.

- **Kopfzeilen und Fußzeilen**
  Kopfzeilen und Fußzeilen sind gleichbleibende Texte, die am oberen beziehungsweise unteren Ende jeder Seite gedruckt werden. In diesem Abschnitt wird beschrieben, wie Sie diese anlegen und bearbeiten.

- **Masterseiten**

- **Aufteilen eines Dokuments in Kapitel**
  Alle in diesem Kapitel vorgestellten Seitenformatierungen gelten normalerweise für das gesamte Dokument. Alle Seiten haben also das gleiche Papierformat, die gleichen Kopf- und Fußzeilen etc. Sie können ein Dokument aber auch in Kapitel aufteilen. Jedes Kapitel kann seine eigenen Kopf- und Fußzeilen und sein eigenes Seitenformat verwenden. In diesem Abschnitt erfahren Sie mehr dazu.

- **Seitenhintergrund ändern**

---

**Manuelle Seitenumbrüche einfügen**

TextMaker füllt die Seiten des Dokuments normalerweise automatisch. Erreicht der Text das Ende der Seite, wird ein automatischer Seitenumbruch durchgeführt und der Text auf der nächsten Seite fortgesetzt. Möchten Sie, dass eine Seite vorzeitig beendet wird, können Sie jederzeit einen *manuellen Seitenumbruch* einfügen.
Zu diesem Zweck setzen Sie die Schreibmarke an die Stelle, an der die neue Seite beginnen soll, und rufen den Menübefehl Einfügen > Umbruch > Seitenumbruch auf. Alternativ können Sie auch das Tastenkürzel Strg+L verwenden.

TextMaker fügt nun einen festen Seitenumbruch ein.

Einen solchen erzwungenen Seitenumbruch können Sie bei Bedarf wieder entfernen, indem Sie die Schreibmarke an den Beginn des Absatzes direkt unter dem Seitenumbruch setzen und die Rücktaste betätigen.

**Seitenumbruch vor einem bestimmten Absatz durchführen lassen**

Sie können einen vorzeitigen Seitenumbruch nicht nur mit dem Menübefehl Einfügen > Umbruch > Seitenumbruch erzwingen, sondern auch, indem Sie einem Absatz das Attribut "Führe vor diesem Absatz stets einen Seitenumbruch durch" geben.

Dazu setzen Sie die Schreibmarke in den gewünschten Absatz, rufen den Menübefehl Format > Absatz auf, wechseln auf die Karteikarte Textfluss und schalten dort die Option Seitenumbruch ein. TextMaker macht dann vor diesem Absatz immer einen Seitenumbruch – auch dann, wenn Sie den Absatz an eine andere Stelle verschieben.

**Seite einrichten**

Mit dem Menübefehl Datei > Seite einrichten können Sie das Seitenformat eines Dokuments festlegen. Dazu zählen Einstellungen wie Papiergröße, Seitenausrichtung (Hochformat oder Querformat) und Seitenränder.
Seitenformatierung

Das Dialogfenster des Befehls Datei > Seite einrichten

In dem Dialog lassen sich folgende Einstellungen vornehmen:

- **Ausrichtung**
  Hier können Sie die **Ausrichtung** der Druckseiten festlegen: **Hochformat** oder **Querformat**.

- **Papier**
  Hier können Sie das Papierformat für die Druckseiten einstellen. In der aufklappbaren Liste **Größe** werden alle vom derzeit gewählten Drucker unterstützten Papierformate angeboten; Sie können aber unter **Breite** und **Höhe** auch eigene Werte von Hand angeben.

- **Ränder**
  Hier können Sie die Seitenränder einstellen.

- **Bundsteg**
  Zusätzlich zu den Seitenrändern lässt sich ein **Bundsteg** einrichten. Diesen benötigen Sie nur bei Dokumenten mit gegenüberliegenden Seiten (zum Beispiel Büchern). Der Bundsteg ist ein zusätzlicher Rand, der für den Falz erforderlich ist, wenn ein solches Dokument gedruckt und dann gebunden oder zusammengeheftet wird.

  Sie können angeben, an welcher Position sich der Bundsteg befinden und wie groß er ausfallen soll.

  Wählen Sie beispielsweise die Einstellung "Innen" und setzen den Bundsteg auf 1 cm, erhalten alle **rechten** Buchseiten einen 1 cm großen zusätzlichen Rand auf der linken Seite. Bei allen **linken** Buchseiten wird dieser Rand hingegen auf der rechten Seite aufgeschlagen.
Papierschächte


Karteikarte Kapitel

Diese Karteikarte enthält Einstellungen zum Kapitelformat, mit dem sich der Abschnitt Aufteilen eines Dokuments in Kapitel befasst.


Kopfzeilen und Fußzeilen

Kopfzeilen und Fußzeilen sind gleichbleibende Texte, die am oberen beziehungsweise unteren Ende jeder Seite gedruckt werden.

Kopf- und Fußzeilen werden stets im oberen beziehungsweise unteren Seitenrand angelegt. Wenn Sie die Seitenräder des Dokuments verändern, passen sich Position und Größe aller Kopf- und Fußzeilen automatisch an.

Auf den nächsten Seiten erfahren Sie alles Wissenswerte zu Kopf- und Fußzeilen.

Kopf- und Fußzeilen erstellen und bearbeiten


Der Kopfzeilenrahmen ist anfänglich nur eine Zeile groß; er wächst aber automatisch, wenn Sie mehr als eine Zeile Text eintippen oder mit der Eingabetaste eine neue Zeile beginnen.

Um vom Kopfzeilenrahmen wieder in den normalen Text zurückzugelangen, klicken Sie einfach mit der Maus auf eine beliebige Stelle im normalen Text. Wenn Sie später die Kopfzeilen noch einmal bearbeiten möchten, rufen Sie den Menübefehl Einfügen > Kopfzeile bearbeiten auf oder klicken mit der Maus in den Kopfzeilenrahmen.


Tipp: Verwenden der Kopf- und Fußzeilenleiste

TextMaker verfügt über einen nützlichen Helfer zum Bearbeiten von Kopfzeilen und Fußzeilen: die Kopf- und Fußzeilenleiste.

Diese Symbolleiste erscheint automatisch, wenn Sie die Schreibmarke in eine Kopf- oder Fußzeile setzen. Falls sie nicht angezeigt wird, wurde sie vermutlich deaktiviert. Rufen Sie den Menübefehl Ansicht > Symbolleisten auf und klicken Sie auf das Kästchen vor Kopf- und Fußzeilenleiste, um sie wieder einzuschalten.

Die Leiste verfügt über folgende Schaltflächen (von links nach rechts):

- Eigenschaften der aktuellen Kopf- oder Fußzeile ändern (siehe Abschnitt Eigenschaften von Kopf- und Fußzeilen ändern)
- Seitenformat ändern (ruft den Menübefehl Datei > Seite einrichten auf)
- Kopfzeile einfügen (oder vorhandene aufrufen)
- Fußzeile einfügen (oder vorhandene aufrufen)
- Kopfzeile löschen
- Fußzeile löschen
- Seitennummer einfügen (als Feld)
- Gesamtseitenzahl einfügen (als Feld)
- Druckdatum einfügen (als Feld)
- Druckzeit einfügen (als Feld)
- Anderes Feld einfügen (ruft den Menübefehl Einfügen > Feld auf)
- Zur vorherigen Kopf-/Fußzeile gehen
- Zur nächsten Kopf-/Fußzeile gehen
- Zwischen Kopf- und Fußzeile wechseln
- Kopf-/Fußzeile verlassen (Schreibmarke zurück in den Text setzen)

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), erscheint ein Infotext, der die Funktion des Symbols angibt.

Seitennummer, Datum etc. einfügen

In Kopf- und Fußzeilen werden häufig Angaben wie Seitennummer, Datum etc. verwendet. Diese Informationen können Sie in TextMaker über sogenannte Felder einbringen.

Setzen Sie die Schreibmarke dazu an die gewünschte Position in der Kopf- oder Fußzeile, rufen Sie den Menübefehl Einfügen > Feld auf und wählen Sie das gewünschte Feld – zum Beispiel "Seitennummer" oder "Druckdatum". Informationen zu den einzelnen Arten von Feldern finden Sie im Kapitel Felder.

Tipp: In der Kopf- und Fußzeilenleiste gibt es einige Schaltflächen zum Einfügen der gebräuchlichsten Felder (Seitennummer, Datum etc.). Siehe vorheriger Abschnitt.
Beispiel: Seitennummer in der Fußzeile ausgeben lassen

Um beispielsweise in der Fußzeile die Seitennummer ausgeben zu lassen, gehen Sie wie folgt vor:

1. Klicken Sie in die Fußzeilen, um die Schreibmarke dorthin zu setzen.
2. Rufen Sie den Menübefehl **Einfügen > Feld** auf.
3. Wählen Sie in der Liste **Gruppe** den Eintrag "Seitennummer".
4. Optional: Mit der Option **Format** können Sie auf Wunsch ein anderes Zahlenformat für die Seitennummer wählen.
5. Bestätigen Sie mit **OK**.

TextMaker fügt nun ein Seitennummernfeld in die Fußzeile ein.

Seitennummerierung beeinflussen

Normalerweise beginnt die Seitennummerierung in jedem Dokument bei "1". Bei Bedarf können Sie TextMaker aber anweisen, die Seitennummerierung auf der ersten Seite mit einer anderen Nummer beginnen zu lassen.

Rufen Sie dazu den Menübefehl **Format > Kapitel** auf, wählen Sie die Karteikarte **Kapitel** und klicken auf die Schaltfläche **Seitennummern**, worauf ein Dialog erscheint. Ändern Sie darin die Einstellung **Nummerierung** von "Automatisch" auf "Wert" und tragen die gewünschte Nummer daneben ein. Haben Sie beispielsweise "42" eingetippt, erhält die erste Seite die Seitennummer 42.

Weitere Informationen zu diesem Dialog, in dem sich auch das Format der Seitennummern ändern lässt, finden Sie im Abschnitt [Seitennummern formatieren](#).

Verwenden von Ausrichtungstabulatoren

In Kopf- und Fußzeilen können Sie neben normalen Tabulatoren auch eine ganz spezielle Sorte von Tabulatoren verwenden: die sogenannten "Ausrichtungstabulatoren".

**Ausrichtungstabulatoren** haben folgende Besonderheiten:

- Sie lassen sich nur in Kopf- und Fußzeilen einfügen.
- Sie ignorieren sämtliche Tabulatoreinstellungen, die in einem Absatz vorgenommen worden sind (z.B. mit dem Befehl **Format > Tabulator**), denn:
- Sie richten den nachfolgenden Text immer relativ zu den Seitenrändern aus – und zwar wahlweise linksbündig, zentriert oder rechtsbündig.

Gerade das Wort "relativ" macht diese spezielle Art von Tabulatoren besonders interessant:

Wenn Sie in die Fußzeile beispielsweise einen zentrierten Ausrichtungstabulator einfügen und dahinter ein "Seitennummer"-Feld hinzufügen, wird dieses Feld zentriert ausgerichtet. So weit so gut. Wenn Sie jetzt jedoch die Seitenränder ändern – oder gar das Papierformat auf Querformat setzen –, wird die Seitennummer auch **weiterhin** zentriert in der Fußzeile erscheinen. Ein normaler zentrierter Tabstopp könnte so etwas nicht leisten, da Sie bei ihm ja stets eine **absolute** Position angeben müssten.

Um einen Ausrichtungstabulator einzufügen, gehen Sie wie folgt vor:
1. Klicken Sie in die Kopf- oder Fußzeile, um die Schreibmarke dorthin zu setzen (oder fügen Sie eine neue Kopf-/Fußzeile) ein).

2. Klicken Sie auf das Symbol \( \text{\textbullet} \) in der Kopf- und Fußzeilenleiste (am unteren Ende des Programm- fensters), um einen Ausrichtungstabulator einzufügen.

3. Es erscheint ein Dialog. Darin können Sie die gewünschte Ausrichtung für den Tabulator wählen und an- dere Einstellungen vornehmen (siehe unten).

Sobald Sie bestätigen, wird der Ausrichtungstabulator eingefügt und der Text hinter ihm entsprechend aus- gerichtet.

**Optionen des Dialogs**

Die Optionen im erwähnten Dialogfenster haben folgende Funktionen:

- **Ausrichtung**
  Legt die Ausrichtung des Ausrichtungstabulators fest: linksbündig, zentriert oder rechtsbündig (jeweils relativ zu den Seitenrändern).

- **Füllzeichen**
  Hier können Sie, genau wie bei normalen Tabulatoren, auf Wunsch ein Füllzeichen auswählen, mit dem dann der Bereich links von dem Tabulator aufgefüllt wird.

- **Relativ zu**

---

**Eigenschaften von Kopf- und Fußzeilen ändern**

Wie alle Arten von Rahmen haben auch die Kopf- und Fußzeilenrahmen (in denen sich die Kopf- und Fuß- zeilen befinden) bestimmte Eigenschaften, die sich mit dem Menübefehl **Objekt > Eigenschaften** modifi- zieren lassen. So können Sie beispielsweise die Höhe einstellen oder den Abstand zum Text und zur Blattkante ändern.

Gehen Sie dazu wie folgt vor:

1. Klicken Sie mit der Maus in den Kopf- oder Fußzeilenrahmen – je nachdem, ob Sie die Kopfzeilen oder die Fußzeilen bearbeiten möchten.

   Alternativ können Sie auch den Menübefehl **Einfügen > Kopfzeile bearbeiten** beziehungsweise **Einfü- gen > Fußzeile bearbeiten** aufrufen, der das Gleiche tut.

2. Rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, worauf ein entsprechender Dialog erscheint.

   **Tipp:** Dieser Befehl lässt sich auch über das Symbol \( \text{\textbullet} \) in der Kopf- und Fußzeilenleiste aufrufen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

**Karteikarte Eigenschaften**

Auf der Karteikarte **Eigenschaften** lassen sich folgende Eigenschaften bearbeiten:
Höhe
Hier können Sie die Höhe des Kopf- beziehungsweise Fußzeilenrahmens ändern:


Genau: Wählen Sie hingegen diese Option, können Sie die exakte Höhe des Rahmens selbst festlegen. Hinweis: Wenn TextMaker dann am unteren Rand des Rahmens einen roten Balken anzeigt, passt der enthaltene Text nicht vollständig hinein. Setzen Sie in diesem Falle die Höhe auf einen größeren Wert, wählen Sie die Option Mindestens oder verringern Sie die Textmenge.


Abstand zum Blattrand
Hier können Sie festlegen, wie viel Abstand TextMaker zwischen dem Rahmen und der Blattkante frei lassen soll.

Abstand zum Text
Hier können Sie festlegen, wie viel Abstand TextMaker zwischen dem Rahmen und dem Fließtext frei lassen soll.

Karteikarte Umrandung
Hier können Sie den Rahmen mit Umrandungslinien versehen.

Die Bedienelemente auf dieser Karteikarte entsprechen denen des Menübefehls Format > Umrandung (siehe Abschnitt Umrandung und Linien).

Karteikarte Schattierung
Hier können Sie den Rahmen mit einer Schattierung versehen.


Unterschiedliche Kopf- und Fußzeilen auf der ersten Seite
Kopf- und Fußzeilen sind Bestandteile der sogenannten Masterseite (siehe auch Abschnitt Masterseiten). Der Inhalt der Masterseite wird normalerweise auf allen Seiten des Dokuments wiederholt.

Bei Bedarf können Sie allerdings festlegen, dass für die erste Seite des Dokuments eine andere Masterseite verwendet werden soll (und somit auch andere Kopf- und Fußzeilen). Dies ist nützlich, wenn man zum Beispiel die erste Seite eines Briefes auf vorbedrucktes Briefpapier und den Rest auf normales weißes Papier druckt.

Um dies zu bewerkstelligen, rufen Sie den Menübefehl Format > Kapitel auf und schalten die Option Unterschiedliche erste Seite ein. Von nun an können die Kopf- und Fußzeilen der ersten Seite unabhängig von allen anderen Seiten bearbeitet werden.
Unterschiedliche Kopf- und Fußzeilen links/rechts


Um unterschiedliche Kopf- und Fußzeilen für linke und rechte Seiten verwenden zu können, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Format > Kapitel auf.

Genauer gesagt: Wenn Sie nun auf einer beliebigen linken Seite des Dokuments eine Kopfzeile anlegen oder bearbeiten, bleibt die Kopfzeile auf den rechten Seiten davon unberührt. Genauso wirken sich Änderungen der Kopfzeile auf einer beliebigen rechten Seite nur auf rechte Seiten aus.

Entsprechendes gilt natürlich auch für Fußzeilen.

Kopf- und Fußzeilen entfernen

Sie können den Inhalt einer Kopfzeile jederzeit entfernen, indem Sie in den Kopfzeilenrahmen hineinklicken, darin den gesamten Text markieren und diesen einfach löschen.

Bei Bedarf können Sie den Kopfzeilenrahmen auch gänzlich entfernen, obwohl dies normalerweise nicht nötig ist. Gehen Sie dazu wie folgt vor:

1. Setzen Sie die Schreibmarke in den Kopfzeilenrahmen.
2. Klicken Sie auf das Symbol ✂ in der Kopf- und Fußzeilenleiste. (Sie finden diese am unteren Ende des Programmfensters.)

Der Kopfzeilenrahmen wird nun samt Inhalt entfernt.

Alternativ können Sie die Kopfzeile auch entfernen, indem Sie einen Rechtsklick auf einen beliebigen leeren Bereich innerhalb des Kopfzeilenrahmens durchführen und dann aus dem Kontextmenü den Befehl Kopf-/Fußzeile entfernen aufrufen.

Bei Fußzeilen lässt sich auf die gleiche Weise vorgehen.

Masterseiten

Sie haben in diesem Kapitel bereits die Kopf- und Fußzeilen kennengelernt, die nur ein einziges Mal eingegeben werden müssen, dann aber auf jeder Seite erscheinen. Dies ist eine sehr praktische Sache, wenngleich TextMaker hier noch ein Ass im Ärmel hat:
Der Inhalt der Masterseite wird ebenfalls auf jeder Seite des Dokuments ausgegeben. Wie der Name schon sagt, sind Sie hier jedoch nicht auf ein paar Zeilen am oberen oder unteren Seitenrand beschränkt, sondern können die gesamte Seite befüllen.

**Hinweis:** Auf einer Masterseite dürfen allerdings nur Rahmen angebracht werden (Textrahmen, Grafikrahmen etc.). Tipp: Wenn Sie zu einer Masterseite Text hinzufügen wollen, können Sie dies dennoch tun: Fügen Sie einfach einen Textrahmen ein.

Möchten Sie also einen Brief beispielsweise mit einem "Wasserzeichen" veredeln, fügen Sie einfach einen Grafikrahmen mit einer geeigneten Grafik auf der Masterseite ein und setzen die Option Textfluss in den Eigenschaften der Grafik auf "Hinter Text". Das Wasserzeichen erscheint nun auf jeder Seite des Dokuments; der Text fließt dabei einfach darüber hinweg.

### Masterseite bearbeiten

Wenn Sie möchten, dass Objekte auf jeder Seite eines Dokuments oder Kapitels erscheinen, so bringen Sie diese einfach auf der Masterseite an. Dazu wechseln Sie in die Masterseitenansicht und fügen diese Objekte dort ein.

**Hinweis:** Auf Masterseiten können nur Rahmen (Textrahmen, Grafikrahmen etc.) und Zeichnungen angebracht werden. Informationen, wie man mit diesen Objekten arbeitet, finden Sie im Kapitel Rahmen und Zeichnungen.

Eine Masterseite bearbeiten Sie also wie folgt:

1. Wechseln Sie mit dem Menübefehl Ansicht > Masterseiten in die Masterseitenansicht.
2. Nehmen Sie die gewünschten Änderungen vor. Um beispielsweise eine Grafik anzubringen, rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen auf, um Text eingeben zu können, legen Sie mit Objekt > Neuer Textrahmen einen Textrahmen an etc.
3. Wenn Sie fertig sind, rufen Sie den Menübefehl Ansicht > Normal auf, um die Masterseitenansicht wieder zu verlassen.

Alle Objekte, die Sie auf der Masterseite eingefügt haben, erscheinen nun auf allen Seiten des Dokuments. Kopf- und Fußzeilen sind übrigens ebenfalls Bestandteile der Masterseite. Abgesehen von der Tatsache, dass sie automatisch im oberen beziehungsweise unteren Seitenrand platziert werden, verhalten sich diese im Prinzip wie auf der Masterseite eingefügte Textrahmen.

### Unterschiedliche Masterseiten im gleichen Dokument


Dort erfahren Sie auch, wie Sie eine Masterseite einrichten, die nur für die erste Seite des Dokuments gilt, und wie Sie unterschiedliche Masterseiten für linke und rechte Seiten einrichten.

**Tipp:** In der Masterseitenansicht wird am Beginn jeder Seite angezeigt, um welche Masterseite es sich handelt. Steht dort beispielsweise "Kapitel 7, rechte Masterseite", wird gerade die Masterseite für alle rechten Seiten in Kapitel 7 angezeigt.
Objekte auf der Masterseite für die Normalansicht sperren

Damit auf einer Masterseite angebrachte Objekte in der Normalansicht nicht versehentlich mit der Maus verschoben werden können, lassen sich diese auf Wunsch "sperren".

Rufen Sie dazu den Menübefehl **Datei > Eigenschaften** auf und wählen Sie die Karteikarte **Ansicht**. Schalten Sie in der Rubrik **Sperren** die Option **Objekte auf der Masterseite** ein.

Nun lassen sich in der Normalansicht die Objekte auf der Masterseite weder verschieben noch lässt sich ihre Größe ändern. Sie können nur noch in der Masterseitenansicht (Menübefehl **Ansicht > Masterseiten**) verändert werden.

*Hinweis:* Diese Einstellung wirkt sich nur auf das aktuelle Dokument aus.

---

Aufteilen eines Dokuments in Kapitel

Die in diesem Kapitel vorgestellten Seitenformatierungen gelten normalerweise für das gesamte Dokument. Alle Seiten haben also die gleichen Kopf- und Fußzeilen, das Papierformat lässt sich innerhalb eines Dokuments nicht wechseln etc.

Abhilfe schaffen hier **Kapitel**. Mit dem Menübefehl **Einfügen > Umbruch > Kapitelumbruch** können Sie ein Dokument nämlich in beliebig viele Kapitel aufteilen.

Dies hat folgende Auswirkungen auf die Seitenformatierung des Dokuments:

- **Papierformat, Seitenausrichtung** und **Seitenränder** lassen sich für jedes Kapitel getrennt einstellen.
- Jedes Kapitel kann eine eigene **Masterseite** und somit auch eigene **Kopfzeilen** und **Fußzeilen** haben.
- Die **Seitennummerierung** kann in einem Kapitel bei Bedarf auf einen beliebigen Anfangswert zurückgesetzt werden. Außerdem lässt sich das Format der Seitennummern für jedes Kapitel einzeln einstellen.
- Schalten Sie in der Kapitelformatierung die Option **Unterschiedliche linke und rechte Seiten** an, lassen sich für linke und rechte Seiten unterschiedliche Kopfzeilen, Fußzeilen und Masterseiten anlegen (z.B. bei einem Buch).
- Sie können bestimmen, dass ein Kapitel beispielsweise stets auf einer rechten Seite beginnen soll. Falls die erste Kapitelseite dabei auf einer linken Seite landet, fügt TextMaker automatisch eine Leerseite davor ein.

Das Aufteilen eines Dokuments in Kapitel ist insofern nicht nur dann sinnvoll, wenn Sie ein längeres Werk mit einzelnen "Kapiteln" im herkömmlichen Sinn schreiben. Es kann beispielsweise auch vorkommen, dass Sie inmitten eines Dokuments auf das Querformat wechseln möchten, damit Sie mehr Platz für eine breite Tabelle zur Verfügung haben.

Fügen Sie dazu einen Kapitelumbruch ein, stellen Sie das Papierformat in dem neuen Kapitel auf Querformat und erstellen Sie die Tabelle. Unterhalb der Tabelle fügen Sie erneut einen Kapitelumbruch ein und setzen das Papierformat für dieses Kapitel wieder auf Hochformat, um den weiteren Text wieder im Hochformat schreiben zu können.

Einzelheiten zum Arbeiten mit Kapiteln finden Sie auf den nächsten Seiten.
Kapitel einfügen und entfernen

Um ein neues Kapitel anzulegen, fügen Sie einfach einen Kapitelumbruch in den Text ein:

1. Bewegen Sie die Schreibmarke an die Stelle, an der das neue Kapitel beginnen soll.
2. Rufen Sie den Menübefehl **Einfügen > Umbruch > Kapitelumbruch** auf.

TextMaker fügt nun einen Kapitelumbruch ein.

_Hinweis:_ Am Beginn eines neuen Kapitels führt TextMaker stets einen Seitenumbruch durch.

_Tipp:_ In der Statuszeile am unteren Rand des TextMaker-Fensters wird hinter "Kapitel" angezeigt, in welchem Kapitel sich die Schreibmarke momentan befindet.

Kapitelumbruch entfernen

Einen Kapitelumbruch können Sie bei Bedarf wieder entfernen, indem Sie die Schreibmarke an den Beginn des Absatzes direkt unter dem Kapitelumbruch setzen und die **Rücktaste** betätigen. Das Kapitel vor dem Umbruch wird dadurch in das Kapitel nach dem Umbruch integriert und übernimmt auch dessen Kapitelformatierung.

Kapitel auffinden

Mit dem Menübefehl **Bearbeiten > Gehe zu** können Sie zu einem bestimmten Kapitel blättern. Rufen Sie den Befehl dazu auf, wählen Sie in der Liste die Option **Kapitel** und wählen Sie dann das gewünschte Kapitel aus.

Kapitel und die Seitenformatierung

_Wichtig:_ In jedem Kapitel eines Dokuments kann eine andere Seitenformatierung verwendet werden.

Zur Wiederholung – zur Seitenformatierung gehören:

- Papierformat, Seiten ausrichtung und Ränder
- Kopfzeilen, Fußzeilen und Masterseiten
- Seitennummern (Anfangswert, Format)

Wenn Sie ein neues Dokument beginnen, besteht dieses zunächst aus _einem_ Kapitel. Ändern Sie etwas an der Seitenformatierung, wirkt sich dies insofern auf das gesamte Dokument aus.

Unterteilen Sie das Dokument nun mit dem Menübefehl **Einfügen > Umbruch > Kapitelumbruch** in mehrere Kapitel, übernehmen die neuen Kapitel zunächst die ursprüngliche Seitenformatierung. Denn es gilt:
**Wichtig:** Wenn Sie einen Kapitelumbruch einfügen, übernimmt das daraus resultierende neue Kapitel zunächst die Seitenformatierung und die Masterseite des aktuellen Kapitels. Anschließend können Sie Seitenformatierung und Masterseite jedoch in jedem Kapitel separat ändern.

Sie können nun also für jedes Kapitel z.B. andere Kopf- und Fußzeilen anlegen oder ein anderes Papierformat einstellen usw.

---

**Kapitelformatierung**

Abgesehen von der Tatsache, dass die *Seitenformatierung* in jedem Kapitel anders eingestellt werden kann, gibt es zusätzlich noch die *Kapitelformatierung*.

Die *Seitenformatierung* eines Kapitels ändern Sie über die bekannten Befehle (siehe Kapitel "Seitenformatierung").

Um die *Kapitelformatierung* zu ändern, gehen Sie folgendermaßen vor:


2. Rufen Sie den Menübefehl **Format > Kapitel** auf.

![Seitenformatieren Dialogfenster](image)

3. Nehmen Sie die gewünschten Änderungen vor (siehe unten) und bestätigen Sie mit **OK**.
In dem Dialogfenster dieses Befehls lassen sich folgende Einstellungen vornehmen:

- **Masterseiten**

Hier können Sie Einstellungen für die Masterseite(n) des Kapitels ändern (siehe auch Abschnitt Masterseiten):

**Unterschiedliche erste Seite:** Wenn Sie diese Option aktivieren, verwendet die erste Seite des Kapitels eine andere Masterseite als die anderen Seiten. Dies ist nützlich, wenn Sie zum Beispiel auf der ersten Seite Ihres Dokuments (oder Kapitels) andere Kopfzeilen haben möchten als auf den restlichen Seiten.

**Unterschiedliche linke und rechte Seiten:** Diese Option benötigen Sie, wenn Ihr Dokument beidseitig gedruckt werden soll, wie das beispielsweise bei einem Buch der Fall ist. Wird sie eingeschaltet, legt TextMaker eine Masterseite für alle linken Seiten des Dokuments – und eine andere für alle rechten an. Dies ermöglicht es, zum Beispiel die Seitennummer in der Fußzeile auf linken Seiten links und auf rechten Seiten rechts zu platzieren.

**Tipp:** In der Masterseitenansicht wird am Beginn jeder Seite angezeigt, um welche Masterseite es sich handelt. Steht dort beispielsweise "Kapitel 7, rechte Masterseite", wird gerade die Masterseite für alle rechten Seiten in Kapitel 7 angezeigt.


- **Kapitel beginnt auf**

Wenn Sie einen Kapitelumbruch einfügen, macht TextMaker stets auch einen Seitenumbruch. Neue Kapitel beginnen also immer auf einer neuen Seite.

Ändern Sie nun die Option Kapitel beginnt auf von der Standardeinstellung Beliebiger Seite beispielsweise auf Rechter Seite, sorgt TextMaker dafür, dass das Kapitel stets auf einer rechten Seite beginnt. Falls der Kapitelbeginn dann auf eine linke Seite fällt, fügt TextMaker automatisch eine Leerseite ein, damit das Kapitel wieder auf der nächsten rechten Seite beginnt.

In Büchern ist es beispielsweise üblich, alle Kapitel auf einer rechten Seite beginnen zu lassen. Der Leser findet dadurch beim schnellen Durchblättern den Beginn neuer Kapitel leichter.

- **Vertikale Ausrichtung**

Hier lässt sich die vertikale Ausrichtung des Fließtextes auf der Seite ändern.

Wählen Sie beispielsweise die Option Zentriert, wird der Text vertikal in der Mitte der Seite zentriert. Bei der Option Vertikaler Blockszatz wird der Abstand zwischen den Absätzen gleichmäßig so erweitert, dass der Fließtext genau am oberen Blattrand beginnt und genau am unteren endet.

- **Kapitelnummer**

Kapitel werden von TextMaker automatisch fortlaufend durchnumeriert. In der Statuszeile können Sie stets die aktuelle Kapitelnummer ablesen.

Ändern Sie die Option Kapitelnummer von der Standardeinstellung Automatisch auf Wert, können Sie einen eigenen Wert für die Kapitelnummer angeben. Tragen Sie für die Kapitelnummer im dritten Kapitel beispielsweise den Wert "5" ein, lauten die Kapitelnummern im Dokument 1, 2, 5, 6, 7 etc.

**Tipp:** Die Kapitelnummer kann über den Menübefehl Einfügen > Feld jederzeit im Text ausgegeben werden (beispielsweise in der Kopf-/Fußzeile).

- **Schaltfläche Seitennummern**
Sie können in ein Dokument (z.B. in der Kopf-/Fußzeile) jederzeit ein Seitennummer-Feld einfügen, das die aktuelle Seitennummer ausgibt. Diese Schaltfläche öffnet einen Dialog, in dem sich das Format der Seitennummern ändern lässt. Außerdem können Sie darin den Anfangswert für die Seitennummerierung manuell auf einen festen Wert setzen.

Lesen Sie dazu den Abschnitt Seitennummern formatieren.

- Karteikarte Seitenformat

Auf der Karteikarte Seitenformat in diesem Dialog können Sie das Seitenformat (Papiergröße, Ausrich tung, Seitenränder etc.) einstellen. Informationen zu den einzelnen Optionen finden Sie im Abschnitt Seite einrichten.

Es sei noch einmal daran erinnert, dass Sie das Seitenformat für jedes einzelne Kapitel anders einstellen können. Haben Sie ein Dokument also in mehrere Kapitel aufgeteilt und möchten die Formatierung der Seiten des gesamten Dokuments ändern, müssen Sie zuvor auch das gesamte Dokument markieren.

### Seitennummern formatieren

Mit dem in diesem Abschnitt beschriebenen Dialogfenster lässt sich das Format der Seitennummern für das aktuelle Kapitel ändern. Außerdem können Sie darin den Anfangswert für die Seitennummerierung manuell auf einen festen Wert setzen.

Im Detail:

Wie im Abschnitt Seitennummer, Datum etc. einfügen beschrieben, können Sie mit dem Menübefehl Einfügen > Feld ein Seitennummer-Feld einfügen, das die aktuelle Seitennummer ausgibt. Wurde dabei in der Liste Format die Option Kapiteleinstellungen verwenden gewählt, richtet sich dieses Seitennummern-Feld nach den Einstellungen, die Sie in dem nachfolgend beschriebenen Dialog machen.

Sie erreichen diesen Dialog wie folgt:

- Rufen Sie den Menübefehl Format > Kapitel auf und betätigen Sie die Schaltfläche Seitennummern.
- Rufen Sie den Menübefehl Einfügen > Feld auf, wählen Sie den Eintrag Seitennummer in der Liste und betätigen Sie die Schaltfläche Einstellungen (nur verfügbar, wenn bei Format die Option Kapitelleinstellungen verwenden ausgewählt ist).

**Anmerkung:** Die Optionen in diesem Dialog gehören zur Kapitelformatierung. Sie können also bei Bedarf für jedes Kapitel in einem Dokument eigene Einstellungen festlegen.

### Optionen des Dialogs

Folgende Optionen sind in dem Dialog verfügbar:

- **Nummerierung**

  TextMaker nummeriert die Seiten eines Dokuments automatisch durch. Die erste Seite im Dokument ist normalerweise also Seite 1, die zweite Seite 2 etc. etc.

  Bei Bedarf können Sie aber manuell in die Seitennummerierung eingreifen und die Seitennummer für die erste Seite eines bestimmten Kapitels auf einen festen Wert setzen.

Haben Sie also beispielsweise "42" eingetippt, erhält die erste Seite des Kapitels die Seitennummer 42, die zweite Seite 43 etc.

- **Zahlenformat**

Hier können Sie das Zahlenformat der Seitennummern ändern.

Zur Wahl stehen Formate wie arabische Zahlen (1, 2, 3, …), Buchstaben (A, B, C, …) und römische Zahlen (I, II, III, …).

- **Überschriftennummer einschließen, Überschriftenebene und Trennzeichen**

Wenn Sie die Option **Überschriftennummer einschließen** aktivieren, wird der Seitennummer die Nummer der jeweils aktuellen Überschrift vorangestellt.

_Hinweis:_ Dies funktioniert nur, wenn die Überschriften des Dokuments mit einer *Nummerierung* versehen worden sind. Informationen dazu finden Sie im Abschnitt Überschriften nummerieren.

Bei **Überschriftenebene** können Sie auswählen, die Überschriften welcher Überschriftenebene hierzu herangezogen werden sollten (Überschrift 1, Überschrift 2 etc.)

Außerdem lässt sich bei **Trennzeichen** einstellen, welches Zeichen zum Trennen zwischen Überschriftenebene und Seitennummer verwendet werden soll.

Ein Beispiel: Wenn Sie ein **Seitennummer**-Feld auf der Seite 42 eines Dokuments einfügen und die auf dieser Seite aktuelle Überschrift der Ebene 1 lautet (inklusive Nummerierung): "5. Die Lärche", so gibt dieses Feld folgendes aus: 5.-42.

- **Anwenden auf**

Hier können Sie auswählen, ob die in diesem Dialog vorgenommenen Änderungen nur auf das aktuelle Kapitel oder auf das gesamte Dokument angewendet werden sollen.

Diese Option ist nur verfügbar, wenn Sie diesen Dialog über den Befehl Einfügen > Feld ausgerufen haben.

---

**Seitenhintergrund ändern**

Wie im Abschnitt Kapitelformatierung bereits erwähnt, können Sie den Menübefehl Format > Kapitel verwenden, um den Hintergrund der Seiten eines Dokuments zu ändern – wenn Sie diese beispielsweise einfärben möchten.

Es gibt hierfür allerdings noch einen anderen Befehl, der deutlich mehr Optionen bietet: den Menübefehl Format > Seitenhintergrund.

In diesem Abschnitt erfahren Sie, wie Sie diese beiden Befehle einsetzen und welche Unterschiede es gibt.

**Format > Seitenhintergrund**

Mit dem Menübefehl Format > Seitenhintergrund lässt sich der Seitenhintergrund für das gesamte Dokument ändern.

Verwenden Sie diesen Befehl wie folgt:

1. Rufen Sie den Menübfehlf Format > Seitenhintergrund auf.

3. Nehmen Sie die gewünschten Einstellungen vor und bestätigen Sie mit OK.

Weitere Informationen zu obigem Dialog finden Sie im Abschnitt **Objekt-Eigenschaften, Karteikarte Füllung**. Darin wird der Füllungsdialog für Objekte beschrieben, der mit diesem Dialog praktisch identisch ist.

**Drucken:** Beachten Sie, dass diese Art von Seitenhintergrund normalerweise nur auf dem Bildschirm angezeigt wird – er erscheint **nicht** in Ausdrucken. Es gibt allerdings eine Dokumentoption, mit der Sie dies ändern können: Wenn Sie im Dialog des Menübefehls **Datei > Eigenschaften** auf der Karteikarte **Ansicht** die Option **Seitenhintergrund drucken** aktivieren, wird der Hintergrund auch ausgedruckt.

---

**Format > Kapitel**

Etwas anders funktioniert der Menübefehl **Format > Kapitel**:

Mit diesem Befehl lässt sich der Seitenhintergrund für das aktuelle **Kapitel** ändern (genauer gesagt: für dessen Masterseite(n)).

Verwenden Sie diesen Befehl wie folgt:

1. Falls Ihr Dokument in mehrere Kapitel aufgeteilt ist: Bewegen Sie die Schreibmarke an eine beliebige Stelle innerhalb des gewünschten Kapitels.

2. Rufen Sie den Menübefehl **Format > Kapitel** auf.

3. Klicken Sie bei **Umrandung und Schattierung der Masterseiten** auf die Schaltfläche **Ändern** und wählen Sie, welche Art von Masterseite(n) des Kapitels geändert werden soll.

4. Wechseln Sie auf die Karteikarte **Schattierung**.

5. Wählen Sie dann bei **Typ**, welche Art von Füllung für den Seitenhintergrund verwendet werden soll. Bei diesem Befehl lässt sich lediglich zwischen Raster (Farbton) oder Muster wählen.

6. Nehmen Sie die gewünschten Einstellungen vor und bestätigen Sie mit OK.

Weitere Informationen zu obigem Dialog finden Sie im Abschnitt **Schattierung**. Darin wird der Füllungsdialog für Textabsätze beschrieben, der mit diesem Dialog praktisch identisch ist.

Beachten Sie: Falls Sie das Dokument in mehrere Kapitel unterteilt haben, wirken sich obige Änderungen immer nur auf das aktuelle Kapitel aus (siehe auch Abschnitt **Aufteilen eines Dokuments in Kapitel**).

**Drucken:** Diese Art von Seitenhintergrund erscheint **immer** auch in Ausdrucken. Die weiter oben erwähnte Dokumentoption **Seitenhintergrund drucken** hat hier keine Wirkung.
Formatvorlagen

Eine besondere Arbeitserleichterung für Textverarbeitungs-Profis stellen die Formatvorlagen dar.

Benötigen Sie eine bestimmte Zeichen- oder Absatzformatierung häufiger, lohnt es sich, dafür eine Formatvorlage zu erstellen. Diese können Sie dann auf beliebig viele Textstellen anwenden – und schon wird dieser Text so formatiert, wie Sie es in der Vorlage bestimmt hatten.

Und: Sie sparen dadurch nicht nur die Zeit, immer wieder die gleichen Formatierungen anzubringen, sondern Sie sorgen auch dafür, dass Ihr Dokument einheitlich formatiert ist. Denn: Ändern Sie die Formatierung einer Formatvorlage, ändert sich die Formatierung aller Textstellen, denen Sie diese Vorlage zugewiesen haben!

In der Praxis kann das so aussehen: Sie legen eine Absatzvorlage namens "Überschriften" an, in der Sie eine größere, fette Schrift wählen, die Absatzausrichtung auf zentriert setzen usw. Jetzt brauchen Sie bei Überschriften nur noch diese Vorlage anzuwenden, und schon wird der Absatz entsprechend formatiert.

Sie können übrigens in jedem Dokument andere Formatvorlagen anlegen – diese werden innerhalb des Dokuments gespeichert.

In diesem Kapitel finden Sie ausführliche Informationen zum Verwenden von Formatvorlagen. Folgende Themen werden darin behandelt:

- **Zeichenvorlagen**
  
  In einer Zeichenvorlage können Sie ein häufig benötigtes Zeichenformat (Schriftart, Schriftgröße, Textauszeichnungen etc.) speichern und es dann immer wieder auf beliebige Zeichen anwenden.

  Dafür ist der Menübefehl **Format > Zeichenvorlage** zuständig.

- **Absatzvorlagen**
  
  In einer Absatzvorlage können Sie ein häufig benötigtes Absatzformat (Einzüge, Tabulatoren, Ausrichtung etc.) speichern und es dann immer wieder auf beliebige Absätze anwenden.

  Dafür ist der Menübefehl **Format > Absatzvorlage** zuständig.

- **Formatvorlagen verwalten**
  
  Mit dem **Vorlagenmanager** können Sie Zeichen- und Absatzvorlagen zwischen Dokumenten hin- und herkopieren und so deren Aussehen aneinander angleichen.

  Dafür ist der Menübefehl **Format > Vorlagenmanager** zuständig.

- **Dokumentvorlagen**
  
  Besonders häufig benötigte Formatvorlagen lassen sich in einer **Dokumentvorlage** speichern.


  Ausführliche Information zu diesen Themen finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.
Zeichenvorlagen

In einer Zeichenvorlage können Sie ein häufig benötigtes Zeichenformat (Schriftart, Schriftgröße, Textauszeichnungen etc.) speichern und es dann immer wieder auf beliebige Zeichen anwenden.

 Möchten Sie beispielsweise in einem Vertrag kleingedruckte Bereiche in einer anderen Schrift und einer kleineren Größe drucken, erstellen Sie sich einfach eine entsprechende Zeichenvorlage – nennen wir sie "Kleingedruckt" – und wenden diese an den gewünschten Stellen an.

**Anmerkung:** Der Unterschied zwischen Zeichenvorlagen und Absatzvorlagen (siehe Abschnitt Absatzvorlagen) liegt darin, dass in Zeichenvorlagen nur das Zeichenformat gespeichert wird, in Absatzvorlagen hingegen sowohl das Absatzformat (Einzüge, Tabulatoren, Ausrichtung etc.) als auch das Zeichenformat. Dementsprechend sind Zeichenvorlagen auch auf einzelne Zeichen anwendbar, Absatzvorlagen hingegen nur auf komplette Absätze.

Auf den nächsten Seiten finden Sie ausführliche Informationen zum Arbeiten mit Zeichenvorlagen. Folgende Themen werden darin behandelt:

- Zeichenvorlagen erstellen
- Zeichenvorlagen anwenden
- Zeichenvorlagen ändern
- Geltungsbereich von Zeichenvorlagen
- Zeichenvorlage Normal
- Verknüpfte Zeichenvorlagen erstellen
- Zeichenvorlagen und die Seitenleiste

### Zeichenvorlagen erstellen

Um eine Zeichenvorlage zu erstellen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Format > Zeichenvorlage** auf.
2. Klicken Sie auf die Schaltfläche **Neu**.

3. Geben Sie der Zeichenvorlage einen beliebigen Namen.

4. Es erscheint ein Dialogfenster, das dem des Menübefehls **Format > Zeichen** weitgehend entspricht. Stellen Sie hier die gewünschte Zeichenformatierung ein (siehe Abschnitt **Zeichenformatierung**).

5. Wenn Sie die Formatvorlage häufig benötigen, können Sie ihr ein Tastenkürzel zuordnen (siehe unten).


7. Verlassen Sie das Dialogfenster "Zeichenvorlage" mit **Schließen**.

Die Vorlage ist nun erzeugt und einsatzbereit. Wie Sie sie einsetzen, erfahren Sie gleich (Abschnitt **Zeichenvorlagen anwenden**).

**Zeichenvorlagen aus bestehendem Text erstellen**

Alternativ können Sie auch erst Text nach Wunsch formatieren und dann eine neue Vorlage erstellen, die genau diese Formatierung übernimmt. Verwenden Sie dazu die Schaltfläche **Neu aus Markierung** statt der Schaltfläche **Neu**.

Diese Vorgehensweise ist praktisch, wenn Sie Text zuvor "von Hand" formatiert haben und nun eine Zeichenvorlage mit exakt dieser Zeichenformatierung anlegen möchten.

Im Detail gehen Sie dazu wie folgt vor:

1. Bringen Sie an einem Textabschnitt die gewünschten Zeichenformatierungen an (Schriftart, Schriftgröße etc.).

2. Setzen Sie die Schreibmarke in diesen Textabschnitt (oder markieren Sie ihn; beides funktioniert gleichermaßen).
3. Erstellen Sie, wie weiter oben beschrieben, mit dem Menübefehl **Format > Zeichenvorlage** eine neue Zeichenvorlage. Wichtig: Verwenden Sie dabei aber nicht die Schaltfläche **Neu**, sondern die Schaltfläche **Neu aus Markierung**.

Eine so erzeugte Vorlage verhält sich genau wie alle anderen Vorlagen. Der einzige Unterschied ist, dass sie beim Anlegen die Formatierung von bestehendem Text übernimmt. (Sie können die Formatierung der Vorlage aber natürlich auch weiterhin jederzeit ändern – unabhängig von diesem Text.)

**Tastenkürzel verwenden**

Benötigen Sie eine Formatvorlage besonders häufig, können Sie ihr jederzeit ein Tastenkürzel geben. Das hat den Vorteil, dass Sie die Vorlage blitzschnell mit einem einzigen Tastendruck aktivieren können.

Um einer Vorlage ein Tastenkürzel zuzuordnen, wechseln Sie im Dialog zum Bearbeiten der Vorlage auf die Karteikarte **Vorlage**. Setzen Sie dann die Schreibmarke in das Eingabefeld **Tastenkürzel** und betätigen Sie die gewünschte Tastenkombination.

**Hinweis:** Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird unter dem Eingabefeld **Tastenkürzel** angezeigt, womit diese momentan belegt ist. Sie sollten dann die Rücktaste betätigen, um das Tastenkürzel wieder zu löschen und eine andere Tastenkombination verwenden. Andernfalls über- schreiben Sie die Tastenkombination einer anderen Vorlage oder eines TextMaker-Befehls.

Wir empfehlen Ihnen, stets Tastenkombinationen mit den Tasten **Strg und Umschalt** zu verwenden, da diese normalerweise nicht belegt sind.

**Zeichenvorlagen anwenden**

Um eine Zeichenvorlage anzuwenden, gehen Sie wie folgt vor:

1. Markieren Sie den Text, auf den Sie die Zeichenvorlage anwenden möchten.
2. Rufen Sie den Menübefehl **Format > Zeichenvorlage** auf.
3. Wählen Sie die gewünschte Vorlage.

**Hinweis:** In der rechten Hälfte des Dialogs wird eine kleine Vorschau der momentan ausgewählten Vorlage präsentiert. Sie können diese Vorschau über die Schaltflächen >> beziehungsweise << jederzeit ein- oder ausschalten.

4. Klicken Sie auf **Anwenden**.

Sofort ändert sich die Formatierung des markierten Textes so, wie Sie es in der Zeichenvorlage festgelegt hatten.

**Tipp 1:** Wenn Sie Formatvorlagen häufig verwenden, sollten Sie die Seitenleiste aktivieren. Diese lässt sie Vorlagen blitzschnell anwenden und auch bearbeiten. Siehe Abschnitt **Zeichenvorlagen und die Seitenleiste**.

**Tipp 2:** Haben Sie der Formatvorlage ein Tastenkürzel zugewiesen, können Sie die Vorlage noch schneller anwenden: Markieren Sie den gewünschten Text und betätigen Sie die gewählte Tastenkombination.
Um die Vorlage wieder zu entfernen, weisen Sie dem Text die Zeichenvorlage "Normal" zu. Text, dem eine Zeichenvorlage zugewiesen wurde, lässt sich aber natürlich auch weiterhin über den Menübefehl Format > Zeichen formatieren.

Zeichenvorlagen ändern

Selbstverständlich können Sie Zeichenvorlagen jederzeit abändern.

**Hinweis:** Wenn Sie eine Zeichenvorlage bearbeiten, ändert sich die Formatierung aller Textstellen, die mit dieser Vorlage formatiert wurden! Dies gilt allerdings nur eingeschränkt für Text, bei dem Sie die Formatierung nach dem Zuweisen der Formatvorlage manuell geändert haben (siehe nächster Abschnitt).

Um eine Zeichenvorlage zu bearbeiten, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf.
2. Wählen Sie die zu ändernde Vorlage in der Liste.
4. Nehmen Sie die gewünschten Änderungen an der Vorlage vor.
5. Klicken Sie auf OK.
6. Verlassen Sie das Dialogfenster mit Schließen.

Die Vorlage wurde nun entsprechend geändert.

Bestimmen, welche Vorlagen in der Liste angezeigt werden

Standardmäßig werden im obigen Dialog nur die Vorlagen angezeigt, die in Benutzung sind oder von Ihnen selbst angelegt wurden. Wenn Sie alle verfügbaren Vorlagen sehen möchten, wählen Sie bei Anzeigen die Option Alle Vorlagen. Es erscheinen dann auch alle vorgefertigten Vorlagen in der Liste.

Eine Vorlage aus bestehendem Text aktualisieren

Die Schaltfläche Aktualisieren im obigen Dialog erlaubt es Ihnen, eine Formatvorlage "aus dem Text" zu aktualisieren.

Betätigen Sie diese Schaltfläche, wird die Formatierung des momentan selektierten Textes auf die gewählte Vorlage übertragen. Die Vorlage übernimmt also exakt die Formatierung dieses Textabschnitts.

Gehen Sie dazu wie folgt vor:

1. Bringen Sie an einem Textabschnitt die gewünschten Zeichenformatierungen an (Schriftart, Schriftgröße etc.).
2. Setzen Sie die Schreibmarke in diesen Textabschnitt (oder markieren Sie ihn; beides funktioniert gleichermaßen).
4. Wählen Sie die gewünschte Vorlage in der Liste.
5. Klicken Sie auf Aktualisieren.
Die Vorlage "vergisst" nun ihre alten Formatierungseinstellungen und übernimmt die Formatierung des gewählten Textabschnitts. (Sie können die Formatierung der Vorlage aber natürlich auch weiterhin jederzeit ändern – unabhängig von diesem Textabschnitt.)

**Vorlagen löschen oder umbenennen**

Um eine Vorlage im aktuellen Dokument zu löschen, selektieren Sie diese im obigen Dialog per Mausklick und klicken auf die Schaltfläche **Löschen**. Um ihr einen neuen Namen zu geben, klicken Sie auf **Umbenen-nen** und tippen den neuen Namen ein.

Hinweis: Bei den vorgefertigten Vorlagen ist die Schaltfläche **Löschen** nicht verfügbar.

Um die Formatvorlagen in einer **Dokumentvorlage** zu löschen oder umzubenennen, öffnen Sie die Dokumentvorlage, nehmen die Änderungen darin vor und speichern dann die Dokumentvorlage.

---

**Geltungsbereich von Zeichenvorlagen**

Sie haben eine Zeichenvorlage verändert, an manchen Textstellen, denen diese Vorlage zugewiesen wurde, ist aber nichts passiert? Das liegt daran, dass diese Stellen nachträglich von Hand umformatiert wurden. Ein Beispiel:

Nehmen wir an, Sie definieren eine Vorlage mit der Schrift Arial und wenden diese an. Wenn Sie jetzt die Schrift der Vorlage beispielsweise auf Times New Roman ändern, verändern sich alle Abschnitte, die in dieser Vorlage formatiert wurden, entsprechend.

*Aber:* Haben Sie in einem dieser Textabschnitte später über den Menübefehl **Format > Zeichen** oder die Formatleiste eine völlig andere Schrift gewählt, wirkt sich die Änderung der Zeichenvorlage *nicht* mehr auf den Abschnitt aus. Von Hand angebrachte Zeichenformatierungen haben nämlich eine höhere Priorität als Vorlagen.

Möchten Sie, dass der betroffene Textabschnitt wieder von seiner manuellen Formatierung "befreit" wird, rufen Sie den Menübefehl **Format > Standard** auf. Jetzt hat der Abschnitt wieder die in der Zeichenvorlage festgelegte Formatierung.

---

**Zeichenvorlage Normal**

Die Zeichenvorlage namens "Normal" existiert standardmäßig in jedem Dokument und hat eine besondere Bedeutung. Sie ist die Standardvorlage für den Text. Solange Sie in einem neuen Dokument einfach Text tippen, wird diesem automatisch die Vorlage "Normal" zugewiesen, sofern an der aktuellen Position nicht schon eine andere Vorlage gewählt wurde.

Ändern Sie beispielsweise die Schriftart der Vorlage "Normal", ändert sich die Schrift des kompletten Textes (sofern Sie ihm nicht mit dem Menübefehl **Format > Zeichen** eine andere Schrift gegeben haben). Weiterhin haben Sie auf diese Weise die Standardschrift für zukünftige Eingaben geändert.
Verknüpfte Zeichenvorlagen erstellen

Wenn Sie, wie zu Beginn dieses Abschnittes beschrieben, neue Zeichenvorlagen erstellen, basieren diese stets auf der Zeichenvorlage "Normal". Wählen Sie also beispielsweise für die Vorlage "Normal" eine neue Schriftart, ändert sich die Schrift auch in allen anderen Zeichenvorlagen – sofern dort nicht explizit eine andere Schrift gewählt wurde.

*Also:* Standardmäßig sind also alle Zeichenvorlagen mit der Vorlage "Normal" verknüpft. Sie können allerdings beim Erstellen einer neuen Vorlage unter Basierend auf eine beliebige andere Zeichenvorlage als Basis angeben.

Um eine Zeichenvorlage zu erstellen und diese auf einer anderen Vorlage als "Normal" basieren zu lassen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Format > Zeichenvorlage** auf.
2. Klicken Sie auf die Schaltfläche **Neu**.
3. Geben Sie der Vorlage einen Namen.
4. Wechseln Sie auf die Karteikarte **Vorlage**.
5. **Jetzt kommt der entscheidende Schritt:** Wählen Sie unter Basierend auf die Vorlage, mit der die neue Vorlage verknüpft sein soll.
6. Nun können Sie die gewünschte Formatierung wählen etc.

**Ein Anwendungsbeispiel:**

Nehmen wir an, dass Sie für die Überschriften Ihrer Doktorarbeit eine markante Schrift und Fettdruck verwenden möchten. Je nachdem, wie wichtig die Überschrift ist, möchten Sie aber verschiedene Schriftgrößen einsetzen.

Dazu gehen Sie folgendermaßen vor:

1. Erstellen Sie sich zuerst eine Zeichenvorlage "Überschriften1" für die Hauptüberschriften. Hier wählen Sie eine andere Schrift in der Größe 24 Punkt und schalten Fettdruck ein.
2. Dann legen Sie eine Zeichenvorlage "Überschriften2" an, wählen bei Basierend auf die Vorlage "Überschriften1" und stellen bei der Schriftgröße 18 Punkt ein.
3. Für die nächste Unterebene folgt die Zeichenvorlage "Überschriften3", die wir auf "Überschriften2" basieren lassen und als Schriftgröße 14 Punkt wählen usw.

Vorteil: Fällt Ihnen später ein, dass eine andere Schrift für die Überschriften besser geeignet ist, müssen Sie lediglich die Schriftart in der Zeichenvorlage "Überschriften1" ändern, und schon werden alle Überschriften mit den Vorlagen "Überschriften1" bis "Überschriften3" in dieser Schrift formatiert. Hätten Sie die Vorlagen auf "Normal" basieren lassen, hätte jede Vorlage einzeln geändert werden müssen.

**Relative Schriftgröße**

Wenn Sie eine Vorlage auf einer anderen basieren lassen, können Sie auf Wunsch sogar die relative Schriftgröße angeben. Sie können zum Beispiel festlegen, dass die Schriftgröße der Vorlage X stets 80% der Schriftgröße von Vorlage Y betragen soll.

Gehen Sie dazu wie folgt vor:
1. Rufen Sie den Menübefehl **Format > Zeichenvorlage** auf.
2. Selektieren Sie eine Vorlage und klicken Sie auf **Bearbeiten**.
3. Wechseln Sie auf die Karteikarte **Vorlage**.
4. Schalten Sie die Option **Größe** ein.
5. Tragen Sie den gewünschten Faktor in Prozent ein – zum Beispiel 80.
6. Bestätigen Sie mit **OK**.

Die Schriftgröße einer so bearbeiteten Vorlage wird nun stets 80% der Vorlage betragen, auf der sie basiert.

---

**Zeichenvorlagen und die Seitenleiste**

Auf den vorherigen Seiten haben Sie erfahren, wie Sie Zeichenvorlagen erstellen, anwenden und bearbeiten. Alternativ lassen sich solche Aufgaben auch über einen sehr nützlichen Helfer erledigen: der **Seitenleiste**.

Die Seitenleiste zeigt auf Wunsch eine Liste aller verfügbaren Zeichenvorlagen an. Um Text in einer dieser Vorlagen zu formatieren, markieren Sie einfach die gewünschten Zeichen und führen dann einen Doppelklick auf die Vorlage in der Seitenleiste durch.

Darüber hinaus können Sie Zeichenvorlagen in der Seitenleiste auch bearbeiten und verwalten. Sie müssen die Seitenleiste dazu einfach nur einschalten und darin die Funktion "Zeichenvorlagen" auswählen. Das geht folgendermaßen:

1. Falls die Seitenleiste nicht sichtbar ist, schalten Sie diese zunächst ein, indem Sie beispielsweise den Menübefehl **Ansicht > Seitenleiste > Rechts anzeigen** aufrufen.
2. Klicken Sie auf das Symbol in der kleinen Funktionsleiste ganz oben in der Seitenleiste. Damit schalten Sie die Seitenleiste auf die Funktion "Zeichenvorlagen" um.

Die Seitenleiste zeigt nun alle Zeichenvorlagen im Dokument an, und Sie können damit folgende Aktionen durchführen:

- **Zeichenvorlage anwenden**
  Markieren Sie die zu formatierenden Zeichen im Dokument. Führen Sie dann einen Doppelklick auf die gewünschte Vorlage in der Seitenleiste durch.
  (Alternativ können Sie die Vorlage auch mit einem einfachen Mausklick auswählen und dann die Schaltfläche **Anwenden** am unteren Ende der Seitenleiste anklicken.)

- **Zeichenvorlage bearbeiten**
  Wählen Sie die gewünschte Vorlage in der Seitenleiste mit einem einfachen Mausklick aus. Klicken Sie dann auf die Schaltfläche **Bearbeiten** am unteren Ende der Seitenleiste.

- **Zeichenvorlagen verwalten**
  Wählen Sie die gewünschte Vorlage in der Seitenleiste mit einem einfachen Mausklick aus. Klicken Sie dann auf die Schaltfläche **Verwalten** am unteren Ende der Seitenleiste.

Es erscheint ein Menü mit Befehlen zum Verwalten Ihrer Vorlagen (neu erstellen, aktualisieren, umbenennen, löschen etc.). Wählen Sie darin die gewünschte Funktion. Detaillierte Informationen zu den einzelnen Befehlen finden Sie im Verlaufe des Abschnitts Zeichenvorlagen.
Tipp: Dieses Menü lässt sich noch schneller aufrufen: mit einem Rechtsklick auf eine Vorlage in der Seitenleiste.

- **Neue Zeichenvorlage erstellen**
  
  Führen Sie einen Rechtsklick auf diejenige Vorlage in der Seitenleiste durch, auf der die neue Vorlage basieren soll. Es erscheint das gerade erwähnte Menü. Wählen Sie darin den Befehl Neu... aus.

---

## Absatzvorlagen

In einer Absatzvorlage können Sie ein häufig benötigtes Absatzformat (Einzüge, Tabulatoren, Ausrichtung etc.) speichern und es dann immer wieder auf beliebige Absätze anwenden.

Möchten Sie beispielsweise die Überschriften in Ihrem Dokument in einer größeren, fetten Schrift gedruckt und zentriert ausgerichtet haben, erstellen Sie sich einfach eine Absatzvorlage "Überschrift" und wenden diese auf die gewünschten Absätze an.

*Anmerkung:* Der Unterschied zwischen Zeichenvorlagen (siehe Abschnitt Zeichenvorlagen) und Absatzvorlagen liegt darin, dass in Zeichenvorlagen nur das Zeichenformat (Schriftart, Textauszeichnungen etc.) gespeichert wird, in Absatzvorlagen hingegen sowohl das Absatzformat als auch das Zeichenformat.

Weiterhin sind Zeichenvorlagen auch auf einzelne Zeichen anwendbar, Absatzvorlagen hingegen nur auf komplette Absätze.

Auf den nächsten Seiten finden Sie ausführliche Informationen zum Arbeiten mit Absatzvorlagen. Folgende Themen werden darin behandelt:

- **Absatzvorlagen erstellen**
- **Absatzvorlagen anwenden**
- **Absatzvorlagen ändern**
- **Geltungsbereich von Absatzvorlagen**
- **Absatzvorlage Normal**
- **Verknüpfte Absatzvorlagen erstellen**
- **Absatzvorlagen und die Seitenleiste**

---

## Absatzvorlagen erstellen

Um eine Absatzvorlage zu erstellen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Format > Absatzvorlage** auf.
2. Klicken Sie auf die Schaltfläche Neu.


5. Tipp: Wenn Sie die Formatvorlage häufig benötigen, können Sie ihr ein Tastenkürzel zuordnen (siehe unten).

6. Wurden alle Einstellungen vorgenommen, klicken Sie auf OK, um die Vorlage zu erzeugen.


Erstellen einer Absatzvorlage aus markiertem Text

Alternativ können Sie auch erst Text nach Wunsch formatieren und dann eine neue Vorlage erstellen, die genau diese Formatierung übernimmt. Verwenden Sie dazu die Schaltfläche Neu aus Markierung statt der Schaltfläche Neu.

Diese Vorgehensweise ist praktisch, wenn Sie Absätze zuvor "von Hand" formatiert haben und nun eine Absatzvorlage mit exakt dieser Absatzformatierung anlegen möchten.

Im Detail gehen Sie dazu wie folgt vor:

1. Bringen Sie an einem oder mehreren Absätzen die gewünschten Absatzformatierungen an (Einzüge, Zeilenabstand, Absatzausrichtung etc.).

2. Setzen Sie die Schreibmarke in einen dieser Absätze (oder markieren Sie die Absätze; beides funktioniert gleichermaßen).
3. Erstellen Sie, wie weiter oben beschrieben, mit dem Menübefehl **Format > Absatzvorlage** eine neue Absatzvorlage. Wichtig: Verwenden Sie dabei aber nicht die Schaltfläche **Neu**, sondern die Schaltfläche **Neu aus Markierung**.

Eine so erzeugte Vorlage verhält sich genau wie alle anderen Vorlagen. Der einzige Unterschied ist, dass sie beim Anlegen die Formatierung von bestehendem Text übernimmt. Sie können ihre Formatierung aber natürlich jederzeit ändern.

### Die Option "Nächste Vorlage" – oder: in welcher Vorlage soll der nächste Absatz formatiert werden?

Jedes Mal, wenn Sie einen Absatz mit einer bestimmten Vorlage durch Betätigen der **Eingabetaste** abschließen, erhält der nächste Absatz automatisch die gleiche Vorlage.

Dies ist in manchen Fällen allerdings unpraktisch. Überschriften bestehen beispielsweise meist nur aus einem Absatz, und danach möchte man wieder normalen Text tippen, also beispielsweise die Vorlage "Normal" verwenden.

Deshalb können Sie bei jeder Absatzvorlage angeben, welche Vorlage der nächste Absatz erhalten soll, wenn Sie die **Eingabetaste** drücken. Wechseln Sie dazu im Dialog zum Bearbeiten der Vorlage auf die Karteikarte **Vorlage**. Wählen Sie dann bei **Nächste Vorlage** die gewünschte Vorlage – in unserem Beispiel also die Vorlage "Normal".

### Tastenkürzel verwenden

Benötigen Sie eine Formatvorlage besonders häufig, können Sie ihr jederzeit ein Tastenkürzel geben. Das hat den Vorteil, dass Sie die Vorlage blitzschnell mit einem einzigen Tastendruck aktivieren können.

Um einer Vorlage ein Tastenkürzel zuzuordnen, wechseln Sie im Dialog zum Bearbeiten der Vorlage auf die Karteikarte **Vorlage**. Setzen Sie dann die Schreibmarke in das Eingabefeld **Tastenkürzel** und betätigen Sie die gewünschte Tastenkombination.

*Hinweis:* Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird unter dem Eingabefeld **Tastenkürzel** angezeigt, womit diese momentan belegt ist. Sie sollten dann die Rücktaste betätigen, um das Tastenkürzel wieder zu löschen und eine andere Tastenkombination verwenden. Andernfalls überschreiben Sie die Tastenkombination einer anderen Vorlage oder eines TextMaker-Befehls.

Wir empfehlen Ihnen, stets Tastenkombinationen mit den Tasten **Strg und Umschalt** zu verwenden, da diese normalerweise nicht belegt sind.

### Absatzvorlagen anwenden

Um eine Absatzvorlage anzuwenden, gehen Sie folgendermaßen vor:

1. Setzen Sie die Schreibmarke in den Absatz, auf den Sie die Vorlage anwenden möchten (oder markieren Sie mehrere Absätze).
2. Rufen Sie den Menübefehl **Format > Absatzvorlage** auf.
3. Wählen Sie die gewünschte Vorlage.
**Tipp:** In der rechten Hälfte des Dialogs wird eine kleine Vorschau der momentan ausgewählten Vorlage präsentiert. Sie können diese Vorschau über die Schaltflächen >> beziehungsweise << jederzeit ein- oder ausschalten.

4. Klicken Sie auf **Anwenden**.

Sofort ändert sich die Formatierung der markierten Absätze so, wie Sie es in der Absatzvorlage festgelegt hatten.

**Tipp 1:** Ganz links in der Formatleiste wird stets die für den aktuellen Absatz gewählte Absatzvorlage angezeigt. Sie können hier jederzeit auf eine andere Vorlage wechseln (nachdem Sie die Liste durch einen Mausklick auf das Pfeilchen rechts daneben geöffnet haben).

**Tipp 2:** Haben Sie der Formatvorlage ein Tastenkürzel zugewiesen, können Sie die Vorlage sogar noch schneller anwenden: Betätigen Sie einfach die gewählte Tastenkombination.

**Tipp 3:** Außerdem können Sie die Seitenleiste verwenden, um Formatvorlagen anzuwenden und auch zu bearbeiten. Siehe Abschnitt Absatzvorlagen und die Seitenleiste.

---

**Absatzvorlagen ändern**

Naturally können Sie Absatzvorlagen jederzeit abändern.

**Hinweis:** Wenn Sie eine Absatzvorlage bearbeiten, ändert sich die Formatierung aller Absätze, die mit dieser Vorlage formatiert wurden! Dies gilt allerdings nur eingeschränkt für Absätze, in denen Sie die Absatzformatierung nach dem Zuweisen der Vorlage manuell geändert haben (siehe nächster Abschnitt).

Um eine Absatzvorlage zu bearbeiten, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Format > Absatzvorlage** auf.
2. Wählen Sie die zu ändernde Vorlage in der Liste.
3. Klicken Sie auf **Bearbeiten**.
4. Nehmen Sie die gewünschten Änderungen an der Vorlage vor.
5. Klicken Sie auf **OK**.
6. Verlassen Sie das Dialogfenster mit **Schließen**.

Die Vorlage wurde nun entsprechend geändert.

**Bestimmen, welche Vorlagen in der Liste angezeigt werden**

Standardmäßig werden im obigen Dialog nur diejenigen Vorlagen angezeigt, die in Benutzung sind oder von Ihnen selbst modifiziert wurden. Wenn Sie alle verfügbaren Vorlagen sehen möchten, wählen Sie bei **Anzeigen** die Option **Alle Vorlagen**. Es erscheinen dann auch alle vorgefertigten Vorlagen in der Liste.
Eine Vorlage aus bestehendem Text aktualisieren

Die Schaltfläche Aktualisieren im obigen Dialog erlaubt es Ihnen, eine Formatvorlage "aus dem Text" zu aktualisieren.

Betätigen Sie diese Schaltfläche, wird die Formatierung des momentan selektierten Textes auf die gewählte Vorlage übertragen. Die Vorlage übernimmt also exakt die Formatierung dieses Textabschnitts.

Gehen Sie dazu wie folgt vor:

1. Bringen Sie an einem oder mehreren Absätzen die gewünschten Absatzformatierungen an (Einzüge, Zeilenabstand, Absatzausrichtung etc.).
2. Setzen Sie die Schreibmarke in einen dieser Absätze (oder markieren Sie die Absätze; beides funktioniert gleichermaßen).
4. Wählen Sie die gewünschte Vorlage in der Liste.
5. Klicken Sie auf Aktualisieren.

Die Vorlage "vergisst" nun ihre alten Formatierungseinstellungen und übernimmt die Formatierung des gewählten Textabschnitts. (Sie können die Formatierung der Vorlage aber natürlich auch weiterhin jederzeit ändern – unabhängig von diesem Textabschnitt.)

Vorlagen löschen oder umbenennen

Um eine Vorlage im aktuellen Dokument zu löschen, selektieren Sie diese im obigen Dialog per Mausklick und klicken auf die Schaltfläche Löschen. Um ihr einen neuen Namen zu geben, klicken Sie auf Umbenennen und tippen den neuen Namen ein.

Hinweis: Bei den vorgefertigten Vorlagen ist die Schaltfläche Löschen nicht verfügbar.

Um die Formatvorlagen in einer Dokumentvorlage zu löschen oder umzubenennen, öffnen Sie die Dokumentvorlage, nehmen die Änderungen darin vor und speichern dann die Dokumentvorlage.

Geltungsbereich von Absatzvorlagen

Sie haben eine Absatzvorlage geändert, in manchen Absätzen, denen diese Vorlage zugewiesen wurde, ist aber nichts passiert? Das liegt daran, dass diese Absätze nachträglich von Hand umformatiert wurden. Ein Beispiel:

Nehmen wir an, Sie definieren eine Vorlage, in der die Absatzausrichtung auf zentriert gesetzt wird. Ändern Sie jetzt die Ausrichtung in der Vorlage auf rechtsbündig, ändern sich alle in dieser Vorlage formatierten Absätze entsprechend.


Möchten Sie, dass der betroffene Absatz wieder von der manuellen Formatierung "befreit" wird, markieren Sie ihn einfach und weisen ihm mit dem Menübefehl Format > Absatzvorlage die gleiche Formatvorlage erneut zu. Jetzt wird der Absatz erstens wieder der Vorlage entsprechend formatiert, zweitens wirken sich Änderungen an der Vorlage auf ihn aus.
### Absatzvorlage Normal

Die Absatzvorlage "Normal" existiert standardmäßig in jedem Dokument. Sie hat eine besondere Bedeutung: Sie ist die Standardvorlage für die Absatzformatierung im Dokument. Solange Sie in einem neuen Dokument einfach Text tippen, wird diesem automatisch die Vorlage "Normal" zugewiesen, sofern an der aktuellen Position nicht schon eine andere Vorlage gewählt wurde.


### Verknüpfte Absatzvorlagen erstellen

Wenn Sie, wie zu Beginn dieses Abschnittes beschrieben, neue Absatzvorlagen erstellen, basieren diese stets auf der Absatzvorlage "Normal". Wählen Sie also beispielsweise für die Vorlage "Normal" einen neuen Zeilenabstand, ändert sich dieser in allen Absatzvorlagen – sofern dort nicht explizit ein anderer Zeilenabstand gewählt wurde.

> Also: Standardmäßig sind also alle Absatzvorlagen mit der Vorlage "Normal" verknüpft. Sie können allerdings beim Erstellen einer neuen Vorlage unter Basierend auf eine beliebige andere Absatzvorlage als Basis angeben.

Um eine Absatzvorlage zu erstellen und diese auf einer anderen Vorlage als "Normal" basieren zu lassen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Format > Absatzvorlage auf.
2. Klicken Sie auf die Schaltfläche Neu.
3. Geben Sie der Vorlage einen Namen.
4. Wechseln Sie auf die Karteikarte Vorlage.
6. Nun können Sie die gewünschte Formatierung wählen etc.

In der gedruckten Fassung dieses Handbuchs basieren beispielsweise die Vorlagen für alle Ebenen der Überschriften auf einer Absatzvorlage, in der unter anderem der Abstand zum vorherigen Absatz erhöht wurde.

Als wir später feststellten, dass dieser Abstand zu klein ist, mussten wir ihn lediglich bei der einen Vorlage vergrößern, und alle Überschriften erhielten mehr Abstand zum vorherigen Absatz. Hätten wir die Vorlagen auf "Normal" basieren lassen, hätte jede Überschriftenvorlage einzeln geändert werden müssen.
Absatzvorlagen und die Seitenleiste

Auf den vorherigen Seiten haben Sie erfahren, wie Sie Absatzvorlagen erstellen, anwenden und bearbeiten. Alternativ lassen sich solche Aufgaben auch über einen sehr nützlichen Helfer erledigen: der Seitenleiste.

Die Seitenleiste zeigt auf Wunsch eine Liste aller verfügbaren Absatzvorlagen an. Um einen Absatz in einer dieser Vorlagen zu formatieren, setzen Sie einfach die Schreibmarke in den Absatz und führen dann einen Doppelklick auf die Vorlage in der Seitenleiste durch.

Darüber hinaus können Sie Absatzvorlagen in der Seitenleiste auch bearbeiten und verwalten. Sie müssen die Seitenleiste dazu einfach nur einschalten und darin die Funktion "Absatzvorlagen" auswählen. Das geht folgendermaßen:

1. Falls die Seitenleiste nicht sichtbar ist, schalten Sie diese zunächst ein, indem Sie beispielsweise den Menübefehl Ansicht > Seitenleiste > Rechts anzeigen aufrufen.

2. Klicken Sie auf das Symbol im in der kleinen Funktionsleiste ganz oben in der Seitenleiste. Damit schalten Sie die Seitenleiste auf die Funktion "Absatzvorlagen" um.

Die Seitenleiste zeigt nun alle Absatzvorlagen im Dokument an, und Sie können damit folgende Aktionen durchführen:

- **Absatzvorlage anwenden**
  
  Setzen Sie die Schreibmarke in den gewünschten Absatz (oder markieren Sie mehrere Absätze). Führen Sie dann einen Doppelklick auf die gewünschte Vorlage in der Seitenleiste durch.

  (Alternativ können Sie die Vorlage auch mit einem einfachen Mausklick auswählen und dann die Schaltfläche Anwenden am unteren Ende der Seitenleiste anklicken.)

- **Absatzvorlage bearbeiten**
  
  Wählen Sie die gewünschte Vorlage in der Seitenleiste mit einem einfachen Mausklick aus. Klicken Sie dann auf die Schaltfläche Bearbeiten am unteren Ende der Seitenleiste.

- **Absatzvorslagen verwaltende**
  
  Wählen Sie die gewünschte Vorlage in der Seitenleiste mit einem einfachen Mausklick aus. Klicken Sie dann auf die Schaltfläche Verwalten am unteren Ende der Seitenleiste.

  Es erscheint ein Menü mit Befehlen zum Verwalten Ihrer Vorlagen (neu erstellen, aktualisieren, umbenennen, löschen etc.). Wählen Sie darin die gewünschte Funktion. Detaillierte Informationen zu den einzelnen Befehlen finden Sie im Verlaufe des Abschnitts Absatzvorlagen.

  Tipp: Dieses Menü lässt sich noch schneller aufrufen: mit einem Rechtsklick auf eine Vorlage in der Seitenleiste.

- **Neue Absatzvorlage erstellen**
  
  Führen Sie einen Rechtsklick auf diejenige Vorlage in der Seitenleiste durch, auf der die neue Vorlage basieren soll. Es erscheint das gerade erwähnte Menü. Wählen Sie darin den Befehl Neu... aus.
Formatvorlagen verwalten

Mit dem integrierten Vorlagenmanager können Sie die Formatvorlagen von Dokumenten verwalten. In erster Linie ist diese Funktion dafür gedacht, die Zeichen- und Absatzvorlagen eines Dokuments in ein anderes kopieren zu können.

Um den Vorlagenmanager zu starten, rufen Sie den Menübefehl Format > Vorlagenmanager auf.

Standardmäßig werden in der linken Liste alle Vorlagen des aktuellen Dokuments angezeigt; die rechte Liste ist leer.

Sie bedienen dieses Dialogfenster über die folgenden Bedienelemente:

**Linke Vorlagenliste**

In der linken Liste werden alle Absatz- und Zeichenvorlagen des aktuellen Dokuments angezeigt. Sie können darin eine oder mehrere Vorlagen selektieren und dann über die Schaltflächen des Dialogs Aktionen damit ausführen. Um mehrere Vorlagen zu selektieren, halten Sie die Taste Strg gedrückt und klicken dann nacheinander die gewünschten Vorlagen an.

Falls Sie ein anderes Dokument in der Liste öffnen möchten, klicken Sie auf die Schaltfläche Öffnen und wählen die gewünschte Datei aus.
Rechte Vorlagenliste


Schaltflächen >> und <<

Mit Hilfe dieser Schaltflächen können Sie Vorlagen zwischen den beiden in dem Dialog geöffneten Dokumenten hin- und herkopieren.

Selektieren Sie dazu eine oder mehrere Vorlagen in einer der Listen. Klicken Sie dann auf die Schaltfläche >>, um die Vorlage(n) von der linken in die rechte Liste zu kopieren. Die Schaltfläche << kopiert Vorlagen von der rechten Liste in die linke.

Falls Sie eine Vorlage kopieren, die im Zildokument bereits existiert, fragt TextMaker erst nach, ob Sie die Vorlage überschreiben möchten.

Schaltfläche Umbenennen

Diese Schaltfläche kann zum Umbenennen von Vorlagen verwendet werden. Selektieren Sie dazu die gewünschte Vorlage, klicken Sie auf Umbenennen und geben Sie den neuen Namen ein.

Hinweis: Die Basisvorlage namens "Normal" kann nicht umbenannt werden.

Schaltfläche Löschen

Diese Schaltfläche kann zum Löschen von Vorlagen verwendet werden. Selektieren Sie dazu die gewünschte(n) Vorlage(n) und klicken Sie auf Löschen.

Hinweis: Die Basisvorlage namens "Normal" kann nicht gelöscht werden.

Schaltfläche Schließen

Diese Schaltfläche beendet den Vorlagenmanager.

Dokumentvorlagen


TextMaker lässt Sie nämlich jedes Mal, wenn Sie mit dem Menübefehl Datei > Neu ein neues Dokument anlegen, auswählen, auf welcher Dokumentvorlage dieses basieren soll. Wählen Sie hier eine von Ihnen erstellte Dokumentvorlage, stehen in dem neuen Dokument genau die Zeichen- und Absatzvorlagen zur Verfügung, die in der Dokumentvorlage gespeichert wurden.

Dokumentvorlagen dürfen auch Text enthalten – zum Beispiel Ihren Briefkopf. So lassen sich zwei Fliegen mit einer Klappe schlagen: Sie können eine Dokumentvorlage mit Ihrem Briefkopf und Ihren Lieblingsvor-
Formatvorlagen

Vorlagen mit Datenbankanbindung

Es kommt aber noch besser: Sie können einer Dokumentvorlage eine Datenbank zuweisen und dann Datenbankfelder darin einfügen. Beim Anlegen eines neuen Dokuments auf Basis dieser Vorlage erscheint dann automatisch die TextMaker-Datenbank, lässt Sie einen Datensatz auswählen und fügt dessen Felder in Ihren Briefkopf, Ihr Faxformular etc. ein!


_Tipp:_ TextMaker liegen zahlreiche vorgefertigte Dokumentvorlagen für Briefe, Faxe etc. bei. Probieren Sie diese einmal aus – einfach den Menübefehl Datei > Neu aufrufen und eine der Vorlagen in den Unterordnern wählen.

Weitere Informationen zu diesem Thema finden Sie im Abschnitt Übernahme von Einzeladressen.

Allgemeine Informationen zum Arbeiten mit Dokumentvorlagen folgen auf den nächsten Seiten.

Dokumentvorlagen erstellen

Um eine neue Dokumentvorlage zu erstellen, gehen Sie folgendermaßen vor:

1. Beginnen Sie ein neues Dokument oder öffnen Sie das Dokument oder die Dokumentvorlage, auf deren Basis die neue Dokumentvorlage erstellt werden soll.
2. Bearbeiten Sie den Text im Dokument, falls die Dokumentvorlage auch Text enthalten soll.
5. Rufen Sie den Menübefehl Datei > Speichern unter auf.
7. TextMaker wechselt nun automatisch in den Ordner, in dem sich die Dokumentvorlagen befinden.
8. Tippen Sie bei Dateiname einen Namen für die Vorlage ein.
9. Bestätigen Sie mit OK.

_Vorlagen auf mehrere Ordner aufteilen:_ Sie können mit der Schaltfläche Neuer Ordner jederzeit einen neuen Ordner im Vorlagenordner anlegen, in diesen wechseln und die Vorlage dort speichern. Auf diese Weise lassen sich Vorlagen je nach Anwendungsgebiet in separaten Ordnern ablegen. Die bei TextMaker mitgelieferten Dokumentvorlagen sind beispielsweise nach Briefköpfen, Memos, Faxformularen etc. aufgeteilt.
Dokumentvorlagen anwenden

Um eine Dokumentvorlage zu verwenden, beginnen Sie einfach mit dem Menübefehl **Datei > Neu** ein neues Dokument. TextMaker fragt Sie dabei automatisch, auf welcher Dokumentvorlage dieses basieren soll.

Gehen Sie also wie folgt vor:

1. Rufen Sie den Menübefehl **Datei > Neu** auf.
2. Es erscheint ein Dialog, in dem Sie die gewünschte Dokumentvorlage auswählen können.
   - In der Liste sehen Sie auch einige Ordner. Diese lassen sich per Doppelklick öffnen. Sie enthalten bereits vorgefertigte Dokumentvorlagen für das Schreiben von Briefen, Faxen etc.
3. Wählen Sie die gewünschte Dokumentvorlage.
   - **Tipp:** In der rechten Hälfte des Dialogs wird eine kleine Vorschau der momentan ausgewählten Vorlage präsentiert. Sie können diese Vorschau über die Schaltflächen >> beziehungsweise << jederzeit ein- oder ausschalten.
4. Bestätigen Sie mit **OK**.

Es wird nun ein neues Dokument angelegt, in dem Ihnen alle in der Dokumentvorlage gespeicherten Zeichen- und Absatzvorlagen zur Verfügung stehen. Auch die Einstellungen in den Dialogen der Menübefehle **Datei > Seite einrichten** und **Datei > Eigenschaften** werden aus der Vorlage übernommen.

Und: Enthält die Dokumentvorlage auch Text, wird dieser entsprechend angezeigt und kann wie ganz normaler Text bearbeitet werden.

- **Tipp:** TextMaker wird mit etlichen vorgefertigten Dokumentvorlagen ausgeliefert. Diese enthalten komplette Briefköpfe, Faxformulare usw. und sind mit der Adressdatenbank **tmw.dbf** verknüpft. Sie erleichtern Ihnen den täglichen Schreibkram ungemein – lesen Sie dazu den Abschnitt Übernahme von Einzeladressen!

Dokumentvorlagen ändern

Das Ändern einer Dokumentvorlage unterscheidet sich nicht weiter vom Bearbeiten eines normalen Dokuments. Sie öffnen die Vorlage, nehmen Ihre Änderungen vor und speichern die Dokumentvorlage.

- **Wichtig:** Wenn Sie eine Dokumentvorlage abändern, wirkt sich das natürlich auf alle Dokumente aus, die Sie später auf Basis dieser Vorlage erstellen.

Um eine Dokumentvorlage abzuändern, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Datei > Öffnen** auf.
2. Wählen Sie in der Liste der Dateitypen den Eintrag **Dokumentvorlage**.
3. Suchen Sie sich die zu ändernde Vorlage aus und bestätigen Sie mit **OK**.
5. Rufen Sie den Menübefehl **Datei > Speichern** auf, um geänderte Vorlage zu speichern.

Sie können die Vorlage natürlich auch mit dem Menübefehl **Datei > Speichern unter** mit einem anderen Namen sichern, wenn das Original nicht überschrieben werden soll.

---

**Dokumentvorlage Normal.tmvx**

Die Dokumentvorlage *normal.tmvx* ist die Standardvorlage für neue Dokumente. Wenn Sie den Menübefehl **Datei > Neu** aufrufen, wird stets diese Vorlage vorgegeben. Sie enthält keinerlei Text und lediglich die Standardzeichenvorlage "Normal" sowie die Standardabsatzvorlage "Normal" und einige Vorschriften für Überschriften.

Dementsprechend eignet sich die Dokumentvorlage *normal.tmvx* gut als Basis, wenn Sie eine völlig neue Dokumentvorlage erstellen möchten, in der zu Beginn nichts eingetragen sein soll.

**Wichtig:** Die Standardvorlage *normal.tmvx* sollten Sie normalerweise nicht ändern. Wenn Sie dies trotzdem tun, sollten Sie sich bewusst sein, dass *normal.tmvx* die Standardwerte für die Seiten- Absatz- und Zeichenformatierung sowie viele weitere Vorschriften enthält. Eine Änderung wirkt sich auf alle Dokumente aus, die anschließend auf Basis der Standardvorlage *normal.tmvx* neu erstellt werden.

Möchten Sie also beispielsweise die Standardschrift für alle Dokumente ändern, die in Zukunft auf Basis der Vorlage *normal.tmvx* erstellt werden, dann öffnen Sie diese Vorlage, ändern die Zeichenformatierung der Absatzvorlage "Normal" und speichern die Vorlage.

Übrigens können Sie für neue Dateien auch eine andere Standardvorlage wählen. Rufen Sie dazu den Menübefehl **Datei > Neu** auf, wählen Sie die gewünschte Vorlage und klicken Sie auf **Neuer Standard**. Ab jetzt bietet Ihnen TextMaker beim Anlegen neuer Dokumente stets diese Vorlage als Standardvorlage an.
Mehrspaltendruck

In TextMaker haben Sie die Möglichkeit, Text in mehreren Spalten nebeneinander auszudrucken. Sie können die Anzahl der Spalten innerhalb eines Dokuments beliebig oft ändern.


Ausführliche Informationen zum Einrichten von mehrspaltigem Text folgen auf den nächsten Seiten.

Ändern der Spaltenzahl eines Textabschnitts

Um beispielsweise einen einspaltigen Textabschnitt zu einem dreispaltigen Text umzuformatieren, müssen Sie diesen nur markieren und mit dem Menübefehl Format > Bereich die Zahl der Spalten ändern.

Gehen Sie dazu folgendermaßen vor:
1. Markieren Sie den Text, dessen Spaltenzahl Sie ändern möchten.
2. Rufen Sie den Menübefehl Format > Bereich auf.
3. **Wichtig:** Wählen Sie unter **Anwenden auf** die Option **Markierter Text**.

4. Tragen Sie bei **Zahl** ein, wie viele Spalten Sie wünschen.


6. Bestätigen Sie mit **OK**

Der markierte Text wird nun in der entsprechenden Spaltenzahl formatiert.

Soll ein mehrspaltiger Text wieder einspaltig werden, verfahren Sie wie oben beschrieben, tragen aber als Zahl der Spalten "1" ein.

Das Dialogfenster des Menübefehls **Format > Bereich** verfügt zusätzlich über folgende Optionen:

**Karteikarte Spalten**

Auf der Karteikarte **Spalten** legen Sie die Anzahl und das Format der Spalten fest:

- **Rubrik Voreinstellungen**
  
  Hier können Sie per Mausklick unter verschiedenen vordefinierten Spalten-Layouts wählen.

- **Rubrik Spalten**
  
  Lässt Sie Anzahl, Breite und Abstand der Spalten bestimmen.
Bei **Anzahl** geben Sie die gewünschte Spaltenzahl an.

Bei **Breite** und **Abstand** legen Sie die Spaltenbreiten und den Abstand zwischen den Spalten fest. Ist dabei die Option **Gleiche Breite** aktiviert, haben alle Spalten die gleiche Breite und den gleichen Abstand. Schalten Sie diese Option aus, können Sie pro Spalte unterschiedliche Breiten und Abstände einstellen.

- **Rubrik Höhe**
  Lässt Sie die Höhe der Spalten bestimmen:
  - **Automatisch**: Wenn Sie diese Einstellung wählen, passt TextMaker die Spaltenhöhe automatisch an die Textlänge an, so dass alle Spalten gleich hoch sind.
  - **Seitenhöhe**: Bei dieser Einstellung laufen die Spalten über die gesamte Seitenhöhe – unabhängig von der Textlänge.
  - **Feste Höhe**: Wählen Sie diese Einstellung, können Sie eine feste Spaltenhöhe festlegen.

- **Seitenumbruch**
  Ist diese Option aktiviert, führt TextMaker vor dem mehrspaltigen Bereich einen Seitenumbruch durch.

- **Auto-Nummern zurücksetzen**

- **Schreibrichtung**
  Für Text in *arabischer* Schrift können Sie hier die Schreibrichtung eines mehrspaltigen Textbereichs ändern. Wenn Sie die Richtung auf rechts-nach-links setzen, ist nicht mehr die Spalte ganz links die erste Spalte, sondern die Spalte ganz rechts. Siehe auch Kapitel [Arbeiten mit arabischem Text](#).

- **Schaltfläche Ränder**
  Hier können Sie die Ränder des Bereichs ändern, also unter anderem festlegen, wie viel Abstand TextMaker oberhalb und unterhalb des Bereichs freihalten soll.

- **Schaltfläche Zwischenlinie**
  Klicken Sie auf diese Schaltfläche, wenn Sie eine vertikale Linie zwischen den Spalten des mehrspaltigen Textes anbringen möchten.
  Es erscheint dazu ein Dialog, in dem Sie den gewünschten Linienstil, die Linienstärke etc. bestimmen können.
  Wenn Sie die Linie wieder entfernen möchten, wählen Sie bei **Linienstil** die Option **Keine Linie**.

- **Anwenden auf:**
  Bestimmt, auf welchen Teil des Dokuments sich die in diesem Dialog getätigten Einstellungen auswirken sollen:

  - **Gesamtes Dokument**: Das gesamte Dokument.
  - **Von hier an**: Den Textabschnitt von der Schreibmarke bis zum Ende des Dokuments.
  - **Markierter Text**: Den markierten Text.
  - **Aktueller Bereich**: Den aktuellen Bereich des Textes. Ein Bereich ist ein Textabschnitt mit gleicher Spaltenzahl (siehe auch nächster Abschnitt).
  - **Markierte Bereiche**: Alle Bereiche vom Beginn der Markierung bis zu deren Ende.
**Bis zum Ende des Bereichs:** Den Textabschnitt von der Schreibmarke bis zum Ende des aktuellen Bereichs.

**Karteikarte Zeilenummern**

Die Karteikarte Zeilenummern ist nicht für den Mehrspaltendruck zuständig, sondern erlaubt es Ihnen, dem Dokument Zeilenummern im linken Seitenrand hinzufügen. Informationen dazu finden Sie im Abschnitt [Zeilenummern anbringen](#).

---

**Was sind Bereiche?**

Im vorherigen Abschnitten wurde mehrmals der Begriff "Bereich" erwähnt. Was aber sind Bereiche? Ganz einfach: Als **Bereich** wird ein Textabschnitt bezeichnet, in dem die Zahl der Spalten einheitlich ist.

Ein Beispiel: Sie haben in der Mitte eines ansonsten einspaltigen Dokuments einen Textabschnitt markiert und diesen zweispaltig formatiert.

Somit ergeben sich drei Bereiche: Ein einspaltiger Bereich am Beginn des Dokuments, ein zweispaltiger Bereich in der Mitte und ein einspaltiger Bereich am Schluss.

Wenn Sie nun den zweispaltigen Bereich in der Mitte doch lieber dreispaltig formatieren möchten, bewegen Sie die Schreibmarke einfach an eine beliebige Stelle innerhalb dieses Bereichs und rufen den Menübefehl **Format > Bereich** auf. Wählen Sie bei Anwenden auf die Option **Aktueller Bereich** und ändern Sie die Spaltenzahl auf 3. Schon wird der zweispaltige Bereich zu einem dreispaltigen.

**Bereichsumbruch einfügen:** Mit dem Menübefehl **Einfügen > Umbruch > Bereichsumbruch** können Sie einen Bereich in zwei Bereiche unterteilen. Auf diese Weise lassen sich Dokumente in mehrere Bereiche unterteilen. Jeder Bereich kann mit einer anderen Spaltenzahl formatiert werden.

**Seitenumbruch vor Bereichen:** Normalerweise macht TextMaker zwischen zwei Bereichen keinen Seitenumbruch, sondern lässt den Text einfach weiterlaufen. Möchten Sie hingegen, dass vor einem bestimmten Bereich stets ein Seitenumbruch durchgeführt werden soll, bewegen Sie die Schreibmarke in diesen Bereich, rufen den Menübefehl **Format > Bereich** auf und schalten im Dialogfenster die Option **Seitenumbruch** ein.
Suchen und Ersetzen

In diesem Kapitel lernen Sie alle Funktionen zum Suchen und Ersetzen von Text und Formatierungen kennen.

- **Suchen und Ersetzen**

  Sie können Begriffe im Text *suchen* und diese auf Wunsch durch andere *ersetzen* lassen.

  Stellen Sie beispielsweise fest, dass sich der mehrmals im Text auftauchende Name "Meier" eigentlich "Meyer" schreibt, so können Sie TextMaker beauftragen, alle "Meier" durch "Meyer" zu ersetzen.

  Weiterhin ist das Suchen und Ersetzen von *Formatierungen* wie Zeichen- oder Absatzformatierungen möglich.

- **Textmarken**

  Eine weitere Möglichkeit zum schnellen Auffinden bestimmter Textstellen bieten *Textmarken*. Dazu setzen Sie an der gewünschten Textstelle eine Textmarke und geben dieser einen Namen. Mit dem Menübefehl *Bearbeiten > Gehe zu ...* können Sie so markierte Textstellen nun jederzeit wieder aufschlagen. Es lassen sich in jedem Dokument beliebig viele Textmarken anbringen.

- **Der Befehl "Gehe zu ..."**

  Darüber hinaus erlaubt der Befehl *Gehe zu ...* auch das Blättern zu bestimmten Textstellen – zum Beispiel zu einer bestimmten *Seite*, einem bestimmten *Kapitel*, einem bestimmten *Objekt* etc.

- **Navigieren mit der Seitenleiste**

  Noch schneller und direkter navigieren Sie in einem Dokument, indem Sie die *Seitenleiste* aktivieren. Diese zeigt am rechten Fensterrand alle Überschriften, Textmarken, Objekte etc. an. Um zur entsprechenden Stelle im Dokument zu springen, genügt ein Mausklick.

  Lesen Sie dazu die nächsten Seiten.

### Suchen

Mit dem Menübefehl *Bearbeiten > Suchen* können Sie ein Dokument nach einem bestimmten Suchbegriff durchsuchen lassen.

Es ist sogar möglich, nach Formatierungen zu suchen – zum Beispiel nach allen fettgedruckten Passagen (siehe Abschnitt *Suchen/Ersetzen von Formatierungen*).
Suchen und Ersetzen

1. Rufen Sie den Menübefehl Bearbeiten > Suchen auf.
2. Geben Sie bei Suchen nach den gesuchten Text ein.
3. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Abschnitt Erweiterte Suchfunktionen).
4. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen.

Wenn der gesuchte Text gefunden wird, springt TextMaker zu der Fundstelle und markiert sie. Sie haben nun folgende Möglichkeiten:

A) Sie klicken auf Weitersuchen, um zur nächsten Fundstelle zu gelangen.
B) Sie beenden den Suchen-Dialog mit Schließen.

Sie können nicht nur nach einem bestimmten Text suchen, sondern diesen auch durch anderen ersetzen lassen. Lesen Sie dazu den nächsten Abschnitt.

Ersetzen

Manchmal geht es nicht nur darum, einen Begriff im Text wiederzufinden. Man will ihn auch gleich gegen einen anderen austauschen. Hierzu dient der Menübefehl Bearbeiten > Ersetzen.

Diesen setzen Sie wie folgt ein:

1. Rufen Sie den Menübefehl Bearbeiten > Ersetzen auf.
2. Geben Sie bei Suchen nach den gesuchten Text ein.
4. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Abschnitt Erweiterte Suchfunktionen).

5. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen.

Wenn der gesuchte Text gefunden wird, blättert TextMaker zu der Fundstelle und markiert sie.

Sie haben nun folgende Möglichkeiten:

A) Sie klicken auf Ersetzen, woraufhin der Suchbegriff durch den Ersatzbegriff ersetzt wird und TextMaker zur nächsten Fundstelle springt.

B) Sie klicken auf Weitersuchen, woraufhin TextMaker zur nächsten Fundstelle springt – ohne den Begriff zu ersetzen.

C) Sie klicken auf Alle ersetzen, woraufhin TextMaker alle weiteren Vorkommen des Suchbegriffs im Text ersetzt.

D) Sie beenden den Suchen-Dialog mit Schließen.

---

**Suchen/Ersetzen wiederholen**

Um einen Such- oder Ersetzungsvorgang zu wiederholen oder ihn nach Abbruch fortzuführen, rufen Sie den Menübefehl Bearbeiten > Suchen wiederholen beziehungsweise Bearbeiten > Ersetzen wiederholen auf oder drücken einfach die Taste F3.

TextMaker setzt die Suche nun fort und zeigt die nächste Fundstelle an.

*Tipp:* Um eine Suche fortzuführen, können Sie auch die folgenden Tastenkombinationen verwenden: Strg+Bild↓ springt zur nächsten Fundstelle und Strg+Bild↑ zur vorherigen.

---

**Erweiterte Suchfunktionen**

Wenn Sie im Dialog des Menübefehls Bearbeiten > Suchen oder Bearbeiten > Ersetzen auf die Schaltfläche Erweitern klicken, wird der Dialog vergrößert und bietet zusätzliche Optionen an.

Mit der Schaltfläche Reduzieren lässt sich der Dialog wieder verkleinern.

Der erweiterte Suchen/Ersetzen-Dialog bietet folgende Optionen zusätzlich:

**Rubrik "Optionen"**

Hier können Sie folgende Einstellungen zum Suchvorgang ändern:

- **Groß-/Kleinschreibung beachten**

  Normalerweise wird die Groß-/Kleinschreibung des Suchbegriffs ignoriert. Bei der Suche nach "haus" wird also gleichermäßen "Haus", "haus", "HAUS", "HaUs" etc. gefunden.
Schalten Sie diese Option jedoch ein, wird nur dann etwas gefunden, wenn die Groß-/Kleinschreibung der Fundstelle genau mit der des Suchbegriffs übereinstimmt. Bei der Suche nach "haus" wird dann also nur noch "haus" gefunden.

- **Nur ganze Wörter suchen**

Schalten Sie diese Option ein, wird der Suchbegriff nur dann gefunden, wenn er als eigenständiges Wort vorkommt.

Bei der Suche nach "Fahrrad" wird also nur "Fahrrad" gefunden, "Fahrradpumpe" oder "Nasenfahrrad" hingegen nicht.

- **Ab Dokumentanfang/-ende suchen**

Normalerweise beginnt TextMaker mit der Suche an der aktuellen Position der Schreibmarke. Schalten Sie die Option **Ab Dokumentanfang suchen** jedoch ein, wird am Anfang des Dokuments begonnen.

Wenn die Option **Rückwärts suchen** eingeschaltet ist, erscheint hier stattdessen die Option **Ab Dokumentende suchen**. Diese funktioniert entsprechend.

- **Rückwärts suchen**

Schalten Sie diese Option ein, wird die Suche rückwärts durchgeführt, also von der aktuellen Position der Schreibmarke zurück zum Textanfang.

- **Alle Rahmen durchsuchen**

Normalerweise durchsucht TextMaker nur den Textrahmen, in dem sich die Schreibmarke momentan befindet. Ist die Schreibmarke im normalen Fließtext, wird nur der Fließtext durchsucht. Schalten Sie diese Option jedoch ein, werden der Fließtext und alle vorhandenen Textrahmen (inklusive Kopf- und Fußzeilen) durchsucht.

**Schaltfläche "Zurücksetzen"**

Die Schaltfläche **Zurücksetzen** löscht den Inhalt des Felds **Suchen nach** beziehungsweise **Ersetzen durch** (inklusive Formatierung) – je nachdem, in welchem dieser beiden Felder sich die Schreibmarke momentan befindet.

**Schaltfläche "Format"**

Die Schaltfläche **Format** ermöglicht es Ihnen, Dokumente nach einer bestimmten Formatierung zu durchsuchen – zum Beispiel nach allen fettgedruckten Stellen oder allen zentrierten Absätzen.

Klicken Sie diese Schaltfläche dazu an und stellen Sie die zu suchenden Formatierungen ein.

Weitere Informationen zu dieser Funktion finden Sie im nächsten Abschnitt (**Suchen/Ersetzen von Formatierungen**).

**Schaltfläche "Sonstiges"**

Die Schaltfläche **Sonstiges** ermöglicht es Ihnen, Dokumente nach besonderen Zeichen zu durchsuchen und Platzhalter wie "Beliebiges Zeichen" zu verwenden:


- **Beliebiger Buchstabe (**^$**)** – suchen Sie beispielsweise nach "^$", findet TextMaker a bis z und A bis Z (sowie alle Umlaute und andere Akzentzeichen).

- **Beliebiges Zeichen (**^?**)** – steht für ein beliebiges Zeichen (Buchstabe, Zahl oder Sonderzeichen).
Beliebiges typografisches Anführungszeichen (^q) – sucht nach einem beliebigen typografischen Anführungszeichen. (Neutrale Anführungszeichen wie " oder ' werden hingegen nicht gefunden.)

Caret (^) – sucht nach einem Zirkumflex (Caret) "\".

Geschütztes Leerzeichen (^n) – sucht nach einem nicht-trennenden Leerzeichen.

Tabstopzeichnen (^t) – sucht nach einem Tabulator.

Manueller Zeilenwechsel (^z) – sucht nach einem manuellen Zeilenwechsel (erzeugt durch Um-schalt+).)

Absatzmarke (^a) – sucht nach der Absatzmarke, die sich am Ende jedes Absatzes befindet.

Seitenumbruch (^p) – sucht nach einem mit Einfügen > Umbruch > Seitenumbruch eingefügten manuellen Seitenumbruch.

Bereichsumbruch (^s) – sucht nach einem mit Einfügen > Umbruch > Bereichsumbruch eingefügten Bereichsumbruch.

Kapitelumbruch (^c) – sucht nach einem mit Einfügen > Umbruch > Kapitelumbruch eingefügten Kapitelumbruch.

Um einen solchen Platzhalter in den Suchbegriff einzufügen, klicken Sie die Schaltfläche Sonstiges an und wählen dann den gewünschten Platzhalter per Mausklick.

Sie können diese Platzhalter in Ihrem Suchbegriff nach Belieben wiederholen und kombinieren. Weiterhin können Sie sie natürlich mit normalem Text mischen. Eine Suche nach "^#^# Liter Benz$^" findet beispielsweise "10 Liter Benzin", "42 Liter Benzol" etc.

**Suchen/Ersetzen von Formatierungen**

Mit den Menübefehlen Bearbeiten > Suchen und Bearbeiten > Ersetzen können Sie nicht nur nach Text, sondern auch nach Formatierungen suchen und diese bei Bedarf durch andere ersetzen lassen.

So lässt sich beispielsweise eine bestimmte Schrift, die immer wieder im Text vorkommt, durch eine andere ersetzen.

Um Formatierungen zu suchen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Bearbeiten > Suchen auf.
2. Falls die Schaltfläche Format nicht zu sehen sein sollte, klicken Sie auf die Schaltfläche Erweitern, um den Suchen-DIALOG zu erweitern.
3. Löschen Sie den Suchbegriff bei Suchen nach, indem Sie auf Zurücksetzen klicken.
4. Klicken Sie auf die Schaltfläche Format.
5. Wählen Sie, welche Art von Formatierung gesucht werden soll: Zeichenformatierungen, Absatzformatierungen, Zeichenvorlagen oder Absatzvorlagen.
6. Es öffnet sich ein Dialogfenster, in dem Sie die zu suchende(n) Formatierung(en) auswählen. Bestätigen Sie dann mit OK.
7. Jetzt können Sie die Suche mit der Schaltfläche Suchen starten.

Um Formatierungen zu suchen und sie durch andere zu ersetzen, gehen Sie folgendermaßen vor:
1. Ruf den Menübefehl **Bearbeiten > Ersetzen** auf.

2. Geben Sie über die Schaltfläche **Format** die zu suchende Formatierung an (siehe oben) und bestätigen Sie dann mit **OK**.

3. Klicken Sie in das Eingabefeld **Ersetzen durch**.

4. Verwenden Sie abermals die Schaltfläche **Format**, um zu bestimmen, durch welche andere Formatierung die oben gewählte ersetzt werden soll. Bestätigen Sie wieder mit **OK**.

5. Jetzt können Sie die Suche mit der Schaltfläche **Suchen** starten.

Wenn der Suchbegriff gefunden wird, zeigt TextMaker die Fundstelle an.

Um weiterzusuchen, klicken Sie auf die Schaltfläche **Weitersuchen**. Möchten Sie die Formatierung hingegen ersetzen, betätigen Sie die Schaltfläche **Ersetzen**. Wenn Sie auf **Alles ersetzen** klicken, werden auch alle weiteren Vorkommen der gesuchten Formatierung im Text ersetzt.

**Tipp:** Mit dieser Funktion können Sie beispielsweise im gesamten Dokument eine Schrift durch eine andere ersetzen. Profis würden hierfür jedoch **Formatvorlagen** verwenden (siehe Kapitel **Formatvorlagen**), mit denen diese Aufgabe viel eleganter gelöst werden kann. Ändern Sie nämlich die Schrift in einer Formatvorlage, wird automatisch das Format aller Textabschnitte geändert, die damit formatiert wurden.

Das Suchen von Text und Formatierungen lässt sich übrigens auch kombinieren; Sie können also nach einem bestimmten Suchbegriff in einer bestimmten Formatierung suchen. Tragen Sie beispielsweise als Suchbegriff "TextMaker" ein und wählen die Zeichenformatierung "Fett", werden alle fettgedruckten "TextMaker" im Dokument gefunden.

---

**Textmarken**

Wie bei einem Buch können Sie auch in TextMaker-Dokumenten Lesezeichen anbringen, um beispielsweise wichtige Textpassagen schnell wiederzufinden. Diese Lesezeichen nennt man **Textmarken**.

Um eine Textmarke einzufügen, rufen Sie an der gewünschten Textstelle den Menübefehl **Einfügen > Textmarke** auf und geben der Textmarke einen Namen. Mit dem Befehl **Bearbeiten > Gehe zu** können Sie so markierte Textstellen nun jederzeit aufschlagen.

**Textmarken setzen**

Um eine Textstelle mit einem "Lesezeichen" zu versehen, setzen Sie dort eine Textmarke. Dazu gehen Sie folgendermaßen vor:

1. Bewegen Sie die Schreibmarke an die Position im Text, an der die Textmarke gesetzt werden soll.
2. Ruf den Menübefehl **Einfügen > Textmarke** auf.
3. Tippen Sie einen beliebigen Namen für die Textmarke ein.

   **Hinweis:** Der Name darf nur Buchstaben, Ziffern und Unterstriche enthalten. Sonderzeichen sind nicht erlaubt. Das erste Zeichen muss stets ein Buchstabe sein.


Sie können in jedem Dokument beliebig viele Textmarken anlegen.
Suchen und Ersetzen

Textmarken abrufen
Um eine der so gekennzeichneten Textstellen wieder abzurufen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Bearbeiten > Gehe zu... auf oder drücken Sie F5.
2. Wählen Sie in der Liste Gehe zu den Eintrag Textmarke.
3. Wählen Sie die gewünschte Textmarke aus der Liste oder tippen Sie ihren Namen von Hand ein.
4. Bestätigen Sie mit OK.
TextMaker bewegt die Schreibmarke nun an die Position, an der Sie die Textmarke angelegt hatten.

Textmarken löschen
Wenn Sie eine Textmarke nicht mehr benötigen, können Sie diese jederzeit löschen. Dazu gehen Sie folgendermaßen vor:

2. Wählen Sie die zu löschende Textmarke aus der Liste oder tippen Sie ihren Namen von Hand ein.

Hinweis: Eine Textmarke wird automatisch gelöscht, wenn Sie die Textpassage löschen, in der die Textmarke enthalten ist.

Textmarken im Dokument anzeigen

(Anmerkung: Diese Option entspricht der Option Textmarken anzeigen im Dialog des Menübefehls Datei > Eigenschaften, Karteikarte Ansicht.)

Gehe zu...
Mit dem Befehl Bearbeiten > Gehe zu... können Sie zu einer bestimmten Stelle im Dokument springen – zum Beispiel zu einer bestimmten Seite oder zu einer Textmarke.

Um beispielsweise eine bestimmte Seite aufzuschlagen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Bearbeiten > Gehe zu... auf.
2. Wählen Sie in der Liste Gehe zu die Option Seite aus.
3. Tragen Sie die gewünschte Seitennummer ein. Diese wird dann sofort aufgeschlagen.
4. Klicken Sie auf Schließen, um den Dialog zu verlassen.

Wenn Sie in der Liste Gehe zu eine der anderen Optionen wählen, können Sie darüber hinaus folgende Operationen mit diesem Befehl durchführen:
Suchen und Ersetzen

<table>
<thead>
<tr>
<th>Option</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seite</td>
<td>Zur angegebenen Seite springen (wie oben beschrieben)</td>
</tr>
<tr>
<td>Kapitel</td>
<td>Zum angegebenen Kapitel springen</td>
</tr>
<tr>
<td>Textmarke</td>
<td>Zur ausgewählten Textmarke springen</td>
</tr>
<tr>
<td>Fußnote</td>
<td>Zur angegebenen Fußnote springen</td>
</tr>
<tr>
<td>Fußnotentext</td>
<td>Zum Fußnotentext der angegebenen Fußnote springen</td>
</tr>
<tr>
<td>Objekt</td>
<td>Zum ausgewählten Objekt (Grafik, Tabelle etc.) springen</td>
</tr>
<tr>
<td>Inhaltsverzeichnis</td>
<td>Zum Inhaltsverzeichnis des Dokuments springen</td>
</tr>
<tr>
<td>Index</td>
<td>Zum Index (Stichwortverzeichnis) des Dokuments springen</td>
</tr>
</tbody>
</table>

etc.

**Tipp: Verwenden der Schaltflächen unter dem vertikalen Rollbalken**

Sie können auch die drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters verwenden, um zu bestimmten Stellen im Dokument zu springen.

2. Klicken Sie auf die Schaltfläche mit dem Pfeil nach oben, springt TextMaker zur vorherigen Fundstelle. Haben Sie in dem Menü also beispielsweise "Seite" gewählt, wird die vorherige Seite angezeigt.
3. Klicken Sie auf die Schaltfläche mit dem Pfeil nach unten, springt TextMaker zur nächsten Fundstelle, also beispielsweise zur nächsten Seite.

**Navigieren mit der Seitenleiste**

Neben dem Menübefehl **Bearbeiten > Gehe zu** (siehe vorheriger Abschnitt) gibt es noch einen weiteren Helfer für das Navigieren im Dokument: die **Seitenleiste**.

Sie können in der Seitenleiste unter anderem eine Liste aller im Dokument enthaltenen Überschriften anzeigen lassen. Um zu einer Überschrift zu springen, genügt dann ein Mausklick auf den entsprechenden Listen-Eintrag.

Alternativ kann die Seitenleiste auch alle Textmarken, Objekte, Fußnoten und andere Bestandteile des Dokuments auflisten.

Sie müssen die Seitenleiste dazu einfach nur einschalten und darin die Funktion "Navigation" auswählen. Das geht folgendermaßen:
1. Falls die Seitenleiste nicht sichtbar ist, schalten Sie diese zunächst ein, indem Sie beispielsweise den Menübefehl **Ansicht > Seitenleiste > Rechts anzeigen** aufrufen.


Die Seitenleiste listet nun alle Überschriften im Dokument auf (sofern vorhanden). Um zu einer bestimmten Überschrift zu springen, klicken Sie diese einfach in der Liste an.

Sie können auf die gleiche Weise nicht nur zu Überschriften, sondern auch zu anderen Bestandteilen des Dokuments springen. Öffnen Sie dazu die aufklappbare Liste **Dokumentinhalt** ganz oben in der Seitenleiste und wählen Sie darin, was in der Seitenleiste angezeigt werden soll. Folgende Optionen stehen zur Wahl:

<table>
<thead>
<tr>
<th>Option</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Überschriften</td>
<td>In der Seitenleiste alle Überschriften anzeigen</td>
</tr>
<tr>
<td>Textmarken</td>
<td>Alle Textmarken anzeigen</td>
</tr>
<tr>
<td>Tabellen</td>
<td>Alle Tabellen anzeigen</td>
</tr>
<tr>
<td>Bilder</td>
<td>Alle Bilder anzeigen</td>
</tr>
<tr>
<td>Objekte</td>
<td>Alle Objekte (Bilder, Zeichnungen, Tabellen etc.) anzeigen</td>
</tr>
<tr>
<td>Fußnoten</td>
<td>Alle Fußnoten anzeigen</td>
</tr>
<tr>
<td>Fußnotenreferenzen</td>
<td>Alle Fußnotenreferenzen (also die Fußnotennummern im Text) anzeigen</td>
</tr>
<tr>
<td>Kommentare</td>
<td>Alle Kommentare anzeigen</td>
</tr>
<tr>
<td>Beschriftungen</td>
<td>Alle Beschriftungen (von Bildern etc.) anzeigen</td>
</tr>
</tbody>
</table>

Die Liste in der Seitenleiste zeigt daraufhin die gewünschten Inhalte an. Klicken Sie auf einen der Listen-Einträge, springt TextMaker sofort zur entsprechenden Stelle im Dokument.
Felder

Mit dem Menübefehl **Einfügen > Feld** können Sie verschiedene Arten von "Feldern" in den Text eingefügen.

*Felder* sind Platzhalter, die symbolisch für eine bestimmte Information stehen. So liefert das Feld "Druckdatum" beispielsweise das aktuelle Datum, das Feld "Seitennummer" die aktuelle Seitennummer etc. Weiterhin kann ein Feld den Inhalt eines Datenbankfelds aus einer Datenbank enthalten, was beispielsweise bei Serienbriefen benötigt wird.

Beim Öffnen und beim Drucken eines Dokuments werden alle enthaltenen Felder automatisch aktualisiert. Wenn Sie ein Dokument mit dem Feld "Druckdatum" also morgen erneut drucken, erscheint das morgige Datum im Ausdruck. Davon abgesehen können Sie die Felder eines Dokuments jederzeit mit dem Menübefehl **Weiteres > Felder aktualisieren** manuell aktualisieren.

Felder können wie normaler Text formatiert, gelöscht, kopiert und verschoben werden, ihr Inhalt lässt sich jedoch nicht direkt editieren.

Ausführliche Informationen zum Verwenden von Feldern finden Sie auf den nächsten Seiten.

---

**Feld einfügen**

Um ein Feld in den Text einzufügen, setzen Sie die Schreibmarke an die gewünschte Position und rufen den Menübefehl **Einfügen > Feld** auf.

In der Liste **Gruppe** wählen Sie, welche Art von Feld eingefügt werden soll.
Danach können Sie bei Bedarf in der rechten Hälfte des Dialogs noch den Typ oder die Darstellungsweise des Feldes ändern – zum Beispiel, ob eine Seitenzahl arabisch (1, 2, 3, ...) oder römisch (I, II, III, ...) ausgegeben werden soll.

Klicken Sie auf **Einfügen**, wenn Sie eine Auswahl getroffen haben.

Das Feld wird nun in den Text eingefügt und dort angezeigt. Üblicherweise sehen Sie gleich das Resultat des Felds. Fügen Sie also zum Beispiel das Feld "Druckdatum" ein, wird im Text das aktuelle Datum angezeigt.

### Liste aller verfügbaren Arten von Feldern

In obigem Dialogfenster gibt es folgende Arten von Feldern:

- **Erstelldatum**
  Datum, an dem das aktuelle Dokument erstellt wurde

- **Erstellzeit**
  Uhrzeit, zu der das aktuelle Dokument erstellt wurde

- **Druckdatum**

- **Druckzeit**
  Die aktuelle Uhrzeit. Wird beim Drucken automatisch aktualisiert.

- **Änderungsdatum**
  Datum, an dem das aktuelle Dokument zuletzt geändert (sprich: gespeichert) wurde

- **Änderungszeit**
  Uhrzeit, zu der das aktuelle Dokument zuletzt geändert (sprich: gespeichert) wurde

- **Datenbankfeld**
  Der Inhalt eines Datenbankfeldes aus der dem Dokument zugeordneten Datenbank. Wählen Sie in der Liste **Feldname**, welches Datenbankfeld eingefügt werden soll. Siehe auch Kapitel [Datenbank](#).  

- **Datenbankinfos**
  Folgende Informationen zu der dem Dokument zugeordneten Datenbank: **Datenbank** (Dateiname der Datenbank), **Datenbank mit Pfad** (dito mit Pfadangabe), **Datensatznummer** (die Satznummer des aktuellen Datensatzes) und **Datensatzanzahl** (Zahl der Datensätze in der Datenbank).

- **Seitennummer**
  Die aktuelle Seitennummer

- **Anzahl Seiten**
  Die Gesamtseitenzahl des Dokuments

- **Kapitelnummer**
  Die aktuelle Kapitelnummer. Siehe auch Abschnitt [Aufteilen eines Dokuments in Kapitel](#).
- **Sequenznummer**
  
  Die laufende Nummer, die in Beschriftungen automatisch eingefügt wird. Siehe Abschnitt [Beschriftungen und Abbildungsverzeichnisse](#).

- **Vorlagenverweis**
  
  Durchsucht das Dokument rückwärts nach Text in der gewählten Formatvorlage und zeigt diesen Text dann an. Dies ermöglicht es, beispielsweise die aktuelle Hauptüberschrift (die ja üblicherweise in der Absatzvorlage "Überschrift 1" formatiert wurde) im Text anzuzeigen. Siehe Abschnitt [Vorlagenverweise](#).

- **Dateiname**
  
  Dateiname des aktuellen Dokuments, wahlweise mit kompletter Pfadangabe (z.B. `c:\dokumente\test.tmdx`) oder ohne Pfadangabe (z.B. `test.tmdx`).

- **Dokumentinfos**
  
  Informationen zum aktuellen Dokument (Thema, Autor, Schlüsselwörter etc.). Wenn Sie auf [Einstellungen](#) klicken, können Sie diese bearbeiten. Siehe auch Abschnitt [Dokumentinfos](#).

- **Letzter Autor**
  
  Name oder Initialen des Anwenders, der das Dokument zuletzt geändert (sprich: gespeichert) hat. Ihren Namen und Ihre Initialen können Sie eintragen, indem Sie den Menübefehl [Weiteres > Einstellungen](#) aufrufen, in dem Dialog auf die Karteikarte [Allgemein](#) wechseln und darin die Schaltfläche [Benutzerdaten](#) anklicken.

- **Benutzerdaten**
  
  Verschiedene persönliche Angaben, die sich über die Schaltfläche [Benutzerdaten...](#) bearbeiten lassen.

  Wenn Sie eines dieser Felder in den Text einfügen, erscheint dort je nach Auswahl Ihr Name, Ihre Adresse, Ihre Telefonnummer etc. Diese Art von Feldern wird beispielsweise auch in den mitgelieferten Dokumentvorlagen häufig verwendet.

  Anmerkung: Sie können Ihre Benutzerdaten alternativ auch bearbeiten, indem Sie den Menübefehl [Weiteres > Einstellungen](#) aufrufen, auf die Karteikarte [Allgemein](#) wechseln und darin die Schaltfläche [Benutzerdaten](#) anklicken.

- **Auto-Nummer**
  
  Generiert eine laufende Nummer. Mehr dazu im Kapitel [Automatische Nummerierung](#).

**Felder bearbeiten**

Wenn Sie ein bereits im Dokument vorhandenes Feld bearbeiten möchten (um beispielsweise ein anderes Datumsformat für das Feld zu wählen), selektieren Sie das Feld einfach im Text und rufen den Menübefehl [Einfügen > Feld](#) erneut auf.


**Tipp:** Sie können den Dialog auch durch Doppelklick direkt auf das Feld öffnen.
**Felder aktualisieren**

Beim Öffnen und beim Drucken eines Dokuments werden alle enthaltenen Felder automatisch aktualisiert. Wenn Sie ein Dokument mit dem Feld "Druckdatum" also morgen ausdrucken, erscheint darin das morgige Datum.

Mit dem Menübefehl **Weiteres > Felder aktualisieren** oder der Taste **F9** können Sie die Felder jederzeit manuell aktualisieren. Sämtliche Felder und Berechnungen im Dokument werden dann auf den aktuellen Stand gebracht.

**Feldnamen anzeigen/Felder schattieren**

Wenn Sie einmal kontrollieren möchten, wo sich in einem Dokument welche Felder befinden, können Sie jederzeit die Option **Nur Feldnamen anzeigen** einschalten. In dem Dokument wird dann bei Feldern nicht mehr das Ergebnis, sondern der Name des Feldes in geschweiften Klammern angezeigt – beim Feld "Druckzeit" also beispielsweise {Druckzeit}.

Rufen Sie dazu den Menübefehl **Datei > Eigenschaften** auf, wechseln Sie auf die Karteikarte **Ansicht** und schalten Sie dort die Option **Nur Feldnamen anzeigen** ein.

**Tipp:** Noch schneller schalten Sie die Option **Feldnamen anzeigen** mit dem Tastenkürzel **Alt+F9** um. Der jeweilige Modus, den Sie dadurch aktiviert haben, wird damit auch direkt in der Karteikarte Ansicht übernommen.

Sie finden in dem Dialogfenster außerdem eine Option namens **Felder schattieren**. Aktivieren Sie diese, werden alle Felder im Dokument grau hinterlegt und heben sich somit besser vom Text ab.

**Hinweis:** Diese beiden Optionen wirken sich nur auf das aktuelle Dokument aus.

**Datums- und Uhrzeitformat selbst festlegen**

Bei Feldern, die ein Datum oder eine Uhrzeit zurückliefern, können Sie das Darstellungsformat selbst festlegen, falls Ihnen keines der vorgegebenen Formate zusagt. Wählen Sie im Dialogfenster des Menübefehls **Einfügen > Feld** dazu das gewünschte Datums- oder Zeitfeld aus und klicken Sie dann auf die Schaltfläche **Neues Format**.


Es sind hierbei beliebige Kombinationen aus folgenden Kürzeln zulässig (achten Sie genau auf die Groß-/Kleinschreibung!):

<table>
<thead>
<tr>
<th>Eingabe</th>
<th>Ergebnis</th>
<th>Beispiel</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>Tag</td>
<td>2</td>
</tr>
<tr>
<td>dd</td>
<td>Tag mit zwei Stellen</td>
<td>02</td>
</tr>
<tr>
<td>ddd</td>
<td>Wochentag auf 3 Buchstaben gekürzt</td>
<td>Mon</td>
</tr>
<tr>
<td>dddd</td>
<td>Wochentag ausgeschrieben</td>
<td>Montag</td>
</tr>
<tr>
<td>m</td>
<td>Monat</td>
<td>4</td>
</tr>
</tbody>
</table>
mm    Monat mit zwei Stellen    04

mmm   Monatsname auf 3 Buchstaben gekürzt   Apr

mmmm  Monatsname ausgeschrieben   April

yy    Jahr mit zwei Stellen    18

yyyy  Jahr mit vier Stellen   2018

h    Stunde (12-Stunden-Format)    8

hh   Stunde mit zwei Stellen (12-Stunden-Format)   08

H    Stunde (24-Stunden-Format)   8

HH   Stunde mit zwei Stellen (24-Stunden-Format)   08

M    Minute    5

MM   Minute mit zwei Stellen    05

S    Sekunde    0

SS   Sekunde mit zwei Stellen   00

am   Hinter der Uhrzeit am/pm anzeigen    am

AM   Hinter der Uhrzeit AM/PM anzeigen    AM

Darüber hinaus können Sie in Ihrer Eingabe beliebige Trennzeichen wie Punkt, Schrägstrich etc. verwenden.

Beispiel: Geben Sie beim Feld Druckdatum "ddddd, d. mmmm yyyy" als Format ein, erhalten Sie am 26.4.2018 die Ausgabe "Mittwoch, 26. April 2018".

Sprache wechseln: Im Dialog des Menübefehls Format > Zeichen können Sie übrigens die Sprache eines Textabschnitts ändern. Formatieren Sie Text in einer anderen Sprache, werden Monatsnamen und Wochentage in Datumsfeldern automatisch in der entsprechenden Sprache angezeigt (siehe auch Abschnitt Sprache einstellen).

Datum und Uhrzeit als Text einfügen

Mit dem Menübefehl Einfügen > Datum/Uhrzeit können Sie das aktuelle Datum oder die Uhrzeit als fester Text in das Dokument einfügen.

Im Gegensatz zu den auf den vorherigen Seiten beschriebenen Feldern wird von diesem Befehl ein fester Text mit dem Datum beziehungsweise der Uhrzeit erzeugt, der nicht mehr automatisch aktualisiert wird.

Rufen Sie den Menübefehl Einfügen > Datum/Uhrzeit auf, erscheint ein Dialogfenster. Hier können Sie wählen, ob der Text das Datum oder die Uhrzeit enthalten soll, und das Format bestimmen.
Sagt Ihnen keines der vorgegebenen Formate zu, klicken Sie auf die Schaltfläche **Neues Format** und tippen die am Ende des letzten Abschnitts beschriebenen Kürzel ein, um ein eigenes Format festzulegen.

Wenn Sie möchten, dass das Datum oder die Uhrzeit nicht als fester Text, sondern als *Feld* eingefügt wird, schalten Sie die Option **Als Feld einfügen** ein. TextMaker erzeugt dann ein Feld *Druckdatum* beziehungsweise *Druckzeit*. Details über die Verwendung von Feldern enthält der vorherige Abschnitt.

**Tipp: Tastenkürzel verwenden**

Für das Einfügen von Datum oder Uhrzeit gibt es folgende Tastenkürzel:

- Datum einfügen: **Strg**+. (Punkt)
- Uhrzeit einfügen: **Strg**+**Umschalt**+. (Punkt)

Wenn Sie eine dieser Tastenkombinationen betätigen, wird das Datum beziehungsweise die Uhrzeit sofort in den Text eingefügt – ohne dass erst ein Dialog erscheinen würde.
Sonderzeichen einfügen

Einige Zeichen lassen sich über die Tastatur nicht direkt eingeben – zum Beispiel das Copyrightzeichen, das Promillezeichen oder Akzentzeichen aus anderen Sprachen. Bei TextMaker können Sie diese sogenannten Sonderzeichen bequem über die integrierte Zeichentabelle in den Text eingeben.

Gehen Sie dazu folgendermaßen vor:

1. Rufen Sie den Menübefehl **Einfügen > Sonderzeichen** auf.
2. Es erscheint ein Dialogfenster, das alle in der derzeit gewählten Schrift verfügbaren Zeichen anbietet. Über die aufklappbare Liste **Schriftart** können Sie bei Bedarf eine andere Schriftart wählen.
3. Über die aufklappbare Liste **Subset** können Sie zu einem bestimmten Bereich des Zeichensatzes springen. Wählen Sie beispielsweise **Kyrillisch**, um zu den kyrillischen Zeichen zu gelangen (sofern in der gewählten Schriftart welche vorhanden sind).


4. Selektieren Sie das einzufügende Zeichen mit den Pfeiltasten und betätigen Sie die **Eingabetaste** oder führen Sie einen Doppelklick auf das Zeichen aus, um es in den Text einzufügen.

5. Sie können nun auf die gleiche Weise noch weitere Zeichen einfügen oder den Dialog mit der Schaltfläche **Schließen** beenden.

**Tipp für Windows-Anwender:** Die meisten Windows-Versionen enthalten zwei Symbolschriften namens **Symbol** und **Wingdings**. Darin finden Sie zahlreiche nützliche Symbole (Telefonsymbole, Bullets etc.).

Tastenkürzel verwenden

Wenn Sie ein bestimmtes Sonderzeichen häufiger benötigen, können Sie ihm jederzeit ein Tastenkürzel geben. Dies hat den Vorteil, dass Sie das Zeichen dann blitzschnell mit einem einzigen Tastendruck in den Text eingeben können.

Um einem Sonderzeichen ein Tastenkürzel zuzuordnen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Einfügen > Sonderzeichen** auf.
2. Wählen Sie das Sonderzeichen, dem Sie ein Tastenkürzel geben möchten.
3. Klicken Sie neben der Option **Tastenkürzel** auf die Schaltfläche **Ändern**.
4. Es erscheint ein weiterer Dialog. Drücken Sie darin im Eingabefeld **Bitte Tastenkürzel drücken** das gewünschte Tastenkürzel.

   Wir empfehlen Ihnen, stets Tastenkombinationen mit den Tasten **Strg** und **Umschalt** zu verwenden, da diese normalerweise nicht belegt sind.

   **Tipp:** Falls Sie sich vertippt haben, können Sie das eingegebene Tastenkürzel mit der **Rücktaste** wieder löschen.

5. **Nicht vergessen:** Klicken Sie auf **Hinzufügen**, um dem Zeichen dieses Tastenkürzel zuzuweisen.
6. Bestätigen Sie mit **OK** und verlassen Sie den Hauptdialog mit **Schließen**.

Von nun an können Sie dieses Sonderzeichen mit der entsprechenden Tastenkombination in den Text einfügen.

**Hinweis:** Das Tastenkürzel merkt sich nur das ausgewählte Zeichen, nicht jedoch die gewählte Schriftart.

Weitere Informationen zum Ändern der Tastaturbelegung finden Sie im Abschnitt **Tastenkürzel anpassen**.
Tipp: Die Tastenkürzel für Sonderzeichen können Sie bearbeiten, indem Sie in dem Dialog für das Bearbeiten der Tastaturbelegung in der linken Liste den Eintrag **Zeichen** auswählen.

**Sonderzeichen über ihren Zeichencode einfügen**

Es gibt noch eine andere Methode zum Einfügen von Sonderzeichen: Tippen Sie dazu dessen hexadezimalen Zeichencode (Unicode) ein, und betätigen Sie dann die Tastenkombination **Strg+Alt+Umschalt+X**.

Wenn Sie beispielsweise 20AC eingeben und dann diese Tastenkombination drücken, erhalten Sie ein Eurozeichen, da dieses in der Unicode-Zeichentabelle den Zeichencode 20AC hat.

**Sonderzeichen über Alt + Nummernblock einfügen**

Und hier noch eine weitere Methode zum Einfügen eines Sonderzeichens, über dessen ASCII Code: Halten Sie dazu die Taste **Alt** gedrückt, und geben Sie dabei die entsprechende Ziffernfolge ein (nur über den Nummernblock möglich!). Bitte achten Sie auch darauf, dass der Nummernblock über die **Num**-Taste aktiviert ist.

Wenn Sie beispielsweise Alt+0128 eingeben, erhalten Sie ein Eurozeichen, sobald Sie die Alt-Taste losgelassen haben.

**Mac/Linux:** Auf manchen Systemen (inklusive macOS und einigen Linux-Distributionen) funktionieren diese Tastenkombinationen nicht.
Automatische Nummerierung

TextMaker verfügt über mehrere Funktionen zum Erzeugen automatisch generierter Nummerierungen. In diesem Kapitel erfahren Sie alles Wissenswerte dazu:

- **Einfache Nummerierungen**

- **Nummerierungslisten**
  Auf Wunsch können Sie mit diesem Befehl auch Nummerierungslisten anlegen. In diesen lassen sich das Layout und die Einstellungen einer Absatznummerierung speichern und immer wieder anwenden. Weiterhin sind über Nummerierungslisten auch hierarchische Nummerierungen (1., 1.1., 1.1.1. etc.) möglich.

- **Nummerierung von Überschriften**
  Sie können Nummerierungslisten auch verwenden, um die Überschriften eines Dokuments automatisch mit einer Nummerierung zu versehen. Informationen dazu finden Sie allerdings nicht in diesem Kapitel, sondern im Abschnitt Überschriften nummerieren.

- **Nummerierung mit Auto-Nummern**
  Unabhängig von den oben erwähnten absatzweisen Nummerierungen können Sie an beliebigen Textstellen ein Auto-Nummer-Feld einfügen.Alle Vorkommen dieses Feldes werden automatisch durchnummert.

- **Zeilennummern anbringen**

Informationen zu diesen Themen erhalten Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Einfache Nummerierungen

Im Abschnitt Aufzählungen mit Bullets wurde beschrieben, wie Sie mit dem Menübefehl Format > Bullets und Nummerierungen Absätze mit einem Aufzählungszeichen ("Bullet") versehen können.

Zusätzlich eignet sich dieser Befehl auch zum Anbringen einer Nummerierung an Absätze. TextMaker rückt die Absätze dabei automatisch links ein, um Platz für die Nummern zu schaffen, und versieht die Absätze dann mit einer laufenden Nummer.
Automatische Nummerierung

Absätze mit einer Nummerierung

Sie können innerhalb eines Dokuments beliebig viele nummerierte Aufzählungen verwenden. Die Nummer wird am Beginn jeder neuen Aufzählung automatisch wieder auf Eins zurückgesetzt.

Nummerierung anbringen

Um Absätze mit einer Nummerierung zu versehen, gehen Sie wie folgt vor:

1. Markieren Sie die betreffenden Absätze.
2. Rufen Sie den Menübefehl **Format > Bullets und Nummerierungen** auf.
3. Wechseln Sie auf die Karteikarte **Bullets und einfache Nummerierungen**.
4. Wählen Sie bei **Typ** die Option **Nummerierung**.
5. Nehmen Sie bei Bedarf die gewünschten Einstellungen zu der Nummerierung vor (siehe Abschnitt "Optionen" weiter unten).

6. Bestätigen Sie mit OK.

Die Absätze werden nun mit einer Nummerierung versehen.


**Nummerierung unterbrechen**

Sie können die Nummerierung für einen Absatz unterbrechen und anschließend wieder fortsetzen.

Setzen Sie die Schreibmarke dazu in den betreffenden Absatz, rufen Sie den Menübefehl **Format > Bullets und Nummerierungen** auf, wechseln Sie auf die Karteikarte **Bullets und einfache Nummerierungen** und schalten Sie die Option **Nummerierung überspringen** ein.

Die Nummer wurde nun entfernt, lediglich die Einrückung wird beibehalten. Unterhalb dieses Absatzes wird die Nummerierung wieder fortgesetzt.
Tipp: Sie können auch ganz einfach über das Kontextmenü auf die Option Nummerierung überspringen zugreifen.

Nummerierung beenden oder entfernen

Um die Nummerierung von Absätzen zu beenden oder eine zuvor angebrachte Nummerierung wieder zu entfernen, gehen Sie wie folgt vor:

1. Drücken Sie am Ende des letzten nummerierten Absatzes die Eingabetaste, um einen neuen Absatz zu beginnen.

   Oder: Markieren Sie die nummerierten Absätze, falls Sie die Nummerierung dieser Absätze wieder komplett entfernen möchten.

2. Rufen Sie den Menübefehl Format > Bullets und Nummerierungen auf.

3. Wechseln Sie auf die Karteikarte Bullets und einfache Nummerierungen.

4. Schalten Sie die Nummerierung aus, indem Sie bei Typ die Option Keine wählen.

5. Bestätigen Sie mit OK.

Optionen des Dialogs

Auf der Karteikarte Bullets und einfache Nummerierungen im Dialogfenster des Menübefehls Format > Bullets und Nummerierungen können Sie folgende Einstellungen zu Nummerierungen vornehmen:

- **Typ**
  
  Hier können Sie bestimmen, ob die Absätze mit einer Nummerierung oder einem Bullet versehen werden sollen. Wählen Sie hier also die Option Nummerierung aus. (Informationen zur Option Bullet finden Sie im Abschnitt Aufzählungen mit Bullets.)

  Wenn Sie den Typ auf Keine setzen, werden vorhandene Bullets oder Nummern entfernt.

  Sie können übrigens jederzeit eine nummerierte Aufzählung in eine Aufzählung mit Bullets umwandeln, indem Sie einfach den Typ auf Bullet ändern. Der umgekehrte Weg ist natürlich ebenfalls möglich.

- **Vorher und Nachher**
  
  Sie können bei Bedarf Text vor und nach der Nummer ausgeben lassen. Sollen die Nummern beispielsweise von Strichen umgeben werden (-1-, -2-, -3- usw.), ist bei Format der Typ "1, 2, 3, ..." zu wählen, bei Vorher "." und bei Nachher "." einzutragen.

- **Format**
  

- **Nummerierung beginnt mit...**
  
  Normalerweise lässt TextMaker jede Nummerierung bei "1" beginnen. Möchten Sie einen anderen Startwert verwenden, tragen Sie diesen hier ein.

- **Nummerierung überspringen**
  
  Oft benötigt man innerhalb einer nummerierten Aufzählung einen Absatz, bei dem die Nummerierung vorübergehend ausgesetzt, anschließend aber wieder fortgeführt werden soll. Schalten Sie bei solchen Absätzen die Option Nummerierung überspringen ein.
Die Nummer wird daraufhin entfernt, und lediglich die Einrückung wird beibehalten. Unterhalb des Absatzes wird die Nummerierung wieder fortgesetzt.

Tipp: Sie können auch ganz einfach über das Kontextmenü auf die Option *Nummerierung überspringen* zugreifen.

- **Schaltfläche Zeichenformat**
  Klicken Sie diese Schaltfläche an, können Sie die Zeichenformatierung (Schriftart und -größe, Textauszeichnungen etc.) für die Nummern ändern.

- **Abstand zum Text**
  Bestimmt, wie weit der Text nach rechts eingerückt soll, um Platz für die Nummern zu schaffen.

- **Vertikaler Versatz**
  Bestimmt die vertikale Position der Nummer. Bei einem negativen Wert wird die Nummer tiefer, bei einem positiven Wert höher positioniert.

- **Karteikarte Nummerierungslisten**
  Diese Karteikarte enthält eine erweiterte Möglichkeit zum Erzeugen von Aufzählungen mit Bullets oder Nummern: die **Nummerierungslisten**. In diesen lassen sich Aufzählungen speichern und immer wieder anwenden. Außerdem sind über Nummerierungslisten auch hierarchische Nummerierungen (1., 1.1., 1.1.1. etc.) möglich.

  Informationen zu Nummerierungslisten finden Sie im nächsten Abschnitt.

---

**Nummerierungslisten**

Fortgeschrittene TextMaker-Anwender werden sicher die im Kapitel *Formatvorlagen* beschriebenen *Absatzvorlagen* zu schätzen wissen. In einer Absatzvorlage können Sie ein häufig benötigtes Absatzformat speichern und es dann immer wieder auf beliebige Absätze anwenden.

Etwas Ähnliches gibt es auch für Nummerierungen: die **Nummerierungslisten**.


Anschließend lässt sich diese Nummerierungsliste auf beliebige Absätze anwenden. Diese werden dann genau mit der in der Nummerierungsliste eingestellten Nummerierung versehen.

Ein weiterer Vorteil: Wenn Sie nachträglich die Formatierung der Nummerierungsliste ändern, ändert sich die Nummerierung aller damit formatierten Absätze entsprechend.

**Verwendung hierarchischer Listen**

Ein zusätzlicher Vorteil von Nummerierungslisten ist, dass damit auch *hierarchische* Nummerierungen erzeugt werden können.

Während *einfache Listen* (wie etwa 1., 2., 3. etc.) nur eine Ebene haben, können *hierarchische Listen* mehrere Ebenen haben, also beispielsweise wie folgt aussehen:
In obigem Beispiel befinden sich unter 1. beispielsweise zwei Absätze mit einer Nummerierung zweiter Ebene: 1.1. und 1.2.

Ausführliche Informationen zum Anlegen von Nummerierungslisten finden Sie auf den nächsten Seiten.

---

**Nummerierungslisten erstellen**

Um eine neue Nummerierungsliste zu erstellen, gehen Sie wie folgt vor:

1. Falls Sie die neue Nummerierungsliste auch gleich anwenden möchten, markieren Sie zunächst die gewünschten Absätze.
2. Rufen Sie den Menübefehl **Format > Bullets und Nummerierungen** auf.
3. Wechseln Sie auf die Karteikarte **Nummerierungslisten**.
4. Klicken Sie auf die Schaltfläche **Neu**.
5. Geben Sie einen beliebigen Namen für die neue Nummerierungsliste ein, wählen Sie eine Vorlage aus und bestätigen Sie mit **OK**.
6. Oder wenn Sie die Vorlage noch weiter anpassen möchten, gehen Sie auf **Bearbeiten...** und nehmen Sie bei Bedarf weitere Einstellungen zu der Nummerierung vor (siehe unten).

Die neue Nummerierungsliste wurde nun angelegt. Wenn Sie diese gleich auf die derzeit markierten Absätze anwenden möchten, klicken Sie auf **Anwenden**, ansonsten klicken Sie auf **Schließen**.

Weitere Informationen zum Anwenden der Nummerierungsliste finden Sie im Abschnitt **Nummerierungslisten anwenden**.

Im Dialogfenster zum **Bearbeiten** von Nummerierungslisten können Sie folgende Einstellungen vornehmen:

**Allgemeine Optionen**

- **Einfache Liste** beziehungsweise **Hierarchische Liste**
  
  Welche Option Sie hier auswählen ist ganz entscheidend für das Aussehen der Nummerierungsliste, denn hier bestimmen Sie den Typ der Liste:

  Wählen Sie **Einfache Liste** für eine einfache Nummerierung mit nur einer Ebene (also 1., 2., 3. etc.)

  Wählen Sie **Hierarchische Liste** für eine hierarchische Nummerierung mit mehreren Ebenen (zum Beispiel 1., 1.1., 1.1.1. etc.)

- **Gliederungsebene des Absatzes verwenden**
  
  Nur verfügbar, wenn als Listentyp **Hierarchische Liste** gewählt wurde.
Ist diese Option aktiviert, wird die Gliederungsebene des jeweiligen Absatzes automatisch als Ebene für die Nummerierung der Liste verwendet. Hat beispielsweise ein Absatz eine Gliederungsebene von 3 (ist also eine Überschrift dritter Ordnung), wird dementsprechend eine Listenebene von 3 angewandt (also zum Beispiel "1.1.1.").

**Hinweis:** Wenn diese Option aktiviert ist, erscheint die Nummerierung nur bei Überschriften. Bei normalem Text (also Text mit Gliederungsebene Null) erscheint keine Nummerierung.

Informationen zum Gliedern von Dokumenten finden Sie im Abschnitt **Gliederungen**.

Ist die Option **Gliederungsebene des Absatzes verwenden** nicht aktiviert, können Sie die Listenebene über die Option **Listenebene** im Hauptdialog dieses Befehls jederzeit manuell einstellen (siehe auch Abschnitt **Nummerierungslisten anwenden**).

### Ebene

Nur verfügbar, wenn als Listentyp **Hierarchische Liste** gewählt wurde.

Hier können Sie per Mausklick auswählen, welche Ebene der Liste Sie verändern möchten. Klicken Sie beispielsweise auf "3", können Sie die Einstellungen für die dritte Ebene ändern.

Jede Ebene einer hierarchischen Liste kann eigene Einstellungen verwenden. Sie können also beispielsweise die Farbe für die Nummern bei Ebene 1 auf Blau, bei allen anderen Ebenen hingegen auf Schwarz setzen.

### Vorschau

Im Feld **Vorschau** wird angezeigt, wie die Nummerierung mit den aktuellen Einstellungen aussehen würde.

Weiterhin können Sie hier (genau wie im oben beschriebenen Feld **Ebene**) bei hierarchischen Listen auswählen, welche Ebene Sie bearbeiten möchten. Klicken Sie die gewünschte Ebene dazu in der Vorschau an.

### Höhere Ebenen anzeigen

Nur bei Listenebenen von 2 oder höher in hierarchischen Listen verfügbar.

Ist diese Option aktiviert, enthält die für die Nummerierung angebrachte Nummer alle Listenebenen. Bei Listenebene 3 wird also beispielsweise die Nummer "1.5.9." verwendet.

Ist diese Option nicht aktiviert, wird nur die Nummer für die **aktuelle** Ebene angebracht (in obigem Beispiel also nur "9.")

### Ebene nicht zurücksetzen

Nur bei Listenebenen von 2 oder höher in hierarchischen Listen verfügbar.

Ist diese Option aktiviert, wird die Nummer dieser Listenebene nicht auf 1 zurückgesetzt, wenn diese Ebene auf eine übergeordnete Ebene folgt.

Schalten Sie diese Option also bei Ebene 2 ein, hat dies beim nachfolgenden Beispiel folgende Auswirkung:

<table>
<thead>
<tr>
<th>Option ausgeschaltet:</th>
<th>Option eingeschaltet:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>1.</td>
</tr>
<tr>
<td>1.1</td>
<td>1.1</td>
</tr>
<tr>
<td>1.2</td>
<td>1.2</td>
</tr>
</tbody>
</table>
Beim letzten Eintrag im obigen Beispiel wird also, wenn diese Option aktiviert ist, die zweite Ebene mit 2.3 fortgeführt anstatt auf 2.1 zurückgesetzt zu werden.

- **Schaltfläche Zurücksetzen**
  Falls Sie sich einmal beim Abändern einer Nummerierungsliste komplett vertan haben, können Sie jederzeit die Schaltfläche Zurücksetzen betätigen. Diese verwirft Ihre Änderungen und stellt die ursprünglichen Einstellungen wieder her (für alle Ebenen).

Mit den weiteren Optionen in diesem Dialog können Sie das Aussehen der Nummerierungsliste verändern (siehe nachfolgende Seiten).

Wie oben erwähnt, lassen sich bei hiearhischen Listen für jede Listenebene eigene Einstellungen vornehmen. Klicken Sie also zuvor im Feld Ebene auf die Ebene, deren Einstellungen Sie verändern möchten.

**Optionen für Bullets**

Wenn Sie bei Typ die Option Bullet gewählt haben, erscheinen in dem Dialog folgende Optionen:

- **Rubrik Bullet**
  Hier können Sie das zu verwendende Bullet auswählen.

  In der Reihe **Standard** werden vorgefertigte Bullets angeboten, in der Reihe **Benutzerdefiniert** können Sie benutzerdefinierte Bullets anlegen. Klicken Sie dazu auf eines der Bullets in der Reihe **Benutzerdefiniert**, betätigen Sie die Schaltfläche **Ändern** rechts daneben und wählen Sie das Zeichen aus, das als Bullet verwendet werden soll.

- **Farbe** (nur bei Standard-Bullets)

*Tipps:* Wenn Sie die Farbe auf "Auto" setzen, verwendet TextMaker automatisch die Schriftfarbe des Absatzes rechts des Bullets.

- **Größe** (nur bei Standard-Bullets)
  Hier können Sie bei Bedarf die Größe des Bullets (in Punkt) ändern.

*Tipps:* Wenn Sie hier die Option "Automatisch" wählen, verwendet TextMaker automatisch die Schriftgröße des Absatzes rechts des Bullets.

- **Schaltfläche Zeichenformat** (nur bei benutzerdefinierten Bullets)
  Bei benutzerdefinierten Bullets erscheint statt der obigen zwei Optionen die Schaltfläche Zeichenformat. Klicken Sie diese an, können Sie das Zeichenformat (Größe, Farbe, Textauszeichnungen etc.) des Bullets ändern.

*Tipps:* Wenn Sie an diesen Einstellungen nichts verändern, verwendet das Bullet automatisch das Zeichenformat des Absatzes rechts des Bullets.

- **Abstand zum Text**
  Bestimmt, wie weit der Text nach rechts eingerückt soll, um Platz für die Bullets zu schaffen.
Automatische Nummerierung

- **Vertikaler Versatz**
  Bestimmt die vertikale Position des Bullets. Bei einem negativen Wert wird das Bullet tiefer, bei einem positiven Wert höher positioniert.

- **Zusätzlicher Einzug**
  Mit Hilfe dieser Einstellung können Sie zusätzlich den gesamten Text (inklusive Bullet) nach rechts einrücken lassen.

**Optionen für Nummerierungen**

Wenn Sie bei **Typ** die Option **Nummerierung** gewählt haben, erscheinen in dem Dialog folgende Optionen:

- **Nummerierungstext**
  Über diese und die nächste Option können Sie bei Bedarf das Format der Nummerierung ändern.
  Die Option **Nummerierungstext** wird vom Programm automatisch ausgefüllt; Sie können aber jederzeit Änderungen vornehmen. {1} steht als Platzhalter für die Nummer im gewählten Format (siehe nächste Option). Ist hier also {1} eingetragen, werden die Nummern in der Form 1, 2, 3 etc. angezeigt. Tragen Sie hingegen zum Beispiel -{1}- ein, erscheinen die Nummern in der Form -1-, -2-, -3- etc.
  Enthält die Nummerierung mehrere Ebenen, heißen die Platzhalter entsprechend {1}, {2}, {3} (für die Nummer der ersten, zweiten, dritten Ebene) etc.

- **Format**

- **Nummerierung beginnt mit...**
  Soll die Nummerierung nicht mit 1, sondern mit einem anderen Wert beginnen, tragen Sie diesen hier ein.
  Diese Option wirkt sich nur dann aus, wenn die Nummerierung neu beginnt oder über die Option **Nummerierung zurücksetzen** im Hauptdialog des Befehls zurückgesetzt wird.

- **Schaltfläche Zeichenformat**
  Klicken Sie diese Schaltfläche an, können Sie die Zeichenformatierung (Schriftart und -größe, Textauszeichnungen etc.) der Nummern ändern.

- **Abstand zum Text**
  Bestimmt, wie weit der Text nach rechts eingerückt soll, um Platz für die Nummern zu schaffen.

- **Vertikaler Versatz**
  Bestimmt die vertikale Position der Nummer. Bei einem negativen Wert wird die Nummer tiefer, bei einem positiven Wert höher positioniert.

- **Zusätzlicher Einzug**
  Mit Hilfe dieser Einstellung können Sie zusätzlich den gesamten Text (inklusive Nummer) nach rechts einrücken lassen.
Automatische Nummerierung

Nummerierungslisten anwenden

Nummerierungslisten werden ähnlich wie Absatzvorlagen eingesetzt: Erst die gewünschten Absätze markieren, dann die Nummerierungsliste anwenden.

Gehen Sie also wie folgt vor:

1. Setzen Sie die Schreibmarke in den Absatz, auf den Sie die Nummerierungsliste anwenden möchten, oder markieren Sie mehrere Absätze.
2. Rufen Sie den Menübefehl Format > Bullets und Nummerierungen auf.
3. Wechseln Sie auf die Karteikarte Nummerierungslisten.
4. Wählen Sie die gewünschte Nummerierungsliste.
5. Klicken Sie auf Anwenden.

Die Absätze werden nun mit einer entsprechenden Nummerierung versehen.

_Hinweis:_ Wenn Sie eine hierarchische Liste anwenden, bei der die Option Gliederungsebene des Absatzes verwenden aktiviert ist, erscheint die Nummerierung nur bei Überschriften. Bei normalem Text (also Text mit Gliederungsebene Null) erscheint keine Nummerierung.

Optionen des Dialogs

Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

- **Listenebene**

  Bei _hierarchischen_ Nummerierungslisten können Sie hier die Listenebene einstellen. Setzen Sie diese Option auf 1, wird also beispielsweise die Nummer 1. angebracht, wählen Sie 3, erscheint die Nummer 1.1.1. etc.

  Hinweis: Die Listenebene ist nicht einstellbar, wenn Sie in der Nummerierungsliste die Option Gliederungsebene des Absatzes verwenden aktiviert haben, da TextMaker dann ja automatisch die Gliederungsebene des Absatzes als Listenebene verwendet.

- **Nummerierung überspringen**

  Oft benötigt man innerhalb einer nummerierten Aufzählung einen Absatz, bei dem die Nummerierung vorübergehend ausgesetzt, anschließend aber wieder fortgeführt werden soll. Setzen Sie die Schreibmarke dazu in den betreffenden Absatz und schalten Sie die Option Nummerierung überspringen ein.

  Die Nummer wird daraufhin entfernt, und lediglich die Einrückung wird beibehalten. Unterhalb des Absatzes wird die Nummerierung wieder fortgesetzt.

  _Tipp:_ Sie können auch ganz einfach über das Kontextmenü auf die Option Nummerierung überspringen zugreifen.

- **Nummerierung zurücksetzen**

  Startet die Nummerierung bei diesem Absatz neu, setzt die Nummer also auf 1 zurück.

  Hinweis: Falls beim Aufruf dieses Befehls mehrere Absätze markiert sind, wird die Nummerierung nur beim ersten markierten Absatz zurückgesetzt.
**Listenebene über die Formatleiste ändern**

Bei Absätzen, auf die eine *hierarchische* Nummerierungsliste angewandt wurde, können Sie die Listenebene auch über die folgenden Schaltflächen ändern, die Sie ganz rechts in der Formatleiste finden:

- Reduziert die Listenebene
- Erhöht die Listenebene

**Nummerierungslisten ändern**

Sie können zuvor angelegte Nummerierungslisten jederzeit abändern.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl *Format > Bullets und Nummerierungen* auf.
2. Wechseln Sie auf die Karteikarte *Nummerierungslisten*.
3. Wählen Sie per Mausklick die Nummerierungsliste, die Sie bearbeiten möchten.
4. Klicken Sie auf die Schaltfläche *Bearbeiten* (siehe Abschnitt *Nummerierungslisten erstellen*).
5. Nehmen Sie die gewünschten Änderungen vor.
6. Bestätigen Sie mit *OK*.

Die Nummerierungsliste wurde nun entsprechend geändert. Wenn Sie diese gleich auf die derzeit markierten Absätze anwenden möchten, klicken Sie auf *Anwenden*, ansonsten klicken Sie auf *Schließen*.

*Hinweis:* Wenn Sie eine Nummerierungsliste ändern, wirkt sich das auf *alle* Absätze aus, die zuvor mit dieser Nummerierungsliste formatiert wurden.

**Nummerierungslisten löschen oder umbenennen**

Um eine Nummerierungsliste zu löschen, wählen Sie diese im obigen Dialog per Mausklick und klicken auf die Schaltfläche *Löschen*.

*Hinweis:* Wenn Sie eine Nummerierungsliste löschen, wird die Nummerierung von *allen* Absätzen, die Sie mit ihr formatiert haben, entfernt.

Weiterhin können Sie Nummerierungslisten jederzeit umbenennen. Klicken Sie dazu im obigen Dialog auf die Schaltfläche *Umbenennen* und tippen Sie den neuen Namen ein.
Nummerierung von Überschriften

Nummerierungslisten können auch zum automatischen Nummerieren aller Überschriften eines Dokuments verwendet werden. Ausführliche Informationen dazu finden Sie im Abschnitt Überschriften nummerieren.

Nummerierung mit Auto-Nummern

Neben der auf den vorherigen Seiten vorgestellten automatischen Absatznummerierung können Sie auch manuell Nummerierungen erzeugen, indem Sie an beliebigen Textstellen eine Auto-Nummer einfügen.

Die "Auto-Nummer" ist ein Feld, das symbolisch für eine laufende Nummer steht. Die erste Auto-Nummer, die in einem Dokument vorkommt, liefert stets eine "1" zurück, die nächste eine "2" usw.


Um eine Auto-Nummer einzufügen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Einfügen > Feld auf.
2. Wählen Sie in der Liste Gruppe das Feld "Auto-Nummer".

Die Auto-Nummer erscheint nun im Text.

Auto-Nummer zurücksetzen

Falls Sie innerhalb eines Dokuments mehrere Nummerierungen mit Auto-Nummern benötigen, können Sie die Auto-Nummer jederzeit auf Eins zurücksetzen.

Gehen Sie dazu folgendermaßen vor:

1. Setzen Sie die Schreibmarke an die Stelle, an der die neue Nummerierung zurückgesetzt werden soll.
2. Rufen Sie den Menübefehl Einfügen > Umbruch > Bereichsumbruch auf.
4. Vergewissern Sie sich, dass in dem Dialogfenster unter Anwenden auf die Option Aktuellen Bereich gewählt ist.
5. Schalten Sie die Option Auto-Nummern zurücksetzen ein.
6. Bestätigen Sie mit OK.

Wundern Sie sich nicht, dass es im Dialogfenster des Menübefehls Format > Bereich primär um Textspalten geht. "Bereiche" sind in erster Linie für den Mehrspaltendruck zuständig; sie lassen sich aber zusätzlich auch zum Zurücksetzen von Auto-Nummern verwenden.
Zeilenummern anbringen


Um Zeilenummern anzeigen zu lassen, gehen Sie wie folgt vor:

1. Markieren Sie gegebenenfalls den Textabschnitt, für den Zeilenummern angezeigt werden sollen.
2. Rufen Sie den Menübefehl **Format > Bereich** auf.
3. Wechseln Sie auf die Karteikarte **Zeilenummern**.
4. Schalten Sie die Option **Zeilenummern anzeigen** ein.
5. Nehmen Sie gegebenenfalls die gewünschten Einstellungen zur Nummerierung vor (siehe unten).
6. Bestätigen Sie mit **OK**.

Die Zeilenummern werden nun angezeigt.

Zeilenummern ausschalten oder überspringen

Wenn Sie die Anzeige der Zeilenummern wieder abschalten möchten, verfahren Sie wie oben beschrieben, schalten die Option **Zeilenummern anzeigen** dabei jedoch nicht ein, sondern aus.

Um die Zeilenummern die Nummerierung lediglich für bestimmte Absätze zu überspringen, markieren Sie diese Absätze, rufen den Menübefehl **Format > Absatz** auf, wechseln auf die Karteikarte **Textfluss** und schalten dort die Option **Zeilenummern unterdrücken** ein.

Optionen des Dialogs

Im Dialogfenster für den Menübefehl **Format > Bereich** können Sie folgende Einstellungen zu Zeilenummern vornehmen:

- **Zeilenummern anzeigen**
  Schaltet die Anzeige von Zeilenummern ein/aus.
- **Rubrik Optionen**
  Hier können Sie folgende Optionen einstellen:
  
  - **Erste Zeilenummer** bestimmt, mit welcher Nummer die Zeilenummern beginnen sollen.
  - **Zählintervall** bestimmt das Intervall der Zeilenummern. Tragen Sie beispielsweise 5 ein, erscheinen Zeilenummern nur in den Zeilen 5, 10, 15, 20 usw.
  - **Abstand zum Text** legt fest, wie viel Abstand TextMaker zwischen den Zeilenummern und dem Text freihalten soll.
  - **Position** bestimmt, wo die Zeilenummern angezeigt werden sollen: im linken oder rechten Seitenrand beziehungsweise im inneren oder äußeren Seitenrand (bei Dokumenten mit gegenüberliegenden Seiten, also beispielsweise Büchern).
Rubrik **Nummerierung**

Bestimmt, ob und wann die Nummerierung neu beginnen soll:

**In diesem Bereich neu beginnen:** Die Nummerierung wird nur am Beginn des aktuellen Bereichs auf 1 zurückgesetzt. Tipp: Neue Bereiche können Sie mit dem Menübefehl *Einfügen > Umbruch > Bereichsumbruch* anlegen.

**Auf jeder Seite neu beginnen:** Die Nummerierung wird am Beginn jeder Seite des Dokuments auf 1 zurückgesetzt.

**Fortlaufend:** Die Nummerierung wird nicht auf 1 zurückgesetzt.

Zusätzlich gibt es die Option **Leere Absätze überspringen.** Wird diese eingeschaltet, übergeht die Nummerierung alle Absätze, die komplett leer sind.

**Anwenden auf:**

Bestimmt, auf welchen Teil des Dokuments sich die in diesem Dialog getätigten Einstellungen auswirken sollen:

**Gesamtes Dokument:** Das gesamte Dokument.

**Von hier an:** Den Textabschnitt von der Schreibmarke bis zum Ende des Dokuments.

**Markierter Text:** Den markierten Text.

**Aktueller Bereich:** Den aktuellen Bereich des Textes. Tipp: Mit dem Menübefehl *Einfügen > Umbruch > Bereichsumbruch* können Sie das Dokument in beliebige viele Bereiche unterteilen.

**Markierte Bereiche:** Alle Bereiche vom Beginn der Markierung bis zu deren Ende.

**Bis zum Ende des Bereichs:** Den Textabschnitt von der Schreibmarke bis zum Ende des aktuellen Bereichs.
Möchten Sie in einem Dokument Text, Zahlen oder auch Grafiken übersichtlich in Tabellenform nebeneinander anordnen? Dann fügen Sie einfach eine *Tabelle* in das Dokument ein.

|---------------------------------------|---------------------------------------------------------------------------------|--------------------------------------------------|

Einfache tabellarische Auflistungen ließen sich zwar auch durch das Einfügen von Tabulatoren bewerkstelligen, Tabellen bieten aber folgende Vorteile:

- Text wird innerhalb einer Tabellenzelle automatisch auf mehrere Zeilen umbrochen, wenn er nicht hineinpasst. Die Höhe der Tabellenzeile passt sich dabei automatisch an.
- Sie können in Tabellen bequem einzelne Zellen (oder komplette Zeilen und Spalten) markieren und deren Inhalte dann löschen, kopieren, verschieben oder formatieren.
- Tabellenzellen lassen sich umranden, mit einem Gitter aus Zwischenlinien versehen oder mit einer Schattierung hinterlegen.
- Mit den Inhalten von Tabellen können sogar Berechnungen durchgeführt werden (siehe Kapitel [Berechnungen im Text](#)).

In diesem Kapitel erfahren Sie alles Wissenswerte zum Arbeiten mit Tabellen. Folgende Themen werden darin behandelt:

- **Tabellen einfügen**
- **Tabellen ausfüllen**
- **Tabellenzellen und -inhalte markieren**
- **Tabelleninhalte löschen, kopieren, verschieben**
- **Tabellenzellen löschen und einfügen**
- **Tabellenzellen teilen oder verbinden**
- **Tabellen formatieren**
- **Tabelle in Text umwandeln**
- **Text in Tabelle umwandeln**
- **Tabellen sortieren**
- **Text sortieren**
- **Tipp: Verwenden der Tabellenleiste**

Lesen Sie dazu die nächsten Seiten.
Tabellen einfügen

Um eine Tabelle in den Text einzufügen, setzen Sie die Schreibmarke an die gewünschte Position und rufen den Menübefehl **Tabelle > Neue Tabelle** auf.

Es erscheint ein Dialogfenster, in dem Sie bestimmen können, wie viele Zeilen und Spalten die Tabelle enthalten soll.

Unten können Sie bei Bedarf außerdem die Innenränder für die Tabellenzellen einstellen.

Wenn Sie mit **OK** bestätigen, fügt TextMaker die Tabelle in den Text ein.

Tabellen ausfüllen

In Tabellen können Sie Text wie gewohnt eingeben, editieren und formatieren. Nach dem Einfügen einer Tabelle setzt TextMaker die Schreibmarke automatisch in die erste Tabellenzeile, so dass Sie gleich mit dem Tippen beginnen können.

Sie können in einer Zelle auch mehrere Zeilen Text tippen – der Umbruch in die nächste Zeile erfolgt automatisch – und mittels der **Eingabetaste** einen neuen Absatz beginnen.

Das Einfügen einer Grafik in eine Tabellenzelle nehmen Sie wie üblich mit dem Menübefehl **Objekt > Neue Grafik** vor, der im Kapitel **Grafiken** beschrieben wird. Sie können natürlich auch andere Arten von Objekten einfügen – zum Beispiel OLE-Objekte, Formularobjekte etc.

Um die Schreibmarke von einer Tabellenzelle zu einer anderen zu bewegen, gehen Sie folgendermaßen vor:

**Tastatur:** Drücken Sie die Tabulatortaste **Tab** für die nächste Zelle beziehungsweise **Umschalt+Tab** für die vorherige Zelle. Mit den Pfeiltasten **↓** und **↑** können Sie die Schreibmarke zeilenweise bewegen.

**Maus:** Klicken Sie in die gewünschte Zelle.

**Hinweis:** Wie Sie sehen, kann die Tabulatortaste **Tab** in Tabellen nicht zum Einfügen eines Tabulators verwendet werden. In Tabellen muss hierfür die Tastenkombination **Strg+Tab** verwendet werden.
Tabellenzellen und -inhalte markieren

Das Markieren von Text *innerhalb einer Zelle* funktioniert genauso wie im normalen Text.

Zum Markieren *kompletter Tabellenzellen* samt Inhalt klicken Sie in die erste zu markierende Zelle und ziehen die Maus dann bei gedrückter Maustaste zur letzten gewünschten Zelle.

Für das Markieren *kompletter Zeilen oder Spalten* gibt es alternativ auch den Menübefehl *Tabelle > Markieren*. Rufen Sie diesen auf, öffnet sich ein Untermenü, in dem Sie wählen können, ob die aktuelle Zeile, die aktuelle Spalte oder die gesamte Tabelle markiert werden sollen.


In seltenen Fällen müssen Sie nur eine *einzeln Zelle* markieren. Dies geht über folgenden "Trick": Ziehen Sie den Mauszeiger von der zu markierenden Zelle in eine benachbarte Zelle und wieder zurück.

Tabelleninhalte löschen, kopieren, verschieben

Um die Inhalte von Tabellenzellen zu löschen, zu kopieren oder zu verschieben, markieren Sie diese und verwenden dann die bekannten Befehle des Menüs *Bearbeiten*:

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Löschen</td>
<td>Der Menübefehl <em>Bearbeiten &gt; Löschen</em> löscht die Inhalte aller derzeit markierten Zellen.</td>
</tr>
<tr>
<td>Ausschneiden</td>
<td>Der Befehl <em>Bearbeiten &gt; Ausschneiden</em> schneidet die Inhalte der markierten Zellen in die Zwischenablage aus.</td>
</tr>
<tr>
<td>Kopieren</td>
<td><em>Bearbeiten &gt; Kopieren</em> kopiert die Inhalte der markierten Zellen in die Zwischenablage.</td>
</tr>
<tr>
<td>Einfügen</td>
<td><em>Bearbeiten &gt; Einfügen</em> fügt den Inhalt der Zwischenablage ein. Setzen Sie die Schreibmarke zuvor in die gewünschte Tabellenzelle.</td>
</tr>
</tbody>
</table>

_Hinweis:_ Beachten Sie dabei, dass sich diese Befehle nur auf den *Inhalt* der Zellen auswirken. Markieren Sie also beispielsweise Zellen und rufen den Menübefehl *Bearbeiten > Löschen* auf, werden nur die Inhalte dieser Zellen entfernt; die Zellen selbst bleiben erhalten. Informationen zum Löschen/Einfügen *kompletter* Tabellenzellen (samt Inhalt) finden Sie im nächsten Abschnitt.

Tabellenzellen löschen und einfügen

Im vorherigen Abschnitt haben Sie erfahren, wie Sie den *Inhalt* von Tabellenzellen löschen, kopieren oder verschieben.
In diesem Abschnitt wird hingegen beschrieben, wie Sie Tabellenzellen *komplett* aus der Tabelle heraustö- 
schen und zusätzliche Tabellenzellen einfügen können.

Folgende Themen werden darin behandelt:

- Tabellenzellen löschen
- Tabellenzellen einfügen

### Tabellenzellen löschen

Um Tabellenzellen (samt Inhalt) komplett aus einer Tabelle heraußulöschen, gehen Sie wie folgt vor:

1. Markieren Sie die zu löschenden Zellen.
2. Rufen Sie den Menübefehl *Tabelle > Zellen löschen* auf. 
   
   Tipp: Drücken Sie hierfür nicht einfach nur die Taste *Entf* – denn diese löscht nur den *Inhalt* der Tabellenzellen, nicht die Tabellenzellen selbst.
3. Wählen Sie aus dem Untermenü aus, was genau gelöscht werden soll:
   
   **Zeilen löschen:** alle Zeilen innerhalb der Markierung löschen
   **Spalten löschen:** alle Spalten innerhalb der Markierung löschen
   **Tabelle löschen:** die komplette Tabelle löschen
   **Zellen löschen...:** nur die momentan markierten Zellen löschen

Die Tabellenzellen werden nun entfernt.

### Tabellenzellen einfügen

Um einer Tabelle zusätzliche Zellen hinzuzufügen, gehen Sie folgendermaßen vor:

1. Setzen Sie die Schreibmarke in die Zelle, vor oder hinter der die neuen Zellen eingefügt werden sollen.
2. Rufen Sie den Menübefehl *Tabelle > Zellen einfügen* auf.
3. Wählen Sie aus dem Untermenü aus, was genau eingefügt werden soll:
   
   **Zeile oberhalb einfügen:** eine Zeile oberhalb der aktuellen Zelle einfügen
   **Zeile unterhalb einfügen:** eine Zeile unterhalb der aktuellen Zelle einfügen
   **Spalte links einfügen:** eine Spalte links von der aktuellen Zelle einfügen
   **Spalte rechts einfügen:** eine Spalte rechts von der aktuellen Zelle einfügen
   **Zellen einfügen...:** einen Dialog mit weiteren Optionen öffnen (siehe unten)

Die Zellen werden der Tabelle nun hinzugefügt.
Optionen

Wenn Sie bei obiger Vorgehensweise die Option Zellen einfügen... wählen, erscheint dabei ein Dialog, in dem Sie bestimmen können, auf welche Weise die neuen Zellen eingefügt werden sollen.

Es gibt darin die folgenden Optionen:

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ganze Zeilen</td>
<td>Es werden ganze Zeilen eingefügt.</td>
</tr>
<tr>
<td>Ganze Spalten</td>
<td>Es werden ganze Spalten eingefügt.</td>
</tr>
<tr>
<td>Einzelne Zellen</td>
<td>Es werden einzelne Zellen eingefügt. Hatten Sie vor dem Aufruf dieses Befehls beispielsweise 4x4 Zellen markiert, werden nun auch 4x4 Zellen eingefügt.</td>
</tr>
</tbody>
</table>

Darüber hinaus können Sie über die Option Anzahl bestimmen, wie viele Zellen eingefügt werden sollen. Wählen Sie beispielsweise die Option Ganze Zeilen und setzen die Anzahl auf 10, werden zehn Zeilen statt nur einer Zeile eingefügt.

Klicken Sie abschließend auf Oberhalb einfügen, um die neuen Zellen vor der aktuellen Zelle einzufügen – oder auf Unterhalb einfügen, um sie dahinter einzufügen.

**Tipp: Schnelles Anhängen einer zusätzlichen Zeile am Ende einer Tabelle**

Das Anhängen einer zusätzlichen Zeile am Ende einer Tabelle können Sie auch erreichen, indem Sie in der letzten Zelle einer Tabelle einfach die Tabulatortaste Tab drücken. TextMaker erweitert die Tabelle dann automatisch um eine weitere Zeile.

---

**Tabellenzellen teilen oder verbinden**


In diesem Abschnitt erfahren Sie, wie das geht. Folgende Themen werden darin behandelt:

- [Tabellenzellen teilen](#)
- [Tabellenzellen verbinden](#)
### Tabellen teilen

Sie können eine Tabellenzelle jederzeit teilen, sie also in mehrere Zellen unterteilen.

Gehen Sie dazu wie folgt vor:

1. Setzen Sie die Schreibmarke in die Zelle, die Sie aufteilen möchten.
2. Rufen Sie den Menübefehl **Tabelle > Zellen teilen** auf.
3. Es erscheint ein Dialogfenster. Tragen Sie darin ein, in wie viele Zeilen und Spalten die Zelle aufgeteilt werden soll.
4. Bestätigen Sie mit **OK**.

Die Zelle wird nun entsprechend aufgeteilt.

### Mehrere Zellen auf einmal teilen

Sie können vor dem Aufruf des Befehls **Zellen teilen** auch mehrere zusammenhängende Zellen markieren. In diesem Falle werden diese Zellen allesamt aufgeteilt.

Beachten Sie dabei die Einstellung **Selektierte Zellen vor dem Teilen verbinden** im Dialogfenster dieses Befehls:

- Wenn Sie hier die Option **Die Markierung wird als eine große Zelle behandelt und dann aufgeteilt** wählen, werden die Zellen vor dem Teilen zu einer einzigen Zelle zusammengeführt.
- Wählen Sie hingegen **Jede markierte Zelle wird einzeln aufgeteilt**, wird jede der markierten Zellen in die angegebene Zahl an Zeilen und Spalten aufgeteilt.

### Tabellenzellen verbinden

Sie können mehrere benachbarte Tabellenzellen jederzeit miteinander verbinden. Diese werden dann zu einer einzigen Zelle zusammengeführt.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie die zu verbindenden Zellen.
2. Rufen Sie den Menübefehl **Tabelle > Zellen verbinden** auf.

Die Zellen werden nun zu einer Zelle zusammengeführt.

Die Inhalte der ursprünglichen Zellen gehen dabei nicht verloren; sie werden gemeinsam in die resultierende Zelle übertragen (jeder Zellinhalt in einem eigenen Absatz).
Tabellen teilen

Mit Hilfe des Menübefehls Tabelle > Tabelle teilen können Sie eine Tabelle horizontal teilen. Aus der ursprünglichen Tabelle werden dann also zwei Tabellen.

Gehen Sie dazu wie folgt vor:

1. Setzen Sie die Schreibmarke in eine beliebige Zelle der Tabellenzeile, über der die Tabelle geteilt werden soll.
2. Rufen Sie den Menübefehl Tabelle > Tabelle teilen auf.

Die Tabelle wird nun in zwei Tabellen geteilt.

Tabellen verbinden

Bei Bedarf können Sie zwei Tabellen zu einer einzigen Tabelle verbinden.

Gehen Sie dazu wie folgt vor:

1. Löschen (oder verschieben) Sie sämtlichen Text zwischen den beiden Tabellen, sodass die zwei Tabellen nur noch durch einen leeren Absatz getrennt sind.
2. Setzen Sie die Schreibmarke in diesen leeren Absatz.
3. Drücken Sie die Taste Entf.

Die beiden Tabellen werden nun zu einer Tabelle vereint.

Tabellen formatieren

Zum Formatieren von Tabellen stehen mehrere Befehle zur Verfügung. Diese stellen wir Ihnen in den nachfolgenden Abschnitten vor:

- **Zeilen und Spalten gleichmäßig verteilen**
  
  Mit den Menübefehlen Tabelle > Zeilen verteilen oder Tabelle > Spalten verteilen können Sie markierte Zeilen/Spalten auf einheitliche Höhe oder Breite anpassen.

- **Zeileneigenschaften ändern**
  
  Mit dem Menübefehl Tabelle > Zeileneigenschaften können Sie die Formatierung der Zeilen einer Tabelle ändern. Dazu gehören die Zeilenhöhe und Optionen zum Verhalten der Zeile bei einem Seitenumbruch.
Tabellen

- **Zelleneigenschaften ändern**

Einstellungen zum Formatieren bestimmter *Zellen* in einer Tabelle bietet der Menübefehl *Tabelle > Zelleneigenschaften*. Sie können damit unter anderem die Breite, Ausrichtung und Ränder von Zellen ändern und Zellen mit einer Umrandung oder Schattierung versehen.

- **Allgemeine Eigenschaften von Tabellen ändern**

Der Menübefehl *Tabelle > Tabelleneigenschaften* dient zum Ändern von Einstellungen, die die *gesamte Tabelle* betreffen. Beispielsweise lässt sich mit diesem Befehl die Umrandung und Schattierung aller Tabellenzellen auf einmal ändern. Außerdem können Sie Einstellungen zur Positionierung der Tabelle vornehmen.

- **Tabellenvorlagen**

Der Menübefehl *Tabelle > Tabellenvorlage* ist ein besonders praktischer Helfer: Er bietet Ihnen vorgefertigte Tabellenvorlagen an, mit denen Sie die Formatierung der *kompletten* Tabelle auf Knopfdruk ändern können.

Lesen Sie dazu die nächsten Seiten.

---

**Zeilen und Spalten gleichmäßig verteilen**

Sie können mit den Menübefehlen *Tabelle > Zeilen verteilen* und *Tabelle > Spalten verteilen* die markierten Zeilen oder Spalten einer Tabelle mit gleichmäßigen Abständen versehen.

Wenn Sie Zeilen einer Tabelle mit gleicher Höhe haben möchten, gehen Sie folgendermaßen vor:

1. Markieren Sie die gewünschten Zeilen (alle oder auch nur einige) einer Tabelle.
2. Gehen Sie zum Menübefehl *Tabelle > Zeilen verteilen* und drücken Sie OK.
3. Als Ergebnis sind die markierten Zeilen gleich hoch.

Und wenn Sie die Spalten einer Tabelle mit gleicher Breite haben möchten, gehen Sie so vor:

1. Markieren Sie die gewünschten Spalten (alle oder auch nur einige) einer Tabelle.
2. Gehen Sie zum Menübefehl *Tabelle > Spalten verteilen* und drücken Sie OK.
3. Als Ergebnis sind die markierten Spalten gleich breit.

---

**Zelleneigenschaften ändern**

Der Menübefehl *Tabelle > Zelleneigenschaften* dient zum Ändern der Formatierung der Zeilen einer Tabelle.

Markieren Sie vor dem Aufruf dieses Befehls erst die Tabellenzeilen, deren Format geändert werden soll. Wenn Sie keine Zeilen markieren, wirken sich die Änderungen nur auf die Tabellenzeile aus, in der sich die Schreibmarke befindet.
Das Dialogfenster dieses Befehls bietet folgende Optionen:

### Höhe
Hier können Sie die Höhe der Tabellenzeile ändern. Folgende Optionen stehen zur Wahl:

- **Automatisch**
  Dies ist die Standardeinstellung. Ist sie gewählt, ermittelt TextMaker die optimale Höhe der Zeile automatisch (indem er diese an den tatsächlichen Platzbedarf der Zellinhalte anpasst).

- **Genau**
  Wählen Sie diese Option, können Sie die gewünschte Zeilenhöhe exakt in Zentimetern festlegen. Die Zeile nimmt dann allerdings immer diese Höhe ein – selbst wenn diese nicht ausreichen sollte, um die Inhalte der Zellen vollständig darzustellen.

- **Mindestens**
  Diese Option ist eine Mischung aus den beiden obigen Optionen. Tragen Sie hier beispielsweise 2 cm ein, ist die Zeile normalerweise genau zwei Zentimeter hoch. Geben Sie jedoch in eine der Zellen so viel Text ein, dass diese zwei Zentimeter nicht mehr ausreichen, erhöht TextMaker die Zeilenhöhe automatisch.

### Mit der nächsten Zeile zusammenhalten
Das Aktivieren dieser Option bewirkt, dass die markierten Tabellenzeilen und (!) die darauf folgende Tabelle stets zusammengehalten werden. Fiele ein automatischer Seitenumbruch also zwischen diese Zeilen, würde TextMaker diesen bereits vor den Zeilen durchführen, damit diese gemeinsam auf einer Seite bleiben.

### Seitenumbruch vor dieser Zeile
Schalten Sie diese Option ein, beginnt TextMaker vor dieser Tabellenzeile stets eine neue Seite.

### Seitenumbruch in Zeile erlauben
Diese Option ist standardmäßig ausgeschaltet. Das bedeutet: Sollte ein automatischer Seitenumbruch inmittel dieser Tabellenzeile landen, würde TextMaker diesen nicht zulassen und stattdessen bereits oberhalb der Tabellenzeile eine neue Seite beginnen.

Dies verbessert die Lesbarkeit, denn es verhindert, dass die Zellinhalte in dieser Tabellenzeile durch einen Seitenumbruch "auseinandergerissen" und auf zwei Seiten verteilt werden.
Schalten Sie diese Option hingegen ein, verhindert TextMaker nicht mehr, dass ein automatischer Seite-numbruch inmitten der Tabellenzeile durchgeführt wird. Er lässt nun also zu, dass ein Teil der Zellinhalte auf der einen Seite, ein Teil auf der anderen Seite landet.

**Diese Zeile als Kopfzeile wiederholen**

Diese Option ist nur in den ersten Zeilen einer Tabelle verfügbar.

Sie wirkt sich nur auf Tabellen aus, die sich über mehrere Seiten erstrecken. Wird sie eingeschaltet, wiederholt TextMaker den Inhalt der selektierten Tabellenzeilen am Beginn jeder Seite.

Dies ist nützlich, wenn beispielsweise die ersten beiden Zeilen der Tabelle Überschriften enthalten, die auf jeder Seite wiederholt werden sollen. Markieren Sie in diesem Fall die ersten beiden Zeilen und schalten Sie diese Option dort ein.

### Zelleneigenschaften ändern

Mit dem Menübefehl **Tabelle > Zelleneigenschaften** lässt sich das Erscheinungsbild der aktuellen Tabellenzelle verändern. Sie können natürlich vor dem Aufruf dieses Befehls mehrere Zellen (oder auch komplette Zeilen und Spalten) markieren, um deren Eigenschaften gemeinsam zu ändern.

Das Dialogfenster dieses Befehls bietet folgende Optionen:
Größe
Hier können Sie die Breite der markierten Zellen ändern. Folgende Optionen stehen hierfür zur Wahl:

- **Feste Breite**
  Wählen Sie diese Option, können Sie die Breite exakt festlegen. Tragen Sie dazu rechts daneben den gewünschten Wert ein.

- **Prozentsatz**
  Wählen Sie diese Option, können Sie die gewünschte Breite als Prozentwert der gesamten Tabellenbreite eingeben.

Bei einer dreispaltigen Tabelle ist bei allen Zellen standardmäßig 33,3% eingetragen. Möchten Sie beispielsweise, dass die erste Spalte doppelt so breit sein soll wie die anderen beiden, tragen Sie für alle Zellen der ersten Spalte "50" und für die Zellen der zweiten und dritten Spalte "25" ein.

- **Automatisch**
  Wählen Sie diese Option, ermittelt TextMaker automatisch eine geeignete Breite. Die Zellenbreiten werden dabei gleichmäßig auf den zur Verfügung stehenden Platz aufgeteilt.

Diese drei Optionen lassen sich nach Belieben kombinieren. So können Sie beispielsweise eine Tabelle anlegen, bei der die Zellen der ersten Spalte eine feste Breite haben, die der anderen Spalten jedoch auf "Automatisch" gesetzt sind. Erhöhen Sie dann die Breite der ersten Spalte, werden die anderen Spalten automatisch entsprechend schmaler.

**Tipp:** Sie können die Breite von Zellen auch mit der Maus ändern. Ziehen Sie dazu mit der Maus an der rechten Begrenzungslinie der Zelle. Wenn Sie dabei nichts markiert haben, ändert sich die Breite der gesamten Spalte. Haben Sie hingegen bestimmte Zellen markiert, ändert sich nur deren Breite.

Vertikale Ausrichtung
Diese Einstellung bestimmt, auf welche Weise der Zellinhalt innerhalb der Zelle ausgerichtet werden soll:

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oben</td>
<td>Der Zellinhalt wird an der Oberkante der Zelle ausgerichtet. (Dies ist die Standardeinstellung.)</td>
</tr>
<tr>
<td>Zentriert</td>
<td>Der Zellinhalt wird zwischen Ober- und Unterkante zentriert.</td>
</tr>
<tr>
<td>Unten</td>
<td>Der Zellinhalt wird an der Unterkante der Zelle ausgerichtet.</td>
</tr>
<tr>
<td>Blocksatz</td>
<td>Der Abstand zwischen den Textzeilen wird gleichmäßig so erweitert, dass der Zellinhalt genau an der Oberkante der Zelle beginnt und genau an der Unterkante endet.</td>
</tr>
</tbody>
</table>

Drehen um...
Hier können Sie den Zellinhalt um den angegebenen Winkel drehen.

Ränder
Hier können Sie die Innenränder der markierten Zellen ändern.
**Optionen**

Aktivieren Sie die Option *Text sperren*, lässt sich der Inhalt der markierten Tabellenzellen nicht mehr ändern, wenn das Dokument im *Formularmodus* bearbeitet wird.

Standardmäßig ist diese Option jedoch ausgeschaltet; die Zellen lassen sich also auch im Formularmodus editieren.

Weitere Informationen zu diesem Thema finden Sie im Abschnitt *Inhalt von Formularobjekten schützen*.

**Karteikarte Umrandung**

Auf dieser Karteikarte können Sie Umrandungslinien und Gitternetzlinien an den markierten Zellen anbringen (beziehungsweise die vorhandenen Linien ändern).

Die Bedienelemente auf dieser Karteikarte entsprechen denen des Menübefehls *Format > Umrandung* (siehe Abschnitt *Umrandung und Linien*).

Hinweis: Wenn Sie *mehrere* Zellen markiert haben, lassen sich nicht nur die äußeren Umrandungslinien ändern, sondern auch die Gitternetzlinien *zwischen* den Zellen.

**Tipp:** Sie können die Umrandung von Zellen auch über das Symbol in der Tabellenleiste ändern. Selektieren Sie dazu die gewünschten Zellen und klicken Sie dann *nicht* auf das Symbol selbst, sondern auf den *Pfeil* rechts davon. Es öffnet sich ein Menü, in dem Sie gewünschte Art der Umrandung per Mausklick auswählen können.


**Karteikarte Schattierung**

Mit Hilfe dieser Karteikarte können Sie die markierten Zellen mit einer Schattierung versehen.

Die Bedienelemente auf dieser Karteikarte entsprechen denen des Menübefehls *Format > Schattierung* (siehe Abschnitt *Schattierung*).

**Allgemeine Eigenschaften von Tabellen ändern**


Um diesen Dialog zu öffnen, setzen Sie die Schreibmarke in eine beliebige Tabellenzelle und rufen dann den Menübefehl *Tabelle > Tabelleneigenschaften* auf.

Alternativ lässt sich der Dialog auch über den Menübefehl *Objekt > Eigenschaften* aufrufen – diese beiden Befehle sind identisch.

In dem Dialog lassen sich folgende Einstellungen vornehmen:
**Tabellen**

**Karteikarte Eigenschaften**

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe dazu Abschnitt *Objekt-Eigenschaften, Karteikarte Eigenschaften*.

**Hinweis:** Die dort erwähnte Option Text sperren gibt es bei Tabellen nicht, da sich in Tabellen mit dem Menübefehl *Tabelle > Zelleneigenschaften* jede einzelne Zelle gegen Änderungen schützen lässt (siehe Option Text sperren im Abschnitt *Zelleneigenschaften* ändern). Sie können natürlich auch die gesamte Tabelle gegen Änderungen schützen, indem Sie alle enthaltenen Zellen markieren und die Option Text sperren dann für alle Zellen einschalten.

**Schreibrichtung:** Für Text in *arabischer* Schrift können Sie außerdem die Schreibrichtung der Tabelle ändern. Wenn Sie die Richtung auf rechts-nach-links setzen, ist nicht mehr die Spalte ganz links die erste Spalte, sondern die Spalte ganz rechts. Siehe auch Kapitel *Arbeiten mit arabischem Text*.

**Karteikarte Layout**

Auf dieser Karteikarte können Sie Einstellungen zur Positionierung der Tabelle vornehmen:

- **Ausrichtung**
  
  Hier können Sie die Ausrichtung der Tabelle von linksbündig auf zentriert oder rechtsbündig ändern. (Anmerkung: Dies ist natürlich nur bei Tabellen zu sehen, die nicht über die komplette Seitenbreite gehen.)

- **Linker Einzug**
  
  Hier können Sie die Tabelle um den angegebenen Wert nach rechts einrücken.

- **Umbruch**
  
  Hier können Sie festlegen, ob der Fließtext im Dokument die Tabelle umgeben soll oder nicht:

  - **Keiner:** Dies ist die Standardinstellung: Der Fließtext umgibt die Tabelle nicht.
  - **Umgebend:** Wählen Sie hingegen diese Einstellung, umgibt der Fließtext die Tabelle – ähnlich wie Text, der einen Textrahmen umfließt.

  Darüber hinaus hat das Wählen der Option Umgebend folgende weitere Auswirkungen:

  1. Ein Symbol mit vier Pfeilen wird jetzt links oberhalb der Tabelle angezeigt, wenn sich die Schreibmarke in ihr befindet. Sie können die Tabelle frei bewegen, indem Sie mit der Maus an diesem Symbol ziehen.

  2. Außerdem ist in dem Dialog jetzt die Schaltfläche *Position* verfügbar. Diese öffnet einen weiteren Dialog, in dem erweiterte Einstellungen zur Positionierung der Tabelle gemacht werden können:

    - **Horizontal und Vertikal:** Hier lässt sich die horizontale (beziehungsweise vertikale) Position der Tabelle exakt festlegen. Tipp: Sie können im Feld *Position* nicht nur feste Werte eingeben, sondern auch dessen aufklappbare Liste öffnen und darin eine der vordefinierten Einstellungen auswählen. Wählen Sie beispielsweise den Eintrag "Rechts", wird die Tabelle rechtsbündig am rechten Seitenrand ausgerichtet.

    - **Abstand zum umgebenden Text:** Hier können Sie die Außenränder der Tabelle ändern – also festlegen, wie viel Platz zwischen der Tabelle und dem umgebenden Text freigelassen werden soll.

    - **Mit Text verschieben:** Tabellen sind stets mit dem Textabsatz verankert, der sich unter ihrer linken oberen Ecke befindet. "Verankert" bedeutet hierbei: Sie erscheinen immer auf der Seite, auf der sich dieser Absatz befindet. Verschieben Sie diesen Absatz auf die nächste Seite, landet die Tabelle eben-
falls dort. Wenn Sie diese Option hingegen ausschalten, ist dies nicht mehr der Fall. Die Tabelle bleibt dann stets auf der Seite, auf der sie sich momentan befindet.

**Karteikarte Umrandung**

Hier können Sie die Umrandungs- und Gitternetzlinien für die gesamte Tabelle ändern.

Die Bedienelemente auf dieser Karteikarte entsprechen denen des Menübefehls **Format > Umrandung** (siehe Abschnitt Umrandung und Linien).

Hinweis: Es lassen sich hier nicht nur die äußeren Umrandungslinien ändern, sondern auch die Gitternetzlinien zwischen den Zellen.

**Karteikarte Schattierung**

Hier können Sie die gesamte Tabelle mit einer Schattierung versehen.

Die Bedienelemente auf dieser Karteikarte entsprechen denen des Menübefehls **Format > Schattierung** (siehe Abschnitt Schattierung).

---

**Tabellenvorlagen**

Der Menübefehl **Tabelle > Tabellenvorlage** ist ein besonders praktischer Helfer: Er bietet Ihnen vorgefertigte Tabellenvorlagen an, mit denen Sie die Formatierung der kompletten Tabelle auf Knopfdruck ändern können.

Setzen Sie die Schreibmarke dazu in eine beliebige Zelle der gewünschten Tabelle und rufen Sie diesen Befehl dann auf.

Es erscheint ein Dialog mit einer Liste aller verfügbaren Tabellenvorlagen. Darin können Sie mit den kleinen Vorschaubildern in der Liste das gewünschte Aussehen der Tabelle vorab begutachten und auf die Tabelle anwenden.

Das Auswählen einer anderen Tabellenvorlage ändert das komplette Erscheinungsbild einer Tabelle hinsichtlich Farbgebung und Struktur der Tabelle. Wählen Sie die gewünschte Vorlage aus und bestätigen Sie mit **OK**. Die Formatierung der kompletten Tabelle ändert sich daraufhin entsprechend.

Mit den Optionen im unteren Teil des Dialogs können Sie bei Bedarf eingrenzen, wie sich das Anwenden der Vorlage auf die Tabelle auswirken soll:

- **Kopfzeile**
  
  Schaltet die *Kopfzeile* für Spaltenüberschriften oberhalb der Tabelle ein/aus.

- **Ergebniszeile**
  
  Schaltet eine *Ergebniszeile* am unteren Ende der Tabelle ein/aus.

- **Gebänderte Zeilen und gebänderte Spalten**
  
  Schaltet die abwechselnde farbliche Hervorhebung für jede zweite Zeile beziehungsweise Spalte ein/aus.

- **Erste Spalte und letzte Spalte**
  
  Wenn Sie diese Option einschalten, werden die erste und/oder die letzte Spalte der Tabelle besonders hervorgehoben.
Die Auswirkungen sehen Sie direkt im Feld in den kleinen Vorschaubildern der Liste. Schalten Sie beispielsweise Ergebniszeile aus, verliert die letzte Tabellenzeile ihre besondere Formatierung. Sie wird dann so formatiert wie alle anderen "gewöhnlichen" Tabellenzellen.

_Tipp:_ Wenn Sie das aus früheren Versionen vertraute AutoFormat für Tabellen vermissen, so können Sie es auch weiterhin zu Ihrer individuellen Benutzeroberfläche hinzufügen und anwenden. Siehe Abschnitt Symbolleisten anpassen.

---

**Tabelle in Text umwandeln**

Mit dem Menübefehl Tabelle > Tabelle in Text umwandeln können Sie eine Tabelle in normalen Fließtext umwandeln.

**Ein Beispiel:** Sie möchten eine Tabelle mit 2 x 2 Zellen in eine Liste umwandeln, bei der die Tabellenzellen durch Strichpunkte getrennt sind.

Gehen Sie dazu wie folgt vor:

1. Setzen Sie die Schreibmarke in eine beliebige Zelle der Tabelle.
2. Rufen Sie den Menübefehl Tabelle > Tabelle in Text umwandeln auf.
3. Wählen Sie das gewünschte Trennzeichen, in unserem Beispiel also Strichpunkte.
4. Bestätigen Sie mit OK.


**Wenn Sie also die folgende Tabelle umwandeln...**

<table>
<thead>
<tr>
<th>Zelle1</th>
<th>Zelle2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zelle3</td>
<td>Zelle4</td>
</tr>
</tbody>
</table>

...erhalten Sie folgenden Text:

Zelle1;Zelle2
Zelle3;Zelle4

Jede Zeile wird dabei in einen eigenen Absatz übertragen. Zwischen den Zellen einer Zeile wird das Trennzeichen eingefügt. Je nachdem, welches Trennzeichen Sie wählen, erhalten Sie also folgende Resultate:

<table>
<thead>
<tr>
<th>Trennzeichen</th>
<th>Resultat</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absatztrenner</td>
<td>Hier wird für jede einzelne Tabellenzelle ein neuer Absatz begonnen.</td>
</tr>
<tr>
<td>Benutzerdefiniert</td>
<td>Hier können Sie das Trennzeichen selbst festlegen. Tragen Sie das gewünschte Zeichen dazu in das Eingabefeld ein. Sie können auch mehrere Zeichen eintragen.</td>
</tr>
</tbody>
</table>
Übrigens ist auch der umgekehrte Weg möglich: Sie können tabellarisch angeordneten Text in eine Tabelle umwandeln (siehe nächster Abschnitt).

---

**Text in Tabelle umwandeln**

Im vorherigen Abschnitt wurde beschrieben, wie man eine Tabelle in Textabsätze umwandelt. Es ist jedoch auch der umgekehrte Weg möglich: Mit dem Menübefehl *Tabelle > Text in Tabelle umwandeln* können Sie tabellarisch aufgebauten Text in eine Tabelle umwandeln.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie die Textabsätze, die in eine Tabelle umgewandelt werden sollen.
2. Rufen Sie den Menübefehl *Tabelle > Text in Tabelle umwandeln* auf.
3. Wählen Sie zuerst, durch welche *Trennzeichen* die Einträge im Text abgetrennt sind (siehe unten).
4. Bestimmen Sie dann, wie viele Zeilen und Spalten die Tabelle haben soll. (TextMaker schlägt normalerweise automatisch passende Werte vor.)
5. Bestätigen Sie mit *OK*.

Der Text wird nun in eine Tabelle umgewandelt. Jede Zeile des Textes wird zu einer Zeile der Tabelle.

**Ein Beispiel:**

Sie möchten folgende Adressliste in eine Tabelle wandeln:

Peter; Müller; Gebhardtstraße 24; 12345; Buxtehude
Thomas; Meier; Wiesenallee 7a; 54321; Neustadt

Rufen Sie dazu den Menübefehl *Tabelle > Text in Tabelle umwandeln* auf, wählen Sie Strichpunkte als *Trennzeichen*. Sie erhalten als Ergebnis folgende Tabelle:

<table>
<thead>
<tr>
<th>Peter</th>
<th>Müller</th>
<th>Gebhardtstraße 24</th>
<th>12345</th>
<th>Buxtehude</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thomas</td>
<td>Meier</td>
<td>Wiesenallee 7a</td>
<td>54321</td>
<td>Neustadt</td>
</tr>
</tbody>
</table>

**Optionen des Dialogs**

Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

- **Zeilen und Spalten**

  Um diese Einstellung müssen Sie sich normalerweise nicht kümmern. Denn wenn Sie das korrekte Trennzeichen gewählt haben, ermittelt TextMaker automatisch, wie viele Zeilen und Spalten die resultierende Tabelle haben sollte, und schlägt diese vor.

  Sie können bei Bedarf aber auch eigene Werte eingeben.
- Trennzeichen

  Die wichtigste Einstellung: Hier geben Sie an, welches Zeichen TextMaker als Trennzeichen für die einzelnen Einträge ansehen soll.

  Zur Wahl stehen:
  - Absatztrenner: Jeder Eintrag steht in einem eigenen Absatz.
  - Tabstopps: Die Einträge sind durch Tabulatoren getrennt.

  Hinweis: Das Trennzeichen sollte innerhalb der Einträge natürlich nicht vorkommen, da TextMaker dort sonst aus einem Eintrag zwei Einträge machen würde.

- Anführungszeichen entfernen

  Schalten Sie diese Option ein, entfernt TextMaker bei der Umwandlung alle Anführungszeichen (") aus dem Text.

  Dies ist praktisch, wenn Sie eine Liste konvertieren möchten, bei der alle Einträge in Anführungszeichen eingeschlossen sind. ("Hans";"Meier";...). Viele Datenbankprogramme erzeugen solche Listen.

- Leerzeichen entfernen

  Ist diese Option aktiviert, entfernt TextMaker bei der Umwandlung alle Leerzeichen am Anfang und am Ende der Texteinträge. (Leerzeichen inmitten von Texteinträgen bleiben hingegen unberührt.) Übrigens ist auch der umgekehrte Weg möglich: Sie können Tabellen in Text umwandeln (siehe vorheriger Abschnitt).

---

**Tabellen sortieren**

Mit dem Menübefehl Tabelle > Tabelle sortieren können Sie die Zeilen einer Tabelle sortieren lassen.

Hinweis: Dieser Befehl ist nur auf Tabellen anwendbar. Falls Sie gewöhnliche Textabsätze sortieren lassen möchten, lesen Sie bitte den Abschnitt Text sortieren.

Um die Zeilen einer Tabelle sortieren zu lassen, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke in eine beliebige Zelle der Tabelle.

   Oder: Wenn Sie nur einen Teil der Tabelle sortieren lassen möchten, markieren Sie die Zeilen, die sortiert werden sollen.

2. Rufen Sie den Menübefehl Tabelle > Tabelle sortieren auf.


4. Bestätigen Sie mit OK.

   Die Tabellenzeilen werden nun nach der ausgewählten Spalte sortiert.
Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

**Sortieren nach**
Hier bestimmen Sie, nach welcher Spalte sortiert werden soll.

**Typ**
Normalerweise verwenden Sie hier die Standardeinstellung **Text**. Wenn die Spalte allerdings Datumsangaben enthält, wählen Sie den Typ **Datum**. Wenn sie Zahlen enthält, wählen Sie **Zahlen**.


**Anschließend nach**
Bei Bedarf können Sie mehr als ein Sortierkriterium wählen.
Wenn die erste Spalte beispielsweise Nachnamen und die zweite Spalte Vornamen enthält, wählen Sie bei **Sortieren nach** die erste Spalte und bei **Anschließend nach** die zweite Spalte. Nun werden die Zeilen der Tabelle zunächst nach Nachnamen sortiert. Bei Nachnamen, die mehrmals vorkommen, wird zusätzlich nach Vornamen sortiert.

**Erste Zeile enthält Überschriften**
Wenn die erste Zeile Ihrer Tabelle Überschriften enthält, sollten Sie diese Option einschalten. TextMaker sortiert die erste Zeile dann **nicht** mit.
Beispiel: Eine Tabelle enthält Adressen. In der ersten Zeile stehen Überschriften wie "Name", "Straße", "Ort" etc. Hier sollten Sie diese Option einschalten, damit die Überschriftenzeile nicht mitsortiert wird, sondern weiterhin die erste Zeile der Tabelle bleibt.

**Groß-/Kleinschreibung beachten**
Wenn Sie diese Option einschalten, wird beim Sortieren zwischen groß- und kleingeschriebenen Buchstaben unterschieden. Dadurch landen beispielsweise alle Wörter, die mit einem Kleinbuchstaben beginnen, vor den Wörtern, die mit einem Großbuchstaben beginnen:

**Aus:** Apfel, birne, Clementine. **Ein:** birne, Apfel, Clementine.

**Zellenformatierungen mitsortieren**
Bestimmt, ob nur der Inhalt der Zellen oder auch deren Formatierung umsortiert werden soll:

**Aus:** Es werden nur die Zellinhalte sortiert; die ursprüngliche Formatierung der Tabelle bleibt also erhalten.
**Ein:** Jede Zeile, die durch das Sortieren an eine andere Stelle verschoben wird, nimmt ihre Formatierung (Schattierung, Ränder, Ausrichtung, Rotation) mit an die neue Position.
Text sortieren

Sie können nicht nur, wie im vorherigen Abschnitt beschrieben, die Inhalte einer Tabelle sortieren, sondern auch gewöhnliche Absätze im Text. Verwenden Sie dazu den Menübefehl Bearbeiten > Sortieren.

Gehen Sie wie folgt vor:

1. Markieren Sie die zu sortierenden Textabsätze.
2. Rufen Sie den Menübefehl Bearbeiten > Sortieren auf.
3. Wählen Sie, ob aufsteigend oder absteigend sortiert werden soll.
4. Bestätigen Sie mit OK.

Die Absätze werden nun entsprechend sortiert.

Das Dialogfenster des Sortierbefehls verfügt über einige zusätzliche Optionen, die Sie normalerweise nicht benötigen. Dazu gehören:

Sortieren nach


Das Wählen der Spalte, nach der sortiert werden soll, ist nur dann sinnvoll, wenn die markierten Absätze wie eine Tabelle aufgebaut sind – also zum Beispiel Tabulatoren oder ein anderes Trennzeichen enthalten (siehe auch Option Trennzeichen).

Anschließend nach

Bei Bedarf können Sie mehr als ein Sortierkriterium wählen.


Trennzeichen

Die Option Trennzeichen müssen Sie nur beachten, wenn Sie Absätze sortieren, die wie eine Tabelle aufgebaut sind.

Enthalten die Absätze beispielsweise jeweils Name, Straße und Wohnort, können Sie TextMaker mitteilen, durch welches Trennzeichen die einzelnen Bestandteile der Adresse getrennt sind:

- Leerzeichen
- Tabstopps
- Benutzerdefiniert (hier können Sie das Trennzeichen selbst eingeben)

Ein Beispiel:

Sie möchten die folgenden drei Absätze sortieren:
Hier sollten Sie als Trennzeichen natürlich **Tabstopps** auswählen, da die einzelnen Bestandteile der Adresse (Name, Straße, Ort) durch Tabulatoren getrennt sind.

Vorteil: Jetzt können Sie im Dialog des Sortierbefehls nach Spalte1, Spalte2 oder wahlweise Spalte3 sortieren. Spalte1 steht für den Namen, Spalte2 für die Straße, Spalte3 für den Ort.

Wären Sie hingegen das Leerzeichen als Trennzeichen wählen, würde TextMaker jedes Wort als eine "Spalte" ansehen, was natürlich nicht hilfreich ist, da beispielsweise der Name mal aus zwei Wörtern, mal aus drei Wörtern bestehen kann.

### Erster Absatz enthält Überschriften

Wenn der erste der markierten Absätze Überschriften enthält, sollten Sie diese Option einschalten. TextMaker sortiert den ersten Absatz dann *nicht* mit.

Beispiel: Die markierten Absätze enthalten Adressen. Im ersten Absatz stehen Überschriften wie "Name", " Straße", " Ort" etc. Hier sollten Sie diese Option einschalten, damit dieser Absatz nicht mitsortiert wird, sondern weiterhin der erste Absatz bleibt.

### Groß-/Kleinschreibung beachten

Wenn Sie diese Option einschalten, wird beim Sortieren zwischen groß- und kleingeschriebenen Buchstaben unterschieden. Dadurch landen beispielsweise alle Wörter, die mit einem Kleinbuchstaben beginnen, vor den Wörtern, die mit einem Großbuchstaben beginnen:

**Aus:** Apfel, birne, Clementine.  **Ein:** birne, Apfel, Clementine.

### Tipp: Verwenden der Tabellenleiste

Über die Menübefehle hinaus verfügt TextMaker noch über einen besonders nützlichen Helfer zum Bearbeiten von Tabellen: die *Tabellenleiste*.

**Die Tabellenleiste**

Diese Symbolleiste erscheint automatisch, wenn Sie die Schreibmarke in eine Tabelle setzen. Sie verfügt über folgende Schaltflächen (von links nach rechts):

- Tabelle (in die aktuelle Tabellenzelle) einfügen
- Tabelleneigenschaften bearbeiten
- Zeileneigenschaften bearbeiten
- Zelleneigenschaften bearbeiten
- Zellen einfügen
- Zellen löschen
- Zellen verbinden
- Zellen teilen
- Tabelle in zwei Tabellen aufteilen
- Tabelle sortieren
- Ganze Zeile(n) einfügen
- Ganze Spalte(n) einfügen
- Ganze Zeile(n) löschen
- Ganze Spalte(n) löschen
- Tabellenvorlagen
- Umrandung der selektierten Zellen ändern
- Schattierung der selektierten Zellen ändern
- Ausrichtung der selektierten Zellen ändern

Detailliertere Informationen zu den einzelnen Funktionen finden Sie im Kapitel Tabellen.
Sie können in Ihre Dokumente jederzeit Grafiken einfügen. Dabei können Sie wählen, ob die Grafik direkt in den Fließtext eingebettet oder in einem frei verschiebbaren "Rahmen" eingefügt werden soll:

- **Grafik in den Text einfügen**
  
  Mit dem Menübefehl **Objekt > Neue Grafik** können Sie Grafiken direkt in den Fließtext einfügen.
  
  Eine so eingefügte Grafik wird von TextMaker behandelt, als ob sie ein Buchstabe inmitten des Textes wäre. Sie ist in den Textfluss eingebunden. Tippen Sie also direkt vor der Grafik etwas ein, wird diese wie ein Buchstabe weiterrgeschoben.

- **Grafikrahmen einfügen**
  
  Alternativ lassen sich Grafiken mit dem Menübefehl **Objekt > Neuer Grafikrahmen** auch in Form von **Grafikrahmen** einfügen.
  
  Grafikrahmen sind standardmäßig an einer festen Position auf der Seite fixiert – sie verändern ihre Position also nicht, wenn Sie Text oberhalb der Grafik einfügen oder löschen. Natürlich können Sie Grafikrahmen aber jederzeit verschieben.

In diesem Kapitel geht es zunächst nur um das Einfügen einer Grafik direkt in den Text. Informationen zu **Grafikrahmen** finden Sie im Kapitel **Rahmen und Zeichnungen**.

Folgende Themen werden in diesem Kapitel behandelt:

- **Grafiken in den Text einfügen**
- **Grafiken einscannen**
- **Grafiken aus der Galerie/Kamera einfügen (Android)**
- **Position und Größe von Grafiken ändern**
- **Eigenschaften von Grafiken ändern**
- **Verwenden der Grafikleiste**

Lesen Sie dazu die nächsten Seiten.

---

**Grafiken in den Text einfügen**

Um eine Grafik in den Text einzufügen, gehen Sie folgendermaßen vor:

1. Setzen Sie die Schreibmarke an die gewünschte Position.
2. Rufen Sie den Menübefehl **Objekt > Neue Grafik** auf.
3. Nun erscheint ein Dialog, in dem Sie festlegen, welche Grafik eingefügt werden soll. Wählen Sie die gewünschte Grafikdatei und bestätigen Sie mit **OK**.
Die Grafik wird nun in den Text eingefügt.

**Grafik nicht sichtbar?** Sollte die Grafik nach dem Einfügen nicht zu sehen sein, haben Sie vermutlich die Anzeige von Bildern deaktiviert, sprich die Option **Platzhalter anzeigen** für Bilder eingeschaltet. Damit die Grafiken wieder angezeigt werden, rufen Sie den Menübefehl **Datei > Eigenschaften** auf, wechseln auf der Karteikarte **Ansicht** und schalten diese Option wieder auf **Bilder anzeigen** um.

**Optionen des Dialogs**

Die Optionen im obigen Dialogfenster haben folgende Bedeutung:

- **Im Dokument ablegen**

  Ist diese Option eingeschaltet, speichert TextMaker eine Kopie der Grafik im Dokument ab und verwendet dieses anstelle des Originals.

  Ist sie ausgeschaltet, wird im Dokument nur ein Verweis auf die originale Grafikdatei gespeichert.

- **In den Ordner des Dokuments kopieren**

  Ist diese Option eingeschaltet, erzeugt TextMaker eine Kopie der Grafikdatei in dem Ordner, in dem sich das Dokument befindet, und verwendet diese anstelle des Originals.

  Diese Option ist nur dann verfügbar, wenn das Dokument schon einmal gespeichert wurde.

**Als Grafikrahmen einfügen**

Wie in der Einleitung erwähnt, lassen sich Grafiken alternativ auch als Grafikrahmen einfügen. Verwenden Sie dazu einfach den Menübefehl **Objekt > Neuer Grafikrahmen** statt des Befehls **Neue Grafik**.

Der Unterschied: Rahmen sind an einer festen Position auf der Seite fixiert; sie verschieben sich also nicht, wenn Sie Text oberhalb des Rahmens einfügen oder löschen.

Weitere Informationen zu Grafikrahmen finden Sie im Abschnitt [Grafikrahmen](#).

**Grafiken einscannen**


Mit TextMaker für Windows lassen sich Originale direkt in ein Dokument einscannen. Sie müssen dazu einen Scanner an Ihren Rechner angeschlossen und die dazugehörige Software installiert haben.

Um etwas in das aktuelle Dokument einzuscannen, gehen Sie wie folgt vor:

1. Schalten Sie den Scanner ein und legen Sie die Vorlage ein.

2. Setzen Sie in TextMaker die Schreibmarke an die Position des Dokuments, an der Ihr gescanntes Ergebnis eingefügt werden soll.

3. Rufen Sie den Menübefehl **Datei > Holen** auf.

TextMaker aktiviert nun die Scan-Software Ihres Scanners. Nehmen Sie darin die gewünschten Einstellungen vor (siehe Handbuch zum Scanner) und starten Sie den Scanvorgang. Wenn dieser abgeschlossen ist, erscheint das Ergebnis als Grafik im TextMaker Dokument.
**Als Grafikrahmen einscannen**


Der Unterschied: Rahmen sind an einer festen Position auf der Seite fixiert; sie verschieben sich also nicht, wenn Sie Text oberhalb des Rahmens einfügen oder löschen.

Weitere Informationen zu Grafikrahmen finden Sie im Abschnitt **Grafikrahmen**.

**Eine andere Quelle wählen**

Wenn an Ihren PC mehrere Scanner angeschlossen sind, können Sie mit dem Menübefehl **Datei > Quelle wählen** entscheiden, aus welcher dieser Quellen Sie beim Verwenden des Befehls **Datei > Holen** etwas ein-scannen möchten.

---

### Grafiken aus der Galerie/Kamera einfügen (Android)

*Hinweis:* Diese Funktion steht nur in der **Android**-Version zur Verfügung.

Bei der Android-Version können Sie Grafiken auch über die **Galerie** oder über die **Kamera** Ihres Geräts einfügen.

Gehen Sie dazu wie folgt vor:

**Grafik aus der Galerie einfügen**

1. Setzen Sie die Schreibmarke an die Position, an der die Grafik eingefügt werden soll.
2. Rufen Sie den Menübefehl **Objekt > Neue Grafik aus der Galerie** auf.
3. Ihr Android-Gerät öffnet automatisch seine **Galerie**-App. Wählen Sie darin die gewünschte Grafik durch Antippen aus.

Die Grafik wird nun eingefügt.

**Grafik von der Kamera einfügen**

1. Setzen Sie die Schreibmarke an die Position, an der die Grafik eingefügt werden soll.
2. Rufen Sie den Menübefehl **Objekt > Neue Grafik von der Kamera** auf.

Die Grafik wird nun eingefügt.
Als Grafikrahmen einfügen

Bei der gerade beschriebenen Vorgehensweise wird die Grafik direkt in den Fließtext eingefügt. Alternativ können Sie die Grafik als Grafikrahmen einbinden. Verwenden Sie dazu einfach den Menübefehl **Objekt** > **Neuer Grafikrahmen aus der Galerie** (Kamera) statt des Befehls **Neue Grafik aus der Galerie** (Kamera).


Position und Größe von Grafiken ändern

Die **Position** einer Grafik können Sie wie folgt ändern:

- **Ausschneiden und an anderer Stelle einfügen**
  Das Verschieben einer eingebetteten Grafik funktioniert genau wie das Verschieben von Text: Markieren Sie die Grafik und schneiden Sie diese mit dem Menübefehl **Bearbeiten** > Ausschneiden aus. Dann setzen Sie die Schreibmarke an die Zielstelle und fügen die Grafik dort mit dem Menübefehl **Bearbeiten** > **Einfügen** wieder ein.

- **Mit der Maus verschieben**
  Alternativ können Sie eingebettete Grafiken auch mit der Maus verschieben: Selektieren Sie die Grafik dazu per Mausklick und ziehen Sie diese dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.

Die **Größe** einer Grafik lässt sich mit folgenden Methoden ändern:

- **Ziehen an den Greifern auf dem Selektionsrahmen**
  Klicken Sie die Grafik an, um sie zu selektieren. Es erscheint daraufhin ein blauer Selektionsrahmen um die Grafik, der auch einige runde "Greifer" enthält. Wenn Sie mit der Maus an einem dieser Greifer ziehen, ändert die Grafik ihre Größe entsprechend.

- **Werte von Hand eingeben**
  Sie können die Größe einer Grafik auch exakt in Zahlenwerten angeben. Selektieren Sie die Grafik dazu per Mausklick und rufen Sie den Menübefehl **Objekt** > **Eigenschaften** auf. Es erscheint daraufhin ein Dialogfenster zum Ändern der Eigenschaften der Grafik (siehe auch nächster Abschnitt). Wechseln Sie darin auf die Karteikarte **Format** und geben Sie in der Rubrik **Größe** die gewünschten Maße an.

Eigenschaften von Grafiken ändern

Um die Eigenschaften einer Grafik zu bearbeiten, selektieren Sie diese zunächst per Mausklick. Dann rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, worauf ein entsprechender Dialog erscheint.

*Tipp:* Sie können diesen Dialog auch über einen Doppelklick auf die Grafik aufrufen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

**Karteikarten Layout, Format, Füllung etc.**

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgender Einstellungen:

- **Layout:** Auf dieser Karteikarte können Sie lediglich die Außenränder der Grafik ändern. Die anderen Optionen sind nur bei Grafikrahmen verfügbar. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.
- **Format:** Hier können Sie die Größe der Grafik ändern und die Grafik drehen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Format**.
- **Füllung:** Hier können Sie die Füllung ändern. Nur bei Grafiken mit transparenten Bereichen sichtbar. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Füllung**.
- **Linien:** Hier können Sie Umrandungs- und Linien anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Linien**.
- **Schatten:** Hier können Sie einen Schatten anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Schatten**.
- **Effekte:** Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Effekte**.
- **Eigenschaften:** Hier können Sie allgemeine Einstellungen ändern. Außerdem werden Informationen zur verwendeten Grafik angezeigt. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Eigenschaften**.

Weiterhin erscheint bei Grafiken eine zusätzliche Karteikarte mit weiteren Optionen:

**Karteikarte Grafik**

Auf der Karteikarte **Grafik** können Sie Einstellungen zur Grafik selbst vornehmen.

*Tipp:* Einen Teil dieser Einstellungen können Sie auch über die Grafikleiste ändern, die automatisch erscheint, wenn Sie eine Grafik selektieren. Siehe Abschnitt **Verwenden der Grafikleiste**.

Sie finden auf dieser Karteikarte folgende Optionen:

- **Varianten**

  In dieser Liste werden einige vorgefertigte Variationen der Grafik angeboten – zum Beispiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, bei denen das Bild eingefärbt wurde.

  Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog werden dann automatisch auf entsprechende Einstellungen gesetzt.

- **Rubrik Optionen**

  Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alternative Möglichkeit zum Ändern der Helligkeit) ändern.
Grafiken

- **Schaltfläche Weiteres**
  Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen:
  Wenn Sie die Option **Einfärben** aktivieren und darunter eine Farbe auswählen, wird die Grafik entsprechend eingefärbt.

  Mit den Optionen in der Rubrik **Beschnitt** können Sie die Grafik zuschneiden. Dies ist nützlich, wenn Sie nur einen Ausschnitt der Grafik benötigen. Soll beispielsweise das obere Viertel der Grafik abgeschnitten werden, wählen Sie zunächst **Relative Werte verwenden** und geben Sie bei **Oben** die Zahl "25" (Prozent) ein.

  Wählen Sie **Absolutes Werte verwenden** aus, werden die Eingaben nicht prozentual, sondern in absoluten Längeneinheiten abgeschnitten. Wenn Sie negative Werte eingeben, werden die Bereiche der Grafik nicht abgeschnitten, sondern wird mit einem Rahmen erweitert.

- **Rubrik Transparenz**
  Hier können Sie Einstellungen zur Transparenz der Grafik vornehmen:


  **Keine Transparenz**: Die Grafik wird nicht transparent dargestellt – selbst wenn es sich um eine Grafikdatei mit Transparenz-Informationen handelt.

  **Farbe**: Lässt Sie die Farbe auswählen, die als transparente Farbe verwendet werden soll. Wählen Sie beispielsweise die Farbe Weiß, werden alle weißen Bereiche der Grafik transparent dargestellt.

- **Schaltfläche Datei**
  Über diese Schaltfläche können Sie eine andere Grafikdatei auswählen.

- **Schaltfläche Exportieren**
  Nur bei Grafiken verfügbar, die im Dokument gespeichert sind. Mit dieser Schaltfläche können Sie die Grafikdatei exportieren, also eine Kopie der Grafik unter einem beliebigen Namen auf Festplatte speichern.

  Schalten Sie dabei die Option **Verknüpfung zu Datei herstellen** ein, ersetzt TextMaker außerdem die im Dokument gespeicherte Grafik durch einen Verweis auf die Zieldatei. Die Grafik ist dann also nicht mehr im Dokument gespeichert.

---

**Verwenden der Grafikleiste**

Manche Eigenschaften von Grafiken können auch über die **Grafikleiste** geändert werden.

![Grafikleiste](image)

Diese Symbolleiste erscheint automatisch, wenn Sie eine Grafik selektieren. Sie enthält folgende Schaltflächen (von links nach rechts):
Dialog des Menübefehls **Objekt > Eigenschaften** für die Grafik aufrufen

- Grafik mit einem Fotorahmen-Effekt versehen
- Originalfarben der Grafik verwenden
- Farben auf Graustufen reduzieren
- Farben auf schwarz/weiß reduzieren
- Helligkeit erhöhen
- Helligkeit reduzieren
- Kontrast erhöhen
- Kontrast reduzieren
- Gamma erhöhen
- Gamma reduzieren
- Um 90° nach rechts drehen
- Um 90° nach links drehen
- Alle mit dieser Symbolleiste gemachten Änderungen verwerfen
- **Beschnittmodus** aktivieren/deaktivieren. In diesem Modus erscheinen zusätzliche Greifer an den Rändern der Grafik. Wenn Sie an diesen mit der Maus ziehen, wird die Grafik entsprechend beschnitten.

Alle obigen Einstellungen lassen sich alternativ auch mit dem Menübefehl **Objekt > Eigenschaften** vornehmen. Siehe Abschnitt [Eigenschaften von Grafiken ändern](#).
Diagramme

Mit Hilfe von Diagrammen können Sie Zahlenwerte grafisch darstellen.

In diesem Kapitel finden Sie alles Wissenswerte dazu. Es ist unterteilt in folgende Abschnitte:

- **Diagramme einfügen**

  Als erstes erfahren Sie, wie man ein Diagramm anlegt. Der komfortabelste Weg geht dabei einen kleinen "Umweg" über die Tabellenkalkulation PlanMaker. Sie können aber auch einfach ein leeres Diagramm einfügen und die darzustellenden Werte dann von Hand eintippen.

- **Diagramme bearbeiten**

  Dieser Abschnitt enthält alle Informationen zum Bearbeiten von Diagrammen. Sie erfahren darin, wie man die in einem Diagramm darzustellenden Zahlenwerte eingibt/bearbeitet, wie man mit den einzelnen Diagrammelementen (Datenreihen, Achsen, Legende etc.) arbeitet und wie man die Eigenschaften von Diagrammen ändert.

- **Diagramme als Grafik speichern**

  Der Menübefehl **Objekt > Diagramm > Als Grafik speichern** ermöglicht es Ihnen, ein Abbild eines Diagramsms in einer Grafikdatei zu speichern.

  Lesen Sie dazu die nächsten Seiten.

  **Tipp:** Grundlegende Informationen zu Diagrammen finden Sie auch im Handbuch zur Tabellenkalkulation PlanMaker, Kapitel "Diagramme".

Diagramme einfügen

Es gibt zwei Methoden, ein Diagramm in ein Dokument einzufügen:

- **Diagramme über PlanMaker einfügen**


- **Diagramme manuell einfügen**

  Alternativ können Sie auch den Menübefehl **Objekt > Neues Diagramm** in TextMaker aufrufen, um einfach ein neues, leeres Diagramm anzulegen. Anschließend geben Sie die darzustellenden Zahlenwerte in einen Dialog ein, den Sie mit dem Menübefehl **Objekt > Diagramm > Daten bearbeiten** aufrufen können.

  Details dazu finden Sie auf den nächsten Seiten.
Diagramme über PlanMaker einfügen

Der komfortabelste Weg zum Einfügen eines Diagramms führt über einen kleinen "Umweg": Sie verwenden die Tabellenkalkulation PlanMaker, um das Diagramm zu erzeugen. Dann kopieren Sie das Diagramm in die Zwischenablage, wechseln zu TextMaker und fügen es dort ein.

Der Vorteil dieser Methode: PlanMaker eignet sich einfach am besten zum Eintragen von Daten – und auch zum Anlegen von Diagrammen. Sie haben dort zahlreiche Features zur Verfügung, die Sie nur in einer Tabellenkalkulation finden.

Diese Methode funktioniert natürlich nur, wenn Sie PlanMaker installiert haben.

Im Einzelnen gehen Sie wie folgt vor:

3. Falls das Diagramm nicht bereits selektiert ist, klicken Sie es an, um es zu selektieren.
5. Wechseln Sie zu TextMaker.
6. Setzen Sie die Schreibmarke an die Position, an der das Diagramm eingefügt werden soll.

Hinweis: Das Diagramm wird beim Einfügen nicht in eine Grafik umgewandelt, sondern es bleibt weiterhin ein Diagramm. Sie können später also jederzeit z.B. seinen Diagrammtyp ändern oder seine Daten und Einstellungen bearbeiten.

Als Diagramrahamen einfügen


Der Unterschied: Rahmen sind an einer festen Position auf der Seite fixiert; sie verschieben sich also nicht, wenn Sie Text oberhalb des Rahmens einfügen oder löschen.

Weitere Informationen zu Rahmen finden Sie im Abschnitt Rahmen und Zeichnungen.

Als OLE-Objekt einfügen

Ein wie oben beschrieben kopiertes und eingefügtes Diagramm hat keine Verbindung zu dem Originaldiagramm in PlanMaker. Wenn Sie das Original also nachträglich in PlanMaker verändern, wirkt sich das nicht auf seine Kopie in TextMaker aus.
Falls Sie ein Diagramm einfügen möchten, das eine Verbindung zu seinem Original in PlanMaker aufrecht-erhält, müssen Sie dieses als OLE-Objekt einfügen. Verwenden Sie dazu den Menübefehl Objekt > Neues OLE-Objekt und wählen als Objekttyp "PlanMaker-Diagramm".

Weitere Informationen zum Umgang von OLE-Objekten finden Sie im Abschnitt OLE-Objekte.

**Diagramme manuell einfügen**

Im vorherigen Abschnitt wurde beschrieben, wie Sie Diagramme mit PlanMaker erstellen und dann in Ihr TextMaker-Dokument kopieren. Alternativ können Sie auch einfach ein leeres Diagramm in das TextMaker-Dokument einfügen und dieses dann von Hand mit Daten füllen. Dazu gehen Sie wie folgt vor:

**Schritt 1: Einfügen eines leeren Diagramms**

Fügen Sie zunächst ein leeres Diagramm ein. Gehen Sie dazu wie folgt vor:

1. Setzen Sie die Schreibmarke an die gewünschte Position in Ihrem TextMaker-Dokument.
2. Rufen Sie den Menübefehl Objekt > Neues Diagramm auf.
3. Es erscheint ein Dialog, in dem Sie bestimmen können, welche Art von Diagramm eingefügt werden soll. Wählen Sie dazu den gewünschten Diagrammtyp und Untertyp. Informationen zu allen verfügbaren Diagrammtypen finden Sie im Handbuch zu PlanMaker, Stichwort "Diagrammtyp".
4. Bestätigen Sie mit OK.

Das Diagramm wird nun eingefügt.

**Schritt 2: Eingeben der darzustellenden Daten**

Wenn Sie ein neues Diagramm anlegen, sind darin standardmäßig die Werte 1, 2, 3 und 4 eingetragen. Diese Werte dienen lediglich als Beispielwerte – damit das Diagramm nicht komplett leer dargestellt wird. Sie sollten hier natürlich eigene Werte eintragen.

Gehen Sie dazu wie folgt vor:

1. Falls das Diagramm nicht mehr selektiert ist, selektieren Sie es per Mausklick.
2. Rufen Sie den Menübefehl Objekt > Diagramm > Daten bearbeiten auf.
3. Es erscheint ein Dialog. Tragen Sie die darzustellenden Werte darin in die Spalte Y-Werte ein. Die anderen Spalten und Einstellungen brauchen Sie normalerweise nicht zu beachten; sie sind für die meisten Diagrammtypen irrelevant. (Ausführliche Informationen zu diesem Dialog finden Sie im Abschnitt Daten eines Diagramms eingeben/bearbeiten)
4. Wenn alles eingetragen ist, bestätigen Sie mit OK.

Das Diagramm aktualisiert sich und stellt nun die eingetragenen Werte dar.

Wenn Sie die Werte später noch einmal ändern möchten, selektieren Sie das Diagramm und rufen den Menübefehl Objekt > Diagramm > Daten bearbeiten erneut auf.
Als Diagrammrahmen einfügen

Sie können neue Diagramme alternativ auch als Rahmen einfügen. Verwenden Sie dazu zum Einfügen einfach den Menübefehl **Objekt > Neuer Diagrammrahmen** statt des Befehls **Neues Diagramm**.

Der Unterschied: Rahmen sind an einer festen Position auf der Seite fixiert; sie verschieben sich also nicht, wenn Sie Text oberhalb des Rahmens einfügen oder löschen.

Weitere Informationen zu Rahmen finden Sie im Abschnitt **Rahmen und Zeichnungen**.

---

Diagramme bearbeiten

Auf den nächsten Seiten erfahren Sie, wie Sie vorhandene Diagramme bearbeiten können. Folgende Themen werden darin behandelt:

- **Daten eines Diagramms eingeben/bearbeiten**
  
  Mit dem Menübefehl **Objekt > Diagramm > Daten bearbeiten** können Sie die Daten eines Diagramms bearbeiten – sprich: die darzustellenden Zahlenwerte eintragen oder abändern.

- **Diagrammelemente bearbeiten**
  
  Ein Diagramm enthält verschiedene Elemente – zum Beispiel Datenreihen, Achsen, eine Legende etc. Sie können jedes dieser Elemente per Mausklick selektieren und dann bearbeiten. In diesem Abschnitt erfahren Sie, wie das geht.

- **Eigenschaften von Diagrammen ändern**
  

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten.

*Tipp:* Grundlegende Informationen zu Diagrammen finden Sie auch im Handbuch zur Tabellenkalkulation **PlanMaker**, Kapitel "Diagramme".

---

**Tipp: Verwenden der Diagrammleiste**

Wenn Sie ein Diagramm selektieren, erscheint automatisch ein nützlicher Helfer auf dem Bildschirm: die **Diagrammleiste**.

Die Diagrammleiste

Diese Leiste enthält Symbole für die wichtigsten Funktionen zum Bearbeiten von Diagrammen. Von links nach rechts:

- Diagrammtyp auswählen
- Untertyp auswählen (nur bei einigen Diagrammtypen verfügbar)
Diagramme

- Liste aller Diagrammelemente, die das Diagramm enthält (klicken Sie auf ein Element, wird es im Diagramm selektiert)
- Eigenschaften des gewählten Diagrammelements bearbeiten
- Allgemeine Eigenschaften des gesamten Diagramms bearbeiten
- Trendlinie hinzufügen
- Daten des Diagramms bearbeiten
- Legende ein-/ausblenden
- Vertikale Gitternetzlinien ein-/ausblenden
- Horizontale Gitternetzlinien ein-/ausblenden

**Daten eines Diagramms eingeben/bearbeiten**

Wenn Sie ein neues Diagramm anlegen, sind darin standardmäßig die Werte 1, 2, 3 und 4 eingetragen. Diese Werte dienen lediglich als Beispielwerte – damit das Diagramm nicht komplett leer ist.

Mit dem Menübefehl **Objekt > Diagramm > Daten bearbeiten** können Sie diese Werte jederzeit bearbeiten und so Ihre eigenen Werte eintragen.

Gehen Sie wie folgt vor:

1. Selektieren Sie das betreffende Diagramm per Mausklick.
2. Ruf den Menübefehl **Objekt > Diagramm > Daten bearbeiten** auf.
3. Es erscheint ein Dialog. Tragen Sie die darzustellenden Werte darin in die Spalte **Y-Werte** ein.
   - Die anderen Spalten und Einstellungen brauchen Sie normalerweise nicht zu beachten; sie sind für die meisten Diagrammtypen irrelevant.
   - (Ausführliche Informationen zu allen Optionen in diesem Dialog folgen gleich im Anschluss.)
4. Bestätigen Sie mit **OK**.

Das Diagramm aktualisiert sich und stellt nun die eingetragenen Werte dar.

Alternativ können Sie diesen Dialog auch öffnen, indem Sie das Diagramm per Mausklick selektieren, den Menübefehl **Objekt > Eigenschaften** aufrufen, auf die Karteikarte **Datenreihen** wechseln und dort die Schaltfläche **Bearbeiten** betätigen.

**Optionen des Dialogs**

Die Optionen im oben erwähnten Dialogfenster haben folgende Funktionen:

- **Datenreihen**
  - Bei Diagrammen, die mehrere Datenreihen haben, können Sie hier auswählen, welche Datenreihe in dem Dialog angezeigt werden soll.
  - Tipp: Um die Datenreihen eines Diagramms zu verwalten, selektieren Sie es, rufen den Menübefehl **Objekt > Eigenschaften** auf und wechseln auf die Karteikarte **Datenreihen**. Dort können Sie unter anderem Datenreihen hinzufügen, entfernen und bearbeiten.

- **Schaltfläche Umbenennen**
  - Benennt die momentan in der Liste **Datenreihen** ausgewählte Datenreihe um.
  - Tipp: Dieser Name erscheint auch in der Legende des Diagramms.
Den größten Teil des Dialogs nimmt eine Tabelle zum Eintragen der Werte ein:

- **X-Werte**

- **Y-Werte**
  Die mittlere Spalte steht für die Y-Werte. *Hier* sind üblicherweise die darzustellenden Werte einzutragen.

- **Blasengrößen**
  Die rechte Spalte ist nur bei Blasendiagrammen auszufüllen und bestimmt dort die Größe der Blasen.

- **Schaltfläche Zeile einfügen**
  Fügt eine zusätzliche Zeile oberhalb der aktuellen Zeile ein.

- **Schaltfläche Zeile anhängen**
  Hängt eine zusätzliche Zeile unterhalb der letzten Zeile ein.

- **Schaltfläche Zeile löschen**
  Löscht die aktuelle Zeile.

- **Schaltfläche Aus Zwischenablage**
  Überschreibt die Werte für die aktuelle Datenreihe mit den Werten, die sich momentan in der Zwischenablage befinden.


  Siehe auch nachfolgende Anmerkungen.

**Einige Anmerkungen zur Schaltfläche "Aus Zwischenablage":**

- Die Schaltfläche *Aus Zwischenablage* kann immer nur eine Datenreihe mit Daten füllen. Sie können also nicht z.B. den Inhalt einer kompletten Tabelle markieren und deren Werte dann in Form von *mehreren* Datenreihen einfügen.

  Tipp: Sie können dies aber jederzeit über einen kleinen "Umweg" erreichen: Fügen Sie den Inhalt der Tabelle in die Tabellenkalkulation PlanMaker ein (als Tabellenzellen), erstellen Sie dort daraus das Diagramm, kopieren Sie dieses in die Zwischenablage und fügen Sie es dann in TextMaker ein. Siehe dazu auch Abschnitt *Diagramme über PlanMaker einfügen*.


  Ähnliches gilt auch für Blasendiagramme. Hier kann die Zwischenablage bis zu drei Werte pro Zeile enthalten: X, Y und die Blasengröße.

- Zeichenketten in der Zwischenablage werden wie folgt behandelt: Normalerweise liefern diese immer den Wert 0 (Null). Enthält eine Zeichenkette aber auch Ziffern, wird die erste Zahl daraus extrahiert.

  Beispiele:
"Euro" liefert den Wert 0.
"50 Euro" liefert den Wert 50.
"Euro 50" liefert den Wert 50.
"50 Euro, 20 Cent" liefert ebenfalls den Wert 50. (Es wird immer nur die erste Zahl berücksichtigt).

**Diagrammelemente bearbeiten**

Diagramme bestehen aus mehreren Komponenten. So gibt es neben den Datenreihen selbst beispielsweise die Achsen, eine Legende etc. Diese einzelnen Komponenten eines Diagramms nennt man die Diagramm-elemente.

Die nachfolgende Abbildung zeigt, welche Diagrammelemente es gibt:

Reihe 1, Reihe 2 etc. sind dabei die Datenreihen.

Bei dreidimensionalen Diagrammtypen kommen noch ein paar zusätzliche Elemente (Bodenfläche, Wände etc.) hinzu.

Jedes dieser Diagrammelemente lässt sich bei Bedarf per Mausklick selektieren und dann bearbeiten.

**Selektieren von Diagrammelementen**

Um ein Diagrammelement zu selektieren, selektieren Sie zunächst das Diagramm selbst (durch Anklicken) und klicken dann auf das gewünschte Diagrammelement. Um beispielsweise eine Datenreihe zu selektieren, klicken Sie auf einen beliebigen Wert innerhalb dieser Reihe.

Hinweis: Wenn Sie einen einzelnen Wert innerhalb einer Datenreihe selektieren möchten, müssen Sie erst auf die Datenreihe und dann auf den gewünschten Einzelwert klicken.

*Tipp:* Alternativ können Sie Diagrammelemente selektieren, indem Sie die Liste der Elemente in der Mitte der Diagrammleiste aufklappen und darin das gewünschte Element auswählen.
Diagramme

Position und Größe von Diagrammelementen ändern

Bei machen Diagrammelementen (z.B. der Legende) lässt sich die Position und Größe ändern. Selektieren Sie das Element dazu und ziehen Sie es anschließend an die gewünschte Position. Um die Größe zu ändern, ziehen Sie an einem der Greifer, die das Element umgeben.

Eigenschaften von Diagrammelementen ändern

Sie können nicht nur, wie später im Abschnitt Eigenschaften von Diagrammen ändern beschrieben, die Eigenschaften des Diagramms an sich ändern, sondern auch die Eigenschaften einzelner Diagrammelemente bearbeiten.

Um beispielsweise die Eigenschaften der Legende eines Diagramms zu ändern, gehen Sie wie folgt vor:

1. Selektieren Sie das Diagramm per Mausklick.
2. Rechtsklick auf die Legende, um Ihr Kontextmenü aufzurufen.

   **Android:** Bei der Android-Version können Sie das Kontextmenü auch mit dem Finger öffnen: Tippen Sie dazu auf den Bildschirm und halten Sie den Finger für etwa eine Sekunde gedrückt.


Nun erscheint ein Dialog, in dem Sie die gewünschten Einstellungen vornehmen können.

**Tipp:** Alternativ können Sie diesen Dialog auch über das Symbol in der Diagrammleiste aufrufen.

**Noch schneller:** Darüber hinaus können Sie den Dialog mit einem Doppelklick auf das gewünschte Element öffnen.

Welche Eigenschaften sich in dem Dialog ändern lassen, hängt davon ab, für welche Art von Diagrammelement Sie ihn aufrufen. Bei einer Achse lässt sich beispielsweise die Skalierung der Achse einstellen, bei der Legende die Schriftart etc.

Detaillierte Informationen zu allen Diagrammelementen und ihren Eigenschaften finden Sie im Handbuch zur Tabellenkalkulation PlanMaker, Stichwort "Diagrammelemente".

Eigenschaften von Diagrammen ändern

Im vorherigen Abschnitt wurde beschrieben, wie sie die Eigenschaften einzelner Elemente eines Diagramms bearbeiten. In diesem Abschnitt geht es um die Eigenschaften des Diagramms an sich. Dazu zählen verschiedene Layoutoptionen, der Diagrammtyp, Einstellungen zu den Datenreihen etc.

Um die Eigenschaften eines Diagramms zu ändern, selektieren Sie das Diagramm per Mausklick und rufen den Menübefehl Objekt > Eigenschaften auf.

**Tipp:** Alternativ können Sie diesen Befehl auch über das Symbol in der Diagrammleiste aufrufen.
Diagramme

In dem Dialog lassen sich folgende Einstellungen vornehmen:

**Karteikarte Layout**

Auf der Karteikarte **Layout** können Sie die Außenränder des Diagramms ändern. Bei Diagrammrahmen lassen sich zusätzlich Position und Textumbruch modifizieren.

Siehe dazu Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.

**Karteikarte Format**

Auf dieser Karteikarte können Sie die Größe des Diagramms ändern.

Siehe dazu Abschnitt **Objekt-Eigenschaften, Karteikarte Format**.

**Karteikarte Eigenschaften**

Hier können Sie allgemeine Einstellungen für das Diagramm ändern.

Siehe dazu Abschnitt **Objekt-Eigenschaften, Karteikarte Eigenschaften**.

**Karteikarte Diagrammtyp**

Hier können Sie den Diagrammtyp ändern:

Wählen Sie zunächst links den gewünschten **Diagrammtyp** und dann rechts den gewünschten **Untertyp**.

Informationen zu den einzelnen Diagrammtypen finden Sie im Handbuch zur Tabellenkalkulation *PlanMaker*, Stichwort "Diagrammtyp".

**Karteikarte Datenreihen**

Die **Datenreihen** sind die wichtigsten Bestandteile eines Diagramms. Sie stellen die auszuwertenden Daten dar – je nach gewähltem Diagrammtyp in Form von Säulen, Balken, Linien etc.

Auf der Karteikarte **Datenreihen** können Sie Einstellungen zu den einzelnen Datenreihen eines Diagramms vornehmen. Hier können Sie auch die Zahlenwerte eintragen und abändern, die in dem Diagramm dargestellt werden sollen (über die Schaltfläche **Bearbeiten**).

Wählen Sie zunächst in der Liste **Datenreihen** die Datenreihe aus, die Sie modifizieren möchten. Nehmen Sie dann die gewünschten Einstellungen vor:

- **Datenreihen**

  In der Liste **Datenreihen** sind alle Datenreihen aufgelistet, die das Diagramm momentan enthält.

  Mit Hilfe der Pfeil-Schaltflächen rechts der Liste können Sie die Reihenfolge der Datenreihen bei Bedarf ändern.

  Mit den Schaltflächen **Hinzufügen** und **Löschen** können Sie Datenreihen hinzufügen beziehungsweise entfernen.

  Die Schaltfläche **Bearbeiten** lässt Sie die Zahlenwerte für die gewählte Datenreihe editieren. Siehe dazu auch Abschnitt **Daten eines Diagramms eingeben/bearbeiten**.
Rubrik Datenquellen
Hier lässt sich festlegen, welche Daten die gewählte Datenreihe darstellen soll.

Die Felder in dieser Rubrik werden automatisch ausgefüllt. Normalerweise müssen Sie sich um diese Einstellungen also überhaupt nicht kümmern.

**Hinweis:** Bearbeiten Sie die Felder in dieser Rubrik nicht von Hand, sondern verwenden Sie dazu die Schaltfläche Bearbeiten (unter der Liste Datenreihen). Damit können Sie diese bequem dialoggesteuert ausfüllen. Weitere Informationen zu diesem Dialog finden Sie im Abschnitt Daten eines Diagramms eingeben/bearbeiten.

Folgende Felder gibt es hier:

**Name:** Der Name der Datenreihe. Dieses Feld kann auch leer gelassen werden, worauf die Datenreihe einen automatisch erzeugten Namen erhält (z.B. "Reihe 1", "Reihe 2" etc.).

**Y-Werte:** Die Y-Werte für die einzelnen Datenpunkte der Datenreihe. Verwenden Sie zum Bearbeiten dieser Werte am besten die Schaltfläche Bearbeiten (unter der Liste Datenreihen).

Erläuterung: Bei den meisten Diagrammtypen sind die Y-Werte die Werte, die in dem Diagramm dargestellt werden sollen. Sie bestimmen also beispielsweise die Höhe der Säule, die gezeichnet wird.

**X-Werte:** Die X-Werte für die Datenreihe. Verwenden Sie zum Bearbeiten dieser Werte ebenfalls die Schaltfläche Bearbeiten (unter der Liste Datenreihen).

Erläuterung: Bei den meisten Diagrammtypen sind die X-Werte irrelevant und auf "Auto" (also automatisch) gesetzt, da sie lediglich zur Beschriftung der Rubrikenachse (X-Achse) dienen. Eine Ausnahme hiervon bilden z.B. XY-Punktgramme und Blasendiagramme: hier bestimmen die X- und Y-Werte die Koordinaten der Datenpunkte.

**Blasengrößen:** Bei Blasendiagrammen gibt es neben X- und Y-Werten noch einen dritten Parameter: die Größe der Blasen für die einzelnen Datenpunkte. Auch hier sollten Sie zum Bearbeiten der Werte die Schaltfläche Bearbeiten verwenden.

Rubrik Diese Datenreihe darstellen als
Hier können Sie festlegen, wie die Datenreihe dargestellt werden soll. Haben Sie als Diagrammtyp beispielsweise ein Säulendiagramm gewählt, möchten aber, dass eine bestimmte Datenreihe darin als Linendiagramm dargestellt wird, so wählen Sie für diese Datenreihe die Option Linien.

**Sekundäre Achse für diese Datenreihe**
Aktivieren Sie diese Option, wird dem Diagramm für diese Datenreihe eine sekundäre Größenachse (Y-Achse) hinzugefügt. Die sekundäre Größenachse kann einen anderen Maßstab als die primäre Größenachse haben.

Erläuterung: Das Darstellen von bestimmten Datenreihen auf einer sekundären Achse ist sinnvoll, wenn diese Datenreihen eine Achse mit einem völlig anderen Maßstab benötigen, da sie beispielsweise erheblich größere Werte enthalten als die anderen Datenreihen.

Karteikarte Elemente
Auf der Karteikarte **Elemente** können Sie die verschiedenen Diagrammelemente ein-/ausblenden und beschreiben:

**Diagrammtitel**
Hier können Sie dem Diagramm einen Titel geben. Dieser wird dann oberhalb des Diagramms angezeigt.
Rubrik **Primäre Achsen**

Hier können Sie Einstellungen zu den primären Achsen vornehmen:

Mit dem Kontrollkästchen vor der jeweiligen Achse können Sie die Anzeige dieser Achse ein-/ausschalten.

Rechts daneben können Sie der Achse einen Namen geben. Dieser wird unterhalb/neben der Achse angezeigt.

Die Optionen **Hauptgitternetz** und **Hilfsgitternetz** bestimmen, ob Gitternetzlinien im Hintergrund des Diagramms angezeigt werden sollen. Diese erleichtern das Ablesen der Werte.

Rubrik **Sekundäre Achsen**

Sofern das Diagramm über sekundäre Achsen verfügt, können Sie diese hier, analog zu den primären Achsen (siehe oben), konfigurieren.

Legende

Hier können Sie die Position der Legende bestimmen. Dies ist ein kleiner Kasten, in dem angezeigt wird, welche Datenreihe in welcher Farbe/Musterung dargestellt wird.

**Karteikarte 3D-Ansicht**

*Hinweis:* Diese Karteikarte erscheint nur bei dreidimensionalen Diagrammtypen.

Auf der Karteikarte **3D-Ansicht** können Sie (bei dreidimensionalen Diagrammtypen) den 3D-Effekt für das Diagramm verändern.

- **Drehwinkel** und **Betrachtungswinkel**

  Hier können Sie den Blickwinkel (in Grad) einstellen, von dem aus der Betrachter das Diagramm sieht. **Drehwinkel** dreht den Betrachter um die vertikale Achse, **Betrachtungswinkel** um die horizontale Achse.

- **Perspektive**

  Ist diese Option aktiviert, wird das Diagramm perspektivisch verzerrt. Daneben können Sie die Stärke der Verzerrung angeben (von 0 bis 100%).

- **Höhe** und **Tiefe**

  Hier können Sie die Höhe und Tiefe des Diagramms (in Prozent der Originalmaße) ändern.

**Karteikarte Netz**

*Hinweis:* Diese Karteikarte erscheint nur bei Netzdiagrammen.

Auf der Karteikarte **Netz** können Sie (bei Netzdiagrammen) zusätzliche Einstellungen zur Darstellung des Diagramms vornehmen.

- **Startwinkel**

  Rotiert das Diagramm um den angegebenen Winkel.

- **Orientierung**

  Bestimmt, ob die Werte im Uhrzeigersinn oder gegen den Uhrzeigersinn eingezeichnet werden sollen.
Diagramme

- **Netz abrunden**
  Zeichnet das Diagramm nicht mit Linien sondern mit Kreissegmenten zwischen den Achsen.

- **Polarkoordinaten**

  Setzen Sie dabei den **Winkel zwischen Achsen** auf $x$, wird alle $x$ Grad eine Achse eingezeichnet.

  Setzen Sie den **Winkel zwischen Achsenbeschriftungen** auf $x$, wird alle $x$ Grad eine Achsenbeschriftung eingezeichnet.

- **Zeichnungsfläche auf Netzform begrenzen**
  Ist diese Option aktiviert, wird nur die Fläche *innerhalb* des Netzes mit der Füllung der Zeichnungsfläche gefüllt. Ist sie deaktiviert, wird das gesamte Rechteck um das Netz herum gefüllt.

---

**Diagramme als Grafik speichern**

Sie können jederzeit ein Abbild eines Diagramms als Grafikdatei speichern. Dies erleichtert die Weitergabe an andere und das Einfügen in Webseiten oder andere Dokumente.

Gehen Sie dazu wie folgt vor:

1. Selektieren Sie das gewünschte Diagramm per Mausklick.
2. Rufen Sie den Menübefehl **Objekt > Diagramm > Als Grafik speichern** auf.
3. Wählen Sie in der Liste **Dateityp** das gewünschte Grafikformat.

   **Tipp:** Das **PNG-Format** ist hier immer eine gute Wahl, da es eine gute und dabei völlig verlustfreie Komprimierung bietet.

4. Geben Sie den Dateinamen an, unter dem die Grafik gespeichert werden soll, und bestätigen Sie mit **OK**.
5. Es erscheint ein weiterer Dialog. Wählen Sie darin die gewünschte Auflösung für die Grafik oder tragen Sie eigene Werte für die Breite und Höhe von Hand ein. Bestätigen Sie dann mit **OK**.

TextMaker legt nun eine entsprechende Grafikdatei mit einem Abbild des Diagramms an.
## OLE-Objekte

**Hinweis:** Die Verwendung von OLE-Objekten ist nur mit der Windows-Version von TextMaker möglich.

Bei TextMaker für Windows können Sie in Ihre Dokumente Objekte (Zeichnungen, Grafiken etc.) einbetten, die mit einer anderen Applikation erzeugt wurden.


Vorteil: Sie müssen auf die Zeichnung im TextMaker-Dokument nur einen Doppelklick ausführen – schon wird *Paint* automatisch erneut gestartet. Wenn Sie die Zeichnung darin nun bearbeiten und *Paint* wieder beenden, werden die Änderungen auch von TextMaker übernommen.

Damit dies funktioniert, muss die aufzurufende Applikation OLE unterstützen. OLE steht für "Object Linking and Embedding" ("Verknüpfen und Einbetten von Objekten"). Das Objekt, das von der anderen Applikation zu TextMaker gereicht wird, nennt man ein OLE-Objekt.

In diesem Kapitel erfahren Sie alles Wissenswerte zum Arbeiten mit OLE-Objekten. Folgende Themen werden darin behandelt:

- OLE-Objekte einfügen
- OLE-Objekte bearbeiten
- Verknüpfungen von OLE-Objekten bearbeiten
- Position und Größe von OLE-Objekten ändern
- Eigenschaften von OLE-Objekten ändern
- Verwendung des SoftMaker Formeleditors

Lesen Sie dazu die nächsten Seiten.

### OLE-Objekte einfügen

**Hinweis:** Die Verwendung von OLE-Objekten ist nur mit der Windows-Version von TextMaker möglich.

Mit dem Menübefehl **Objekt > Neues OLE-Objekt** können Sie ein OLE-Objekt in das Dokument einbetten.

OLE-Objekte


Im Einzelnen gehen Sie zum Einfügen eines OLE-Objekts in ein Dokument wie folgt vor:

1. Setzen Sie die Schreibmarke an die Stelle im Dokument, an der das Objekt eingebettet werden soll.
2. Rufen Sie den Menübefehl **Objekt > Neues OLE-Objekt** auf.
3. Es erscheint ein Dialogfenster. Wählen Sie darin aus der Liste **Objekttyp** die Quellanwendung aus, von der TextMaker das OLE-Objekt erhalten soll.
4. Bestätigen Sie mit **OK**, worauf die zum gewählten Objekttyp gehörende Anwendung gestartet wird.
5. Erstellen Sie das Objekt in der Anwendung.
7. Die Anwendung fragt nun möglicherweise nach, ob Sie das Objekt im TextMaker-Dokument aktualisieren möchten. Bestätigen Sie dies mit "Ja".

Das in der anderen Anwendung erstellte OLE-Objekt ist nun in das TextMaker-Dokument eingebettet.

**OLE-Objektrahmen:** Ein in den Text eingefügtes OLE-Objekt wird von TextMaker so behandelt, als ob es ein Buchstabe inmitten des Textes wäre. Es ist also in den Textfluss eingebunden. Alternativ lassen sich OLE-Objekte auch als fest auf der Seite positionierter **OLE-Objektrahmen** einfügen. Informationen dazu finden Sie im Abschnitt **OLE-Objektrahmen**.

**OLE-Objekte aus einer Datei erstellen**

Möchten Sie kein neues OLE-Objekt erstellen, sondern ein bereits vorhandenes Dokument einer anderen Anwendung als OLE-Objekt einbetten, rufen Sie ebenfalls den Menübefehl **Objekt > Neues OLE-Objekt** auf, wählen im Dialogfenster jedoch die Option **Aus Datei erstellen**.

Das Aussehen des Dialogs ändert sich: Statt der Liste **Objekttyp** finden Sie nunmehr das Eingabefeld **Datei** vor. Geben Sie hier den kompletten Dateinamen an oder klicken Sie auf die Schaltfläche **Durchsuchen**, um ein Dialogfenster zu erhalten, mit dem Sie Ihre Festplatte nach dem Dokument durchforsten können.

Bestimmen Sie eine Datei und bestätigen Sie mit **OK**, wird diese als OLE-Objekt eingefügt.


**Verknüpfung mit der Originaldatei herstellen**

Im oben beschriebenen Dialogfenster können Sie zusätzlich auswählen, ob die einfügende Datei **eingebettet** oder **verknüpft** werden soll. Lassen Sie die Option **Verknüpfen** ausgeschaltet, fügt TextMaker eine Kopie der Datei als OLE-Objekt ein und speichert diese im Dokument – das OLE-Objekt wird also wie gewohnt eingebettet.

Schalten Sie hingegen die Option **Verknüpfen** ein, stellt TextMaker eine Verknüpfung mit der Originaldatei für das OLE-Objekt her. Von der Bedienung her ändert sich dadurch nichts. Ändern Sie jedoch später die Originaldatei des OLE-Objekts mit einem anderen Programm und öffnen das TextMaker-Dokument er-
neut, hat sich auch das OLE-Objekt entsprechend geändert – das OLE-Objekt ist also mit der Originaldatei verknüpft.

## OLE-Objekte bearbeiten

 Folgendermaßen bearbeiten Sie vorhandene OLE-Objekte:

* **Tipp:** Um ein OLE-Objekt zu editieren, führen Sie einfach einen Doppelklick auf das OLE-Objekt durch. Es wird sofort in der zugehörigen Applikation geöffnet und kann darin bearbeitet werden.

 Alternativ können Sie auch das Menü verwenden, um ein OLE-Objekt zu editieren. Gehen Sie folgendermaßen vor:

1. Klicken Sie das OLE-Objekt an, um es zu selektieren.


3. Die zu dem OLE-Objekt gehörende Quellanwendung wird nun gestartet. Nehmen Sie die gewünschten Änderungen vor.

Um wieder zu TextMaker zurückzukehren, beenden Sie die Quellanwendung einfach. Beim Beenden mancher Quellanwendungen wird dabei nachgefragt, ob Sie das Objekt im TextMaker-Dokument aktualisieren möchten. Antworten Sie mit "Ja" – andernfalls werden Ihre Änderungen verworfen.

## Verknüpfungen von OLE-Objekten bearbeiten

Haben Sie ein OLE-Objekt aus einer Datei erstellt und dabei die Option **Verknüpfung** aktiviert, können Sie diese Verknüpfung zu der Quelldatei mit dem Menübefehl **Bearbeiten > Verknüpfungen** bearbeiten.

Rufen Sie diesen Befehl dazu auf. Es erscheint ein Dialogfenster, in dem alle im aktuellen Dokument vorhandenen Verknüpfungen aufgelistet sind. Wenn Sie eine Verknüpfung selektieren, wird im unteren Teil des Dialogfensters Dateiname und Typ der zugehörigen Quelldatei angezeigt.

Mit den Schaltflächen des Dialogfensters lassen sich folgende Aktionen ausführen:

<table>
<thead>
<tr>
<th>Schaltfläche</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jetzt aktualisieren</td>
<td>Aktualisiert das OLE-Objekt. Verwenden Sie diese Schaltfläche, falls die Quelldatei von einem anderen Programm verändert wurde und die Änderungen im TextMaker-Dokument nicht sichtbar werden.</td>
</tr>
<tr>
<td>Quelle ändern</td>
<td>Lässt Sie eine andere Datei als Quelle für das OLE-Objekt auswählen.</td>
</tr>
</tbody>
</table>
Verknüpfung lösen  Trennt die Verbindung zur Quelldatei. Das Objekt ist anschließend fest in das TextMaker-Dokument eingebettet. Änderungen an der Quelldatei wirken sich nicht mehr aus. Das Objekt lässt sich aber nach wie vor per Doppelklick bearbeiten.

Position und Größe von OLE-Objekten ändern

Die **Position** eines OLE-Objekts können Sie wie folgt ändern:

- **Ausschneiden und an anderer Stelle einfügen**
  
  Das Verschieben eines eingebetteten OLE-Objekts funktioniert genau wie das Verschieben von Text: Markieren Sie das Objekt und schneiden Sie es mit dem Menübefehl **Bearbeiten > Ausschneiden** aus. Dann setzen Sie die Schreibmarke an die Zielstelle und fügen das Objekt dort mit dem Menübefehl **Bearbeiten > Einfügen** wieder ein.

- **Mit der Maus verschieben**
  
  Alternativ können Sie eingebettete OLE-Objekte auch mit der Maus verschieben: Selektieren Sie das Objekt dazu mit einem (einfachen!) Mausklick und ziehen Sie es dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.

Die **Größe** eines OLE-Objekts lässt sich mit folgenden Methoden ändern:

- **Ziehen an den Greifern auf dem Selektionsrahmen**
  
  Selektieren Sie das Objekt mit einem Mausklick. Es erscheint daraufhin ein blauer Selektionsrahmen um das Objekt, der auch einige runde "Greifer" enthält. Wenn Sie mit der Maus an einem dieser Greifer ziehen, ändert das Objekt seine Größe entsprechend.

- **Werte von Hand festlegen**
  
  Sie können die Größe eines OLE-Objekts auch exakt in Zahlenwerten angeben. Selektieren Sie das Objekt dazu per Mausklick und rufen Sie den Menübefehl **Objekt > Eigenschaften** auf. Es erscheint daraufhin ein Dialogfenster zum Ändern der Eigenschaften des OLE-Objekts (siehe auch nächster Abschnitt). Wechseln Sie darin auf die Karteikarte **Format** und geben Sie in der Rubrik **Größe** die gewünschten Maße an.

Eigenschaften von OLE-Objekten ändern


Um die Eigenschaften eines OLE-Objekts zu bearbeiten, selektieren Sie dieses zunächst per Mausklick. Dann rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, worauf ein entsprechender Dialog erscheint.

In dem Dialog lassen sich folgende Einstellungen vornehmen:
**Karteikarten Layout, Format, Füllung etc.**

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgender Einstellungen:

- **Layout:** Auf dieser Karteikarte können Sie lediglich die Außenränder des Objekts ändern. Die anderen Optionen sind nur bei OLE-Objektrahmen verfügbar. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Layout*.
- **Format:** Hier können Sie die Größe des Objekts ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Format*.
- **Füllung:** Hier können Sie die Füllung ändern. Diese Funktion wird allerdings nicht von allen OLE-Anwendungen unterstützt. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Füllung*.
- **Linien:** Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Linien*.
- **Schatten:** Hier können Sie einen Schatten anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Schatten*.
- **Effekte:** Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Effekte*.
- **Eigenschaften:** Hier können Sie allgemeine Einstellungen ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Eigenschaften*.

Weiterhin erscheint bei OLE-Objekten eine zusätzliche Karteikarte mit weiteren Optionen:

**Karteikarte Grafik**

Auf der Karteikarte Grafik können Sie Einstellungen zur grafischen Darstellung des Objekts vornehmen.

*Hinweis:* Abhängig vom Typ des OLE-Objekts sind manche dieser Optionen möglicherweise ohne Funktion.

Verfügbare Optionen:

- **Varianten**
  
  In dieser Liste werden einige vorgefertigte Variationen angeboten – zum Beispiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, bei denen das Objekt eingefärbt wurde.
  
  Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog werden dann automatisch auf entsprechende Einstellungen gesetzt.

- **Rubrik Optionen**
  
  Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alternative Möglichkeit zum Ändern der Helligkeit) ändern.

- **Schaltfläche Weiteres**
  
  Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen:
  
  Wenn Sie die Option **Einfärben** aktivieren und darunter eine Farbe auswählen, wird das Objekt entsprechend eingefärbt.
Mit den Optionen in der Rubrik *Beschnitt* können Sie das Objekt zuschneiden. Dies ist nützlich, wenn Sie nur einen Ausschnitt des Objekts benötigen. Soll beispielsweise das obere Viertel des Objekts abgeschnitten werden, wählen Sie zunächst *Relative Werte verwenden* und geben Sie bei *Oben* die Zahl "25" (Prozent) ein.

Wählen Sie *Absolute Werte verwenden* aus, werden die Eingaben nicht prozentual, sondern in absoluten Längeneinheiten abgeschnitten. Wenn Sie negative Werte eingeben, werden die Bereiche des Objekts nicht abgeschnitten, sondern es wird mit einem Rahmen erweitert.

- **Schaltfläche Exportieren**

  Mit dieser Schaltfläche können Sie eine Kopie der grafischen Repräsentation des Objekts exportieren, also ein Abbild des Objekts unter einem beliebigen Namen auf Festplatte speichern.

---

**Verwendung des SoftMaker Formeleditors**


Dazu gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke an die gewünschte Position im Dokument.
5. Erstellen Sie die gewünschte Formel.
6. Wenn die Formel fertiggestellt ist, beenden Sie den Formeleditor einfach.


Mit dem Menübefehl *Objekt > Eigenschaften* können Sie weiterhin die Eigenschaften des Formeleditor-Objekts ändern, nachdem Sie es mit einem (einfachen!) Mausklick selektiert haben.

**Informationen vom Hersteller des Formeleditors**

Der SoftMaker Formeleditor ist eine spezielle Version des Programms *MathType* der Firma *Design Science*. Falls Sie häufig Formeln in Ihren Dokumenten verwenden, werden Sie in MathType eine Lösung finden, die Ihren Ansprüchen noch besser genügt. MathType ist genauso einfach zu bedienen wie der SoftMaker Formeleditor, hat jedoch zahlreiche zusätzliche Funktionen, die Ihnen helfen, produktiver zu sein und anspruchsvollere Formeln zu gestalten.

MathType ist in Deutsch, Englisch und anderen Sprachen erhältlich. Informationen über den Bezug von MathType erhalten Sie bei Ihrem Softwarehändler oder direkt bei Design Science.
Rahmen und Zeichnungen


Der Unterschied:

Rahmen werden standardmäßig fest auf der Seite positioniert. Natürlich können Sie einen Rahmen jederzeit verschieben; ansonsten behält dieser aber seine feste Position auf der Seite. Wenn Sie oberhalb eines Rahmens Text eingeben oder löschen, verschiebt sich der Rahmen dadurch nicht.

Rahmen sind also in allen Dokumenten praktisch, in denen beispielsweise ein Textkasten oder eine Grafik immer an einer bestimmten Position auf der Seite verbleiben soll.

Ein Rahmen darf übrigens ohne weiteres bestehenden Fließtext überdecken. Der Text wird dann automatisch so neu umbrochen, dass er den Rahmen "umfließt".

In diesem Kapitel erfahren Sie alles Wissenswerte zum Umgang mit Rahmen und Zeichnungen. Es ist in folgende Abschnitte gegliedert:

- **Rahmen – Allgemeines**
  
  Hier lernen Sie grundlegende Funktionen wie das Einfügen, Selektieren und Bearbeiten von Rahmen und anderen Objekten kennen.

- **Rahmen – Fortgeschrittene Funktionen**
  
  Dieser Abschnitt richtet sich an fortgeschrittene Anwender. Sie erfahren darin, wie man Rahmen verbirgt, gruppiert etc.

Im Anschluss stellen wir Ihnen die einzelnen Arten von Rahmen im Detail vor:
Die Termineinheiten enthalten einen Textkasten mit Text.

Grafikrahmen enthalten eine Grafik.

OLE-Objektrahmen enthalten ein OLE-Objekt.

Zeichnungen sind Rahmen, die Zeichnungsobjekte wie zum Beispiel Linien, Rechtecke oder andere Formen enthalten.

**Rahmen – Allgemeines**

In diesem Abschnitt finden Sie grundlegende Informationen zum Arbeiten mit Rahmen, Zeichnungen und anderen Objekten:

- Rahmen einfügen
- Selektieren von Objekten
- Der Objektmodus
- Position, Größe und Ränder von Objekten ändern
- Rotieren und Kippen von Objekten
- Ausrichten und Verteilen von Rahmen
- Duplizieren von Objekten
- Eigenschaften von Objekten ändern

Anschließend (im Abschnitt **Rahmen – Fortgeschrittene Funktionen**) werden Funktionen für fortgeschrittene Anwender vorgestellt.

**Rahmen einfügen**

Wie Sie in der Einleitung dieses Kapitels erfahren haben, können Grafiken und andere Objekte nicht nur direkt in den Fließtext, sondern auch in Form von Rahmen eingefügt werden. Neben Grafiken können Sie also beispielsweise auch Grafikrahmen verwenden.

Der Unterschied:

Ein Rahmen wird *fest auf der Seite positioniert*. Solange Sie ihn nicht selbst verschieben, behält er stets seine feste Position auf der Seite. Auch wenn Sie oberhalb eines Rahmens Text eingeben oder löschen, verschiebt er sich dadurch nicht.

Um beispielsweise einen Grafikrahmen einzufügen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Objekt > Neuer Grafikrahmen** auf.
2. Es erscheint ein Dialog. Wählen Sie darin die gewünschte Grafikdatei aus und bestätigen Sie mit **OK**.
3. Der Grafikrahmen wird nun eingefügt.
Wenn Sie möchten, können Sie den Grafikrahmen anschließend noch verschieben oder seine Größe ändern:

Zum Verschieben klicken Sie mit der Maus auf den Grafikrahmen und ziehen ihn dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die den Grafikrahmen umgeben.

Auf ähnliche Weise verfahren Sie auch bei allen anderen Arten von Rahmen.

Ausführliche Informationen zu den einzelnen Arten von Rahmen finden Sie in den Abschnitten Textrahmen, Grafikrahmen etc.

---

**Selektieren von Objekten**

Wenn Sie ein Objekt bearbeiten möchten, müssen Sie es erst auswählen, sprich *selektieren*. Bei den meisten Arten von Objekten genügt es, das Objekt dazu einfach mit der Maus anzuklicken. Es erscheint dann ein Rahmen um das Objekt, um anzuzeigen, dass es selektiert ist.

*Hinweis:* Dies funktioniert allerdings nicht bei Textfeldern, Textrahmen und anderen Objekten mit transparenter Füllung. Um ein solches Objekt zu selektieren, klicken Sie auf dessen Umrandung (sofern vorhanden) oder wechseln in den *Objektmodus* (siehe nächster Abschnitt), in dem sich alle Arten von Objekten einfach per Mausklick selektieren lassen.

Wenn ein Objekt selektiert wurde, können Sie den normalen Text nicht mehr verändern, sondern nur noch das selektierte Objekt bearbeiten. Möchten Sie wieder am Text weiterarbeiten, klicken Sie einfach mit der Maus an die gewünschte Textstelle. Die Selektion des Objekts wird dadurch aufgehoben.

---

**Der Objektmodus**

Am einfachsten gestaltet sich das Arbeiten mit Rahmen, Zeichnungen und allen anderen Objekten im *Objektmodus*.

Normalerweise arbeiten Sie mit TextMaker im *Editiermodus*. In diesem Modus können Sie Text eingeben, bearbeiten, formatieren usw.

Schalten Sie in den *Objektmodus* um, können Sie den Text nicht mehr bearbeiten. Dafür bietet dieser Modus viele Funktionen, die das Arbeiten mit Objekten erleichtern. So können Sie im Objektmodus beispielsweise *alle* Arten von Objekten einfach per Mausklick selektieren.

*Hinweis:* Solange Sie sich im Objektmodus befinden, stehen Ihnen ausschließlich Funktionen zum Anlegen und Bearbeiten von Objekten zur Verfügung. Sie können keinen Text mehr eingeben, und ein Großteil der Menübefehle ist nicht verfügbar.

---

**Wechseln zwischen Editiermodus und Objektmodus**

Es gibt zahlreiche Möglichkeiten, um zwischen Editiermodus und Objektmodus zu wechseln:
Rahmen und Zeichnungen

- Rufen Sie den Menübefehl **Ansicht > Objektmodus** auf, um in den Objektmodus zu gelangen. Rufen Sie den Befehl noch einmal auf, um wieder im Editiermodus zu landen.

- Klicken Sie das Symbol ☐ in der Formatleiste an, um in den Objektmodus zu wechseln. Klicken Sie es erneut an, gelangen Sie zurück in den Editiermodus.

- Sie können auch mit der **rechten** Maustaste auf eine beliebige Position im Dokument klicken. Es öffnet sich dann ein Kontextmenü, aus dem Sie den Befehl **Objektmodus** beziehungsweise **Objektmodus verlassen** auswählen.

- Am schnellsten geht folgende Methode: Zeigen Sie mit der Maus auf eine beliebige freie Position im Dokument und führen Sie einen Doppelklick mit der **rechten** Maustaste durch, um zwischen Editier- und Objektmodus zu wechseln.

- Außerdem können Sie vom Objektmodus jederzeit in den Editiermodus zurückkehren, indem Sie auf eine beliebige Stelle im Text doppelklicken, an der sich kein Objekt befindet.

**Die Objektleiste**

Wenn Sie den Objektmodus aktivieren, wird die Formatleiste ausgeblendet. An ihrer Stelle erscheint die **Objektleiste**.

Die Symbole in dieser Leiste dienen zum Anlegen und Bearbeiten von Objekten. Von links nach rechts:

- Zwischen Objektmodus und Editiermodus wechseln
- Textrahmen einfügen
- Grafikrahmen einfügen
- Diagrammrahmen einfügen
- OLE-Objektrahmen einfügen (nur unter Windows verfügbar)
- OLE-Objektrahmen mit dem SoftMaker Formeleditor* einfügen
- OLE-Objektrahmen mit einem PlanMaker-Objekt einfügen
- OLE-Objektrahmen mit einem PlanMaker-Diagramm-Objekt einfügen
- OLE-Objektrahmen mit einem Presentations-Objekt einfügen
- Linie oder Kurve einfügen
- Rechteck einfügen
- Rechteck mit abgerundeten Ecken einfügen
- Ellipse oder Kreis einfügen
- AutoForm einfügen
- TextArt-Objekt einfügen
- Objekte gruppieren
- Textrahmen miteinander verbinden
- Eigenschaften des selektierten Objekts bearbeiten
- Objektliste (eine Liste aller Objekte im Dokument, siehe unten)

* Nicht in allen Versionen von TextMaker enthalten

**Tipp:** Wenn Sie den Mauszeiger auf eines dieser Symbole bewegen, wird dessen Funktion in der Statuszeile angezeigt.

**Objektliste:** Ganz rechts in der Leiste sehen Sie die **Objektliste**. In dieser sind alle im aktuellen Dokument enthaltenen Objekte aufgelistet. Sie können darin ein Objekt anhand seines Namens auswählen: Klicken Sie auf die Liste, um sie zu öffnen, und wählen Sie dann das gewünschte Objekt per Mausklick. Dieses wird daraufhin selektiert.
Rahmen und Zeichnungen

Warum Objekte einen Namen haben und wie Sie diesen ändern, können Sie im Abschnitt "Namen von Objekten ändern" nachlesen.

Selektieren im Objektmodus

Im Objektmodus können Sie alle Arten von Objekten einfach per Mausklick selektieren.

Dies ist besonders bei Objekten mit transparenter Füllung (z.B. Textrahmen) sehr praktisch, da sich derartige Objekte im Editiermodus nur durch einen gezielten Mausklick auf den Rand des Objekts selektieren lassen. Im Objektmodus können Sie solche Objekte hingegen einfach an einer beliebigen Stelle anklicken, um sie zu selektieren.

Bei Rahmen und Zeichnungen können Sie auch mehrere Objekte auf einmal selektieren. Ziehen Sie dazu mit der Maus einen Rahmen um die gewünschten Objekte. Alternativ können Sie auch bei gedrückter Umschalttaste mehrere Objekte nacheinander anklicken, um diese zu selektieren.

Position, Größe und Ränder von Objekten ändern

Auf den nächsten Seiten erfahren Sie, wie Sie Position, Größe und Außenränder von Objekten ändern können.

Position von Objekten ändern

Objekte können nach Belieben verschoben werden. Selektieren Sie das Objekt einfach per Mausklick und gehen Sie dann wie folgt vor:

- **Mit der Maus:** Ziehen Sie das selektierte Objekt bei gedrückter Maustaste an die gewünschte Stelle.
- **Mit der Tastatur:** Bei Rahmen und Zeichnungen können Sie alternativ auch die Richtungstasten verwenden, um das momentan selektierte Objekt zu verschieben.
- **Per Dialog:** Bei Rahmen und Zeichnungen können Sie außerdem den Menübefehl **Objekt > Eigenschaften** aufrufen und auf die Karteikarte **Layout** wechseln. Dort lässt sich die genaue Position per Dialog genau festlegen.

  **Tipp:** Auf dieser Karteikarte stehen auch einige erweiterte Optionen zur Verfügung: So können Sie die Position von Rahmen beispielsweise relativ zum Seitenrand festlegen. Siehe dazu Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.

**Hinweis: Der "Anker" eines Objekts bestimmt, auf welcher Seite es angezeigt wird**

Anmerkung: Nachfolgendes betrifft nur Rahmen und Zeichnungen.

Wenn Sie einen Rahmen oder eine Zeichnung einfügen, werden Sie feststellen, dass anschließend links neben dem Absatz unter diesem Objekt ein *Anker* angezeigt wird:
Rahmen und Zeichnungen

Links oben ist der Anker des selektierten Objekts zu sehen.

Der Anker eines Objekts bestimmt, auf welcher Seite dieses Objekt angezeigt wird. Genauer gesagt:

**Wichtig:** Rahmen und Zeichnungen, die mit einem Absatz verankert sind, erscheinen stets auf der Seite, auf der sich dieser Absatz befindet.

Fügen Sie also vor diesem Absatz so viel Text ein, dass dieser auf der nächsten Seite landet, wandert auch das verankerte Objekt mit auf die nächste Seite.

Der Anker eines Objekts kann jederzeit verschoben werden. Selektieren Sie das Objekt dazu und ziehen Sie den Anker dann bei gedrückter Maustaste zu einem anderen Absatz.

**Anker fest auf eine bestimmte Seite setzen**

Sie können das oben beschriebene Verhalten für ein Objekt auch abschalten, so dass dieses Objekt immer auf einer bestimmten Seite verbleibt:

Selektieren Sie das Objekt dazu, rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, wechseln Sie auf die Karteikarte **Layout**, setzen Sie die Option **Objekt** auf **Fest auf Seite**. Tragen Sie dann die Seitennummer der Seite ein, auf der das Objekt erscheinen soll.

Das Objekt ist nun nicht mehr mit einem Absatz verankert, sondern bleibt stets auf der angegebenen Seite. Wenn Sie das Objekt selektieren, erscheint deshalb auch kein Anker mehr links von einem Absatz, sondern es wird ein Anker in der linken oberen Seitenzecke angezeigt. Dieser ist nicht verschiebbar.

Informationen, was die weiteren Optionen zu Ankern in diesem Dialog bedeuten, finden Sie im Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.

**Größe und Ränder von Objekten ändern**

Folgendermaßen ändern Sie die Größe und Ränder von Objekten:

- Klicken Sie das Objekt an, um es zu selektieren. Es erscheint daraufhin ein blauer Selektionsrahmen um das Objekt, der auch einige runde "Greifer" enthält. Wenn Sie mit der Maus an einem dieser Greifer ziehen, ändert das Objekt seine Größe entsprechend.
- Bei Rahmen und Zeichnungen können außerdem die **Außenränder** geändert werden:
Rahmen und Zeichnungen

Die inneren Linien des Selektionsrahmens repräsentieren die Größe des Objekts.

Die äußeren (gestrichelten) Linien hingegen stehen für dessen Außenränder. Ziehen Sie an einer dieser Linien, wird der entsprechende Außenrand vergrößert oder verkleinert.

Änderungen an Position und Größe verhindern

Indem Sie ein Objekt sperren, können Sie verhindern, dass sich seine Position oder Größe mit der Maus oder den Richtungstasten auf der Tastatur verändern lässt.

Selektieren Sie das Objekt dazu, rufen Sie den Menübefehl **Objekt > Eigenschaften** auf und schalten Sie auf der Karteikarte **Eigenschaften** die Option **Sperren** ein.


Schalten Sie die Option **Sperren** wieder aus, lassen sich die Position und Größe des Objekts auch wieder mit der Maus ändern.

Rotieren und Kippen von Objekten

**Hinweis:** Nur Zeichnungen und Grafiken lassen sich rotieren und kippen; bei anderen Arten von Objekten ist dies nicht möglich.

Wenn Sie ein Objekt selektieren, das sich drehen lässt, erscheint ein zusätzlicher grüner Greifer auf einer seiner Begrenzungslinien. Ziehen Sie mit der Maus an diesem Greifer, wird das Objekt rotiert.
Alternativ können Sie den gewünschten Drehwinkel auch von Hand festlegen. Selektieren Sie das Objekt dazu, rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, wechseln Sie auf die Karteikarte **Format** und tragen Sie in der Rubrik **Drehung** den Winkel ein.

Darüber hinaus können Sie Zeichnungen und Grafiken auch über den Menübefehl **Objekt > Drehen oder Kippen** drehen und kippen (spiegeln).

---

**Ausrichten und Verteilen von Rahmen**

*Hinweis:* Nur **Rahmen** und **Zeichnungen** lassen sich ausrichten und verteilen; bei in den Text eingebetteten Objekten ist dies nicht möglich.

Um zwei oder mehr Rahmen/Zeichnungen auszurichten oder gleichmäßig zu verteilen, selektieren Sie diese und rufen dann den Menübefehl **Objekt > Ausrichten oder verteilen** auf.

Es erscheint ein Untermenü, aus dem Sie die gewünschte Ausrichtung beziehungsweise Verteilung auswählen können:

- Linksbündig ausrichten
- Horizontal zentrieren
- Rechtsbündig ausrichten
- Oben ausrichten
- Vertikal zentrieren
- Unten ausrichten
- Horizontal verteilen
- Vertikal verteilen

Die letzten beiden Befehle funktionieren nur, wenn mindestens drei Objekte selektiert sind. Sie sorgen dafür, dass die Objekte gleichmäßig verteilt werden (so dass anschließend alle den gleichen Abstand voneinander haben).

---

**Duplizieren von Objekten**

Um eine Kopie eines Objekts zu erhalten, kopieren Sie dieses üblicherweise in die Zwischenablage und fügen es von dort aus wieder ein.

Alternativ können Sie auch den Menübefehl **Bearbeiten > Duplizieren** verwenden. Dieser erstellt sofort eine Kopie des selektierten Objekts.
Tipp: Noch schneller geht das Duplizieren mit der Maus: Wenn Sie die Taste Strg gedrückt halten und mit der Maus an einem Objekt ziehen, erhalten Sie ein Duplikat von diesem Objekt. Dies funktioniert allerdings nur bei Rahmen und Zeichnungen.

**Eigenschaften von Objekten ändern**

Zu den Eigenschaften eines Objekts zählt man beispielsweise dessen Größe, Ränder, etc. Diese lassen sich zentral mit dem Menübefehl Objekt > Eigenschaften bearbeiten.

Um die Eigenschaften eines Objekts zu ändern, selektieren Sie dieses zunächst per Mausklick. Dann rufen Sie den Menübefehl Objekt > Eigenschaften auf, worauf ein entsprechender Dialog erscheint.

Tipp: Bei den meisten Arten von Objekten können Sie diesen Dialog auch blitzschnell über einem Doppellklick auf das Objekt aufrufen.

Der Dialog verfügt über mehrere Karteikarten, zwischen denen Sie wechseln können, indem Sie oben auf einen der Karteikartenreiter klicken.

Auf den nächsten Seiten werden alle Karteikarten mit allen darin enthaltenen Optionen ausführlich beschrieben.

**Objekt-Eigenschaften, Karteikarte Layout**

Auf der Karteikarte Layout können Sie die Außenränder des Objekts einstellen. Bei Rahmen und Zeichnungen lassen sich zusätzlich Position und Textumbruch des Objekts modifizieren.

Verfügbare Optionen:

- Rubrik Horizontale Position

  Diese Optionen sind nur bei Rahmen und Zeichnungen verfügbar.

  **Hinweis:** Die Position von direkt in den Text eingefügten Objekten (z.B. Grafiken) können Sie nur ändern, indem Sie das Objekt ausschneiden und es an anderer Stelle wieder einfügen.

  Bei Rahmen und Zeichnungen hingegen können Sie hier einstellen, wo das Objekt platziert werden soll.

  Normalerweise genügt es, dazu bei der Option Abstand den gewünschten Abstand zur Blattkante einzutragen. Setzen Sie Abstand also auf 5 cm, beginnt das Objekt 5 cm rechts von der linken Blattkante.


  Im Einzelnen gibt es für die horizontale Position folgende Optionen:

  **Position:** Mit der Option Position legen Sie fest, wie das Objekt ausgerichtet werden soll:
Rahmen und Zeichnungen

**Option** | **Auswirkung**
---|---
**Links** | Objekt linksbündig ausrichten. Wenn Sie *Abstand* auf 5 cm setzen, *beginnt* das Objekt also beispielsweise 5 cm hinter der *linken* Blattkante.

**Zentriert** | Objekt zentriert ausrichten. Ist der Abstand auf 0 cm gesetzt, wird das Objekt also horizontal in der Mitte der Seite zentriert, bei einem Abstand von 5 cm wird es 5 cm rechts davon positioniert etc.

**Rechts** | Objekt rechtsbündig ausrichten. Das Objekt *endet* also beispielsweise 5 cm vor der *rechten* Blattkante.

**Innen** | Objekt linksbündig ausrichten, falls es sich auf einer rechten Seite (ungerade Seitennummer) befindet – beziehungsweise rechtsbündig ausrichten, falls es sich auf einer linken Seite befindet.*

**Außen** | Objekt rechtsbündig ausrichten, falls es sich auf einer rechten Seite (ungerade Seitennummer) befindet – beziehungsweise linksbündig ausrichten, falls es sich auf einer linken Seite befindet.*

* Diese beiden Optionen verhalten sich nur dann wie oben beschrieben, wenn mit dem Menübefehl *Format > Kapitel* die Option *Unterschiedliche linke und rechte Seiten* eingeschaltet wurde. Ansonsten betrachtet TextMaker alle Seiten als *rechte* Seiten.

**Relativ zu:** Mit der Option *Relativ zu* legen Sie fest, worauf sich der eingestellte *Abstand* beziehen soll:

<table>
<thead>
<tr>
<th>Option</th>
<th>Auswirkung</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Seite</strong></td>
<td>Der Abstand ist relativ zur Seite (genauer gesagt: zu den Blattkanten). Die Seitenränder werden dabei nicht berücksichtigt.</td>
</tr>
<tr>
<td><strong>Seitenrand</strong></td>
<td>Der Abstand ist relativ zu den Seitenrändern. Erhöhen Sie die Seitenränder, verschiebt sich auch das Objekt entsprechend.</td>
</tr>
<tr>
<td><strong>Absatz</strong></td>
<td>Der Abstand ist relativ zu der Position des Absatzes, in dem sich der Anker des Objekts befindet. Die Einzüge dieses Absatzes werden dabei nicht berücksichtigt. Landet dieser Absatz also beispielsweise bei einem zwei- spaltigen Dokument in der rechten Spalte, wird auch das Objekt entsprechend weit nach rechts verschoben.</td>
</tr>
<tr>
<td><strong>Einzug</strong></td>
<td>Wie <em>Absatz</em>, allerdings wird der Einzug des Absatzes berücksichtigt. Ist <em>Position</em> also auf <em>Links</em> gesetzt und Sie erhöhen den linken Einzug dieses Absatzes um 1 cm, wird auch das Objekt 1 cm nach rechts verschoben.</td>
</tr>
<tr>
<td><strong>Linker Rand, Rechter Rand etc.</strong></td>
<td>Hier bezieht sich <em>Abstand</em> auf den jeweiligen Seitenrand. Setzen Sie <em>Abstand</em> beispielsweise auf 0, <em>Position</em> auf <em>Links</em> und wählen hier <em>Rechter Rand</em>, beginnt das Objekt genau dort, wo der rechte Seitenrand beginnt.</td>
</tr>
</tbody>
</table>

Informationen, was *Anker* sind, können Sie bei Bedarf im Abschnitt *Position von Objekten ändern* nachlesen.

**Abstand:** Mit der Option *Abstand* können Sie schließlich den gewünschten Abstand einstellen.

Beispiel: Ist *Position* auf "Links" gesetzt, *Relativ zu* auf "Seitenrand" und *Abstand* auf 5 cm, beginnt das Objekt 5 cm hinter dem linken Seitenrand. Ist dieser Seitenrand also 2 cm groß, beginnt das Objekt bei 7 cm.

**Vertikale Position**

Diese Optionen sind nur bei Rahmen und Zeichnungen verfügbar.
Beim vertikalen Position gilt genau das Gleiche wie bei der horizontalen Position: Sie können die Standardeinstellungen verwenden und einfach bei Abstand eintragen, welchen Abstand das Objekt zur oberen Blattkante haben soll.

Alternativ können Sie erweiterte Optionen zum Festlegen der Position verwenden:

**Position:** Mit der Option Position legen Sie fest, wie das Objekt ausgerichtet werden soll:

<table>
<thead>
<tr>
<th>Option</th>
<th>Auswirkung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oben</td>
<td>Objekt oben ausrichten. Das Objekt beginnt also beispielsweise 5 cm unterhalb der oberen Blattkante.</td>
</tr>
<tr>
<td>Zentriert</td>
<td>Objekt vertikal zentriert ausrichten. Ist der Abstand auf 0 cm gesetzt, wird das Objekt also vertikal in der Mitte der Seite zentriert, bei einem Abstand von 5 cm wird es 5 cm weiter unten positioniert.</td>
</tr>
<tr>
<td>Unten</td>
<td>Objekt unten ausrichten. Das Objekt endet also beispielsweise 5 cm oberhalb der unteren Seitenkante.</td>
</tr>
</tbody>
</table>

**Relativ zu:** Mit der Option Relativ zu legen Sie fest, worauf sich der eingestellte Abstand beziehen soll:

<table>
<thead>
<tr>
<th>Option</th>
<th>Auswirkung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seite</td>
<td>Der Abstand ist relativ zur Seite (genauer gesagt: zu den Blattkanten). Die Seitenränder werden dabei nicht berücksichtigt.</td>
</tr>
<tr>
<td>Seitenrand</td>
<td>Der Abstand ist relativ zu den Seitenrändern. Erhöhen Sie die Seitenränder, verschiebt sich auch das Objekt entsprechend.</td>
</tr>
<tr>
<td>Absatz</td>
<td>Der Abstand ist relativ zu der Position des Absatzes, in dem sich der Anker des Objekts befindet.</td>
</tr>
</tbody>
</table>

**Hinweis:** Wenn Sie diese Option wählen, wandert das Objekt also mit dem Absatz mit. Fügen Sie oberhalb des Objekts eine neue Zeile ein, rutscht auch das Objekt eine Zeile weiter nach unten.

| Oberer Rand, Unterer Rand etc. | Hier bezieht sich Abstand auf den jeweiligen Seitenrand. Setzen Sie Abstand beispielsweise auf 0, Position auf Oben und wählen hier Unterer Rand, beginnt das Objekt genau dort, wo der untere Seitenrand beginnt. |

Informationen, was Anker sind, können Sie bei Bedarf im Abschnitt Position von Objekten ändern nachlesen.

**Abstand:** Mit der Option Abstand können Sie schließlich den gewünschten Abstand einstellen.

Beispiel: Ist Position auf "Oben" gesetzt, Relativ zu auf "Seitenrand" und Abstand auf 5 cm, beginnt das Objekt 5 cm unter dem oberen Seitenrand. Ist dieser Seitenrand also 2 cm groß, beginnt das Objekt bei 7 cm.

- **Rubrik Außenränder**
  Hier können Sie die Außenränder des Objekts ändern.

  **Tipp:** Die Außenränder lassen sich auch durch Ziehen an den äußeren (gestrichelten) Begrenzungslinien des Objekts ändern.

- **Rubrik Textfluss**
  Diese Option ist nur bei Rahmen und Zeichnungen verfügbar.
Sie bestimmt, wie sich der Fließtext verhalten soll, der den Rahmen (beziehungsweise die Zeichnung) umgibt.

Verfügbare Optionen (von links nach rechts):

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zeile</td>
<td>Der Fließtext wird oberhalb des Rahmens unterbrochen und unterhalb des Rahmens fortgeführt.</td>
</tr>
<tr>
<td>Rechteck</td>
<td>Der Fließtext umfließt den Rahmen in rechteckiger Form. (Dies ist die Standardeinstellung.)</td>
</tr>
<tr>
<td>Kontur</td>
<td>Der Fließtext umfließt möglichst genau die Konturen des in dem Rahmen enthaltenen Objekts (sogenannter &quot;Kontursatz&quot;). Dies funktioniert nur bei Grafiken, die Transparenzen enthalten, und bei Zeichnungen.</td>
</tr>
<tr>
<td>Hinter Text</td>
<td>Der Fließtext läuft einfach durch den Rahmen hindurch. Er wird dabei hinter dem Rahmen dargestellt.</td>
</tr>
<tr>
<td>Vor Text</td>
<td>Der Fließtext läuft ebenfalls durch den Rahmen hindurch. Er wird dabei allerdings vor dem Rahmen dargestellt.</td>
</tr>
</tbody>
</table>

Hinweis: Bei Objekten, deren Anker sich in einer Tabellenzelle befindet, ist diese Option nicht verfügbar.

- **Rubrik Kontur**

Diese Option ist nur bei Rahmen und Zeichnungen verfügbar.

Wenn Sie bei Textfluss die Option Rechteck oder Kontur gewählt haben, können Sie hier bestimmen, auf welchen Seiten des Rahmens der Text fließen soll.

Verfügbare Optionen (von links nach rechts):

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beide</td>
<td>Der Fließtext umfließt den Rahmen auf beiden Seiten.</td>
</tr>
<tr>
<td>Links</td>
<td>Er umfließt ihn nur auf der linken Seite.</td>
</tr>
<tr>
<td>Rechts</td>
<td>Er umfließt ihn nur auf der rechten Seite.</td>
</tr>
<tr>
<td>Größte Seite</td>
<td>Er umfließt ihn nur auf der Seite, auf der mehr Platz ist.</td>
</tr>
</tbody>
</table>

- **Rubrik Objekt**

Diese Option ist nur bei Rahmen und Zeichnungen verfügbar.

Wenn Sie einen Rahmen oder eine Zeichnung anlegen, setzt dieses Objekt automatisch einen "Anker" in den Textabsatz links von der Stelle, an der Sie es einfügen.

Objekte erscheinen immer auf der Seite, auf der sich ihr Anker befindet. Verschieben Sie den Absatz, mit dem das Objekt verankert ist, also auf die nächste Seite, landet dieses Objekt ebenfalls auf der nächsten Seite.

So verhält sich TextMaker zumindest, wenn Sie die Standardeinstellung Mit Text verschieben gewählt haben. Wählen Sie hingegen die Option Fest auf Seite, bleibt das Objekt immer auf der Seite, dessen Seitennummer Sie hier einstellen. Es ist dann also nicht mit einem Absatz verankert.
Weitere Informationen zur Verwendung von Ankern finden Sie auch im Abschnitt Position von Objekten ändern.

- Rubrik Wenn das Objekt verschoben wird

Diese Option ist nur bei Rahmen und Zeichnungen verfügbar.

Wenn Sie bei Objekt (siehe oben) die Option Mit Text verschieben gewählt haben, können Sie hier bestimmen, wie sich der Anker des Objekts verhalten soll, wenn Sie das Objekt verschieben:

Wenn die Standardeinstellung Den Anker zum nächstgelegenen Absatz verschieben gewählt ist, wandert der Anker mit dem Objekt mit. Verschieben Sie das Objekt, entfernt es also seinen bisherigen Anker und setzt einen neuen Anker in dem Absatz links der Zielposition.

Wählen Sie hingegen die Option Den Anker am aktuellen Absatz verankert lassen, belässt das Objekt seinen Anker immer in dem Absatz, mit dem es derzeit verankert ist – auch dann, wenn Sie das Objekt verschieben.

- Rubrik Objekt-Eigenschaften, Karteikarte Format

Auf der Karteikarte Format können Sie Einstellungen zum Format des Objekts vornehmen, also beispielsweise seine Größe ändern.

Verfügbare Optionen:

- Rubrik Größe

Hier lässt sich die Größe des Objekts ändern. Tragen Sie dazu die gewünschte Breite und Höhe ein.

Bei Objekten, die Text enthalten (z.B. Textrahmen), können Sie die Breite und Höhe entweder genau festlegen oder den Rahmen automatisch wachsen lassen, sobald der Platz für den enthaltenen Text nicht mehr ausreicht. Wählen Sie dazu bei Breite beziehungsweise Höhe die Option Wachsen und geben Sie das gewünschte Minimum und Maximum an.

- Rubrik Skalierung

Alternativ können Sie die Größe eines Objekts ändern, indem Sie bei Horz. Faktor und Vert. Faktor angeben, auf wie viel Prozent seiner Originalgröße das Objekt vergrößert/verkleinert werden soll.

Haben Sie dabei die Option Seitenverhältnis beibehalten eingeschaltet, wirken sich Änderungen an der Höhe automatisch auf die Breite aus (und umgekehrt).


- Rubrik Drehung

Nur bei Zeichnungen und Grafiken verfügbar.

Hier können Sie das Objekt drehen. Tragen Sie dazu den Winkel ein, um den das Objekt im Uhrzeigersinn gedreht werden soll.

- Rubrik Kippen

Nur bei Zeichnungen und Grafiken verfügbar.

Hier können Sie das Objekt vertikal oder horizontal kippen.
Objekt-Eigenschaften, Karteikarte Füllung

**Hinweis:** Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar. Und: Bei Grafiken wirken sich Änderungen an der Füllung nur auf die transparenten Teile der Grafik aus.

Auf der Karteikarte **Füllung** können Sie festlegen, womit das Objekt ausgefüllt werden soll.

Wählen Sie zunächst in der Liste **Fülltyp** die gewünschte Art der Füllung. Anschließend können Sie zu jedem Fülltyp noch diverse Einstellungen vornehmen.

Nachfolgend eine Liste aller Fülltypen inklusive ihrer Einstellungen:

- **Keine Füllung**
  
  Wenn Sie den ersten Fülltyp in der Liste wählen, wird das Objekt nicht gefüllt, ist also transparent.

- **Farbe**
  
  Bei diesem Fülltyp wird das Objekt mit einer Farbe gefüllt. Wählen Sie die gewünschte Farbe dazu in der Liste **Farben**.

  Tipp: Farblisten bieten immer nur einige Standardfarben an, Sie können aber jederzeit auch andere Farben wählen. Klicken Sie dazu auf **Weitere Farben** und gehen Sie dann wie im Abschnitt **Dokumenteigenschaften, Karteikarte Farben** beschrieben vor.

  Mit der Option **Transparenz** können Sie auf Wunsch die Transparenz der Füllung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig). Setzen Sie diesen Wert also beispielsweise auf 75, ist die Füllung zu 75% durchsichtig.

- **Raster**
  
  Hier wird das Objekt mit einem Raster gefüllt. Wählen Sie dazu in der Liste **Raster** die Art des Rasters und stellen Sie dann die gewünschte Farbe für Vordergrund und Hintergrund ein.

  Mit der Option **Transparenz** können Sie auf Wunsch die Transparenz der Füllung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

- **Grafik**
  
  Hier wird das Objekt mit einer Grafik gefüllt. Über die Schaltfläche **Öffnen** können Sie bestimmen, welche Grafikdatei dies sein soll. Die zuletzt verwendeten Grafiken werden außerdem in der Liste **Grafiken** angezeigt und lassen sich dort per Mausklick auswählen.

  Weitere Optionen:

  **Mit dem Objekt drehen:** Wenn Sie diese Option einschalten, dreht sich die Grafik mit, wenn Sie das zu füllende Objekt rotieren.

  **Spiegelung:** Mit dieser Option können Sie die Grafik horizontal oder vertikal spiegeln.

  **Transparenz:** Mit dieser Option können Sie auf Wunsch die Transparenz der Füllung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

  **Als Textur kacheln:** Wenn diese Option aktiviert ist, wird die Grafik in dem Objekt wie ein Kachelmuster wiederholt.

  Über die Einstellungen in der Rubrik **Kacheloptionen** können Sie dann die Größe und Position der Kacheln ändern: Mit **X-Skalierung** und **Y-Skalierung** ändern Sie die Größe (in Prozent). Mit **X-Versatz** und **Y-Versatz** ändern Sie die Position. Die Option **Ausrichtung** bestimmt, an welcher Kante oder Ecke des zu füllenden Objekts die Kacheln ausgerichtet werden sollen.
Ist die Option *Als Textur kacheln* deaktiviert, lassen sich hier lediglich die *Abstände* zu den Kanten des zu füllenden Objekts einstellen.

**Speichern:** Mit dieser Schaltfläche können Sie die momentan ausgewählte Grafikdatei exportieren, also eine Kopie der Grafik unter einem beliebigen Namen auf Festplatte speichern.

### Linearer Farbverlauf, Rechteckiger Farbverlauf etc.


In der Rubrik *Optionen* lässt sich das Aussehen des Farbverlaufs noch genauer festlegen:

Mit *X-Versatz* und *Y-Versatz* können Sie das Zentrum des Farbverlaufs verschieben. Weiterhin lässt sich der *Drehwinkel* einstellen.

**Tipps:** Sie können auch das Steuerkreuz im Feld *Beispiel* mit der Maus verschieben oder rotieren, um diese Einstellungen zu ändern.

Aktivieren Sie die Option *Doppelter Farbverlauf*, verläuft die Farbe beispielsweise nicht nur von der Ausgangsfarbe zur Endfarbe, sondern auch wieder zurück zur Ausgangsfarbe.

In der Rubrik *Farben* können Sie die Farben für den Verlauf ändern:

Um eine Farbe zu ändern, klicken Sie zunächst auf eines der kleinen Dreiecke unter dem Balken für den Farbverlauf. Das linke Dreieck steht für die Ausgangsfarbe, das rechte Dreieck für die Endfarbe:

![Diagramm]

Wählen Sie dann die gewünschte Farbe aus der Liste *Farbe* darunter.

Mit der Option *Transparenz* lässt sich auf Wunsch die Transparenz für die gewählte Farbe ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

Sie können dem Farbverlauf sogar noch weitere Farben hinzufügen, indem Sie einen Doppelklick auf die gewünschte Position in dem Balken durchführen und dann eine Farbe auswählen. Auf die gleiche Weise, nämlich mit einem Doppelklick auf das Dreieck, lassen sich zusätzliche Farben auch wieder aus dem Verlauf löschen.

---

**Objekt-Eigenschaften, Karteikarte Linien**

**Hinweis:** Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.

Auf der Karteikarte *Linien* können Sie festlegen, welche Art von Linien für das Objekt verwendet werden soll. Bei Zeichnungen betrifft dies die Linien, mit denen das Objekt gezeichnet wird; bei allen anderen Objekten die Linien, mit denen das Objekt umrandet wird.

Verfügbare Optionen:

- **Varianten**

Hier können Sie den gewünschten Linienstil auswählen.

Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optionen des Dialogs können Sie das Aussehen der Linien bei Bedarf noch genauer festlegen.
Rahmen und Zeichnungen

- **Farbe**
  Lässt Sie die Farbe der Linien festlegen.

- **Strich**
  Hier können Sie festlegen, ob durchgezogene Linien oder gestrichelte Linien gezeichnet werden sollen.

- **Liniendicke**
  Hier können Sie die Liniendicke exakt in Zehntelpunkt angeben.

- **Transparenz**
  Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Linien ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

- **Startpunkt und Endpunkt**
  Nur bei Linien, Kurven und Verbindungslinien verfügbar.

---

**Objekt-Eigenschaften, Karteikarte Schatten**

_Hinweis:_ Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.

Mit Hilfe der Karteikarte Schatten können Sie das Objekt mit einem Schatten versehen.

Verfügbare Optionen:

- **Varianten**
  Hier können Sie den gewünschten Typ von Schatten auswählen.
  Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optionen des Dialogs können Sie das Aussehen des Schattens bei Bedarf noch genauer festlegen.

- **Skalierung**
  Hier können Sie die Größe des Schattens (im Verhältnis zur Größe des Objekts) ändern.

- **Versatz**
  Hier können Sie die Position des Schattens ändern.

- **Perspektive**
  Hier können Sie den Neigungswinkel des Schattens ändern.
  Bei bestimmten Varianten des Typs "Perspektivische Schatten" lässt sich außerdem der Horizont ändern, was den Schatten perspektivisch verzerrt. Ist Horizont ein positiver Wert, liegt der Schatten vor dem Objekt; bei negativen Werten liegt er hinter dem Objekt.

- **Farbe**
  Hier können Sie die Farbe des Schattens ändern.
- **Unscharfe**

Wenn Sie hier einen Wert größer als Null eintragen, wird der Schatten mit einem Unscharfe-Effekt versehen. Je größer der Wert ist, desto weicher werden die Kanten des Schattens gezeichnet.

- **Transparenz**

Hier können Sie die Transparenz des Schattens ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig). Bei einem Wert von 75 ist der Schatten also beispielsweise zu 75% durchsichtig.

---

**Objekt-Eigenschaften, Karteikarte 3D**

**Hinweis:** Diese Karteikarte ist nur bei Textrahmen und Zeichnungen verfügbar.

Mit Hilfe der Karteikarte **3D** können Sie das Objekt mit einem 3D-Effekt versehen.

Verfügbare Optionen:

- **Varianten**

Hier können Sie den gewünschten Typ von 3D-Effekt auswählen.

Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optionen des Dialogs können Sie das Aussehen des Effekts bei Bedarf noch genauer festlegen.

- **Rubrik Optionen**

Hier können Sie die **Winkel**, um die das Objekt um die Achsen rotiert werden soll, und die **Tiefe** des 3D-Effekts einstellen.

- **Rubrik 3D-Oberfläche**

  **Seitenflächen:** Die Farbe für die Seitenflächen des Objekts wird normalerweise automatisch eingestellt. Falls Sie eine andere Farbe verwenden möchten, aktivieren Sie die Option **Seitenflächen** und wählen darunter die gewünschte Farbe.

  **Vorderfläche anpassen:** Wenn diese Option aktiviert ist, wird auch die Vorderfläche des Objekts den Beleuchtungseinstellungen des 3D-Effekts entsprechend abgedunkelt. Die Beleuchtung können Sie mit der Schaltfläche **Weiteres** beeinflussen.

  **Drahtmodell:** Wenn Sie diese Option aktivieren, wird das Objekt wie ein Drahtgittermodell dargestellt.

- **Schaltfläche Weiteres**

Klicken Sie auf diese Schaltfläche, können Sie auf die Beleuchtung für den 3D-Effekt Einfluss nehmen. Es erscheint dazu ein eigener Dialog. Klicken Sie im Feld **Beleuchtung** auf die Position, an der sich die Lichtquelle befinden soll. Darüber hinaus können Sie die **Intensität** einstellen und bestimmen, welche Art von **Oberfläche** der 3D-Effekt simulieren soll.

---

**Objekt-Eigenschaften, Karteikarte Effekte**

**Hinweis:** Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.

Mit Hilfe der Karteikarte **Effekte** können Sie das Objekt mit diversen Effekten versehen.
Verfügbare Effekte und Optionen:

- **Spiegelung**
  
  Wenn Sie die Option *Spiegelungseffekt verwenden* aktivieren, wird das Objekt so dargestellt, als ob es auf einer spiegelnden Oberfläche stehen würde.

  **Optionen:**
  
  - **Sichtbarer Teil des Objekts:** Bestimmt, wie viel von dem Objekt in der Spiegelung zu sehen sein soll (in Prozent).
  - **Transparenz beginnt bei:** Die Spiegelung wird nach unten hin weich ausgeblendet. Dieser Wert bestimmt, wie transparent die Spiegelung ganz oben sein soll (in Prozent).
  - **Y-Versatz:** Verschiebt die Spiegelung nach oben oder unten.

- **Weiche Kanten**
  
  Wenn Sie die Option *Weiche Kanten-Effekt verwenden* aktivieren, werden die Umrandungslinien des Objekts mit einem Weichzeichner-Effekt versehen.

  **Optionen:**
  
  - **Breite:** Bestimmt, wie stark der Effekt ausfallen soll.

- **Leuchteffekt**
  
  Wenn Sie die Option *Leuchteffekt verwenden* aktivieren, werden die Umrandungslinien des Objekts mit einem Leuchteffekt umgeben.

  **Optionen:**
  
  - **Breite:** Bestimmt, wie stark der Leuchteffekt ausfallen soll.
  - **Farbe:** Ändert die Farbe für den Leuchteffekt.

---

**Objekt-Eigenschaften, Karteikarte Eigenschaften**

Auf der Karteikarte *Eigenschaften* lassen sich allgemeine Einstellungen für ein Objekt ändern.

Verfügbare Optionen:

- **Name**
  
  Jedes Objekt in einem Dokument bekommt von TextMaker automatisch einen eindeutigen Namen zugewiesen. Rechtecke heißen also beispielsweise Rechteck1, ...2, ...3 usw.

  Auf Wunsch können Sie hier einen anderen Namen eintragen.

  Ausführlichere Informationen zur Verwendung von Namen für Objekte finden Sie im Abschnitt *Namen von Objekten ändern*.

- **Sichtbar**
  
  Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt auf dem Bildschirm angezeigt wird (siehe auch Abschnitt *Verbergen von Objekten*).

  Schalten Sie diese Option aus, wird das Objekt unsichtbar.
**Rahmen und Zeichnungen**

- **Drucken**
  Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt im Ausdruck erscheint, wenn Sie das Dokument drucken (siehe auch Abschnitt Verbergen von Objekten).
  Schalten Sie diese Option aus, wird das Objekt nicht gedruckt.

- **Sperren**
  Wenn Sie diese Option aktivieren, kann die Position (bei Rahmen und Zeichnungen) und Größe des Objekts mit der Maus und Tastatur nicht mehr verändert werden. Position und Größe lassen sich dann nur noch durch Eingabe von Werten in das Dialogfenster des Menübefehls **Objekt > Eigenschaften** ändern.

- **Tabstopp**
  Nur bei Formularobjekten (z.B. Textfeldern und Textrahmen, Kontrollkästchen und Auswahllisten) verfügbar.
  Im Formularmodus können Sie mit der Tabulatortaste **Tab** (oder der **F11**-Taste) zwischen Formularobjekten hin- und herspringen (siehe Abschnitt Tab-Reihenfolge ändern).
  Schalten Sie die Option **Tabstopp** jedoch aus, wird dieses Objekt dabei übersprungen.

- **Text sperren**
  Nur bei Objekten verfügbar, die Text enthalten (z.B. Textfeldern und Textrahmen).
  Wenn diese Option aktiviert ist, lässt sich der in dem Objekt enthaltene Text nicht mehr abändern, wenn das Dokument im **Formularmodus** bearbeitet wird.
  Standardmäßig ist diese Option jedoch ausgeschaltet; der Text in dem Objekt lässt sich also auch im Formularmodus editieren.
  Weitere Informationen zu diesem Thema finden Sie im Abschnitt Inhalt von Formularobjekten schützen.

- **Hyperlink**
  Bei Grafiken werden in der rechten Hälfte des Dialogs außerdem Information zu der verwendeten Grafik angezeigt (Auflösung, Farbtiefe etc.).

---

**Zusätzliche Karteikarten**

Bei manchen Arten von Objekten erscheinen zusätzliche Karteikarten mit weiteren Optionen. Informationen zu diesen Karteikarten finden Sie im Abschnitt über das betreffende Objekt.

---

**Standardeinstellungen für Objekte ändern**

Sie können die Standardeinstellungen für Objekte (Zeichnungen, Grafiken etc.) jederzeit ändern.

**Hinweis:** Änderungen an den Standardeinstellungen für Objekte betreffen nur Objekte, die Sie *danach* einfügen. Bereits vorhandene Objekte bleiben hingegen unberührt. Um die Standardeinstellungen für Objekte zu verändern, verwenden Sie die Schaltfläche **Standard** im Dialogfenster des Menübefehls **Objekt > Eigenschaften**.

Die Standard-Liniendicke für Zeichnungen lässt sich beispielsweise folgendermaßen ändern:

1. Fügen Sie eine neue Zeichnung ein (oder klicken Sie auf eine vorhandene Zeichnung).
2. Rufen Sie den Menübefehl **Objekt > Eigenschaften** auf.
3. Nehmen Sie die gewünschten Einstellungen vor. Um also beispielsweise die Voreinstellung für die Liniendicke zu ändern, stellen Sie einfach auf der Karteikarte **Linien** die gewünschte Liniendicke ein.
4. Jetzt kommt der entscheidende Schritt: Klicken Sie nicht auf **OK**, sondern auf die Schaltfläche **Standard**.
5. Es erscheint ein Dialog, in dem Sie bei Bedarf noch eingrenzen können, welche Standardeinstellungen geändert werden sollen. In der Regel ist dies aber nicht nötig.
6. Wenn Sie mit **OK** bestätigen, werden die aktuell im Dialog gemachten Einstellungen als Standardeinstellungen für neue Zeichnungen festgelegt.

Alle Zeichnungen, die Sie von nun an einfügen, verwenden standardmäßig die so festgelegte Liniendicke.

**Hinweis:** Die Standardeinstellungen für Objekte lassen sich für jedes Dokument getrennt festlegen.

---

**Rahmen – Fortgeschrittene Funktionen**

Die nächsten Seiten enthalten Informationen zu den etwas ausgefalleneren Funktionen zum Bearbeiten von Rahmen und anderen Objekten. Folgende Themen werden darin behandelt:

- Konvertieren zwischen Rahmen und eingebettetem Objekt
- Verbergen von Objekten
- Reihenfolge von Rahmen ändern
- Gruppieren von Rahmen
- Namen von Objekten ändern
**Konvertieren zwischen Rahmen und eingebettetem Objekt**

Sie können einen Rahmen (z.B. einen Grafikrahmen) jederzeit in ein in den Text eingebettetes Objekt umwandeln (z.B. eine Grafik).

Gehen Sie dazu wie folgt vor:

1. Selektieren Sie das gewünschte Objekt.
2. Rechtsklicken Sie auf das Objekt, um sein Kontextmenü aufzurufen.
3. Wählen Sie im Kontextmenü den Befehl **In eingebettetes Objekt umwandeln** auf.

Der Grafikrahmen wird nun in eine "gewöhnliche" Grafik konvertiert, die in den Text eingebettet ist.

Naturally ist auch der umgekehrte Weg möglich: Wenn Sie ein Objekt auswählen, das in den Text eingebettet ist (z.B. eine Grafik), und dann im Kontextmenü den Befehl **In Objektrahmen umwandeln** auswählen, wird diese Grafik zu einem Grafikrahmen.

**Verbergen von Objekten**

Sie können ein Objekt bei Bedarf **verbergen**. Es wird dann auf dem Bildschirm und/oder im Ausdruck nicht mehr dargestellt.

Selektieren Sie das gewünschte Objekt dazu, rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, wechseln Sie auf die Karteikarte **Eigenschaften** und gehen Sie dann wie folgt vor:

- Schalten Sie Option **Sichtbar** aus, wird das Objekt auf dem Bildschirm nicht mehr angezeigt.
- Schalten Sie Option **Drucken** aus, erscheint das Objekt nicht mehr im Ausdruck.

**Tipp:** Wenn Sie ein Objekt einmal versehentlich unsichtbar gemacht haben, können Sie jederzeit den Menübefehl **Datei > Eigenschaften** aufrufen und die Option **Nicht sichtbare Objekte anzeigen** auf der Karteikarte **Optionen** einschalten. Nun werden alle verborgenen Objekte wieder angezeigt. Sie können das Objekt jetzt also selektieren und die Option **Sichtbar** wieder einschalten.

**Reihenfolge von Rahmen ändern**

Wenn sich mehrere Rahmen/Zeichnungen überlappen, können Sie bestimmen, in welcher Reihenfolge diese hintereinander angeordnet sein sollen – also welches Objekt im Vordergrund ist, welches im Hintergrund etc.

Gehen Sie dazu folgendermaßen vor:

1. Selektieren Sie das gewünschte Objekt.
2. Rufen Sie den Menübefehl **Objekt > Reihenfolge** auf. Es öffnet sich ein Untermenü mit folgenden Befehlen:
**In den Vordergrund:** Bringt das Objekt vor alle anderen Objekte.

**In den Hintergrund:** Bringt das Objekt hinter alle anderen Objekte.

**Eine Ebene vorne:** Bringt das Objekt eine Ebene weiter nach vorne.

**Eine Ebene hinten:** Bringt das Objekt eine Ebene weiter nach hinten.

---

**Gruppieren von Rahmen**

Wenn Sie mehrere Rahmen oder Zeichnungen *gruppiert*, fassen Sie diese zu einer Einheit zusammen, die wie ein einzelnes Objekt selektiert und manipuliert werden kann.

Das bedeutet in der Praxis:

Selektieren Sie ein Objekt, das zu einer Gruppe gehört, wird die gesamte Gruppe selektiert. Verschieben Sie dieses Objekt, werden alle Objekte der Gruppe mitbewegt.

Das Gruppieren verhindert außerdem, dass zusammengehörende Objekte versehentlich mit der Maus gegeneinander verschoben werden können.

Um Objekte zu gruppieren, gehen Sie folgendermaßen vor:

1. Selektieren Sie die zu gruppierenden Rahmen oder Zeichnungen.
   - Klicken Sie die Objekte dazu bei gedrückter Umschalttaste nacheinander an – oder wechseln Sie in den Objektmodus und ziehen Sie bei gedrückter Maustaste ein Rechteck um alle zu selektierenden Objekte auf.

2. Klicken Sie auf das Symbol in der Objektleiste oder rufen Sie den Menübefehl **Objekt > Gruppie-**
   - **ren** auf, um die Objekte zu gruppieren.

---

**Gruppierung wieder aufheben**

Um die Gruppierung von Objekten wieder aufzuheben, gehen Sie folgendermaßen vor:

1. Selektieren Sie die Gruppe, indem Sie eines der darin enthaltenen Objekte anklicken.

2. Rufen Sie den Menübefehl **Objekt > Gruppierung aufheben** auf.

---

**Namen von Objekten ändern**

Jedes Objekt in einem Dokument muss einen eindeutigen Namen haben. Dies ist erforderlich, damit Sie beispielsweise Berechnungen mit dem Inhalt von Tabellenzellen oder Textfeldern anstellen können.

Normalerweise brauchen Sie sich um diese Namen nicht zu kümmern, da sie von TextMaker automatisch vergeben werden: Fügen Sie ein Rechteck in ein leeres Dokument ein, heißt dieses automatisch "Rechteck1". Fügen Sie eine Grafik ein, wird diese "Grafik1" genannt, die nächste Grafik heißt dann "Grafik2" usw.

Sie können den Namen von Objekten aber jederzeit ändern. Haben Sie beispielsweise ein Formular erstellt, das ein Textfeld zur Eingabe des Wohnorts enthält, liegt es natürlich nahe, dieses Feld "Wohnort" zu nen-
nen. Selektieren Sie das Textfeld dazu, rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, wechseln Sie auf die Karteikarte **Eigenschaften** und ändern Sie den Eintrag im Feld **Name**.

Beachten Sie, dass Namen eindeutig sein müssen. Wenn Sie versuchen, einem Objekt einen bereits vergebenen Namen zu geben, weist TextMaker diesen mit einer Fehlermeldung zurück.

**Namen – wozu?**

Falls Sie sich fragen, welchen Zweck diese eindeutigen Namen für Objekte haben:

In erster Linie sind diese Namen für Berechnungen mit dem Inhalt von Objekten erforderlich. Um beispielsweise den Inhalt der Zelle C3 in einer Tabelle namens "Tabelle1" mit zwei zu multiplizieren, können Sie folgende Berechnung eingefügen:

```
Tabelle1.C3 * 2
```

Ausführliche Informationen zu Berechnungen mit Objekten finden Sie im Abschnitt Objekte in Berechnungen.

Die allgemeinen Informationen zu Rahmen und Zeichnungen sind hiermit abgeschlossen. In den nächsten Abschnitten werden die einzelnen Arten von Rahmen ausführlich vorgestellt:

- **Textrahmen**
- **Grafikrahmen**
- **OLE-Objektrahmen**
- **Zeichnungen**
- **Formularobjekte im Detail**

---

**Textrahmen**

Mit Hilfe von **Textrahmen** können Textkästen inmitten des laufenden Textes erzeugt werden – zum Beispiel ein Kasten mit besonders wichtigen Informationen.
Wie alle Arten von Rahmen hat auch ein Textrahmen eine feste Position auf der Seite. Er verschiebt sich also nicht, wenn Sie oberhalb des Rahmens Text einfügen oder löschen. Der normale Fließtext wird dabei automatisch um den Rahmen herum umbrochen – er "umfließt" den Rahmen.

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Textrahmen. Folgende Themen werden darin behandelt:

- **Textrahmen einfügen**
- **Eigenschaften von Textrahmen ändern**
- **Textrahmen verbinden**

Lesen Sie dazu die nächsten Seiten.

---

**Textrahmen einfügen**

Um einen Textrahmen einzufügen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Objekt > Neuer Textrahmen** auf.

   Alternativ können Sie auch auf das Symbol \[\text{\textyen}\] in der Objektleiste anklicken, sofern Sie den Objektmodus aktiviert haben.

2. Der Textrahmen wird nun eingefügt. Wenn Sie möchten, können Sie den Textrahmen anschließend noch verschieben oder seine Größe ändern:

   *Wichtig:* Zum Verschieben klicken Sie mit der Maus auf die *Umrandung* des Textrahmens. Dann ziehen Sie ihn (bei weiterhin gedrückter Maustaste) an die gewünschte Position.

   Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die den Textrahmen umgeben.

Der Textrahmen ist nun erstellt, und Sie können sofort mit der Eingabe von Text beginnen.

*Wichtig:* Wenn TextMaker am unteren Rand eines Textrahmens einen roten Balken anzeigt, zeigt dies an, dass der enthaltene Text nicht vollständig in den Rahmen hineinpasst. Vergrößern Sie in diesem Falle den Rahmen oder verringern Sie die Textmenge.

Um von einem Textrahmen wieder zurück in den normalen Fließtext zu gelangen, klicken Sie eine beliebige Stelle im Fließtext an. Umgekehrt gelangen Sie in den Textrahmen zurück, indem Sie in den Rahmen hineinklicken.

Textrahmen dürfen übrigens ohne weiteres bestehenden Fließtext überdecken – dieser wird dann automatisch so umbrochen, dass er den Rahmen umfließt.
Eigenschaften von Textrahmen ändern

Um die Eigenschaften eines Textrahmens zu bearbeiten, selektieren Sie diesen zunächst. Klicken Sie dazu die Umrandung an, die den Textrahmen umgibt, oder klicken Sie ihn im Objektmodus einfach an. Dann rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, worauf ein entsprechender Dialog erscheint.

*Tipp:* Wenn Sie den Objektmodus verwenden, können Sie diesen Dialog auch blitzschnell über einem Doppelklick auf den Textrahmen aufrufen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

**Karteikarten Layout, Format, Füllung etc.**

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgender Einstellungen:

- **Layout:** Auf dieser Karteikarte können Sie Position und Außenränder ändern und bestimmen, wie der Fließtext den Rahmen umfließen soll. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.
- **Format:** Hier können Sie die Größe des Rahmens ändern. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Format**.
- **Füllung:** Hier können Sie die Füllung ändern. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Füllung**.
- **Linien:** Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Linien**.
- **Schatten:** Hier können Sie einen Schatten anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Schatten**.
- **3D:** Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte 3D**.
- **Effekte:** Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Effekte**.
- **Eigenschaften:** Hier können Sie allgemeine Einstellungen ändern. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Eigenschaften**.

Weiterhin erscheinen bei Textrahmen zwei zusätzliche Karteikarten mit weiteren Optionen:

**Karteikarte Innentext**

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern.

Verfügbare Optionen:

- **Rubrik Innenränder**
  
  Hier können Sie die Ränder zwischen dem Textrahmen und dem darin enthaltenen Text ändern. Schalten Sie die Option **Automatisch** ein, ermittelt das Programm automatisch geeignete Ränder.

- **Rubrik Überlappende Objekte**
  
  Diese Einstellung bestimmt, was passieren soll, wenn sich der Textrahmen mit einem anderen Rahmen überlapt.
Bei der Standardeinstellung **Objekt ignorieren** greift TextMaker nicht ein. In dem sich überlappenden Bereich wird also der Inhalt beider Rahmen übereinander gedruckt.

Wählen Sie hingegen die Option **Text umbrechen**, wird der Text in diesem Rahmen automatisch neu umbrochen, so dass er die Überlappung umfließt.

**Rubrik Drehen um…**

Hier können Sie den Text um den angegebenen Winkel drehen.

**Rubrik Vertikale Ausrichtung**

Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Unterkante des Rahmens ausgerichtet werden soll:

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oben</td>
<td>Der Text wird an der Oberkante des Rahmens ausgerichtet. (Dies ist die Standardeinstellung.)</td>
</tr>
<tr>
<td>Zentriert</td>
<td>Der Text wird zwischen Ober- und Unterkante zentriert.</td>
</tr>
<tr>
<td>Unten</td>
<td>Der Text wird an der Unterkante des Rahmens ausgerichtet.</td>
</tr>
<tr>
<td>Blocksatz</td>
<td>Der Abstand zwischen den Textzeilen wird gleichmäßig so erweitert, dass der Text genau an der Oberkante des Rahmens beginnt und genau an der Unterkante endet.</td>
</tr>
</tbody>
</table>

**Karteikarte AutoFormen**

Ein Textrahmen ist eigentlich nichts anderes als eine *AutoForm*, der Text hinzugefügt wurde. Standardmäßig wird hierzu ein einfaches Rechteck als AutoForm verwendet. Sie können dem Textrahmen jedoch jederzeit eine andere AutoForm zuweisen, also beispielsweise aus dem Rechteck eine Sprechblase oder eine beliebige andere Form machen.

Wählen Sie dazu einfach auf der Karteikarte **AutoForm** die gewünschte Form aus.

**Hinweis:** Textrahmen haben standardmäßig *keine* Umrandungslinien. Wenn Sie hier eine andere Autoform auswählen, wird diese deshalb erst sichtbar, wenn Sie UmrandungsLinien anbringen. Wählen Sie dazu auf der Karteikarte **Linien** den gewünschten Linienstil.

Weitere Informationen zu AutoFormen finden Sie im Abschnitt Zeichnungen.

**Textrahmen verbinden**


Nehmen wir an, Sie haben auf einer Seite zwei Textrahmen erstellt, durch die der Text laufen soll. Verbinden Sie diese Textrahmen wie folgt:

1. Klicken Sie auf das Symbol 🎨 in der Formatleiste oder rufen Sie den Menübefehl Ansicht > Objektmodus auf, um den Objektmodus zu aktivieren.
2. Wählen Sie das Symbol **Textrahmen verbinden** in der Objektleiste.


4. Klicken Sie den zu verbindenden Textrahmen an. **Wichtig:** Dieser Textrahmen muss leer sein!

5. Klicken Sie erneut auf das Symbol **beziehungsweise rufen Sie Ansicht > Objektmodus** auf, um den Objektmodus wieder zu verlassen.

Wenn Sie nun Text in den ersten Rahmen eingeben, wird dieser im zweiten Rahmen fortgeführt, sobald er nicht mehr in den ersten hineinpasst.

Sie können auch mehr als zwei Textrahmen miteinander verbinden. Verbinden Sie dazu den ersten Rahmen mit dem zweiten, dann den zweiten mit dem dritten usw.

Um eine vorhandene Verbindung wieder zu lösen, klicken Sie mit dem Werkzeug **Textrahmen verbinden** auf den ersten der beiden verbundenen Rahmen. TextMaker fragt Sie daraufhin, ob er die Verbindung lösen soll.

---

### Grafikrahmen

Grafikrahmen unterscheiden sich von fest in den Text eingefügten Grafiken (siehe Kapitel Grafiken) folgendermaßen:

Wie alle Arten von Rahmen hat auch ein Grafikrahmen eine feste Position auf der Seite. Er verschiebt sich also nicht, wenn Sie oberhalb des Rahmens Text eingeben oder löschen.

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Grafikrahmen. Folgende Themen werden darin behandelt:

- Grafikrahmen einfügen
- Eigenschaften von Grafikrahmen ändern

Lesen Sie dazu die nächsten Seiten.

---

### Grafikrahmen einfügen

Um einen Grafikrahmen einzufügen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Objekt > Neuer Grafikrahmen** auf.

   Alternativ können Sie das Symbol **in der Objektleiste anklicken, sofern Sie den Objektmodus aktiviert haben.**

2. Es erscheint ein Dialog. Wählen Sie darin die gewünschte Grafikdatei aus und bestätigen Sie mit **OK.**

3. Der Grafikrahmen wird nun eingefügt.

   Wenn Sie möchten, können Sie den Rahmen anschließend noch verschieben oder seine Größe ändern:
Zum Verschieben klicken Sie mit der Maus auf den Grafikrahmen und ziehen ihn dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die den Grafikrahmen umgeben.

Ein Grafikrahmen darf ohne weiteres bestehenden Fließtext überdecken – der Text wird automatisch neu umbrochen, so dass er den Rahmen umfließt.

**Optionen des Dialogs**

Die Optionen in obigem Dialogfenster haben folgende Bedeutung:

- **Im Dokument ablegen**
  
  Ist diese Option eingeschaltet, speichert TextMaker eine Kopie der Grafik im Dokument ab und verwendet dieses anstelle des Originals.
  
  Ist sie ausgeschaltet, wird nur ein Verweis auf die Grafikdatei im Dokument gespeichert.

- **In den Ordner des Dokuments kopieren**
  
  Ist diese Option eingeschaltet, erzeugt TextMaker eine Kopie der Grafikdatei in dem Ordner, in dem sich das Dokument befindet, und verwendet diese anstelle des Originals.
  
  Diese Option ist nur verfügbar, wenn das Dokument schon einmal gespeichert wurde.

---

**Eigenschaften von Grafikrahmen ändern**

Um die Eigenschaften eines Grafikrahmens zu bearbeiten, selektieren Sie diesen zunächst per Mausklick. Dann rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, worauf ein entsprechender Dialog erscheint.

**Tipp:** Sie können diesen Dialog auch über einen Doppelklick auf den Grafikrahmen aufrufen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

- **Karteikarten Layout, Format, Füllung etc.**
  
  Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgender Einstellungen:
**Rahmen und Zeichnungen**

- **Layout:** Auf dieser Karteikarte können Sie Position und Außenränder ändern und bestimmen, wie der Fließtext den Rahmen umfließen soll. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.

- **Format:** Hier können Sie die Größe des Rahmens ändern und den Rahmen drehen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Format**.

- **Füllung:** Hier können Sie die Füllung ändern. Nur bei Grafiken mit transparenten Bereichen sichtbar. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Füllung**.

- **Linien:** Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Linien**.

- **Schatten:** Hier können Sie einen Schatten anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Schatten**.

- **Effekte:** Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Effekte**.

- **Eigenschaften:** Hier können Sie allgemeine Einstellungen ändern. Außerdem werden Informationen zu der verwendeten Grafik angezeigt. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Eigenschaften**.

Weiterhin erscheint bei Grafiken eine zusätzliche Karteikarte mit weiteren Optionen:

**Karteikarte Grafik**

Auf der Karteikarte **Grafik** können Sie Einstellungen zur Grafik selbst vornehmen.

**Tipp:** Einen Teil dieser Einstellungen können Sie auch über die **Grafikleiste** ändern, die automatisch erscheint, wenn Sie eine Grafik selektieren. Siehe Abschnitt **Verwenden der Grafikleiste**.

Sie finden auf dieser Karteikarte folgende Optionen:

- **Varianten**
  
  In dieser Liste werden einige vorgefertigte Variationen der Grafik angeboten – zum Beispiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, bei denen das Bild eingefärbt wurde.

  Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog werden dann automatisch auf entsprechende Einstellungen gesetzt.

- **Rubrik Optionen**
  
  Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alternative Möglichkeit zum Ändern der Helligkeit) ändern.

- **Schaltfläche Weiteres**
  
  Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen:

  Wenn Sie die Option **Einfärben** aktivieren und darunter eine Farbe auswählen, wird die Grafik entsprechend eingefärbt.

  Mit den Optionen in der Rubrik **Beschnitt** können Sie die Grafik zuschneiden. Dies ist nützlich, wenn Sie nur einen Ausschnitt der Grafik benötigen. Soll beispielsweise das obere Viertel der Grafik abgeschnitten werden, wählen Sie zunächst **Relative Werte verwenden** und geben Sie bei **Oben** die Zahl "25" (Prozent) ein.

  Wählen Sie **Absolute Werte verwenden** aus, werden die Eingaben nicht prozentual, sondern in absoluten Längeneinheiten abgeschnitten. Wenn Sie negative Werte eingeben, werden die Bereiche der Grafik nicht abgeschnitten, sondern wird mit einem Rahmen erweitert.
Rahmen und Zeichnungen

Rubrik Transparenz

Hier können Sie Einstellungen zur Transparenz der Grafik vornehmen:


**Keine Transparenz:** Die Grafik wird nicht transparent dargestellt – selbst wenn sie sich in eine Grafikdatei mit Transparenz-Informationen handelt.

**Farbe:** Lässt Sie die Farbe auswählen, die als transparente Farbe verwendet werden soll. Wählen Sie beispielsweise die Farbe Weiß, werden alle weißen Bereiche der Grafik transparent dargestellt.

Schaltfläche **Datei**

Über diese Schaltfläche können Sie eine andere Grafikdatei auswählen.

Schaltfläche **Exportieren**

Nur bei Grafiken verfügbar, die im Dokument gespeichert sind. Mit dieser Schaltfläche können Sie die Grafikdatei exportieren, also eine Kopie der Grafik unter einem beliebigen Namen auf Festplatte speichern.

Schalten Sie dabei die Option **Verknüpfung zu Datei herstellen** ein, ersetzt TextMaker außerdem die im Dokument gespeicherte Grafik durch einen Verweis auf die Zielseite. Die Grafik ist dann also nicht mehr im Dokument gespeichert.

---

**OLE-Objektrahmen**


Im Kapitel **OLE-Objekte** haben Sie erfahren, was OLE-Objekte sind und wie diese eingesetzt werden. Über das Einfügen direkt in den Text hinaus lassen sich OLE-Objekte auch in Form von Rahmen einfügen.

Der Unterschied:

Wie alle Arten von Rahmen hat auch ein OLE-Objektrahmen eine feste Position auf der Seite. Er verschiebt sich also nicht, wenn Sie oberhalb des Rahmens Text einfügen oder löschen.

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit OLE-Objektrahmen. Folgende Themen werden darin behandelt:

- OLE-Objektrahmen einfügen
- Eigenschaften von OLE-Objektrahmen ändern

Lesen Sie dazu die nächsten Seiten.
**OLE-Objektrahmen einfügen**

**Hinweis:** Die Verwendung von OLE-Objekten ist nur mit der Windows-Version von TextMaker möglich.

Um einen OLE-Objektrahmen einzufügen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Objekt > Neuer OLE-Objektrahmen** auf.
   
   Alternativ können Sie das Symbol in der Objektleiste anklicken, sofern Sie den Objektmodus aktiviert haben.

2. Es erscheint ein Dialogfenster. Wählen Sie darin aus der Liste **Objekttyp** die Quellanwendung aus, von der TextMaker das OLE-Objekt erhalten soll.

3. Bestätigen Sie mit **OK**, worauf die zum gewählten Objekttyp gehörende Anwendung gestartet wird.

4. Erstellen Sie das Objekt in der Anwendung.

5. Beenden Sie die Anwendung.

6. Die Anwendung fragt nun möglicherweise nach, ob Sie das Objekt im TextMaker-Dokument aktualisieren möchten. Bestätigen Sie dies mit "Ja".

7. Der OLE-Objektrahmen wird nun angelegt.

   Wenn Sie möchten, können Sie den Rahmen anschließend noch verschieben oder seine Größe ändern:

   Zum Verschieben klicken Sie mit der Maus auf den OLE-Objektrahmen und ziehen ihn dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.

   Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die den Rahmen umgeben.

Der eingefügte Rahmen darf ohne weiteres bestehenden Fließtext überdecken – dieser wird automatisch neu umbrochen, so dass er den Rahmen umfließt.

Alternativ können Sie OLE-Objekte auch aus einer bereits vorhandenen Datei erstellen, indem Sie im obigen Dialog die Option **Datei** wählen und die einzubindende Datei angeben.

Weitere Informationen zum Arbeiten mit OLE-Objekten finden Sie im Kapitel **OLE-Objekte**.

---

**Eigenschaften von OLE-Objektrahmen ändern**

Um die Eigenschaften eines OLE-Objektrahmens zu bearbeiten, selektieren Sie diesen zunächst per Mausklick. Dann rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, worauf ein entsprechender Dialog erscheint.

In dem Dialog lassen sich folgende Einstellungen vornehmen:
Karteikarten Layout, Format, Füllung etc.

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgender Einstellungen:

- **Layout:** Auf dieser Karteikarte können Sie Position und Außenränder ändern und bestimmen, wie der Fließtext den Rahmen umfließen soll. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Layout*.

- **Format:** Hier können Sie die Größe des Objekts ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Format*.

- **Füllung:** Hier können Sie die Füllung ändern. Diese Funktion wird allerdings nicht von allen OLE-Anwendungen unterstützt. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Füllung*.

- **Linien:** Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Linien*.

- **Schatten:** Hier können Sie einen Schatten anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Schatten*.

- **Effekte:** Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Effekte*.

- **Eigenschaften:** Hier können Sie allgemeine Einstellungen ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Eigenschaften*.

Weiterhin erscheint bei OLE-Objekten eine zusätzliche Karteikarte mit weiteren Optionen:

Karteikarte Grafik

Auf der Karteikarte **Grafik** können Sie Einstellungen zur grafischen Darstellung des Objekts vornehmen.

*Hinweis:* Abhängig vom Typ des OLE-Objekts sind manche dieser Optionen möglicherweise ohne Funktion.

Verfügbare Optionen:

- **Varianten**

  In dieser Liste werden einige vorgefertigte Variationen angeboten – zum Beispiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, bei denen das Objekt eingefärbt wurde.

  Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog werden dann automatisch auf entsprechende Einstellungen gesetzt.

- **Rubrik Optionen**

  Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alternative Möglichkeit zum Ändern der Helligkeit) ändern.

- **Schaltfläche Weiteres**

  Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen:

  Wenn Sie die Option **Einfärben** aktivieren und darunter eine Farbe auswählen, wird das Objekt entsprechend eingefärbt.

  Mit den Optionen in der Rubrik **Beschnitt** können Sie das Objekt zuschneiden. Dies ist nützlich, wenn Sie nur einen Ausschnitt des Objekts benötigen. Soll beispielsweise das obere Viertel des Objekts abge-
schnitten werden, wählen Sie zunächst **Relative Werte verwenden** und geben Sie bei **Oben** die Zahl "25" (Prozent) ein.

Wählen Sie **Absolute Werte verwenden** aus, werden die Eingaben nicht prozentual, sondern in absoluten Längeneinheiten abgeschnitten. Wenn Sie negative Werte eingeben, werden die Bereiche des Objekts nicht abgeschnitten, sondern es wird mit einem Rahmen erweitert.

- **Schaltfläche Exportieren**

Mit dieser Schaltfläche können Sie eine Kopie der grafischen Repräsentation des Objekts exportieren, also ein Abbild des Objekts unter einem beliebigen Namen auf Festplatte speichern.

---

**Zeichnungen**

TextMaker bietet mehrere Werkzeuge zum Erstellen von Zeichnungen an. Sie können in Ihre Dokumenten folgende Arten von Zeichnungsobjekten einfügen:

- Linien und Kurven (Linien, Pfeile, Verbindungslinien, Kurven)
- Rechtecke und Ellipsen
- AutoFormen (vorgefertigte Formen unterschiedlichster Art)
- TextArt-Objekte (mit Effekten versehene Schriftzüge)

Das Verhalten von Zeichnungen entspricht dem von Rahmen: Sie bleiben stets an der gleichen Stelle auf der Seite, auch wenn Sie Textzeilen oberhalb der Zeichnung löschen oder einfügen. Der normale Fließtext wird dabei automatisch um die Begrenzungslinien der Zeichnung herum umbrochen – er "umfließt" die Zeichnung.

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Zeichnungen. Folgende Themen werden darin behandelt:

- **Zeichnungen einfügen**
- **Text zu AutoFormen hinzufügen**
- **Eigenschaften von Zeichnungen ändern**

Lesen Sie dazu die nächsten Seiten.

---

**Zeichnungen einfügen**

Um eine Zeichnung einzufügen, zum Beispiel ein Rechteck, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Objekt > Neue Zeichnung** auf. Es öffnet sich ein Untermenü, aus dem Sie das gewünschte Zeichenwerkzeug auswählen können – in diesem Fall also das Werkzeug **Rechteck**.

   Alternativ können Sie auch das entsprechende Symbol in der Objektleiste anklicken, sofern Sie den Objektmodus aktiviert haben.
2. Bei manchen Werkzeugen müssen Sie nun noch weitere Schritte durchführen (siehe unten). Bei Rechtecken ist dies jedoch nicht der Fall.

3. Das Rechteck wird nun eingefügt.

Wenn Sie möchten, können Sie das Rechteck anschließend noch verschieben oder seine Größe ändern:

Zum Verschieben klicken Sie mit der Maus auf das Rechteck und ziehen es dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die das Rechteck umgeben.

Das Anbringen von Zeichnungen unterscheidet sich je nach verwendetem Zeichenwerkzeug etwas. Nachfolgend eine Liste aller verfügbaren Zeichnungsobjekte und Informationen zu deren Handhabung:

**Linie und Kurven**

Mit dem Werkzeug ![Linie](image) in der Objektleiste können Sie Linien und Kurven zeichnen.

Wenn Sie dieses Symbol anklicken, öffnet sich eine Liste mit verschiedenen Werkzeugen für Linien und Kurven zur Auswahl. Wählen Sie darin das gewünschte Werkzeug und wenden Sie es dann wie folgt an:

- **Linien**

  Mit den Werkzeugen in der obersten Rubrik der Liste können Sie einfache Linien und Pfeile zeichnen.

  Ziehen Sie dazu, nachdem Sie das gewünschte Werkzeug angeklickt haben, bei gedrückter Maustaste einfach eine Linie im Dokument.

  Tipp: Wenn Sie dabei die Umschalttaste gedrückt halten, ist die Linie auf 45°-Winkel beschränkt.

  Anmerkung: Pfeile sind nichts weiter als gewöhnliche Linien, bei denen in den Objekteigenschaften (Karteikarte ![Linien](image)) für die Option Startpunkt und/oder Endpunkt eine Pfeilspitze gewählt wurde.

- **Verbindungslinien (gerade, gewinkelte und gekrümmte)**

  Mit den Werkzeugen in den nächsten drei Rubriken können Sie Verbindungslinien zwischen zwei Objekten ziehen. Den Unterschied zwischen den drei Arten von Verbindungslinien sehen Sie in folgender Abbildung:

  ![Abbildung von Verbindungslinien](image)

  Wählen Sie dazu eines dieser Werkzeuge und ziehen Sie dann den Mauszeiger bei gedrückter Maustaste von einem Objekt zum anderen.

  Tipp: Es erscheinen hierbei kleine blaue Rechtecke am Objekt. Diese zeigen, an welchen Stellen des Objekts die Linie "andocken" kann.

- **Kurven**

  Die Werkzeuge in dieser Kategorie dienen zum Zeichnen von Kurven:
Mit dem Werkzeug \( \text{Kurve} \) können Sie Bezierkurven zeichnen.

Klicken Sie dazu auf den Ausgangspunkt und anschließend auf beliebig viele andere Positionen. Die Kurve "folgt" Ihren Mausklicks automatisch.

Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeichnung automatisch zu einer geschlossenen Kurve. Möchten Sie hingegen eine offene Kurve erhalten, müssen Sie die Zeichnung mit einem Doppelklick beenden.

Mit dem Werkzeug \( \text{Freihandform} \) können Sie Kurven hingegen wie mit einem Zeichenstift zeichnen.

Bewegen Sie die Maus dazu auf den gewünschten Ausgangspunkt und beginnen Sie bei gedrückter Maustaste zu zeichnen – wie mit einem Stift. Alternativ können Sie die Maustaste auch loslassen und eine andere Stelle anklicken, worauf eine gerade Linie dorthin gezeichnet wird.

Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeichnung automatisch zu einer geschlossenen Kurve. Möchten Sie hingegen eine offene Kurve erhalten, müssen Sie die Zeichnung mit einem Doppelklick beenden.

### Rechteck, abgerundetes Rechteck und Ellipse

Mit den drei Werkzeugen \( \text{Rechteck}, \text{Abgerundetes Rechteck} \) und \( \text{Ellipse} \) können Sie Rechtecke beziehungsweise Ellipsen einfügen.

Wenn Sie eines dieser Werkzeuge anklicken, wird das entsprechende Zeichnungsobjekt sofort (in einer Standardgröße) eingefügt. Wenn Sie möchten, können Sie es anschließend mit der Maus verschieben oder seine Größe ändern, indem Sie an einem der runden Greifer an seinen Ecken ziehen.

Bei abgerundeten Rechtecken lässt sich zudem noch die Rundung der Ecken ändern. Selektieren Sie das Rechteck dazu, worauf unter anderem ein gelber Greifer neben einer der Ecken erscheint. Ziehen Sie an diesem Greifer, ändert sich die Rundung entsprechend.

### AutoForm

Mit dem Werkzeug \( \text{AutoForm} \) können Sie AutoFormen einfügen. Das sind vorgefertigte Formen für die unterschiedlichsten Einsatzzwecke – Standardformen wie etwa Rechtecke, aber auch Symbole für Flussdiagramme, Sterne, Sprechblasen und viele mehr.

Sobald Sie eine AutoForm ausgewählt haben, wird diese (in einer Standardgröße) eingefügt. Wenn Sie möchten, können Sie die AutoForm anschließend mit der Maus verschieben oder ihre Größe ändern, indem Sie an einem der runden Greifer an ihren Ecken ziehen.

**Hinweis:** In manchen Arten von AutoFormen werden zusätzliche gelbe Greifer angezeigt, wenn diese selektiert sind. Ziehen Sie an einem dieser Greifer, ändert die AutoForm bestimmte Parameter ihres Aussehens. Bei Sternen lässt sich auf diese Weise beispielsweise die Länge der Zacken ändern.

**Tipp:** Sie können sogar Text innerhalb einer AutoForm eingeben – genau wie bei einem Textrahmen. Informationen dazu finden Sie im Abschnitt [Text zu AutoFormen hinzufügen](#).

### TextArt

Mit dem Werkzeug \( \text{TextArt} \) können Sie TextArt-Objekte einfügen. Das sind Schriftzüge, die mit diversen Effekten versehen werden können.
Wenn Sie dieses Werkzeug aktivieren, erscheint ein Dialog. Geben Sie darin den Text ein und klicken Sie auf **Varianten**, um einen der vorgefertigten Effekte auszuwählen. Bestätigen Sie dann mit **OK**.

---

**Text zu AutoFormen hinzufügen**

Sie können AutoFormen auf Wunsch Text hinzufügen. Dieser Text wird dann innerhalb der AutoForm angezeigt – genau wie bei einem Textrahmen.

Gehen Sie dazu wie folgt vor:

1. Seletzieren Sie die gewünschte AutoForm.
2. Rechtsklicken Sie auf die AutoForm, um ihr Kontextmenü aufzurufen.
3. Wählen Sie darin den Befehl **Text hinzufügen**.

Nun blinkt die Schreibmarke in der AutoForm; Sie können jetzt also Text eingeben.

**Tipp:** Es gibt noch einen schnelleren Weg, Text zu einer AutoForm hinzuzufügen: Seletzieren Sie die AutoForm dazu und beginnen Sie dann einfach mit dem Tippen.

Wenn Sie mit der Eingabe fertig sind, klicken Sie auf eine beliebige Stelle außerhalb des Objekts. Möchten Sie den Text später noch einmal bearbeiten, selektieren Sie die AutoForm erneut und wählen den Befehl **Text bearbeiten** aus dem Kontextmenü.

**Wichtig:** Wenn TextMaker am unteren Rand des Textes einen roten Balken anzeigt, zeigt dies an, dass der Text nicht vollständig in den zur Verfügung stehenden Platz passt. Vergrößern Sie in diesem Falle also das Objekt oder verringern Sie die Textmenge.

**Hinweis:** Die weiter vorne in diesem Kapitel vorgestellten Textrahmen sind übrigens nichts anderes als AutoFormen (in diesem Falle einfache Rechtecke), denen Text hinzugefügt wurde. Alle Informationen im Abschnitt *Textrahmen* gelten also im gleichen Maße auch für AutoFormen, denen Text hinzugefügt wurde.

---

**Eigenschaften von Zeichnungen ändern**

Um die Eigenschaften einer Zeichnung zu bearbeiten, selektieren Sie diese zunächst per Mausklick. Dann rufen Sie den Menübefehl **Objekt > Eigenschaften** auf, worauf ein entsprechender Dialog erscheint.

**Tipp:** Sie können diesen Dialog auch über einen Doppelklick auf die Zeichnung aufrufen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

**Karteikarten Layout, Format, Füllung etc.**

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgender Einstellungen:
- **Layout**: Auf dieser Karteikarte können Sie Position und Außenränder ändern und bestimmen, wie der Fließtext die Zeichnung umfließen soll. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Layout*.

- **Format**: Hier können Sie die Größe der Zeichnung ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Format*.

- **Füllung**: Hier können Sie die Füllung ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Füllung*.

- **Linien**: Hier können Sie den Linienstil der Linien, mit denen das Objekt gezeichnet wird, ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Linien*.

- **Schatten**: Hier können Sie einen Schatten anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Schatten*.

- **3D**: Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte 3D*.

- **Effekte**: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Effekte*.

- **Eigenschaften**: Hier können Sie allgemeine Einstellungen ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Eigenschaften*.

Weiterhin erscheinen bei einigen Arten von Zeichnungen zusätzliche Karteikarten mit weiteren Optionen (siehe nachfolgende Seiten).

---

**Karteikarte AutoFormen (nur bei AutoFormen)**

Diese Karteikarte erscheint nur bei AutoFormen.

Auf der Karteikarte **AutoFormen** können Sie dem Objekt eine andere AutoForm zuweisen, also beispielsweise aus einem Rechteck eine Sprechblase oder eine beliebige andere Form machen.

Wählen Sie dazu einfach die gewünschte AutoForm aus.

Ausführliche Informationen zu AutoFormen finden Sie im Abschnitt *Zeichnungen einfügen*.

---

**Karteikarte Innentext (bei AutoFormen, denen Text hinzugefügt wurde)**

Diese Karteikarte erscheint nur bei AutoFormen, denen Text hinzugefügt wurde (siehe Abschnitt *Text zu AutoFormen hinzufügen*) und bei *Textrahmen*.

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern.

Verfügbare Optionen:

- **Rubrik Innenränder**

  Hier können Sie die Innenränder für den Text ändern. Schalten Sie die Option *Automatisch* ein, ermittelt das Programm automatisch geeignete Ränder.

- **Rubrik Überlappende Objekte**

  Diese Einstellung bestimmt, was passieren soll, wenn sich das Objekt mit einem anderen Objekt überlapt.
Bei der Standardeinstellung **Objekt ignorieren** greift TextMaker nicht ein. In dem sich überlappenden Bereich wird also der Inhalt beider Objekte übereinander gedruckt.

Wählen Sie hingegen die Option **Text umbrechen**, wird der in diesem Objekt enthaltene Text automatisch neu umbrochen, so dass er die Überlappung umfließt.

- **Rubrik Drehen um...**
  
  Hier können Sie den Text um den angegebenen Winkel drehen.

- **Rubrik Vertikale Ausrichtung**
  
  Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Unterkante der Zeichnung ausgerichtet werden soll:

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oben</td>
<td>Der Text wird an der Oberkante des Objekts ausgerichtet. (Dies ist die Standardeinstellung.)</td>
</tr>
<tr>
<td>Zentriert</td>
<td>Der Text wird zwischen Ober- und Unterkante zentriert.</td>
</tr>
<tr>
<td>Unten</td>
<td>Der Text wird an der Unterkante des Objekts ausgerichtet.</td>
</tr>
<tr>
<td>Blockszr</td>
<td>Der Abstand zwischen den Textzeilen wird gleichmäßig so erweitert, dass der Text genau an der Oberkante des Objekts beginnt und genau an der Unterkante endet.</td>
</tr>
</tbody>
</table>

**Karteikarte Text (nur bei TextArt-Objekten)**

Diese Karteikarte erscheint nur bei TextArt-Objekten.

Sie können darin den gewünschten Effekt auswählen sowie den anzuzeigenden Text eingeben und formatieren.

Verfügbare Optionen:

- **Text**
  
  Hier können Sie den Text eintippen, der angezeigt werden soll.

- **Varianten**
  
  In dieser Liste können Sie auswählen, mit welchem Effekt der Text dargestellt werden soll.

- **Rubrik Schrift**
  
  Hier können Sie die Schriftart ändern und die Textauszeichnungen **Fett** und **Kursiv** ein-/ausschalten.

  Aktivieren Sie die Option **Gleiche Höhe**, werden alle Buchstaben (inklusive Kleinbuchstaben) auf eine einheitliche Höhe gestreckt.

- **Rubrik Abstände**
  
  Die Option **Zeichen** ändert den Abstand zwischen den Zeichen. Bei Werten kleiner als 100% sind die Zeichen enger zusammen, bei Werten größer als 100% weiter auseinander.

  Die Option **Zeilen** ändert den Zeilenabstand. Dies wirkt sich nur auf Text aus, der aus mehreren Zeilen besteht.
■ **Rubrik Ausrichtung**

Hier können Sie die Ausrichtung des Textes ändern. Dies wirkt sich nur auf Text aus, der aus mehreren Zeilen besteht.

■ **Rubrik Platzierung**

Aktivieren Sie die Option **Vertikaler Text**, werden die Buchstaben des Textes um 90° gedreht.

---

**Karteikarte Deformation (nur bei TextArt-Objekten)**

Diese Karteikarte erscheint nur bei TextArt-Objekten.

Sie können darauf festlegen, mit welcher Art von Verzerrung der Text dargestellt werden soll. Wählen Sie dazu die gewünschte Art von Deformation aus der Liste.
Formulare

Formulare sind Dokumente "zum Ausfüllen".

Sie können mit TextMaker beispielsweise ein Formular für Urlaubsanträge anfertigen. Wenn dann einer Ihrer Mitarbeiter Urlaub beantragen möchte, öffnet er einfach dieses vorgefertigte Formular, trägt Name, Urlaubsanfang, Urlaubsende ein und druckt das Formular aus. Schon hat er einen komplett ausgefüllten Urlaubsantrag zum Abgeben.


In diesem Kapitel erfahren Sie, wie man mit Formularen arbeitet:

- **Formulare ausfüllen**
  Im ersten Abschnitt wird erläutert, wie beim Ausfüllen fertiger Formulare vorzugehen ist.

- **Formulare erstellen**
  Im nächsten Abschnitt erfahren Sie, wie Sie eigene Formulare erstellen.
Sie fügen dazu an allen Stellen, die später ausgefüllt werden sollen, Formulare ein: zum Beispiel Textfelder und Textrahmen für Texteingaben, Kontrollkästchen zum Ankreuzen und Auswahllisten zum Auswählen eines Eintrags aus mehreren vorgegebenen.

- **Formularobjekte im Detail**

  In diesem Abschnitt werden die verfügbaren Arten von Formularobjekten im Detail vorgestellt.

- **Formulare – fortgeschrittene Funktionen**

  Zum Schluss lernen Sie einige Funktionen für fortgeschrittene Anwender kennen: Ändern der Tab-Reihenfolge, Formulare vor Änderungen schützen und Berechnungen anstellen.

### Formulare ausfüllen

Widmen wir uns zunächst dem Ausfüllen fertiger Formulare. Das Erstellen eigener Formulare wird anschließend (im Abschnitt Formulare erstellen) beschrieben.

Formulare unterscheiden sich von anderen Dokumenten nur in einem einzigen Punkt: An den Stellen, die ausgefüllt werden sollen, enthalten sie Formularobjekte.

Im Folgenden erfahren Sie, welche Arten von ausfüllbaren Formularobjekten es gibt und wie diese auszufüllen sind:

- **Textfelder und Textrahmen** (zum Eingeben von Text)

  Um Textfelder oder -rahmen auszufüllen, setzen Sie einfach die Schreibmarke hinein und tippen den gewünschten Text ein.
Formulare

- **Auswahllisten und Auswahllistenrahmen** (für Auswahlmenüs)
  Klicken Sie auf eine Auswahlliste, wird diese geöffnet. Nun können Sie per Mausklick einen der Einträge auswählen.

- **Kontrollkästchen und Kontrollkästchenrahmen** (zum Ankreuzen)
  Klicken Sie das Kästchen mit der Maus an, wird es mit einem Häkchen versehen, also angekreuzt. Klicken Sie es erneut an, wird das Häkchen wieder entfernt.

**Bewegen der Schreibmarke in Formularen**

In Formularen können Sie die Schreibmarke wie folgt bewegen:

- Sie können die Schreibmarke wie gewohnt mit den Richtungstasten oder per Mausklick an die gewünschte Stelle setzen.
- Mit der Taste Strg+F11 können Sie zum nächsten, mit Strg+Umschalt+F11 zum vorherigen Formularobjekt springen.
- Im Formularmodus (siehe unten) lässt sich die Schreibmarke nur noch zwischen ausfüllbaren Formularobjekten bewegen. Weiterhin können Sie darin die Tabulator-taste Tab verwenden, um zwischen den Formularobjekten hin- und herzuspringen.

**Der Formularmodus**

Es empfiehlt sich, zum Ausfüllen von Formularen stets den Formularmodus zu aktivieren. Dieser erleichtert Ihnen die Arbeit erheblich.

Der Formularmodus lässt sich mit dem Menübefehl Ansicht > Formularmodus ein- und ausschalten.

Ob der Formularmodus momentan aktiv ist, erkennen Sie auch an der Titelleiste: Wird dort hinter dem Namen des Dokuments "(Formularmodus)" angezeigt, so ist dieser eingeschaltet.

Im Formularmodus ändert sich das Verhalten von TextMaker wie folgt:

- Sie können die Tabulator-taste Tab verwenden, um von einem Formularobjekt zum nächsten zu springen: Tab springt zum nächsten und Umschalt+Tab zum vorherigen Objekt.
- Es lassen sich nur noch Formularobjekte ausfüllen, der normale Text ist nicht mehr editierbar.
- Die meisten Menübefehle sind "ausgegraut", also nicht mehr verfügbar. Damit soll verhindert werden, dass die Bestandteile des Formulars, die nicht ausgefüllt werden sollen, verändert werden können.

Im Formularmodus lassen sich Formulare also so bequem ausfüllen, wie Sie es von der Eingabemaske eines Datenbankprogramms her kennen.

**Hinweis:** Wenn Sie ein Dokument öffnen, das zuletzt im Formularmodus gespeichert wurde, aktiviert dieses selbsttätig wieder den Formularmodus.

**Wenn sich der Formularmodus nicht abschalten lässt**

Bei manchen Formularen hat der Autor das Deaktivieren des Formularmodus mit einem Kennwort gesperrt. Damit soll verhindert werden, dass Unbefugte die Bestandteile des Formulars abändern, die nicht auszufüllen sind.
Wenn Sie also beim Versuch, den Formularmodus auszuschalten, nach einem Kennwort gefragt werden, ist dieses Formular geschützt. Sie können den Formularmodus dann nur durch Eingabe des korrekten Kennworts deaktivieren.

**Formulare erstellen**

Um ein Formular zu erstellen, legen Sie einfach ein ganz normales Dokument an und fügen an den Stellen, die später ausgefüllt werden sollen, *Formularobjekte* ein.

Alle weiteren Informationen zum Erstellen von Formularen finden Sie auf den nächsten Seiten. Folgende Themen werden darin behandelt:

- Arten von Formularobjekten
- Formularobjekte einfügen
- Formularobjekte bearbeiten
- Beispielformular anfertigen

Lesen Sie dazu die nächsten Seiten.

**Arten von Formularobjekten**

 Folgende Arten von Formularobjekten können in Formularen verwendet werden:

<table>
<thead>
<tr>
<th>Formularobjekt</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Textfelder</td>
<td>Textfelder sind für Freitext wie &quot;Name&quot;, &quot;Straße&quot; etc. gedacht. Der Anwender, der das Formular ausfüllt, kann darin beliebigen Text eingeben.</td>
</tr>
<tr>
<td>Textrahmen</td>
<td>Entsprechen Textfeldern, sind jedoch in einem Rahmen untergebracht (siehe unten).</td>
</tr>
<tr>
<td>Kontrollkästchen</td>
<td>Kontrollkästchen eignen sich für Ja/Nein-Angaben. Klickt der Anwender auf ein Kontrollkästchen, wird dieses angekreuzt. Klickt er es erneut an, wird das Kreuz wieder entfernt.</td>
</tr>
<tr>
<td>Kontrollkästchenrahmen</td>
<td>Entsprechen Kontrollkästchen, sind jedoch in einem Rahmen untergebracht (siehe unten).</td>
</tr>
<tr>
<td>Auswahllisten</td>
<td>Klickt der Anwender auf eine Auswahlliste, wird diese geöffnet und er kann einen der vorgegebenen Listeneinträge auswählen. Eingaben von Hand sind nicht möglich.</td>
</tr>
<tr>
<td>Auswahllistenrahmen</td>
<td>Entsprechen Auswahllisten, sind jedoch in einem Rahmen untergebracht (siehe unten).</td>
</tr>
</tbody>
</table>

Darüber hinaus gibt es zwei Arten von Formularobjekten, die sich *nicht* ausfüllen lassen, sondern nur für das Anbringen von Beschriftungen gedacht sind:
**Bezeichnungen**

In Bezeichnungen kann eine beliebige Beschriftung eingegeben werden, die im Formular angezeigt werden soll.

**Gruppenfelder**

Gruppenfelder sind Rechtecke, die sich links oben mit einer Beschriftung versehen lassen. Sie können dazu verwendet werden, zusammengehörende Teile eines Formulars optisch zu einer Gruppe zusammenzufassen.

Naturally können Formulare, neben obigen Formularobjekten, auch alle anderen Arten von Objekten und gewöhnlichen Text enthalten.

Ausführliche Informationen zu den einzelnen Arten von Formularobjekten können Sie in den Abschnitten **Textfelder** und folgende nachlesen.

---

**Mit oder ohne Rahmen?**

Wie Sie vielleicht bemerkt haben, können die meisten Formularobjekte *mit* oder *ohne* Rahmen eingefügt werden können:

- Textfelder und Textrahmen
- Kontrollkästchen und Kontrollkästchenrahmen
- Auswahllisten und Auswahllistenrahmen

Der Unterschied zwischen normalen Objekten und Objektrahmen:


**Objekte in einem Rahmen** (z.B. Auswahllistenrahmen) sind hingegen frei auf der Seite positionierbar. Sie können jederzeit mit der Maus verschoben werden, behalten danach aber ihre feste Position auf der Seite – auch wenn Sie oberhalb des Rahmens Text einfügen oder löschen.

---

**Formularobjekte einfügen**

Um ein Formularobjekt in den Text einzufügen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Objekt > Neues Formularobjekt** auf.
2. Es öffnet sich ein Untermenü. Wählen Sie darin die gewünschte Art von Objekt.

Das Objekt wird nun eingefügt.

Ausführliche Informationen zu den einzelnen Arten von Formularobjekten können Sie in den Abschnitten **Textfelder** und folgende nachlesen.

---

**Formularleiste verwenden**

Sie können zum Einfügen von Formularobjekten auch die **Formularleiste** verwenden. Um diese ein-/auszuschalten, rufen Sie den Menübefehl **Ansicht > Symbolleisten** auf und klicken auf das Kästchen vor **Formular**.
Die Formularleiste enthält folgende Symbole (von links nach rechts):

- Textfeld einfügen
- Kontrollkästchen einfügen
- Auswahlliste einfügen
- Textrahmen einfügen
- Kontrollkästchenrahmen einfügen
- Auswahllistenrahmen einfügen
- Bezeichnung einfügen
- Gruppenfeld einfügen
- Formularfelder schattieren ein/aus (hebt alle Textfelder, Kontrollkästchen und Auswahllisten im Text mit einer grauen Schattierung hervor)
- Formularmodus ein/aus (entspricht dem Menübefehl Ansicht > Formularmodus)

Formularobjekte bearbeiten

Formularobjekte können wie alle anderen Arten von Objekten per Mausklick selektiert und dann bearbeitet werden. Sie können sie löschen, verschieben, kopieren, mit dem Menübefehl Objekt > Eigenschaften ihre Eigenschaften ändern etc.

_Tipp:_ Mit dem Menübefehl Objekt > Tab-Reihenfolge können Sie außerdem festlegen, in welcher Reihenfolge die Formularobjekte angesprungen werden, wenn der Anwender im Formularmodus die Tabulator-taste **Tab** drückt (siehe Abschnitt Tab-Reihenfolge ändern).

Allgemeine Informationen zum Arbeiten mit Objekten können Sie dem Kapitel Rahmen und Zeichnungen entnehmen.

Beispielformular anfertigen

Beginnen Sie als Erstes mit dem Menübefehl **Datei > Neu** ein neues Dokument. Dann gehen Sie wie folgt vor:

### Textfelder für freie Texteingaben

Die erste Zeile des Formulars soll ein Textfeld zur Eingabe des Namens enthalten. Am besten geben Sie dazu erst links eine Beschreibung an, was in dieses Feld einzutragen ist – zum Beispiel "Name:". Rechts davon fügen Sie dann das Textfeld ein.

Gehen Sie also wie folgt vor:

1. Tippen Sie "Name:" und fügen Sie anschließend mit der Tabulatortaste **Tab** einen Tabulator ein.
2. Fügen Sie mit dem Menübefehl **Objekt > Neues Formularobjekt > Textfeld** ein Textfeld ein.
3. Die Schreibmarke befindet sich jetzt in dem Textfeld. Drücken Sie →, um es zu verlassen.
4. Betätigen Sie zweimal die **Eingabetaste ↓**.


### Auswahllisten

Als nächstes soll unterhalb der drei Textfelder eine **Auswahlliste** eingefügt werden. Auswahllisten dienen zur Auswahl einer von mehreren Alternativen.

Gehen Sie wie folgt vor:

1. Tippen Sie "Geschlecht:" und drücken Sie dann **Tab**.
2. Rufen Sie den Menübefehl **Objekt > Neues Formularobjekt > Auswahlliste** auf.

4. Verlassen Sie den Dialog mit OK.

5. Drücken Sie zweimal die Eingabetaste.

**Kontrollkästchen für Ja/Nein-Angaben**

Als letztes soll ein Kontrollkästchen eingefügt werden. Kontrollkästchen können für Ja/Nein-Angaben verwendet werden. Wird das Kästchen angekreuzt, bedeutet dies "Ja". Ist es nicht angekreuzt, heißt das "Nein". Fügen wir also ein Kontrollkästchen hinzu, das nur dann angekreuzt werden soll, wenn der Kunde Neukunde ist:

1. Tippen Sie "Neukunde?" und drücken Sie dann Tab.
2. Rufen Sie den Menübefehl Objekt > Neues Formularobjekt > Kontrollkästchen auf.
4. Verlassen Sie den Dialog mit OK.
5. Betätigen Sie zweimal die Eingabetaste.

Damit die Formularobjekte bündig untereinander stehen, sollten Sie die eingegebenen Zeilen nun noch allesamt markieren und mit dem Menübefehl Format > Tabulator einen geeigneten Tabulator setzen – zum Beispiel bei 3 cm.

Damit ist unser Formular auch schon fertig.

Formularobjekte im Detail

In diesem Abschnitt stellen wir Ihnen die einzelnen Arten von Formularobjekten im Detail vor. Folgende Objekte werden darin behandelt:

- Textfelder
- Textrahmen
- Kontrollkästchen
- Kontrollkästchenrahmen
- Auswahllisten
- Auswahllistenrahmen
- Bezeichnungen und Gruppenfelder

Textfelder

Mit dem Menübefehl **Objekt > Neues Formularobjekt > Textfeld** fügen Sie ein Textfeld ein. Textfelder sind häufig in Formularen zu finden. Sie erlauben die Eingabe von Freitext, eignen sich also zum Beispiel für Angaben wie Name, Straße, Ort etc.

Bedienung von Textfeldern

Um ein Textfeld auszufüllen, setzen Sie per Mausklick die Schreibmarke hinein und geben den Text ein.

Eigenschaften von Textfeldern ändern

Wenn Sie die Schreibmarke in ein Textfeld setzen oder das Textfeld im Objektmodus per Mausklick selektieren und dann den Menübefehl **Objekt > Eigenschaften** aufrufen, können Sie die Eigenschaften dieses Textfelds verändern. Zu den Eigenschaften zählen Größe, Ränder und zahlreiche andere Einstellmöglichkeiten.

Es gibt folgende Eigenschaften:

**Karteikarte Format**

Auf dieser Karteikarte können Sie das Format des Textfelds ändern:
Rubrik **Größe**

Hier lässt sich die **Größe** des Textfelds ändern.

Sie können die Breite und Höhe entweder genau festlegen oder das Textfeld automatisch wachsen lassen, sobald der Platz für den enthaltenen Text nicht mehr ausreicht. Wählen Sie dazu bei **Breite** beziehungsweise **Höhe** die Option **Wachsend** und geben Sie das gewünschte Minimum und Maximum an.

Rubrik **Vertikale Ausrichtung**

Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Unterkante des Textfelds ausgerichtet werden soll:

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oben</td>
<td>Der Text wird an der Oberkante des Textfelds ausgerichtet. (Dies ist die Standardeinstellung.)</td>
</tr>
<tr>
<td>Zentriert</td>
<td>Der Text wird zwischen Ober- und Unterkante zentriert.</td>
</tr>
<tr>
<td>Unten</td>
<td>Der Text wird an der Unterkante des Textfelds ausgerichtet.</td>
</tr>
<tr>
<td>Blocksat</td>
<td>Der Abstand zwischen den Textzeilen wird gleichmäßig so erweitert, dass der Text genau an der Oberkante des Textfelds beginnt und genau an der Unterkante endet.</td>
</tr>
</tbody>
</table>

**Karteikarte Ränder**

Auf dieser Karteikarte können Sie die Ränder des Textfelds ändern:

- **Rubrik Außenränder**
  
  Hier lassen sich die Außenränder ändern.

- **Rubrik Innenränder**
  
  Hier lassen sich die Innenränder ändern.

**Karteikarte Eigenschaften**

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe dazu Abschnitt **Objekt-Eigenschaften, Karteikarte Eigenschaften**.

**Karteikarte Umrandung**

Mit dieser Karteikarte können Sie das Textfeld mit einer Umrandung oder einzelnen Linien versehen.

Die Bedienelemente auf dieser Karteikarte entsprechen denen des Menübefehls **Format > Umrandung** (siehe Abschnitt **Umrandung und Linien**).

**Karteikarte Schattierung**

Mit dieser Karteikarte können Sie das Textfeld mit einer Schattierung aus einer Farbe oder einem Muster versehen.

Die Bedienelemente auf dieser Karteikarte entsprechen denen des Menübefehls **Format > Schattierung** (siehe Abschnitt **Schattierung**).
**Textrahmen**

Mit dem Menübefehl **Objekt > Neuer Textrahmen** fügen Sie einen Textrahmen ein.

Die Bedienung beim Ausfüllen entspricht der von Textfeldern (siehe vorheriger Abschnitt): einfach die Schreibmarke hineinsetzten und lostippen.

Der Unterschied zu Textfeldern: Wie alle Arten von Rahmen hat auch ein Textrahmen eine feste Position auf der Seite. Er verschiebt sich also nicht, wenn Sie oberhalb des Rahmens Text einfügen oder löschen. Der normale Fließtext wird dabei automatisch um die Begrenzungslinien des Rahmens herum umbrochen – er "umfließt" den Rahmen.

Informationen zu Textfeldern können Sie dem vorherigen Abschnitt entnehmen. Alle weiteren Informationen zu Textrahmen finden Sie im Abschnitt **Textrahmen**.

---

**Kontrollkästchen**

Mit dem Menübefehl **Objekt > Neues Formulareobjekt > Kontrollkästchen** fügen Sie ein Kontrollkästchen ein.

Kontrollkästchen können in Formularen für Ja/Nein-Angaben verwendet werden. Wird das Kästchen angekreuzt, steht das für **Ja**; wird es nicht angekreuzt, bedeutet das **Nein**.

**Bedienung von Kontrollkästchen**


**Eigenschaften von Kontrollkästchen ändern**

Wenn Sie ein Kontrollkästchen per Mausklick selektieren und den Menübefehl **Objekt > Eigenschaften** aufrufen, können Sie die Eigenschaften dieses Objekts verändern.

Es gibt folgende Eigenschaften:

**Karteikarte Layout**

Nur bei Kontrollkästchenrahmen verfügbar.

Auf dieser Karteikarte können Sie unter anderem Position und Außenränder des Objekts ändern. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.
**Karteikarte Format**

Nur bei Kontrollkästchenrahmen verfügbar.

Auf dieser Karteikarte können Sie die Größe des Objekts ändern. Siehe Abschnitt [Objekt-Eigenschaften](#).

**Karteikarte Eigenschaften**

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt [Objekt-Eigenschaften](#).

**Karteikarte Formularelement**

Auf dieser Karteikarte können Sie Einstellungen zu dem Kontrollkästchen selbst vornehmen:

- **Text**
  
  Hier können Sie den Text angeben, der rechts neben dem Kästchen angezeigt werden soll.

- **Rubrik Wert**
  
  Hier können Sie festlegen, ob das Kästchen angekreuzt sein soll oder nicht. Entspricht dem Ankreuzen des Kästchens direkt im Dokument.

- **3D-Effekt**
  
  Schalten Sie diese Option ein, wird das Kästchen mit einem 3D-Effekt gezeichnet.

Bei Kontrollkästchenrahmen können Sie zusätzlich noch das Zeichenformat (Schriftart, -größe, -farbe etc.) des Textes festlegen.

**Kontrollkästchenrahmen**

Mit dem Menübefehl **Objekt > Neues Formularobjekt > Kontrollkästchenrahmen** fügen Sie einen Kontrollkästchenrahmen ein.

Bedeutung und Funktionsweise entsprechen der von Kontrollkästchen (siehe vorheriger Abschnitt).

**Der Unterschied:** Wie alle Arten von Rahmen hat auch ein Kontrollkästchenrahmen eine feste Position auf der Seite. Er verschiebt sich also nicht, wenn Sie oberhalb des Rahmens Text einfügen oder löschen. Der normale Fließtext wird dabei automatisch um die Begrenzungslinien des Rahmens herum umbrochen – er "umfließt" den Rahmen.

**Auswahllisten**

Mit dem Menübefehl **Objekt > Neues Formularobjekt > Auswahlliste** fügen Sie eine aufklappbare Auswahlliste ein.

**Bedienung von Auswahllisten**

Klicken Sie das Pfeilchen rechts der Liste an, um die Liste zu öffnen. Nun können Sie einen Eintrag auswählen, indem sie ihn anklicken.

**Eigenschaften von Auswahllisten ändern**

Wenn Sie eine Auswahlliste per Mausklick selektieren und den Menübefehl **Objekt > Eigenschaften** aufrufen, können Sie die Eigenschaften dieses Objekts verändern.

Es gibt folgende Eigenschaften:

**Karteikarte Layout**

Nur bei Auswahllistenrahmen verfügbar.

Auf dieser Karteikarte können Sie unter anderem Position und Außenränder des Objekts ändern. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Layout**.

**Karteikarte Format**

Nur bei Auswahllistenrahmen verfügbar.

Auf dieser Karteikarte können Sie die Größe des Objekts ändern. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Format**.

**Karteikarte Eigenschaften**

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt **Objekt-Eigenschaften, Karteikarte Eigenschaften**.

**Karteikarte Formularelement**

Auf dieser Karteikarte können Sie Einstellungen zu der Auswahlliste selbst vornehmen:

- **Rubrik Listeneinträge**

  Hier bestimmen Sie, welche Einträge in der Auswahlliste erscheinen sollen. Gehen Sie dazu folgendermaßen vor:

  **Eintrag hinzufügen**: Geben Sie den Eintrag in das Eingabefeld **Neuer Eintrag** ein und drücken Sie die Eingabetaste oder klicken Sie auf die Schaltfläche **Hinzufügen**.

  **Eintrag entfernen**: Selektieren Sie den Eintrag in der Liste der Einträge und klicken Sie auf die Schaltfläche **Entfernen**.
Eintrag ändern: Entfernen Sie den Eintrag und fügen Sie ihn neu hinzu.

Reihenfolge ändern: Selektieren Sie einen der Einträge in der Liste und klicken Sie auf die Pfeilchen rechts der Liste, um den Eintrag nach oben oder nach unten zu verschieben.

- **Zeilen (max.)**
  

- **Zusätzliche Innenränder verwenden**
  
  Nur bei Auswahllisten verfügbar. Normalerweise macht TextMaker Auswahlmenüs genau so groß, dass der enthaltene Text gerade hineinpasst. Schalten Sie diese Option ein, fügt er kleine Innenränder hinzu. Das Objekt wird dazu automatisch etwas vergrößert.

- **3D-Effekt**
  
  Schalten Sie diese Option ein, wird die Liste mit einem 3D-Effekt gezeichnet.

Bei Auswahlmenürahmen können Sie zusätzlich noch das Zeichenformat (Schriftart, -größe, -farbe etc.) für die Listeneinträge festlegen.

---

**Auswahlmenürahmen**

Mit dem Menübefehl **Objekt > Neues Formularobjekt > Auswahlmenürahmen** fügen Sie einen Auswahlmenürahmen ein.

Bedienung und Funktionsweise entsprechen der von Auswahllisten (siehe [vorheriger Abschnitt](#)).

**Der Unterschied:** Wie alle Arten von Rahmen hat auch ein Auswahlmenürahmen eine feste Position auf der Seite. Er verschiebt sich also nicht, wenn Sie oberhalb des Rahmens Text einfügen oder löschen. Der normale Fließtext wird dabei automatisch um die Begrenzungsflächen des Rahmens herum umbrochen – er "umfließt" den Rahmen.

---

**Bezeichnungen und Gruppenfelder**

Neben den zuvor beschriebenen Formularobjekten gibt es zusätzlich zwei Arten von Formularobjekten, die sich *nicht* ausfüllen lassen, sondern lediglich für das Anbringen von Beschriftungen gedacht sind:

- **Bezeichnungen**

  In **Bezeichnungen** kann eine beliebige Beschriftung eingegeben werden, die im Formular angezeigt werden soll.

- **Gruppenfelder**

  **Gruppenfelder** sind Rechtecke, die sich links oben mit einer Beschriftung versehen lassen. Sie können dazu verwendet werden, zusammengehörige Teile eines Formulars optisch abzusäumen.

Um eine Bezeichnung oder ein Gruppenfeld einzufügen, rufen Sie den Menübefehl **Objekt > Neues Formularobjekt > Bezeichnung** beziehungsweise **Objekt > Neues Formularobjekt > Gruppenfeld** auf.
Das entsprechende Formularobjekt wird daraufhin eingefügt. Verschieben Sie es nun mit der Maus an die gewünschte Position. Um seine Größe zu ändern, ziehen Sie an einem der runden Greifer, die das Objekt umgeben.

**Bedienung von Bezeichnungen und Gruppenfeldern**

Im Gegensatz zu allen anderen Formularobjekten lassen sich Bezeichnungen und Gruppenfelder *nicht* ausfüllen. Sie können lediglich dazu verwendet werden, dem Formular (unveränderbare) Beschrifungen hinzuzufügen.

**Eigenschaften von Bezeichnungen und Gruppenfeldern ändern**

Wenn Sie eine Bezeichnung oder ein Gruppenfeld per Mausklick selektieren und den Menübefehl *Objekt > Eigenschaften* aufrufen, können Sie die Eigenschaften dieses Objekts verändern.

Es gibt folgende Eigenschaften:

**Karteikarte Layout**


**Karteikarte Format**

Auf dieser Karteikarte können Sie die Größe des Objekts ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Format*.

**Karteikarte Eigenschaften**

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt *Objekt-Eigenschaften, Karteikarte Eigenschaften*.

**Karteikarte Formularelement**

Auf dieser Karteikarte können Sie Einstellungen zu dem Text vornehmen, den die Bezeichnung beziehungsweise das Gruppenfeld anzeigen soll:

- **Rubrik Text**
  
  Hier geben Sie den anzuzeigenden Text ein.

- **3D-Effekt**
  

Weiterhin können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text festlegen.
Formulare – fortgeschrittene Funktionen

Zum Abschluss des Kapitels über Formulare sehen wir uns noch einige Formularfunktionen für fortgeschrittene Anwender an:

- Tab-Reihenfolge ändern
- Inhalt von Formularobjekten schützen
- Formulare schützen
- Berechnungen mit Formularobjekten

Lesen Sie dazu die nächsten Seiten.

Tab-Reihenfolge ändern


Im Formularmodus können Sie dazu alternativ auch die Tasten Tab und Umschalt+Tab verwenden.

Die Reihenfolge, in der die Formularobjekte dabei angesprungen werden, lässt sich mit dem Menübefehl Objekt > Tab-Reihenfolge ändern.

Rufen Sie den Befehl dazu auf und selektieren Sie in der Liste Objekte das Formularobjekt, dessen Position in der Tab-Reihenfolge verändert werden soll. Klicken Sie dann auf eine der Pfeiltasten, um das Objekt nach oben oder unten zu verschieben. Die Position des Objekts in der Tab-Reihenfolge ändert sich entsprechend.

Inhalt von Formularobjekten schützen

In bestimmten Situationen möchte man in Formularen auch Formularobjekte verwenden, die im Formularmodus nicht änderbar sein sollen – zum Beispiel Textrahmen mit Erläuterungen.

Dies lässt sich durch Aktivieren der Option Text sperren in den Objekteigenschaften verwirklichen. Wenn diese aktiviert ist, lässt sich der Inhalt des Objekts im Formularmodus nicht mehr abändern. Weiterhin kann das Objekt im Formularmodus nicht mehr angeklickt werden und auch das Anspringen mit der Tabulatortaste Tab funktioniert nicht mehr.

Um den Inhalt eines Formularobjekts zu schützen, gehen Sie also wie folgt vor:

1. Falls momentan der Formularmodus aktiv ist, verlassen Sie diesen mit dem Menübefehl Ansicht > Formularmodus.
2. Selektieren Sie das Objekt, das Sie schützen möchten, per Mausklick.
3. Rufen Sie den Menübefehl Objekt > Eigenschaften auf.
4. Wechseln Sie auf die Karteikarte Eigenschaften.
5. Schalten Sie dort die Option Text sperren ein.
6. Bestätigen Sie mit OK.

Der Inhalt dieses Objekts ist nun geschützt.

**Besonderheiten bei Tabellen**

Bei Tabellen können Sie sogar für jede einzelne Tabellenzelle festlegen, ob deren Inhalt im Formularmodus gegen Änderungen geschützt werden soll. Selektieren Sie dazu die gewünschten Zellen, rufen Sie den Menübefehl Tabelle > Zelleneigenschaften auf und schalten Sie auf der Karteikarte Format die Option Text sperren ein.

Der Inhalt dieser Zellen lässt sich fortan im Formularmodus nicht mehr bearbeiten. Außerdem werden die Zellen beim Drücken der Tabulatorstaste Tab übersprungen.

Natürlich können Sie auch komplette Tabellen schützen. Selektieren Sie dazu einfach die gesamte Tabelle und verfahren Sie dann wie oben beschrieben.

---

**Formulare schützen**

Bevor Sie ein fertig gestaltetes Formular zum Einsatz bringen, sollten Sie es gegen Veränderungen schützen. Schließlich soll sich das Formular selbst ja nicht mehr verändern lassen, sondern nur noch die auszufüllenden Formularobjekte.

Zum Schützen eines Formulars haben Sie folgende Möglichkeiten:

**Verwenden des Formularmodus**

Wenn Sie den im Abschnitt Formulare ausfüllen vorgestellten Formularmodus aktivieren, können nur noch Formularobjekte ausgefüllt werden. Die anderen Bestandteile des Dokuments lassen sich dann nicht mehr editieren, und die meisten TextMaker-Befehle sind nicht mehr verfügbar.

Der Formularmodus lässt sich mit dem Menübefehl Ansicht > Formularmodus ein- und ausschalten.

Hinweis: Beachten Sie, dass der Anwender, der das Formular ausfüllt, den Formularmodus jederzeit wieder ausschalten kann. Sie können dieses allerdings verhindern, indem Sie den Formularmodus mit einem Kennwort verriegeln (siehe unten).

**Speichern des Formulars im Formularmodus**

Tipp: Wenn Sie ein Dokument im Formularmodus speichern, wird beim nächsten Öffnen dieses Dokuments automatisch wieder der Formularmodus aktiviert.

**Den Formularmodus mit einem Kennwort verriegeln**

Sie können bei Bedarf verhindern, dass andere Anwender den Formularmodus ausschalten, indem Sie ihn mit einem Kennwort verriegeln.
Rufen Sie dazu den Menübefehl **Datei > Eigenschaften** auf und wechseln Sie auf die Karteikarte **Formular**. Aktivieren Sie den Formularmodus, indem Sie die Option **Formularmodus aktiv** einschalten. Geben Sie dann ein **Kennwort zum Deaktivieren** des Formularmodus ein und bestätigen Sie mit **OK**. Speichern Sie das Dokument anschließend.

Wenn zukünftig ein Anwender dieses Dokument öffnet und versucht, den Formularmodus auszuschalten, wird das Kennwort abgefragt. Der Formularmodus kann also nur noch mit dem korrekten Kennwort verlassen werden.

**Tipp: Formular als Dokumentvorlage speichern**

Es ist generell empfehlenswert, Formulare als Dokumentvorlage zu speichern. Denn hier ist in jedem Falle gewährleistet, dass die Originaldatei nicht verändert werden kann. Schließlich wird beim Anwenden einer Dokumentvorlage mit dem Befehl **Datei > Neu** ja nicht die Vorlage selbst geöffnet, sondern ein neues Dokument mit dem Inhalt der Vorlage angelegt.

Weitere Informationen zur Verwendung von Dokumentvorlagen finden Sie im Abschnitt **Dokumentvorlagen**.

---

**Berechnungen mit Formularobjekten**


Weitere Informationen dazu finden Sie im Abschnitt **Objekte in Berechnungen**.
Sprachwerkzeuge

TextMaker hat sich schon immer durch seine besonders leistungsfähigen Sprachwerkzeuge (Rechtschreibprüfung, Thesaurus etc.) hervorgetan. Dieses Kapitel stellt Ihnen alle verfügbaren Sprachwerkzeuge ausführlich vor. Es besteht aus folgenden Abschnitten:

- **Sprache einstellen**
  Die Standardsprache für Rechtschreibprüfung, Silbentrennung und Thesaurus lässt sich über den Menübefehl Weiteres > Einstellungen (Karteikarte Sprache) einstellen.

  Bei Bedarf können Sie Textabschnitte außerdem mit dem Menübefehl Format > Zeichen eine andere Sprache zuweisen – wenn Sie beispielsweise englischsprachige Zitate in einem deutschsprachigen Dokument verwenden möchten.

- **Rechtschreibprüfung**
  Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler und macht bei Fehlern Korrekturvorschläge.

- **Silbentrennung**
  Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach deren Sprechsilben. Dies geschieht vollautomatisch während des Tippens.

- **Thesaurus**
  Der in TextMaker integrierte große deutsche Thesaurus zeigt Ihnen Synonyme (Wörter gleicher oder verwandter Bedeutung) zu einem Wort an. Auch für viele Fremdsprachen sind Thesauri verfügbar.

- **Duden-Korrektor**

  Dieser verfügt über Module für Rechtschreibprüfung und Silbentrennung, die anstelle der eingebauten Module verwendet werden können. Darüber hinaus steht ein Modul zum Prüfen der Grammatik zur Verfügung.

- **Duden-Wörterbücher zum Nachschlagen**

- **Langenscheidt-Übersetzungswörterbücher**

- **Textbausteine**
  Über Textbausteine können Sie Ihre "Lieblingstippfehler" automatisch korrigieren lassen und Kürzel für häufig benötigte Floskeln definieren – zum Beispiel "mfg" für "Mit freundlichen Grüßen".
Sprache einstellen

Wenn Sie mehrere Sprachen installiert haben, können Sie die Sprache für Rechtschreibprüfung, Silbentrennung und Thesaurus jederzeit wechseln.

Hierfür gibt es folgende Möglichkeiten:

- **Einstellen der Standardsprache**
  
  In der Regel genügt es, mit dem Menübefehl *Weiteres > Einstellungen* die *Standardsprache* einzustellen. Rechtschreibprüfung, Silbentrennung und Thesaurus richten sich normalerweise stets nach der Standardsprache.

- **Formatieren von Text in einer anderen Sprache**
  

  Ausführlichere Informationen dazu folgen auf den nächsten Seiten.

**Einstellen der Standardsprache**

Durch das Einstellen der *Standardsprache* legen Sie fest, welche Sprache Rechtschreibprüfung, Silbentrennung und Thesaurus normalerweise verwenden sollen. Stellen Sie hier also die Sprache ein, in der Sie Ihre Dokumente üblicherweise verfassen.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl *Weiteres > Einstellungen* auf.

2. Wechseln Sie auf die Karteikarte *Sprache*.

3. Wählen Sie die gewünschte Sprache aus der Liste *Standardsprache*.

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser Liste gibt:

- *"Deutsch (Deutschland)"* steht für die neue Rechtschreibung (gemäß der sogenannten "Rechtschreibreform" von 1996 in ihrer letzten Überarbeitung von 2006).

- *"Deutsch (Deutschland, alt)"* steht hingegen für die alte Rechtschreibung.

  Entsprechendes gilt für "Deutsch (Österreich)" und "Deutsch (Schweiz)".

  Wenn Sie neue Dokumente erstellen, werden diese standardmäßig immer in der Standardsprache formatiert. Sie können natürlich auch Dokumente verfassen, die (ganz oder teilweise) Text in anderen Sprachen enthalten. Mehr dazu erfahren Sie im nächsten Abschnitt.
Formatieren von Text in einer anderen Sprache

Im letzten Abschnitt haben Sie erfahren, wie Sie die Standardsprache einstellen, die TextMaker standardmäßig für Rechtschreibprüfung, Silbentrennung und Thesaurus verwenden soll.

Darüber hinaus können Sie beliebige Textabschnitte in einer anderen Sprache formatieren – falls Sie beispielsweise englischsprachige Zitate in einem ansonsten deutschsprachigen Dokument verwenden möchten.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie den Textabschnitt, dessen Sprache Sie ändern möchten.
2. Rufen Sie den Menübefehl Format > Zeichen auf.
3. Wählen Sie die gewünschte Sprache in der Liste Sprache.

Rechtschreibprüfung, Silbentrennung und Thesaurus wissen nun, dass dieser Textabschnitt in einer anderen Sprache vorliegt und liefern dort entsprechende Resultate.

Die Liste Sprache enthält zwei Einträge mit einer besonderen Bedeutung:

- **Die Sprache "Standard"**
  Dies ist die Standardeinstellung.
  Standardmäßig sind alle Dokmente, die Sie erstellen, in der Sprache "Standard" formatiert. Welche Sprache die Standardsprache ist, können Sie mit dem Menübefehl Weiteres > Einstellungen einstellen, wie im vorherigen Abschnitt beschrieben.

- **Die Sprache "Keine"**
  Formatieren Sie einen Textabschnitt in der Sprache "Keine", wird er von der Rechtschreibprüfung ignoriert. Es werden darin auch keine Silbentrennungen vorgenommen.

  **Tipp:** Noch schneller formatieren Sie den Textabschnitt in einer anderen Sprache, indem Sie in der Statuszeile in das Feld für die Aktuelle Sprache klicken.

Anwendungsbeispiele

Einige Anwendungsbeispiele als Zusammenfassung:

**Sie schreiben ausschließlich Dokumente in Ihrer Landessprache:**

Stellen Sie einfach im Dialog des Menübefehls Weiteres > Einstellungen die gewünschte Standardsprache auf der Karteikarte Sprache ein – fertig.

**Sie schreiben gelegentlich Dokumente in einer Fremdsprache:**

In diesem Fall ist es nicht empfehlenswert, die Standardsprache in den Einstellungen auf diese Fremdsprache umzustellen. Dies würde zwar zum gewünschten Resultat führen, wäre aber nur vorübergehend wirk-
Rechtschreibprüfung

Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler und macht bei Fehlern Korrekturvorschläge.

In diesem Abschnitt stellen wir Ihnen die einzelnen Werkzeuge der Rechtschreibprüfung ausführlich vor. Folgende Themen werden darin behandelt:

- Rechtschreibprüfung nachträglich
  Die nachträgliche Rechtschreibprüfung lässt Sie ein Dokument en bloc überprüfen und korrigieren.

- Rechtschreibprüfung im Hintergrund

- Umsetzung auf die neue deutsche Rechtschreibung
  Die Rechtschreibprüfung im Hintergrund kann Ihnen außerdem helfen, Text, der in alter deutscher Rechtschreibung verfasst wurden, auf die neue Rechtschreibung umzusetzen.

- Benutzerwörterbücher bearbeiten
  Wenn Sie die Rechtschreibprüfung Wörter lernen lassen, werden diese in Ihr Benutzerwörterbuch aufgenommen. Dieses können Sie jederzeit bearbeiten, um beispielsweise falschlicherweise aufgenommene Wörter wieder zu löschen.

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Rechtschreibprüfung nachträglich

Mit dem Menübefehl Weiteres > Rechtschreibprüfung starten Sie die nachträgliche Rechtschreibprüfung.
Diese überprüft den Text Wort für Wort auf Rechtschreibfehler. Bei einem unbekannten Wort hält die Rechtschreibprüfung an und zeigt das Wort in einem Dialogfenster an.

Sie können nun wählen, ob Sie das Wort korrigieren, lernen oder den vermeintlichen Fehler einfach ignorieren möchten. In der Liste unter **Ändern auf** finden Sie außerdem Vorschläge für die korrekte Schreibweise des Wortes (sofern welche gefunden werden).

Anhand der Schaltflächen können Sie bestimmen, was mit dem unbekannten Wort geschehen soll:

<table>
<thead>
<tr>
<th>Schaltfläche</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ändern</strong></td>
<td>Lässt Sie das Wort korrigieren. Tippen Sie, bevor Sie diese Schaltfläche betätigen, die korrekte Schreibweise im Eingabefeld <strong>Ändern auf</strong> ein oder wählen Sie einen der Wortvorschläge aus der Liste.</td>
</tr>
<tr>
<td><strong>Alle ändern</strong></td>
<td>Funktioniert wie <strong>Ändern</strong>, ändert jedoch alle weiteren Vorkommen des Wortes (von hier an bis zum Ende des Dokuments) auf die angegebene Schreibweise.</td>
</tr>
<tr>
<td><strong>Ignorieren</strong></td>
<td>Weist TextMaker an, diesen Rechtschreibfehler zu ignorieren und die Rechtschreibprüfung fortzuführen.</td>
</tr>
</tbody>
</table>
| **Alle ignorieren** | Weist TextMaker an, fortan alle Vorkommen dieses Wortes zu ignorieren.  
  Hinweis: Die Liste der ignorierten Wörter merkt sich TextMaker nur **vorübergehend**; beim nächsten Programmstart hat er sie wieder vergessen. Wenn Sie TextMaker Wörter permanent lernen lassen möchten, verwenden Sie stattdessen den Befehl **Lernen**. |
| **Lernen** | Weist TextMaker an, das Wort in das Benutzerwörterbuch aufzunehmen und damit den ihm bekannten Wortschatz zu vergrößern.  
  Verwenden Sie diese Option bei richtig geschriebenen Wörtern, die TextMaker noch nicht kennt. Diese Wörter merkt sich TextMaker permanent, also auch nach einem Neustart. |

Wenn Sie die Rechtschreibprüfung beenden möchten, bevor das Ende des Dokuments erreicht ist, klicken Sie auf **Schließen**.

**Die Rechtschreibprüfung arbeitet fehlerhaft?** Wenn die Rechtschreibprüfung in einem Textabschnitt viele Wörter als falsch einstuft, deren Schreibweise jedoch definitiv korrekt ist, dann wurde der Abschnitt vermutlich in der falschen Sprache formatted. Markieren Sie den Textabschnitt in diesem Fall, rufen Sie den
Menübefehl **Format > Zeichen** auf und setzen Sie die Option **Sprache** auf der Karteikarte **Schrift** wieder auf "Standard" (beziehungsweise auf die Sprache, in der er verfasst wurde).

---

**Rechtschreibprüfung im Hintergrund**

Die **Rechtschreibprüfung im Hintergrund** prüft den gesamten Text permanent auf Rechtschreibfehler. Alle falsch geschriebenen Wörter werden mit einer roten Unterstreichung markiert.

### Aktivieren der Rechtschreibprüfung im Hintergrund

Um die Rechtschreibprüfung im Hintergrund zu aktivieren, rufen Sie den Menübefehl **Weiteres > Einstellungen** auf, wechseln auf die Karteikarte **Sprache** und aktivieren dort die Option **Rechtschreibprüfung im Hintergrund verwenden**.

TextMaker prüft das gesamte Dokument nun im Hintergrund permanent auf Rechtschreibfehler. Es werden nicht nur bestehende Rechtschreibfehler erkannt, sondern auch Textänderungen und neue Eingaben werden sofort auf die korrekte Schreibweise überprüft.

### Korrigieren falsch geschriebener Wörter

Falsch geschriebene Wörter werden auf dem Bildschirm mit einer roten Unterstreichung gekennzeichnet. So sehen Sie auf einen Blick alle falsch geschriebenen Wörter und können diese sofort oder später korrigieren – ganz nach Belieben.

Um eines dieser rot unterstrichenen Wörter zu korrigieren, ändern Sie entweder seine Schreibweise einfach von Hand oder klicken mit der **rechten** Maustaste auf das Wort, woraufhin das Kontextmenü der Rechtschreibprüfung erscheint.

**Android:** Bei der Android-Version können Sie das Kontextmenü auch mit dem Finger öffnen: Tippen Sie dazu auf den Bildschirm und halten Sie den Finger für etwa eine Sekunde gedrückt.

Das Kontextmenü enthält folgende Einträge:

<table>
<thead>
<tr>
<th>Eintrag</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liste mit Wortvorschlägen</td>
<td>Im oberen Teil des Menüs werden Vorschläge für die korrekte Schreibweise des Wortes angeboten, sofern TextMaker welche findet. Klicken Sie einen davon an, wird das Wort im Text ersetzt. Falls TextMaker sehr viele Wortvorschläge findet, erscheint zusätzlich ein Menüpunkt namens <strong>Weitere Vorschläge...</strong> Klicken Sie diesen an, erscheint ein Dialog mit allen gefundenen Vorschlägen.</td>
</tr>
<tr>
<td>Wort ignorieren</td>
<td>Ignoriert den vermeintlichen Rechtschreibfehler (für alle Vorkommen dieses Wortes) und entfernt die rote Markierung. Verwenden Sie diese Option bei Wörtern, die zwar richtig geschrieben sind, die aber nicht gelernt werden sollen. Wenn Sie TextMaker beenden, &quot;vergisst&quot; er die ignorierten Wörter wieder.</td>
</tr>
<tr>
<td>Wort lernen</td>
<td>Weist TextMaker an, das Wort in das Benutzerwörterbuch aufzunehmen und damit den ihm bekannten Wortschatz zu vergrößern.</td>
</tr>
</tbody>
</table>
Verwenden Sie diese Option bei richtig geschriebenen Wörtern, die TextMaker noch nicht kennt. Diese Wörter merkt sich TextMaker permanent.

**Textbaustein erzeugen**

Erzeugt einen Textbaustein aus dem Wort. Weitere Informationen zu diesem Feature finden Sie im Abschnitt Textbausteine.

Sobald Sie die korrekte Schreibweise wiederherstellen (beziehungsweise TextMaker das Wort ignorieren oder lernen lassen), verschwindet die rote Unterstreichung automatisch wieder.

**Die Rechtschreibprüfung arbeitet fehlerhaft?**

Wenn die Rechtschreibprüfung in einem Textabschnitt viele Wörter als falsch einstuft, deren Schreibweise jedoch definitiv korrekt ist, dann wurde der Abschnitt vermutlich in der falschen Sprache formatiert. Markieren Sie den Textabschnitt in diesem Fall, rufen Sie den Menübefehl **Format > Zeichen** auf und setzen Sie die Option **Sprache** auf der Karteikarte **Schrift** wieder auf "Standard" (beziehungsweise auf die Sprache, in der er verfasst wurde).

**Tipp: Springen zum vorherigen/nächsten Rechtschreibfehler**

Wenn die Rechtschreibprüfung im Hintergrund aktiviert ist, können Sie die drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters unter anderem dazu verwenden, zum vorherigen/nächsten Rechtschreibfehler springen.

![Pfeil nach oben](image)

![Pfeil nach unten](image)

Klicken Sie dazu auf die Schaltfläche mit dem roten Punkt. Es erscheint ein kleines Menü. Wählen Sie darin die Option **Rechtschreibfehler**.

Nun lassen sich die Schaltflächen wie folgt einsetzen:

- Klicken Sie auf die Schaltfläche mit dem Pfeil nach oben, um zum vorherigen Rechtschreibfehler zu springen.
- Klicken Sie auf die Schaltfläche mit dem Pfeil nach unten, um zum nächsten Rechtschreibfehler zu springen.

Weitere Informationen zu diesen drei Schaltflächen finden Sie im Abschnitt **Gehe zu...**

*Hinweis:* Wenn Sie außerdem die *Duden-Grammatikprüfung* aktiviert haben (nur in *SoftMaker Office Professional* enthalten), springen die Pfeile jeweils zum vorherigen/nächsten Rechtschreibfehler oder Grammatikfehler.

---

**Umsetzung auf die neue deutsche Rechtschreibung**

Wie Sie vielleicht schon bemerkt haben, bietet TextMaker in Listen zur Auswahl der Sprache gleich zwei Einträge für Deutsch an:

- "Deutsch (Deutschland)" steht für die *neue* Rechtschreibung (gemäß der sogenannten "Rechtschreibreform" von 1996 in ihrer letzten Überarbeitung von 2006).
- "Deutsch (Deutschland, alt)" steht hingegen für die *alte* Rechtschreibung.

Entsprechendes gilt für "Deutsch (Österreich)" und "Deutsch (Schweiz)".
So können Sie selbst entscheiden, ob Sie lieber die alte oder die neue deutsche Rechtschreibung verwenden möchten:

**Verwenden der alten Rechtschreibung**

Wählen Sie die Sprache "Deutsch (Deutschland, alt)", folgen Rechtschreibprüfung, Silbentrennung und Thesaurus weiterhin den alten Rechtschreibregeln.

**Verwenden der neuen Rechtschreibung**

Möchten Sie Dokumente hingegen in der neuen deutschen Rechtschreibung verfassen, wählen Sie die Sprache "Deutsch (Deutschland)". In diesem Falle stellt Ihnen die im letzten Abschnitt beschriebene Rechtschreibprüfung im Hintergrund auf Wunsch einen nützlichen Helfer zur Seite:

Schalten Sie nämlich die Option Alte Schreibweisen blau unterstreichen ein, unterstreicht sie alle Wörter mit blauer Farbe, die der alten deutschen Rechtschreibung entsprechen, nach der neuen Rechtschreibung jedoch anderes geschrieben werden sollten.


**Aktivieren der Umsetzung auf die neue Rechtschreibung**

Um die Prüfung und Umsetzung auf die neue deutsche Rechtschreibung zu aktivieren, sind folgende Schritte durchzuführen:

1. Rufen Sie den Menübefehl Weitere > Einstellungen auf.
2. Wechseln Sie auf die Karteikarte Sprache.
3. Schalten Sie die Option Rechtschreibprüfung im Hintergrund verwenden ein.
4. Aktivieren Sie zusätzlich die Option Alte Schreibweisen blau unterstreichen.
5. Bestätigen Sie mit OK.

**Hinweis:** Die Option Alte Schreibweisen blau unterstreichen wird nur bei Text in der Sprache "Deutsch (Deutschland)", "Deutsch (Österreich)" oder "Deutsch (Schweiz)" aktiv. Bei allen anderen Sprachen ist sie ohne Funktion.

Korrigieren von Wörtern in alter Rechtschreibung

Wenn Sie, wie im letzten Abschnitt beschrieben, die Option Alte Schreibweisen blau unterstreichen eingeschaltet haben, werden deutsche Wörter, deren Schreibweise in der Rechtschreibreform geändert wurde, mit einer blauen Unterstreicung gekennzeichnet.

Um ein solches Wort auf die neue Rechtschreibung umzusetzen, ändern Sie seine Schreibweise einfach von Hand oder klicken mit der rechten Maustaste auf das Wort, worauf das Kontextmenü der Rechtschreibprüfung erscheint.

**Android:** Bei der Android-Version können Sie das Kontextmenü auch mit dem Finger öffnen: Tippen Sie dazu auf den Bildschirm und halten Sie den Finger für etwa eine Sekunde gedrückt.

Das Kontextmenü enthält folgende Einträge:

<table>
<thead>
<tr>
<th>Eintrag</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liste mit Wortvorschlägen</td>
<td>Ganz oben werden alle laut Rechtschreibreform korrekten Schreibweisen angezeigt. Klicken Sie eine davon an, ersetzt TextMaker das Wort im Text.</td>
</tr>
<tr>
<td>Infos</td>
<td>Ruft ein Dialogfenster mit zusätzlichen Optionen und Informationen auf (siehe Abschnitt Der Befehl Infos der Rechtschreibprüfung).</td>
</tr>
<tr>
<td>Wort ignorieren</td>
<td>Ignoriert den vermeintlichen Rechtschreibfehler und entfernt die blaue Markierung.</td>
</tr>
<tr>
<td>Verwenden Sie diese Option bei Wörtern, die zwar richtig geschrieben sind, die aber nicht gelernt werden sollen. Wenn Sie TextMaker beenden, &quot;vergisst&quot; er die ignorierten Wörter wieder.</td>
<td></td>
</tr>
<tr>
<td>Wort lernen</td>
<td>Weist TextMaker an, das Wort in das Benutzerwörterbuch aufzunehmen.</td>
</tr>
<tr>
<td>Solche Wörter merkt sich TextMaker permanent; sie werden zukünftig nicht mehr blau unterstrichen (siehe Anmerkung!)</td>
<td></td>
</tr>
</tbody>
</table>

**Anmerkung:** Verwenden Sie den Befehl Wort lernen ausschließlich bei solchen blau unterstrichenen Wörtern, die tatsächlich gemäß der neuen Rechtschreibung korrekt geschrieben sind. Wenn Sie hingegen Wörter lernen lassen, die der alten Rechtschreibung entsprechen, der neuen hingegen nicht mehr, dann bringen Sie TextMaker falsch geschriebene Wörter bei!

Der Befehl Infos der Rechtschreibprüfung

Wenn Sie, wie im letzten Abschnitt beschrieben, das Kontextmenü der Rechtschreibprüfung aufrufen, erscheint bei deutschen Wörtern in alter Schreibweise ein zusätzlicher Eintrag: der Befehl Infos. Dieser enthält zusätzliche Optionen und zeigt Informationen an, nach welcher Regel sich die Schreibweise des Wortes in der Rechtschreibreform geändert hat.

Das Dialogfenster dieses Befehls bietet folgende Funktionen:

<table>
<thead>
<tr>
<th>Eintrag</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Hier werden alle laut Rechtschreibreform korrekten Schreibweisen angezeigt. Klicken Sie eine davon an und betätigen die Schaltfläche Ändern, ersetzt TextMaker das Wort im Text.

Lässt Sie das Wort korrigieren. Wählen Sie zuvor die korrekte Schreibweise aus der Liste der Wortvorschläge.

Falls TextMaker tatsächlich einmal einen falschen Vorschlag machen sollte, können Sie im Eingabefeld Ändern auf die korrekte Schreibweise selbst von Hand eingeben.

Lässt Sie einen Textbaustein anlegen. Siehe Abschnitt Textbausteine.

Weist TextMaker an, diesen Rechtschreibfehler zu ignorieren.

Weist TextMaker an, fortan alle Vorkommen dieses Wortes zu ignorieren.

Hinweis: Die Liste der ignorierten Wörter merkt sich TextMaker nur vorübergehend; beim nächsten Programmstart hat er sie wieder vergessen. Wenn Sie TextMaker Wörter permanent lernen lassen möchten, verwenden Sie stattdessen den Befehl Lernen:

Weist TextMaker an, das Wort in das Benutzerwörterbuch aufzunehmen.

Solche Wörter merkt sich TextMaker permanent; sie werden zukünftig nicht mehr blau unterstrichen (siehe Anmerkung!)

Schließt das Dialogfenster ohne eine Änderung vorzunehmen.

**Anmerkung:** Verwenden Sie den Befehl Lernen ausschließlich bei solchen blau unterstrichenen Wörtern, die tatsächlich gemäß der neuen Rechtschreibung korrekt geschrieben sind. Wenn Sie hingegen Wörter lernen lassen, die nach der alten Rechtschreibung stimmen, nach der neuen hingegen nicht mehr, dann bringen Sie TextMaker falsch geschriebene Wörter bei!

### Benutzerwörterbücher bearbeiten

Wenn Sie die Rechtschreibprüfung Wörter lernen lassen, werden diese in Ihr Benutzerwörterbuch aufgenommen. Dieses können Sie jederzeit bearbeiten, um beispielsweise fälschlicherweise aufgenommene Wörter wieder zu löschen.

Rufen Sie dazu den Menübefehl Weiteres > Wörterbücher bearbeiten auf. Es erscheint ein Dialogfenster mit folgenden Schaltflächen und Optionen:

- **Sprache**

  Es gibt zu jeder Sprache ein eigenes Benutzerwörterbuch. Über die aufklappbare Liste Sprache können Sie auswählen, welches Benutzerwörterbuch Sie bearbeiten möchten.

  **Hinweis:** Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser Liste gibt: "Deutsch (Deutschland)" steht für die neue Rechtschreibung und "Deutsch (Deutschland, alt)" für die alte Rechtschreibung. Entsprechendes gilt für "Deutsch (Österreich)" und "Deutsch (Schweiz)".

- **Wörter**

  Eine Liste aller Wörter, die sich in Ihrem Benutzerwörterbuch (für die gewählte Sprache) befinden.
- **Schaltfläche "Schließen"**
  Schließt den Dialog.

- **Schaltfläche "Hinzufügen"**
  
  Auf diese Weise hinzugefügte Wörter werden genau so behandelt wie Wörter, die Sie dem Programm über die Schaltfläche **Lernen** in der Rechtschreibprüfung beigebracht haben.

- **Schaltfläche "Ändern"**
  Mit dieser Schaltfläche können Sie das momentan in der Liste selektierte Wort editieren. Dies ist nützlich bei Wörtern, die Sie versehentlich in falscher Schreibweise in Ihr Benutzerwörterbuch aufgenommen haben. Es erscheint dazu ein Dialog, in dem Sie die Schreibweise des Wortes korrigieren können.

- **Schaltfläche "Löschen"**
  Diese Schaltfläche löscht das Wort, das momentan in der Liste ausgewählt ist, aus Ihrem Benutzerwörterbuch.
  
  Die Rechtschreibprüfung wird dieses Wort künftig also wieder als falsch geschrieben ansehen.

---

**Silbentrennung**

Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach deren Sprechsilben. Das sorgt dafür, dass der rechte Rand des Textes nicht so "ausgefranst" erscheint.

Die Silbentrennung arbeitet völlig automatisiert, während Sie tippen. Sie brauchen sich normalerweise also überhaupt nicht um sie zu kümmern.

Sie müssen lediglich darauf achten, dass Sie die korrekte Sprache eingestellt haben, da die Silbentrennung natürlich fehlerhafte Resultate liefert, wenn Sie beispielsweise einen englischen Text nach deutschen Trennregeln trennen lassen.

**Sprache einstellen**

Wie man die Sprache für Rechtschreibprüfung und Silbentrennung einstellt, wurde bereits zu Beginn dieses Kapitels beschrieben (Abschnitt **Sprache einstellen**).

Hier noch einmal eine kurze Zusammenfassung:

- **Standardsprache einstellen**
  Standardmäßig richten sich Rechtschreibprüfung und Silbentrennung stets nach der von Ihnen eingestellten Standardsprache.

  Um die Standardsprache festzulegen, rufen Sie den Menübefehl **Weiteres > Einstellungen** auf, wechseln auf die Karteikarte **Sprache** und wählen bei Standardsprache die gewünschte Sprache.

  Im Normalfall wählen Sie hier Ihre Muttersprache – und brauchen sich um diese Einstellung dann nie wieder zu kümmern.

- **Textabschnitte in einer anderen Sprache formatieren**
Darüber hinaus können Sie aber bei Bedarf für einzelne Textabschnitte jederzeit eine andere Sprache auswählen. Dies ist nützlich, wenn Sie beispielsweise ein englischsprachiges Zitat in einem deutschnsprachigen Dokument verwenden möchten.

Dazu markieren Sie den fremdsprachlichen Textabschnitt, rufen den Menübefehl Format > Zeichen auf, wechseln auf die Karteikarte Schrift und wählen bei Sprache die Sprache, in der dieser Textabschnitt verfasst ist.

Sie können die Sprache innerhalb eines Dokuments beliebig oft wechseln und natürlich auch komplette Dokumente in einer anderen Sprache formatieren.

**Trennhäufigkeit einstellen**

Auf Wunsch können Sie festlegen, wie häufig die Silbentrennungsfunktion Wörter trennen soll – oder die Silbentrennung ganz abschalten. Diese Einstellung lässt sich für jeden Absatz getrennt festlegen.

Markieren Sie dazu die betreffenden Absätze, rufen Sie den Menübefehl Format > Absatz auf und wechseln Sie auf die Karteikarte Textfluss. Wählen Sie dann die gewünschte Einstellung in der Liste Silbentrennung.

Folgende Optionen stehen zur Wahl:

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keine</td>
<td>Keine Silbentrennungen durchführen</td>
</tr>
<tr>
<td>Stets</td>
<td>Beliebig viele aufeinanderfolgende Silbentrennungen versuchen. Dies ist die Standardeinstellung.</td>
</tr>
<tr>
<td>2-Zeilen-Trennung</td>
<td>Silbentrennung nur in jeder zweiten Zeile versuchen</td>
</tr>
<tr>
<td>3-Zeilen-Trennung</td>
<td>Silbentrennung nur in jeder dritten Zeile versuchen</td>
</tr>
</tbody>
</table>

Mit Keine schalten Sie die Silbentrennung für die selektierten Absätze also ab, wogegen Stets in jeder beliebigen Zeile eines Absatzes versucht, eine Silbentrennung durchzuführen.

Wozu aber dienen die zwei anderen Optionen? Nun, es ist nicht immer erstrebenswert, alle denkbaren Silbentrennungen durchzuführen. Denn das kann beispielsweise bei schmalen Textspalten dazu führen, dass in fast jeder Zeile getrennt wird, was die Lesbarkeit des Dokuments vermindert. Deshalb können Sie TextMaker mit Hilfe der Optionen 2- und 3-Zeilen-Trennung anweisen, eine Silbentrennung nur in jeder zweiten beziehungsweise dritten Zeile zu versuchen.

**Silbentrennung für ein Dokument komplett abschalten**

Unabhängig von obigen Einstellungen können Sie die Silbentrennung für das aktuelle Dokument jederzeit komplett ein- oder ausschalten.

Für das Umschalten ist der Menübefehl Weitere > Automatische Silbentrennung zuständig.

Standardmäßig ist die automatische Silbentrennung aktiviert. Sie erkennen das daran, dass im Menü Weitere vor dem Befehl Automatische Silbentrennung ein Häkchen angezeigt wird. Um sie auszuschalten, rufen Sie diesen Befehl auf, woraufhin das Häkchen verschwindet. Die automatische Silbentrennung ist nun (für das aktuelle Dokument) komplett deaktiviert. Es werden also keine Trennzeichen mehr automatisch eingefügt, und die bereits vorhandenen werden allesamt entfernt.

Rufen Sie den Befehl erneut auf, wird die Silbentrennung wieder eingeschaltet.
Hinweis: Diese Einstellung ist eine Dokumentoption. Das bedeutet, dass sie nur das aktuelle Dokument betrifft und ihr Zustand auch im Dokument gespeichert wird. So können Sie bei jedem Dokument einzeln entscheiden, ob darin automatische Silbentrennungen vorgenommen werden sollen oder nicht.

Übrigens gibt es die gleiche Option auch im Dialogfenster des Menübefehls Weiteres > Einstellungen, auf der Karteikarte Sprache: Wenn Sie dort die Option Automatische Silbentrennung verwenden ein- oder ausschalten, ist das gleichbedeutend mit dem Aufruf des Befehls Weiteres > Automatische Silbentrennung.

Silbentrennung für ein Wort oder einen Textabschnitt abschalten

Weiterhin können Sie die Silbentrennung auch gezielt für einen bestimmten Textabschnitt (z.B. ein einzelnes Wort) abschalten.

Markieren Sie den Textabschnitt dazu, rufen Sie den Menübefehl Format > Zeichen auf, wechseln Sie auf die Karteikarte Schrift und wählen Sie dort bei Sprache die Einstellung Keine Sprache.

Hinweis: Beachten Sie dabei, dass in diesem Textabschnitt dann auch keine Rechtschreibprüfung mehr stattfindet.

Einfügen von "weichen" Trennzeichen

TextMaker verfügt über eine äußerst ausgereifte Silbentrennung, die nur in sehr seltenen Fällen Fehler macht. Falls das Programm einmal ein Wort nicht an der gewünschten Stelle trennen sollte, können Sie dies jederzeit korrigieren, indem Sie dort ein weiches Trennzeichen (auch bedingter Trennstrich genannt) einfügen.

Setzen Sie die Schreibmarke dazu an die Stelle, an der das Wort durch einen Bindestrich getrennt werden soll, und betätigen Sie die Tastenkombination Strg+Minus (Minuszeichen). TextMaker wird das Wort dann künftig nur noch an dieser Stelle trennen.

Bei Wörtern mit mehreren Silben können Sie natürlich auch mehrere weiche Trennzeichen einfügen (zum Beispiel einen hinter jeder Silbe).


Einfügen von "geschützten" Trennzeichen

Wenn ein Wort, das sich am Ende einer Zeile befindet, einen Bindestrich enthält, führt TextMaker dort möglicherweise eine Silbentrennung durch. Dies ist in bestimmten Fällen aber nicht wünschenswert.

Bei einer Telefonnummer wie 936386-0 möchte man beispielsweise nicht, dass die Null vom Rest der Telefonnummer durch eine Silbentrennung abgetrennt wird. Schließlich ist die Nummer besser lesbar, wenn TextMaker sie nicht trennt, sondern sie stattdessen komplett auf die nächste Zeile übernimmt.

Wenn Sie verhindern möchten, dass TextMaker eine Trennung an einem Bindestrich vornimmt, dann ersetzen Sie diesen durch ein geschütztes Trennzeichen. Sie können diesen durch das Betätigen der Tastenkombination Strg+Umschalt+Minus (Minuszeichen) einfügen.
Man könnte dieses Zeichen auch "nicht-trennenden Bindestrich" nennen, denn es sieht aus wie ein normaler Bindestrich, verhindert jedoch, dass an dieser Stelle eine Silbentrennung durchgeführt wird.

# Thesaurus

Mit dem Menübefehl **Weiteres > Thesaurus** können Sie TextMaker zu einem Wort **Synonyme** (Begriffe gleicher oder ähnlicher Bedeutung) anzeigen lassen.


Für die deutsche Sprache steht ein besonders großer Thesaurus zur Verfügung (nicht in allen TextMaker-Versionen enthalten). Dieser wurde unter der Leitung eines angesehenen deutschen Sprachwissenschaftlers in langjähriger Arbeit erstellt und enthält sage und schreibe **400.000 Synonyme**. Einen umfangreicheren Thesaurus werden Sie kaum in einer anderen Textverarbeitung finden.

## Verwendung des Thesaurus

Um den Thesaurus aufzurufen, tippen Sie ein Wort ein oder bewegen die Schreibmarke auf ein bereits vorhandenes Wort. Rufen Sie dann den Menübefehl **Weiteres > Thesaurus** auf.


**Hinweis:** Bei Wörtern mit mehreren Bedeutungen werden in der Liste **Bedeutung** mehrere Einträge angezeigt. Wählen Sie dann zuerst die gesuchte Bedeutung, worauf in der Liste **Synonyme** die passenden Synonyme erscheinen.

Nun können Sie per Mausklick ein Wort aus der Liste **Synonyme** auswählen und dann über die Schaltflächen eine der folgenden Funktionen wählen:

<table>
<thead>
<tr>
<th>Schaltfläche</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nachschlagen</td>
<td></td>
</tr>
<tr>
<td>Ersetzen</td>
<td></td>
</tr>
<tr>
<td>Schließen</td>
<td></td>
</tr>
</tbody>
</table>
Nachschlagen
Sucht nach weiteren Alternativen zu dem gewählten Synonym.

Ersetzen
Ersetzt das Wort im Text durch das gewählte Synonym.

Schließen
Beendet den Thesaurus.

---

**Duden-Korrektor**


Bei SoftMaker Office Professional enthält TextMaker, neben seinen vorhandenen Sprachwerkzeugen, zusätzlich den *Duden-Korrektor* vom Dudenverlag.

Dieser beinhaltet Module für **Rechtschreibprüfung** und **Silbentrennung**, die anstelle der eingebauten Module verwendet werden können. Darüber hinaus steht ein Modul für **Grammatikprüfung** zur Verfügung.

*Hinweis:* Sämtliche Module des Duden-Korrektors werden nur bei Text in der Sprache "Deutsch (Deutschland, Österreich, Schweiz etc.)" aktiv.

In den nachfolgenden Abschnitten stellen wir Ihnen den Duden-Korrektor ausführlich vor. Folgende Themen werden darin behandelt:

- **Duden-Rechtschreibprüfung verwenden**
  Der Duden-Korrektor kann unter anderem die Rechtschreibprüfung in Ihren Dokumenten übernehmen:

  Aktivieren Sie dazu einfach in den Einstellungen die Option "Für deutschsprachige Rechtschreibprüfung den Duden-Korrektor verwenden". Von nun an verwendet die Rechtschreibprüfung nicht mehr das in TextMaker integrierte Rechtschreibmodul, sondern das Rechtschreibmodul des Duden-Korrektors.

- **Duden-Silbentrennung verwenden**
  Ähnliches gilt für die automatische Silbentrennung:


- **Duden-Grammatikprüfung verwenden**
  Die Option "Duden-Korrektor-Grammatikprüfung verwenden" bereichert TextMaker um ein besonders interessantes neues Feature:


- **Duden-Korrektor konfigurieren**
  Im letzten Abschnitt lernen Sie den Dialog "Duden-Korrektor-Einstellungen" kennen, mit dem Sie die einzelnen Module des Duden-Korrektors nach Ihren Wünschen konfigurieren können.
Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

**Duden-Rechtschreibprüfung verwenden**


Der Duden-Korrektor verfügt unter anderem über ein *Rechtschreibmodul*.

Wenn Sie dieses aktivieren, nutzt TextMaker für die Rechtschreibprüfung nicht mehr sein eigenes Modul, sondern das Rechtschreibmodul des Duden-Korrektors. Dieses zeichnet sich vor allem dadurch aus, dass es das offizielle Duden-Wörterbuch verwendet.

*Hinweis:* Die Duden-Rechtschreibprüfung wird nur bei Text in der Sprache "Deutsch (Deutschland, Österreich, Schweiz etc.)" aktiv.

**Aktivieren der Duden-Rechtschreibprüfung**

Um die Duden-Rechtschreibprüfung zu aktivieren, rufen Sie den Menübefehl *Weiteres > Einstellungen* auf, wechseln auf die Karteikarte *Sprache* und aktivieren dort die Option *Für deutschnsprachige Rechtschreibprüfung den Duden-Korrektor verwenden*.

Von nun an wird für die Rechtschreibprüfung nicht mehr das in TextMaker integrierte Modul, sondern das Rechtschreibmodul des Duden-Korrektors verwendet.

*Hinweis:* An der *Bedienung* der Rechtschreibprüfung ändert sich dabei absolut nichts. Sie können die Rechtschreibprüfung also auch weiterhin, wie im Abschnitt *Rechtschreibprüfung* beschrieben, von Hand starten oder automatisch im Hintergrund durchführen lassen.

**Duden-Silbentrennung verwenden**


Der Duden-Korrektor verfügt unter anderem über ein *Silbentrennmodul*.

Wenn Sie dieses aktivieren, nutzt TextMaker für die automatische Silbentrennung nicht mehr sein eigenes Modul, sondern das Silbentrennmodul des Duden-Korrektors. Dieses zeichnet sich vor allem dadurch aus, dass es zum Ermitteln der zulässigen Trennungen auf das offizielle Duden-Wörterbuch zurückgreifen kann.

*Hinweis:* Die Duden-Silbentrennung wird nur bei Text in der Sprache "Deutsch (Deutschland, Österreich, Schweiz etc.)" aktiv.
**Aktivieren der Duden-Silbentrennung**

Um die Duden-Silbentrennung zu aktivieren, rufen Sie den Menübefehl *Weiteres > Einstellungen* auf, wechseln auf die Karteikarte *Sprache* und aktivieren dort die Option *Für deutschsprachige Silbentrennung den Duden-Korrektor verwenden*.

Von nun an wird für die automatische Silbentrennung nicht mehr das in TextMaker integrierte Modul, sondern das Silbentrennmodul des Duden-Korrektors verwendet.

Hinweis: An der Bedienung der Silbentrennungsfunktion ändert sich dabei absolut nichts. Sie läuft also, sofern Sie nicht eingreifen, auch weiterhin völlig automatisch ab und trennt Wörter bei Bedarf selbstständig. (Ausführliche Informationen dazu finden Sie im Abschnitt *Silbentrennung*).

---

### Duden-Grammatikprüfung verwenden


Zusätzlich zu den Modulen für Rechtschreibprüfung und Silbentrennung verfügt der Duden-Korrektor auch über eine *Grammatikprüfung*.


*Hinweis:* Die Duden-Grammatikprüfung wird nur bei Text in der Sprache "Deutsch (Deutschland, Österreich, Schweiz etc.)" aktiv.

---

### Aktivieren der Duden-Grammatikprüfung

Um die Duden-Grammatikprüfung zu aktivieren, rufen Sie den Menübefehl *Weiteres > Einstellungen* auf, wechseln auf die Karteikarte *Sprache* und aktivieren dort die Option *Duden-Korrektor-Grammatikprüfung verwenden*.

Von nun an prüft die Grammatikprüfung das gesamte Dokument im Hintergrund permanent auf Grammatikfehler. Sie erkennt nicht nur bestehende Fehler, sondern überprüft auch Textänderungen und neue Eingaben sofort auf Fehler – mit folgender Einschränkung:

*Hinweis:* Beachten Sie beim Editieren und Hinzufügen von Text, dass die Grammatikprüfung in TextMaker immer *absatzweise* arbeitet. Wenn Sie also den Inhalt eines Absatzes editieren, wird dessen Grammatik erst überprüft, wenn Sie den Absatz verlassen – also beispielsweise die Schreibmarke mit den Richtungstasten herausbewegen, mit der Maus außerhalb des Absatzes klicken oder mit der Eingabetaste \( \) einen neuen Absatz beginnen.

Anmerkung: Es sei außerdem darauf hingewiesen, dass das Prüfen der Grammatik eines Textes selbst für die modernsten Computer eine reichlich komplexe Aufgabe ist. Es kann daher gelegentlich vorkommen, dass die Grammatikprüfung Formulierungen als falsch ansieht, in denen sich eigentlich gar kein Fehler befindet. Wenden Sie in solchen Fällen einfach den Befehl *Regel hier ignorieren* an (siehe unten).
**Korrigieren von Grammatikfehlern**


Um einen Grammatikfehler zu korrigieren, editieren Sie den grün unterstrichenen Satzteil einfach von Hand.

**Tipp:** Wenn Sie mit der Maus auf einen Grammatikfehler zeigen (ohne zu klicken), erscheint eine Info-box mit Erläuterungen zu dem Fehler.

Mit einem Rechtsklick auf einen Grammatikfehler können Sie außerdem ein Kontextmenü aufrufen, das folgende Funktionen enthält:

<table>
<thead>
<tr>
<th>Eintrag</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liste mit Vorschlägen</td>
<td>Bei einigen Arten von Grammatikfehlern wird im obersten Teil des Menüs ein Vorschlag für die korrekte Schreibweise angeboten. Klicken Sie diesen an, wird der fehlerhafte Text entsprechend ersetzt.</td>
</tr>
<tr>
<td>Infos</td>
<td>Zeigt Erläuterungen zu dem Grammatikfehler an.</td>
</tr>
<tr>
<td>Regel hier ignorieren</td>
<td>Ignoriert die angewandte Grammatikregel an dieser <em>einen</em> Stelle und entfernt die grüne Markierung. Dieser Befehl ist besonders dann nützlich, wenn die Grammatikprüfung falschlicherweise Text grün unterstrichen hat, dessen Schreibweise eigentlich korrekt ist.</td>
</tr>
</tbody>
</table>

**Tipp: Springen zum vorherigen/nächsten Grammatikfehler**

Wenn die Grammatikprüfung aktiviert ist, können Sie die drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters unter anderem dazu verwenden, zum vorherigen/nächsten Grammatikfehler springen.

Klicken Sie dazu auf die Schaltfläche mit dem roten Punkt. Es erscheint ein kleines Menü. Wählen Sie darin die Option Rechtschreibfehler.

Nun lassen sich die Schaltflächen wie folgt einsetzen:

- Klicken Sie auf die Schaltfläche mit dem Pfeil nach oben, um zum vorherigen Grammatikfehler zu springen.
- Klicken Sie auf die Schaltfläche mit dem Pfeil nach unten, um zum nächsten Grammatikfehler zu springen.
Weitere Informationen zu diesen drei Schaltflächen finden Sie im Abschnitt [Gehe zu...].

**Hinweis:** Wenn Sie außerdem die *Rechtschreibprüfung im Hintergrund* aktiviert haben, springen die Pfeile jeweils zum vorherigen/nächsten Rechtschreibfehler oder Grammatikfehler.

---

**Duden-Korrektor konfigurieren**

**Hinweis:** Dieses Feature ist nur in **SoftMaker Office Professional** (erhältlich für Windows, Mac und Linux) enthalten.


Sie können diesen Dialog wie folgt aufrufen:

1. Rufen Sie den Menübefehl **Weiteres > Einstellungen** auf.
2. Wechseln Sie auf die Karteikarte Sprache.
3. Klicken Sie auf die Schaltfläche **Duden-Korrektor-Optionen**.

In dem Dialog gibt es folgende Einstellungen:

**Prüfstil für Rechtschreibung und Grammatik**

Aufgrund der sogenannten "Rechtschreibreform" von 1996 sind heute bei zahlreichen deutschen Wörtern mehrere Schreibweisen zulässig – zum Beispiel *Foto* oder *Photo*.

Mit dieser Einstellung können Sie festlegen, welche dieser alternativen Schreibweisen die Rechtschreibprüfung und die Grammatikprüfung als korrekt ansehen soll. Sie haben die Wahl zwischen folgenden Optionen:

**Dudenempfehlungen:** Sind von einem Wort mehrere Schreibweisen erlaubt, nur die von der Dudenredaktion empfohlene Schreibweise als korrekt ansehen.

**Konservativ:** Sind mehrere Schreibweisen erlaubt, nur die alte Schreibweise als korrekt ansehen. Richtig: *Photo*. Falsch: *Foto*.

**Progressiv:** Sind mehrere Schreibweisen erlaubt, nur die neue ("reformierte") Schreibweise als korrekt ansehen. Richtig: *Foto*. Falsch: *Photo*.

**Tolerant:** Sind mehrere Schreibweisen erlaubt, alle Schreibweisen als korrekt ansehen – also sowohl *Photo* als auch *Foto*.

**Presse:** Sind mehrere Schreibweisen erlaubt, diejenige Schreibweise als korrekt ansehen, die deutsche Presseagenturen bevorzugen würden.

**Rubrik "Grammatikprüfung"**

- **Quickinfos anzeigen**

   Ist diese Option aktiviert, zeigt die Duden-Grammatikprüfung eine Infobox mit Informationen zur Art des Grammatikfehlers an, wenn Sie mit der Maus auf einen der grün unterstrichenen Grammatikfehler im Text zeigen.
Rubrik "Rechtschreibprüfung"

- Quickinfos anzeigen

   Ist diese Option aktiviert, zeigt die Rechtschreibprüfung eine Infobox mit Informationen zur Art des Rechtschreibfehlers an, wenn Sie mit der Maus auf einen der rot unterstrichenen Rechtschreibfehler im Text zeigen.

   (Dies funktioniert natürlich nur, wenn die Rechtschreibprüfung im Hintergrund eingeschaltet ist.)

Rubrik "Silbentrennung"

- Trennstil

   Aufgrund der sogenannten "Rechtschreibreform" von 1996 gibt es heute zahlreiche deutsche Wörter, für deren Silbentrennung mehrere Varianten zulässig sind. Vor der Reform wurde das Wort Magnet beispielsweise immer zu Ma-gnet getrennt; jetzt ist alternativ auch die Trennung Mag-net erlaubt.

   Mit dieser Einstellung können Sie festlegen, welche Variante in solchen Fällen verwendet werden soll. Sie haben die Wahl zwischen folgenden Optionen:

   **Konservativ:** Sind bei einem Wort mehrere Varianten von Silbentrennungen erlaubt, nur die alte Trennung verwenden. Richtig: Ma-gnet. Falsch: Mag-net.

   **Progressiv:** Sind mehrere Varianten erlaubt, nur die neue ("reformierte") Trennung verwenden. Richtig: Mag-net. Falsch: Ma-gnet.

   **Nach Aussprache:** Sind mehrere Varianten erlaubt, diejenige Variante verwenden, die der Aussprache des Wortes entspricht. Im Falle Magnet wäre das also Ma-gnet.

   **Kombiniert (alle Varianten):** Alle zulässigen Varianten von Trennungen nutzen. Je nach Platzbedarf kann Magnet also entweder zu Mag-net oder zu Ma-gnet getrennt werden.

- Trennungen innerhalb von Wortstämmen zulassen

   Diese Option hat folgende Auswirkung:

   **Ein:** Alle erlaubten Silbentrennungen zulassen, auch solche innerhalb von Wortstählen.

   **Aus:** Trennungen innerhalb von Wortstählen nicht zulassen. Dies betrifft vor allem Wörter mit Vorsilben und Wörter, die aus mehreren Wörtern zusammengesetzt sind:

   Wenn diese Option ausgeschaltet ist, wird beispielsweise heim-kom-men nur noch zu heim-kommen getrennt und Ta-fel-was-ser zu Tafel-wasser.

- Unästhetische Trennungen zulassen

   Diese Option hat folgende Auswirkung:

   **Ein:** Alle erlaubten Silbentrennungen zulassen, auch unästhetische.

   **Aus (empfohlen):** Trennungen, die unästhetisch oder verwirrend sind, nicht zulassen.

   Wenn diese Option ausgeschaltet ist, wird beispielsweise so-zí-al nur noch zu so-zí-al getrennt. Außerdem werden verwirrende Trennungen wie Urin-stinkt oder Reim-port nicht mehr zugelassen.
Rubrik "Prüfregeln für Rechtschreibung und Grammatik"

In dieser Liste erscheinen alle Regeln der Rechtschreib- und Grammatikprüfung mit Ihrem aktiven Status. Zum schnelleren Auffinden einer Regel können Sie mit der aufklappbaren Liste die Auswahl von *Alle Einträge* auf eine bestimmte Rubrik begrenzen. Sie können Regeln deaktivieren, indem Sie das Häkchen vor der Regel per Mausklick entfernen und dann mit OK bestätigen.

Deaktivierte Regeln werden von der Rechtschreib- und Grammatikprüfung ignoriert; es werden also keine Fehler bezüglich dieser Regel gemeldet.

Hintergrund:

Es gibt zwei Gründe, warum Regeln in dieser Liste als deaktiviert auftauchen können:

- **Regeln, die Sie selbst ausgeschaltet haben:**
  Wie im Abschnitt [Duden-Grammatikprüfung verwenden](#) beschrieben, können Sie Regeln deaktivieren, indem Sie auf einen der grün unterstrichenen Grammatikfehler rechtsklicken und in dem Kontextmenü, das daraufhin erscheint, den Befehl *Regel immer ignorieren* wählen.

  Alle auf diese Weise deaktivierten Regeln erscheinen in dieser Liste ohne Häkchen und lassen sich wieder aktivieren, falls Sie es sich einmal anders überlegt haben sollten.

- **Regeln, die standardmäßig ausgeschaltet sind:**
  Einige Regeln sind aus verschiedenen Gründen standardmäßig ausgeschaltet. Vor dem Prozentzeichen beispielsweise könnte ein Leerzeichen stehen, muss es aber nicht. Die entsprechende Regel steht daher anfänglich auf deaktiviert.

  Sie können übrigens jederzeit wieder die Standardeinstellungen für diese Liste wiederherstellen, indem Sie auf die Schaltfläche **Alles zurücksetzen** klicken. Alle von Ihnen geänderten Regeln werden dann wieder auf den ursprünglichen Status gesetzt.

---

**Duden-Wörterbücher zum Nachschlagen**


Bei SoftMaker Office Professional enthält TextMaker nicht nur den Duden-Korrektor für Rechtschreibprüfung, Silbentrennung und Grammatikprüfung, sondern auch folgende Duden-Wörterbücher zum Nachschlagen von Wörtern:

- **Das deutsche Universalwörterbuch**
  Das umfassende Wörterbuch zur deutschen Gegenwartssprache liefert Informationen zu Rechtschreibung, Grammatik, Aussprache, Herkunft und Anwendung von 150.000 Stichwörtern und Redewendungen. Insgesamt enthält es mehr als 500.000 Anwendungsbeispiele.

- **Das große Fremdwörterbuch**
  Das große Fremdwörterbuch ist ein umfassendes und aktuelles Fremdwörterbuch der deutschen Sprache. Es kennt die Bedeutung von etwa 85.000 Fremdwörtern und beinhaltet auch Informationen zu Rechtschreibung, Aussprache und Grammatik.
Verwendung der Duden-Wörterbücher

Um etwas in den Duden-Wörterbüchern nachzuschlagen, tippen Sie ein Wort ein oder bewegen die Schreibmarke auf ein bereits vorhandenes Wort. Dann rufen Sie den Menübefehl **Weiteres > Duden** auf.


**Hinweis:** Bei Wörtern, für die es mehrere Einträge in den Duden-Wörterbüchern gibt, werden in der Liste **Wort** entsprechend mehrere Einträge angezeigt. Wählen Sie einen dieser Einträge, erscheinen im Feld **Ergebnisse** die zugehörigen Erläuterungen.

Die Schaltflächen im Dialog für diesen Befehl haben folgende Funktionen:

<table>
<thead>
<tr>
<th>Schaltfläche</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wörterbücher</strong></td>
<td>Legt fest, welche Duden-Wörterbücher durchsucht werden sollen. Folgende Wörterbücher sind verfügbar:</td>
</tr>
<tr>
<td></td>
<td>- Deutsches Universalwörterbuch</td>
</tr>
<tr>
<td></td>
<td>- Großes Fremdwörterbuch</td>
</tr>
<tr>
<td></td>
<td>- Großes Fremdwörterbuch (revers)*</td>
</tr>
<tr>
<td></td>
<td>* Letzteres arbeitet genau umgekehrt wie das Fremdwörterbuch: es zeigt zu einem deutschen Wort das zugehörige Fremdwort an.</td>
</tr>
<tr>
<td><strong>Nachschlagen</strong></td>
<td>Lässt Sie ein anderes Wort nachschlagen. Tippen Sie das Wort dazu erst im Feld <strong>Wort</strong> ein und betätigen Sie dann diese Schaltfläche.</td>
</tr>
<tr>
<td><strong>Schließen</strong></td>
<td>Schließt das Dialogfenster.</td>
</tr>
</tbody>
</table>
Langenscheidt-Übersetzungswörterbücher


Verwendung der Langenscheidt-Übersetzungswörterbücher

Um Übersetzungen für ein Wort zu finden, tippen Sie das Wort ein oder bewegen die Schreibmarke auf ein bereits vorhandenes Wort. Die Sprache des Wortes spielt keine Rolle – sie wird automatisch erkannt. Rufen Sie dann den Menübefehl Weitere > Langenscheidt auf.

TextMaker sucht das Wort nun in den Langenscheidt-Wörterbüchern.

Falls das Wort nicht gefunden wird, erscheinen ähnlichen geschriebene Wörter zur Auswahl. Ansonsten werden Übersetzungen für das Wort angezeigt.

Hinweis: Wenn Sie ein Wort aus einer Fremdsprache ins Deutsche übersetzen lassen, erhalten Sie nur die deutsche Übersetzung. Bei einem deutschen Wort werden hingegen Übersetzungen in allen vier unterstützten Fremdsprachen geliefert.

Die Schaltflächen im Dialog für diesen Befehl haben folgende Funktionen:

<table>
<thead>
<tr>
<th>Schaltfläche</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wörterbücher</td>
<td>Hier können Sie wählen, welche Sprachen berücksichtigt werden sollen. Wenn Sie beispielsweise nur Übersetzungen ins Englische benötigen, können Sie alle Sprachen außer Englisch abschalten.</td>
</tr>
<tr>
<td>Nachschlagen</td>
<td>Lässt Sie ein anderes Wort nachschlagen. Tippen Sie das Wort dazu erst im Feld Wort ein und betätigen Sie dann diese Schaltfläche.</td>
</tr>
<tr>
<td>Schließen</td>
<td>Schließt das Dialogfenster.</td>
</tr>
</tbody>
</table>

Textbausteine

Textbausteine bieten eine enorme Arbeitserleichterung: Sie können sich Textbausteine für häufig benötigte Floskeln anlegen und diese dann blitzschnell im Text abrufen.

Legen Sie beispielsweise einen Textbaustein namens "anf" mit dem Inhalt "Ihre Anfrage haben wir dankend erhalten" an. Nun können Sie diesen Baustein jederzeit abrufen. Tippen Sie dazu im Text einfach "anf" und dann die Leerstaste, die Eingabetaste \ oder ein Satzzeichen. Sofort wird "anf" durch "Ihre Anfrage haben wir dankend erhalten" ersetzt.

Auf diese Weise können Sie sich mit TextMaker Ihr persönliches "Computersteno" Zusammenstellen und beim Tippen viel Zeit sparen.
In diesem Abschnitt erfahren Sie alles über das Arbeiten mit Textbausteinen:

- **Textbausteine anlegen**
  Neue Textbausteine können dialoggesteuert mit dem Menübefehl **Einfügen > Textbaustein** oder über die Rechtschreibprüfung angelegt werden. Für jeden Textbaustein muss ein Name (z.B. "anf") und der gewünschte Inhalt angegeben werden (z.B. "Ihre Anfrage haben wir dankend erhalten").

- **Textbausteine abrufen**
  Wenn in den Programmeinstellungen die Option **Textbausteine automatisch ersetzen** aktiviert ist, lassen sich Textbausteine ganz einfach abrufen: Tippen Sie dazu den Namen des Bausteins und anschließend die Leertaste, die **Eingabetaste** oder ein Satzzeichen. Sofort wird der Name durch den Inhalt ersetzt.
  Alternativ lassen sich Bausteine mit dem Menübefehl **Einfügen > Textbaustein** von Hand einfügen.

- **Textbausteine bearbeiten**
  Mit dem Menübefehl **Einfügen > Textbaustein** lassen sich nicht nur neue Textbausteine anlegen, sondern auch vorhandene Bausteine bearbeiten, formatieren, umbenennen oder löschen. Ausführliche Informationen folgen auf den nächsten Seiten.

---

**Textbausteine anlegen**

Textbausteine lassen sich auf mehrere Arten anlegen. Welche Methode Sie verwenden, spielt dabei keine Rolle.

**A) Mit dem Befehl Einfügen > Textbaustein**

Um beispielsweise einen Baustein mit dem Namen "anf" und dem Inhalt "Ihre Anfrage haben wir dankend erhalten" anzulegen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Einfügen > Textbaustein** auf.
2. Klicken Sie auf die Schaltfläche **Neu**, um einen neuen Baustein anzulegen.
3. Geben Sie dem Baustein einen Namen (in unserem Beispiel also "anf"). Anhand seines Namens kann der Baustein später abgerufen werden.
5. Tippen Sie nun in dem großen Eingabefeld den Text für den Baustein ein (in unserem Beispiel also "Ihre Anfrage haben wir dankend erhalten").
6. Falls sich TextMaker die Formatierung des Textbausteins merken soll, müssen Sie noch die Option **Formatierung verwenden** einschalten. Nun können Sie die Mini-Formatleiste über dem Eingabefeld verwenden, um Schrift, Textauszeichnungen und Farbe einzustellen.
7. Klicken Sie auf **Speichern**, um Ihren neuen Textbaustein zu speichern.
8. Verlassen Sie den Dialog mit **Schließen**.

Der Baustein ist nun angelegt. Wie Sie ihn abrufen können, erfahren Sie im nächsten Abschnitt (**Textbausteine abrufen**).
**B) Über die Rechtschreibprüfung im Hintergrund**

Wenn Sie die *Rechtschreibprüfung im Hintergrund* aktiviert haben, lassen sich Textbausteine alternativ auch wie folgt anlegen:

1. Vergewissern Sie sich, dass auf der Karteikarte *Sprache* im Dialogfenster des Menübefehls *Weiteres > Einstellungen* die Option *Rechtschreibprüfung im Hintergrund verwenden* aktiviert ist.
2. Tippen Sie die drei Buchstaben "anf" und betätigen Sie die Leertaste.
4. Wählen Sie den Befehl *Textbaustein erzeugen*.
5. Tippen Sie "Ihre Anfrage haben wir dankend erhalten" ein.
6. Bestätigen Sie mit *OK*.

Das Ergebnis ist das Gleiche: Der Baustein "anf" ist nun angelegt worden.

Weitere Informationen zur Hintergrund-Rechtschreibprüfung können Sie bei Bedarf im Abschnitt *Rechtschreibprüfung im Hintergrund* nachlesen.

---

**Textbausteine abrufen**

Jetzt können Sie den im vorherigen Abschnitt erzeugten Textbaustein jederzeit abrufen.


*Hinweis:* Sollte dies nicht funktionieren, haben Sie die Option *Textbausteine automatisch ersetzen* deaktiviert. Rufen Sie den Menübefehl *Weiteres > Einstellungen* auf, wechseln Sie auf die Karteikarte *Sprache* und schalten Sie diese Option wieder ein.

Alternativ können Sie Bausteine auch per Dialog in den Text eingeben, indem Sie den Menübefehl *Einfügen > Textbaustein* aufrufen, den gewünschten Baustein auswählen und dann die Schaltfläche *Einfügen* betätigen.

Die Option *Formatierung verwenden* hat dabei folgende Bedeutung:

- **Aus:** Standardmäßig ist diese Option ausgeschaltet. Der Textbaustein wird also unformatiert eingefügt – sprich in der aktuell gewählten Schrift.

- **Ein:** Ist die Option hingegen eingeschaltet, wird der Textbaustein in der Schriftart und -größe eingefügt, die Sie im Dialog zum Anlegen des Bausteins eingestellt hatten. Auch Textauszeichnungen und die Schriftfarbe werden wiederhergestellt.
Textbausteine bearbeiten

Mit dem Menübefehl **Einfügen** > **Textbaustein** können Sie weiterhin die bereits angelegten Textbausteine bearbeiten:

- **Neuen Baustein anlegen**
  
  Betätigen Sie die Schaltfläche **Neu**, um einen neuen Textbaustein anzulegen (siehe Abschnitt **Textbausteine anlegen**).

- **Baustein löschen**
  
  Um einen Textbaustein zu löschen, selektieren Sie ihn in der Liste **Textbausteine** und betätigen dann die Schaltfläche **Löschen**.

- **Baustein umbenennen**
  
  Möchten Sie den Namen eines Bausteins ändern, selektieren Sie ihn in der Liste und klicken auf die Schaltfläche **Umbenennen**. Es erscheint ein Dialogfenster, in das Sie den neuen Namen eingeben können.

- **Baustein bearbeiten**
  
  Um einen Baustein zu bearbeiten, selektieren Sie ihn in der Liste und klicken dann in das große Eingabefeld rechts. Nun können Sie den Inhalt des Bausteins abändern.

  Weiterhin können Sie die Formatierung ändern, indem Sie die Mini-Formatleiste oberhalb des Eingabefelds verwenden. Dies geht natürlich nur, wenn die Option **Formatierung verwenden** eingeschaltet wurde.

  Wenn Sie die gewünschten Änderungen angebracht haben, klicken Sie auf die Schaltfläche **Speichern**.

- **Baustein einfügen**
  
  Um einen Baustein in den Text einzufügen, selektieren Sie ihn in der Liste und klicken auf die Schaltfläche **Einfügen** (siehe auch Abschnitt **Textbausteine abrufen**).

Mit der Schaltfläche **Schließen** können Sie den Dialog schließlich verlassen.
TextMaker enthält ein einfach zu bedienendes dBase-kompatibles Datenbankmodul, das nahtlos in die Textverarbeitung integriert ist. Dieses bietet alle zum Verwalten von Adressen und anderen Informationen benötigten Funktionen: Sie können Daten eingeben und bearbeiten, nach bestimmten Daten suchen und vieles mehr.

In diesem Kapitel erfahren Sie alles Wissenswerte zum Umgang mit Datenbanken in TextMaker:

- **Datenbank öffnen**
  Im ersten Abschnitt erfahren Sie, wie man eine Datenbank öffnet. Der Menübefehl **Weiteres > Datenbank bearbeiten** ist dafür zuständig.

- **Datenbankmodul verwenden**

- **Übernahme von Einzeladressen** (über Dokumentvorlagen)

- **Listen und Aufkleber herstellen**

- **Briefumschläge bedrucken**
  Auf ähnliche Weise können Sie auch Briefumschläge bedrucken. Sie müssen lediglich das Papierformat auswählen und Absender und Empfänger festlegen.

- **Anlegen neuer Datenbanken**
  Obwohl vielen Anwendern die mitgelieferte Datenbank *tmw.dbf* für die Verwaltung ihrer Adressen völlig ausreicht, können Sie mit TextMaker jederzeit neue Datenbanken im dBase-Format anlegen. Hier erfahren Sie, wie das geht.

- **Ändern der Struktur von Datenbanken**
  Sie können jederzeit die Struktur bestehender Datenbanken modifizieren – also beispielsweise Felder hinzufügen/löschen oder die Eigenschaften von Feldern ändern (Name, Typ, Länge etc.)

- **Thunderbird-Adressbuch importieren**

**Datenbank öffnen**

Um eine Datenbank zu öffnen, rufen Sie den Menübefehl **Weiteres > Datenbank bearbeiten** auf. Es erscheint ein Dialogfenster, in dem Sie auswählen können, welche Datenbank geöffnet werden soll. Tippen Sie dazu den Dateinamen ein oder wählen Sie eine Datei aus der Liste.

**Anmerkungen zu den unterstützten Datenbankformaten**

TextMaker kann alle Datenbanken im dBase-Format öffnen. Das dBase-Format ist ein weitverbreitetes Datenbankformat, das von vielen Datenbankprogrammen unterstützt wird.

Folgende Varianten des dBase-Formats werden unterstützt:

<table>
<thead>
<tr>
<th>Dateiformat</th>
<th>Beschreibung</th>
</tr>
</thead>
<tbody>
<tr>
<td>dBase/DOS</td>
<td>Für Datenbanken mit DOS-Zeichensatz. Dies ist das Standardformat – siehe Anmerkung unten!</td>
</tr>
<tr>
<td>dBase/Windows</td>
<td>Für Datenbanken mit Windows-Zeichensatz</td>
</tr>
</tbody>
</table>

Das Dateiformat bestimmen Sie, indem Sie im obigen Dialogfenster die Liste der Dateitypen öffnen und darin das gewünschte Format wählen.

**Anmerkung:** Die meisten Datenbanken sind im Format dBase/DOS gespeichert. Auch Windows-Datenbankprogramme verwenden in der Regel das DOS-Format statt des Windows-Formats.

Wenn Sie sich nicht sicher sind, ob die zu öffnende Datenbank das DOS- oder das Windows-Format verwendet, öffnen Sie diese als dBase/DOS und sehen Sie nach, ob Akzentzeichen (z.B. Umlaute) darin korrekt angezeigt werden. Ist dies nicht der Fall, schließen Sie die Datenbank und öffnen sie erneut, wählen diesmal aber das Dateiformat dBase/Windows.

**Datenbankmodul verwenden**

Wenn Sie, wie im letzten Abschnitt beschrieben, eine Datenbank öffnen, erscheint das Datenbankmodul von TextMaker.
Dieses lässt Sie nicht nur Datenbanken bearbeiten, sondern bietet auch einige erweiterte Funktionen. In diesem Abschnitt stellen wir Ihnen alle Funktionen des Datenbankmoduls ausführlich vor.

Folgende Themen werden darin behandelt:

- **Das Arbeitsfenster des Datenbankmoduls**
- **Listen und Formularansicht**
- **Blättern zwischen Datensätzen**
- **Datensatz anhand seiner Satznummer aufrufen**
- **Datenbank durchsuchen**
- **Datensätze bearbeiten und neue anlegen**
- **Datensätze löschen und wiederherstellen**
- **Datenbank sortieren**
- **Datenbank schließen**

Lesen Sie dazu die nächsten Seiten.

---

### Das Arbeitsfenster des Datenbankmoduls


Wenn Sie diese öffnen, wird Ihnen ein Datenbankfenster präsentiert, das beispielsweise wie folgt aussieht:

![Datenbankfenster](image)

*Die Beispieldatenbank tmw.dbf (in der Formularansicht)*
Falls bei Ihnen stattdessen eine tabellarische Liste der Datensätze erscheint, können Sie jederzeit den Menübefehl **Ansicht > Formular** aufrufen, um zwischen der Listenansicht und der oben abgebildeten Formularansicht zu wechseln.

Wenn Sie möchten, können Sie die Beispieldatenbank *tmw.dbf* gleich als Ihre persönliche Adressdatenbank verwenden. Diese enthält alle für das Erfassen von Adressen benötigten Datenbankfelder:

<table>
<thead>
<tr>
<th>Feld</th>
<th>Beschreibung</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANBK</td>
<td>Anrede im Briefkopf (z.B. &quot;Herr&quot;)</td>
</tr>
<tr>
<td>ANBR</td>
<td>Anrede im Brieftext (z.B. &quot;Sehr geehrter Herr Schneider&quot;)</td>
</tr>
<tr>
<td>NAME1</td>
<td>Erste Zeile für den Namen (zum Beispiel der Nachname)</td>
</tr>
<tr>
<td>NAME2</td>
<td>Zweite Zeile für den Namen (zum Beispiel der Firmenname)</td>
</tr>
<tr>
<td>VORNAME</td>
<td>Vorname</td>
</tr>
<tr>
<td>STRASSE</td>
<td>Straße und Hausnummer</td>
</tr>
<tr>
<td>PLZ</td>
<td>Postleitzahl</td>
</tr>
<tr>
<td>ORT</td>
<td>Ort</td>
</tr>
<tr>
<td>TELEFON</td>
<td>Telefonnummer</td>
</tr>
<tr>
<td>TELEFAX</td>
<td>Telefaxnummer</td>
</tr>
<tr>
<td>BEMERK1</td>
<td>Erste Zeile für Bemerkungen</td>
</tr>
<tr>
<td>BEMERK2</td>
<td>Zweite Zeile für Bemerkungen</td>
</tr>
<tr>
<td>BEMERK3</td>
<td>Dritte Zeile für Bemerkungen</td>
</tr>
</tbody>
</table>

Auf dem Bildschirm sehen Sie jetzt den ersten Datensatz der Datenbank, bestehend aus mehreren Datenfeldern. Ein **Datenfeld** ist eine Informationseinheit, zum Beispiel also der Vornamen. Die gesamte Information, die Sie für eine Person eingeben (Anrede, Name, Adresse etc.) bildet einen **Datensatz**.

In der Statuszeile (am unteren Ende des Programmfensters) können Sie die folgenden Informationen ablesen:

- Als erstes wird die Nummer des aktuellen Datensatzes (die **Datensatznummer**) und die Gesamtzahl der Datensätze in der Datenbank angezeigt ("Satz 1 von x").

- Rechts daneben erscheinen folgende Statusinformationen:
  
  **Gelöscht**, falls der Datensatz zum Löschen markiert ist
  
  **Selektiert**, falls der Datensatz selektiert ist

  Das Selektieren von Datensätzen wird im Abschnitt **Datensätze für den Serienbriefdruck wählen** beschrieben.

- Ganz rechts können Sie den **Feldtyp** des aktuellen Feldes ablesen, der bestimmt, welche Eingaben in das Feld zulässig sind:

<table>
<thead>
<tr>
<th>Feldtyp</th>
<th>Zulässige Eingaben</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zeichen</td>
<td>Beliebige Eingaben</td>
</tr>
<tr>
<td>Numerisch</td>
<td>Zahlen</td>
</tr>
<tr>
<td>Datum</td>
<td>Datumsangaben im Format TT.MM.JJ (z.B. &quot;16.04.18&quot;) oder TT.MM.JJJJ (z.B. &quot;16.04.2018&quot;)</td>
</tr>
<tr>
<td>Logisch</td>
<td>Nur J für Ja oder N für Nein</td>
</tr>
<tr>
<td>Memo</td>
<td>Notizen – diese können nach Betätigen der Taste <strong>F9</strong> bearbeitet werden.</td>
</tr>
</tbody>
</table>

Dahinter wird die maximale Länge des Feldes angegeben.

**Welches Jahrtausend?** Beachten Sie beim Ausfüllen von Datumsfeldern: Wenn Sie eine zweistellige Jahreszahl zwischen 0 und 29 eingeben, stellt TextMaker automatisch "20..." voran. Bei Jahreszahlen zwischen 30 und 99 stellt TextMaker "19..." voran.
Die Eingabe "01.01.29" wird also als 1.1.2029 interpretiert, die Eingabe "01.01.30" hingegen als 1.1.1930.

Listen und Formularansicht

Das Datenbankmodul kann Datenbanken auf zwei verschiedene Arten darstellen:

- **Listenansicht** bietet den besten Überblick über die Datenbank. Hier sehen Sie mehrere Datensätze in Tabellenform untereinander aufgelistet.
- **Formularansicht** eignet sich besser zur Betrachtung einzelner Datensätze. Hier werden die Felder eines einzigen Datensatzes wie in einem Formular dargestellt.

**Hinweis:** In der Listenansicht lassen sich keine Daten eingeben. Dies ist nur in der Formularansicht möglich.

Um zwischen Listen- und Formularansicht umzuschalten, rufen Sie den Menübefehl Ansicht > Formular auf. Erscheint ein Häkchen vor diesem Menübefehl, ist die Formularansicht aktiv, ansonsten die Listenansicht.

**Tipp:** Über die Taste F2 können Sie blitzschnell zwischen diesen beiden Ansichtsarten wechseln. Weiterhin zeigt ein Doppelklick auf einen Datensatz in der Listenansicht dessen Formularansicht an.

Blättern zwischen Datensätzen

Zum Bewegen zwischen den Datensätzen einer Datenbank stehen sowohl Tasten als auch Symbole in der Funktionsleiste zur Verfügung:

<table>
<thead>
<tr>
<th>Taste</th>
<th>Symbol</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bild↑</td>
<td><img src="image" alt="Symbol" /></td>
<td>Zum vorherigen Datensatz (in der Listenansicht: zur vorherigen Seite)</td>
</tr>
<tr>
<td>Bild↓</td>
<td><img src="image" alt="Symbol" /></td>
<td>Zum nächsten Datensatz (in der Listenansicht: zur nächsten Seite)</td>
</tr>
<tr>
<td>Strg+Alt+Bild↑</td>
<td><img src="image" alt="Symbol" /></td>
<td>Zum vorherigen selektierten Datensatz</td>
</tr>
<tr>
<td>Strg+Alt+Bild↓</td>
<td><img src="image" alt="Symbol" /></td>
<td>Zum nächsten selektierten Datensatz</td>
</tr>
<tr>
<td>Strg+Bild↑</td>
<td><img src="image" alt="Symbol" /></td>
<td>Zum ersten Datensatz</td>
</tr>
<tr>
<td>Strg+Bild↓</td>
<td><img src="image" alt="Symbol" /></td>
<td>Zum letzten Datensatz</td>
</tr>
</tbody>
</table>
**Datensatz anhand seiner Satznummer aufrufen**

Bei der *Datensatznummer* (kurz: *Satznummer*) handelt es sich um einen einfachen Zähler. Der erste Datensatz hat die Nummer 1, der zehnte 10 usw. Die Satznummer des aktuellen Datensatzes wird links unten in der Statuszeile angezeigt.

Sie können einen Datensatz im Datenbankmodul direkt anhand seiner Satznummer aufrufen. Rufen Sie dazu den Menübefehl **Gehe zu > Satznummer** auf.

Es erscheint ein Dialogfenster, in das Sie die gewünschte Satznummer eintragen und mit **OK** bestätigen. Der zugehörige Datensatz wird dann sofort aufgeblättert.

Noch schneller geht dies, wenn Sie mit der Maus auf die Satznummer klicken, die in der Funktionsleiste angezeigt wird, und die gewünschte Satznummer hier einfach eintippen.

---

**Datenbank durchsuchen**

Mit Hilfe des Menübefehls **Bearbeiten > Suchen** können Sie die Datenbank im Datenbankmodul nach einem Begriff durchsuchen lassen.

Die Suchfunktion lässt sich auch über das Symbol in der Funktionsleiste aufrufen.

![Suchen Fenster](image)

Wenn Sie einen Suchbegriff eingegeben und mit **OK** bestätigt haben, beginnt TextMaker mit der Suche. Sobald der Begriff in einem Datensatz gefunden wird, zeigt TextMaker den Datensatz an und beendet den Suchvorgang.

**Suche fortsetzen**

Mit dem Symbol in der Funktionsleiste oder durch Aufruf des Menübefehls **Bearbeiten > Weitersuchen** weisen Sie TextMaker an, die nächste Fundstelle anzuzeigen.
Hinweise zum Suchbegriff

**Datumsfelder:** Möchten Sie nach Datumsangaben in Datumsfeldern suchen, müssen Sie diese im Format TT.MM.JJJJ eingegeben – für den 25. September 2018 ist also 25.09.2018 einzutippen.

**Memofelder:** Memofelder lassen sich mit der Suchfunktion nicht durchsuchen.


Optionen im Suchen-Dialog

Über die Optionen im Suchen-Dialog können Sie folgendermaßen auf die Suche Einfluss nehmen:

- **In Feld**
  Wählen Sie hier die Einstellung *Alle Felder* aus, wenn alle Felder der Datenbank durchsucht werden sollen. Alternativ können Sie ein bestimmtes Feld auswählen, wenn nur dieses durchsucht werden soll.

- **Ab erstem Datensatz suchen**
  Ist dieser Schalter aktiviert, beginnt TextMaker die Suche beim ersten Datensatz; es wird also die komplette Datenbank durchsucht. Ändernfalls beginnt die Suche erst mit dem aktuellen Datensatz.

- **Rückwärts suchen**
  Ist dieser Schalter aktiviert, wird die Datenbank in umgekehrter Reihenfolge durchsucht.

- **Groß-/Kleinschreibung beachten**
  Ist dieser Schalter aktiviert, wird die Groß-/Kleinschreibung des Suchbegriffs berücksichtigt. Bei einer Suche nach "Haus" würde also nur "Haus" gefunden – "HAUS", "haus" etc. hingegen nicht.

- **Nur selektierte Datensätze**
  Ist dieser Schalter aktiviert, werden nur die selektierten Datensätze durchsucht, ansonsten alle Datensätze (siehe auch Abschnitt *Datensätze für den Serienbriefdruck wählen*).

- **Genauigkeit**
  Legt fest, wie genau der Feldinhalt mit dem Suchbegriff übereinstimmen muss:

  **Suchbegriff an beliebiger Stelle im Feld:** Es werden alle Datensätze gefunden, bei denen das durchsuchte Feld den Suchbegriff an beliebiger Position enthält.

  **Feld beginnt mit Suchbegriff:** Es werden nur Datensätze gefunden, bei denen das Feld mit dem Suchbegriff beginnt. Suchen Sie also nach "Fisch", werden nur Felder gefunden, die mit "Fisch" beginnen (also beispielsweise auch "Fischer"), nicht hingegen Felder mit dem Inhalt "Helmut Fischer".

  **Feld stimmt mit Suchbegriff überein:** Hier findet die Suchfunktion nur Datensätze, bei denen der komplette Feldinhalt mit dem Suchbegriff übereinstimmt. Suchen Sie also nach "Fisch", werden nur Felder mit genau dem Inhalt "Fisch" gefunden, Felder mit "Fischer" hingegen nicht.
Datenbank

**Datensätze bearbeiten und neue anlegen**

*Wichtig:* Datensätze lassen sich nur in der *Formularansicht* des Datenbankmoduls abändern. Um zwischen Listen- und Formularansicht umzuschalten, rufen Sie den Menübefehl *Ansicht > Formular* auf. Erscheint ein Häkchen vor diesem Menübefehl, ist die Formularansicht aktiv, ansonsten die Listenansicht.

Zum Bearbeiten eines Datensatzes setzen Sie einfach die Schreibmarke in das gewünschte Datenfeld und nehmen Ihre Änderungen vor. Mit der Tabulatortaste *Tab* können Sie zum nächsten, mit *Umschalt+Tab* zum vorherigen Datenfeld gelangen.

*Hinweis:* Sie müssen zum Speichern von Änderungen an einem Datensatz *keinen* Befehl aufrufen, denn Änderungen am aktuellen Datensatz werden automatisch gespeichert, wenn Sie zu einem anderen Satz blättern oder die Datenbank verlassen.

**Einen neuen Datensatz anhängen**

Wenn Sie Ihre Datenbank um einen zusätzlichen Eintrag erweitern möchten, rufen Sie im Datenbankmodul den Menübefehl *Bearbeiten > Datensatz anhängen* auf.

Dieser Befehl lässt sich auch über das Symbol in der Funktionsleiste aufrufen.

TextMaker hängt einen leeren Datensatz an die Datenbank an und stellt die Schreibmarke auf das erste Feld des Datensatzes. Sie können sofort mit dem Ausfüllen des Datensatzes beginnen.

Neue Datensätze werden grundsätzlich *hinter* die bereits existierenden Sätze angehängt.

**Datensatz duplizieren**

Mit dem Menübefehl *Bearbeiten > Datensatz duplizieren* können Sie ein Duplikat eines Datensatzes anlegen. Blättern Sie dazu zu dem gewünschten Datensatz und rufen Sie diesen Befehl dann auf.

Duplizierte Datensätze werden, genau wie neu angelegte Datensätze, stets an das Ende der Datenbank angehängt.

**Datensätze löschen und wiederherstellen**

Nicht mehr benötigte Datensätze lassen sich im Datenbankmodul jederzeit löschen.

**Datensatz löschen**

Um einen Datensatz zu löschen, rufen Sie den Menübefehl *Bearbeiten > Aktuellen Datensatz löschen* auf.

Diese Funktion lässt sich auch über das Symbol in der Funktionsleiste aufrufen.
Der Datensatz wird nun allerdings nicht sofort gelöscht, sondern nur zum Löschen markiert. Das tatsächliche Löschen aller zum Löschen markierten Datensätze geschieht durch das Komprimieren der Datenbank über den Menübefehl Bearbeiten > Datenbank komprimieren (siehe unten).

### Alle selektierten Datensätze löschen
Mit dem Menübefehl Bearbeiten > Selektierte Datensätze löschen markieren Sie alle derzeit selektierten Datensätze zum Löschen. Dies ist praktisch, wenn Sie eine große Menge an Datensätzen löschen möchten. Das Arbeiten mit Selektionen wird im Abschnitt Datensätze für den Serienbriefdruck wählen beschrieben.

### Gelöschte Datensätze anzeigen?
Standardmäßig ist die Option Gelöschte Datensätze anzeigen eingeschaltet, was bedeutet, dass auch zum Löschen markierte Datensätze angezeigt werden. Um kenntlich zu machen, dass diese Sätze gelöscht sind, erscheint das Wort Gelöscht in der Statuszeile.

Sie können diese Option mit dem Menübefehl Ansicht > Gelöschte Datensätze anzeigen allerdings jederzeit deaktivieren, um die zum Löschen markierten Datensätze zu verbergen.

### Gelöschte Datensätze wiederherstellen

Mit dem Menübefehl Bearbeiten > Gelöschte Datensätze wiederherstellen können Sie weiterhin die Löschmarkierung aller momentan zum Löschen markierten Datensätze aufheben.

### Gelöschte Datensätze tatsächlich entfernen (Datenbank "komprimieren")

### Datenbank sortieren
Sie können Datenbanken auch sortieren lassen. Rufen Sie dazu im Datenbankmodul den Menübefehl Bearbeiten > Sortieren auf.

Diese Funktion lässt sich auch über das Symbol in der Funktionsleiste aufrufen.
Wählen Sie in dem Dialog bei **Feld 1** das Feld aus, nach dem sortiert werden soll.

Wenn nötig, können Sie auch nach zwei Feldern sortieren lassen: Soll beispielsweise nach dem Nachnamen und innerhalb dieser Reihenfolge zusätzlich nach dem Vornamen sortiert werden, wählen Sie bei **Feld 1** NAME1 und bei **Feld 2** VORNAME.

Sobald Sie mit **OK** bestätigen, werden die Datensätze umsortiert und die Datenbank in der neuen Reihenfolge gespeichert.

*Hinweis:* Beim Sortieren werden die Datensätze physikalisch in der Datenbank umgegruppiert. Diese Akti-on kann nicht rückgängig gemacht werden.

---

**Datenbank schließen**

Wenn Sie die derzeit geöffnete Datenbank wieder schließen möchten, rufen Sie den Menübefehl **Datei > Schließen** auf. Die Datenbank wird automatisch gespeichert und dann geschlossen.

Sie können stattdessen auch den Menübefehl **Datei > Datensatz kopieren und beenden** verwenden, der das Gleiche tut, zuvor jedoch den Inhalt des aktuellen Datensatzes in die Zwischenablage kopiert.

Der Menübefehl **Datei > Datensatz einfügen und beenden** steht dann zur Verfügung, wenn die Datenbank über eine Dokumentvorlage aufgerufen wurde, womit sich der Abschnitt **Übernahme von Einzeladressen** be fasst.

---

**Übernahme von Einzeladressen**


Sie benötigen dazu lediglich eine passende **Dokumentvorlage** – nämlich eine Dokumentvorlage, der erstens eine Adressdatenbank zugewiesen wurde und in die zweitens Datenbankfelder aus dieser Adressdatenbank eingefügt wurden. Einige solche Vorlagen (für Briefe, Faxe, Memos etc.) und eine passende Datenbank werden bei TextMaker gleich mitgeliefert.

Auf den nächsten Seiten finden Sie ausführliche Erläuterungen hierzu.

### Dokumentvorlage erstellen

**Hinweis:** Um einfach schnell einen Brief oder ein Fax zu erstellen, müssen Sie nicht unbedingt eigene Dokumentvorlagen erstellen. Zahlreiche Dokumentvorlagen mit Briefköpfen, Faxformularen und Memo-vordrucken werden mit TextMaker nämlich bereits mitgeliefert. Lesen Sie den Abschnitt **Dokumentvorlage anwenden**, um zu erfahren, wie Sie diese sofort ausprobieren können.

Um eine neue Dokumentvorlage für das Einfügen von Einzeladressen zu erstellen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Datei > Neu** auf und wählen Sie die Vorlage `normal.tmvx`, um einen neuen Text zu beginnen.
2. Füllen Sie das Dokument mit dem gewünschten Text – erstellen Sie beispielsweise einen Briefkopf, ein Faxformular etc.
4. Rufen Sie an den gewünschten Textstellen den Menübefehl **Einfügen > Feld** auf, um dort Datenbankfelder aus der zugewiesenen Datenbank einzusetzen (siehe auch Abschnitt **Datenbankfelder einfügen**).
5. Rufen Sie den Menübefehl **Datei > Speichern unter** auf.
6. Wählen Sie in der Liste **Dateityp** den Eintrag **Dokumentvorlage**.
7. TextMaker wechselt automatisch in den Ordner für Dokumentvorlagen.
8. Tragen Sie bei **Dateiname** einen Namen für die Vorlage ein und bestätigen Sie mit **OK**.

Im Prinzip müssen Sie also vorgehen, als ob Sie einen Serienbrief (ohne Brieftext) erstellen möchten, und diesen anschließend als Dokumentvorlage speichern.

Wenn Sie mehr über das Arbeiten mit Dokumentvorlagen erfahren möchten, lesen Sie die grundlegenden Informationen im Abschnitt **Dokumentvorlagen**. Als Anschauungsbeispiel können Sie auch eine der mitgelieferten Dokumentvorlagen öffnen.

### Dokumentvorlage anwenden

Wenn Sie sich hier eine Vorlage aussuchen, der eine Datenbank zugewiesen ist, zeigt TextMaker diese Datenbank an und lässt Sie auswählen, welcher Datensatz in den Text eingefügt werden soll. Blättern Sie zum gewünschten Datensatz und klicken Sie dann auf die Schaltfläche **Einfügen**.

Die Schritte im Einzelnen:

1. Rufen Sie den Menübefehl **Datei > Neu** auf.

2. Wählen Sie eine von Ihnen erstellte Dokumentvorlage mit Datenbankanbindung oder eine der mitgelieferten Vorlagen und bestätigen Sie mit **OK**.

3. Nun erscheint ein Dialog, in dem die entsprechende Datenbank angezeigt wird.

   ![Datenbankdialog](image)

   Tipp: Mit den beiden Optionen in der rechten unteren Ecke des Dialogs können Sie zwischen den Ansichten **Liste** und **Formular** umschalten.


   Sie können auch eine neue Adresse eintippen, nachdem Sie mittels der Schaltfläche **Anhängen** einen neuen Datensatz angelegt haben.

   (Auszuführlische Informationen zur Bedienung dieses Dialogs finden Sie weiter unten.)

5. Klicken Sie auf die Schaltfläche **Einfügen**.

   TextMaker ersetzt nun jede Stelle, an der sich in der Vorlage ein Datenbankfeld befindet, durch den Inhalt des korrespondierenden Feldes aus diesem Datensatz.

**Tipp:** Im Dialogfenster des Menübefehls **Datei > Neu** sehen Sie auch einige Ordner. Diese lassen sich per Doppelklick öffnen. Sie enthalten bereits vorgefertigte Dokumentvorlagen für das Schreiben von Briefen, Faxen etc. Den meisten dieser Vorlagen wurde die mitgelieferte Beispieldatei *tmw.dbf* zugewiesen.

### Bedienung des Datenbank-Dialogs

Der Datenbank-Dialog, der hierbei erscheint, hat folgende Bedienelemente:

**Datenanzeige**

Den größten Teil des Fensters nimmt die Anzeige der Daten ein.

Sie können die Daten entweder tabellarisch in der **Listenansicht** oder in der ausführlicheren **Formularansicht** betrachten. Um die gewünschte Ansicht auszuwählen, klicken Sie im unteren Teil des Fensters auf die Option **Liste** beziehungsweise **Formular**.

**Wichtig:** Beachten Sie, dass das Editieren der Daten nur in der **Formularansicht** möglich ist.

Zum Speichern von Änderungen an den Daten müssen Sie **keinen** Befehl aufrufen, denn Änderungen am aktuellen Datensatz werden automatisch gespeichert, wenn Sie zu einem anderen Satz blättern oder die Datenbank verlassen.

**Filter**

Sie können die Datensätze bei Bedarf **filtern** lassen. Tragen Sie dazu den Begriff, nach dem gesucht werden soll, in das Eingabefeld **Filter** ein und betätigen Sie die Schaltfläche **Anwenden**. Sofort ändert sich die Anzeige der Daten: es werden nur noch Datensätze angezeigt, die den Suchbegriff (in einem beliebigen Datenfeld) enthalten.

Filtern Sie also zum Beispiel nach "Müller", werden nur noch Datensätze angezeigt, bei denen eines der Felder den Begriff "Müller" enthält.

**Schaltfläche "Einfügen"**

Fügt den Inhalt des aktuellen Datensatzes in das Dokument ein. Nur verfügbar, wenn die Datenbank über eine Dokumentvorlage aufgerufen wurde, wie oben beschrieben.

**Schaltfläche "Schließen"**

Schließt die Datenbank. Alle Änderungen an der Datenbank werden dabei automatisch gespeichert.

**Schaltfläche "Suchen"**

Ruft einen Suchen-Dialog auf, mit dem Sie genauer als mit einem Filter (siehe oben) nach bestimmten Daten suchen können. Informationen zu diesem Dialog finden Sie im Abschnitt **Datenbank durchsuchen**.

**Schaltfläche "Weitersuchen"**

Zeigt die nächste Fundstelle einer Suche an.
### Schaltfläche "Anhängen"

Hängt einen neuen Datensatz an die Datenbank an.

### Liste/Formular

Mit den Optionen **Liste** und **Formular** können Sie zwischen der **Listenansicht** (mehrere Datensätze untereinander) und der **Formularansicht** (ein kompletter Datensatz im Detail) umschalten.

---

### Listen und Aufkleber herstellen

Mit dem Menübefehl **Einfügen > Liste/Aufkleber** können Sie mit wenig Aufwand Listen und Etiketten aller Art anfertigen. In erster Linie ist dieser Befehl zum Anlegen von Adressaufklebern gedacht. Die zugehörigen Adressen sollten in Form einer **Datenbank** vorliegen. (Grundlegende Informationen zum Arbeiten mit Datenbanken finden Sie in den ersten Abschnitten des Kapitels **Datenbank**).
Neben Aufklebern können Sie mit diesem Befehl auch Listen und Tabellen mit den Daten einer Datenbank herstellen. Die Unterschiede:

- **Aufkleber**: Zum Herstellen von Aufklebern, zum Beispiel Adressaufklebern mit je einer Adresse (aus einer Datenbank) pro Aufkleber.
- **Liste**: Zum Herstellen von Listen, zum Beispiel Adresslisten mit einer Adresse pro Zeile – also etwa "Helmut Müller, Hauptstraße 42a, 54321 Gunzenhausen,...".
- **Tabelle**: Ähnlich wie Listen, allerdings werden die Daten hier auf Tabellenzellen verteilt (eine Adresse pro Zelle).


**Tipp:** Mit Hilfe der Schaltfläche Verwalten können Sie einmal angelegte Aufkleberdefinitionen (sprich: alle in dem Dialog gemachten Einstellungen) dabei speichern und zu einem beliebigen späteren Zeitpunkt wieder abrufen. Dies funktioniert auch mit Listen und Tabellen.

**Listen/Aufkleber anlegen**

Um beispielsweise Aufkleber anzulegen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Einfügen > Liste/Aufkleber auf.
2. Wählen Sie bei Ausgabe als, was Sie herstellen möchten: einen Aufkleber, eine Liste oder eine Tabelle. In unserem Beispiel wählen Sie also: Aufkleber.
3. Falls Sie in dem Aufkleber die Inhalte einer Datenbank ausgeben möchten: Klicken Sie auf die Schaltfläche Datenbank und wählen Sie die gewünschte Datenbank aus – zum Beispiel die mitgelieferte Adressdatenbank tmw.dbf.

Um Datenbankfelder einzufügen, verwenden Sie am besten die Schaltfläche Datenbankfeld. Diese zeigt eine Liste aller Felder an. Klicken Sie eines davon an, wird es an der aktuellen Position der Schreibmarke eingefügt.

Die Mini-Formatleiste oberhalb des Eingabefelds können Sie bei Bedarf verwenden, um die Formatierung von Text in dem Eingabefeld ändern (Schriftart, Schriftgröße etc.). Selektieren Sie zuvor den zu ändernden Text.

Wenn das Eingabefeld fertig ausgefüllt ist, fahren Sie folgendermaßen fort:

5. Bei Aufklebern müssen Sie nun noch auf die Schaltfläche Format klicken und das Format der Aufkleber einstellen, die Sie bedrucken möchten. Wählen Sie dazu den Hersteller und die Bezeichnung des Aufklebers aus den Listen aus.

 Falls Sie einen Aufkleber verwenden, der nicht in der Liste enthalten ist, können Sie in diesem Unterdialog auf die Schaltfläche Neu klicken und eigene Maße eingeben (siehe Erläuterung der Optionen des Dialogs weiter unten).

7. Wenn alles fertig ist, betätigen Sie eine der folgenden Schaltflächen:

**Drucken:** Druckt den Aufkleber aus. Dazu erscheint der übliche Drucken-Dialog.

**Neues Dokument:** Legt stattdessen ein neues Dokument mit dem (fertig ausgefüllten) Aufkleber an.

**Verwalten:** Mit Hilfe dieser Schaltfläche können Sie Aufkleberdefinitionen (also alle in diesem Dialog gemachten Einstellungen) speichern und später jederzeit wieder abrufen. Dies funktioniert sowohl mit Aufklebern, als auch mit Listen und Tabellen. Mehr dazu ganz am Ende dieses Abschnitts.

Das Anlegen von Listen und Tabellen funktioniert entsprechend. Im Vergleich zu Aufklebern stehen dabei lediglich weniger Optionen zur Verfügung. Außerdem wird die Schaltfläche **Drucken** hier durch eine Schaltfläche namens **Einfügen** ersetzt. Diese fügt die Liste/Tabelle an der aktuellen Position in das Dokument ein.

**Optionen des Dialogs**

Die Optionen im Dialogfenster des obigen Befehls haben folgende Funktionen:

- **Großes Eingabefeld oben**

  In das große Eingabefeld im oberen Teil des Dialogs tragen Sie die gewünschten Inhalte für den Aufkleber (beziehungsweise der Liste oder Tabelle) ein – genau so, wie diese später auf dem Aufkleber erscheinen sollen. Ein Beispiel sehen Sie in der Abbildung am Beginn dieses Abschnitts.

  Um dort Text hinzuzufügen, tippen Sie diesen einfach ein.

  Sie können auch Datenbankfelder einfügen (sofern Sie über die Schaltfläche **Datenbank** eine Datenbank ausgewählt haben): Um ein Feld einzufügen, klicken Sie auf die Schaltfläche **Datenbankfeld** und wählen dann das gewünschte Feld aus. Alternativ können Sie auch einfach den Feldnamen mit geschweiften Klammern eintippen (z.B. `{VORNAME}`).

  Mit der **Mini-Formatleiste** oberhalb des Eingabefelds können Sie den Text in dem Eingabefeld auf Wunsch auch formatieren. Gehen Sie dazu vor wie in einem normalen Dokument: erst Text markieren, dann Formatierung anbringen.

- **Ausgabe als**

  Hier bestimmen Sie, was der Befehl liefern soll: **Aufkleber**, eine **Liste** oder eine **Tabelle**.

- **Format**

  **Nur bei Aufklebern:** Hier wird angezeigt, welches Aufkleberformat momentan ausgewählt ist (Hersteller, Bezeichnung, Zahl der Zeilen/Spalten).

  Um ein anderes Format zu wählen, klicken Sie auf die Schaltfläche **Format**. Wählen Sie dann den Hersteller und die Bezeichnung des Aufklebers aus den Listen aus. Sie können hier auch die Ränder einstellen, die in jedem (einzelen) Aufkleber freigelassen werden sollen.

  Falls Sie Aufkleber verwenden, die TextMaker nicht kennt, können Sie jederzeit auf die Schaltfläche **Neu** klicken, um ein neues benutzerdefiniertes Aufkleberformat zu definieren. Tragen Sie dazu Hersteller und Bezeichnung/Nummer des Aufklebers ein (sofern bekannt). Vermessen Sie den Aufkleber dann mit einem Lineal und tragen Sie die ermittelten Werte in den Dialog ein.

  Die folgende Abbildung verdeutlicht den Zusammenhang zwischen einigen der Werte:
Über die Schaltfläche **Bearbeiten** können Sie zuvor angelegte benutzerdefinierte Aufkleberformate erneut überarbeiten. Die vorgegebenen Formate können nicht verändert werden – Sie können aber jederzeit ein benutzerdefiniertes Format auf Basis eines der vordefinierten Formate anlegen, indem Sie dieses in der Liste selektieren und dann auf die Schaltfläche **Neu** klicken.

Die Schaltfläche **Löschen** löscht das selektierte benutzerdefinierte Format.

- **Schaltfläche "Datenbank"**
  Aufkleber und Listen werden häufig dazu verwendet, die Inhalte einer Datenbank auszugeben. Wenn Sie auf die Schaltfläche **Datenbank** klicken, können Sie festlegen, welche Datenbank dies sein soll – zum Beispiel die mitgelieferte Adressdatenbank t.mw.dbf.

- **Schaltfläche "Datenbankfeld"**

- **Rubrik "Datenbank"**
  In der Rubrik "Datenbank" wird der Pfad und Name der momentan ausgewählten Datenbank angezeigt (siehe Schaltfläche **Datenbank** weiter oben). Außerdem können Sie hier bestimmen, welche Datensätze der Datenbank verwendet werden sollen: **Alle**, nur **Selektierte** (siehe Abschnitt Datenbankfelder für den Serienbriefdruck wählen) oder ein **Bereich** von Datensätzen, den Sie durch Eintragen der ersten und letzten Satznummer festlegen können.

- **Rubrik "Optionen"**
  Dieser Bereich ändert sich abhängig davon, was Sie bei **Ausgabe als** gewählt haben:

  **Aufkleber:**
  Bei Aufklebern können Sie hier folgende Einstellungen zur Ausgabe des Aufklebers machen:


  Kopien: Hier können Sie einstellen, wie viele Kopien von jedem einzelnen Aufkleber ausgegeben werden sollen.


  **Liste:**
  Für Listen gibt es hier keine Optionen.
Tabelle:

Bei Tabellen können Sie hier folgende Einstellungen machen:

**Zeilenhöhe:** Hier können Sie die Höhe der Tabellenzeilen festlegen: **Automatisch** (optimale Höhe automatisch ermitteln), **Genau** (exakte Höhe in Zentimetern vorgeben) oder **Mindestens** (Mindesthöhe in Zentimetern vorgeben; falls diese nicht ausreicht, wächst die Zeilenhöhe automatisch)

**Spalten:** Diese Einstellung legt die Zahl der Spalten in der Tabelle fest.

- **Schaltfläche "Drucken" beziehungsweise "Einfügen"**
  
  Bei **Aufklebern** enthält der Dialog unter anderem eine **Drucken**-Schaltfläche. Diese bringt Sie zum Drucken-Dialog, mit dem Sie den Ausdruck des Aufklebers starten können.

  Bei **Listen** und **Tabellen** erscheint stattdessen die Schaltfläche **Einfügen**. Diese fügt die Liste/Tabelle in das aktuelle Dokument ein.

- **Schaltfläche "Neues Dokument"**
  
  Erzeugt ein neues Dokument mit dem (komplett ausgefüllten) Endergebnis – also den entsprechenden Aufklebern, so wie sie im Ausdruck erscheinen würden, beziehungsweise der fertigen Liste/Tabelle.

- **Schaltfläche "Verwalten"**
  
  Mit Hilfe dieser Schaltfläche können Sie Aufkleberdefinitionen (also **alle** in diesem Dialog gemachten Einstellungen) speichern und später jederzeit wieder abrufen. Es öffnet sich dazu ein Dialog mit folgenden Schaltflächen:

  **Speichern:** Speichert die Aufkleberdefinition (also alle im Hauptdialog gemachten Einstellungen) unter einem beliebigen Namen.

  **Laden:** Stellt eine Aufkleberdefinition wieder her. Wählen Sie zuvor den gewünschten Eintrag in der Liste.

  **Löschen:** Löscht die momentan in der Liste ausgewählte Aufkleberdefinition.

  **Umbenennen:** Lässt Sie einen neuen Namen für die momentan in der Liste ausgewählte Aufkleberdefinition festlegen.

  Dies funktioniert nicht nur mit Aufklebern, sondern gleichermaßen auch mit Listen und Tabellen.

---

**Briefumschläge bedrucken**

Wenn Sie einen Brief versenden möchten, können Sie entweder einen Adressaufkleber dafür herstellen (wie im letzten Abschnitt beschrieben) oder TextMaker die Adresse einfach direkt auf einen Briefumschlag drucken lassen.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl **Einfügen > Briefumschlag** auf.

2. Klicken Sie auf die Schaltfläche **Papiereinstellungen**, stellen Sie das Papierformat des zu bedruckenden Briefumschlags ein und bestätigen Sie mit **OK**.

3. Tragen Sie im Eingabefeld **Absender** Ihre Adresse ein.

4. Tragen Sie im Eingabefeld **Empfänger** die Adresse des Empfängers ein.
Sie können dazu entweder eine Adresse von Hand eingeben oder Felder aus einer Adressdatenbank verwenden. Klicken Sie dazu auf die Schaltfläche Datenbankfeld und wählen Sie das einzufügende Feld aus.

5. Wenn alles eingetragen ist, klicken Sie auf eine der folgenden Schaltflächen:

**Neues Dokument erzeugen:** Legt den Briefumschlag als neues Dokument an.

**An Dokument anhängen:** Hängt den Briefumschlag an das Ende des aktuellen Dokuments an.

**Briefumschlag drucken:** Druckt den Briefumschlag einmalig aus und verwirft ihn dann.

6. Falls Sie Datenbankfelder eingefügt haben, zeigt TextMaker nun die Datenbank an. Blättern Sie darin zu dem Datensatz mit dem gewünschten Empfänger und klicken Sie auf **Einfügen**.

Der Briefumschlag wird nun angelegt und ausgefüllt.

Obige Einstellungen müssen Sie nur ein einziges Mal vornehmen. TextMaker merkt sich, welches Papierformat Sie für Briefumschläge verwenden und wie Sie die Datenbankfelder platziert haben möchten. Natürlich steht es Ihnen frei, die Einstellungen in diesem Dialog jederzeit wieder zu ändern.

Im Detail lassen sich im obigen Dialog folgende Einstellungen vornehmen:

**Absender**

Hier geben Sie die Adresse des Absenders ein.

Mit Hilfe der Schaltfläche oberhalb des Feldes können Sie bei Bedarf die Schriftart ändern, in der die Adresse auf dem Umschlag erscheinen soll.
Empfänger

Hier geben Sie die Adresse des Empfängers ein.

Tipp: Es empfiehlt sich, die Adresse dabei nicht von Hand einzutippen, sondern die Datenbankfelder Ihrer Adressdatenbank zu verwenden. Um ein Datenbankfeld einzufügen, klicken Sie auf die Schaltfläche **Datenbankfeld**.

Falls noch keine Datenbank ausgewählt ist, müssen Sie zuvor noch die Schaltfläche **Datenbank** anklicken und die gewünschte Datenbank wählen.

Mit Hilfe der Schaltfläche **A** oberhalb des Feldes können Sie bei Bedarf die Schriftart ändern, in der die Adresse auf dem Umschlag erscheinen soll.

Position Absender

Hier können Sie die Position der Absenderadresse auf dem Umschlag ändern (ausgehend von der linken oberen Ecke).

Position Empfänger

Hier können Sie die Position der Empfängeradresse ändern.

Ränder Empfänger

Hier können Sie den rechten und den unteren Rand der Empfängeradresse ändern.

Schaltfläche Papiereinstellungen

Diese Schaltfläche öffnet einen zusätzlichen Dialog, in dem Sie das Papierformat des Umschlags genau festlegen können.

Es gibt darin folgende Optionen:

- In der Liste **Umschlagtyp** werden alle vom aktuellen Drucker unterstützten Papierformate angeboten. Wählen Sie hier das Format des verwendeten Umschlagtyps. Alternativ können Sie auch unter **Breite** und **Höhe** eigene Werte von Hand angeben.

- Falls Ihr Drucker über mehrere Papierschächte verfügt, können Sie außerdem bei **Papierschacht** einstellen, aus welchem Schacht der Drucker den Umschlag einziehen soll. (Diese Option ist nur unter Windows verfügbar.)

- Bei **Auszrichtung des Umschlags** stellen Sie ein, wie bei dem verwendeten Drucker Briefumschläge in den Papiereinzug eingelegt werden müssen (linksbündig, zentriert oder rechtsbündig; gedreht oder nicht gedreht).

- Außerdem können Sie bei Bedarf einen **zusätzlichen Versatz** einstellen, falls der Drucker den Briefumschlag etwas versetzt bedruckt.

Tipp: Wenn Sie mit diesem Befehl einen Umschlag angelegt und dann als Dokument gespeichert haben, können Sie obige Einstellungen darin jederzeit nachträglich bearbeiten. Rufen Sie dazu in dem Dokument den Menübefehl **Datei > Seite einrichten** auf, wechseln Sie auf die Karteikarte **Seitenformat** und klicken Sie dort auf die Schaltfläche **Briefumschlagseinstellungen** ganz unten.
Anlegen neuer Datenbanken

Sie können mit TextMaker nicht nur bestehende Datenbanken verwenden, sondern auch neue Datenbanken anlegen.

Gehen Sie dazu folgendermaßen vor:

1. Rufen Sie den Menübefehl **Weiteres > Datenbank erzeugen** auf.

2. Legen Sie in dem Dialog das erste Datenbankfeld an.

   Geben Sie dazu bei **Name** einen eindeutigen Namen für das Feld ein und wählen Sie bei **Typ** einen geeigneten Feldtyp. Tragen Sie dann gegebenenfalls die gewünschte **Länge** und bei **Dez.** die Zahl der Dezimalstellen ein. Nähere Erläuterungen hierzu folgen unten.


   Wurden bereits andere Felder angelegt, können Sie alternativ auch auf **Einfügen** klicken, um es vor dem aktuellen Feld einzufügen.

4. Wiederholen Sie die Schritte 2. und 3. für jedes weitere Feld, das in die Datenbank aufgenommen werden soll. Sie können maximal 254 Felder anlegen, die Länge aller Felder insgesamt darf aber 4000 nicht übersteigen.

5. Wenn alle gewünschten Felder eingetragen sind, klicken Sie auf die Schaltfläche **Erzeugen**.


7. Bestätigen Sie mit **OK**.

Die Datenbank wird nun angelegt und auch gleich geöffnet.

**Tipp:** Wenn Sie beim Festlegen von Feldname, Feldtyp etc. einen Eingabefehler machen und das erst bemerken, nachdem Sie die Schaltfläche **Anhängen** betätigt haben, können Sie den Fehler nachträglich korrigieren. Führen Sie dazu einen Doppelklick auf das betroffene Feld in der Liste **Felder** durch, berichtigen Sie unten Ihre Eintragungen und klicken Sie auf **Ersetzen**. Mit **Löschen** können Sie fälschlicherweise angelegte Felder auch ganz entfernen.

Anmerkungen zum Feldtyp

Über die Option **Typ** im obigen Dialog können Sie den **Feldtyp** eines Feldes festlegen. Dieser bestimmt, welche Art von Daten in das Feld eingegeben werden soll. Es gibt folgende Feldtypen (in Klammern jeweils die maximal zulässige Feldlänge):

<table>
<thead>
<tr>
<th>Feldtyp (Länge)</th>
<th>Zulässige Eingaben</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zeichen</strong> (1 bis 254)</td>
<td>Zeichenfelder erlauben beliebige Eingaben.</td>
</tr>
<tr>
<td><strong>Numerisch</strong> (1 bis 19)</td>
<td>Numerische Felder akzeptieren als Eingabe nur Zahlen. Bei <strong>Dez.</strong> lässt sich die gewünschte Zahl der Nachkommastellen festlegen. Mit dem Inhalt solcher Felder können Sie sogar Berechnungen anstellen (siehe Kapitel <strong>Berechnungen im Text</strong>).</td>
</tr>
<tr>
<td><strong>Datum</strong> (stets 8)</td>
<td>Datumsfelder sind für Datumsangaben gedacht.</td>
</tr>
</tbody>
</table>
**Datenbank**

**Logisch** (stets 1)
Logikfelder sind für Ja/Nein-Angaben gedacht. Zulässige Eingaben sind ausschließlich \textbf{J} für "Ja" oder \textbf{N} für "Nein".

**Memo** (stets 10)
Memofelder verhalten sich etwas anders als "normale" Felder. Sie erlauben beliebige Eingaben und sind zum Eintragen zusätzlicher Notizen zu einem Datensatz gedacht. Memofelder lassen sich lediglich in der Datenbank einsehen und editieren – Sie können diese Art von Feldern jedoch weder in Dokumente einfügen noch ausdrucken lassen. Ihre Länge beträgt intern zwar stets 10, tatsächlich lassen sich in jedes Memofeld aber bis zu 4000 Zeichen eingeben.

**Tipp:** Wählen Sie für Zahlenangaben wie Telefonnummern, Postleitzahlen usw. als Feldtyp nicht "Numerisch", sondern "Zeichen". Numerische Felder brächten hier keinerlei Vorteile – im Gegenteil: Versuchten Sie, in ein numerisches Feld die Telefonnummer "089/123456" einzugeben, wird TextMaker erstens die Eingabe des "/" nicht erlauben, da nur Ziffern zulässig sind, zweitens würde die führende Null automatisch entfernt.

**Anmerkungen zu den unterstützten Datenbankformaten**
Datenbanken, die Sie mit TextMaker anlegen, werden stets im \textit{dBase-Format} gespeichert. Das dBase-Format ist ein weitverbreitetes Datenbankformat, das von vielen Datenbankprogrammen unterstützt wird.

Das dBase-Format gibt es in verschiedenen Varianten. Wenn Sie den Menübefehl \textit{Weiteres > Datenbank erzeugen} verwenden, können Sie in dem Dateidialog, der am Ende erscheint, die gewünschte Variante über die Option \textit{Dateityp} auswählen.

Folgende Varianten werden unterstützt:

<table>
<thead>
<tr>
<th>Dateiformat</th>
<th>Beschreibung</th>
</tr>
</thead>
<tbody>
<tr>
<td>dBase/DOS</td>
<td>Datenbank mit DOS-Zeichensatz. Dies ist das Standardformat – siehe Anmerkung unten!</td>
</tr>
<tr>
<td>dBase/Windows</td>
<td>Datenbank mit Windows-Zeichensatz.</td>
</tr>
</tbody>
</table>

\textit{Anmerkung:} Die meisten Datenbanken sind im Format \textit{dBase/DOS} gespeichert. Auch Windows-Datenbankprogramme verwenden in der Regel das DOS-Format statt des Windows-Formats.

**Hinweis zum Datenbankformat dBase/Unicode**
Neben den üblichen Formaten dBase/DOS und dBase/Windows unterstützt TextMaker auch Datenbanken im Format \textit{dBase/Unicode}.

Dieses Format ist eine von SoftMaker entwickelte Variante des dBase-Formats, das auch komplexe Zeichensätze (z.B. asiatische Schriftzeichen) unterstützt. Sie können in solchen Datenbanken also beispielsweise auch chinesisches Text speichern, was bei Datenbanken im Format dBase/DOS und dBase/Windows nicht möglich ist.

Folgendes gibt es bei der Verwendung dieses Formats jedoch zu beachten:

Ändern der Struktur von Datenbanken

Im vorherigen Abschnitt wurde erläutert, wie Sie eine komplett neue Datenbank anlegen. Sie können mit TextMaker aber auch die Struktur einer bestehenden Datenbank modifizieren – also beispielsweise Felder hinzufügen/löschen oder die Eigenschaften von Feldern ändern (Name, Typ, Länge etc.)

Gehen Sie dazu folgendermaßen vor:

1. Empfohlen: Legen Sie eine Sicherungskopie der Datenbank an, deren Aufbau geändert werden soll.
2. Rufen Sie den Menübefehl *Weiteres > Datenbankstruktur ändern* auf.
3. Es erscheint ein Dateidialog. Wählen Sie darin die zu ändernde Datenbank und bestätigen Sie mit *OK*.
4. Es erscheint ein weiterer Dialog, der dem Dialog des Befehls *Datenbank erzeugen* entspricht, und alle Felder der Datenbank präsentiert. Nehmen Sie darin die gewünschten Änderungen an der Datenbankstruktur vor. (Erläuterungen finden Sie weiter unten.)
5. Wenn Sie fertig sind, klicken Sie auf die Schaltfläche *Speichern unter*.

_Hinweis:_ Wenn Sie die Vorgaben in diesem Dialog übernehmen, wird die bestehende Datenbank überschrieben.

7. Bestätigen Sie mit *OK*.

Ihre Änderungen werden nun angewandt.

_Tipp:_ Es empfiehlt sich, die resultierende Datenbank nun kurz zu öffnen und das Ergebnis zu kontrollieren. Wenn Sie nämlich sehr viele unterschiedliche Arten von Änderungen auf einmal vornehmen, kann es in seltenen Fällen passieren, dass die Inhalte bestimmter Felder nicht in die neue Datenbank übernommen werden. Spielen Sie in so einem Falle die Sicherungskopie der Datenbank zurück und nehmen Sie die Änderungen erneut vor, verteilen sie diesmal jedoch auf _mehrere_ Schritte.

_Tipp:_ Eine Liste aller Feldtypen und deren Eigenschaften finden Sie im Abschnitt *Anlegen neuer Datenbanken*.

Der eingangs erwähnte Dialog des Befehls *Datenbankstruktur ändern* lässt sich wie folgt bedienen:

- **Neues Feld einfügen**

  Um ein neues Feld einzufügen, geben Sie bei *Name* einen eindeutigen Namen für das Feld ein und wählen bei *Typ* einen geeigneten Feldtyp. Tragen Sie dann gegebenenfalls die gewünschte *Länge* und bei *Dez.* die Zahl der Dezimalstellen ein.

  Sind alle Angaben für ein Feld gemacht, klicken Sie auf *Anhängen*, um es hinter dem letzten Feld anzuhängen. Alternativ können Sie auch auf *Einfügen* klicken, um es vor dem aktuellen Feld einzufügen.
Hinweis: Eine Datenbank kann maximal 254 Felder enthalten, die Länge aller Felder insgesamt darf aber 4000 nicht übersteigen.

- **Feld ändern**

Um die Eigenschaften eines Feldes zu ändern (Name, Typ, Länge etc.), führen Sie einen Doppelklick auf das Feld in der Liste *Felder* durch, worauf dessen Eigenschaften in die Kontrollen am unteren Ende des Dialogs übernommen werden. Nehmen Sie dort die gewünschten Änderungen vor und klicken Sie dann auf *Ersetzen*.

- **Feld löschen**

Um ein Feld zu löschen, selektieren Sie es in der Liste *Felder* und klicken auf *Löschen*.

---

### Thunderbird-Adressbuch importieren

_Hinweis:_ Dieses Feature ist in der Android-Version nicht verfügbar.

Der Befehl **Thunderbird-Adressbuch konvertieren** ermöglicht es Ihnen, ein Adressbuch des E-Mail-Programms *Thunderbird* in eine Datenbank zu konvertieren.

Diese Datenbank kann anschließend mit TextMaker verwendet werden. Sie können sie also beispielsweise mit dem Datenbankmodul von TextMaker öffnen, sie für Serienbriefe nutzen etc.

Gehen Sie wie folgt vor:


2. Es erscheint ein Dialog. Nehmen Sie darin, falls nötig, die gewünschten Einstellungen vor (siehe unten) und bestätigen Sie diese.

Das Thunderbird-Adressbuch wird nun in eine Datenbank konvertiert, und diese wird im eingestellten Zielverzeichnis gespeichert.

Wenn Sie als AusgabefORMAT "dBase (*.dbf)" gewählt haben, können Sie die Datenbank nun mit dem Menübefehl *Weiteres > Datenbank bearbeiten* im Datenbankmodul von TextMaker öffnen und bearbeiten. Außerdem lässt sich die Datenbank auch als Quelldatenbank für Serienbriefe, Listen, Aufkleber etc. verwenden.

#### Optionen des Dialogs

Im Dialogfenster für diesen Befehl gibt es folgende Optionen:

- **Verzeichnis des Thunderbird-Adressbuches (abook.mab)**

Hier lässt sich der Pfad und Dateiname der Datei mit dem zu konvertierenden Thunderbird-Adressbuch einstellen.

_Hinweis:_ Wenn Thunderbird auf Ihrem Rechner installiert ist, kann TextMaker den korrekten Pfad und Dateinamen dieser Datei in der Regel automatisch ermitteln. Sie können die Voreinstellung dann also einfach übernehmen.

Alternativ können Sie auch manuell einen anderen Pfad oder Dateinamen angeben.
Anmerkung: Mit dem Befehl **Hilfe > Informationen zur Fehlerbehebung** in Thunderbird können Sie sich bei Bedarf anzeigen lassen, wo sich der Profilordner für Ihr aktuell gewähltes Benutzerprofil befindet. In diesem Ordner befindet sich dann auch die Datei **abook.mab**, die das Adressbuch enthält.

### Auch leere Felder einbeziehen

Diese Option hat folgende Auswirkung:

**Aus:** Wenn die Option ausgeschaltet ist, werden alle Felder, die im *gesamten* Adressbuch leer sind, bei der Konvertierung automatisch weggelassen.

**Ein:** Ist diese Option hingegen eingeschaltet, werden auch solche komplett leeren Felder in die Ausgabedatei übernommen.

### AusgabefORMAT

Hier können Sie das Dateiformat für die Ausgabedatei bestimmen:


**Textdatei (*.csv):** Wählen Sie hingegen diese Option, wird eine reine Textdatei vom Typ CSV erzeugt. CSV steht für "comma separated values", die einzelnen Feldinhalte werden in der Textdatei also jeweils durch ein Komma getrennt.

### Name der Zielfieldatei

Hier lässt sich festlegen, in welchem Verzeichnis und unter welchem Dateinamen die Ausgabedatei abgelegt werden soll.
Serienbriefe

Fast täglich finden Sie Serienbriefe in Ihrem Briefkasten – zum Beispiel die scheinbar unvermeidbaren Reklameschreiben von Versandhändlern, Versicherungen etc. etc.

Ein Serienbrief – in die Felder {VORNAME}, {NAME1} etc. wird später die Adresse eingesetzt.


Genau dieses Einsetzen der Adressen von Hand können Sie TextMaker übernehmen lassen, wenn Sie für die Einladung einen Serienbrief erstellen.

Prinzipiell gehen Sie dazu folgendermaßen vor (ausführliche Informationen finden Sie auf den nächsten Seiten):

1. Sofern Sie die Adressen der Empfänger noch nicht in einer Datenbank erfasst haben, erstellen oder öffnen Sie eine Datenbank und tragen Sie die Adressen dort ein. Die mitgelieferte Datenbank tmw.dbf eignet sich sehr gut für das Erfassen von Adressen, Sie können aber jede beliebige Datenbank verwenden.

2. Beginnen Sie ein neues Dokument.


4. Verfassen Sie den Brieftext.

5. Fügen Sie an der Stelle, an der später die Adresse erscheinen soll, mit dem Menübefehl Einfügen > Feld > Datenbankfeld die entsprechenden Datenbankfelder für Name, Straße, Ort etc. ein.

7. Drucken Sie den Brief mit dem Menübefehl Datei > Serienbriefdruck aus.

Beim Drucken ersetzt TextMaker die Datenbankfelder durch die Daten aus der Datenbank – Datensatz für Datensatz. Dabei werden für den ersten Brief die Daten des ersten Datensatzes genommen, für den zweiten Brief die Daten des zweiten Satzes usw.

Die folgenden Seiten beschreiben die erforderlichen Schritte vom Erstellen eines Serienbriefs bis hin zum Ausgeben des fertigen Dokuments ausführlich. Folgende Themen werden darin behandelt:

- Dokumenten eine Datenbank zuordnen
- Datenbankfelder einfügen
- Testdatensatz im Text anzeigen lassen
- Übungsbrief
- Datensätze für den Serienbriefdruck wählen
- Serienbriefe ausgeben

---

**Dokumenten eine Datenbank zuordnen**

Bevor Sie die Felder einer Datenbank in einen Serienbrief einfügen, müssen Sie TextMaker mitteilen, welche Datenbank Sie dazu verwenden möchten, indem Sie dem Dokument eine Datenbank zuordnen.

Rufen Sie dazu den Menübefehl Weitere > Datenbank zuordnen auf. Es erscheint ein Dialogfenster, in dem Sie die Datenbank auswählen. Tippen Sie den Dateinamen der gewünschten Datenbank ein oder wählen Sie eine Datei aus der Liste der angezeigten Datenbanken.

Unterstützt werden Datenbanken folgender Formate:

<table>
<thead>
<tr>
<th>Dateiformat</th>
<th>Beschreibung</th>
</tr>
</thead>
<tbody>
<tr>
<td>dBase/DOS</td>
<td>dBase-Datenbank mit DOS-Zeichensatz. Dies ist das Standardformat – siehe Anmerkung unten!</td>
</tr>
<tr>
<td>dBase/Windows</td>
<td>dBase-Datenbank mit Windows-Zeichensatz</td>
</tr>
<tr>
<td>dBase/Unicode</td>
<td>dBase-Datenbank mit Unicode-Zeichensatz</td>
</tr>
<tr>
<td>Textdatei</td>
<td>Eine Textdatei, in der die Feldinhalte durch Strichpunkte voneinander getrennt eingetragen wurden und jede Zeile einen Datensatz enthält.</td>
</tr>
<tr>
<td>Textdatei mit DOS-Zeichensatz</td>
<td>Ebenfalls eine Textdatei, allerdings nicht mit Windows-, sondern mit DOS-Zeichensatz.</td>
</tr>
</tbody>
</table>

Das Dateiformat bestimmen Sie, indem Sie im obigen Dialogfenster die Liste Dateityp öffnen und darin das gewünschte Format wählen.

**Anmerkung:** Die meisten dBase-Datenbanken sind im Format dBase/DOS gespeichert. Auch Windows-Datenbankprogramme verwenden in der Regel das DOS-Format statt des Windows-Formats.
Sobald Sie eine Datenbank ausgewählt und mit OK bestätigt haben, weiß TextMaker, aus welcher Datenbank Sie Felder einfügen möchten, und Sie können wie im nächsten Abschnitt beschrieben fortfahren.


**Zuordnung aufheben**

Sie können die Zuordnung bei Bedarf wieder aufheben, indem Sie den Menübefehl **Weiteres > Datenbank zuordnen** aufrufen und auf die Schaltfläche **Zuordnung aufheben** klicken.

---

### Datenbankfelder einfügen

Wenn Sie sich entschieden haben, an welchen Stellen des Serienbriefs welche Felder der Datenbank erscheinen sollen, können Sie diese dort mit dem Menübefehl **Einfügen > Feld** in den Text setzen. Beim Drucken werden diese Felder dann Datensatz für Datensatz durch die tatsächlichen Feldinhalte der Datenbank ersetzt.

Konkret gehen Sie folgendermaßen vor, um ein Datenbankfeld einzufügen:

1. Setzen Sie die Schreibmarke an die gewünschte Position.
2. Rufen Sie den Menübefehl **Einfügen > Feld** auf.
3. Wählen Sie in der Liste **Gruppe** den Eintrag **Datenbankfeld**.
4. Jetzt können Sie in der Liste **Feldname** auswählen, welches Feld eingefügt werden soll.
5. Wenn Sie nun auf **Einfügen** klicken, fügt TextMaker das Feld in den Text ein und zeigt dort den Feldnamen in geschweiften Klammern an – zum Beispiel {NAME}.

Verfahren Sie an allen anderen Stellen, an denen Datenbankfelder eingefügt werden sollen, genauso – bis der Serienbrief das gewünschte Aussehen hat.

Datenbankfelder lassen sich wie normaler Text formatieren; sie können Ihnen also jederzeit eine andere Schriftart, Schriftgröße etc. geben.

Beim Ausgeben des Serienbriefs sorgt TextMaker später selbstständig dafür, dass der Text optimal umbrochen wird. Er passt den Zeilenumbruch also automatisch an die tatsächlichen Inhalte der Datenbankfelder an, die ja bei jedem Datensatz unterschiedlich breit sein können.

---

### Testdatensatz im Text anzeigen lassen

TextMaker zeigt in den Text eingefügte Datenbankfelder normalerweise in Form des Feldnamens in geschweiften Klammern an – zum Beispiel:

{NAME}
Um zu sehen, wie der Serienbrief beim Ausdruck tatsächlich aussehen wird, können Sie TextMaker anweisen, statt der Feldnamen die Feldinhalte aus einem beliebigen Satz der Datenbank anzuzeigen. Voraussetzung ist dabei, dass dem Dokument mit dem Menübefehl Weiteres > Datenbank zuordnen bereits eine Datenbank zugewiesen wurde.

Ist dies geschehen, rufen Sie den Menübefehl Datei > Eigenschaften auf und wechseln in dem Dialogfens- ter auf die Karteikarte Ansicht. Vergewissern Sie sich, dass die Option Nur Feldnamen anzeigen nicht eingeschaltet ist. Dann schalten Sie Datensatz anzeigen ein und geben dahinter die Datensatznummer des Datensatzes an, dessen Feldinhalte gezeigt werden sollen.

**Hinweis:** Rufen Sie jetzt den Menübefehl Datei > Serienbriefdruck auf, werden nach wie vor Serien- briefe mit allen selektierten Datensätzen ausgedruckt. Beim Befehl Datei > Drucken hingegen druckt TextMaker nur einen einzigen Brief mit der Adresse, die Sie oben ausgewählt haben.

### Serienbriefleiste verwenden


Die Serienbriefleiste wird daraufhin eingeblendet.

Sie können diese wie folgt verwenden:

- Klicken Sie auf die Pfeilchen nach links oder rechts, um von Datensatz zu Datensatz zu blättern.
- Tragen Sie in das Eingabefeld in der Mitte die Nummer des Datensatzes ein, der angezeigt werden soll, und drücken Sie die Eingabetaste.
- Wenn Sie statt des Testdatensatzes wieder die Feldnamen sehen möchten, dann blättern Sie zu Datensatz 0 oder tragen in das Eingabefeld "0" ein und betätigen die Eingabetaste. TextMaker schaltet die Option Datensatz anzeigen daraufhin wieder aus.

**Tipp:** Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), erscheint ein Infotext, der die Funktion des Symbols angibt.

---

### Übungsbrief

Übung macht bekanntlich den Meister. In diesem Abschnitt wollen wir deshalb zur Übung einen Serienbrief herstellen.


Tippen Sie dann den nachfolgenden Text ein. Es steht Ihnen natürlich frei, diesen zu kürzen oder etwas ganz anderes einzutippen. Entscheidend ist dabei lediglich folgendes:

**Wichtig:** Die in geschweiften Klammern gesetzten Textstellen tippen Sie nicht ein – hierbei handelt es sich nämlich um Datenbankfelder. Stattdessen rufen Sie an diesen Stellen jeweils den Menübefehl Einfügen >
**Feld** auf, wählen in der Liste **Gruppe** den Eintrag **Datenbankfeld**, in der Liste **Feldname** den Feldnamen und klicken dann auf **Einfügen**. Auf diese Weise werden die Datenbankfelder in den Text eingesetzt.

Verband Deutscher Kalligraphen e.V.

{VORNAME} {NAME1}
{STRASSE}
{PLZ} {ORT}

{ANBR},

wir freuen uns, Ihnen mitteilen zu können, dass der Verband Deutscher Kalligraphen in Zukunft nicht mehr alle Briefe von Hand schreiben muss.

Denn wir haben uns entschlossen, unser gesamtes Schreibbüro auf Personalcomputer umzustellen. Wir verwenden TextMaker mit der integrierten Datenbank und können nun alle unsere Mitglieder mit persönlich wirkenden Serienbriefen anschreiben.

Alles in allem hat uns TextMaker eine enorme Einsparung an Zeit und Kosten gebracht – von den Ersparnissen an Tinte und Federkielen gar nicht zu reden...

Mit freundlichen Grüßen

Nun haben Sie eine "Schablone" erstellt, in die TextMaker beim Drucken der Reihe nach die Felder der Datensätze aus der Datenbank einfügen kann.

Rufen Sie die Beispieldatenbank *tmw.dbf* auf und geben Sie ein paar Datensätze ein. Welche Namen und Adressen Sie wählen, bleibt völlig Ihnen überlassen. Wenn Sie die Datensätze eingegeben haben, verlassen Sie die Datenbank mit dem Menübefehl **Datei > Schließen**.

Alle grundlegenden Schritte sind jetzt getan, und Sie könnten Ihren Serienbrief nun ausdrucken. Lesen Sie den Rest dieses Kapitels, um zu erfahren, wie man die Empfänger für einen Serienbrief auswählt – und wie Serienbriefe letztlich ausgegeben werden.

---

**Datensätze für den Serienbriefdruck wählen**

Bei Bedarf können Sie genau festlegen, an welche Datensätze einer Datenbank ein Serienbrief geschickt werden soll. Dazu öffnen Sie die Datenbank und *selektieren* die gewünschten Datensätze.
Es gibt drei Methoden zum Selektieren von Datensätzen, die nach Belieben miteinander kombiniert werden können. So können Sie beispielsweise Datensätze erst anhand einer Bedingung selektieren und anschließend manuell einige Datensätze wieder aus der Selektion herausnehmen.

Folgende Selektionsmethoden stehen im Datenbankmodul zur Verfügung:

- **Manuelles Selektieren einzelner Datensätze**
  
  Mit dem Menübefehl **Selektieren > Aktueller Datensatz** können Sie den aktuellen Datensatz in die Selektion aufnehmen oder entfernen. Rufen Sie diesen Befehl bei einem nicht selektierten Satz auf, wird dieser selektiert und umgekehrt.

  Mit dem Menübefehl **Selektieren > Alle Datensätze selektieren** und **Selektieren > Alle Datensätze deselectieren** lassen sich auch alle Datensätze auf einmal selektieren beziehungsweise deselectieren.

- **Selektion nach Satznummern**
  
  Beim Menübefehl **Selektieren > Nach Satznummern** geben Sie einen Bereich von Satznummern an, der selektiert oder deselectiert werden soll.

- **Selektion anhand einer Bedingung**
  
  Der Menübefehl **Selektieren > Nach Bedingung** lässt Sie Selektionsbedingungen wie "Selektiere alle Meiers" oder "Selektiere alle Berliner" anwenden.

  Ausführliche Informationen zu diesen Selektionsmethoden folgen auf den nächsten Seiten.

**Navigieren zwischen den selektierten Datensätzen**

Mit den Menübefehlen **Gehe zu > Vorheriger Selektierter** und **Gehe zu > Nächster Selektierter** können Sie zum vorherigen beziehungsweise nächsten selektierten Datensatz springen.

Alternativ können Sie hierfür die Symbole ⌘ ← und ⌘ → in der Funktionsleiste oder die Tastenkürzel `Strg+Alt+Bild↑` und `Strg+Alt+Bild↓` verwenden.

**Tipp:** Weiterhin lassen sich mit dem Menübefehl **Ansicht > Nur selektierte Datensätze anzeigen** alle Datensätze ausblenden, die nicht selektiert sind.

---

**Manuelles Selektieren einzelner Datensätze**

Mit dem Menübefehl **Selektieren > Aktueller Datensatz** selektieren beziehungsweise deselectieren Sie den aktuell im Datenbankmodul angezeigten Datensatz.

Rufen Sie diesen Befehl bei einem nicht selektierten Satz auf, wird dieser selektiert. Rufen Sie ihn bei einem bereits selektierten Satz auf, wird dieser wieder aus der Selektion entfernt.

**Tipp:** In der Listenansicht können Sie Datensätze auch selektieren/deselectieren, indem Sie per Mausklick das Kontrollkästchen vor dem Datensatz ein-/ausschalten.
Mit den Menübefehlen **Selektieren > Alle Datensätze selektieren** und **Selektieren > Alle Datensätze deselectieren** können Sie alle Datensätze der Datenbank auf einmal selektieren beziehungsweise deselectieren.

**Anzeige in der Statuszeile:** Ob ein Datensatz selektiert ist oder nicht wird auch unten in der Statuszeile angezeigt: Bei selektierten Datensätzen erscheint hier das Wort **Selektiert**.

### Selektion nach Satznummern

Bei der *Datensatznummer* (kurz: *Satznummer*) handelt es sich um eine laufende Nummer, mit der die Datensätze durchnummeriert werden. Der erste Datensatz hat die Nummer 1, der zehnte 10 usw. Die Satznummer wird im Datenbankmodul links unten in der Statuszeile angezeigt.

Der Menübefehl **Selektieren > Nach Satznummern** erlaubt es Ihnen, einen durch Satznummern eingeengten Bereich zu selektieren oder zu deselectieren.


Wenn Sie die Schaltfläche **Selektieren** betätigen, werden alle Datensätze in diesem Bereich selektiert; wählen Sie hingegen **Deselectieren**, werden diese deselectiert, also aus der Auswahl entfernt.

### Selektion anhand einer Bedingung

Mit Hilfe des Menübefehls **Selektieren > Nach Bedingung** können Sie eine Auswahl anhand einer Bedingung treffen – zum Beispiel "Selektiere alle, bei denen im Feld NAME1 'Huber' steht". Alle Datensätze, bei denen diese Bedingung erfüllt ist, werden dann in die Selektion aufgenommen.

**Tipp:** Der Inhalt des Feldes muss lediglich mit dem Suchbegriff beginnen. Ist der Inhalt des Felds NAME1 in einem Datensatz also "Hubermeier", wird dieser Satz von TextMaker ebenfalls selektiert.

Sie können bei Bedarf auch mehrere Bedingungen kombinieren – zum Beispiel NAME1=Huber und PLZ=CH, um alle Hubers in der Schweiz zu selektieren.

Wenn Sie den Menübefehl **Selektieren > Nach Bedingung** aufrufen, erscheint der folgende Dialog:
Um beispielsweise alle Datensätze zu selektieren, bei denen das Feld NAME1 mit "Huber" beginnt, gehen Sie wie folgt vor:

1. Wählen Sie in der aufklappbaren Liste Datenbankfeld das gewünschte Feld aus – in obigem Beispiel also NAME1.

2. Geben Sie im Eingabefeld Inhalt den zu suchenden Wert ein – in obigem Beispiel also "Huber".

   **Hinweis:** Beachten Sie dabei, dass die Suche die Groß-/Kleinschreibung des Suchbegriffs berücksichtigt. Bei der Suche nach "Huber" werden Datensätze mit "HUBER" oder "huber" also nicht gefunden.

3. Klicken Sie auf die Schaltfläche Hinzufügen, woraufhin die Bedingung definiert und in die Liste Bedingungen eingetragen wird.

   Sie könnten nun noch weitere Bedingungen hinzufügen, indem Sie obige Schritte wiederholen.

4. Klicken Sie auf Selektieren, um alle Datensätze, die die Bedingung erfüllen, zur Selektion hinzuzufügen. Oder klicken Sie auf Deselektieren, um diese Datensätze aus der Selektion zu entfernen.

   Wenn Sie jetzt also auf Selektieren klicken, werden alle Datensätze zur Selektion hinzugefügt, bei denen das Feld NAME1 mit "Huber" beginnt.

   Mit Hilfe der Schaltflächen Löschen und Alle löschen in obigem Dialogfenster können Sie zuvor hinzugefügte Selektionsbedingungen jederzeit löschen, falls sie nicht mehr benötigt werden.

   **Hinweis:** Beachten Sie, dass einmal selektierte Datensätze so lange selektiert bleiben, bis sie wieder deselectiert werden. Selektieren Sie also nach NAME1=Huber und anschließend nach NAME1=Meier, sind alle Hubers und alle Meiers selektiert. Sollen tatsächlich nur die Meiers angeschrieben werden, müssen Sie vor dem Anwenden der Bedingung NAME1=Meier erst alle Datensätze deselectieren, indem Sie den Menübefehl Selektieren > Alle Datensätze deselectieren aufrufen.

**Verfügbare Vergleichsoperatoren**

Neben dem Gleichheitszeichen = können Sie im obigen Dialog auch andere Vergleichsoperatoren für Bedingungen verwenden. Folgende Operatoren stehen zur Verfügung (in der aufklappbaren Liste rechts des Datenbankfeldes):

<table>
<thead>
<tr>
<th>Operator</th>
<th>Erläuterung</th>
</tr>
</thead>
</table>

**Datenbankfeld:**

<table>
<thead>
<tr>
<th>NAME1</th>
<th>Inhalt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>=</td>
</tr>
</tbody>
</table>
Das durchsuchte Feld muss dem Suchbegriff genau entsprechen oder zumindest mit ihm beginnen.

Das Feld darf dem Suchbegriff nicht entsprechen (und auch nicht mit ihm beginnen).

Kleiner als (für numerische Felder)

Größer als (für numerische Felder)

Kleiner oder gleich (für numerische Felder)

Größer oder gleich (für numerische Felder)

Das durchsuchte Feld muss den Suchbegriff an beliebiger Position enthalten.

Bei der Bedingung NAME1 enthält Huber werden also alle Sätze selektiert, bei denen dieses Feld beispielsweise den Inhalt "Huber", "Hubermeier" oder auch "Müller, Huber & Co." hat.

Das durchsuchte Feld hat keinen Eintrag.

---

Serienbriefe ausgeben

Haben Sie einen Serienbrief erstellt und in der Datenbank die gewünschten Datensätze selektiert, lassen Sie TextMaker die beiden zusammenführen und als Serienbrief ausdrucken.

Dazu rufen Sie nicht wie üblich den Menübefehl Datei > Drucken, sondern den Befehl Datei > Serienbriefdruck auf.

Alle weiteren Informationen zu diesem Befehl finden Sie im Abschnitt Drucken eines Serienbriefs.

Automatisches Unterdrücken überflüssiger Leerläufer

Stößt TextMaker beim Drucken von Serienbriefen auf zwei Datenbankfelder, die durch ein oder mehrere Leerzeichen getrennt sind, unterdrückt TextMaker diese Leerzeichen automatisch, wenn das vordere der beiden Datenbankfelder leer ist.

Ein Beispiel: Sie haben, durch ein Leerzeichen getrennt, Felder für Vor- und Nachnamen in den Text eingefügt:

\{VORNAME\} \{NAME1\}


Automatisches Unterdrücken leerer Zeilen mit Datenbankfeldern

Enthält eine Textzeile ausschließlich ein Datenbankfeld oder mehrere durch Leerzeichen oder Tabulatoren getrennte Datenbankfelder, wird die komplette Zeile weggelassen, wenn diese Felder bei einem Datensatz keinen Inhalt tragen.

Ein Beispiel – Ihr Serienbrief enthält folgenden Textabschnitt:
{VORNAME} {NAME1} {NAME2} {STRASSE} {PLZ} {ORT}

Ist das Feld {NAME2} bei einem Datensatz leer, lässt TextMaker die dadurch entstehende Leerzeile automatisch weg. Gedruckt wird also Vorname und Name, in der nächsten Zeile folgt die Straße.

Wäre {VORNAME} und {NAME1} leer, würde diese Zeile komplett unterdrückt.

**Verhindern des automatischen Unterdrückens von Leerräumen**

In bestimmten Fällen ist es nicht erwünscht, dass TextMaker überflüssige Leerräume oder Leerzeilen automatisch unterdrückt. Um dies zu verhindern, verwenden Sie anstelle normaler Leerzeichen *geschützte* Leerzeichen, die Sie mit der Tastenkombination `Strg+Umschalt+Leertaste` einfügen können.

Ein Beispiel – Ihr Serienbrief enthält folgenden Textabschnitt:

{VORNAME}<geschütztes Leerzeichen>{NAME1}

Hier wird das Leerzeichen trotzdem gedruckt, auch wenn {VORNAME} leer ist. Weiterhin wird die Zeile nicht unterdrückt, wenn beide Felder leer sind.
Berechnungen im Text

Mit TextMaker können Sie komfortabel Berechnungen in Ihren Dokumenten durchführen:

- Sie können Berechnungen direkt in den Text einfügen; angezeigt und gedruckt wird das Ergebnis.
- In Berechnungen lassen sich auch Variablen verwenden. So können Sie Zwischenergebnisse ermitteln und mit diesen weiterrechnen.

Die Eingabe der Rechenformel erfolgt komfortabel über das Dialogfenster des Menübefehls Einfügen > Berechnung. Dieses enthält auch Listen aller Variablen, Datenbankfelder, Funktionen und Operatoren.

Besonders interessant macht die Rechenfunktionalität die Tatsache, dass sich auch Feldinhalte einer Datenbank in Berechnungen einbeziehen lassen. Rechnungen erstellen? Kein Problem: Hat Ihre Rechnungsdatenbank Felder für Menge und Preis, können Sie TextMaker Berechnungen wie Menge * Preis durchführen lassen und so Rechnungen als Serienbriefe erstellen und ausdrucken.


Ausführliche Informationen zum Thema "Berechnungen" finden Sie auf den nächsten Seiten. Folgende Themen werden darin behandelt:

- Einfügen von Berechnungen
- Berechnungen formatieren und runden
- Berechnungen aktualisieren
- Bedingter Text
- Einfache Berechnungen auf Knopfdruck
- Rechenformeln und -funktionen

Einfügen von Berechnungen

Berechnungen lassen sich über den Menübefehl Einfügen > Berechnung in den Text einfügen.

Beim Aufruf dieses Befehls erscheint ein Dialogfenster, in das Sie die Rechenformel eintragen. Die Formel darf bis zu 255 Zeichen umfassen. Nach Ihrem OK steht das Ergebnis der Berechnung im Text (maximal 100 Zeichen).

**Berechnungen einfügen**

Ein simples Beispiel für die Verwendung des Rechenbefehls:

Sie möchten das Volumen eines Swimmingpools ausrechnen, der die Maße $7 \times 4 \times 2$ Meter hat. Dazu gehen Sie folgendermaßen vor:

1. Tippen Sie z.B. den Text "Das Volumen beträgt: " ein.
2. Rufen Sie den Menübefehl **Einfügen > Berechnung** auf oder drücken Sie **F2**.
3. Tragen Sie bei **Berechnung** "7*4*2" ein und bestätigen Sie mit **OK**.

Im Text steht nun das Ergebnis: 56.

Diese Zahl "56" sieht zwar aus wie normaler Text, ist tatsächlich aber ein **Feld**, also ein symbolischer Platzhalter für die Berechnung "7*4*2". Sie sehen dies, wenn Sie auf der Karteikarte **Ansicht** im Dialog des Menübefehls **Datei > Eigenschaften** die Option **Nur Feldnamen anzeigen** einschalten. Im Text steht dann nicht mehr 56, sondern {Formel: 7*4*2}.

*Tipp:* Noch schneller schalten Sie die Option **Feldnamen anzeigen** mit dem Tastenkürzel **Alt+F9** um. Der jeweilige Modus, den Sie dadurch aktiviert haben, wird damit auch direkt in der Karteikarte Ansicht übernommen.

**Berechnungen editieren**

Die Formel für die Berechnung lässt sich jederzeit wieder abändern. Markieren Sie das Ergebnis "56" dazu und rufen Sie erneut den Menübefehl **Einfügen > Berechnung** auf. Im Dialogfenster wird die Formel 7*4*2 angezeigt. Sollte der Swimmingpool nun doch andere Ausmaße haben, ändern Sie die Rechenformel einfach ab. Nach Ihrem **OK** steht das neu berechnete Ergebnis im Text.

*Tipp:* Sie können den Dialog auch durch Doppelklick direkt auf das Feld öffnen.

**Weitere Informationen**

Detailliertere Informationen zum Einfügen von Berechnungen finden Sie auf den nächsten Seiten. Folgende Themen werden darin behandelt:

- **Variablen in Berechnungen**
- **Tabellenzellen in Berechnungen**
- **Datenbankfelder in Berechnungen**
- **Objekte in Berechnungen**

**Variablen in Berechnungen**

Sie können das Ergebnis einer Berechnung als Zwischenergebnis speichern, indem Sie die Berechnung einer **Variablen** zuweisen.
Berechnungen im Text


Um in Berechnungen Variablen zu verwenden, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Einfügen > Berechnung** auf.
2. Tippen Sie den Variablennamen gefolgt von einem Gleichheitszeichen und dann den Wert oder die Formel – zum Beispiel: "VOLUMEN=7*4*2".

**Wichtig:** Wenn Sie nun mit **OK** bestätigen, passieren zwei Dinge:

- Die Berechnung wird durchgeführt und das Ergebnis im Text angezeigt.
- Gleichzeitig wird das Ergebnis in der Variablen VOLUMEN gespeichert.

Nun ließe sich die Variable VOLUMEN in anderen Berechnungen verwenden: die Rechenformel VOLUMEN+10 ergäbe beispielsweise 56+10, also 66.

Sie können auch einfach nur den Inhalt der Variablen VOLUMEN an einer anderen Textstelle ausgeben lassen. Bewegen Sie sich einfach die Schreibmarke dorthin, rufen Sie den Menübefehl **Einfügen > Berechnung** auf und tippen Sie als Berechnung nur den Variablennamen VOLUMEN ein. Sobald Sie mit **OK** bestätigen, erscheint der Inhalt dieser Variable im Text.

Wenn Sie sich das Dialogfenster von **Einfügen > Berechnung** etwas genauer ansehen, werden Sie entdecken, dass in der Liste **Variable/Feld** alle momentan gültigen Variablen angezeigt werden. Diese lassen sich per Doppelklick komfortabel in die Formel einsetzen.

**Wichtig:** Eine Variable gilt erst ab der Stelle im Text, an der sie definiert wurde. Fügen Sie also im dritten Absatz Ihres Dokuments die Formel VOLUMEN=7*4*2 ein und versuchen, VOLUMEN schon im zweiten Absatz auszugeben oder damit zu rechnen, quittiert TextMaker dies mit der Fehlermeldung "Unbekannter Variablennamen".

**Ein Anwendungsbeispiel**

Ein Tenniscenter möchte Rechnungen für die Vermietung seiner Tennisplätze schreiben. Der Computer soll die Endsumme berechnen und die Mehrwertsteuer hinzufügen. Grob gekürzt würde man eine solche Rechnung etwa in dieser Form schreiben:

**RECHNUNG**

<table>
<thead>
<tr>
<th>? Stunden</th>
<th>???.??</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summe</td>
<td>???.??</td>
</tr>
<tr>
<td>+ 19% Mehrwertsteuer</td>
<td>???.??</td>
</tr>
<tr>
<td>Gesamtbetrag</td>
<td>???.??</td>
</tr>
</tbody>
</table>

Die mit Fragezeichen gefüllten Rechnungspunkte müsste man nun mit dem Taschenrechner ausrechnen und von Hand ausfüllen. Diese Arbeit nimmt Ihnen TextMaker ab:
Nehmen wir an, die Tennis-Cracks haben 2 Stunden gespielt, die Stunde kostet 10,- Euro zzgl. MwSt.

1. Löschen Sie das Fragezeichen vor "Stunden", rufen Sie den Menübefehl **Einfügen > Berechnung auf** und tragen Sie mit dessen Hilfe folgende Berechnung ein: \( \text{DAUER} = 2 \).

   *(Dadurch haben Sie erstens die Variable **DAUER** mit dem Wert 2 belegt. Zweites wird der Inhalt von **DAUER** (also 2) im Text angezeigt.)*

2. Rechts, anstelle der Fragezeichen hinter "à", tragen Sie die Berechnung \( \text{PREIS} = 10 \) ein.

   *(Hier gilt das Gleiche: Erstens weisen Sie der Variable **PREIS** den Wert 10 zu, zweitens erscheint der Inhalt dieser Variable (10) im Text.)*

3. Die Rechenformel, die Sie mithilfe des Befehls **Einfügen > Berechnung** für die Fragezeichen hinter "Summe" eingeben müssen, lautet: \( \text{SUMME} = \text{DAUER} \times \text{PREIS} \).

   *(Der Variablen **SUMME** wird nun das Ergebnis der Berechnung **DAUER** mal **PREIS** zugewiesen, und das Resultat im Text angezeigt. Entscheidend dabei: ändern Sie später **DAUER** oder **PREIS**, ändert sich auch der Inhalt der Variablen **SUMME** entsprechend.)*

4. Hinter ",+ 19% Mehrwertsteuer" fügen Sie mittels **Einfügen > Berechnung** die Rechenformel \( \text{MWST} = \text{SUMME} \times 19/100 \) ein, um die Mehrwertsteuer zu berechnen.

   *(In dieser Formel wird mit der gerade errechneten Summe weitergerechnet. Auch hier gilt: Ändert sich etwas am Ergebnis von **SUMME**, wird das Ergebnis von **MWST** automatisch korrigiert.)*

5. Der "Gesamtbetrag" wird schließlich mit \( \text{SUMME} + \text{MWST} \) ausgerechnet.

   *(Beim letzten Schritt verzichten wir darauf, nochmals eine neue Variable zu definieren. Schließlich geht es uns nur darum, das Ergebnis im Text stehen zu haben.)*

Schalten Sie auf der Karteikarte **Ansicht** im Dialog des Menübefehls **Datei > Eigenschaften** die Option **Nur Feldnamen anzeigen** ein, werden die Rechenformeln im Text sichtbar. Die Rechnung sollte dann etwa folgendermaßen aussehen:

\[
\begin{align*}
\text{DAUER} &= 2 \text{ Stunden} & \text{PREIS} &= 10 \\
\text{SUMME} &= \text{DAUER} \times \text{PREIS} \\
\text{MWST} &= \text{SUMME} \times 19/100 \\
\text{GESAMTBETRAG} &= \text{SUMME} + \text{MWST}
\end{align*}
\]

Schalten Sie **Nur Feldnamen anzeigen** wieder aus, sehen Sie die Ergebnisse im Text.

Soll nun eine Rechnung für einen anderen Kunden geschrieben werden, muss nur der Wert für die Variable **DAUER** geändert werden. Dazu markieren Sie die 2 vor "Stunden", rufen den Menübefehl **Einfügen > Berechnung** auf und ersetzen die 2 in der Formel einfach durch die gewünschte Stundenzahl. Nach Ihrem **OK** führt TextMaker die Neuberechnung durch.

**Nachkommastellen**: Etwas unschön mag Ihnen dabei vorkommen, dass die Geldbeträge nicht wie üblich mit zwei Nachkommastellen angezeigt werden. Dies können Sie aber sofort ändern: Markieren Sie die entsprechenden Berechnungen dazu jeweils, rufen Sie den Menübefehl **Einfügen > Berechnung** auf, wählen Sie bei **Nachkommastellen** die Option **Fest** und tragen Sie daneben eine "2" ein.
Tabellenzellen in Berechnungen

Sie können in Tabellen auch Berechnungen mit den Zellen von Tabellen anstellen – ähnlich einer Tabellenkalkulation!

Wenn Sie sich in einer Tabelle von Zelle zu Zelle bewegen, sollten Sie einmal auf die Statuszeile am unteren Rand des Programmfensters achten. Dort werden nämlich die Koordinaten der aktuellen Tabellenzelle angezeigt.

Die Zeilen einer Tabelle sind bei TextMaker mit 1, 2, 3 etc. durchnummeriert; die Spalten erhalten die Buchstaben A, B, C etc.:

<table>
<thead>
<tr>
<th>A1</th>
<th>B1</th>
<th>C1</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2</td>
<td>B2</td>
<td>C2</td>
<td>...</td>
</tr>
<tr>
<td>A3</td>
<td>B3</td>
<td>C3</td>
<td>...</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>


Um innerhalb einer Tabelle Berechnungen mit den Zellinhalten anzustellen, rufen Sie den Menübefehl **Einfügen > Berechnung** auf und geben, angeführt von einem Doppelkreuz (#), einfach deren Koordinaten an. Für "Addiere den Inhalt der Zellen A1 und A2" wäre die korrekte Rechenformel also:

#A1 + #A2

Das Doppelkreuz # teilt TextMaker mit, dass er den Inhalt der Zelle als **Zahl** behandeln soll. Soll der Zellinhalt hingegen als **Text** angesehen werden, verwenden Sie das Dollarzeichen ($) – zum Beispiel $A1.

Beachten Sie dabei, dass Berechnungen wie #A1 + #A2 nur **innerhalb** der gleichen Tabelle funktionieren. Wenn Sie die Zellen A1 und A2 **außerhalb** dieser Tabelle addieren möchten, müssen Sie jeweils den Namen der Tabelle und einen Punkt voranstellen. Heißt die Tabelle also "Tabelle1", wäre die korrekte Formel:

Tabelle1.#A1 + Tabelle1.#A2

Siehe dazu auch Abschnitt **Objekte in Berechnungen**.

Summe von Tabellenbereichen berechnen

Besonders praktisch zum Addieren von Zahlen in Tabellenzellen ist die SUM-Funktion. Geben Sie als Parameter einfach die erste und letzte gewünschte Zelle an, und TextMaker zählt die Werte in allen Zellen dieses Bereichs zusammen.

Mit SUM(#B2,#B5) können Sie beispielsweise den Inhalt der Zellen B2 bis B5 addieren.

Berechnungen mit benachbarten Zellen leichtgemacht

Tipp: In einigen Rechenfunktionen (z.B. SUM) können Sie auch **symbolische** Zellreferenzen verwenden, die stellvertretend für alle Zellen stehen, die direkt an eine Zelle angrenzen.
Hierfür gibt es folgende symbolische Zellreferenzen:

- **ABOVE** (steht für die Zellen oberhalb der aktuellen Zelle)
- **BELOW** (steht für die Zellen unterhalb der aktuellen Zelle)
- **LEFT** (steht für die Zellen links der aktuellen Zelle)
- **RIGHT** (steht für die Zellen rechts der aktuellen Zelle)


Folgende Funktionen unterstützen symbolische Zellreferenzen:

- AVG, COUNT, MIN, MAX, PROD, SUM

(Beschreibungen aller Rechenfunktionen finden Sie im Abschnitt Übersicht Rechenfunktionen.)

---

**Datenbankfelder in Berechnungen**

In Berechnungen lassen sich auch Felder einer Datenbank einsetzen. Voraussetzung dafür ist, dass Sie dem Dokument über den Menübefehl **Weiteres > Datenbank zuordnen** eine Datenbank zugeordnet haben.

Sie brauchen die Feldnamen nicht einmal von Hand einzugeben. Betrachten Sie nämlich das Dialogfenster des Menübefehls **Einfügen > Berechnung**, wird Ihnen auffallen, dass in der Liste **Variable/Feld** die Namen aller Datenbankfelder auftauchen, sobald Sie dem Dokument eine Datenbank zuordnen. Diese lassen sich per Doppelklick in die Rechenformel einsetzen.

Als Beispiel wollen wir ein Rechnungsformular erstellen, das sich komfortabel als Serienbrief ausdrucken lässt. Dazu brauchen Sie lediglich eine Datenbank, die Felder für die persönlichen Daten des Kunden enthält (Name, Straße, Ort etc.). Darüber hinaus soll die Datenbank – lassen Sie uns das grob vereinfachen und nur einen Artikel pro Rechnung zulassen – ein Feld Menge mit der Bestellmenge, ein Feld ARTIKEL mit der Bezeichnung des Artikels und ein Feld PREIS mit dem Einzelpreis enthalten. Los geht’s:

1. Erstellen Sie mithilfe des Menübefehls **Datei > Neu** ein neues Dokument.
2. Weisen Sie diesem mit dem Menübefehl **Weiteres > Datenbank zuordnen** eine geeignete Datenbank zu (Beispiel: siehe unten).
4. Gestalten Sie nach eigenem Gusto die Rechnung selbst. Verwenden Sie dabei die Felder Ihrer Datenbank – beispielsweise für die bestellte Menge das Datenbankfeld Menge, das Sie über den Menübefehl **Einfügen > Feld > Datenbankfeld** einsetzen, etc.
Beispiel


Je nach Betriebssystem finden Sie diesen Ordner wie folgt:

- **Windows:** Navigieren Sie zu Ihrem Dokumenten-Ordner und öffnen Sie darin den Ordner SoftMaker\Beispiele.
- **macOS:** Navigieren Sie zu Ihrem Benutzerordner und öffnen Sie darin den Ordner SoftMaker/Beispiele.
- **Linux:** Navigieren Sie zu Ihrem Home-Verzeichnis und öffnen Sie darin den Ordner SoftMaker/Beispiele.
- **Android:** Navigieren Sie zu dem Ordner SoftMaker/Beispiele auf Ihrer SD-Karte.


Objekte in Berechnungen

Manche Arten von Objekten lassen sich auch in Berechnungen verwenden. So können Sie beispielsweise ein Formular erstellen, das Textfelder enthält, und mit dem Inhalt dieser Textfelder Berechnungen anstellen.

Wie im Abschnitt Namen von Objekten ändern beschrieben wurde, haben alle Objekte in einem Dokument eindeutige Namen. In Berechnungen können Sie jedes einzelne Objekt anhand seines Namens ansprechen. Textbox1 liefert beispielsweise den Inhalt des Textfelds "Textbox1".

Folgendermaßen werten Sie den Inhalt von Objekten in Berechnungen aus:

- **Textfelder und Textrahmen**
  
  Textbox1.Text (oder kurz Textbox1) gibt den Inhalt des Textfelds mit dem Namen "Textbox1" als Text zurück (ohne Formattierung).

  Textbox1.Wert interpretiert den Inhalt dieses Textfelds hingegen als Zahl.

- **Tabellen**
  
  Tabelle1.A1 gibt den Inhalt der Zelle A1 der Tabelle1 zurück.

  Tabelle1.#A1 interpretiert den Inhalt dieser Zelle als Zahl.

  Tabelle1.$A1 interpretiert den Inhalt dieser Zelle als Text.

  Tabelle1 liefert die Summe aller Tabellenzellen von Tabelle1.

- **Kontrollkästchen und Kontrollkästchenrahmen**

  Kontrollkästchen1.Sel (oder kurz Kontrollkästchen1) gibt zurück, ob das Kontrollkästchen angekreuzt wurde (0 = nein, 1 = ja).

Auswahllisten und Auswahllistenrahmen

*Auswahlliste1.Text* gibt den *Text* zurück, der in Auswahlliste1 gewählt wurde.

*Auswahlliste1.Sel* (oder kurz *Auswahlliste1*) gibt die *Nummer* des gewählten Eintrags zurück.


---

**Berechnungen formatieren und runden**

Über den Menübefehl *Einfügen > Berechnung* können Sie nicht nur neue Berechnungen eingeben (siehe Abschnitt *Einfügen von Berechnungen*) und bestehende bearbeiten, sondern auch das Format einer Berechnung bestimmen.

Sie können das Format gleich beim Einfügen einer neuen Berechnung festlegen oder es jederzeit nachträglich ändern, indem Sie die Berechnung markieren und den Menübefehl *Einfügen > Berechnung* aufrufen.

Folgende Optionen des Dialogfensters bestimmen das Format der Berechnung:

- **Tausenderpunkte**
  
  Schalten Sie diese Option ein, werden Zahlen ab 1000 mit Tausenderpunkten dargestellt. 1230000 wird beispielsweise als 1.230.000 angezeigt.

- **Verborgen**
  
  Wurde diese Option angewählt, ist das Ergebnis der Berechnung nicht im Text zu sehen. Dies ist sinnvoll, wenn Sie beispielsweise Zwischenberechnungen mit Variablen durchführen möchten, deren Ergebnis nicht angezeigt werden soll.

  Hinweis: Um eine verborgene Berechnung wieder sichtbar zu machen, rufen Sie den Menübefehl *Datei > Eigenschaften* auf, wechseln auf die Karteikarte *Ansicht* und aktivieren die Option *Nur Feldnamen anzeigen*. Jetzt können Sie die Berechnung wieder selektieren, den Menübefehl *Einfügen > Berechnung* aufrufen und die Option *Verborgen* wieder ausschalten.

- **Nachkommastellen**
  

  **Beachten Sie:** Hierbei wird der Wert nicht tatsächlich gerundet, sondern nur gerundet angezeigt (siehe unten)!

**Variablen tatsächlich runden**

Bei der gerade vorgestellten Möglichkeit, die Zahl der Nachkommastellen für Berechnungen einzustellen, gibt es unbedingt zu beachten: Es wird dadurch nur die Anzahl der Nachkommastellen *für die Anzeige* geändert. In Wirklichkeit behält die Variable jedoch ihre tatsächliche Zahl an Nachkommastellen.

In der Praxis heißt das: Geben Sie die Variable A mit dem Wert 2,5 aus und setzen Sie die Zahl der Nachkommastellen dabei auf 0, erscheint eine 3. Multiplizieren Sie A jedoch mit 2, kommt jedoch nicht 6 heraus, sondern 5.
Deshalb verfügt TextMaker auch über eine Funktion namens ROUND für das echte Runden. Diese kann beispielsweise wie folgt eingesetzt werden:

\[ A = \text{ROUND} ( 2.5 ; 0 ) \]


Ausführliche Informationen zu allen Rechenfunktionen von TextMaker finden Sie im Abschnitt "Rechenformeln und -funktionen".

### Berechnungen aktualisieren

Wenn Sie über den Menübefehl **Einfügen > Berechnung** eine Berechnung eingeben oder bearbeiten, aktualisiert TextMaker automatisch auch alle anderen Berechnungen im Dokument, sobald Sie mit **OK** bestätigt haben.


Für solche Fälle ist der Menübefehl **Weiteres > Felder aktualisieren** vorgesehen. Rufen Sie diesen auf, bringt TextMaker die Bildschirmanzeige aller Berechnungen und Felder im Dokument auf den neuesten Stand.

**Hinweis:** Dieser Befehl ist nur in den oben genannten Fällen zur Aktualisierung der Anzeige von Berechnungen auf dem Bildschirm nötig. Vor dem Drucken eines Dokuments aktualisiert TextMaker automatisch alle Berechnungen und Felder. Dass Sie beim Ausdrucken ein Dokument mit veralteten Ergebnissen erhalten, ist also ausgeschlossen.

### Bedingter Text

TextMaker erlaubt über die Rechenfunktion IF auch das Arbeiten mit Bedingungen. Auf diese Weise können Sie beispielsweise "bedingten Text" in Ihren Dokumenten verwenden.

Ein typischer Fall: Sie haben eine Adressdatenbank mit einem Feld namens GESCHLECHT, in der ein Schlüssel für das Geschlecht der jeweiligen Person steht: "M" für männlich oder "W" für weiblich. Mit folgender IF-Anweisung lassen Sie TextMaker eine vom Geschlecht abhängige Anrede ausgeben:

\[ \text{IF (GESCHLECHT}="M" ; "Sehr geehrter Kunde" ; "Sehr geehrte Kundin")} \]

Verwenden Sie diese Berechnung in einem Serienbrief, sieht TextMaker bei jedem Datensatz nach, ob das Feld GESCHLECHT ein "M" enthält. Ist dies der Fall, liefert obige Rechenformel das Ergebnis "Sehr geehrter Kunde", ansonsten erscheint "Sehr geehrte Kundin".
Einfache Berechnungen auf Knopfdruck


Der Unterschied:

Der Menübefehl Einfügen > Berechnung eignet sich für beliebig komplexe Berechnungen mit Variablen etc.

Der Menübefehl Bearbeiten > Ausrechnen eignet sich nur für simplere Berechnungen, er ist aber viel einfacher anzuwenden: Sie tippen eine Rechenformel einfach direkt in den Text, markieren diese und rufen Bearbeiten > Ausrechnen auf – schon steht das Ergebnis im Text.

Ein Beispiel:

1. Tippen Sie: "Die Summe ist: 90+55+220".
2. Markieren Sie "90+55+220".

Einfacher und schneller geht’s nicht mehr: Eine Berechnung markieren und F8 drücken.

Wichtig: Im Gegensatz zum Rechnen mit dem Menübefehl Einfügen > Berechnung wird das Ergebnis hier nicht als Feld angelegt, sondern im Klartext ins Dokument geschrieben.


Funktionen verwenden: Es sind nicht nur die Grundrechenarten erlaubt, sondern auch Funktionen (siehe Abschnitt Rechenformeln und -funktionen: Tippen Sie "SQRT(2)", markieren dies und rufen den Menübefehl Bearbeiten > Ausrechnen auf, erscheint als Ergebnis die Wurzel von 2.


Tabellenzellen summieren

Auch in Tabellen lassen sich so Berechnungen durchführen. Hier gibt es sogar noch eine zusätzliche Funktion:

- Haben Sie eine Berechnung innerhalb einer Tabellenzelle markiert, können Sie diese wie oben beschrieben mit dem Menübefehl Bearbeiten > Ausrechnen berechnen lassen.

- Markieren Sie hingegen mehrere komplette Tabellenzellen, steht im Menü Bearbeiten der Befehl Tabellenzellen summieren zur Verfügung. Rufen Sie diesen auf, berechnet TextMaker die Summe der Werte in den markierten Tabellenzellen.

Es erscheint dann ein Fenster, das Ihnen das Ergebnis mitteilt. Wenn Sie dieses einfach nur zur Kenntnis nehmen und nicht weiter verwenden möchten, klicken Sie auf Schließen. Alternativ können Sie die

### Rechenformeln und -funktionen


**Hinweis:** Es geht in diesem Abschnitt um das Formulieren von **Rechenformeln** (zum Durchführen von Berechnungen im Text). Falls Sie Informationen über den **SoftMaker Formeleditor** (zur grafischen Darstellung mathematischer Formeln) suchen, finden Sie diese im Abschnitt [Verwendung des SoftMaker Formeleditors](#).

#### Der Aufbau einer Rechenformel

Rechenformeln dürfen aus bis zu 255 Zeichen bestehen. Das Ergebnis ist auf 100 Zeichen begrenzt.

Sie können Rechenformeln aus folgenden Bestandteilen aufbauen:

**Feste Werte**

Eine Rechenformel ergibt sich in ihrer einfachsten Form aus einem festen Wert – wie in den folgenden Beispielen:

- **Zeichenketten**
  
  Beispiel: "Guten Tag!"

  Eine Rechenformel mit diesem Inhalt ergibt stets die Zeichenkette "Guten Tag!". (Eine **Zeichenkette** ist eine Reihe von Zeichen – also Buchstaben, Ziffern oder Sonderzeichen.)

  Zeichenketten dürfen maximal 100 Zeichen lang werden.

  **Wichtig:** Wenn Sie feste Zeichenketten direkt in eine Rechenformel eingeben (z.B. "Guten Tag!") müssen diese mit "Anführungszeichen" versehen werden. TextMaker würde sonst versuchen, sie als Funktionsnamen oder Variablennamen zu interpretieren.

- **Numerische Werte**
  
  Beispiel: 42,50

  Natürlich kann ein fester Wert auch ein numerischer Wert, sprich eine Zahl sein. Diese Rechenformel liefert stets die Zahl 42,5 zurück.

- **Datumsangaben**
  
  Beispiel: "20.04.18"

  Diese Formel entspricht dem Datum 20.4.2018.
FORMAT VON DATUMSANGABEN:

Beachten Sie bitte beim Eingeben von festen Datumsangaben in Rechenformeln:

1. Wenn Sie feste Datumsangaben in Rechenformeln eingeben, müssen Sie diese mit "Anführungszeichen" versehen.

2. Tag und Monat müssen stets zweistellig angegeben werden. "20.04.18" wäre also korrekt, "20.4.18" hingegen falsch (Monat ist einstellig).

3. Das Jahr kann wahlweise zwei- oder vierstellig angegeben werden. "20.04.18" ist also genauso zulässig wie "20.04.2018".

4. Wenn Sie eine zweistellige Jahreszahl zwischen 0 und 29 angeben, stellt TextMaker automatisch 20... voran. Bei Jahreszahlen zwischen 30 und 99 stellt TextMaker 19... voran. Das Datum "01.01.29" wird also als 1.1.2029 interpretiert, das Datum "01.01.30" als 1.1.1930.

DATENBANKFELDER, TABELLENZELLEN UND OBJEKTE

Sie können auch den Inhalt von Datenbankfeldern, Tabellenzellen und Objekten in Rechenformeln verwenden.

Informationen dazu finden Sie in den Abschnitten Tabellenzellen in Berechnungen, Datenbankfelder in Berechnungen und Objekte in Berechnungen.

BERECHNUNGEN

Eine Rechenformel kann verschiedene Arten von Berechnungen enthalten.

Beispiel: 6*5
Liefert immer den festen Wert 30 zurück, ist also eigentlich ein fester Wert – keine Berechnung.

Beispiel: 5*ANZAHL
In dieser Formel wird der feste Wert 5 mit der Variablen ANZAHL multipliziert. Hat ANZAHL momentan den Wert 10, ergibt die Formel 50.

Weiterhin stellt TextMaker Ihnen auch eine Vielzahl an Rechenfunktionen zur Verfügung. Detaillierte Beschreibungen finden Sie im Abschnitt Übersicht Rechenfunktionen. Hier vorab einige Beispiele:

Beispiel: TODAY()

Beispiel: MONTH(TODAY())

Beispiel: INT(B/1000)
Hier wird die Funktion INT, welche die Nachkommastellen eines Wertes entfernt, auf die Berechnung B/1000 angewandt. Hat B den Wert 3752,70, ergibt die Formel den Wert 3.

Das Argument für Funktionen kann also eine andere Funktion, eine beliebige Berechnung, ein Datenbankfeld, eine Tabellenzelle und natürlich auch eine Kombination aus alledem sein.
**Variablen**

Das Ergebnis einer Rechenformel kann einer Variablen zugewiesen werden.

Tipp: Im Dialogfenster von des Menübefehls Einfügen > Berechnung erscheinen alle momentan definier-ten Variablen in der Liste Variable/Feld. Per Doppelklick können sie in die Rechenformel eingesetzt wer-
den.

Beispiel: PREIS=17,99


**Hinweis:** Immer, wenn Sie einen Wert oder eine Berechnung einer Variablen zuweisen, erscheint das Er-
gebnis der Variablen an der aktuellen Position im Text. Wünschen Sie dies nicht – zum Beispiel, weil Sie
nur eine Zwischenberechnung durchführen wollen, deren Ergebnis nicht angezeigt werden soll –, schal-
ten Sie bei der Eingabe der Rechenformel im Dialogfenster des Menübefehls Einfügen > Berechnung
die Option Verborgen ein.

Beispiel: MONAT=MONTH(TODAY())

Hier wird der Monat des heutigen Datums ausgerechnet und ausgegeben. Gleichtzeitig wird das Ergebnis
aber auch in der Variablen MONAT gespeichert.

Natürlich lassen sich solche Variablen auch in anderen Rechenformeln verwenden.

Beispiel: PREIS*1,19

Diese Rechenformel liefert den momentanen Inhalt der Variable PREIS, multipliziert mit 1,19.

**Operatoren**

Folgende Operatoren können in Rechenformeln verwendet werden:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addieren (bei Zahlen) beziehungsweise Verbinden* (bei Zeichenketten)</td>
</tr>
<tr>
<td>-</td>
<td>Subtrahieren</td>
</tr>
<tr>
<td>*</td>
<td>Multiplizieren</td>
</tr>
<tr>
<td>/</td>
<td>Dividieren</td>
</tr>
<tr>
<td>%</td>
<td>Modulo (Rest einer Division)</td>
</tr>
</tbody>
</table>

* Über das Pluszeichen lassen sich nicht nur Zahlenwerte addieren, sondern auch Zeichenketten zusammenfügen. "Text"+"Maker" ergibt beispiels-
weise "TextMaker".

Es gilt die Punkt-vor-Strich-Regel. Multiplikationen und Divisionen werden also vor Additionen und Sub-
traktionen ausgerechnet. 2+3*4 ergibt 14.

Diese Hierarchie können Sie durch Klammern beeinflussen: (2+3)*4 ergibt 20.
Weiterhin gibt es Vergleichsoperatoren, wie sie beispielsweise von der Funktion IF benötigt werden:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Ist gleich?</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Ungleich?</td>
</tr>
<tr>
<td>&gt;</td>
<td>Größer als?</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Größer als oder gleich?</td>
</tr>
<tr>
<td>&lt;</td>
<td>Kleiner als?</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Kleiner als oder gleich?</td>
</tr>
<tr>
<td>&amp;</td>
<td>Logisches &quot;Und&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>Negation</td>
</tr>
</tbody>
</table>

**Einige Hinweise zu Vergleichen**

- Beim Vergleich zweier Zeichenketten mit "=" ist das Ergebnis nur dann "wahr", wenn die Zeichenketten *exakt* übereinstimmen und die *gleiche Länge* haben. Die Groß-/Kleinschreibung wird dabei berücksichtigt.

  "Hans"="Hans" ist wahr.

  "Hans"="hans" ist falsch.

  "Hans"="Hans-Peter" ist falsch.

- Falls Sie einen komplexen Vergleich mit mehreren "Unds" und "Oders" konstruieren, sollten Sie die einzelnen Bedingungen jeweils in Klammern setzen.

**Übersicht Rechenfunktionen**

In TextMaker können Sie die nachfolgend beschriebenen Rechenfunktionen verwenden. Die für die Funktion erforderlichen Parameter sind jeweils in Klammern angegeben:

- $n$ Eine Zahl
- $s$ Eine Zeichenkette
- $d$ Ein Datum

Beim INT($n$) müsste als Parameter also beispielsweise eine Zahl oder andere Berechnung, die eine Zahl ergibt, angegeben werden – zum Beispiel INT(3,14) oder INT(1+SQRT(2)).

**Wichtig:** Werden mehrere Argumente verlangt, sind diese voneinander nicht durch Kommas, sondern durch Semikolons (;) zu trennen.
<table>
<thead>
<tr>
<th>Funktion</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS(n)</td>
<td>Absolutwert der Zahl n. (Das Vorzeichen wird entfernt.) – ABS(3) ergibt 3, ABS(-3) ebenfalls.</td>
</tr>
<tr>
<td>ASC(s)</td>
<td>Position des Zeichens s im Zeichensatz – ASC(&quot;A&quot;) ergibt 65.</td>
</tr>
<tr>
<td>AT(s1; n2)</td>
<td>Gibt als Zahlenwert zurück, an welcher Position der Zeichenkette s1 die Zeichenkette n2 zum ersten Mal vorkommt – AT(&quot;Bauhaus&quot;,&quot;au&quot;) ergibt 2.</td>
</tr>
<tr>
<td>CHR(n)</td>
<td>Das Zeichen mit der Position n im Zeichensatz – CHR(65) ergibt ein &quot;A&quot;.</td>
</tr>
<tr>
<td>DAY(d)</td>
<td>Der Tag des Datums d (als Zahl) – DAY(&quot;25.09.18&quot;) ergibt 25.</td>
</tr>
<tr>
<td>DTON(d)</td>
<td>Wandelt das Datum d in eine serielle Tageszahl um. Wird benötigt, um die Differenz zweier Datumsangaben in Tagen zu berechnen: DTON (&quot;12.11.18&quot;) - DTON (&quot;20.10.18&quot;) ergibt 23 (Tage).</td>
</tr>
<tr>
<td>IF</td>
<td>IF(Bedingung; Wert1; Wert2) gibt Wert1 zurück, wenn die Bedingung wahr ist, ansonsten wird Wert2 zurükgeliefert. Wert2 kann allerdings auch weggelassen werden. Beispiel: IF (GESCHLECHT=&quot;W&quot; ; &quot;Sehr geehrte Dame&quot; ; &quot;Sehr geehrter Herr&quot;) – siehe Abschnitt Bedingter Text. Wert1 und Wert2 können von einem beliebigen Typ sein (also beispielsweise auch numerisch).</td>
</tr>
<tr>
<td>INT(n)</td>
<td>Nachkommastellen der Zahl n abschneiden (ohne zu runden) – bei der Formel INT(3,90) wäre das Ergebnis 3.</td>
</tr>
<tr>
<td>LEFT(s; n)</td>
<td>Gibt die ersten n Zeichen der Zeichenkette s zurück – LEFT(&quot;TextMaker&quot;; 4) ergibt &quot;Text&quot;.</td>
</tr>
<tr>
<td>LEN(s)</td>
<td>Länge der Zeichenkette s – LEN(&quot;John&quot;) ergibt 4.</td>
</tr>
<tr>
<td>LOWER(s)</td>
<td>Wandelt die Zeichenkette s in Kleinbuchstaben um – LOWER(&quot;John&quot;) ergibt &quot;john&quot;.</td>
</tr>
<tr>
<td>LTRIM(s)</td>
<td>Entfernt alle führenden Leerzeichen aus der Zeichenkette s – LTRIM(&quot; Text &quot;) ergibt &quot;Text&quot;.</td>
</tr>
<tr>
<td>MONTH(d)</td>
<td>Der Monat des Datums d (als Zahl) – MONTH(&quot;25.09.18&quot;) ergibt 9.</td>
</tr>
<tr>
<td>NTOD(n)</td>
<td>Gegenstück zu DTON – Sie geben mit n die serielle Tageszahl an, und NTOD wandelt diese in ein Datum um.</td>
</tr>
</tbody>
</table>
POW(n1;n2)  Potenziert die Zahl n1 mit dem Exponenten n2 – POW(2;8) ergibt 256.


RIGHT(s;n)  Gibt die letzten n Zeichen der Zeichenkette s zurück – RIGHT("TextMaker"; 5) ergibt "Maker".

ROUND(n1;n2)  Die Zahl n1 wird auf n2 Nachkommastellen gerundet – ROUND(2,44;1) ergibt 2,4 und ROUND(2,45;1) ergibt 2,5.

RTRIM(s)  Entfernt alle abschließenden Leerzeichen aus der Zeichenkette s – RTRIM(" Text ") ergibt " Text".

SQRT(n)  Quadratwurzel der Zahl n – SQRT(4) ergibt 2.

STR(n)  Wandelt die Zahl n in eine Zeichenkette um – bei STR(17) wäre das Ergebnis die Zeichenkette "17".

STRING(s;n)  Zeichenkette s wird n mal wiederholt – STRING("Text"; 3) ergibt "TextTextText".

SUBSTR(s;n1;n2)  Extrahiert n2 Zeichen aus der Zeichenkette s ab Position n1 – SUBSTR("Kartoffel";2;3) ergibt "art"


TODAY()  Heutiges Datum im Format TT.MM.JJ. Das leere Klammernpaar hinter dem Funktionsnamen muss eingegeben werden.

TRIM(s)  Entfernt alle Leerzeichen am Beginn und Ende der Zeichenkette s – TRIM(" Text ") ergibt "Text".

TRUNC(n1;n2)  Schneidet von der Zahl n1 alle Nachkommastellen bis auf n2 ab – TRUNC(1,2345;2) ergibt 1,23.

UPPER(s)  Wandelt die Zeichenkette s in Großbuchstaben um – UPPER("John") ergibt "JOHN"

USER()  Name, unter dem der aktuelle Benutzer auf diesem System angemeldet ist. Das leere Klammernpaar hinter dem Funktionsnamen muss eingegeben werden.

VAL(s)  Wandelt die Zeichenkette s in eine Zahl um. Die Zeichenkette darf dabei auch Text enthalten, TextMaker nimmt dann die erste Zahl, die er darin finden kann: VAL("9") ergibt 9. VAL("9 Bratwürste") und VAL("Bitte 9 Bratwürste und 3 Brötchen") ebenfalls. VAL("Bratwürste") ergibt 0, da keine Zahl enthalten ist.

YEAR(d)  Die Jahreszahl eines Datums als Zahl (zweistellig) – die Formel YEAR("17.09.18") ergibt 18.
Arbeiten mit umfangreichen Dokumenten

Für das Verfassen von umfangreichen Dokumenten wie wissenschaftlichen Arbeiten oder Büchern hält TextMaker einige nützliche Funktionen bereit:

- **Gliederungen**

- **Verzeichnisse (Inhalt, Stichwörter etc.)**
  TextMaker kann Ihnen beim Erstellen von Verzeichnissen wie Inhalts- oder Stichwortverzeichnissen helfen. Folgende Arten von Verzeichnissen werden unterstützt:
  - Stichwortverzeichnisse
  - Inhaltsverzeichnisse
  - Beschriftungen und Abbildungsverzeichnisse
  - Bibliografien (Literaturverzeichnisse)
  Für Details lesen Sie bitte den entsprechenden Unterabschnitt.

- **Querverweise**
  Auch das Anbringen von *Querverweisen* auf andere Textstellen und Objekte ist möglich – zum Beispiel: "Siehe Grafik auf Seite 12".

- **Vorlagenverweise**
  Ein Vorlagenverweis-Feld durchsucht das Dokument rückwärts nach Text in der gewählten Formatvorlage und zeigt diesen Text dann an. Dies ermöglicht es, beispielsweise die aktuelle Hauptüberschrift (die ja üblicherweise in der Absatzvorlage "Überschrift 1" formatiert wurde) im Text anzuzeigen.

- **Fußnoten**

**Gliederungen**

Umfangreiche Dokumente sollten Sie mit einer *Gliederung* versehen, das Dokument also nach Themen und Unterthemen aufgliedern und vor jedem neuen Themenabschnitt eine Überschrift anbringen. Dies schafft Übersicht und lockert den Text auf.

Sie können dazu die *Gliederungsansicht* von TextMaker verwenden, in die Sie mit dem Menübefehl **Ansicht > Gliederung** gelangen.
Arbeiten mit umfangreichen Dokumenten

Die Gliederungsansicht ist nichts weiter als eine andere Darstellungsart des Dokuments. Sehen wir uns diese einmal etwas genauer an:

Wie Sie sehen, werden die einzelnen Textabschnitte in dieser Ansicht unterschiedlich weit eingerückt dargestellt. Hauptüberschriften stehen ganz links, Überschriften der nächsttieferen Gliederungsebene etwas weiter rechts usw.

Weiterhin wurde die Formatleiste ausgeblendet und durch die Gliederungsleiste ersetzt. Diese enthält, wie der Name schon sagt, Funktionen zum Gliedern von Dokumenten.


Über die Schaltflächen 1 bis 9 können Sie weiterhin bestimmen, welche Ebenen von Überschriften angezeigt werden sollen. Bei der Schaltfläche 3 werden beispielsweise nur noch Überschriften von der ersten bis zur dritten Gliederungsebene angezeigt. Die Schaltfläche Alle sorgt dafür, dass wieder alle Ebenen zu sehen sind.

Die Gliederungsansicht ist nicht nur zum Betrachten des Dokuments geeignet, sondern auch zum Bearbeiten der Gliederung. Auch hierfür verwenden Sie die Gliederungsleiste: Mit Hilfe der Schaltflächen mit den Pfeilchen können Sie die Gliederungsebene von Überschriften höher- oder tieferstufen oder normale Textabsätze zu Überschriften "ernennen".


Ausführlichere Informationen zum Arbeiten mit Gliederungen finden Sie auf den nächsten Seiten. Folgende Themen werden darin behandelt:
- Gliederungsansicht verwenden
- Überschriften formattieren
- Profi-Tipp: Überschriften über Absatzvorlagen verwalten
- Gliederungen in der Praxis
- Überschriften nummerieren
- Gegliederte Dokumente und Kapitel

## Gliederungsansicht verwenden

Wie in der Einleitung erwähnt, stellt Ihnen TextMaker zum Bearbeiten der Gliederung eines Dokuments einen speziellen Anzeigemodus zur Verfügung: die sogenannte **Gliederungsansicht**.

Um in die Gliederungsansicht zu wechseln, rufen Sie den Menübefehl **Ansicht > Gliederung** auf. Mit **Ansicht > Normal** können Sie von der Gliederungsansicht jederzeit wieder zur Normalansicht zurückkehren.

In der Gliederungsansicht sehen Sie das Dokument nach Haupt- und Unterüberschriften aufgegliedert. Die Überschriften der ersten Ebene (Hauptüberschriften) sind ganz links angeordnet. Die tieferen Ebenen sind jeweils etwas weiter nach rechts eingerückt.

Alles Weitere zur Gliederungsansicht erfahren Sie in den nächsten Abschnitten.

## Gliederungsebene von Absätzen ändern

Um ein Dokument mit einer Gliederung zu versehen oder eine vorhandene Gliederung zu bearbeiten, wechseln Sie in die Gliederungsansicht und ändern darin einfach die Gliederungsebene der Absätze, die Überschriften enthalten.

Wenn Sie Text eingeben, haben standardmäßig alle Absätze dieses Textes die Gliederungsebene 0. Weisen Sie nun einem bestimmten Absatz beispielsweise die Gliederungsebene 1 zu, dann haben Sie diesen Absatz zu einer Überschrift erster Ebene "ernannt".

Durch Zuweisen der Gliederungsebene 1 bestimmen Sie also die Hauptüberschriften im Dokument. Möchten Sie dann unterhalb der Hauptüberschriften weitere *untergeordnete* Überschriften, weisen Sie diesen die Gliederungsebene 2 zu etc.

Die Gliederungsebene eines Absatzes lässt sich wie folgt ändern:

1. Rufen Sie mit dem Menübefehl **Ansicht > Gliederung** die Gliederungsansicht auf.
2. Bewegen Sie die Schreibmarke auf den gewünschten Absatz.
3. Klicken Sie auf eines der folgenden Symbole in der Gliederungsleiste oder verwenden Sie eines der folgenden Tastenkürzel:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Gliederungsebene des Absatzes um 1 erhöhen. Tastenkürzel: <strong>Alt+Umschalt+ Graves</strong></td>
</tr>
</tbody>
</table>
Arbeiten mit umfangreichen Dokumenten

Gliederungsebene des Absatzes um 1 reduzieren. Tastenkürzel: Alt+Umschalt++
Dem Absatz Gliederungsebene 0 (= normaler Text) zuweisen. Tastenkürzel: Strg+Umschalt+N

Tipp: Weiterhin sind den Gliederungsebenen 1 bis 3 standardmäßig die Tastenkürzel Alt+1 bis Alt+3 zugewiesen, der Ebene 0 (für normalen Text) das Tastenkürzel Alt+0. Mit diesen Tastenkombinationen können Sie also blitzschnell Überschriften der Ebenen 1 bis 3 anlegen oder eine Überschrift wieder zu normalem Text machen. Diese Tastenkombinationen funktionieren übrigens nicht nur in der Gliederungsansicht, sondern auch in der Normalansicht.

Anzuzeigende Gliederungsebenen auswählen

Um die Struktur eines Dokuments in der Gliederungsansicht besser überblicken zu können, bietet es sich an, den normalen Text ausblenden, so dass nur noch die Überschriften sichtbar sind. Bei Bedarf können Sie außerdem Überschriften unterhalb einer bestimmten Ebene ausblenden.

Zu diesem Zweck verfügt die Gliederungsleiste über folgende Schaltflächen:


Tipp: Anstelle dieser Schaltfläche können Sie auch das Tastenkürzel Alt+Umschalt+A verwenden, um die Anzeige von Text ein- oder auszuschalten.

Mit den anderen Schaltflächen können Sie bestimmen, welche Gliederungsebenen angezeigt werden sollen. Ein Mausklick auf die Schaltfläche "1" sorgt dafür, dass nur noch die Hauptüberschriften zu sehen sind. Ein Klick auf die Schaltfläche "3" blendet alle Überschriften bis einschließlich Ebene 3 ein etc.

Tipp: Anstelle der Schaltflächen "1" bis "9" können Sie hierfür auch die Tastenkürzel Alt+Umschalt+1 bis Alt+Umschalt+9 verwenden.

Standardmäßig ist die Schaltfläche Alle gewählt, TextMaker zeigt also alle Überschriftenebenen an.

Anzeige einer Überschrift erweitern/reduzieren

Wie gerade beschrieben, kann man in der Gliederungsansicht mit den Schaltflächen "1" bis "9" einen Teil der Überschriftenebenen ausblenden, um nur die Überschriften bestimmter Ebenen zu sehen.

Was aber, wenn Sie von einer einzelnen Überschrift nun doch die untergeordneten Ebenen einsehen möchten? Hierfür haben Sie folgende Möglichkeiten:
■ Schaltflächen "+" und "−" in der Gliederungsleiste

Bewegen Sie die Schreibmarke in die gewünschte Überschrift. Klicken Sie dann auf eines der folgenden Symbole in der Gliederungsleiste oder verwenden Sie eines der folgenden Tastenkürzel:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Eine weitere Unterebene einblenden. Tastenkürzel: Alt+Umschalt+(Num+) (Plustaste auf der Zehnertastatur)</td>
</tr>
<tr>
<td>−</td>
<td>Eine Unterebene weniger anzeigen. Tastenkürzel: Alt+Umschalt+(Num-) (Minustaste auf der Zehnertastatur)</td>
</tr>
</tbody>
</table>

■ Symbole "+" und "−" direkt vor den Textabsätzen


Bearbeiten von Text in der Gliederungsansicht

In der Gliederungsansicht können Sie theoretisch auch Text eingeben, bearbeiten und formatieren. In der Praxis sollten Sie hierfür jedoch zurück in die Normalansicht wechseln, da diese hierfür besser geeignet ist.

Löschen, Kopieren und Verschieben von Text


Um eine Überschrift samt Text beispielsweise zu verschieben, gehen Sie folgendermaßen vor:

2. Rufen Sie den Menübefehl Bearbeiten > Ausschneiden auf.
3. Bewegen Sie die Schreibmarke an den Beginn der Zeile, vor der Sie den ausgeschnittenen Text wieder einfügen möchten.
4. Rufen Sie den Menübefehl Bearbeiten > Einfügen auf.

Die Überschrift und der dazugehörende Text wurden nun gemeinsam verschoben.
Arbeiten mit umfangreichen Dokumenten

**Tipp:** Für das Verschieben von markiertem Text können Sie auch folgende Tastenkürzel verwenden: 
*Alt+Umschalt+↑* schiebt den Text einen Absatz nach oben und *Alt+Umschalt+↓* einen Absatz nach unten.

**Überschriften formatieren**


**Tipp: Alle Überschriften einer gesamten Ebene formatieren (Stichwort "Absatzvorlagen")**

TextMaker formatiert Überschriften automatisch mit ganz bestimmten Absatzvorlagen: alle Überschriften der ersten Ebene sind stets mit der Absatzvorlage **Überschrift 1** formatiert, die der zweiten Ebene mit der Vorlage **Überschrift 2** usw.

Möchten Sie also das Aussehen aller Überschriften einer bestimmten Ebene ändern, muss lediglich die entsprechende Absatzvorlage bearbeitet werden. Dazu gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Format > Absatzvorlage** auf.
2. Wählen Sie die entsprechende Vorlage aus der Liste. Um beispielsweise alle Überschriften der ersten Ebene zu ändern, wäre die Vorlage **Überschrift 1** auszuwählen.
3. Klicken Sie auf **Bearbeiten**.
4. Es erscheint ein Dialogfenster, in dem sich die gewünschte Absatzformatierung einstellen lässt.
   - **Tipp:** Sie können bei Bedarf auch die Zeichenformatierung ändern, indem Sie die Schaltfläche **Zeichen** auf der Karteikarte **Absatz** anklicken.
5. Nehmen Sie die gewünschten Änderungen vor.
6. Klicken Sie auf **OK**.
7. Verlassen Sie das Dialogfenster mit **Schließen**.

Genauere Informationen zu Formatvorlagen können Sie bei Bedarf im Kapitel **Formatvorlagen** nachlesen.

**Hinweis:** Wenn Sie die Gliederung eines Dokument in der Gliederungsansicht bearbeiten, weist TextMaker den Überschriften automatisch die Vorlage **Überschrift 1**...9 zu. Sie sollten nicht versuchen, die Namen dieser Vorlagen zu ändern oder den Überschriften andere Vorlagen zuzuweisen. Dies funktioniert zwar, TextMaker wird jedoch automatisch wieder "seine" Vorlagen anbringen, wenn Sie in der Gliederungsansicht die Gliederungsebene von Absätzen verändern.
Arbeiten mit umfangreichen Dokumenten

Profi-Tipp: Überschriften über Absatzvorlagen verwalten

Wenn Sie in der Gliederungsansicht die Gliederungsebene eines Absatzes verändern, passiert eigentlich nicht viel: TextMaker weist dem Absatz lediglich eine der Absatzvorlagen Überschrift 1 bis Überschrift 9 zu.

Was denkt sich da der schlaue Fuchs? Richtig: Sie können Überschriften auch dadurch festlegen, dass Sie Textabsätzen einfach eine der Formatvorlagen Überschrift 1 bis Überschrift 9 zuweisen.

Möchten Sie also eine neue Überschrift anlegen, können Sie dies auch ohne die Gliederungsansicht tun. Tippen Sie einfach die Überschrift ein und wählen Sie die gewünschte Überschriftenvorlage aus der Formatleiste – fertig.

Genau so einfach können Sie die Gliederungsebene einer Überschrift ändern. Wenn Sie die Schreibmarke beispielsweise auf eine Überschrift der 2. Ebene setzen und ihr die Formatvorlage Überschrift 3 zuweisen, wird diese auf die 3. Ebene herabgestuft.

Und das geht sogar noch schneller: Den Vorlagen Überschrift 1 bis 3 sind standardmäßig die Tastenkürzel Alt+1 bis Alt+3 zugewiesen, der Vorlage Normal das Tastenkürzel Alt+0. Mit diesen Tastenkombinationen können Sie also blitzschnell Überschriften anlegen, ihre Ebene ändern und Überschriften wieder zu normalem Text machen.

Erläuterung: Die Gliederungsebene ist eine Absatzformatierung!

"Was haben eigentlich Formatvorlagen mit der Gliederung zu tun?", werden Sie sich jetzt vielleicht fragen.


In den Formatvorlagen Überschrift 1 bis Überschrift 9 wurde diese Option entsprechend auf 1 ... 9 gesetzt. Das ist der Grund, warum Sie über Formatvorlagen die Ebene von Überschriften verändern können.


Gliederungen in der Praxis

Betrachten wir zusammenfassend, wie sich Gliederungen am besten in der Praxis einsetzen lassen:

Ein bestehendes Dokument gliedern

Nehmen wir an, Sie haben ein Dokument inklusive Überschriften bereits eingetippt und wollen ihm jetzt mittels Gliederung eine Struktur geben.

Dazu brauchen Sie nur mit dem Menübefehl Ansicht > Gliederung in die Gliederungsansicht zu wechseln und den Überschriften die gewünschten Gliederungsebenen zu geben.
Bewegen Sie dazu die Schreibmarke auf die jeweilige Überschrift und verwenden Sie die Schaltflächen (höherstufen) und (tieferstufen), um die Gliederungsebene herauf- beziehungsweise herabzusetzen.

Weisen Sie den Hauptüberschriften Gliederungsebene 1 zu, den Überschriften der nächsttieferen Ebene die Gliederungsebene 2 usw.

Um die Gliederungsansicht wieder zu verlassen, rufen Sie den Menübefehl Ansicht > Normal auf.

**Ein neues Dokument gliedern**

Bei einem neuen Dokument gibt es – abgesehen von der Tatsache, dass die Überschriften noch nicht existieren, keine Unterschiede zur obigen Vorgehensweise.

Sie können das Dokument erst an einem Stück durchschreiben und sich dann um die Gliederung kümmern. Wahlweise können Sie jeder neu eingetippten Überschrift nach dem oben beschriebenen Verfahren sofort eine Gliederungsebene geben.

---

**Überschriften nummerieren**

Häufig versieht man die Überschriften eines umfangreichen Dokuments mit einer Nummerierung. Die Hauptüberschrift ist beispielsweise mit 1. nummeriert, die dazugehörigen Unterthemen mit 1.1., 1.2., 1.3. usw.

Mit TextMaker können Sie die Überschriften eines Dokuments automatisch durchnummerieren lassen. Gehe Sie dazu wie folgt vor:

1. Erstellen Sie das Dokument und versehen Sie es mit einer Gliederung.

2. Erstellen Sie eine Nummerierungsliste mit der gewünschten Art der Nummerierung. Wählen Sie bei Typ die Option Hierarchische Liste und schalten Sie die Option Gliederungsebene des Absatzes verwenden ein.

3. Weisen Sie der Absatzvorlage "Überschrift 1" diese Nummerierungsliste zu.

Schon erscheint ohne weiteres Zutun vor jeder Überschrift eine Nummer mit der geeigneten Ebene. Haupt-überschriften werden also mit 1., 2., 3. etc. nummeriert, Überschriften zweiter Ebene mit 1.1, 1.2, 1.3 etc. und so weiter.

Im Detail sind dazu folgende Schritte durchzuführen:

**Schritt 1: Erstellen und Gliedern des Dokuments**

Zuerst müssen Sie natürlich das Dokument erstellen und mit einer Gliederung versehen. Ob Sie die Gliederung gleich zu Beginn oder erst nach der Eingabe des kompletten Textes anbringen, spielt keine Rolle.

Informationen zum Gliedern von Dokumenten finden Sie am Abschnitt Gliederungen.

**Schritt 2: Erstellen einer geeigneten Nummerierungsliste**

Im nächsten Arbeitsschritt erstellen Sie eine geeignete Nummerierungsliste. Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl Format > Bullets und Nummerierungen auf.

2. Wechseln Sie auf die Karteikarte Nummerierungslisten.
3. Klicken Sie auf die Schaltfläche **Neu**.

4. Geben Sie einen beliebigen Namen für die neue Nummerierungsliste ein (zum Beispiel "Überschriften") und bestätigen Sie mit **OK**.

5. **Wichtig:** Wählen Sie bei **Nummerierungsliste** die Option **Hierarchische Liste**.

6. **Wichtig:** Schalten Sie die Option **Gliederungsebene des Absatzes verwenden** ein.

7. Die anderen Einstellungen können Sie nach Belieben verändern oder es bei den Standardeinstellungen belassen. Informationen zu den einzelnen Optionen finden Sie im Abschnitt **Nummerierungslisten erstellen**.

8. Bestätigen Sie mit **OK**.

9. Die Nummerierungsliste wurde nun angelegt, und Sie können das Dialogfenster verlassen, indem Sie auf **Schließen** klicken.

**Schritt 3: Der Absatzvorlage "Überschrift 1" diese Nummerierungsliste zuweisen**

Der letzte Schritt ist der eigentliche "Clou": Wenn Sie jetzt nämlich der Absatzvorlage "Überschrift 1" die oben erzeugte Nummerierungsliste zuweisen, geht fortan alles von selbst – jede vorhandene oder neu eingegebene Überschrift wird automatisch mit einer Nummerierung versehen.

Selbst untergeordnete Überschriften (zweiter Ordnung, dritter Ordnung etc.) werden ebenfalls nummeriert, da deren Formatvorlagen ja alle auf der Formatvorlage "Überschrift 1" basieren.

Gehen Sie also wie folgt vor:

1. Rufen Sie den Menübefehl **Format > Absatzvorlage** auf.

2. Wählen Sie die Absatzvorlage **Überschrift 1**.

3. Klicken Sie auf die Schaltfläche **Bearbeiten**.

4. Es erscheint der Dialog zum Bearbeiten der Vorlage. Wechseln Sie darin auf die Karteikarte **Absatz**.

5. Klicken Sie auf die Schaltfläche **Bullets**.

6. Es erscheint der Dialog zum Anlegen von Aufzählungen. Wechseln Sie darin auf die Karteikarte **Nummerierungslisten**.

7. Wählen Sie die Nummerierungsliste, die Sie in Schritt 2 erstellt haben.

8. Klicken Sie auf **OK, OK** und **Schließen**, um alle Dialoge zu verlassen.

Alle vorhandenen und später hinzugefügten Überschriften werden nun automatisch mit einer Nummerierung versehen.

**Tipp:** Falls Sie Ihnen das Format der Nummerierung nicht zusagen sollte, können Sie die in Schritt 2 erstellte Nummerierungsliste jederzeit nach Ihren Wünschen anpassen. Rufen Sie dazu wieder den Menübefehl **Format > Bullets und Nummerierungen** auf, wechseln Sie auf die Karteikarte **Nummerierungslisten**, wählen Sie die Liste aus, klicken Sie auf **Bearbeiten** und nehmen Sie die gewünschten Änderungen vor. Diese wirken sich dann – auch nachträglich – auf alle Überschriften im Dokument aus.

**Hinweis für Anwender älterer Versionen von TextMaker**

Falls Sie alte Dokumente besitzen, die diese Methode noch verwenden, können Sie diese natürlich uneingeschränkt weiterverwenden. Das Feld "Auto-Nummer" wird auch weiterhin von TextMaker unterstützt.

Beim Anlegen von neuen Dokumenten ist es aber empfehlenswert, die neue Methode anzuwenden. Nummerierungslisten haben nämlich mehrere Vorteile:

- Sie müssen nicht mehr von Hand "Auto-Nummer"-Felder vor jeder Überschrift einfügen.
- Nummerierungslisten sind flexibler: es stehen mehr Arten von Nummerierungen und Formatierungen zur Verfügung.
- Nummerierungslisten lassen sich bequem nachträglich abändern. Möchten Sie beispielsweise die Formatierung aller Nummern ändern, müssen Sie einfach nur die Formatierung in der Nummerierungsliste bearbeiten – sofort ändern sich die Nummern bei allen Überschriften entsprechend.

---

**Gegliederte Dokumente und Kapitel**

Bei Dokumenten mit einer Gliederung verwendet man häufig Kopf- oder Fußzeilen, in denen der Leser Informationen wie die Hauptüberschrift des jeweiligen Kapitels findet.

Dies lässt sich natürlich auch mit TextMaker bewerkstelligen. Sie müssen das Dokument lediglich in Kapitel aufteilen, denn jedes Kapitel darf eigene Kopf- und Fußzeilen haben.

Fügen Sie dazu vor jedem neuen Themenbereich, in der Regel also vor jeder Hauptüberschrift, mit dem Menübefehl **Einfügen > Umbruch > Kapitelumbruch** einen sogenannten **Kapitelumbruch** ein.

Nun können Sie in jedem Kapitel Kopf- und Fußzeilen mit einem anderen Inhalt anlegen. Übrigens lässt sich sogar die komplette Seitenformatierung (Papierformat, Seitenränder etc.) für jedes Kapitel einzeln einstellen.

Ausführliche Informationen zum Arbeiten mit Kapiteln finden Sie im Abschnitt **Aufteilen eines Dokuments in Kapitel**.

---

**Verzeichnisse (Inhalt, Stichwörter etc.)**

Für das Verfassen umfangreicher Dokumente hält TextMaker Funktionen bereit, die einige der zeitraubendsten Arbeiten deutlich erleichtern:

Mit TextMaker ist das Erstellen von **Inhalts-** und **Stichwortverzeichnissen** ein Leichtes, Grafiken lassen sich mit **Beschriftungen** und einem **Abbildungsverzeichnis** versehen und selbst **Bibliografien** (Literaturverzeichnisse) können angelegt werden:

- **Stichwortverzeichnisse**

  Für ein **Stichwortverzeichnis** müssen Sie TextMaker nur mitteilen, welche Wörter an welchen Textstellen als Stichwörter aufgenommen werden sollen. Das geschieht durch Markieren des Wortes im Text und Aufrufen des Menübefehls **Weiteres > Stichwort > Stichwort aufnehmen**.

  Wurden alle Stichwörter festgelegt, können Sie das Verzeichnis mit dem Menübefehl **Weiteres > Stichwort > Stichwortverzeichnis erstellen** erzeugen lassen.
Arbeiten mit umfangreichen Dokumenten

- **Inhaltsverzeichnisse**

  Für ein Inhaltsverzeichnis müssen Sie Ihr Dokument lediglich mit einer Gliederung versehen, wie dies im Abschnitt Gliederungen beschrieben wurde. TextMaker kennt die Hierarchie der Überschriften dadurch ja bereits.

  Rufen Sie den Menübefehl Weiteres > Inhaltsverzeichnis erstellen auf, erzeugt TextMaker sofort das Verzeichnis.

- **Beschriftungen und Abbildungsverzeichnisse**

  Mit dem Menübefehl Einfügen > Beschriftung kann unterhalb von Bildern eine automatisch durchnumerierte Beschriftung eingefügt werden – z.B. "Abbildung 1", "Abbildung 2" etc.

  Danach können Sie bei Bedarf auch den Menübefehl Weiteres > Abbildungsverzeichnis erstellen verwenden, der auf Knopfdruck ein Abbildungsverzeichnis aller Bilder mit Seitenzahlen einfügt.

- **Bibliografien**

  Für eine Bibliografie legen Sie zunächst eine Bibliografie-Datenbank an, in die Sie alle Quellen eingetragen, auf die Sie sich beziehen möchten. Nun können Sie mit dem Befehl Bibliografiefeld einfügen Verweise auf diese Quellen in das Dokument einfügen.

  Am Ende des Dokuments lassen Sie TextMaker mit dem Menübefehl Weiteres > Bibliografie > Bibliografie erzeugen ein Literaturverzeichnis generieren, das automatisch alle verwendeten Quellen auflistet.

Zum Abschluss des Abschnitts über Verzeichnisse finden Sie außerdem noch folgende Informationen:

- **Verzeichnisse aktualisieren**
- **Verzeichnisse bearbeiten und formatieren**

  Ausführliche Informationen zu obigen Themen folgen auf den nächsten Seiten.

---

**Stichwortverzeichnisse**

Ein Stichwortverzeichnis (auch Index genannt) ist eine alphabetisch sortierte Auflistung der wichtigsten Stichwörter eines Dokuments mit Angabe der Seitenzahlen, auf denen diese Wörter jeweils vorkommen.

Auf den nächsten Seiten erfahren Sie, wie Sie ein solches Verzeichnis anlegen.

---

**Stichwortverzeichnis vorbereiten**

Bevor TextMaker ein Stichwortverzeichnis erstellen kann, müssen Sie ihm mitteilen, welche Begriffe darin erscheinen sollen. Dazu nehmen Sie diese in die Stichwortliste auf.

**Begriff in die Stichwortliste aufnehmen**

Um einen Begriff in die Stichwortliste aufzunehmen, verfahren Sie wie folgt:

2. Rufen Sie den Menübefehl **Weiteres > Stichwort > Stichwort aufnehmen** auf.

3. Normalerweise merkt sich TextMaker nur die aktuell markierte Position des Begriffs. Sollen hingegen alle Vorkommen des Begriffs in die Stichwortliste aufgenommen werden, schalten Sie die Option **Alle Vorkommen aufnehmen** ein (siehe auch unten).

4. Klicken Sie auf **OK**.

Nun haben Sie den markierten Begriff in die Liste der Stichwörter aufgenommen. TextMaker merkt sich darin sowohl den Begriff selbst als auch die Textstelle, an der Sie ihn aufgenommen haben. Lassen Sie später das Stichwortverzeichnis erzeugen, erscheint darin der Begriff und rechts daneben die Nummer der Seite, auf denen er als Stichwort markiert wurde.

Damit das Stichwortverzeichnis seinen Zweck erfüllt, ist es insofern wichtig, die Stelle sorgfältig auszuwählen, an der Sie einen Begriff in die Stichwortliste aufnehmen. Das Wort "Drucken" kommt im Handbuch für eine Textverarbeitung beispielsweise häufig vor. Sinnvollerweise nimmt man es aber nur in dem Abschnitt in die Stichwortliste auf, der sich speziell dem Thema "Drucken" widmet.

**Stichwörter mehrmals aufnehmen**

Übrigens lässt sich der gleiche Begriff auch mehrmals in die Stichwortliste aufnehmen. In diesem Fall erscheint das Stichwort nur einmal im Verzeichnis, dahinter werden jedoch mehrere Seitenzahlen ausgegeben.

**Hinweis:** Die Groß-/Kleinschreibung von Stichwörtern wird ignoriert. Bei der Aufnahme der Stichwörter "Drucken" und "drucken" erscheinen diese im Stichwortverzeichnis zusammengefasst unter "Drucken".

**Alle Vorkommen eines Begriffs aufnehmen**

In bestimmten Fällen ist es sinnvoll, alle Textstellen, an denen ein Begriff erscheint, im Stichwortverzeichnis erscheinen zu lassen. Natürlich könnten Sie dazu jedes einzelne Vorkommen des Stichworts markieren und es wie oben beschrieben in die Liste aufnehmen. TextMaker kann Ihnen diese Mühe jedoch abnehmen.

Schalten Sie dazu beim Aufnehmen eines Stichworts mit dem Menübefehl **Weiteres > Stichwort > Stichwort aufnehmen** die Option **Alle Vorkommen aufnehmen** ein. TextMaker durchsucht dann beim Erstellen des Verzeichnisses den gesamten Text nach dem angegebenen Begriff und listet die Seitenzahlen sämtlicher Vorkommen auf.

**Stichwortliste bearbeiten**

Der Inhalt der Stichwortliste kann jederzeit nachträglich bearbeitet werden. Rufen Sie dazu den Menübefehl **Weiteres > Stichwort > Stichwortliste bearbeiten** auf.

Es erscheint nun eine Liste aller Stichwörter. Hinter jedem Stichwort wird in eckigen Klammern angezeigt, wie oft das Stichwort im Text aufgenommen wurde.

Um die Stichwortliste zu bearbeiten, gehen Sie wie folgt vor:

- **Stichworteintrag wiederfinden**

  Mit der Schaltfläche **Gehe zu** können Sie feststellen, an welcher Textstelle ein bestimmter Eintrag in die Stichwortliste aufgenommen wurde. Wählen Sie das Stichwort dazu in der Liste aus und klicken Sie auf **Gehe zu**. TextMaker setzt die Schreibmarke nun an die entsprechende Position im Text.
Arbeiten mit umfangreichen Dokumenten

Wurde das Stichwort an mehreren Textstellen aufgenommen, wird zunächst die erste Fundstelle angezeigt, bei erneutem Klicken auf Gehe zu die zweite Fundstelle etc.

Hinweis: Bei Stichwörtern, die mit eingeschalteter Option Alle Vorkommen aufnehmen hinzugefügt wurden, ist die Schaltfläche Gehe zu nicht verfügbar.

- Stichworteintrag löschen

Mit der Schaltfläche Löschen lassen sich versehentlich aufgenommene Stichwörter aus der Liste entfernen. Wählen Sie das Stichwort dazu in der Liste aus und klicken Sie auf Löschen.

Wurde das Stichwort an mehreren Textstellen aufgenommen, können Sie zuvor mit Hilfe der Schaltfläche Gehe zu bestimmen, welches Vorkommen gelöscht werden soll (siehe oben).

Das Feld {Index: '...'}

Abschließend noch eine Information für fortgeschrittene Anwender:

Beim Aufnehmen in die Stichwortliste fügt TextMaker hinter dem markierten Begriff ein unsichtbares "Index"-Feld in den Text ein. Lautet der Begriff beispielsweise "Fisch", steht in diesem Index-Feld: {Index: 'Fisch'}.

Sie können diese Index-Felder sichtbar machen, indem Sie auf der Karteikarte Ansicht im Dialog des Menübefehls Datei > Eigenschaften die Option Nur Feldnamen anzeigen einschalten. Auf diese Weise haben Sie einen exakten Überblick, an welchen Textstellen Sie welche Stichwörter aufgenommen haben.

Bei Stichwörtern, die mit Hilfe der Option Alle Vorkommen aufnehmen zur Liste hinzugefügt wurden, erscheint hingegen kein Index-Feld. Diese werden programmintern verwaltet.

Stichwortverzeichnis erstellen

Im vorherigen Abschnitt wurde beschrieben, wie Sie mithilfe des Menübefehls Weiteres > Stichwort > Stichwort aufnehmen festlegen, welche Wörter im Stichwortverzeichnis erscheinen sollen. Wenn diese Aufgabe erledigt ist, kann das Stichwortverzeichnis erzeugt werden.

Gehen Sie dazu folgendermaßen vor:

1. Setzen Sie die Schreibmarke an den Beginn der Zeile, in die das Stichwortverzeichnis eingefügt werden soll.
2. Rufen Sie den Menübefehl Weiteres > Stichwort > Stichwortverzeichnis erstellen auf.
3. Wählen Sie bei Platzierung, ob ein neues Stichwortverzeichnis an der aktuellen Position erzeugt werden oder ein bereits vorhandenes aktualisiert werden soll.

Wenn Sie mit OK bestätigen, wird das Stichwortverzeichnis in den Text eingefügt.
### Ausschnitt aus einem Stichwortverzeichnis (Stil "Mit Anfangsbuchstaben")

Die Stichwörter werden dabei alphabetisch sortiert ausgegeben. Rechts von jedem Stichwort trägt TextMaker jeweils die Nummern der Seiten ein, auf denen das Stichwort vorkommt.

### Optionen des Dialogs

Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

- **Stil**
  Hier können Sie die gewünschte Gestaltung des Verzeichnisses wählen:
  - **Durchgehend:** Die Einträge werden durchgehend (ohne Unterbrechungen) ausgegeben.
  - **Mit Leerzeilen:** Vor jedem neuen Anfangsbuchstaben wird eine Leerzeile eingefügt.
  - **Mit Anfangsbuchstaben:** Vor jedem neuen Anfangsbuchstaben wird eine Zeile mit dem Anfangsbuchstaben eingefügt.

- **Kapitellnummer verwenden**
  Wenn Sie diese Option aktivieren, wird vor jeder Seitennummer zusätzlich die Kapitellnummer ausgegeben (durch einen Bindestrich abgetrennt).
  Dies ist natürlich nur sinnvoll, wenn Sie das Dokument mit dem Menübefehl **Einfügen > Umbruch > Kapitelumbruch** in mehrere Kapitel aufgeteilt haben (siehe Abschnitt **Aufteilen eines Dokuments in Kapitel**).

- **Seitennummern rechtsbündig**
  Wenn Sie diese Option aktivieren, werden die Seitennummern rechtsbündig ausgegeben.

- **Füllzeichen**
  Wenn Sie die Option **Seitennummern rechtsbündig** aktiviert haben, können Sie hier auswählen, womit der Bereich zwischen Stichwort und Seitennummer ausgefüllt werden soll (z.B. mit Punkten).

### Weitere Informationen:

- Informationen zum **Aktualisieren** von Verzeichnissen finden Sie im Abschnitt **Verzeichnisse aktualisieren**.
- Informationen zum **Bearbeiten und Formatieren** von Verzeichnissen finden Sie im Abschnitt **Verzeichnisse bearbeiten und formatieren**.
Inhaltsverzeichnisse

Ein **Inhaltsverzeichnis** ist eine Auflistung aller im Dokument enthaltenen Überschriften, jeweils mit Seitenzahl.

Im Gegensatz zum Stichwortverzeichnis müssen Sie beim Inhaltsverzeichnis nicht zuvor die Einträge kennzeichnen, die darin erscheinen sollen. Ihr Dokument muss lediglich mit einer Gliederung versehen worden sein. Wie Sie dies bewerkstelligen, können Sie im Abschnitt **Gliederungen** nachlesen.

Anhand der Gliederung weiß TextMaker ja bereits, welche Überschriften der Text enthält und welche Hierarchie diese haben.

Dementsprechend einfach ist das Erstellen eines Inhaltsverzeichnisses:

1. Setzen Sie die Schreibmarke an den Beginn der Zeile, in die das Inhaltsverzeichnis eingefügt werden soll.

2. Rufen Sie den Menübefehl **Weiteres > Inhaltsverzeichnis erstellen** auf.

3. Wählen Sie bei **Platzierung**, ob ein neues Inhaltsverzeichnis an der aktuellen Position erzeugt werden oder ein bereits vorhandenes aktualisiert werden soll.

Wenn Sie mit **OK** bestätigen, wird das Inhaltsverzeichnis in den Text eingefügt.

| Das Liebesleben des Baums...........1 |
| Im Frühling.........................1 |
| März.................................1 |
| April.................................3 |
| Mai......................................4 |
| Im Sommer............................7 |
| Im Herbst.............................10 |

Ausschnitt aus einem Inhaltsverzeichnis

Links gibt TextMaker jeweils die Überschrift aus. Rechts wird, durch einen Tabulator getrennt, die zugehörige Seitenzahl angezeigt.

**Optionen des Dialogs**

Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

- Über die Option **Gliederungsebenen** können Sie einstellen, welche Gliederungsebenen in dem Inhaltsverzeichnis angezeigt werden sollen. Standardmäßig werden alle Ebenen (1 bis 9) angezeigt.

- Wenn Sie die Option **Nur bis zum 1. Tabulator** einschalten, sieht TextMaker bei jeder Überschrift nach, ob sich darin Tabulatoren befinden. Ist dies der Fall, wird der Überschriftentext nur bis zum ersten Tabulator in das Inhaltsverzeichnis übernommen.

- Die Option **Nummerierung verwenden** ist standardmäßig eingeschaltet. Falls Sie die Überschriften im Dokument mit einer Nummerierung versehen haben, werden diese also auch im Inhaltsverzeichnis entsprechend nummeriert.

  Wünschen Sie dies nicht, schalten Sie diese Option ab.
Arbeiten mit umfangreichen Dokumenten

Informationen zum Nummerieren der Überschriften eines Dokuments können Sie im Abschnitt Über- schriften nummerieren nachlesen.

- Bei Platzierung können Sie bestimmen, was passieren soll, wenn das Dokument bereits ein Inhaltsverzeichnis enthält:

  Wählen Sie Bestehendes Verzeichnis ersetzen, wird das vorhandene Verzeichnis ersetzt.

  Wählen Sie hingegen Neues Verzeichnis erzeugen, fügt TextMaker zusätzlich zu dem bestehenden Verzeichnis ein weiteres Inhaltsverzeichnis ein.

Weitere Informationen:

- Informationen zum Aktualisieren von Verzeichnissen finden Sie im Abschnitt Verzeichnisse aktualisie- ren.
- Informationen zum Bearbeiten und Formatieren von Verzeichnissen finden Sie im Abschnitt Ver- zeichnisse bearbeiten und formatieren.

Beschriftungen und Abbildungsverzeichnisse

Unter Bildern lassen sich jederzeit automatisch durchnummerierte Beschriftungen einfügen – also beispielsweise "Abbildung 1", "Abbildung 2" etc. Außerdem können Sie mit minimalem Aufwand ein Abbildungsverzeichnis aller so beschrifteten Bilder generieren.

Beschriftungen können nicht nur für Bilder, sondern auch für beliebige andere Bestandteile eines Dokuments eingefügt werden. So können Sie beispielsweise auf die gleiche Weise alle Tabellen beschriften.

Sie können sogar die Bilder und die Tabellen in einem Dokument mit unabhängig voneinander nummerierten Beschriftungen versehen und jeweils ein Verzeichnis dafür einfügen.

Das Arbeiten mit Beschriftungen und Abbildungsverzeichnissen ist eigentlich ganz einfach:

- **Beschriftungen für Bilder und andere Objekte einfügen**

  Mit dem Menübefehl Einfügen > Beschriftung können Sie eine automatisch durchnummerierte Be- schriftung in den Text einfügen.

  Möchten Sie beispielsweise die Bilder in einem Dokument beschriften, selektieren Sie jeweils das gewünschte Bild und rufen diesen Befehl dann auf. TextMaker fügt nun unter dem Bild eine Beschriftung ein. Diese besteht aus einer Bezeichnung und einer laufenden Nummer – zum Beispiel "Abbildung 1".

  Die Nummerierung erfolgt dabei automatisch und passt sich selbstständig an, wenn Sie Beschriftungen hinzufügen oder löschen.

  Auf Wunsch können Sie hinter jeder Beschriftung noch einen erläuternden Text eintippen, also beispielsweise die Beschriftung "Abbildung 1" zu "Abbildung 1: Die Lärche" erweitern.

- **Abbildungsverzeichnis erstellen**

  Wenn Sie Beschriftungen eingefügt haben, können Sie anschließend mit dem Menübefehl Weitere > Abbildungsverzeichnis erstellen ein Abbildungsverzeichnis in den Text einfügen. In diesem sind alle Beschriftungen gelistet, die Sie in das Dokument eingefügt haben.

  Haben Sie beispielsweise alle Grafiken im Dokument mit einer Beschriftung versehen, können Sie anschließend ein Verzeichnis aller Grafiken erzeugen. Dieses ist auch mit Seitenzahlen versehen, damit der Leser sehen kann, welche Grafik sich auf welcher Seite befindet.
Arbeiten mit umfangreichen Dokumenten

Zusätzlich eingegebener Text erscheint übrigens ebenfalls im Verzeichnis. Haben Sie die Beschriftung "Abbildung 1" also beispielsweise zu "Abbildung 1: Die Lärche" erweitert, landet genau dieser Text im Verzeichnis.

Detailliertere Informationen dazu finden Sie auf den nächsten Seiten.

---

**Beschriftungen für Bilder und andere Objekte einfügen**

Mit dem Menübefehl **Einfügen > Beschriftung** können Sie eine automatisch durchnumerierte *Beschriftung* in den Text einfügen.

Möchten Sie beispielsweise die Bilder in einem Dokument beschriften, selektieren Sie jeweils das gewünschte Bild und rufen diesen Befehl dann auf. TextMaker fügt nun unter dem Bild eine Beschriftung ein. Diese besteht aus einer *Bezeichnung* und einer *laufenden Nummer* – zum Beispiel "Abbildung 1".

Die Nummerierung erfolgt dabei automatisch und passt sich selbstständig an, wenn Sie Beschriftungen hinzufügen oder löschen.

Um eine Grafik mit einer Beschriftung zu versehen, gehen Sie wie folgt vor:

1. Selektieren Sie die Grafik, die Sie mit einer Beschriftung versehen möchten, per Mausklick.
   
   Alternativ können Sie auch die Schreibmarke an die Position setzen, an der die Beschriftung eingefügt werden soll – also zum Beispiel eine leere Zeile unterhalb der Grafik einfügen und die Schreibmarke dort hineinsetzen.

2. Rufen Sie den Menübefehl **Einfügen > Beschriftung** auf.

3. Wählen Sie aus, welche *Bezeichnung* in der Beschriftung erscheinen soll – zum Beispiel "Abbildung".


5. Klicken Sie auf **Einfügen**.

TextMaker fügt nun die gewählte Bezeichnung und dahinter eine laufende Nummer ein. Die gesamte Beschriftung lautet also beispielsweise "Abbildung 1".

Auf Wunsch können Sie direkt hinter der Beschriftung noch einen erläuternden Text eintippen, also beispielsweise die Beschriftung "Abbildung 1" zu "Abbildung 1: Die Lärche" erweitern. Dieser Text erscheint dann auch im Abbildungsverzeichnis (siehe nächster Abschnitt).

Verfahren Sie auf die gleiche Weise mit allen anderen Grafiken, die Sie beschriften möchten.

Beschriftungen lassen übrigens sich nicht nur für Bilder einfügen, sondern auch für beliebige andere Bestandteile des Dokuments. So können Sie beispielsweise auf die gleiche Weise auch alle Tabellen im Dokument beschriften. Wählen Sie dazu einfach den gewünschten Eintrag in der Liste *Bezeichnungen*.

---

**Optionen des Dialogs**

Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

- **Bezeichnungen**

   Hier können Sie auswählen, welche Bezeichnung in der Beschriftung verwendet werden soll.

   Die gewählte Bezeichnung erscheint dann als Text in der Beschriftung. Wählen Sie also die Bezeichnung "Abbildung", erscheint im Dokument die Beschriftung "Abbildung 1".
**Hinweis:** Jede Bezeichnung verwendet ihre eigene Nummerierung. So können Sie beispielsweise die Abbildungen und die Tabellen im Dokument mit voneinander unabhängig durchnummerierten Bezeichnungen versehen. Wählen Sie dazu einfach, wenn Sie eine Beschriftung einfügen, bei Abbildungen die Bezeichnung "Abbildung" und bei Tabellen die Bezeichnung "Tabelle".

Weiterhin kann für jede Bezeichnung ein eigenes Verzeichnis generiert werden (siehe nächster Abschnitt).

### Position

Die Option **Position** ist nur verfügbar, wenn Sie das zu beschriftende Objekt (z.B. eine Grafik) vor dem Aufruf dieses Befehls **selektiert** haben. Sie können mit dieser Option festlegen, ob die Beschriftung dann oberhalb oder unterhalb des Objekts eingefügt werden soll.

TextMaker fügt dabei automatisch einen neuen Absatz ein, um Platz für die Beschriftung zu schaffen. Handelt es sich bei dem Objekt um einen Rahmen (z.B. einen Grafikrahmen), fügt TextMaker automatisch einen Textrahmen darüber oder darunter ein und setzt die Beschriftung dort hinein.

### Format

Hier können Sie festlegen, in welchem Format die laufende Nummer eingefügt werden soll – z.B. als arabische Zahl (1, 2, 3, ...), als römische Zahl (I, II, III, ...) oder als Buchstabe (A, B, C, ...).

### Bezeichnung nicht in der Beschriftung verwenden

Wenn Sie diese Option einschalten, lässt TextMaker beim Einfügen der Beschriftung die Bezeichnung weg und fügt nur die laufende Nummer ein.

Statt "Abbildung 1" wird also beispielsweise nur "1" eingefügt.

### Schaltfläche "Neu"

Mit der Schaltfläche **Neu** können Sie eine neue Bezeichnung anlegen.

Dazu erscheint ein Dialog, in dem Sie den Namen für die Bezeichnung eintippen können. Genau der Text, den Sie hier eingeben, erscheint dann in der Beschriftung. Legen Sie also eine Bezeichnung namens "Illustration" an, erscheint beim Einfügen der Beschriftung beispielsweise "Illustration 1" im Dokument.

Es sei noch einmal darauf hingewiesen, dass jede Bezeichnung ihre eigene, von allen anderen Bezeichnungen unabhängige Nummerierung hat. Außerdem kann für jede Bezeichnung ein eigenes Verzeichnis generiert werden (siehe nächster Abschnitt).

### Schaltfläche "Löschen"

Mit der Schaltfläche **Löschen** können Sie eine Bezeichnung löschen. Selektieren Sie diese zuvor in der Liste **Bezeichnungen**.


**Tipp:** Falls Sie eine Bezeichnung einmal versehentlich gelöscht haben, können Sie dies beheben, indem Sie einfach mit der Schaltfläche **Neu** eine neue Bezeichnung mit genau dem gleichen Namen anlegen.
Anmerkungen

- Die **Bezeichnung** wird in Beschriftungen als fester Text eingefügt.
- Die **Nummer** hingegen ist ein Feld vom Typ "Sequenznummer". Dieses Feld liefert eine laufende Nummer zurück, die bei jedem nachfolgenden Feld (das die gleiche Bezeichnung verwendet) um eins erhöht wird. Für jede Bezeichnung wird eine eigene Serie von Sequenznummer-Feldern mit einer eigenen Nummerierung angelegt.

Informationen zum Arbeiten mit Feldern können Sie bei Bedarf im Kapitel *Felder* nachlesen.

Abbildungsverzeichnis erstellen


Wenn Sie diese Aufgabe erledigt haben, können Sie bei Bedarf auch ein Abbildungsverzeichnis erzeugen und in den Text einfügen. In diesem sind alle Beschriftungen gelistet, die Sie in das Dokument eingefügt haben.

Haben Sie beispielsweise alle Grafiken im Dokument mit einer Beschriftung versehen, können Sie anschließend ein Verzeichnis aller Grafiken erzeugen. Dieses ist auch mit Seitenzahlen versehen, damit der Leser sehen kann, welche Grafik sich auf welcher Seite befindet.

Um ein Abbildungsverzeichnis einzufügen, gehen Sie dazu folgendermaßen vor:

1. Fügen Sie, wie im letzten Abschnitt beschrieben, mit dem Menübefehl **Einfügen > Beschriftung** beliebig viele Beschriftungen in den Text ein.
2. Setzen Sie die Schreibmarke an den Beginn der Zeile, in die das Verzeichnis eingefügt werden soll.
3. Rufen Sie den Menübefehl **Weiteres > Abbildungsverzeichnis erstellen** auf.
4. Wählen Sie in der Liste **Bezeichnung** aus, für welche Bezeichnung ein Verzeichnis eingefügt werden soll (z.B. "Abbildung").
5. Wählen Sie bei **Platzierung**, ob ein neues Verzeichnis an der aktuellen Position erzeugt werden oder ein bereits vorhandenes aktualisiert werden soll.

Wenn Sie mit **OK** bestätigen, wird das Verzeichnis in den Text eingefügt.

| Abbildung 1 | 9 |
| Abbildung 2 | 14 |
| Abbildung 3 | 17 |
| Abbildung 4 | 18 |
| Abbildung 5 | 21 |

*Ausschnitt aus einem Abbildungsverzeichnis*

Links gibt TextMaker jeweils die Bezeichnung und die laufende Nummer aus. Rechts wird, durch einen Tabulator getrennt, die zugehörige Seitenzahl angezeigt.
Falls Sie hinter den Beschrifungen noch erläuternden Text eingetippt hatten, erscheint auch dieser im Verzeichnis. Haben Sie also die Beschriftung "Abbildung 1" beispielsweise zu "Abbildung 1: Die Lärche" erweitert, erscheint genau dieser Text im Abbildungsverzeichnis.

**Optionen des Dialogs**

Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

- **Bezeichnungen**
  
  Wie im letzten Abschnitt beschrieben, lassen sich in Beschrifungen verschiedene Bezeichnungen verwenden. So können Sie beispielsweise Beschriften mit der Bezeichnung "Abbildung" einfügen – und zusätzlich weitere Beschriften mit der Bezeichnung "Tabelle". Für jede verwendete Bezeichnung lässt sich dann auch ein eigenes Verzeichnis anlegen.

  Hier können Sie auswählen, für welche Bezeichnung das Verzeichnis generiert werden soll.

  Hinweis: Die Liste bietet nur Bezeichnungen an, für die mindestens eine Beschriftung in das Dokument eingefügt wurde.

- **Bezeichnung und Nummer verwenden**
  
  Wie zuvor erwähnt, können Sie hinter Beschriften erläuternden Text eintippen, also die Beschriftung "Abbildung 1" beispielsweise zu "Abbildung 1: Die Lärche" erweitern.

  Diese Option bestimmt, ob im Verzeichnis auch die Bezeichnung und die laufende Nummer ausgegeben werden soll.

  Standardmäßig ist sie eingeschaltet; der Verzeichniseintrag für obiges Beispiel lautet also "Abbildung 1: Die Lärche".

  Schalten Sie die Option hingegen aus, erscheint nur der erläuternde Text – hier also: "Die Lärche".

- **Seitennummern rechtsbündig**
  
  Ist diese Option aktiviert, trennt TextMaker die Seitenzahlen im Verzeichnis mit einem rechtsbündigen Tabulator (mit Punkten als Füllzeichen) ab.

  Ist sie ausgeschaltet, wird zur Trennung der Seitenzahlen lediglich ein Leerzeichen eingefügt.

- **Platzierung**
  
  Hier können Sie bestimmen, was passieren soll, wenn das Dokument bereits ein Verzeichnis für die gewählte Bezeichnung bereits enthält:

  Wählen Sie **Bestehendes Verzeichnis ersetzen**, wird das vorhandene Verzeichnis ersetzt.

  Wählen Sie hingegen **Neues Verzeichnis erzeugen**, fügt TextMaker zusätzlich zu dem bestehenden Verzeichnis ein weiteres solches Verzeichnis ein.

**Weitere Informationen:**

- Informationen zum **Aktualisieren** von Verzeichnissen finden Sie im Abschnitt [Verzeichnisse aktualisieren](#).

- Informationen zum **Bearbeiten und Formatieren** von Verzeichnissen finden Sie im Abschnitt [Verzeichnisse bearbeiten und formatieren](#).
**Arbeiten mit umfangreichen Dokumenten**

**Bibliografien**

Im Anhang von wissenschaftlichen Arbeiten finden Sie häufig eine Bibliografie. Das ist ein Literaturverzeichnis, in dem alle Veröffentlichungen aufgelistet sind, auf die sich der Autor in dieser Arbeit bezieht.

TextMaker verfügt über nützliche Funktionen, die Ihnen das Arbeiten mit Bibliografien erheblich erleichtern.

Diese Funktionen setzen Sie am besten in folgenden Schritten ein:

1. **Schritt 1:** Als erstes benötigen Sie eine Bibliografie-Datenbank. Tragen Sie darin alle zitierten Quellen ein. Sie können eine vorhandene Datenbank verwenden (ein Beispiel wird mitgeliefert) oder mit dem Menübefehl **Weiteres > Datenbank erzeugen** eine neue anlegen.

   Die Datenbank kann beliebig aufgebaut sein, muss jedoch auf jeden Fall ein Feld mit einem eindeutigen "Kürzel" für die Quelle enthalten. Weiterhin müssen Felder für Autor und Titel der Quelle vorhanden sein.

2. **Schritt 2:** Anschließend rufen Sie den Menübefehl **Weiteres > Bibliografie > Bibliografie-Einstellungen** auf und weisen dem Dokument mit der Schaltfläche **Datei** diese Datenbank als Bibliografie-Datenbank zu. Geben Sie in dem Dialog auch gleich an, welche Felder der Datenbank das Kürzel für Querverweise, den Autor und den Titel enthalten.

3. **Schritt 3:** Nun können Sie mit dem Menübefehl **Weiteres > Bibliografie > Bibliografiefeld einfügen** im Text Verweise auf die in der Bibliografie-Datenbank eingetragenen Quellen einfügen (zum Beispiel "Wie in [DNA1979] erwähnt, ...").

4. **Schritt 4:** Am Ende des Dokuments können Sie schließlich mit dem Menübefehl **Weiteres > Bibliografie > Bibliografie erstellen** ein Literaturverzeichnis generieren lassen. Dieses listet all diejenigen Datensätze der Bibliografie-Datenbank auf, für die Sie Verweise in den Text eingefügt haben (siehe Schritt 3).

Ausführliche Informationen zur Verwendung dieser Funktionen finden Sie auf den nächsten Seiten.

---

**Schritt 1: Bibliografie-Datenbank erstellen und bearbeiten**

Um die Bibliografie-Funktionen verwenden zu können, benötigen Sie als erstes eine Bibliografie-Datenbank. Das ist eine Datenbank im dBase-Format, in der alle Quellenangaben einzutragen sind.

Sie können für jedes Dokument eine eigene Bibliografie-Datenbank anlegen. Wenn Sie Dokumente verfassen, die die gleichen Quellen verwenden, können Sie für diese Dokumente natürlich auch eine gemeinsame Datenbank verwenden.

**Aufbau einer Bibliografie-Datenbank**

Eine Bibliografie-Datenbank muss mindestens folgende Felder enthalten:

- Ein Feld mit einem eindeutigen Kürzel für die Quelle (siehe unten)
- Ein Feld mit dem Namen des Autors der Quelle
- Ein Feld mit dem Titel der Quelle

Abgesehen von den drei oben gelisteten Pflichtfeldern darf die Datenbank beliebig aufgebaut sein, sie kann also beispielsweise auch Felder für das Datum der Veröffentlichung, den Verlag etc. enthalten.


### Neue Bibliografie-Datenbank anlegen

Sofern Sie nicht eine bereits vorhandene Bibliografie-Datenbank verwenden möchten, müssen Sie eine neue Datenbank anlegen. Sie können dazu das Datenbankmodul von TextMaker oder jedes andere dBase-kompatible Datenbankprogramm verwenden.

Mit TextMaker erzeugen Sie eine neue Bibliografie-Datenbank wie folgt:

1. Rufen Sie den Menübefehl *Weiteres > Datenbank erzeugen* auf.

   Alternativ können Sie auch den Menübefehl *Weiteres > Bibliografie > Eine neue Bibliografiedatenbank erstellen* verwenden, der genau das Gleiche macht.

2. Geben Sie der Datenbank einen beliebigen Namen und bestätigen Sie mit *OK*.

3. Fügen Sie der Datenbank die gewünschten Felder hinzu. Die Datenbank muss auf jeden Fall Felder für das eindeutige "Kürzel" für die Quelle, den Autor und den Titel enthalten.

   Informationen zur Bedienung dieses Dialogs finden Sie im Abschnitt *Anlegen neuer Datenbanken*.

4. Wenn Sie fertig sind, klicken Sie auf *OK*.

5. TextMaker erzeugt die Datenbank nun und öffnet sie anschließend.

   Wenn Sie möchten, können Sie jetzt gleich die Quellen darin eintragen. Ansonsten rufen Sie den Menübefehl *Datei > Schließen* auf, um die Datenbank wieder zu schließen.

### Bibliografie-Datenbank bearbeiten

Anschließend muss die Bibliografie-Datenbank natürlich noch ausgefüllt werden. Tragen Sie also die Quellen, auf die Sie sich in dem Dokument beziehen, darin ein. Ob Sie gleich alle Quellen auf einmal eintragen oder diese nur bei Bedarf hinzufügen, bleibt ganz Ihnen überlassen.

Öffnen Sie die Bibliografiedatenbank dazu im Datenbankmodul von TextMaker, indem Sie den Menübefehl *Weiteres > Datenbank bearbeiten* aufrufen. Informationen zur Bedienung des Datenbankmoduls finden Sie im Kapitel *Datenbank*.

Alternativ kann die Bibliografiedatenbank auch über den Menübefehl *Weiteres > Bibliografie > Die Bibliografiedatenbank bearbeiten* geöffnet werden, der genau das Gleiche macht.
Schritt 2: Bibliografie-Datenbank zuweisen

Im nächsten Schritt teilen Sie TextMaker mit, welche Datenbank Sie als Bibliografie-Datenbank für das Dokument verwenden möchten. Weiterhin müssen Sie angeben, welche Felder dieser Datenbank das Kürzel für Verweise, den Autor und den Titel enthalten.

Gehen Sie dazu wie folgt vor:

1. Öffnen Sie das Dokument, für das Sie die in Schritt 1 erstellte Bibliografie-Datenbank verwenden möchten, beziehungsweise beginnen Sie ein neues Dokument.
2. Rufen Sie den Menübefehl Weiteres > Bibliografie > Bibliografie-Einstellungen auf.
3. Klicken Sie auf die Schaltfläche Datei...
4. Es erscheint ein Dateidialog. Wechseln Sie darin in das Verzeichnis, das die Bibliografie-Datenbank enthält, wählen Sie die Datenbank darin aus und bestätigen Sie mit OK.
5. Nun müssen Sie noch angeben, welche Felder dieser Datenbank Verweis (Kürzel), Autor und Titel enthalten. Wählen Sie diese Felder dazu über die drei aufklappbaren Listen in der Rubrik Einstellungen aus.
6. In der Rubrik Stil der Querverweise können Sie bei Bedarf noch festlegen, wie die Verweise aussehen sollen, die Sie in Schritt 3 einfügen können (siehe Schritt 3).
7. Sind alle Einstellungen zu Ihrer Zufriedenheit, bestätigen Sie mit OK.

TextMaker weiß nun, in welcher Datenbank die Quellen für dieses Dokument eingetragen sind und welche Felder dieser Datenbank welche Inhalte tragen. Sie können also mit Schritt 3 fortfahren.


Schritt 3: Verweise auf Quellen einfügen

Wenn Schritt 1 und 2 erledigt sind, können Sie Bibliografiefelder in den Text einfügen. Das sind Verweise auf die in der Bibliografie-Datenbank gespeicherten Quellen.

Verwenden Sie einen solchen Verweis, wenn Sie sich im Text auf eine der Quellen beziehen – zum Beispiel "Wie in [DNA1979] erwähnt, ...".

Folgendermaßen fügen Sie einen Verweis auf eine Quelle in den Text ein:

1. Setzen Sie die Schreibmarke an die gewünschte Position.
2. Rufen Sie den Menübefehl Weiteres > Bibliografie > Bibliografiefeld einfügen auf.

**Tipp:** Mit Hilfe der Schaltfläche Bearbeiten können Sie den Inhalt der Datenbank jederzeit bearbeiten und so beispielsweise einen neuen Eintrag hinzufügen.

Arbeiten mit umfangreichen Dokumenten

5. Bestätigen Sie mit **OK**.

Der Verweis wird nun in den Text eingefügt. Je nachdem, welche Optionen Sie in den Bibliografie-Einstellungen gewählt haben, erscheint dabei entweder das Kürzel oder die Nummer für die Quelle (siehe unten). Verfahren Sie wie oben beschrieben für jede Quelle, auf die Sie sich in Ihrem Dokument beziehen.

**Optionen für den Stil von Verweisen**

Bei Bedarf können Sie in den Bibliografie-Einstellungen das Aussehen der Verweise ändern. Sie können beispielsweise festlegen, ob diese das Kürzel aus der Datenbank oder eine automatisch generierte Nummer ausgeben sollen.

Rufen Sie dazu den Menübefehl **Weiteres > Bibliografie > Bibliografie-Einstellungen** auf und nehmen Sie die gewünschten Einstellungen in der Rubrik Stil von Verweisen vor.

Es gibt hier folgende Optionen:

- Wählen Sie **Querverweis verwenden**, zeigen Verweise das in der Datenbank eingetragene "Kürzel" für die Quelle an – zum Beispiel [DNA1979].

- Wählen Sie hingegen **Einträge nummerieren**, zeigen Verweise eine automatisch generierte Nummer für die Quelle an – zum Beispiel [42].

  Die Quelle, für die Sie dabei als erstes einen Verweis einfügen, bekommt die Nummer [1], die nächste Quelle bekommt eine [2] etc.

  **Hinweis:** Wenn Sie zwischen diesen beiden Optionen umschalten, ändern sofort alle Verweise im Dokument ihr Aussehen entsprechend. Das Literaturverzeichnis (falls bereits vorhanden) wird hingegen erst angepasst, wenn Sie es **aktualisieren** lassen (siehe Abschnitt **Verzeichnisse aktualisieren**).

- Mit der Option **Klammern** können Sie weiterhin bestimmen, mit welcher Art von Klammern die Verweise umgeben werden sollen.

  Verwenden Sie beispielsweise statt der Standardeinstellung [ ] die Einstellung { }, werden die Verweise nicht mehr mit eckigen, sondern mit geschweiften Klammern umgeben. Statt [DNA1979] erscheint dann also {DNA1979}.

**Schritt 4: Literaturverzeichnis erzeugen**

Im letzten Schritt lassen Sie TextMaker am Ende des Dokuments ein Literaturverzeichnis generieren. Dieses listet all diejenigen Datensätze der Bibliografie-Datenbank auf, für die Sie Verweise in den Text eingefügt haben (wie in Schritt 3 beschrieben).

Um ein Literaturverzeichnis einzufügen, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke an den Beginn der Zeile, in die das Literaturverzeichnis platziert werden soll.

2. Rufen Sie den Menübefehl **Weiteres > Bibliografie > Bibliografie erstellen** auf.

3. Wählen Sie bei **Platzierung**, ob ein neues Literaturverzeichnis an der aktuellen Position erzeugt werden oder ein bereits vorhandenes aktualisiert werden soll.

4. In dem großen Eingabefeld darunter können Sie, falls erforderlich, das Erscheinungsbild des Verzeichnisses noch abändern (siehe unten).
Wenn Sie mit OK bestätigen, wird das Verzeichnis in den Text eingefügt.

**Hinweis:** Wie eingangs erwähnt, erscheinen im Literaturverzeichnis nur diejenigen Datensätze der Bibliografie-Datenbank, für Sie auch tatsächlich **Verweise** in den Text eingefügt haben (siehe Schritt 3).

**Ändern des Erscheinungsbilds des Verzeichnisses**

Bevor Sie obigen Dialog mit OK verlassen, können Sie bei Bedarf das Aussehen des Literaturverzeichnisses nach Belieben ändern:

- **Text bearbeiten:** Sie können den in dem Eingabefeld vorgegebenen Text jederzeit editieren. Dazu stehen Ihnen die bekannten Editierbefehle zur Verfügung.
- **Formatierung ändern:** Auch die Formatierung lässt sich ändern. Markieren Sie dazu in dem Eingabefeld den gewünschten Textabschnitt und verwenden Sie die darüber angezeigte Mini-Formatleiste, um das Zeichenformat zu ändern.
- **Felder einfügen:** Felder der Bibliografie-Datenbank sind durch geschweifte Klammern gekennzeichnet. Bei Bedarf können Sie weitere Felder in das Eingabefeld einfügen, indem Sie diese einfach eintippen (z.B. `{AUTOR}`) oder einen Doppelklick auf das gewünschte Feld in der Liste **Felder** durchführen.

**Tipp:** Die Liste **Felder** enthält an erster Stelle stets ein Feld namens `{#REF}`. Dieses Feld wird automatisch erzeugt und hat folgende Besonderheit: Es gibt entweder das Kürzel oder eine automatisch generierte Nummer für die Quelle aus – je nachdem, welche dieser beiden Optionen Sie in den Bibliografie-Einstellungen gewählt haben.

**Weitere Informationen:**
- Informationen zum **Aktualisieren** von Verzeichnissen finden Sie im Abschnitt **Verzeichnisse aktualisieren**.
- Informationen zum **Bearbeiten und Formatieren** von Verzeichnissen finden Sie im Abschnitt **Verzeichnisse bearbeiten und formatieren**.

**Verzeichnisse aktualisieren**

**Wichtig:** Wenn Sie in ein Dokument ein Verzeichnis ( Inhaltsverzeichnis, Stichwortverzeichnis, Abbildungsverzeichnis oder Bibliografie) einfügen und den Text anschließend weiter bearbeiten, werden diese Verzeichnisse **nicht** laufend automatisch aktualisiert.

Ändern sich also die Seitenzahlen des Dokuments, weil Sie zusätzlichen Text eintippen, zeigen die Verzeichnisse weiterhin die alten Seitenzahlen an. Und wenn Sie beispielsweise neue Überschriften hinzufügen, erweitert sich das Inhaltsverzeichnis nicht selbsttätig.

Um die Verzeichnisse in einem Dokument auf den aktuellen Stand zu bringen, müssen Sie diese aktualisieren lassen. Dazu gehen Sie wie folgt vor:

1. Um das **Stichwortverzeichnis** zu aktualisieren, rufen Sie den Menübefehl **Weiteres > Stichwort > Stichwortverzeichnis erstellen** auf.
Arbeiten mit umfangreichen Dokumenten

Um das *Inhaltsverzeichnis* zu aktualisieren, rufen Sie den Menübefehl **Weiteres > Inhaltsverzeichnis erstellen** auf.

Um ein *Abbildungsverzeichnis* zu aktualisieren, rufen Sie den Menübefehl **Weiteres > Abbildungsverzeichnis erstellen** auf.

Um die *Bibliografie* zu aktualisieren, rufen Sie den Menübefehl **Weiteres > Bibliografie > Bibliografie erstellen** auf.

2. **Wichtig:** Vergewissern Sie sich, dass in dem Dialogfenster bei **Platzierung** die Option **Bestehendes Verzeichnis ersetzen** gewählt ist.

3. Bestätigen Sie mit **OK**.

TextMaker entfernt nun das vorhandene Verzeichnis und ersetzt es durch eine aktualisierte Fassung.

---

**Verzeichnisse bearbeiten und formatieren**

Verzeichnisse (Inhaltsverzeichnis, Stichwortverzeichnis, Abbildungsverzeichnis oder Bibliografie) lassen sich *theoretisch* wie normaler Text bearbeiten. Folgendes sollten Sie dabei jedoch beachten:

**Wichtig:** Wenn Sie Inhalt und/oder Formatierung eines Verzeichnisses von Hand ändern, gehen diese Änderungen beim nächsten Aktualisieren des Verzeichnisses wieder *verloren*, da TextMaker das Verzeichnis hierzu entfernt und neu einfügt.

Manuelle Textänderungen und Formatierungen an einem Verzeichnis sind folglich nur dann sinnvoll, wenn Ihr Dokument 100% druckreif ist und das Verzeichnis definitiv nicht mehr aktualisiert werden muss.

Textänderungen sind in Verzeichnissen normalerweise ohnehin nicht nötig, und die Formatierung können Sie auf wesentlich elegantere Art und Weise ändern:

**Tipp:** Verzeichnisse werden automatisch mit Formatvorlagen formatiert, mit deren Hilfe sich die Formatierung komfortabel ändern lässt.

TextMaker erzeugt dazu folgende Formatvorlagen, wenn Sie eines der genannten Verzeichnisse erstellen:

- **"Verzeichnis 1" bis "Verzeichnis 9"**
  Absatzvorlagen für die einzelnen Ebenen des *Inhaltsverzeichnisses*. Die erste Gliederungsebene (also die Hauptüberschriften) wird mit der Vorlage "Verzeichnis 1" formatiert, die zweite Ebene mit "Verzeichnis 2" usw.

- **"Index"**
  Absatzvorlage für die Stichworteinträge im *Stichwortverzeichnis*.

- **"Indexüberschrift"**
  Absatzvorlage für die Anfangsbuchstaben im *Stichwortverzeichnis* (sofern beim Erstellen des Stichwortverzeichnisses die Option *Mit Anfangsbuchstaben* aktiviert war)

- **"Beschriftung"**
Absatzvorlage für *Beschrifungen*.

- "**Abbildungsverzeichnis**"
  Absatzvorlage für die Einträge in einem *Abbildungsverzeichnis*.

- "**Bibliografie**"
  Absatzvorlage für die Einträge in der Bibliografie.

Möchten Sie also beispielsweise erreichen, dass die Hauptüberschriften im Inhaltsverzeichnis in einer größeren Schrift dargestellt werden sollen, müssen Sie nur die Formatvorlage "Verzeichnis 1" entsprechend ändern:

1. Rufen Sie den Menübefehl **Format > Absatzvorlage** auf.
2. Wählen Sie die Vorlage "Verzeichnis 1" in der Liste und klicken Sie auf **Bearbeiten**.
3. Es erscheint ein Dialog zum Ändern der Formatierung. Wechseln Sie darin auf die Karteikarte **Absatz**.
4. Klicken Sie auf die Schaltfläche **Zeichen**.
5. Wählen Sie im Feld **Größe** die gewünschte Schriftgröße.
6. Verlassen Sie die Dialoge mit **OK, OK** und **Schließen**.

Nun werden die Hauptüberschriften des Inhaltsverzeichnisses in der neuen Schriftgröße dargestellt. Selbst dann, wenn Sie das Verzeichnis aktualisieren oder es gar entfernen und neu einfügen, gilt diese Formatänderung weiterhin.

Allgemeine Informationen zur Verwendung von Formatvorlagen finden Sie im Kapitel [Formatvorlagen](#) nachlesen.

### Querverweise

Mit dem Menübefehl **Einfügen > Querverweis** können Sie einen Querverweis auf ein bestimmtes Textelement (zum Beispiel eine Textmarke oder ein Objekt) in den Text einfügen.

Dieser Befehl fügt ein Feld ein, das beispielsweise die Seitennummer des Zielelements anzeigt. Wenn Sie also auf Seite 3 des Dokuments eine Grafik einfügen, können Sie an einer anderen Stelle einen Querverweis auf diese Grafik anbringen – zum Beispiel "Siehe Grafik auf Seite 3".

Querverweise lassen sich auf die folgenden Textelemente anlegen:

- Textmarken
- Fußnoten
- Objekte (Grafiken, Zeichnungen etc.)

Querverweise auf **Textmarken** sind in umfangreichen Dokumenten häufig anzutreffen. Textmarken sind "Lesezeichen", die an beliebigen Stellen des Dokuments gesetzt werden können.

Wenn Sie beispielsweise einen Querverweis auf das Stichwortverzeichnis am Ende Ihres Dokuments anbringen, setzen Sie zunächst eine Textmarke an den Beginn des Verzeichnisses. Dann tippen Sie an der gewünschten Stelle zum Beispiel "Siehe auch Stichwortverzeichnis ab Seite " ein und fügen einen Querverweis auf diese Textmarke ein. Der Querverweis zeigt nun die Seitenzahl an, auf der das Stichwortverzeichnis beginnt.

Ausführliche Informationen zum Arbeiten mit Querverweisen folgen auf den nächsten Seiten.

### Querverweise einfügen

Um einen Querverweis in den Text einzufügen, gehen Sie wie folgt vor:

1. Falls Sie einen Querverweis auf eine Textmarke anlegen möchten, müssen Sie erst an der Zielstelle mit dem Menübefehl Einfügen > Textmarke eine Textmarke setzen (siehe auch Abschnitt Textmarken).
2. Setzen Sie dann die Schreibmarke an die Textstelle, an der Sie den Querverweis einfügen möchten.
3. Rufen Sie den Menübefehl Einfügen > Querverweis auf.
5. Wählen Sie bei Ziel die Textmarke, die Fußnote oder das Objekt aus, auf das der Querverweis verweisen soll.
6. Wählen Sie bei Anzeigen aus, ob der Querverweis die Seitennummer oder die Nummer des Ziels anzeigen soll (siehe Abschnitt "Optionen" weiter unten).
7. Bestätigen Sie mit OK.

TextMaker fügt den Querverweis nun in den Text ein.

### Optionen des Dialogs

Die Optionen im Dialogfenster dieses Befehls haben folgende Funktionen:

- **Typ**
  
  Hier bestimmen Sie, worauf der Querverweis angelegt werden soll: auf eine Textmarke, eine Fußnote oder ein Objekt.

- **Ziel**
  
  Hier wählen Sie das Ziel für den Querverweis. Haben Sie beispielsweise den Typ auf Textmarke gesetzt, erscheint hier eine Liste aller im Dokument vorhandenen Textmarken. Wählen Sie darin per Mausklick die gewünschte Textmarke.

- **Anzeigen**
  
  Hier bestimmen Sie, was der Querverweis anzeigen soll:

  **Seite**: Der Querverweis zeigt die Seitennummer der Seite an, auf der sich das Ziel befindet.

  **Nummer**: Der Querverweis zeigt die Nummer des Ziels an:

  Bei Fußnoten wird dann die Nummer der Fußnote angezeigt.

  Bei Textmarken wird hingegen die Nummerierung des Absatzes angezeigt, in dem sich die Textmarke befindet. Dazu muss der Absatz mit dem Menübefehl Format > Bullets und Nummerierungen mit einer Nummerierung versehen worden sein. Ist dies nicht der Fall, zeigt der Querverweis eine Null an.
Arbeiten mit umfangreichen Dokumenten

Bei Objekten ist diese Option nicht verfügbar.

Querverweise bearbeiten und aktualisieren

Querverweise sind Felder; für sie gilt also das Gleiche wie für alle Felder: Sie können wie normaler Text formatiert, gelöscht, kopiert und verschoben werden, ihr Inhalt lässt sich jedoch nicht direkt editieren.

**Tipp:** Wenn Sie sehen möchten, welche Querverweise im Dokument auf welche Ziele verweisen, können Sie jederzeit die Option Nur Feldnamen anzeigen im Dialogfenster des Menübefehls Datei > Eigenschaften (Karteikarte Ansicht) aktivieren. Alle Querverweise zeigen dann statt z.B. der Seitennummer den Typ und die Zielstelle des Querverweises an – zum Beispiel: {Querverweis.Textmarke.Seite:Name_der_Textmarke}.

Aktualisieren von Querverweisen

Genau wie alle anderen Felder werden auch Querverweise nicht permanent auf dem aktuellen Stand gehalten. Verschieben Sie also beispielsweise die Zielstelle eines Querverweises auf eine andere Seite, zeigt der Querverweis zunächst auch weiterhin die alte Seitennummer an.

Beim Drucken des Dokuments bringt TextMaker jedoch alle Felder (also auch Querverweise) automatisch auf den neuesten Stand. Sie können sich also sicher sein, dass alle Querverweise stimmen, wenn Sie das Dokument ausdrucken.

Bei Bedarf können Sie die Felder eines Dokuments auch manuell aktualisieren lassen, indem Sie den Menübefehl Weiteres > Felder aktualisieren aufrufen. Alle Felder und Berechnungen werden dann auf den aktuellen Stand gebracht.

**Ungültige Verweise:** Wenn Sie die Zielstelle eines Querverweises löschen, wird dieser natürlich ungültig. Der Querverweis zeigt dann, wenn Sie das Dokument aktualisieren, den Text "Zielstelle nicht gefunden!" an. Sie können dies korrigieren, indem Sie den Querverweis entfernen und (mit einer korrekten Zielstelle) neu einfügen.

Vorlagenverweise

Neben Querverweisen (siehe vorherige Seiten) können Sie auch sogenannte Vorlagenverweise in den Text einfügen.


Das klingt erst einmal wenig hilfreich, lässt sich aber beispielsweise wie folgt sinnvoll einsetzen:

Umfangreiche Dokumente versieht man in der Regel mit einer Gliederung, also Überschriften in mehreren Ebenen. Der einfachste Weg, dies zu erreichen, ist das Formatieren der Überschriften in den vorgefertigten Absatzvorlagen "Überschrift 1", "Überschrift 2" etc. Fügen Sie nun an einer beliebigen Textstelle ein Vor-
Arbeiten mit umfangreichen Dokumenten

lagenverweis-Feld ein und lassen dieses z.B. nach der Vorlage "Überschrift 1" suchen, findet das Feld automatisch die für diese Textstelle gültige Hauptüberschrift und zeigt diese an.

Besonders häufig werden solche Felder dementsprechend in den Kopf- oder Fußzeilen von Büchern und anderen umfangreichen Dokumenten verwendet, um dort die aktuelle Kapitelüberschrift auszugeben.

**Einfügen eines Vorlagenverweis-Feldes**

Um ein Vorlagenverweis-Feld in den Text einzufügen, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke an die Textstelle, an der Sie den Verweis einfügen möchten.
2. Rufen Sie den Menübefehl *Einfügen > Feld* auf.
3. Wählen Sie in der linken Liste den Eintrag *Vorlagenverweis* aus.
4. Wählen Sie in der rechten Liste die Formatvorlage aus, nach der gesucht werden soll.
5. Klicken Sie auf die Schaltfläche *Einfügen*.

TextMaker fügt das Vorlagenverweis-Feld nun in den Text ein.


Sobald Text gefunden wird, der in der gesuchten Vorlage formatiert ist, zeigt das Feld diesen Text an. Hatte man also beispielsweise die Absatzvorlage "Überschrift 1" gewählt, zeigt das Feld die aktuelle Hauptüberschrift für den Textabschnitt an, in den der Text eingefügt wurde. (Dies setzt natürlich voraus, dass alle Überschriften in dem Dokument mit der Absatzvorlage "Überschrift 1" formatiert wurden.)

Falls nichts gefunden wird, zeigt das Feld die Fehlermeldung "Vorlagenverweis: Keinen passenden Text gefunden!". Überprüfen Sie dann, ob Sie nach der richtigen Formatvorlage suchen und ob auch tatsächlich Text existiert, der in dieser Vorlage formatiert wurde.

**Optionen des Dialogs**

In dem Dialogfenster, das beim Einfügen eines Vorlagenverweis-Felds erscheint, gibt es folgende Optionen:

- **Vorlage**
  
  In dieser Liste wählen Sie, nach welcher Formatvorlage gesucht werden soll.

- **Nach Zeichenvorlagen suchen**


- **Seite von unten durchsuchen**

  Betrifft nur Vorlagenverweis-Felder, die in Kopf- oder Fußzeilen eingefügt wurden, da diese eine besondere Suchreihenfolge verwenden:

  Zunächst wird nur die *aktuelle* Seite nach Text in der gewählten Vorlage durchsucht – und zwar in folgender Richtung:

  Ist diese Option ausgeschaltet, wird die Seite von oben nach unten durchsucht.

  Ist diese Option eingeschaltet, wird die Seite von unten nach oben (rückwärts) durchsucht.
Arbeiten mit umfangreichen Dokumenten

Danach wird die Suche, unabhängig von dieser Option, "normal" fortgeführt: Es werden also erst die Seiten vor der aktuellen Seite (rückwärts) durchsucht. Wird nichts gefunden, werden auch die Seiten hinter der aktuellen Seite (vorwärts) durchsucht.

Absatznummer einfügen

Ist diese Option aktiviert, liefert das Vorlagenverweis-Feld nicht mehr den Text, der in der gesuchten Vorlage formatiert ist, sondern dessen Nummerierung.

(Dies funktioniert natürlich nur, wenn der fundene Text mit einer Nummerierung versehen wurde. Siehe dazu Abschnitte Automatische Nummerierung beziehungsweise Überschriften nummerieren.)

'Oben' oder 'Unten' einfügen

Ist diese Option aktiviert, liefert das Vorlagenverweis-Feld nicht mehr den Text, der in der gesuchten Vorlage formatiert ist, sondern lediglich die Positionsangabe "oben" oder "unten":

- Befindet sich die Fundstelle oberhalb des Felds, liefert das Feld den Text "oben".
- Befindet sich die Fundstelle unterhalb des Felds, liefert es den Text "unten".

Auf diese Weise lassen sich Verweise wie "siehe oben" beziehungsweise "siehe unten" einfügen.

Aktualisieren von Vorlagenverweis-Feldern


Fußnoten

In Fußnoten können Sie erläuternde Anmerkungen zu beliebigen Wörtern oder Phrasen im Text anbringen. Fußnoten erscheinen üblicherweise am unteren Ende der Seite; Sie können diese aber wahlweise auch am Ende des Kapitels oder erst am Ende des Dokuments ausgeben lassen.

Fußnoten bestehen stets aus zwei Komponenten: einem (hochgestellten) Fußnotenzeichen im Text und dem dazugehörigen Fußnotentext:

Bei Aufkommen von dichtem Nebel\(^1\) sollten Sie rechtzeitig Ihre Geschwindigkeit drosseln\(^2\) und die Nebelschlussleuchte einschalten.

\(^{1}\) Sichtweite unter 50 Meter
\(^{2}\) Maximal 50 km/h

Ein Beispiel für den Einsatz von Fußnoten

TextMaker nummeriert die Fußnoten automatisch fortlaufend durch. Fügen Sie also irgendwo im Text eine neue Fußnote ein oder löschen eine bestehende Fußnote heraus, ändern sich die Nummern aller nachfolgenden Fußnoten entsprechend.
Zwischen dem Text und dem Fußnotenbereich bringt TextMaker automatisch einen Trennstreifen an. Dieser lässt sich auf Wunsch mit einer anderen Formatierung versehen oder abschalten.

In diesem Abschnitt erfahren Sie alles, was sie zum Arbeiten mit Fußnoten wissen müssen. Folgende Themen werden darin behandelt:

- **Fußnoten einfügen und bearbeiten**
- **Fußnotenformatierung ändern**
- **Fußnotenoptionen**

Lesen Sie dazu die nächsten Seiten.

---

### Fußnoten einfügen und bearbeiten

In TextMaker können Sie eine Textstelle blitzschnell mit einer Fußnote versehen. Rufen Sie einfach hinter dieser Textstelle den Menübefehl **Einfügen > Fußnote > Fußnote einfügen** auf, und tippen Sie dann den Fußnotentext ein. Die Nummerierung, Platzierung und Formatierung der Fußnoten übernimmt TextMaker automatisch für Sie.

Im Detail gehen Sie dazu wie folgt vor:

1. Bewegen Sie die Schreibmarke direkt hinter den Begriff, zu dem Sie eine Fußnote anlegen möchten.
2. Rufen Sie den Menübefehl **Einfügen > Fußnote** auf. Es öffnet sich ein Untermenü. Wählen Sie darin den Befehl **Fußnote einfügen** aus.
3. TextMaker fügt nun ein hochgestelltes *Fußnotenzeichen* (eine automatisch generierte laufende Nummer) für diese Fußnote ein. Danach wird automatisch am unteren Seitenrand ein Fußnotenbereich angelegt, dort die gleiche Nummer eingetragen und die Schreibmarke dahintergesetzt.
4. Sie können nun den *Fußnotentext* für diese Fußnote eintippen.

Um vom Fußnotenbereich wieder zurück in den normalen Text zu gelangen, klicken Sie einfach eine beliebige Stelle im Text an. Alternativ können Sie den Menübefehl **Einfügen > Fußnote > Gehe zu Fußnotenreferenz** verwenden, der Sie zu der entsprechenden Fußnote im Text zurückbefördernt.

### Fußnotentext nachträglich ändern

Der Fußnotentext am unteren Seitenrand lässt sich jederzeit bearbeiten. Sie müssen lediglich die Schreibmarke in den Fußnotenbereich setzen. Verwenden Sie dazu eines der folgenden Verfahren:

- Blättern Sie zu der Seite, auf der sich die abzuändernde Fußnote befindet, und klicken Sie mit der Maus in den Fußnotenbereich am unteren Seitenrand.

**Hinweis:** Dies funktioniert nur in der Normalansicht. Sollten Sie sich in einer anderen Ansicht befinden, müssen Sie also zuvor mit dem Menübefehl **Ansicht > Normal** in die Normalansicht umschalten.

- Mit dem Menübefehl **Einfügen > Fußnote > Gehe zu Fußnote** können Sie TextMaker die nächste Fußnote im Text suchen lassen. Ist diese gefunden, setzt TextMaker die Schreibmarke automatisch in den dazugehörigen Fußnotentext im Fußnotenbereich.

Nun können Sie den Fußnotentext editieren. Wie Sie wieder in den normalen Text zurückgelangen, wissen Sie ja bereits: einfach eine beliebige Textstelle anklicken.
Arbeiten mit umfangreichen Dokumenten

**Tipp:** Es gibt auch Tastenkürzel zum Springen in den Fußnotentext und wieder zurück: Wenn Sie die Schreibmarke auf eine Fußnotennummer setzen und dann Strg+Alt+ → drücken, springt TextMaker in den zugehörigen Fußnotentext. Mit Strg+Alt+ ↑ gelangen Sie wieder zurück zu der Fußnote im Text.

**Fußnotenzeichen erneut einfügen:** Falls Sie einmal die Fußnotennummer in einem Fußnotentext versehentlich gelöscht haben, können Sie diese jederzeit erneut einfügen. Rufen Sie dazu den Menübefehl Einfügen > Fußnote > Fußnotenzeichen auf.

**Fußnoten verschieben, kopieren oder löschen**

Sie können Textabschnitte, die Fußnoten enthalten, wie gewohnt verschieben, kopieren oder löschen. TextMaker ordnet die Fußnoten texte automatisch neu an und korrigiert selbsttätig die Nummerierung.

Sie sollten dabei allerdings folgende Regel beachten:

**Wichtig:** Wenn Sie Fußnoten kopieren, verschieben oder löschen möchten, sollten Sie dies stets im Text durchführen – nicht im Fußnotenbereich am unteren Rand der Seite.

Löschen Sie beispielsweise im Fußnotenbereich den Fußnotentext einer Fußnote, bleibt diese Fußnote trotzdem noch erhalten – lediglich ihr Fußnotentext ist leer. Markieren Sie hingegen das Fußnotenzeichen im Text und löschen dieses, wird die komplette Fußnote (Fußnotenzeichen und -text) entfernt, und alle restlichen Fußnoten werden neu durchnummeriert.

**Nummerierung der Fußnoten beeinflussen**

Wie eingangs erwähnt, werden Fußnoten von TextMaker automatisch durchnummeriert, Sie müssen sich also nicht darum kümmern. Bei Bedarf können Sie die Nummerierung allerdings von Hand beeinflussen:

- **Nummer einer einzelnen Fußnote ändern**

  Um die Nummer einer einzelnen Fußnote zu ändern, setzen Sie die Schreibmarke dahinter und rufen den Menübefehl Einfügen > Fußnote > Fußnote bearbeiten auf. Es erscheint ein Dialog, in dem Sie die Nummerierung für diese Fußnote von automatisch auf benutzerdefiniert umstellen und dann die gewünschte Nummer eintragen können.

- **Nummerierung insgesamt ändern**

  Um die Nummerierung aller Fußnoten im Dokument zu ändern, rufen Sie den Menübefehl Einfügen > Fußnote > Optionen auf. In diesem Dialog können Sie unter anderem den Startwert und die Art der Nummerierung einstellen. Siehe dazu Abschnitt Fußnotenoptionen.

**Fußnotenformatierung ändern**

Sie können sowohl die Formatierung des Fußnotentextes als auch die des Fußnotenzeichens (der Fußnotennummer) nach Belieben ändern:

**Fußnotentext formatieren**

Um die Formatierung des Fußnotentextes zu ändern, setzen Sie die Schreibmarke einfach in den Fußnotentext und bringen die gewünschten Formatierungen an.
Arbeiten mit umfangreichen Dokumenten

Tipp: Wenn Sie die Formatierung aller Fußnotentexte im gesamten Dokument ändern möchten, kann Ihnen TextMaker viel Arbeit abnehmen. Sie brauchen dazu nämlich nur die Absatzvorlage "Fußnotentext" abzuändern, die TextMaker automatisch erzeugt, sobald Sie die erste Fußnote einfügen.

Alle Fußnotentexte werden standardmäßig mit dieser Vorlage formatiert. Solange Sie die Formatierung der Fußnotentexte also nicht von Hand geändert haben, wirken sich Änderungen an der Vorlage "Fußnotentext" auf alle Fußnotentexte im Dokument aus.

Um diese Vorlage zu bearbeiten, gehen Sie wie folgt vor:
1. Rufen Sie den Menübefehl Format > Absatzvorlage auf.
2. Wählen Sie die Vorlage "Fußnotentext" in der Liste und klicken Sie auf Bearbeiten.
4. Verlassen Sie die Dialogfenster mit OK und Schließen.

Allgemeine Informationen zur Verwendung von Formatvorlagen finden Sie im Kapitel Formatvorlagen.

Fußnotenzeichen formatieren


Fußnotenoptionen

Über den Menübefehl Einfügen > Fußnote > Optionen lassen sich Einstellungen zu den Fußnoten im aktuellen Dokument vornehmen.

Das Dialogfenster dieses Befehls enthält folgende Optionen:

Position

Üblicherweise lässt man die Fußnotentexte am unteren Rand jeder Seite ausgeben. Ändern Sie die Option Position, wenn Sie möchten, dass diese an einer anderen Stelle erscheinen. Es gibt hierfür folgende Optionen:

- Seitenende
  Das ist die Standardeinstellung – die Fußnotentexte werden am Ende jeder Seite ausgegeben.

- Ende des Kapitels
  Falls Sie Ihr Dokument mithilfe des Menübefehls Einfügen > Umbruch > Kapitelumbruch in mehrere Kapitel unterteilt haben und wünschen, dass die Fußnotentexte gesammelt am jeweiligen Kapitelaende erscheinen, wählen Sie diese Option.
Arbeiten mit umfangreichen Dokumenten

(Weitere Informationen über den Einsatz von Kapiteln finden Sie im Abschnitt Aufteilen eines Dokuments in Kapitel.)

- **Ende des Dokuments**

  Mit dieser Option erhalten Sie sogenannte Endnoten: sämtliche Fußnoten werden gesammelt am Ende des Dokuments ausgegeben.

**Rubrik Nummerierung**

Hier können Sie Einstellungen zur automatischen Nummerierung der Fußnoten vornehmen:

- **Typ**

  Hier lässt sich die Art der Nummerierung ändern. Neben Zahlen können Sie beispielsweise auch Buchstaben verwenden. Die Fußnoten werden dann nicht mehr mit 1, 2, 3, ... sondern mit A, B, C, ... nummeriert.

- **Startnummer**

  Hier können Sie bestimmen, mit welcher Nummer die Zählung beginnen soll. Standardwert ist "1". Tragen Sie beispielsweise "42" ein, erhält die erste Fußnote die Nummer 42, die nächste 43 etc.

- **Modus**

  Darunter können Sie bestimmen, ob die Nummerierung auf jeder Seite beziehungsweise in jedem Kapitel auf "1" zurückgesetzt werden soll:

  - **Fortlaufende Nummerierung**: Die Nummerierung wird niemals zurückgesetzt. Dies ist die Standardinstellung.
  - **Auf jeder Seite neu beginnen**: Die Nummerierung wird auf jeder Seite des Dokuments auf "1" zurückgesetzt.
  - **In jedem Bereich neu beginnen**: Die Nummerierung wird in jedem Bereich auf "1" zurückgesetzt. (Informationen zu Bereichen finden sie im Abschnitt Was sind Bereiche?)
  - **In jedem Kapitel neu beginnen**: Die Nummerierung wird in jedem Kapitel auf "1" zurückgesetzt. (Informationen zu Kapiteln finden Sie im Abschnitt Aufteilen eines Dokuments in Kapitel.)

**Rubrik Ränder des Fußnotenstrichs**

Hier können Sie die Ränder für den Trennstrich, der automatisch über dem Fußnotenbereich gedruckt wird, festlegen:

Der Rand **Oben** legt den Mindestabstand des Textes zum Fußnotenstrich fest, der Rand **Unten** steht für den Abstand zu den Fußnotentexten.

Erhöhen Sie den Rand **Links**, beginnt der Fußnotenstrich weiter rechts, beim Erhöhen des Rands **Rechts** endet er früher.

**Karteikarte Fußnotenstrich**

Wechseln Sie auf diese Karteikarte, wenn Sie das Aussehen des Fußnotenstrichs ändern möchten, der über dem Fußnotenbereich gedruckt wird.

Um beispielsweise die Stärke dieser Linie zu ändern, wählen Sie bei **Liniendicke** die gewünschte Linienstärke aus.
Wenn Sie möchten, dass überhaupt kein Fußnotenstrich ausgegeben werden soll, wählen Sie bei Linienstil die Option Keine Linie.
Überarbeiten von Dokumenten

Sie können in Dokumenten Kommentare anbringen und Änderungen verfolgen lassen. Diese beiden Funktionen eignen sich beispielsweise zum Überarbeiten eines Dokuments durch mehrere Anwender hintereinander:

- **Kommentare verwenden**

  Sie können beliebige Textstellen markieren und diese dann mit Kommentaren versehen. Erhalten Sie beispielsweise von einem Mitarbeiter ein Dokument zum Korrekturlesen, können Sie direkt in das Dokument Anmerkungen wie "Diesen Abschnitt kürzen" etc. einfügen und ihm das Dokument dann zurückgeben. Der Mitarbeiter kann das Dokument nun Ihren Kommentaren entsprechend überarbeiten.

- **Änderungen an einem Dokument verfolgen**

  Die Funktion "Änderungen verfolgen" geht noch etwas weiter. Ist sie aktiviert, können Sie wie gewohnt Änderungen an dem Dokument vornehmen – also Text löschen, hinzufügen, Formatierungen ändern etc. Ihre Änderungen werden allerdings nicht sofort im Dokument abgelegt, sondern zunächst als farblich hervorgehobene "Änderungswünsche" gespeichert.

  Übergibt Ihnen also ein Mitarbeiter ein Dokument zum Korrigieren, schalten Sie die Funktion "Änderungen verfolgen" ein, nehmen die gewünschten Änderungen vor und geben dem Mitarbeiter das Dokument zurück. Dieser kann sich Ihre Änderungswünsche nun ansehen und jede einzelne Änderung akzeptieren (worauf sie fest im Dokument gespeichert wird) oder verwerfen (worauf sie verworfen wird).

Naturally können Sie Kommentare und die Funktion "Änderungen verfolgen" auch kombiniert einsetzen. Ausführliche Informationen zu diesen beiden Funktionen finden Sie auf den nächsten Seiten.

Kommentare verwenden

Mit dem Menübefehl Weiteres > Kommentare können Sie in ein Dokument Kommentare zu beliebigen Textstellen einfügen.

Mit einem Kommentar versehener Text wird farblich hervorgehoben. Zeigen Sie mit der Maus auf einen solchen Text, wird der Kommentar in einem kleinen Fenster eingeblendet.


Kommentare werden standardmäßig nur auf dem Bildschirm angezeigt und nicht ausgedruckt – sofern Sie nicht in den Dokumenteigenschaften die Option Kommentare drucken eingeschaltet haben.

**Tipp: Verwenden der Überarbeitungsleiste**

Am einfachsten gestaltet sich die Verwendung von Kommentaren mit Hilfe der Überarbeitungsleiste.
Überarbeiten von Dokumenten

Die Überarbeitungsleiste

Diese Symbolleiste erscheint automatisch (unter der Formatleiste), wenn das aktuelle Dokument mindestens einen Kommentar enthält.

Falls die Leiste nicht automatisch angezeigt werden sollte, rufen Sie den Menübefehl Ansicht > Symbolleisten auf und schalten im Dialogfenster dieses Befehls die Symbolleiste Überarbeitung ein.

Die Überarbeitungsleiste verfügt über folgende Schaltflächen (von links nach rechts):

- Neuen Kommentar einfügen
- Aktuellen Kommentar bearbeiten
- Aktuellen Kommentar löschen
- Zum vorherigen Kommentar gehen
- Zum nächsten Kommentar gehen
- Kommentarfeld ein-/ausschalten

Die Schaltflächen rechts davon sind nicht für Kommentare zuständig, sondern dienen zum Verfolgen von Änderungen am Dokument (siehe Änderungen an einem Dokument verfolgen).

Ausführliche Informationen zu den einzelnen Funktionen erhalten Sie in den nachfolgenden Abschnitten.

Kommentare einfügen

Um einen Kommentar einzufügen, gehen Sie wie folgt vor:

1. Markieren Sie die Textstelle, die Sie mit einem Kommentar versehen möchten.
2. Rufen Sie den Menübefehl Weitere > Kommentare > Kommentar einfügen auf.
   Tipp: Dieser Befehl lässt sich auch über das Symbol in der Überarbeitungsleiste aufrufen.
3. Es erscheint ein kleines Fenster zur Eingabe des Kommentars. Tippen Sie Ihren Kommentar darin ein.
4. Ist Ihre Eingabe beendet, klicken Sie auf eine beliebige Stelle außerhalb des Kommentarfensters, um es zu schließen.

Der Kommentar wurde nun eingefügt. Sie erkennen das daran, dass der betreffende Text farblich hinterlegt wurde.

Kommentare bearbeiten

Um einen Kommentar zu bearbeiten, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke an eine beliebige Position innerhalb des Textes, dessen Kommentar Sie bearbeiten möchten.
2. Rufen Sie den Menübefehl Weitere > Kommentare > Kommentar bearbeiten auf.
   Tipp: Dieser Befehl lässt sich auch über das Symbol in der Überarbeitungsleiste aufrufen.
3. Es erscheint ein kleines Fenster zum Bearbeiten des Kommentars. Nehmen Sie darin die gewünschten Änderungen vor.
4. Ist Ihre Eingabe beendet, klicken Sie auf eine beliebige Stelle im Text, um das Kommentarfenster wieder zu verlassen. Der Kommentar wurde nun entsprechend geändert.

_Tipp:_ Es gibt auch Tastenkürzel zum Springen in einen Kommentar und wieder zurück: Wenn Sie die Schreibmarke auf ein beliebiges Zeichen innerhalb eines kommentierten Textstücks setzen und dann Strg+Alt+♀ drücken, springt TextMaker in den zugehörigen Kommentar. Mit Strg+Alt+↑ gelangen Sie wieder zurück in den Text.

## Kommentare löschen

Um einen Kommentar zu löschen, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke an eine beliebige Position innerhalb des Textes, dessen Kommentar Sie löschen möchten.

2. Rufen Sie den Menübefehl **Weiteres > Kommentare > Kommentar löschen** auf.

_Tipp:_ Dieser Befehl lässt sich auch über das Symbol in der Überarbeitungsleiste aufrufen. Der Kommentar wurde nun entfernt.

## Kommentare anzeigen und drucken

Kommentare können auf zwei Arten sichtbar gemacht werden:

- **Permanent, im Kommentarfeld**

  Wenn Sie zum ersten Mal einen Kommentar in ein Dokument einfügen oder das Dokument bereits Kommentare enthält, wird im rechten Seitenrand des Dokuments automatisch das **Kommentarfeld** eingeblendet. In diesem werden alle Kommentare für die aktuelle Seite angezeigt. Eine Verbindungslinie zwischen Kommentar und zugehörigem Text macht deutlich, auf welche Textstelle sich der Kommentar bezieht.

  Sie können dieses Kommentarfeld bei Bedarf ein- oder ausschalten, indem Sie den Menübefehl **Weiteres > Kommentare > Kommentarfeld automatisch anzeigen** aufrufen.

  _Tipp:_ Dieser Befehl lässt sich auch über das Symbol in der Überarbeitungsleiste aufrufen.

  _Hinweis:_ Auch wenn diese Option eingeschaltet ist, erscheint das Kommentarfeld nur dann, wenn das Dokument auch tatsächlich Kommentare enthält.

- **Automatisch, als kleines Fenster**

  Ist das Kommentarfeld ausgeschaltet, werden Kommentare nur dann sichtbar, wenn Sie mit der Maus auf eine Textstelle zeigen, die mit einem Kommentar versehen ist. Es erscheint dann ein kleines Fenster, das den Kommentar anzeigt.
Überarbeiten von Dokumenten

Kommentare drucken

Kommentare erscheinen normalerweise nur auf dem Bildschirm; sie werden nicht ausgedruckt. Wenn Sie möchten, dass Kommentare auch im Ausdruck erscheinen, aktivieren Sie die Option Kommentare drucken (siehe Abschnitt Einstellungen zu Kommentaren).

Hinweis: Der Ausdruck wird dabei etwas verkleinert, um Platz für die Kommentare zu schaffen. Die Proportionen des Ausdrucks entsprechen dann also nicht mehr den tatsächlichen Ausmaßen des Dokuments.

Kommentare auffinden

Im Untermenü des Befehls Weiteres > Kommentare finden Sie zwei Befehle, mit denen Sie zwischen allen Kommentaren im Dokument hin- und herspringen können:

- Weiteres > Kommentare > Vorheriger Kommentar springt zum vorherigen Kommentar
- Weiteres > Kommentare > Nächster Kommentar springt zum nächsten Kommentar

Tipp: Diese beiden Befehle lassen sich auch über die Symbole und in der Überarbeitungsleiste aufrufen.

Einstellungen zu Kommentaren

Mit dem Menübefehl Weiteres > Kommentare > Einstellungen können Sie diverse Einstellungen zu Kommentaren vornehmen.

Hinweis: Dieses Dialogfenster können Sie auch aufrufen, indem Sie den Menübefehl Datei > Eigenschaften aufrufen und auf die Karteikarte Überarbeiten wechseln.

Folgende Optionen sind verfügbar:

Rubrik Kommentare

- Kommentare im Text hervorheben
  Ist diese Option aktiviert, werden alle Textstellen, die mit einem Kommentar versehen wurden, im Text farblich hervorgehoben.

- Kommentare drucken
  Ist diese Option aktiviert, erscheinen Kommentare nicht nur auf dem Bildschirm, sondern auch im Ausdruck.

Hinweis: Der Ausdruck wird dabei etwas verkleinert, um Platz für die Kommentare zu schaffen. Die Proportionen des Ausdrucks entsprechen dann also nicht mehr den tatsächlichen Ausmaßen des Dokuments.
Überarbeiten von Dokumenten

- **Farbe**

Bestimmt die Farbe, in der Kommentare und die farbliche Hervorhebung im Text erscheinen.

Verwenden Sie die Standardeinstellung Autor, erscheinen je nach Bearbeiter des Dokuments automatisch andere Farben. Fügt der erste Anwender Kommentare hinzu, erscheinen diese in rot. Öffnet anschließend ein weiterer Anwender das Dokument und fügt ebenfalls Kommentare hinzu, erscheinen diese in blau etc.

*Hinweis:* Damit dies korrekt funktionieren kann, müssen alle Anwender, die das Dokument bearbeiten, in den TextMaker-Einstellungen ihren Namen angegeben haben. Um Ihren Namen einzutragen, rufen Sie den Menübefehl Weiteres > Einstellungen auf, wechseln auf die Karteikarte Allgemein und geben mit Hilfe der Schaltfläche Benutzerdaten Ihren Namen (oder zumindest Ihre Initialen) ein.

**Rubrik Kommentarfeld**

- **Automatisch anzeigen**

Entspricht dem Menübefehl Weiteres > Kommentare > Kommentarfeld automatisch anzeigen.

Das Kommentarfeld ist eine Fläche im rechten Seitenrand, in der alle Kommentare für die aktuelle Seite des Dokuments angezeigt werden.

Ist diese Option aktiviert, wird das Kommentarfeld automatisch angezeigt, wenn Sie in ein Dokument zum ersten Mal einen Kommentar einfügen oder wenn das Dokument bereits Kommentare enthält.

Ist die Option deaktiviert, wird das Kommentarfeld nicht angezeigt. In diesem Falle können Sie Kommentare aber trotzdem sichtbar machen: Zeigen Sie dazu einfach mit der Maus auf eine Textstelle, die mit einem Kommentar versehen wurde. Der Kommentar wird dann automatisch in einem kleinen Fenster angezeigt.

*Hinweis:* Auch wenn diese Option eingeschaltet ist, erscheint das Kommentarfeld nur dann, wenn das Dokument auch tatsächlich Kommentare enthält.

- **Breite**

Lässt Sie die Breite des Kommentarfel�s ändern.

- **Position**

Lässt Sie die Position des Kommentarfel�s ändern: rechts oder links beziehungsweise außen oder innen (bei Dokumenten im Buchlayout, also mit gegenüberliegenden Seiten).

**Rubrik Änderungen**

Enthält weitere Optionen, die für Kommentare jedoch keine Rolle spielen, sondern nur für die Funktion "Änderungen verfolgen" zuständig sind (siehe nächster Abschnitt).
Änderungen an einem Dokument verfolgen

Wenn Sie die Funktion "Änderungen verfolgen" aktivieren, können Sie nach wie vor beliebige Änderungen an einem Dokument vornehmen. Diese Änderungen werden allerdings nicht sofort im Dokument abgelegt, sondern zunächst als farblich hervorgehobene "Änderungswünsche" darin gespeichert.

Anschließend können Sie – oder ein anderer Anwender – jede einzelne dieser Änderungen akzeptieren (worauf sie fest im Dokument gespeichert wird) oder verwerfen (worauf sie verworfen wird).


Das Überarbeiten eines Dokuments mit Hilfe der Funktion "Änderungen verfolgen" erfolgt also in drei Schritten:

- **Schritt 1**: Aktivieren der Funktion "Änderungen verfolgen"
- **Schritt 2**: Durchführen der gewünschten Änderungen
- **Schritt 3**: Akzeptieren/Verwerfen der einzelnen Änderungen

**Tipp: Verwenden der Überarbeitungsleiste**

Am einfachsten gestaltet sich das Überarbeiten von Dokumenten mit Hilfe der Überarbeitungsleiste.

Diese Symbolleiste erscheint automatisch (unter der Formatleiste), wenn das aktuelle Dokument Änderungen enthält, die bei aktivierter Funktion "Änderungen verfolgen" vorgenommen wurden.

Falls die Leiste nicht automatisch angezeigt werden sollte, rufen Sie den Menübefehl Ansicht > Symbolleisten auf und schalten im Dialogfenster dieses Befehls die Symbolleiste Überarbeitung ein.

Die Überarbeitungsleiste verfügt über folgende Schaltflächen (von links nach rechts):

- Die ersten sechs Schaltflächen sind nicht für die Funktion "Änderungen verfolgen" zuständig, sondern dienen zum Arbeiten mit Kommentaren (siehe Abschnitt Kommentare verwenden).
- Änderungen verfolgen ein/aus
- Zur vorherigen Änderung gehen
- Zur nächsten Änderung gehen
- Aktuelle Änderung akzeptieren (und zur nächsten gehen)
- Aktuelle Änderung verwerfen (und zur nächsten gehen)
- Übersicht über alle Änderungen anzeigen
- Anzeigen der Änderungen im Dokument ein/aus

Ausführliche Informationen zu den einzelnen Funktionen erhalten Sie in den nachfolgenden Abschnitten.
Schritt 1: Aktivieren der Funktion Änderungen verfolgen

Um die Funktion "Änderungen verfolgen" zu verwenden, öffnen Sie das Dokument, das Sie überarbeiten möchten und rufen den Menübefehl Weiteres > Änderungen > Änderungen verfolgen auf.

Die Funktion "Änderungen verfolgen" ist nun eingeschaltet. Alle Änderungen, die Sie jetzt am Dokument machen, werden aufgezeichnet.

(Wenn Sie die Funktion "Änderungen verfolgen" nicht mehr benötigen, können Sie sie jederzeit wieder aus- schalten, indem Sie diesen Befehl erneut aufrufen.)

Tipp: Diese Funktion lässt sich auch über das Symbol in der Überarbeitungsleiste ein-/ausschalten.

Schritt 2: Durchführen der gewünschten Änderungen

Anschließend nehmen Sie wie gewohnt die gewünschten Änderungen am Dokument vor. Sie können Text ändern, löschen, hinzufügen, Formatierungen abändern etc.

Das Dokument lässt sich also weiterhin genau so bearbeiten, als ob die Funktion "Änderungen verfolgen" gar nicht existieren würde. Es gibt nur einen entscheidenden Unterschied: Alle Änderungen, die Sie nun durchführen, werden farblich hervorgehoben und wie folgt gekennzeichnet:

- Wenn Sie Text hinzufügen, wird dieser eingefärbt und unterstrichen.
- Wenn Sie Text löschen, wird dieser wird eingefärbt und durchgestrichen.
- Wenn Sie die Formatierung von Text ändern, wird dieser eingefärbt.

Zusätzlich erscheint im Seitenrand neben jeder Änderung ein vertikaler Strich, um nochmals zu signalisieren, dass an dieser Stelle eine Änderung erfolgt ist.

Schritt 3: Akzeptieren/Verwerfen von Änderungen

Wenn alle gewünschten Änderungen durchgeführt wurden, können diese einzeln angenommen oder abgelehnt werden.

Verwenden Sie dazu die eingangs vorgestellte Überarbeitungsleiste:

Diese Symbolleiste erscheint automatisch (unter der Formatleiste), wenn das aktuelle Dokument Änderun- gen enthält, die bei aktivierter Funktion "Änderungen verfolgen" vorgenommen wurden.

Falls die Leiste nicht automatisch angezeigt werden sollte, rufen Sie den Menübefehl Ansicht > Symbolleisten auf und schalten im Dialogfenster dieses Befehls die Symbolleiste Überarbeitung ein.

Die folgenden Symbole der Überarbeitungsleiste sind für das Überarbeiten von Dokumenten zuständig:
Überarbeiten von Dokumenten

Symbol | Funktion
--- | ---

### Änderungen verfolgen ein/aus

Aktiviert/deaktiviert die Funktion "Änderungen verfolgen".

Entspricht dem Menübefehl Weiteres > Änderungen > Änderungen verfolgen.

### Zur vorherigen Änderung gehen

Setzt die Schreibmarke auf die vorherige Änderung.

Entspricht dem Menübefehl Weiteres > Änderungen > Vorherige Änderung.

### Zur nächsten Änderung gehen

Setzt die Schreibmarke auf die nächste Änderung.

Entspricht dem Menübefehl Weiteres > Änderungen > Nächste Änderung.

### Aktuelle Änderung akzeptieren (und zur nächsten gehen)

Beim Klicken auf diese Schaltfläche wird die Änderung, auf der sich die Schreibmarke momentan befindet, akzeptiert – sie wird also fest in das Dokument übernommen. Danach springt TextMaker direkt zur nächsten Änderung.

Beim Klicken auf das Pfeilchen neben der Schaltfläche erscheint hingegen ein Menü mit folgenden Funktionen zur Wahl:

- **Änderung annehmen und zur nächsten gehen**: macht genau das Gleiche wie die Schaltfläche.
- **Aktuelle Änderung annehmen**: macht das Gleiche wie die Schaltfläche, ohne jedoch zur nächsten Änderung zu springen.
- **Alle Änderungen annehmen**: akzeptiert alle Änderungen im gesamten Dokument auf einmal.

### Aktuelle Änderung verwerfen (und zur nächsten gehen)

Funktioniert genau wie die gerade zuvor beschriebene Schaltfläche – nur dass die Änderung hierbei verworfen wird.

### Übersicht über alle Änderungen anzeigen

Öffnet ein Dialogfenster, in dem alle Änderungen aufgelistet sind. Klicken Sie auf eine der gelisteten Änderungen und dann auf die Schaltfläche Akzeptieren oder Verwerfen, um sie anzunehmen beziehungsweise abzulehnen.

Entspricht dem Menübefehl Weiteres > Änderungen > Übersicht über alle Änderungen.

### Anzeigen der Änderungen ein/aus
Überarbeiten von Dokumenten

Schaltet die Option **Änderungen anzeigen** ein-/aus. Ist diese eingeschaltet, erscheinen Änderungen farblich hervorgehoben (wie eingangs beschrieben). Ist sie ausgeschaltet, erscheint das Dokument so, als ob alle Änderungen akzeptiert worden wären.

Entspricht dem Menübefehl *Weiteres > Änderungen > Änderungen anzeigen*.

---

### Einstellungen zur Funktion Änderungen verfolgen

Mit dem Menübefehl *Weiteres > Änderungen > Einstellungen* können Sie diverse Einstellungen zur Funktion "Änderungen verfolgen" vornehmen.

Hinweis: Dieses Dialogfenster können Sie auch aufrufen, indem Sie den Menübefehl *Datei > Eigenschaften* aufrufen und auf die Karteikarte Überarbeiten wechseln.

Folgende Optionen sind verfügbar:

- **Rubriken Kommentare und Kommentarfeld**

  Diese beiden Rubriken sind nicht für die Funktion "Änderungen verfolgen", sondern für das Einfügen von Kommentaren zuständig. Informationen dazu finden Sie im Abschnitt *Kommentare verwenden*.

- **Änderungen verfolgen**

  Schaltet das Verfolgen von Änderungen ein/aus.

  Entspricht dem Symbol 📌 in der Überarbeitungsleiste und dem Menübefehl *Weiteres > Änderungen > Änderungen verfolgen*.

- **Änderungen anzeigen**

  Schaltet die Option **Änderungen anzeigen** ein/aus. Ist diese Option eingeschaltet, erscheinen Änderungen farblich hervorgehoben. Ist sie ausgeschaltet, erscheint das Dokument so, als ob alle Änderungen akzeptiert worden wären.

  Entspricht dem Symbol 📌 in der Überarbeitungsleiste.

- **Änderungen drucken**

  Ist diese Option aktiviert, werden Änderungen nicht nur auf dem Bildschirm, sondern auch im Ausdruck farblich hervorgehoben. Ist sie ausgeschaltet, wird das Dokument so ausgedruckt, als ob alle Änderungen akzeptiert worden wären.

- **Quickinfos anzeigen**

  Ist diese Option aktiviert, werden auf dem Bildschirm automatisch Informationen zu einer Änderung eingeblendet, wenn Sie mit der Maus darauf zeigen (Autor, Datum und Art der Änderung).

- **Eingefügter Text, Gelöschter Text etc.**

  Im unteren Teil des Dialogs lässt sich genau festlegen, wie Änderungen im Dokument dargestellt werden sollen. Sie können hier bestimmen, auf welche Weise Änderungen angezeigt werden sollen, und die Farbe einstellen, mit der die Änderungen hervorgehoben werden sollen.

  Verwenden Sie für die Farben die Standardeinstellung **Nach Autor**, erscheinen je nach Bearbeiter des Dokuments automatisch andere Farben. Nimmt der erste Anwender Änderungen vor, erscheinen diese in rot. Öffnet anschließend ein weiterer Anwender das Dokument und nimmt zusätzliche Änderungen vor, erscheinen diese in blau etc.
*Hinweis:* Damit dies korrekt funktionieren kann, müssen alle Anwender, die das Dokument bearbeiten, in den TextMaker-Einstellungen ihren *Name* angegeben haben. Um Ihren Namen einzutragen, rufen Sie den Menübefehl *Weiteres > Einstellungen* auf, wechseln auf die Karteikarte *Allgemein* und geben mit Hilfe der Schaltfläche *Benutzerdaten* Ihren Namen (oder zumindest Ihre Initialen) ein.
TextMaker ist mit Funktionen zum Bearbeiten von HTML-Dokumenten für das Internet ausgestattet:

- **HTML-Dokument öffnen**
  Internet-Seiten liegen meist im HTML-Format vor. Mit TextMaker können Sie HTML-Dateien direkt öffnen. Rufen Sie dazu den Menübefehl **Datei > Öffnen** auf und wählen in der Liste der Dateitypen das Format **HTML**.

- **HTML-Dokument bearbeiten**
  Der nächste Abschnitt dieses Kapitels behandelt das Bearbeiten von HTML-Dokumenten. Sie lernen hier, welche Funktionen im HTML-Format zulässig sind und wie Sie diese einsetzen.

- **HTML-Dokument speichern**
  Im letzten Abschnitt geht es schließlich um das Speichern des fertigen Dokuments im HTML-Format mit dem Menübefehl **Datei > Speichern unter**. Ausführliche Informationen dazu folgen auf den nächsten Seiten.

### HTML-Dokument öffnen

Internet-Seiten sind meist im Format **HTML (Hypertext Markup Language)** gespeichert. HTML-Dokumente sind an der Namenserweiterung **.htm** oder **.html** zu erkennen. Sie können in TextMaker folgendermaßen geöffnet werden:

1. Rufen Sie den Menübefehl **Datei > Öffnen** auf.
2. Wählen Sie in der Liste der Dateitypen das Format **HTML**.
3. Bestimmen Sie die zu öffnende Datei und bestätigen Sie mit **OK**.

TextMaker öffnet das HTML-Dokument und zeigt es auf dem Bildschirm an.


### HTML-Dokument bearbeiten

Auf den nächsten Seiten erfahren Sie, welche Möglichkeiten beim Bearbeiten von HTML-Dokumenten zur Verfügung stehen und was es dabei zu beachten gibt.
**Seitenformatierung**

Die **Seitenformatierung** ist bei HTML-Dokumenten ohne Bedeutung.

Wenn Sie mit dem Menübefehl **Datei > Seite einrichten** Änderungen am Seitenformat vornehmen, werden diese *nicht* im HTML-Dokument gespeichert.

---

**Grafiken in HTML-Dokumenten**

Zum Einfügen einer Grafik in ein HTML-Dokument verwenden Sie wie gewohnt den Menübefehl **Objekt > Neue Grafik** (siehe Kapitel Grafiken). Sie sollten dabei allerdings folgendes beachten:

- **Die Grafik sollte sich im gleichen Ordner wie das Dokument befinden**

  Die Grafik sollte sich möglichst in dem Ordner befinden, in dem auch das Dokument abgespeichert ist.

  Kopieren Sie die Grafik also vor der Grafikeinbindung von Hand dorthin oder kreuzen Sie im Dialogfenster des Menübefehls **Objekt > Neue Grafik** einfach die Option **In den Ordner des Dokuments kopieren** an, worauf TextMaker das automatisch für Sie erledigt.

- **Die Grafik sollte nicht im Dokument gespeichert werden**

  Weiterhin sollten Sie die Option **Im Dokument speichern nicht** verwenden, denn im HTML-Dokument selbst lassen sich keine Grafiken speichern.

  Das Einbringen von **Grafikrahmen** ist im HTML-Format nicht möglich.

---

**Welches Grafikformat?**

Im Internet werden üblicherweise nur die folgenden Grafikformate verwendet: **GIF**, **JPG** und **PNG**. Diese speichern die Bildinformation *komprimiert* ab und reduzieren dadurch die Dateigröße des Bildes erheblich.

- **Das GIF-Format** eignet sich vor allem für kleinere Grafiken und Schriftzüge mit maximal 256 Farben. Es verwendet eine Komprimierungsmethode, die verlustfrei arbeitet, die Bildqualität also nicht beeinträchtigt.

- **Das JPG-Format** eignet sich vor allem für Fotos oder andere große Bilder in Echtfarben. Die verwendete Komprimierung arbeitet allerdings nicht verlustfrei – je höher die gewählte Komprimierungsrate, desto schlechter die Bildqualität.

- **Das PNG-Format** ist das vielseitigste Grafikformat: Es verfügt über zahlreiche Unterformate mit unterschiedlichen Arten von Komprimierungen – sowohl verlustfreie als auch verlustbehaftete.

Verwenden Sie möglichst nur Grafiken in einem dieser Formate, da andere Grafikformate nicht von allen Browsern unterstützt werden.
Tabellen in HTML-Dokumenten

In HTML-Dokumenten können auch Tabellen zum Einsatz kommen. Verwenden Sie dazu wie gewohnt den Menübefehl Tabelle > Neue Tabelle (siehe Kapitel Tabellen).

Tipp: Mit Tabellen lassen sich anspruchsvolle Formatierungen nachbilden, die das HTML-Format an sich nicht beherrscht. Zweisprachiger Text kann beispielsweise durch eine Tabelle mit einer Zeile und zwei Spalten erreicht werden.

Horizontale Linien

Mit dem Menübefehl Objekt > Neue horizontale Linie können Sie eine waagrechte Linie in den Text einfügen – wenn beispielsweise eine Trennlinie benötigt wird. Dies funktioniert natürlich nicht nur in HTML-Dokumenten, sondern auch in normalen Dokumenten.

Um eine solche Linie einzufügen, setzen Sie die Schreibmarke in die gewünschte Zeile und rufen den Menübefehl Objekt > Neue horizontale Linie auf.

Die Linie wird nun eingefügt. Sie reicht standardmäßig genau vom linken bis zum rechten Rand.

Eigenschaften ändern

Um das Erscheinungsbild der Linie zu verändern, selektieren Sie die Linie, indem Sie diese mit der Maus anklicken, und rufen den Menübefehl Objekt > Eigenschaften auf.

Tipp: Dieser Befehl kann auch durch einen Doppelklick auf die Linie aufgerufen werden.

Es erscheint ein Dialogfenster mit folgenden Optionen:

- **Breite der Linie**
  
  Die Breite von horizontalen Linien wird normalerweise relativ zur Seitenbreite in Prozent angegeben. Standardmäßig ist die Linienbreite auf 100 Prozent gesetzt; die Linie reicht also genau vom linken bis zum rechten Rand. Ändern Sie diese Einstellung beispielsweise auf 50 Prozent, wird die Linie auf die halbe Seitenbreite verkürzt.

  Alternativ können Sie die Option Absolut aktivieren und die gewünschte Breite als festen Wert angeben.

- **Linendiicke**

  Tragen Sie hier die gewünschte Linienstärke in Punkt ein.

- **Ausrichtung**

  Wählen Sie hier, wie die Linie ausgerichtet werden soll: Links (am linken Rand), Zentriert (mittig) oder Rechts (am rechten Rand).

- **Farbe**

  Hier können Sie die Farbe der Linie wählen.
Neben den hier angebotenen Farben können Sie jederzeit neue Farben definieren (siehe Abschnitt Dokumenteigenschaften, Karteikarte Farben).

### 3D-Effekt

Ist diese Option aktiviert, wird die Linie mit einem 3D-Effekt gezeichnet.

Tipp: Bei Linien, die nur 1 pt dick sind, ist dieser kaum zu erkennen. Wenn Sie diesen Effekt verwenden möchten, sollten Sie die Linien dicke also erhöhen.

### Farbe für 3D-Effekt

Hier können Sie die Farbe des 3D-Effekts ändern.

---

### Hyperlinks verwenden

Mit dem Menübefehl **Format > Hyperlink** können Sie Text mit einem *Hyperlink* versehen. Hyperlinks sind Verknüpfungen auf z.B. Webseiten oder andere Dokumente, die sich dann einfach durch Drücken von Strg + linke Maustaste auf diesen Text aufrufen lassen.

Wenn Sie im Text beispielsweise ein Wort mit einem Link auf eine Webseite versehen, wird künftig beim Anklicken dieses Wortes automatisch der Internet-Browser gestartet und diese Seite darin aufgerufen.

Als Ziel für Hyperlinks ist übrigens auch der Dateiname eines anderen Dokuments erlaubt. Dieses wird dann beim Anklicken des Links automatisch geöffnet.

### Hyperlink erstellen

Um einen Hyperlink zu erzeugen, gehen Sie wie folgt vor:

1. Markieren Sie den Text, an den Sie einen Hyperlink anbringen möchten.
2. Rufen Sie den Menübefehl **Format > Hyperlink** auf.

   Für Links auf Internet-Seiten sollte dabei "http://" und die Adresse der Seite eingetragen werden – zum Beispiel "http://www.example.com/index.htm".

5. Bestätigen Sie mit **OK**.

Der Hyperlink wird nun erstellt. Sie erkennen das daran, dass sich die Farbe des Textes ändert, um das Vorhandensein eines Links anzuzeigen.

**Tipp:** Links lassen sich schneller und einfacher erzeugen, wenn die Option **URLs als Hyperlink formatieren** im Dialog des Menübefehls **Weiteres > Einstellungen** (Karteikarte **Bearbeiten**) eingeschaltet ist. Dann können Sie die Zieladresse (zum Beispiel "http://www.example.com/index.htm") nämlich einfach direkt in den Text eintippen und die Leertaste betätigen. TextMaker erkennt, dass Sie eine Internetadresse eingetippt haben, und formatiert diese automatisch als Link.
Springen zu einer bestimmten Textmarke

Im obigen Dialog können Sie bei Bedarf auch die Zielstelle im zu öffnenden Dokument angeben. Tragen Sie dazu bei **Textmarke** die Textmarke ein, zu der gesprungen werden soll.

Beispiel: Tragen Sie bei **Datei oder URL** "Jahresbericht.tmdx" ein und bei **Textmarke** den Namen einer Textmarke in diesem Dokument, wird beim Aufrufen dieses Links die Datei Jahresbericht.tmdx geöffnet und die Schreibmarke darin auf die angegebene Textmarke gesetzt.

Hyperlinks aufrufen

Um einen Hyperlink aufzurufen, klicken Sie die mit dem Hyperlink versehene Textstelle einfach mit Strg + linke Maustaste an. TextMaker öffnet daraufhin das verknüpfte Dokument.

Alternativ können Sie auch die Schreibmarke auf eine beliebige Position innerhalb des Linktextes setzen und dann den Menübefehl **Bearbeiten > Gehe zu Hyperlink** aufrufen.

Hyperlinks bearbeiten oder entfernen

Bestehende Hyperlinks lassen sich wie folgt bearbeiten:

- **Ziel ändern**
  
  Um das Ziel eines Hyperlinks zu ändern, markieren Sie den kompletten Linktext und rufen dann den Menübefehl **Format > Hyperlink** auf. Es erscheint wieder das eingangs beschriebene Dialogfenster, in dem Sie das Ziel für den Link editieren können.

Um einen Hyperlink zu entfernen, gehen Sie wie folgt vor:

- **Linktext samt Hyperlink löschen**
  
  Wenn Sie Text löschen, der einen Hyperlink enthält, wird auch der Link entfernt.

- **Nur den Hyperlink entfernen**
  
  Soll nur der Hyperlink entfernt werden, die damit versehene Textstelle jedoch erhalten bleiben, markieren Sie diese und rufen den Menübefehl **Format > Hyperlink entfernen** auf.

HTML-Dokument speichern

Um ein Dokument im HTML-Format zu speichern, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Datei > Speichern unter** auf.
2. Wählen Sie in der Liste **Dateityp** das Format **HTML**.
3. Tragen Sie bei **Dateiname** ein, unter welchem Namen die Datei gespeichert werden soll, und bestätigen Sie mit **OK**.

Das Dokument wird nun im HTML-Format gespeichert.

**Tipp:** Öffnen Sie das Dokument nach dem Speichern mit Ihrem Internet-Browser, um das endgültige Aussehen zu prüfen.
Ausgeben von Dokumenten

In diesem Kapitel finden Sie alle Informationen darüber, wie Sie Dokumente mit TextMaker ausgeben können.

Das Kapitel enthält folgende Abschnitte:

- **Druckvorschau**
  Im ersten Abschnitt geht es um den Menübefehl **Datei > Druckvorschau**. Dieser stellt das Dokument exakt so auf dem Bildschirm dar, wie es beim Ausdruck erscheinen wird, und erspart so unnötige Probeausdrucke.

- **Drucken eines Dokuments**
  Um das aktuelle Dokument dann tatsächlich auf dem Drucker auszugeben, rufen Sie den Menübefehl **Datei > Drucken** auf.

- **Drucken eines Serienbriefs**
  Serienbriefe – also Dokumente, die an mehrere Adressaten verschickt werden sollen – drucken Sie mit dem Menübefehl **Datei > Serienbriefdruck** aus.

- **Exportieren eines Dokuments als PDF-Datei**
  Sie können ein Dokument auch in eine PDF-Datei ausgeben, indem Sie den Menübefehl **Datei > Als PDF-Dokument exportieren** aufrufen. PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort ein geeignetes Anzeige- oder Ver- schieben eines Dokuments per E-Mail
  Schließlich lassen sich Dokumente auch per E-Mail versenden. Hierfür ist der Menübefehl **Datei > Versenden** zuständig.

Ausführliche Informationen zu obigen Funktionen folgen auf den nächsten Seiten.

**Druckvorschau**

Die **Druckvorschau** gibt ein Dokument exakt so auf dem Bildschirm wieder, wie es im Ausdruck aussehen wird. Dies erspart unnötige Probeausdrucke.
Um die Druckvorschau zu starten, rufen den Menübefehl **Datei > Druckvorschau** auf.

Um sie wieder zu beenden, klicken Sie auf die Schaltfläche **Schließen** in der Symbolleiste oder betätigen die Taste **Esc**.

**Verwenden der Symbolleiste der Druckvorschau**

Die Druckvorschau hat eine eigene Symbolleiste. Diese verfügt über folgende Funktionen (von links nach rechts):

![](images)

Diese Kontrollen dienen zum Blättern im Dokument. Von links nach rechts:

- Zur ersten Seite
- Zur vorherigen Seite
- Zu einer bestimmten Seitennummer. (Tippen Sie dazu in dem kleinen Eingabefeld in der Mitte die Seitennummer ein und drücken Sie dann die **Eingabetaste**.)
- Zur nächsten Seite
- Zur letzten Seite

![](images)

Die nächsten drei Schaltflächen haben folgende Funktionen:

- Die linke Schaltfläche ruft den Menübefehl **Datei > Seite einrichten** auf, mit dem Sie das Seitenformat (Papiergröße, Ausrichtung etc.) festlegen können. Siehe auch Kapitel **Seitenformatierung**.
  Tipp: Der Pfeil rechts neben der Schaltfläche öffnet eine Liste aller verfügbaren Papierformate – damit können Sie blitzschnell eine andere Papiergröße für das Dokument einstellen.

- Die mittlere Schaltfläche ruft den Menübefehl **Datei > Drucken** auf, mit dem Sie das Dokument ausdrucken können. Siehe auch Abschnitt **Drucken eines Dokuments**.

- Die rechte Schaltfläche ruft den Menübefehl **Datei > Als PDF-Dokument exportieren** auf, mit dem Sie aus dem Dokument eine PDF-Datei erzeugen können. Siehe auch Abschnitt **Exportieren eines Dokuments als PDF-Datei**.

![](images)

Hier können Sie die Vergrößerungsstufe festlegen. Tragen Sie dazu in das Eingabefeld den gewünschten Prozentwert ein und drücken Sie die **Eingabetaste**. Oder Sie verwenden die Schaltflächen links davon, mit denen Sie folgende Vergrößerungsstufen einstellen können:
Ausgeben von Dokumenten

- Originalgröße (Vergrößerungsstufe 100%)
- Auf Textbreite anpassen
- Auf Seitenbreite anpassen
- Eine ganze Seite anzeigen
- Zwei ganze Seiten anzeigen
- Lupe aktivieren. (Ziehen Sie anschließend mit der Maus ein Rechteck um die Textstelle auf, die Sie vergrößern möchten.)

Diese Schaltflächen bestimmen, ob in dem Ausdruck auch folgendes ausgegeben werden soll:

- Kommentare
- Hervorhebungen für alle Änderungen am Dokument, die mit der Funktion "Änderungen verfolgen" aufgezeichnet wurden (siehe Kapitel Überarbeiten von Dokumenten)
- Grafiken

Um die Druckvorschau zu beenden, klicken Sie auf die Schaltfläche Schließen oder drücken die Taste Esc.

Drucken eines Dokuments

Um das aktuelle Dokument auszudrucken, rufen Sie den Menübefehl Datei > Drucken auf.

Es erscheint ein Dialogfenster, in dem folgende Einstellungen gemacht werden können:
Ausgeben von Dokumenten

Drucker

Wählen Sie hier, auf welchem der installierten Drucker der Ausdruck erfolgen soll.

Die Schaltfläche Einrichten öffnet ein Fenster zum Einrichten und Konfigurieren von Druckern. Informationen hierzu finden Sie im Handbuch zu Ihrem Drucker.

Linux-Anwender können hier außerdem das Kommando eintragen, das den Druckvorgang einleiten soll.

Seiten

Bestimmen Sie hier, welche Seiten gedruckt werden sollen:

- **Alle**
  Alle Seiten drucken.

- **Markierung**
  Nur den markierten Bereich drucken.

- **Aktuelle Seite**
  Nur die Seite ausdrucken, auf der sich die Schreibmarke gerade befindet.

- **Seiten**
  Nur die angegebenen Seiten drucken. Tragen Sie dazu die gewünschten Seitennummern ein. Einige Beispiele:

  12     Drucke nur Seite 12
  12-15  Drucke die Seiten 12 bis 15
  12-    Drucke alle Seiten ab Seite 12
  -12    Drucke die Seiten 1 bis 12

  Sie auch mehrere solche Seitenangaben eingeben, indem Sie diese durch Kommata trennen:

  2-5, 12 Drucke die Seiten 2 bis 5 und die Seite 12

  etc.

- Außerdem können Sie über die Option Zu druckende Seiten festlegen, ob alle gewählten Seiten oder nur die Seiten mit gerader beziehungsweise ungerader Seitennummer gedruckt werden sollen.

- Bei Seiten pro Blatt können Sie bestimmen, wie viele Seiten auf ein Blatt Papier gedruckt werden sollen. Normalerweise druckt TextMaker pro Blatt nur eine Seite aus; Sie können das Programm aber anweisen, pro Blatt beispielsweise vier (entsprechend verkleinerte) Seiten auf einmal auszugeben.

Optionen

Dieser Bereich enthält zusätzliche Optionen zum Drucken:

- **Exemplare**
  Hier lässt sich einstellen, wie viele Kopien des Dokuments gedruckt werden sollen.
Ausgeben von Dokumenten

- **Kopien sortieren**
  Diese Option bestimmt, ob die Druckausgabe beim Drucken mehrerer Kopien eines Dokuments nach Seitennummern sortiert werden soll.

  Ist die Option eingeschaltet, werden beim Drucken mehrerer Kopien eines z.B. dreiseitigen Dokuments folgende Seiten ausgegeben: 1-2-3, 1-2-3, 1-2-3, ...

  Wird sie ausgeschaltet, ist die Reihenfolge hingegen: 1-1-1..., 2-2-2..., 3-3-3...

  Hinweis: Einige Drucker unterstützen dieses Feature nicht.

- **In Datei drucken**
  Lenkt die Druckausgabe in eine Datei um.

- **Ohne Bilder**
  Überspringt beim Ausdruck alle Grafiken und Zeichnungen (nützlich für schnelle Testausdrucke).

- **Umgekehrte Reihenfolge**
  Druckt erst die letzte zu druckende Seite, dann die vorletzte etc.

  Den Ausdruck starten Sie mit **OK**.

  **Tipp:** Bevor Sie etwas tatsächlich ausdrucken, können Sie den Menübefehl **Datei > Druckvorschau** aufrufen, um eine Vorschau des Ausdrucks auf dem Bildschirm zu erhalten. Dies erspart Ihnen unnötige Probendrucke.

---

**Drucken eines Serienbriefs**

Um einen Serienbrief auszudrucken, gehen Sie folgendermaßen vor:

1. Öffnen oder erstellen Sie einen Serienbrief (siehe Kapitel Serienbriefe).
2. Stellen Sie sicher, dass dem Serienbrief über den Menübefehl **Weiteres > Datenbank zuordnen** eine Datenbank mit den gewünschten Adressen zugewiesen wurde (siehe Abschnitt Dokumenten eine Datenbank zuordnen).
3. Selektieren Sie bei Bedarf die zu druckenden Datensätze in der Datenbank (siehe Abschnitt Datenbank zuordnen).
4. Rufen Sie den Menübefehl **Datei > Serienbriefdruck** auf.
5. Wählen Sie in der Rubrik **Datensätze** aus, welche Datensätze der zugeordneten Datenbank verwendet werden sollen:
   - **Alle** (alle Datensätze der gesamten Datenbank)
   - **Selektierte** (alle Datensätze, die in der Datenbank selektiert wurden)
   - **Bereich** (ein Bereich von Satznummern – hier ist die erste und die letzte Datensatznummer anzugeben.)

  Bestätigen Sie schließlich mit **OK**, um den Ausdruck zu starten.

  Ausführliche Informationen zum Erstellen von Serienbriefen finden Sie im Kapitel Serienbriefe.
Exportieren eines Dokuments als PDF-Datei

Sie können ein Dokument auch in eine PDF-Datei ausgeben.

PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort ein geeignetes Anzeigeprogramm (zum Beispiel der "Adobe Reader") installiert ist. Alle Formatierungen und Objekte (Grafiken etc.) des Dokuments werden dabei originalgetreu wiedergegeben.

Um von einem Dokument eine PDF-Datei zu erzeugen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Datei > Als PDF-Dokument exportieren auf.
2. Es erscheint ein Dialogfenster. Nehmen Sie darin die gewünschten Einstellungen vor (siehe unten) und bestätigen Sie mit OK.
3. Nun erscheint ein weiterer Dialog. Geben Sie darin den Dateinamen an, unter dem die PDF-Datei gespeichert werden soll, und bestätigen Sie mit OK.

Die PDF-Datei wird nun erzeugt. Um sie zu betrachten, starten Sie ein geeignetes Anzeigeprogramm und öffnen die Datei darin.

**Tipp:** Falls auf Ihrem Gerät kein Anzeigeprogramm für PDF-Dokumente installiert ist, suchen Sie mit Ihrem Web-Browser einfach nach "PDF Viewer". Sie werden zahlreiche geeignete Programme finden; viele davon sind kostenlos.

Das Dialogfenster des obigen Befehls erlaubt es Ihnen, folgende Einstellungen zum PDF-Export vorzunehmen:

**Karteikarte Allgemein**

Auf dieser Karteikarte können Sie festlegen, ob nur Teile des Dokuments ausgegeben werden sollen, und weitere Einstellungen machen. Die Optionen entsprechen weitgehend denen des Menübefehls Datei > Drucken, der im Abschnitt Drucken eines Dokuments beschrieben wurde.

Darüber hinaus sind folgende Optionen zusätzlich verfügbar:

- **Inhaltsverzeichnis erstellen**

  Wenn diese Option aktiviert ist, speichert TextMaker in der PDF-Datei automatisch ein Lesezeichen für jede Überschrift, die das Dokument enthält.

  In Ihrem PDF-Betrachter werden diese Lesezeichen dann in einer Leiste links vom Dokument angezeigt. Sie können diese Leiste wie ein interaktives Inhaltsverzeichnis verwenden: Klicken Sie darin einfach auf eine der Überschriften, um zur entsprechenden Stelle im Dokument zu springen.

  **Tipp:** Falls diese Leiste bei Ihrem PDF-Betrachter nicht angezeigt werden sollte, suchen Sie darin nach einem Befehl zum Anzeigen von Lesezeichen und aktivieren Sie diesen.

  **Hinweis:** Dieses Feature funktioniert natürlich nur, wenn Sie das Dokument zuvor mit einer Gliederung (sprich: mit Überschriften) versehen haben. Wie das geht, beschreibt der Abschnitt Gliederungen.
## Interaktives Formular erstellen

Diese Option bestimmt, ob Formularobjekte (Textfelder, Auswahllisten etc.) sowie Textrahmen und Tabellen ausfüllbar sein sollen.

Standardmäßig ist die Option ausgeschaltet. Wird sie eingeschaltet, lassen sich solche Objekte im PDF-Betrachter editieren (sofern die entsprechenden Berechtigungen gesetzt sind – siehe Karteikarte Schutz).

Informationen zum Erstellen von Formularen finden Sie im Kapitel Formulare.

## Tagged PDF erzeugen

Wenn diese Option aktiviert ist, werden in der PDF-Datei auch Informationen über die logische Struktur des Dokuments gespeichert.

Diese Informationen sorgen dafür, dass Ihre PDF-Dateien barrierefrei sind und beispielsweise auch mit Programmen verwendet werden können, die den Inhalt der PDF-Datei in Blindenschrift wiedergeben oder ihn vorlesen.

## Kommentare exportieren

Mit dem Menübefehl Weiteres > Kommentare können Sie Ihr Dokument mit Kommentaren versehen (siehe Abschnitt Kommentare verwenden).

Wenn Sie diese Option einschalten, erscheinen diese Kommentare nicht nur im Originaldokument, sondern werden in ähnlicher Form auch in der PDF-Datei angezeigt.

**Hinweis:** Die Seiten des Dokuments werden dazu in der PDF-Datei etwas verkleinert, um Platz für die Kommentare zu schaffen. Die Seitengröße in der PDF-Datei entspricht dann also nicht mehr der des Originaldokuments.

## Änderungen exportieren

Mit dem Menübefehl Weiteres > Änderungen verfolgen können Sie erreichen, dass alle Änderungen an Ihrem Dokument farblich hervorgehoben und unterstrichen dargestellt werden (siehe Abschnitt Änderungen an einem Dokument verfolgen).

Wenn Sie diese Option einschalten, erscheinen diese Markierungen nicht nur im Originaldokument, sondern werden in ähnlicher Form auch in der PDF-Datei angezeigt.

## Karteikarte Einstellungen

Auf der zweiten Karteikarte können Sie Einstellungen zur Ausgabequalität machen:

### AutoForm-Optionen

Hier lässt sich die Qualitätsstufe (sprich: Auflösung) einstellen, mit der AutoFormen und alle anderen Arten von Zeichnungen exportiert werden. Je höher die Qualitätsstufe, desto größer wird die erzeugte PDF-Datei.

### Grafikoptionen

Hier können Sie festlegen, ob Bilder mit einer verlustfreien Komprimierung oder der verlustbehafteten JPEG-Komprimierung gespeichert werden sollen. Bei der JPEG-Komprimierung lässt sich weiterhin die Qualitätsstufe einstellen.
**Tipp:** Normalerweise sollten Sie hier die verlustfreie Komprimierung wählen, da sie optimale Qualität gewährleistet. Enthält Ihr Dokument allerdings viele Bilder (speziell Fotos), kann dies zu einer sehr großen PDF-Datei führen. In diesem Falle ist die Verwendung der JPEG-Komprimierung zu empfehlen, da diese Fotos erheblich stärker komprimieren kann.

Die Option **Für Transparenzen Alphakanal verwenden** bestimmt, ob für die Darstellung von Transparenzen in Grafiken und Zeichnungen ein "Alphakanal" verwendet werden soll. Normalerweise sehen diese am besten aus, wenn diese Option eingeschaltet ist. Manche PDF-Betrachter stellen Alphakanäle jedoch fehlerhaft dar, weshalb Sie diese Option auch abschalten können.

## Weitere Optionen

**TextMaker-Dokument einbetten:** Speichert eine Kopie des TextMaker-Dokuments innerhalb der PDF-Datei. Sie können diese PDF-Datei dann direkt in TextMaker öffnen, worauf das Programm die TextMaker-Datei daraus extrahiert und anzeigt.

**Die Datei nach dem Export im PDF-Betrachter öffnen:** Startet nach dem Erzeugen der PDF-Datei automatisch Ihren PDF-Betrachter (sofern einer installiert ist) und zeigt die Datei darin an.

**Für Hyperlinks relative Pfade verwenden:** Wandelt den Dateipfad von Verknüpfungen (Hyperlinks) auf Dateien automatisch in einen relativen Pfad (statt eines absoluten Pfads) um. Wenn Sie also beispielsweise einen Link auf die Datei c:\Dokumente\Listen\test.txt eingefügt haben und die PDF-Datei in den Ordner c:\Dokumente exportieren, wird dieser Link automatisch in "Listen\test.txt" umgewandelt.

## Schriftoptionen

Über die Option **Schriften einbetten** können Sie festlegen, ob die im Dokument verwendeten Schriften in die PDF-Datei eingebettet werden sollen.

Ist das Einbetten von Schriften eingeschaltet, wird die erzeugte PDF-Datei auf *jedem* Computer in den ursprünglich verwendeten Schriften angezeigt – auch wenn diese Schriften dort nicht installiert sind. Ist die Option hingegen ausgeschaltet, wird die PDF-Datei mit automatisch gewählten Ersatzschriften dargestellt.

Die Option **Nur verwendete Zeichen einbetten** bestimmt, ob beim Einbetten von Schriften jeweils alle Zeichen einer Schrift oder nur die tatsächlich im Dokument vorkommenden Zeichen eingebettet werden sollen. Das Einschalten dieser Option hat den Vorteil, dass die Dateigröße der PDF-Datei nicht so stark anwächst.

### Karteikarte Ansicht

Diese Karteikarte enthält erweiterte Optionen zur Darstellung der PDF-Datei in einem PDF-Betrachter:

**Navigationsfenster**

Bestimmt, was im Navigationsfenster des PDF-Betrachters angezeigt werden soll. (Das Navigationsfenster ist die Leiste, die links von der PDF-Datei angezeigt wird.)

Verfügbare Optionen:

**Standard:** Standardeinstellung des PDF-Betrachters verwenden

**Keine Navigation:** Im Navigationsfenster nichts anzeigen

**Lesezeichen:** Im Navigationsfenster alle Lesezeichen des Dokuments anzeigen

**Miniaturseiten:** Im Navigationsfenster Miniaturansichten aller Seiten des Dokuments anzeigen
- **Vergrößerungsstufe**
  Bestimmt, mit welcher Vergrößerungsstufe (Zoom) die PDF-Datei angezeigt werden soll:
  
  **Standard:** Standardeinstellung des PDF-Betrachters verwenden
  **Ganze Seite:** Vergrößerungsstufe so einstellen, dass die gesamte Seite zu sehen ist
  **Seitenbreite:** Auf die Seitenbreite zoomen
  **Seitenhöhe:** Auf die Seitenhöhe zoomen
  **Benutzerdefiniert:** Eigene Vergrößerungsstufe in Prozent festlegen

- **Seitenlayout**
  Bestimmt, mit welchem Layout die Seiten dargestellt werden sollen:
  
  **Standard:** Standardeinstellung des PDF-Betrachters verwenden
  **Einzelne Seiten:** Als einzelne Seiten anzeigen
  **Doppelseiten - ungerade Seiten links:** Als Doppelseiten anzeigen (mit den ungeraden Seiten auf der linken Seite)
  **Doppelseiten - ungerade Seiten rechts:** Als Doppelseiten anzeigen (mit den ungeraden Seiten auf der rechten Seite)

- **Weitere Einstellungen**
  Hier finden Sie folgende zusätzliche Optionen:
  
  **Dokumententitel anzeigen:** Zeigt in der Titelleiste des PDF-Betrachters den Titel des Dokuments (statt seines Dateinamens) an. Tipp: Den Titel können Sie auf der Karteikarte *Infos* im Dialogfenster des Menübefehls *Datei > Eigenschaften* eintragen.
  
  **PDF-Betrachter auf Bildschirm zentrieren:** Zentriert das Programmfenster des PDF-Betrachters nach dem Öffnen der PDF-Datei automatisch in der Bildschirmmitte.
  
  **Vollbildmodus:** Schaltet den PDF-Betrachter nach dem Öffnen der PDF-Datei automatisch in den Vollbildmodus.
  
  **Menüleiste verbergen:** Blendet die Menüleiste des PDF-Betrachters aus.
  
  **Symbolleisten verbergen:** Blendet sämtliche Symbolleisten des PDF-Betrachters aus.
  
  **Steuerelemente verbergen:** Blendet die Steuerelemente für das Navigationsfenster aus.

**Karteikarte Schutz**

Mit Hilfe dieser Karteikarte können Sie die zu erzeugende PDF-Datei verschlüsseln und mit einem Kennwort vor dem Öffnen oder Abändern durch Unberechtigte schützen.

- **Art der Verschlüsselung**
  Hier können Sie bestimmen, ob die PDF-Datei verschlüsselt werden soll. Neben einer 40 Bit-Verschlüsselung, die mit relativ wenig Zeitaufwand zu knacken ist, ist auch die erheblich sicherere 128 Bit-Verschlüsselung verfügbar.

  **Hinweis:** Die anderen Optionen in diesem Dialog werden erst verfügbar, wenn Sie eine Verschlüsselungsart ausgewählt haben.
- **Kennwort zum Öffnen des Dokuments**

  Wenn Sie hier ein Kennwort eingeben, fragt der PDF-Betrachter beim Öffnen der PDF-Datei nach diesem Kennwort. Wird ein falsches Kennwort eingegeben, kann der Anwender die Datei nicht öffnen.

  Wenn Sie nichts eingeben, kann jedermann die Datei ohne Kennwort öffnen.

- **Kennwort zum Setzen von Zugriffsrechten**

  Des Weiteren können Sie die Zugriffsrechte für die PDF-Datei einschränken. Geben Sie dazu ein Kennwort für das Ändern der Rechte ein. Legen Sie dann mit Hilfe der Optionen im Bereich **Zugriffsrechte** fest, welche Rechte Anwender haben sollen.

  Hintergrundinformation: Manche PDF-Betrachter verfügen über einen Befehl zum Ändern der Zugriffsrechte. Ruft ein Anwender diesen Befehl auf, darf er nur fortfahren, wenn er das Kennwort eingibt, das Sie hier festgelegt haben.

- **Zugriffsrechte**

  Hier können Sie bestimmen, welche Zugriffsrechte Anwender auf die PDF-Datei haben sollen, wenn sie diese in einem PDF-Betrachter öffnen. (Nur verfügbar, wenn Sie oben ein Kennwort für das Setzen von Zugriffsrechten eingegeben haben.)

---

**Exportieren eines Dokuments als EPUB-Datei**

Als Alternative zum PDF-Format können Sie Dokumente auch im EPUB-Format exportieren.


Im Gegensatz zum PDF-Format, welches das Dokument völlig originalgetreu abbildet, kann die Formatierung einer EPUB-Datei vom Originaldokument deutlich abweichen. Das ist auch so beabsichtigt: Bei E-Books regelt nämlich der E-Book-Reader den Textfluss selbst und sorgt dafür, dass dieser optimal an die Displaygröße des verwendeten Geräts angepasst wird.

Um ein Dokument in eine EPUB-Datei zu exportieren, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Datei > Als EPUB-Dokument exportieren** auf.
2. Es erscheint ein Dialogfenster. Nehmen Sie darin die gewünschten Einstellungen vor (siehe unten) und bestätigen Sie mit **OK**.
3. Nun erscheint ein weiterer Dialog. Geben Sie darin den Dateinamen an, unter dem die EPUB-Datei gespeichert werden soll, und bestätigen Sie mit **OK**.

Die EPUB-Datei wird nun erzeugt. Um sie zu betrachten, starten Sie ein geeignetes Anzeigeprogramm und öffnen die Datei darin.

**Tipp:** Falls auf Ihrem Gerät kein Anzeigeprogramm für EPUB-Dokumente installiert ist, suchen Sie mit Ihrem Web-Browser einfach nach "EPUB Reader". Sie werden zahlreiche geeignete Programme finden; viele davon sind kostenlos.

Das Dialogfenster des obigen Befehls erlaubt es Ihnen dabei, folgende Einstellungen zum EPUB-Export vorzunehmen:
Karteikarte Allgemein

Auf dieser Karteikarte können Sie die Dokumentinfos und zusätzliche Informationen zum aktuellen Dokument eintragen und weitere Einstellungen machen.

Verfügbare Optionen:

- **Titel, Autor, Thema, Schlüsselwörter, Beschreibung**
  
  Hier können Sie die Dokumentinfos für das Dokument ändern, also den Titel, den Autor etc. eintragen. Wenn Sie vorhaben, die erzeugte EPUB-Datei zu veröffentlichen, sollten Sie diese Felder unbedingt ausfüllen.

  Anmerkung: Sie können diese Felder alternativ auch über die Karteikarte Infos im Dialogfenster des Menübefehls Datei > Eigenschaften ändern.

- **Sprache, ISBN, UUID, Veröffentlichungsdatum, Herausgeber, Copyrightvermerk**
  
  Hier können Sie zusätzliche Informationen zu dem Dokument eintragen. Wenn Sie vorhaben, die erzeugte EPUB-Datei zu veröffentlichen, sollten Sie auch diese Felder unbedingt ausfüllen.

  Die UUID ist eine eindeutige Nummer, die zum Identifizieren eines Dokuments verwendet werden kann. Ein Klick auf die Schaltfläche Neu generiert eine neue, zufällige UUID. (Technisch gesehen sind UUIDs eigentlich gar nicht eindeutig – aufgrund Ihrer schierenden Länge ist allerdings die Wahrscheinlichkeit, versehentlich eine bereits vergebene UUID zu generieren, nahezu Null.)

  Beachten Sie: Nach dem Veröffentlichen eines Dokuments sollte die UUID nicht mehr geändert werden – es sei denn, Sie möchten eine neue Revision herausgeben.


- **Titelblatt**
  
  Aktivieren Sie die Option Titelblatt erstellen, wenn Sie der EPUB-Datei eine Titelseite in Form einer Grafikdatei hinzufügen wollen. Die meisten EPUB-Reader zeigen diese Grafik dann nicht nur als Titelseite im Dokument selbst an, sondern verwenden sie auch als Vorschaubild für das Dokument (z.B. in der "Bibliothek" des Benutzers).

  Um die gewünschte Grafik auszuwählen, klicken Sie auf die drei Punkte neben dem Eingabefeld unter dieser Option. Dies öffnet einen entsprechenden Dateidialog.

  Darunter können Sie auf Wunsch noch die Hintergrundfarbe für das Titelblatt ändern.

- **Inhaltsverzeichnis**
  
  Wenn die Option Inhaltsverzeichnis erstellen aktiviert ist, speichert TextMaker in der EPUB-Datei automatisch ein Lesezeichen für jede Überschrift, die das Dokument enthält.


  Tipp: Falls diese Leiste bei Ihrem Reader nicht angezeigt werden sollte, suchen Sie darin nach einem Befehl zum Anzeigen von Lesezeichen oder des Inhaltsverzeichnisses und aktivieren Sie diesen.
Ausgeben von Dokumenten

**Hinweis:** Dieses Feature funktioniert natürlich nur, wenn Sie das Dokument zuvor mit einer Gliederung (sprich: mit Überschriften) versehen haben. Wie das geht, beschreibt der Abschnitt Gliederungen.

### Karteikarte Einstellungen

Auf der zweiten Karteikarte können Sie Einstellungen zur Ausgabe der EPUB-Datei machen:

- **Grafikoptionen**

  Hier können Sie festlegen, ob Bilder mit einer **verlustfreien Komprimierung** oder der **verlustbehafteten JPEG-Komprimierung** gespeichert werden sollen. Bei der JPEG-Komprimierung lässt sich weiterhin die Qualitätsstufe einstellen.

  **Tipp:** Normalerweise sollten Sie hier die verlustfreie Komprimierung wählen, da sie optimale Qualität gewährleistet. Enthält Ihr Dokument allerdings viele Bilder (speziell Fotos), kann dies zu einer sehr großen EPUB-Datei führen. In diesem Falle ist die Verwendung der JPEG-Komprimierung zu empfehlen, da diese Fotos erheblich stärker komprimieren kann.

- **EPUB-Text aufteilen**

  Beim Exportieren von Dokumenten mit viel Text ist es ratsam, TextMaker diesen Text in mehrere kleine "Häppchen" aufteilen zu lassen. Andernfalls könnten manche leistungsschwache EPUB-Reader daran scheitern, das Dokument zu verarbeiten.

  Normalerweise sollte diese Option also stets eingeschaltet sein. TextMaker teilt den Text dann beim Exportieren in Segmente von ca. 100 KByte Größe auf. Damit sollten alle EPUB-Reader zurechtkommen.

  An der Anzeige ändert sich dabei nichts – EPUB-Reader stellen auch solche Dateien wie ein einziges durchgehendes Dokument dar.

- **Schriftoptionen**

  Über die Option **Schriften einbetten** können Sie festlegen, ob die im Dokument verwendeten Schriftarten in die EPUB-Datei eingebettet werden sollen.

  Normalerweise ist dies **nicht** sinnvoll, da die meisten EPUB-Reader das Dokument ohnehin nur in ihren eigenen, eingebauten Schriftarten anzeigen.


  Beachten Sie: Die resultierende EPUB-Datei kann dadurch erheblich größer werden.

  **Hinweis:** Beachten Sie außerdem die Lizenzbestimmungen des Herstellers der Schriften. Bei den meisten kommerziellen Schriftpaketen ist das Einbetten der Schriften in EPUB-Dateien **nicht** (oder nur gegen Zahlung eines Aufpreises) erlaubt.

- **CSS-Optionen**

  EPUB-Dateien enthalten für gewöhnlich auch eine CSS-Datei. In dieser sind sämtliche Formatvorlagen gespeichert, die Sie in Ihrem Dokument verwenden. Diese CSS-Datei wird von TextMaker automatisch generiert; Sie müssen sich also nicht darum kümmern.
Falls Sie manuell eine eigene CSS-Datei angelegt haben, können Sie alternativ diese statt der automatics genannten verwenden. Aktivieren Sie dazu die Option Benutzerdefiniertes CSS anhängen. Klicken Sie dann auf die drei Punkte neben dem Eingabefeld unterhalb dieser Option. Dies öffnet einen Dateidialog, in dem Sie die gewünschte Datei auswählen können.

Hinweis: Nicht alle EPUB-Reader unterstützen die Verwendung einer eigenen CSS-Datei.

- Weitere Optionen

  **Die Datei nach dem Export in einem EPUB-Betrachter öffnen:** Startet nach dem Erzeugen der EPUB-Datei automatisch Ihren EPUB-Betrachter (sofern einer auf Ihrem Gerät installiert ist) und zeigt die Datei darin an.

---

**Versenden eines Dokuments per E-Mail**

Sofern auf Ihrem Gerät ein geeignetes E-Mail-Programm installiert ist, können Sie Dokumente direkt von TextMaker aus per E-Mail versenden.

Gehen Sie dazu wie folgt vor:

1. Erstellen oder öffnen Sie das zu versendende Dokument.
3. Wählen Sie das Format, in dem das Dokument verschickt werden soll.

   Hinweis: Wenn Sie hier das Format TextMaker-Dokument auswählen, erhält der Empfänger eine E-Mail mit der TextMaker-Datei als Anhang. Um diesen Anhang öffnen zu können, muss er also ebenfalls TextMaker installiert haben.

TextMaker erzeugt nun eine E-Mail mit dem Dokument als Anhang und übergibt diese Ihrem E-Mail-Programm.
Dokumentverwaltung

TextMaker verfügt über Funktionen, die es Ihnen erleichtern, Ihre Dokumente zu verwalten und schneller auf sie zuzugreifen:

- **Schnellwahlpfade**
  
  Sie können in TextMaker *Schnellwahlpfade* anlegen, um beim Öffnen oder Speichern von Dateien blitzschnell in häufig verwendete Ordner wechseln zu können.

- **Dokumentinfos**
  
  In jedem Dokument können Sie *Dokumentinfos* ablegen, die sich über die Karteikarte *Infos* im Dialogfenster des Menübefehls *Datei > Eigenschaften* anzeigen und bearbeiten lassen. Sie können Titel, Thema und Autor des Dokuments eintragen, Schlüsselwörter für die Suchfunktion des Dateimanagers angeben und eine kurze Inhaltsangabe verfassen.

- **Dateimanager**
  
  Mit dem integrierten Dateimanager können Sie bequem auf Ihre Dokumente zugreifen. Sie sehen darin die Namen und Dokumentinfos aller Dokumente auf einen Blick und können Dokumente auf Knopfdruck betrachten, öffnen, ausdrucken oder löschen. Die Suchfunktion lässt Sie Ihre Dokumente nicht nur anhand des Dateinamens finden, sondern erlaubt auch die Suche nach Thema, Titel, Autor etc.

- **Sicherungskopien**
  

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten.

**Schnellwahlpfade**

Sie können in TextMaker bis zu zwanzig *Schnellwahlpfade* anlegen, um beim Öffnen oder Speichern von Dateien blitzschnell in einen bestimmten Ordner wechseln zu können.

Ein Schnellwahlpfad ist eine symbolische Angabe wie "Briefe an das Finanzamt", die für einen bestimmten Ordner auf der Festplatte steht (zum Beispiel den Ordner *c:\briefe\finanz*).

Wenn Sie einen Brief aus diesem Ordner öffnen möchten, brauchen Sie im Dialogfenster des Menübefehls *Datei > Öffnen* nur auf die Schaltfläche *Schnellwahlpfad* zu klicken und diesen Schnellwahlpfad auszuwählen. Der Dialog wechselt dann sofort in den Ordner *c:\briefe\finanz*.

Schnellwahlpfade stehen nicht nur im Dialogfenster des Befehls *Öffnen* zur Verfügung, sondern in allen Dialogfenstern, die zum Öffnen oder Speichern von Dateien dienen.

Ausführliche Informationen zum Verwenden von Schnellwahlpfaden finden Sie auf den nächsten Seiten.
**Schnellwahlpfade anlegen**

Um einen neuen Schnellwahlpfad anzulegen, gehen Sie wie folgt vor:

1. Rufen Sie einen beliebigen Dateidialog auf (zum Beispiel mit dem Menübefehl **Datei > Öffnen**).
2. Klicken Sie auf die Schaltfläche **Schnellwahlpfad**.
3. Es öffnet sich ein Menü unter der Schaltfläche. Wählen Sie darin die Funktion **Schnellwahlpfad neu anlegen**.
4. Tragen Sie bei **Name** einen beliebigen Namen für den Schnellwahlpfad ein – zum Beispiel "Briefe an das Finanzamt".
5. Tragen Sie bei **Pfad** den gewünschten Ordner ein – zum Beispiel "c:\briefe\finanz".

**Tipp:** Sie können auch auf die drei Punkte neben diesem Eingabefeld klicken. Dies öffnet einen Dateidialog, in dem Sie den gewünschten Ordner bequem auswählen können.

6. Bestätigen Sie mit **OK**.

TextMaker weiß nun, dass der Schnellwahlpfad "Briefe an das Finanzamt" in den Ordner `c:\briefe\finanz` wechseln soll.

**Schnellwahlpfade mit Dateimasken:** Sie können nicht nur reine Pfadangaben wie "c:\briefe\finanz" machen, sondern zusätzlich auch eine Dateimaske angeben. Legen Sie zum Beispiel einen Schnellwahlpfad auf "c:\briefe\finanz\2018*.\*" an, wird damit in den Ordner `c:\briefe\finanz` gewechselt und darin alle Dateien angezeigt, die mit "2018" beginnen.

**Kennbuchstaben:** Im Namen für Schnellwahlpfade kann das &-Zeichen verwendet werden, um dem Pfad einen Kennbuchstaben zu geben. Wird als Name beispielsweise "&Briefe" eingetragen, kann der Pfad in der geöffneten Liste der Schnellwahlpfade durch Drücken der Taste **B** aufgerufen werden.

---

**Verwenden von Schnellwahlpfaden**

Schnellwahlpfade stehen in allen Dateidialogen zur Verfügung – zum Beispiel in den Dialogen der Menübefehle **Datei > Öffnen** oder **Objekt > Neue Grafik**.

Um einen Schnellwahlpfad einzusetzen, gehen Sie wie folgt vor:

1. Klicken Sie in einem Dateidialog auf die Schaltfläche **Schnellwahlpfad**.
2. Es öffnet sich ein Menü mit allen bisher eingerichteten Schnellwahlpfaden. Wählen Sie den gewünschten Schnellwahlpfad aus.

TextMaker wechselt nun in den im Schnellwahlpfad festgelegten Ordner.
Schnellwahlpfade bearbeiten und löschen

Um einen vorhandenen Schnellwahlpfad zu bearbeiten oder ihn zu entfernen, gehen Sie wie folgt vor:

1. Klicken Sie in einem Dateidialog auf die Schaltfläche **Schnellwahlpfad**.
2. Es öffnet sich ein Menü. Wählen Sie darin den Befehl **Schnellwahlpfade ändern**.
3. Es erscheint ein Dialogfenster. Selektieren Sie darin den gewünschten Schnellwahlpfad.
Dokumentinfos

Über den Menübefehl **Datei > Eigenschaften** lassen sich nicht nur dokumentspezifische Einstellungen vornehmen, sondern auch die **Dokumentinfos** eintragen.

**Dokumentinfos** sind Zusatzinformationen (wie Thema, Autor, Schlüsselwörter etc.) zu einem Dokument. Um diese einzusehen oder sie zu bearbeiten, rufen Sie den Menübefehl **Datei > Eigenschaften** auf und wechseln auf die Karteikarte **Infos**.

Nehmen Sie die gewünschten Eintragungen vor und bestätigen Sie mit **OK**.

**Tipp:** Im Dateimanager (siehe nächster Abschnitt) können Sie Dokumente nach den Dokumentinfos durchsuchen lassen, um beispielsweise alle Dokumente zu einem bestimmten Thema zu finden.

**Beim Speichern automatisch nach Dokumentinfo fragen:** Auf Wunsch bittet Sie TextMaker bei jedem neuen Dokument automatisch um das Ausfüllen der Dokumentinfos. Rufen Sie dazu den Menübefehl **Weiteres > Einstellungen** auf, wählen Sie die Karteikarte **Dateien** und schalten Sie die Option **Beim Speichern nach Dokumentinfo fragen** ein. Es erscheint nun jedes Mal, wenn Sie ein neues Dokument zum ersten Mal speichern, das Dialogfenster zur Eingabe der Dokumentinfos.
Dateimanager

Der Dateimanager zeigt eine Liste von Dokumenten aus einem oder mehreren Ordnern an und lässt Sie diese per Mausklick öffnen, drucken, löschen oder ansehen.

Sie starten den Dateimanager mit dem Menübefehl **Datei > Dateimanager**.

Mit der Maus können Sie das Fenster des Dateimanagers jederzeit verschieben und es größer oder kleiner ziehen. Außerdem können Sie die Spaltenbreiten durch Ziehen an den Trennlinien zwischen den Spaltenüberschriften ändern.

Durch Klicken auf eine der Spaltenüberschriften können Sie bestimmen, nach welcher Spalte die Dateien sortiert werden sollen.

Über die Schaltfläche **Suchen** können Sie in einen anderen Ordner wechseln. Weiterhin erlaubt die **Suchfunktionen**, die sich hinter dieser Schaltfläche verbirgt, auch die Suche innerhalb der **Dokumentinfos**, so dass Sie nach einem bestimmten Titel, Thema, Autor, Schlagwort etc. suchen können.

Um eine Aktion mit einer Datei durchzuführen, selektieren Sie diese und klicken dann auf eine der Schaltflächen. Deren genaue Funktionen sind im nächsten Abschnitt beschrieben.

Schaltflächen im Dateimanager

Die Schaltflächen im Dateimanager haben folgende Funktionen:

- **Öffnen**

  Klicken Sie auf diese Schaltfläche, öffnet TextMaker die selektierte Datei.

  **Tipp:** Sie können alternativ auch einen Doppelklick auf einen Dateinamen ausführen, um die Datei zu öffnen.
Schließen
Diese Schaltfläche beendet den Dateimanager.

Suchen
Klicken Sie diese Schaltfläche an, um nach bestimmten Dateien zu suchen oder einfach nur den Ordner auszuwählen, der im Dateimanager angezeigt werden soll. Ausführliche Informationen zum Thema Suchen mit dem Dateimanager finden Sie im nächsten Abschnitt.

Ausgabe
Verwenden Sie diese Schaltfläche, um das selektierte Dokument auszugeben. Es öffnet sich dazu ein kleines Menü, das folgende Funktionen enthalten kann (abhängig vom verwendeten Betriebssystem):

E-Mail: Dokument per E-Mail versenden
Drucken: Dokument ausdrucken
Serienbriefdruck: Dokument als Serienbrief ausdrucken

Umbenennen
Klicken Sie diese Schaltfläche an, können Sie die selektierte Datei umbenennen.

Löschen
Klicken Sie diese Schaltfläche an, wird die selektierte Datei (nach Rückfrage) gelöscht.

Vorschau
Ein Mausklick auf diese Schaltfläche öffnet ein Fenster, in dem Sie das selektierte Dokument betrachten können, ohne es dazu öffnen zu müssen.

Um dieses Dokument dann tatsächlich zu öffnen, klicken Sie auf die Schaltfläche Öffnen in der Vorschau. Um das Vorschaufenster hingegen zu verlassen, betätigen Sie die Schaltfläche Abbrechen.

Suchen mit dem Dateimanager
Mit Hilfe der Schaltfläche Suchen im Dateimanager können Sie TextMaker nach bestimmten Dateien suchen lassen – oder einfach nur den Ordner wählen, der im Dateimanager angezeigt werden soll.


Mit dem oben abgebildeten Dialogfenster steuern Sie die Suchfunktion:

- **Dateiname**
  
  Mit Hilfe dieses Eingabefelds können Sie nach bestimmten Dateien suchen.

  Wenn Sie hier nichts eintragen (also die Vorgabe übernehmen), findet die Suchfunktion alle Dokumente des gewählten Dateityps im gewählten Ordner.

  Wenn Sie einen eindeutigen Dateinamen wie Mahnung.tmdx eintippen, werden nur Dokumente mit exakt diesem Namen gefunden.

  Wenn Sie einen mehrdeutigen Dateinamen wie Mahn*.tmdx eintippen, findet die Suche alle TextMaker-Dokumente, deren Dateiname mit "Mahn" beginnt.

- **Dateityp**
  

- **Titel, Thema, Autor etc.**
  
  Durch Eingaben in diese Felder können Sie die Dokumentinfos (siehe Abschnitt Dokumentinfos) Ihrer Dokumente durchsuchen lassen.

  Wenn Sie mehrere Felder ausfüllen, sucht TextMaker nach Dokumenten in denen alle diese Bedingungen zutreffen. Tragen Sie beispielsweise bei Schlüsselwörter "Steuer" und bei Autor "Schmidt" ein, werden nur Dokumente gefunden, bei denen die entsprechenden Felder der Dokumentinfos diese Texte enthalten.

  Sie können auch nur Teile des gesuchten Begriffs angeben. Haben Sie also beim Feld Schlüsselwörter den Suchbegriff "Steuer" eingetippt, werden alle Dokumente gefunden, bei denen die Schlüsselwörter den Begriff "Steuer" enthält – "Steuererhöhung" wird also genauso gefunden wie "Meine Steuererklärung".

  Groß/Kleinschreibung spielt dabei keine Rolle – wenn der Suchbegriff "steuer" lautet, werden also auch Dokumente mit dem Schlüsselwort "Steuer" gefunden.

- **Ordner**
  
  Hier können Sie wählen, in welchem Ordner TextMaker die Suche durchführen soll.

- **Untergeordnete Ordner einbeziehen**
  
  Ist dieser Schalter aktiviert, durchsucht TextMaker nicht nur den gewählten Ordner, sondern auch alle ihm untergeordneten Ordner.

- **Schaltfläche "Neue Dateiliste"**
  
  Startet eine neue Suche mit den aktuellen Einstellungen.
Dokumentverwaltung

- **Schaltfläche "Liste ergänzen"**
  Hier wird ebenfalls mit der Suche begonnen – mit dem Unterschied, dass die Liste der bei der letzten Suche gefundenen Dateien nicht zuvor geleert wird.

---

**Sicherungskopien**

*Hinweis:*
Dieses Feature ist in der **Android**-Version nicht verfügbar. Unter Android werden lediglich **einfache Sicherungskopien** unterstützt (Option **Backupdateien erzeugen** in den Einstellungen).

TextMaker legt auf Wunsch bei jedem Speichervorgang automatisch eine **Sicherungskopie** mit der vorherigen Version des Dokuments an. Sie können das Programm sogar anweisen, mehrere Generationen von Sicherungskopien aufzuheben.

Die Einstellungen dazu finden Sie im Dialog des Menübefehls **Weiteres > Einstellungen**, Karteikarte **Dateien**. In der aufklappbaren Liste unter **Sicherungskopien** können Sie wählen, ob und wie Sicherungskopien angelegt werden sollen:

- **Keine Sicherungskopien**
  Wenn Sie diese Option wählen, werden **keine** Sicherungskopien beim Speichern von Dokumenten angelegt. (Nicht empfohlen.)

- **Einfache Sicherungskopien**
  Hier wird pro Dokument genau **eine** Sicherungskopie angelegt. Diese enthält die vorherige Version des Dokuments. Sie hat die Namenserweiterung **.bak** und befindet sich im gleichen Ordner wie das Dokument selbst.

  Im Detail passiert hierbei folgendes: Wenn Sie beispielsweise ein Dokument namens **brief.tmdx** speichern, wird zunächst die vorhandene Datei **brief.tmdx** in **brief.bak** umbenannt. Erst dann wird das Dokument **brief.tmdx** gespeichert.

  (Diese Option entspricht dem Kontrollkästchen **BAK-Dateien anlegen** in früheren Versionen von SoftMaker Office.)

- **Fortgeschrittene Sicherungskopien**
  Hier werden **mehrere** Generationen von Sicherungskopien für jedes Dokument angelegt. Diese werden allesamt in einem speziellen **Backup**-Ordner gespeichert.

  Tipp: Wenn diese Option gewählt ist, steht außerdem der Menübefehl **Datei > Zurück zu vorheriger Version** zur Verfügung, mit dem Sie bequem zu einer früheren Version des derzeit geöffneten Doku-
mments zurückkehren können (siehe unten).

  Zusätzliche Optionen:
  
  **Verzeichnis für Sicherungskopien:** Hier können Sie den Pfad für den **Backup**-Ordner ändern, in dem alle Sicherungskopien abgelegt werden.

  **Anzahl der Sicherungskopien pro Dokument:** Hier können Sie bestimmen, wie viele Sicherungskopien (= Generationen) maximal pro Dokument aufgehoben werden sollen.

  **Schaltfläche "Bereinigen":** Bietet die folgenden zwei Befehle zum Löschen von Sicherungskopien:
Verwaiste Sicherungskopien löschen entfernt alle Sicherungskopien, bei denen das zugehörige Originaldokument nicht mehr existiert.

Alle Sicherungskopien löschen entfernt sämtliche Sicherungskopien im Verzeichnis für Sicherungskopien.

**Wie verwende ich den Befehl "Datei > Zurück zu vorheriger Version"?**

Wenn Sie die Option **Fortgeschrittene Sicherungskopien** verwenden (siehe oben), landen alle Sicherungskopien in einem speziellen **Backup-Ordner**. Dieser wird vom Programm automatisch verwaltet. Es wird **nicht** empfohlen, die Dateien in diesem Ordner manuell zu verschieben oder umzubenennen.

Um zu einer vorherigen Version eines Dokuments zurückzukehren, muss Sie dieser Ordner auch überhaupt nicht interessieren – denn es gibt hierfür einen eigenen Menübefehl: **Datei > Zurück zu vorheriger Version**.

Mit diesem Befehl können Sie folgendermaßen zu einer vorherigen Version eines Dokuments zurückkehren:

1. Öffnen Sie das gewünschte Dokument (falls es nicht bereits geöffnet ist).
2. Rufen Sie den Menübefehl **Datei > Zurück zu vorheriger Version** auf.
3. Es erscheint ein Dialog, der alle verfügbaren Sicherungskopien für das aktuelle Dokument auflistet. Finden Sie anhand der Zeitangaben die Version, die Sie wiederherstellen möchten, und wählen Sie diese aus.


**Was aber mache ich, wenn ich die Originaldatei verloren habe?**

Wenn die Originaldatei für ein Dokument einmal verlorengegangen sein sollte, weil sie beispielsweise gelöscht wurde, funktioniert die oben beschriebene Vorgehensweise nicht. Was nun?

Auch in diesem Fall können Sie noch immer auf die Sicherungskopien für das Dokument zugreifen (sofern diese natürlich nicht ebenfalls gelöscht wurden). Öffnen Sie dazu einfach die Sicherungskopie selbst.

Wo sich die Sicherungskopien befinden, können Sie im Dialog des Menübefehls **Weiteres > Einstellungen** auf der Karteikarte **Dateien** nachsehen. Der Ordner ist dort bei **Verzeichnis für Sicherungskopien** eingetragen. Standardmäßig ist dies ein Ordner namens **Backup** unterhalb des **SoftMaker**-Ordners in Ihrem Dokument-Ordner.

Die Sicherungskopien in diesem Ordner lassen sich direkt in TextMaker öffnen. Gehen Sie dazu beispielsweise wie folgt vor:

1. Navigieren Sie im Windows-Explorer zu dem **Backup**-Ordner (siehe oben).
2. Suchen Sie in diesem Ordner nach Dateien, deren Name mit dem Namen der Originaldatei beginnt. Eine Sicherungskopie für die Datei Test.tmdx kann beispielsweise Test.tmdx.135.tmbak heißen. (Es wird an den Dateinamen also immer eine laufende Nummer und die Erweiterung .tmbak angehängt.)

   Tipp: Je höher die laufende Nummer im Dateinamen, desto aktueller ist die Sicherungskopie.

3. Doppelklicken Sie im Windows-Explorer auf die Sicherungskopie, die Sie öffnen möchten.

4. TextMaker erkennt, dass Sie versuchen, eine Sicherungskopie zu öffnen. Er fragt nach, was genau Sie nun tun möchten. Dazu erscheint ein Dialog mit den folgenden Optionen:

   **Die Sicherungskopie öffnen:** Öffnet die Sicherungskopie.


   **Die Originaldatei öffnen:** Öffnet die Originaldatei zu dieser Sicherungskopie. (Dies funktioniert natürlich nur, wenn die Originaldatei noch existiert.)

5. Treffen Sie Ihre Wahl, und klicken Sie dann auf **OK**.

   Es sei noch einmal darauf hingewiesen, dass TextMaker die Dateien im **Backup**-Ordner **automatisch** anlegt und verwaltet. Sie sollten daher keine Änderungen an diesen Dateien von Hand vornehmen, also beispielsweise Dateien umbenennen oder verschieben.

   Wenn Sie mehr Platz auf dem Datenträger benötigen, können Sie jederzeit alle Dateien in diesem Ordner löschen, verlieren dann aber natürlich sämtliche Sicherungskopien.
Dokumentschutz


Um ein Dokument zu schützen, rufen Sie darin den Menübefehl Datei > Eigenschaften auf, wechseln auf die Karteikarte Schutz und wählen die Art des Dokumentschutzes. Tragen Sie außerdem das gewünschte Lese- und/oder Schreibkennwort ein.

Es gibt folgende Arten von Dokumentschutz:

- **Kein Schutz**
  Das Dokument wird nicht geschützt. Dies ist die Standardeinstellung.

- **Schreibschutz**
  Das Dokument kann nur gespeichert werden, wenn beim Öffnen des Dokuments das korrekte Schreibkennwort angegeben wurde.

- **Leseschutz**
  Das Dokument lässt sich nur öffnen, wenn beim Öffnen das korrekte Lesekennwort eingegeben wird. Außerdem wird das Dokument verschlüsselt.

- **Schutz abhängig vom Kennwort**
  Hier hängt der Schutz davon ab, ob beim Öffnen des Dokuments das Lese- oder das Schreibkennwort eingegeben wird:

    Gibt der Anwender das Lesekennwort ein, darf er das Dokument öffnen, aber nicht speichern. Gibt er das Schreibkennwort ein, hat er vollen Zugriff. Gibt er ein falsches Kennwort oder überhaupt nichts ein, wird der Zugriff komplett verweigert.

Ausführliche Informationen zum Aktivieren und Deaktivieren eines Dokumentschutzes finden Sie auf den nächsten Seiten.

Dokumentschutz aktivieren


Beim Leseschutz wird das Dokument zusätzlich verschlüsselt, damit es auch mit anderen Programmen nicht eingesehen werden kann.

Um ein Dokument zu schützen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf.
2. Wechseln Sie auf die Karteikarte Schutz.
3. Wählen Sie die gewünschte Art von Dokumentschutz (siehe unten).


   **Wichtig:** Wenn Sie ein Kennwort vergessen, kann das Dokument nicht mehr geöffnet beziehungsweise gespeichert werden. Es ist daher ratsam, sich das Kennwort zu notieren. Achten Sie dabei genau auf die Groß-/Kleinschreibung!

5. Bestätigen Sie mit OK.

6. Es erscheint ein Dialog, in dem Sie das Lese- und/oder Schreibkennwort zur Kontrolle noch einmal eingeben müssen.

7. Bestätigen Sie mit OK.

8. Verlassen Sie das Dialogfenster mit OK.

9. Speichern Sie das Dokument, damit die Änderungen wirksam werden.

Zukünftig wird beim Öffnen dieses Dokuments automatisch das Kennwort erfragt. Wenn das richtige Kennwort angegeben wird, wird der Schutz vorübergehend außer Kraft gesetzt.

Sie können im obigen Dialog zwischen folgenden Arten von Dokumentschutz wählen:

- **Kein Schutz**
  
  Das Dokument wird nicht geschützt. Dies ist die Standardeinstellung.

- **Schreibschutz**

  Beim Öffnen des Dokuments wird der Anwender dazu aufgefordert, das Schreibkennwort einzugeben. Das Dokument kann nur dann gespeichert werden, wenn hier das korrekte Schreibkennwort angegeben wurde.

  Wird ein falsches Kennwort oder überhaupt nichts eingegeben, wird das Dokument _schreibgeschützt_ geöffnet. Es kann dann nicht gespeichert werden – auch nicht unter einem anderen Namen.

- **Leseschutz**

  Versucht ein Anwender, das Dokument zu öffnen, wird er dazu aufgefordert, das Lesekennwort anzugeben. Wird ein falsches Kennwort eingegeben, lässt sich das Dokument nicht öffnen.

  Das Dokument wird hierbei außerdem verschlüsselt gespeichert, damit es auch mit anderen Programmen nicht eingesehen werden kann.

- **Schutz abhängig vom Kennwort**

  Hier hängt der Schutz davon ab, ob bei der Kennwortabfrage beim Öffnen des Dokuments das Lese- oder das Schreibkennwort eingegeben wird:

  Gibt der Anwender das _Lesekennwort_ ein, darf er das Dokument öffnen, aber nicht speichern.

  Gibt er das _Schreibkennwort_ ein, hat er vollen Zugriff, kann das Dokument also auch speichern.

  Gibt er ein _falsches Kennwort_ oder überhaupt nichts ein, wird der Zugriff auf das Dokument komplett verweigert.

**Verschlüsselungsmethode: "Höchste Kompatibilität" oder "Höchste Sicherheit"?**

Bei Dokumenten mit _Leseschutz_ oder einem _Schutz abhängig vom Kennwort_ können Sie zusätzlich die gewünschte _Verschlüsselungsmethode_ auswählen.
**Hinweis:** Diese Einstellung betrifft in erster Linie neu erstellte Dokumente. Beim Öffnen eines bestehenden verschlüsselten Dokuments wird die darin verwendete Verschlüsselungsmethode automatisch ermittelt und diese Einstellung dann entsprechend gesetzt.


Verfügbare Optionen:

- **Höchste Kompatibilität**
  
  Beim Speichern des Dokuments wird eine alte Verschlüsselungsmethode verwendet, die von allen Versionen von Microsoft Office gelesen werden kann. Diese ist allerdings weniger sicher als die andere Methode.

- **Höchste Sicherheit**
  
  Es wird eine modernere und sicherere Verschlüsselungsmethode verwendet. Diese kann allerdings von einigen alten Versionen von Microsoft Office möglicherweise nicht gelesen werden.

Ausführlichere Details zur derzeit gewählten Verschlüsselungsmethode werden im unteren Teil des Dialogs angezeigt.

### Dokumentschutz deaktivieren

Wenn Sie ein lese- oder schreibgeschütztes Dokument öffnen und dabei das korrekte Kennwort angeben, wird der Schutz deaktiviert – allerdings nur vorübergehend. Wenn Sie dieses Dokument nämlich schließen, wird der Schutz wieder "scharfgemacht"; beim nächsten Öffnen erscheint also erneut die Abfrage für das Kennwort.

Um den Schutz eines Dokuments permanent zu entfernen, gehen Sie wie folgt vor:

1. Öffnen Sie das Dokument.
2. Rufen Sie den Menübefehl **Datei > Eigenschaften** auf.
3. Wechseln Sie auf die Karteikarte **Schutz**.
4. Wählen Sie die Option **Kein Schutz**.
5. Bestätigen Sie mit **OK**.
6. Speichern Sie das Dokument, damit die Änderung wirksam wird.

Der Dokumentschutz ist nun dauerhaft deaktiviert.

Fremdformate


Sie können TextMaker aber auch anweisen, Dateien in einem anderen Dateiformat zu speichern. Dies ist nötig, wenn Sie beispielsweise ein TextMaker-Dokument mit einem anderen Programm weiterbearbeiten möchten. Umgekehrt können Sie mit TextMaker auch Dokumente öffnen, die mit anderen Textverarbeitungen erstellt wurden, also in einem Fremdformat vorliegen.

In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es enthält folgende Abschnitte:

- **Speichern und Öffnen von Fremdformaten**
  Im ersten Abschnitt erfahren Sie, wie Sie Dokumente in einem anderen Dateiformat speichern oder öffnen: Einfach den Menübefehl Datei > Speichern unter beziehungsweise Datei > Öffnen aufrufen und in der Liste der Dateitypen das gewünschte Format einstellen.

- **Anmerkungen zum Textformat**
  Wenn Sie eine Textdatei öffnen oder speichern, wird deren Zeichensatz normalerweise automatisch ermittelt. Auf Wunsch können Sie den Zeichensatz auch manuell festlegen. In diesem Abschnitt erfahren Sie, wie das geht.

Lesen Sie dazu die nächsten Seiten.

**Speichern und Öffnen von Fremdformaten**

Folgendermaßen speichern oder öffnen Sie Dokumente in einem anderen Dateiformat:

**Speichern eines Dokuments in einem Fremdformat**

Um das aktuelle Dokument in einem anderen Dateiformat zu speichern, rufen Sie den Menübefehl Datei > Speichern unter auf und öffnen die aufklappbare Liste Dateityp. Wählen Sie darin das gewünschte Format, geben Sie bei Bedarf einen anderen Dateinamen an und bestätigen Sie mit OK.

**Öffnen eines in einem Fremdformat vorliegenden Dokuments**

Um ein Dokument, das in einem anderen Dateiformat vorliegt, zu öffnen, rufen Sie den Menübefehl Datei > Öffnen auf, öffnen die Liste der Dateitypen und wählen das Format aus, in dem die Datei vorliegt. Wählen Sie dann die zu öffnende Datei und bestätigen Sie mit OK.
Unterstützte Dateiformate

In den Dialogen zum Öffnen und Speichern von Dokumenten werden in der Liste der Dateitypen unter anderem folgende Dateiformate angeboten:

- **Dokument**
  
  Das Hausformat für TextMaker-Dokumente, in dem Sie Dokumente üblicherweise speichern (Namenserweiterung: .tmdx).

- **Dokumentvorlage**
  
  Dokumentvorlage für TextMaker-Dokumente (Namenserweiterung: .tmvx). Siehe Abschnitt Dokumentvorlagen

- **Microsoft Word**
  

- **OpenDocument Text**
  

- **TextMaker 2016**
  

- **Rich Text Format**
  
  Das RTF-Format ist gut zum Dokumentaustausch geeignet. Es versteht alle grundlegenden Textformatierungen und kann von sehr vielen anderen Programmen gelesen werden.

- **HTML**
  
  HTML-Format, für Webseiten (siehe auch Kapitel Internet-Funktionen)

- **Textdatei**
  
  Reine Textdatei (ohne Formatierung).

- **Textdatei, mit zusätzlichen Einstellungen**
  

- **TextMaker/DOS** (nur Öffnen, nur unter Windows verfügbar)
  
  Zum Öffnen von Dokumenten, die mit TextMaker für DOS ab Version 3.0 erzeugt wurden. (Speichern in diesem Format ist nicht möglich.)
Anmerkungen zum Textformat

Wie im vorherigen Abschnitt erwähnt, können Sie mit TextMaker auch reine Textdateien öffnen und speichern.

Hierbei muss lediglich darauf geachtet werden, dass der richtige Zeichensatz eingestellt ist:

**Zeichensatz automatisch einstellen lassen**

Normalerweise brauchen Sie sich um das Einstellen des Zeichensatzes nicht zu kümmern, da TextMaker dies automatisch erledigt:

- Wenn Sie eine Textdatei öffnen, versucht TextMaker deren Zeichensatz automatisch zu erkennen. Schlägt dies fehl, wird der Standardzeichensatz Ihres Systems verwendet.
- Wenn Sie eine Textdatei öffnen und sie dann speichern, verwendet TextMaker automatisch den Zeichensatz, in dem die Datei auch geöffnet wurde.
- Wenn Sie ein Dokument in eine neue Textdatei speichern, wird der Standardzeichensatz Ihres Systems verwendet.

**Zeichensatz selbst einstellen**

Alternativ können Sie beim Öffnen (oder Speichern) einer Textdatei auch selbst bestimmen, welcher Zeichensatz verwendet werden soll.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl **Datei > Öffnen** auf (beziehungsweise **Datei > Speichern unter**).
3. Wählen Sie eine Datei beziehungsweise bestimmen Sie den Dateinamen der Textdatei. Bestätigen Sie dann mit **Öffnen** (beziehungsweise **Speichern**).

Folgende Einstellungen können darin gemacht werden:

- **Zeichensatz**
  
  Hier können Sie festlegen, welcher Zeichensatz beim Öffnen/Speichern der Textdatei verwendet werden soll.

  Hinweis: TextMaker schlägt automatisch einen geeigneten Zeichensatz vor. In der Regel können Sie diese Vorgabe übernehmen.

- **Zeilen beenden mit ...**
  
  Nur beim Speichern: Hier können Sie auswählen, welche Steuerzeichen am Ende jeder Zeile eingefügt werden sollen (um den Beginn einer neuen Zeile zu kennzeichnen).

  Hinweis: TextMaker schlägt automatisch geeignete Steuerzeichen vor. In der Regel können Sie diese Vorgabe übernehmen.
Folgende Optionen stehen zur Wahl:

**CR+LF:** Dies ist die empfohlene Einstellung für **Windows**.

**LF:** Dies ist die empfohlene Einstellung für **Linux** und **Mac**.

**CR:** Dieses Steuerzeichen war auf älteren Apple Mac-Systemen (vor Mac OS X) üblich.
Arbeiten mit arabischem Text

Sie können mit TextMaker auch Dokumente in arabischer Schrift verfassen und bearbeiten. In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es enthält folgende Abschnitte:

- Aktivieren der Unterstützung für arabischen Text
- Ändern der Schreibrichtung von Absätzen
- Ändern der Richtung von Tabellen
- Ändern der Richtung von mehrspaltigen Bereichen
- Ändern der Schriftart für arabischen Text
- Einfügen von arabischen Datumsangaben

Lesen Sie dazu die nächsten Seiten.

***Wichtig:** Die in diesem Kapitel beschriebenen Funktionen stehen nur zur Verfügung, wenn in den Einstellungen die Option *Erweiterte Unterstützung für arabischen Text* aktiviert wurde. Lesen Sie dazu den nächsten Abschnitt.

---

Aktivieren der Unterstützung für arabischen Text

TextMaker verfügt über eine "erweiterte Unterstützung für arabischen Text", die einige zusätzliche Funktionen für das Bearbeiten von Text in arabischer Schrift bereitstellt.

Um diese Option zu aktivieren, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Weiteres > Einstellungen** auf.
2. Wechseln Sie auf die Karteikarte **Allgemein**.
3. Schalten Sie darin die Option *Erweiterte Unterstützung für arabischen Text* ein.

***Wichtig:** Nur wenn diese Option aktiviert ist, stehen die auf den nächsten Seiten beschriebenen Funktionen zur Verfügung.

---

Ändern der Schreibrichtung von Absätzen

Ist die Option *Erweiterte Unterstützung für arabischen Text* in den Einstellungen aktiviert, können Sie in einem Absatz jederzeit die Schreibrichtung zwischen links-nach-rechts und rechts-nach-links umschalten.
Arbeiten mit arabischem Text

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl Format > Absatz auf.
2. Wechseln Sie auf die Karteikarte Absatz.
3. Wählen Sie unter Schreibrichtung die gewünschte Option: "von links nach rechts" oder "von rechts nach links".

**Tipp: Verwenden der Tastatur**

Viel schneller geht das Ändern der Schreibrichtung eines Absatzes, wenn Sie dafür die folgenden Tastenkürzel verwenden:

- Wenn Sie gleichzeitig Strg und die linke Umschalttaste drücken, wird die Schreibrichtung auf links-nach-rechts gesetzt.
- Wenn Sie gleichzeitig Strg und die rechte Umschalttaste drücken, wird die Schreibrichtung auf rechts-nach-links gesetzt.

**Mac/Linux**: Auf manchen Systemen (inklusive macOS und einigen Linux-Distributionen) funktionieren diese Tastenkombinationen nicht. Hier können Sie alternativ die Tastenkombinationen Strg+Umschalt+A (links-nach-rechts) und Strg+Umschalt+D (rechts-nach-links) verwenden.

**Ändern der Richtung von Tabellen**

Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellungen aktiviert, können Sie die Schreibrichtung von Tabellen jederzeit ändern.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie in der Tabelle den Menübefehl Tabelle > Tabelleneigenschaften auf.
2. Wechseln Sie auf die Karteikarte Eigenschaften.
3. Schalten Sie unter Schreibrichtung die Option Rechts nach links ein, um die Schreibrichtung auf rechts-nach-links zu setzen.

Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts gesetzt werden soll.

Die Richtung der Tabelle ändert sich nun entsprechend.

Wenn Sie die Schreibrichtung einer Tabelle also auf rechts-nach-links ändern, ist nicht mehr die Tabellenspalte ganz links die erste Spalte, sondern die Tabellenspalte ganz rechts.

Die Tabelle wird also horizontal gespiegelt – wie in folgender Abbildung zu sehen:

![Tabellenabbildung]

*Links: Tabelle mit Schreibrichtung links-nach-rechts
Rechts: Tabelle mit Schreibrichtung rechts-nach-links*

Hinweis: Die Schreibrichtung des Textes in jeder einzelnen Tabellenzelle lässt sich natürlich auch weiterhin individuell festlegen (wie im Abschnitt Ändern der Schreibrichtung von Absätzen beschrieben).
Ändern der Richtung von mehrspaltigen Bereichen

Ist die Option **Erweiterte Unterstützung für arabischen Text** in den Einstellungen aktiviert, können Sie die Schreibrichtung eines mehrspaltigen Textbereichs jederzeit ändern.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie in dem Bereich den Menübefehl **Format > Bereich** auf.
2. Wechseln Sie auf die Karteikarte **Spalten**.
3. Schalten Sie unter **Schreibrichtung** die Option **Rechts nach links** ein, um die Schreibrichtung auf rechts-nach-links zu setzen.

    Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts gesetzt werden soll.

Die Richtung des mehrspaltigen Bereichs ändert sich nun entsprechend.

Wenn Sie die Schreibrichtung in einem mehrspaltigen Bereich also auf rechts-nach-links ändern, ist nicht mehr die Spalte ganz links die erste Spalte, sondern die Spalte ganz rechts.

Hinweis: Die Schreibrichtung des Textes in jedem einzelnen Absatz lässt sich natürlich auch weiterhin individuell festlegen (wie im Abschnitt **Ändern der Schreibrichtung von Absätzen** beschrieben).

Allgemeine Informationen zum Arbeiten mit mehreren Textspalten finden Sie im Kapitel **Mehrspalten- druck**.

Ändern der Schriftart für arabischen Text

Ist die Option **Erweiterte Unterstützung für arabischen Text** in den Einstellungen aktiviert, erscheinen im Dialogfenster des Menübefehls **Format > Zeichen** nicht nur eine, sondern drei Listen zur Auswahl von Schriftart, Schriftgröße, Schriftstil und Sprache:

- Für lateinische Schriftzeichen (z.B. Deutsch, Englisch)
- Für ostasiatische Schriftzeichen (Chinesisch, Japanisch, Koreanisch)
- Für komplexe Schriftzeichen (z.B. Arabisch)

Sie können diese Einstellungen dann also für jede Art von Schriftzeichen getrennt vornehmen.

Setzen Sie beispielsweise die Schriftart für lateinische Zeichen auf "Arial" und die Schriftart für komplexe Zeichen auf "Simplified Arabic", erscheinen alle lateinischen Zeichen, die Sie eintippen, automatisch in Arial und alle arabischen Zeichen in der Schrift "Simplified Arabic".

TextMaker erkennt dabei selbsttätig, ob es sich bei den eingegebenen Zeichen um lateinische, asiatische oder komplexe (z.B. arabische) Schriftzeichen handelt.
Einfügen von arabischen Datumsangaben

Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellungen aktiviert, stehen in den Dialogen der Menübefehle Einfügen > Datum/Uhrzeit und Einfügen > Feld folgende Optionen für das Einfügen von Datumsangaben zusätzlich zur Verfügung:

### Sprache

Bestimmt, in welcher Sprache Tages- und Monatsnamen in das Datum eingefügt werden soll: der Sprache für westliche Schriftzeichen, asiatische Schriftzeichen oder komplexe Schriftzeichen (z.B. Arabisch).

Hinweis: Welche Sprache hierbei verwendet werden soll, lässt sich mit den drei Optionen für die Sprache im Dialog des Menübefehls Format > Zeichen festlegen.

### Kalender

Bestimmt, ob das Datum gemäß dem gregorianischen Kalender oder dem islamischen Kalender (hid-schri) erzeugt werden soll.

Allgemeine Informationen zum Einfügen von Datumsangaben und anderen Feldern finden Sie im Kapitel Felder.
Scripts (BasicMaker)


Mit Hilfe von Scripts lassen sich Arbeitsabläufe in der Textverarbeitung TextMaker und der Tabellenkalkulation PlanMaker automatisieren.

**Starten von BasicMaker**

Um BasicMaker zu starten oder ein BasicMaker-Script ausführen zu lassen, können Sie eine der folgenden Vorgehensweisen verwenden:

- **BasicMaker über das Start-Menü starten**
  

- **BasicMaker von TextMaker/PlanMaker aus starten**
  

- **Scripts von TextMaker/PlanMaker aus ausführen lassen**
  
  Um ein Script ausführen zu lassen, rufen Sie in TextMaker/PlanMaker den Menübefehl Weiteres > Script starten auf. Es erscheint ein Dateidialog. Wählen Sie darin das Script, das ausgeführt werden soll, und bestätigen Sie mit OK.

Alle weiteren Informationen zu BasicMaker und zum "Programmieren" von TextMaker und PlanMaker finden Sie in der Online-Hilfe von BasicMaker, die Sie über das Menü Hilfe in BasicMaker aufrufen können.
Mehrere Dokumente gleichzeitig bearbeiten

Sie können jederzeit mehrere Dokumente gleichzeitig geöffnet haben – um diese miteinander zu vergleichen, sie gleichzeitig zu bearbeiten, Daten zwischen ihnen auszutauschen etc.

Folgendermaßen arbeiten Sie mit mehreren Dokumenten gleichzeitig:

- Mehrere Dokumente im gleichen Programmfenster öffnen
  
  Sie können im aktuellen Programmfenster beliebig viele Dokumente gleichzeitig geöffnet haben.
  
  Zum Wechseln zwischen diesen Dokumenten gibt es zahlreiche Möglichkeiten, unter anderem eine Leiste mit Registerkarten für jedes momentan geöffnete Dokument, die über dem aktuellen Dokument angezeigt wird:

![Registerkarten](Image)

- Dokumente in einem neuen Programmfenster öffnen
  
  Darüber hinaus können Sie Dokumente auf Wunsch auch in einem neuen Programmfenster öffnen. Dies ermöglicht es Ihnen, Dokumente beispielsweise nebeneinander auf dem Monitor zu platzieren.
  
  Kreuzen Sie dazu im Dialogfenster des Menübefehls Datei > Neu oder Datei > Öffnen die Option Neues Programmfenster an, wenn Sie das Dokument anlegen/öffnen. (Hinweis: Diese Option steht in der Android-Version nicht zur Verfügung.)


  In diesem Kapitel erfahren Sie alles Wissenswerte zum Arbeiten mit mehreren Dokumenten gleichzeitig. Lesen Sie dazu die nächsten Seiten.

Dokument neu anlegen oder öffnen

Um ein Dokument neu anzulegen oder zu öffnen, gehen Sie wie folgt vor:

- Zum Anlegen eines neuen Dokuments rufen Sie den Menübefehl Datei > Neu auf.
- Zum Öffnen eines bestehenden Dokuments verwenden Sie den Menübefehl Datei > Öffnen.

Diese beiden Befehle werden im Kapitel Grundlagen ausführlich beschrieben.

Option "Neues Programmfenster"

Die Option Neues Programmfenster im Dialogfenster dieser beiden Befehle hat dabei folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint das Dokument in einem eigenen Programmfenster. Ist sie ausge-
Mehrere Dokumente gleichzeitig bearbeiten

Schaltet, wird das Dokument im bestehenden Programmfenster mit einer neuen Registerkarte geöffnet. (Hinweis: Diese Option steht in der Android-Version nicht zur Verfügung.)

Wechseln zwischen geöffneten Dokumenten

Wenn Sie mehrere Dokumente gleichzeitig geöffnet haben, stehen Ihnen folgende Möglichkeiten zur Verfügung, um zu einem bestimmten Dokument zu wechseln und es dadurch zum aktiven Dokument zu machen:

- **Menü: Menüeintrag "Fenster"**
  
  Im Menü **Fenster** finden Sie eine Liste aller momentan geöffneten Dokumente. Wählen Sie darin den Eintrag für das Dokument, zu dem Sie wechseln möchten.

- **Ribbon: Symbol "Fenster"**
  
  Im Ribbon finden Sie auf der Karteikarte **Ansicht** ein Symbol namens **Fenster**, das ähnlich funktioniert: Wenn Sie es anklicken, erscheint eine Liste aller geöffneten Dokumente. Klicken Sie darin das gewünschte Dokument an.

- **Maus: Anklicken der Registerkarte für das Dokument**
  
  Unter den Symbolleisten beziehungsweise dem Ribbon finden Sie eine Leiste mit **Registerkarten** für alle momentan geöffneten Dokumente. Klicken Sie darin die Registerkarte für das Dokument an, zu dem Sie wechseln möchten.

- **Maus: Klicken in das Programmfenster mit dem Dokument**
  
  Wenn Sie Dokumente in mehreren Programmfenstern geöffnet haben (siehe vorheriger Abschnitt), können Sie natürlich auch einfach in das Programmfenster mit dem gewünschten Dokument klicken, um dieses Dokument zum aktiven Dokument zu machen.

- **Tastatur: Strg+F6**
  
  Sie können auch die Tastatur verwenden, um zwischen den momentan geöffneten Dokumenten zu wechseln: **Strg+F6** wechselt zum nächsten Dokument und **Strg+Umschalt+F6** zum vorherigen.

  **Mac:** Beim Mac sind hierfür die Tasten **Cmd+F6** und **Cmd+Umschalt+F6** zu verwenden.

Dokument schließen

Wenn Sie die Arbeit an einem Dokument beenden möchten, können Sie dieses jederzeit schließen. Hierfür gibt es folgende Möglichkeiten:

- **Menü:** Rufen Sie den Menübefehl **Datei > Schließen** auf, um das aktuelle Dokument zu schließen.

  **Tipp:** Mit dem Menübefehl **Fenster > Alle schließen** können Sie alle derzeit geöffneten Dokumente auf einmal schließen.
Mehrere Dokumente gleichzeitig bearbeiten

- **Ribbon:** Die Karteikarte **Datei** enthält ein Symbol namens **Schließen**, mit dem sich aktuelle Dokument schließen lässt.

- **Registerkarten für Dokumente:** Unter den Symbolleisten beziehungsweise dem Ribbon sehen Sie eine Leiste mit **Registerkarten** für alle momentan geöffneten Dokumente. Wenn Sie mit der **mittleren** Maustaste auf eine dieser Registerkarten klicken, wird das entsprechende Dokument geschlossen.

![Registerkarten Beispiel](image)

Alternativ können Sie zum Schließen auch mit der linken Maustaste auf das **x**-Symbol klicken, das ganz rechts in der Registerkarte angezeigt wird.

Außerdem: Wenn Sie mit der **rechten** Maustaste auf eine Registerkarte klicken, erscheint ein kleines Menü. Dieses enthält Befehle zum Schließen des aktuellen Dokuments oder aller anderen geöffneten Dokumente.

- **Tastatur:** Sie können weiterhin das Tastenkürzel **Strg+F4** oder wahlweise **Strg+W** verwenden, um das aktuelle Dokument zu schließen.

**Mac:** Beim Mac sind hierfür die Tasten **Cmd+F4** beziehungsweise **Cmd+W** zu verwenden.

Wenn Sie ein Dokument schließen, das seit dem letzten Speichern verändert wurde, fragt das Programm zuvor automatisch nach, ob Sie das Dokument erst speichern möchten.

---

Dokumente auf dem Bildschirm anordnen

**Android:** Die Funktion **Fenster nebeneinander anzeigen** ist in der Android-Version nicht verfügbar.

Wenn Sie Dokumente in mehreren Programmfenstern geöffnet haben, können Sie diese wie folgt auf dem Bildschirm anordnen:

- Sie können die einzelnen Programmfenster natürlich manuell verschieben und deren Größe ändern – genau so, wie dies bei allen Arten von Programmfenstern möglich ist.

- Wenn Sie den Menübefehl **Fenster > Nebeneinander anzeigen** aufrufen, werden das aktuelle Programmfenster und ein weiteres (bereits geöffnetes) Programmfenster nebeneinander auf dem Bildschirm angeordnet. Falls derzeit mehr als zwei Programmfenster geöffnet sind, fragt das Programm erst nach, welches andere Fenster verwendet werden soll.
Anpassen von TextMaker

TextMaker lässt Sie über eine Vielzahl von Programmeinstellungen bestimmen, so dass Sie das Programm ganz an Ihren persönlichen Arbeitsstil anpassen können.

- **Einstellungen von TextMaker ändern**
  Mit dem Menübefehl **Weiteres > Einstellungen** können Sie die **Programmeinstellungen** ändern. Diese gelten für das gesamte Programm, also für alle Dokumente.

- **Dokumenteigenschaften ändern**
  Die **Dokumenteigenschaften** sind hingegen Einstellungen, die nur das aktuelle Dokument betreffen und die auch in diesem gespeichert werden. Sie können mit dem Menübefehl **Datei > Eigenschaften** geändert werden.

- **Bildschirmdarstellung ändern**
  In diesem Abschnitt wird beschrieben, wie Sie die Darstellung des Dokuments auf dem Bildschirm anpassen können. Die meisten dazu benötigten Befehle finden Sie im Menü **Ansicht**.

- **Symbolleisten anpassen**
  **Nur bei "klassischen Menüs und Symbolleisten"**: Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit "klassischen Menüs und Symbolleisten" bedienen möchten.

  Sie erfahren hier, wie Sie die **Symbolleisten** (Funktionsleiste, Formatleiste etc.) mit dem Menübefehl **Ansicht > Symbolleisten** konfigurieren und mit **Weiteres > Anpassen** nach Ihren Wünschen anpassen können.

- **Ribbon (Menüband) anpassen**
  **Nur bei "Ribbons"**: Dieser Abschnitt ist hingegen nur für Anwender interessant, die in den Einstellungen ausgewählt haben, dass sie das Programm lieber mit dem "Ribbon" (Menüband) bedienen möchten.

  Sie erfahren hier, wie Sie das Ribbon konfigurieren und anpassen können.

- **Benutzerdefinierte Symbole erstellen**
  Sie können jederzeit benutzerdefinierte Symbole anlegen und diese dann einer Symbolleiste oder dem Ribbon hinzufügen. Mit solchen Symbolen lassen sich beliebige Programme starten.

- **Tastenkürzel anpassen**
  Auch die Tastenkürzel für das Aufrufen häufig benötigter Befehle lassen sich anpassen. Hierfür ist abermals der Menübefehl **Weiteres > Anpassen** zuständig.

- **Gitter verwenden** und **Hilfslinien verwenden**

- **Installieren zusätzlicher Wörterbücher**
  In diesem Abschnitt erfahren Sie, wie Sie bei Bedarf zusätzliche Wörterbücher (zum Beispiel Hunspell) installieren können.
Ausführliche Informationen zu diesen Themen folgen, in obiger Reihenfolge, auf den nächsten Seiten.

---

**Einstellungen von TextMaker ändern**

Allgemeine Einstellungen lassen sich mit dem Menübefehl **Weiteres > Einstellungen** ändern. Diese Einstellungen gelten für *alle* Dokumente.


Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren Einstellungen.

---

**Einstellungen, Karteikarte Ansicht**

Auf der Karteikarte **Ansicht** im Dialogfenster des Menübefehls **Weiteres > Einstellungen** können Sie Einstellungen zum Erscheinungsbild von Dokumenten auf dem Bildschirm vornehmen:

**Rubrik Dokumentfenster**

Hier können Sie auswählen, welche Hilfsmittel in Dokumentfenstern angezeigt werden sollen:

- **Tabellen-Hilfslinien**
  
  
  Standardmäßig ist diese Option eingeschaltet.

- **Textrahmen-Hilfslinien**
  
  
  Standardmäßig ist diese Option eingeschaltet.

- **OLE-Objekt-Hilfslinien**
  
  
  Standardmäßig ist diese Option eingeschaltet.

- **Hilfslinien**
  
  Wie im Abschnitt **Hilfslinien verwenden** beschrieben, können Sie in einem Dokument Hilfslinien einrichten, um das bündige Positionieren von Objekten zu vereinfachen.
  
  Über diese Option bestimmen Sie, ob diese Hilfslinien auf dem Bildschirm angezeigt werden sollen.
Standardmäßig ist diese Option eingeschaltet.

Hinweis: Wenn Sie die Option ausschalten, werden die Hilfslinien zwar unsichtbar, behalten aber weiterhin ihre Funktion.

Anmerkung: Diese Option ist identisch mit der Option **Hilfslinien anzeigen** im Dialogfenster des Menübefehls *Objekt > Gitter und Hilfslinien*.

### Seitenränder

Hier bestimmen Sie, ob die Seitenränder als gepunktete Linien im Dokument angezeigt werden sollen. Diese Linien sollen Ihnen lediglich zur Orientierung auf dem Bildschirm dienen. Sie werden nicht ausgedruckt.

Standardmäßig ist diese Option eingeschaltet.

### Horizontales Lineal

Hier können Sie das horizontale Lineal ein-/ausschalten. Das horizontale Lineal, in diesem Handbuch meist *Linealleiste* genannt, wird oberhalb des Textes angezeigt. Es zeigt nicht nur die aktuelle Absatzformatierung an, sondern lässt Sie Einzüge und Tabulatoren mit der Maus auch verändern (siehe Kapitel *Absatzformatierung*).

Standardmäßig ist dieses Lineal eingeschaltet.

### Vertikales Lineal

Hier können Sie das vertikale Lineal ein-/ausschalten. Das vertikale Lineal wird links vom Text angezeigt. Es dient lediglich zur Information und lässt keine Änderungen an der Formatierung zu.

Standardmäßig ist dieses Lineal ausgeschaltet.

### Markierung für Textüberlauf

Wenn diese Option eingeschaltet ist, zeigt TextMaker an der unteren Kante von Textrahmen einen roten Balken an, falls der enthaltene Text nicht vollständig in den Rahmen passt.

### Rubrik Nichtdruckbare Zeichen anzeigen

Hier bestimmen Sie, ob im Text Symbole für Absatzmarken, Tabulatoren, Leerzeichen etc. angezeigt werden sollen, damit diese besser zu erkennen sind.

<table>
<thead>
<tr>
<th>Bestellung</th>
<th>20</th>
<th>Badekappen, ·Stoff, ·blau/weiß</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitte ·liefern ·Sie ·folgendes ·Artikel ·baldmöglichst ·an ·das ·Hallenbad ·in ·Goslar.</td>
<td>10</td>
<td>Badekappen, ·Stoff, ·rot/weiß</td>
</tr>
<tr>
<td>10</td>
<td>Schwimmbrillen ·„Mark ·Spitz“</td>
<td></td>
</tr>
</tbody>
</table>

*Hier wurden die Kenner für Absätze, Tabulatoren und Leerzeichen aktiviert*

### Absatzmarken

Anpassen von TextMaker

- **Tabstopps**
  Aktivieren Sie diese Option, werden alle Tabulatoren auf dem Bildschirm durch Pfeilchen kenntlich gemacht.

- **Leerzeichen**
  Aktivieren Sie diese Option, werden alle Leerzeichen auf dem Bildschirm durch kleine Pünktchen kenntlich gemacht.

- **Weiche Trennzeichen**
  Aktivieren Sie diese Option, werden alle weichen Trennzeichen sichtbar gemacht und als grau hinterlegte Trennzeichen angezeigt.

- **Alle**
  Entspricht dem Einschalten aller obigen Optionen.

**Rubrik Bildlaufleisten**

Hier können Sie wählen, ob für das Dokument eine horizontale und/oder vertikale Bildlaufleiste angezeigt werden soll.

**Zeilen am Fensterrand umbrechen (in Konzept- und Gliederungsansicht)**

Ist diese Option aktiviert, werden die Zeilen des Dokuments unabhängig von ihrer tatsächlichen Breite am rechten Fensterrand umbrochen. Sie sehen dann zwar nicht mehr das tatsächliche Layout des Dokuments, können den Text aber auf Geräten mit einem kleinen Display besser lesen (ohne ständig nach links und rechts blättern zu müssen).

**Hinweis:** Das Aktivieren dieser Option wirkt sich nur auf die Konzeptansicht (Menübefehl Ansicht > Konzept) und die Gliederungsansicht aus. In der Normalansicht (Menübefehl Ansicht > Normal) hat sie keine Wirkung.

**Mehrere Seiten nebeneinander anzeigen**

Diese Option bestimmt, ob TextMaker mehrere Dokumentseiten nebeneinander anzeigen soll, wenn Sie ein Dokument in einer sehr kleinen Vergrößerungsstufe betrachten:

- **Ein:** Es werden so viele Seiten nebeneinander angezeigt wie möglich. So können Sie mehrere Seiten auf einmal betrachten.

- **Aus:** Die Seiten werden niemals nebeneinander, sondern immer nur untereinander angezeigt.

**Einstellungen, Karteikarte Allgemein**

Auf der Karteikarte Allgemein im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie allgemeine Einstellungen vornehmen:
Maximal widerrufbare Aktionen

Hier können Sie einstellen, wie viele Aktionen sich mit dem Menübefehl Bearbeiten > Rückgängig widerrufen lassen. Sie können diese Einstellung auf maximal 999 erhöhen.

**Hinweis:** Das Programm verbraucht mehr Hauptspeicher, wenn Sie diesen Wert erhöhen. Auf Geräten mit wenig Speicher sollte hier also kein allzu hoher Wert eingestellt werden.

Informationen zum Befehl Rückgängig finden Sie im Abschnitt Änderungen rückgängig machen.

Schaltfläche "Benutzerdaten"

Hier können Sie Ihre persönlichen Daten (Name, Adresse etc.) angeben. Diese Angaben werden beispielsweise von den mitgelieferten Dokumentvorlagen verwendet, um Briefköpfe, Faxformulare usw. automatisch mit Ihrem Absender ausfüllen zu können (siehe auch Abschnitt Dokumentvorlagen).

**Hinweis:** In älteren Versionen von TextMaker gab es an dieser Stelle zwei Schaltflächen, da Sie Ihre Benutzerdaten getrennt für Privatadresse und Firmenadresse angeben konnten. Ab TextMaker 2018 wird nur noch ein Satz an Benutzerdaten unterstützt, um die Kompatibilität mit Microsoft Word zu verbessern.

Erweiterte Unterstützung für asiatische Schriften

Ist diese Option aktiviert, erscheinen im Dialogfenster des Menübefehls Format > Zeichen nicht nur eine, sondern **drei** Listen zur Auswahl von Schriftart, Schriftgröße, Schriftstil und Sprache:

- Für lateinische Schriftzeichen (z.B. Deutsch, Englisch)
- Für ostasiatische Schriftzeichen (Chinesisch, Japanisch, Koreanisch)
- Für komplexe Schriftzeichen (z.B. Arabisch)

Sie können diese Einstellungen dann also für jede Art von Schriftzeichen getrennt vornehmen.

Setzen Sie beispielsweise die Schriftart für lateinische Zeichen auf "Arial" und die Schriftart für asiatische Zeichen auf "SimHei", erscheinen alle lateinischen Zeichen, die Sie eintippen, automatisch in Arial und alle asiatischen Zeichen in SimHei.

TextMaker erkennt dabei selbsttätig, ob es sich bei den eingegebenen Zeichen um lateinische, asiatische oder komplexe (z.B. arabische) Schriftzeichen handelt.

Erweiterte Unterstützung für arabischen Text

Wenn Sie diese Option aktivieren, werden einige zusätzliche Funktionen für das Bearbeiten von Text in **arabischer** Schrift verfügbar. Informationen dazu finden Sie im Kapitel Arbeiten mit arabischem Text.

Nummernanzeige

Bestimmt, mit welcher Art von Ziffern Zahlen im Text dargestellt werden sollen:
**Anpassen von TextMaker**

- **Arabisch:** Arabische Ziffern (1234567890), wie z.B. in der deutschen Sprache üblich. Dies ist die Standardeinstellung.

- **Hindi:** Hindi-Ziffern, wie im Arabischen üblich.

- **Kontext:** Automatische Erkennung. Ist die Zahl von arabischem Text umgeben, werden Hindi-Ziffern verwendet, ansonsten arabische Ziffern.

**Warnung beim Laden von OLE-Objekten**


**Einstellungen, Karteikarte Bearbeiten**

Auf der Karteikarte **Bearbeiten** im Dialogfenster des Menübefehls **Weiteres > Einstellungen** können Sie Einstellungen zum Bearbeiten von Text vornehmen:

**Ersten Buchstaben eines Satzes groß schreiben**

Wenn diese Option aktiviert ist, schreibt TextMaker den ersten Buchstaben jedes Satzes, den Sie eingeben, automatisch groß – auch wenn Sie versehentlich einen Kleinbuchstaben eingetippt haben.

Tippen Sie also einen Satz wie zum Beispiel "dies ist ein neuer Satz." ein, wird dies automatisch in "Dies ist ein neuer Satz." korrigiert.

**Zwei Großbuchstaben am Anfang eines Wortes korrigieren**

Wenn diese Option aktiviert ist, korrigiert TextMaker beim Tippen automatisch die Groß-/Kleinschreibung von Wörtern, die Sie versehentlich mit zwei Großbuchstaben beginnen lassen.

Tippen Sie also "HAus" ein, wird dies automatisch in "Haus" korrigiert.

**Textbausteine automatisch ersetzen**

Wie im Abschnitt Textbausteine beschrieben, können Sie mit TextMaker Textbausteine anlegen (z.B. "mfg" für "Mit freundlichen Grüßen").

Wenn diese Option eingeschaltet ist, können Textbausteine direkt bei der Texteingabe ausgelöst werden. Dazu muss einfach das Kürzel für den Baustein (z.B. "mfg") und dann Leertaste, Eingabetaste oder ein Satzzeichen getippt werden, worauf TextMaker das Kürzel automatisch durch den Inhalt des Bausteins ersetzt.

Ist diese Option deaktiviert, können Textbausteine hingegen nur über den Menübefehl **Einfügen > Textbaustein** abgerufen werden.

**Typografische Anführungszeichen**

TextMaker kann doppelte Anführungszeichen (") und einfache Anführungszeichen/Apostrophzeichen (') beim Eintippen automatisch in die typografisch korrekten Zeichen für die gewählte Sprache umwandeln.
Stellen Sie hier die gewünschte Sprache ein oder wählen Sie "Neutral", wenn TextMaker Anführungszeichen nicht verändern soll.

Tippen Sie beispielsweise "Text" oder 'Text' ein, erscheint je nach Einstellung folgendes Ergebnis:

<table>
<thead>
<tr>
<th>Einstellung</th>
<th>&quot;Text&quot;</th>
<th>'Text'</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatisch*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Neutral (keine Veränderung)</td>
<td>&quot;Text&quot;</td>
<td>'Text'</td>
</tr>
<tr>
<td>Deutsch</td>
<td>„Text“</td>
<td>,&quot;Text&quot;</td>
</tr>
<tr>
<td>Schweizerisches Deutsch</td>
<td>»Text«</td>
<td>›Text‹</td>
</tr>
<tr>
<td>Englisch</td>
<td>&quot;Text&quot;</td>
<td>'Text'</td>
</tr>
<tr>
<td>Französisch**</td>
<td>«Text»</td>
<td>‹Text›</td>
</tr>
<tr>
<td>Schwedisch</td>
<td>&quot;Text&quot;</td>
<td>'Text'</td>
</tr>
</tbody>
</table>

* Eine Sonderstellung nimmt dabei die Option Automatisch ein: Wählen Sie diese, ermittelt TextMaker die Sprache automatisch (verwendet also entweder die in den Einstellungen festgelegte Standardsprache oder die über den Menübefehl Format > Zeichen festgelegte Sprache) und wandelt die Anführungszeichen entsprechend.

** Für das einfache Anführungszeichen bei der Einstellung Französisch beachten Sie bitte folgendes: das schließende Anführungszeichen wird zunächst als Apostroph (') ausgeführt. Drücken Sie auf der Tastatur das einfache Anführungszeichen ein weiteres Mal, wandelt es sich in das einfache Guillemet (‹) um.

** Automatisch Abstände bei Satzzeichen einfügen (nur Französisch):**

Aktivieren Sie die Option, damit vor Satzgrenznachzeichen ; ; ! ? und zwischen Anführungszeichen « Text » ‹ Text › automatisch Leerzeichen eingefügt werden. Diese Option wirkt sich nur aus, wenn Französisch die zugewiesene Sprache in den folgenden Einstellungen ist:

- Menübefehl Weiteres > Einstellungen, Karteikarte Sprache (Französisch)
- Menübefehl Format > Zeichen, Karteikarte Schrift (Französisch oder Standard)

** Beim Markieren immer ganzes Wort markieren**

Nur bei Windows, Mac und Linux: Wenn diese Option aktiviert ist, erweitert TextMaker die Markierung wortweise, wenn Sie mit der Maus Text selektieren. Ist sie nicht aktiviert, wird die Markierung zeichenweise erweitert.

** Leerzeichen beim Einfügen hinzufügen oder löschen**

Wenn diese Option aktiviert ist, wird das Leerzeichen vor und hinter einem Wort bei Bedarf automatisch entfernt oder hinzugefügt, wenn Sie Wörter löschen, ausschneiden oder über die Zwischenablage einfügen.

Markieren Sie also beispielsweise das Wort "ist" im Satz "Dies ist ein Test" und schneiden es mit dem Befehl Ausschneiden aus, löscht TextMaker automatisch das dadurch überflüssig gewordene Leerzeichen hinter "ist".

Fügen Sie das Wort "ist" nun mit Befehl Einfügen vor einem anderen Wort ein, fügt TextMaker automatisch ein Leerzeichen hinter "ist" ein.
**Mittlere Maustaste**

**Nur bei Mac und Linux:** Diese Option bestimmt, was passieren soll, wenn Sie einen Mausklick mit der mittleren Maustaste durchführen. Verfügbare Optionen:

- **Nichts:** Die mittlere Maustaste hat keine Funktion.
- **Markierten Inhalt einfügen:** Wenn Sie mit der mittleren Maustaste in das Dokument klicken, wird an dieser Stelle eine Kopie des aktuellen Inhalts der Selektion eingefügt (also beispielsweise der momentan selektierte Text).

**Zeichenformatierung auf das ganze Wort anwenden**

Wenn diese Funktion aktiviert ist, hat das folgende Auswirkungen:

Wenn sich die Schreibmarke innerhalb eines Wortes befindet und Sie die Zeichenformatierung ändern (also beispielsweise eine andere Schrift wählen oder Fettdruck einschalten), wirkt sich dies auf das komplette Wort aus.

So können Sie schnell die Formatierung eines einzelnen Wortes ändern, ohne es erst markieren zu müssen.

**URLs als Hyperlink formatieren**

Wenn diese Option aktiviert ist, werden URLs (also Adressen von Webseiten) direkt nach der Eingabe automatisch als Hyperlink formatiert.

Tippen Sie beispielsweise "www.softmaker.de" in den Text, wird dies automatisch in einen anklickbaren Hyperlink umgewandelt und entsprechend dargestellt (in der Regel also blau und unterstrichen).

**Ordinalzahlen hochstellen**


In obigen Sprachen werden Teile bestimmter *Ordinalzahlen* (Ordnungszahlen) üblicherweise hochgestellt – zum Beispiel bei 1st, 2nd, 3rd in der englischen Sprache.

Wenn diese Option aktiviert ist, geschieht dieses Hochstellen automatisch bei der Eingabe. Tippen Sie also beispielsweise in einem englischen Text "2nd" ein und drücken dann die Leertaste, wird dieses automatisch zu "2nd" umformatiert – das "nd" wird also hochgestellt.

*Hinweis:* Damit dieses funktioniert, muss der Text in der entsprechenden Sprache formatiert sein (in unserem Beispiel also Englisch). Informationen, wie man die Sprache von Text festlegt, finden Sie im Abschnitt *Sprache einstellen*.

**Linken Einzug und Erstzeileneinzug mit Tabulator- und Rückwärts-Taste setzen**

Wenn diese Option aktiviert ist, können Sie mit der Tabulator-Taste Tab und der Rücktaste \( \text{rücktaste} \) den Einzug von Absätzen ändern.

Setzen Sie dazu entweder die Schreibmarke an den Beginn eines vorhandenen Absatzes oder markieren Sie mehrere Absätze. Drücken Sie dann die Taste Tab, um den Einzug zu erhöhen. Mit der Rücktaste \( \text{rücktaste} \) können Sie den Einzug reduzieren.
**Rahmen und Zeichnungen direkt einfügen**

Diese Option bestimmt, was passieren soll, wenn Sie einen Rahmen oder eine Zeichnung in ein Dokument einfügen (Textrahmen, Grafikrahmen, Autoform, etc.) – zum Beispiel mit dem Menübefehl **Objekt > Neuer Textrahmen**:

- **Immer**: Das entsprechende Objekt wird sofort eingefügt. Seine Position und Größe werden dabei ohne weiteres Zutun fest vorgegeben. (Sie können das Objekt nach dem Einfügen natürlich nach Belieben verschieben, indem Sie es mit der Maus an die gewünschte Position ziehen. Auch können Sie seine Größe ändern, indem Sie an einem der runden Greifer ziehen, die das Objekt umgeben.)

- **Nie**: Bevor das Objekt tatsächlich eingefügt wird, ändert sich der Mauszeiger in ein Fadenkreuz. Um fortzufahren, ziehen Sie mit der Maus ein Rechteck im Dokument auf, um die gewünschte Position und Größe festzulegen. Das Objekt wird dann genau nach Ihren Vorgaben eingefügt.

- **Automatisch**: Eine intelligente Kombination aus den beiden obigen Optionen, die in TextMaker für den jeweiligen Objekttyp bereits voreingestellt ist. Die Objekte Autoform und Textrahmen werden direkt eingefügt (wie bei **Immer**), alle anderen Objekte werden per Steuerung über den Mauszeiger eingefügt (wie bei **Nie**).

**Linke Alt-Taste für Tastenkürzel verwenden**

*Nur beim Mac*: Diese Option bestimmt, welche Funktion die linke Alt-Taste Ihrer Tastatur haben soll:


- **Ein**: Die linke Alt-Taste kann dazu verwendet werden, Menüs im klassischen Menü zu öffnen. (Hinweis: Dies funktioniert nur, wenn Sie das Programm mit klassischen Menüs anstelle des Ribbons verwenden.)

  Alt+E liefert dann kein Eurozeichen mehr, sondern öffnet stattdessen das **Einfügen**-Menü.

**Einstellungen, Karteikarte Aussehen**

Auf der Karteikarte **Aussehen** im Dialogfenster des Menübefehls **Weiteres > Einstellungen** können Sie Einstellungen vornehmen, die das Aussehen der Benutzeroberfläche von TextMaker betreffen:

**Dialogsprache**

Hier können Sie die Sprache wählen, in die Benutzeroberfläche (Menüs, Dialoge etc.) angezeigt werden soll.

**Benutzeroberfläche**

Wenn Sie die Schaltfläche **Benutzeroberfläche** anklicken, erscheint ein Dialog, in dem Sie wählen können, welche Art von Benutzeroberfläche die Programme von SoftMaker Office nutzen sollen:
**Ribbon** (obere Zeile)

Wenn Sie einen der Einträge aus der oberen Zeile auswählen, verwenden die Programme ein "Ribbon" (also ein Menüband) als Benutzeroberfläche. Die Unterschiede zwischen den einzelnen Einträgen liegen nur in der Farbgebung.

**Klassische Menüs und Symbolleisten** (untere Zeile)

Wenn Sie einen der Einträge aus der unteren Zeile auswählen, verwenden die Programme klassische Menüs und Symbolleisten. Auch hier haben Sie die Wahl zwischen verschiedenen Farbvarianten.

Darüber hinaus lassen sich in dem Dialog noch folgende Einstellungen vornehmen:

**Schnellzugriffsleiste**


**Fingereingabemodus**

Wenn Sie diese Option aktivieren, werden alle Symbole im Ribbon beziehungsweise in Menüs und Symbolleisten leicht vergrößert. Dies ist nützlich, wenn Sie die Software mit dem Finger bedienen (beispielsweise auf einem Tablet).

Tipp: Sie können den Fingereingabemodus alternativ auch mit folgenden Befehlen ein-/ausschalten:

**Menü**: Befehl *Ansicht > Fingereingabemodus*

**Schnellzugriffsleiste**: Befehl *Fingereingabemodus*

**Android**: Falls Sie die Android-Version verwenden, haben Sie für die Einstellungen der *Benutzeroberfläche* keine Schaltfläche mit Dialog, sondern eine aufklappbare Liste. Die Optionen *Schnellzugriffsleiste* und *Fingereingabemodus* (für größere Symbole und Menüeinträge) sind separat an anderen Stellen dieser Karteikarte *Aussehen* zu finden und bewirken dasselbe wie oben beschrieben.

**Statuszeile im Ribbonmodus anzeigen**

Gilt nur für den **Ribbonmodus**: Sie können hier die Anzeige der Statuszeile ein-/ausschalten. Um die Anzeige der Statuszeile für das klassische **Menü** zu ändern, siehe Abschnitt *Symbolleisten anzeigen/verbergen*.

**Schriftenliste mit echten Schriften**

Ist diese Option aktiviert, zeigt TextMaker in Schriftenlisten (zum Beispiel der Schriftenliste in der Formatleiste) alle Schriftnamen in der jeweiligen Schriftart an. So können Sie gleich sehen, wie die Schriften tatsächlich aussehen.

**Quickinfos**

Bestimmt, ob **Quickinfos** angezeigt werden sollen. Dabei handelt es sich um kurze Infotexte, die neben dem Mauszeiger angezeigt werden, wenn Sie mit der Maus auf ein Bildschirmelement zeigen (zum Beispiel auf eine Schaltfläche in der Funktionsleiste).

**Warnton bei Meldungen**

Ist diese Option aktiviert, gibt TextMaker bei Hinweis- und Fehlermeldungen einen Signalton aus.
**Echtzeitvorschau**

Hier können Sie eine Echtzeitvorschau für die aufklappbaren Listen in der Formatleiste ein-/ausschalten.

Ist diese aktiviert, können Sie beispielsweise Text markieren, die Schriftenliste in der Formatleiste öffnen und dann mit der Maus über die Schriftarten darin fahren. Sofort wird "in Echtzeit" im Dokument angezeigt, wie der markierte Text in der entsprechenden Schrift aussehen würde.

Um die Schrift dann tatsächlich anzuwenden, klicken Sie sie einfach an. Um die Änderung zu verwerfen, klicken Sie auf eine beliebige Stelle außerhalb der Schriftenliste oder drücken die Taste **Esc**.

**Systemmenüs verwenden**

**Nur beim Mac:** Diese Option bestimmt, ob das Programm sein Hauptmenü in der Menüleiste am oberen Bildschirmrand anzeigen soll (wie dies bei Mac-Anwendungen üblich ist) oder nicht.

Je nachdem, welche Art von **Benutzeroberfläche** Sie ausgewählt haben ("Ribbon" oder "Klassische Menüs und Symbolleisten"), hat diese Option folgende Auswirkung:

- **Aus:** Das Hauptmenü wird *nicht* in der Menüzeile am oberen Bildschirmrand angezeigt.
  - Details:
    - **Klassische Menüs und Symbolleisten:** Bei der klassischen Benutzeroberfläche wird das Hauptmenü nun nicht mehr am oberen Bildschirmrand, sondern in seiner eigenen Leiste (unterhalb der Titelleiste) angezeigt.
    - **Ribbon:** Wenn Sie als Benutzeroberfläche das "Ribbon" ausgewählt haben, steht Ihnen nun lediglich das "Hamburgermenü" (das Symbol ‹ in der Schnellzugriffsteleiste) zur Verfügung, falls Sie doch einmal auf das klassische Hauptmenü zugreifen möchten.

- **Ein:** Das Hauptmenü wird in der Menüzeile am oberen Bildschirmrand angezeigt.
  - Details:
    - **Klassische Menüs und Symbolleisten:** Das Hauptmenü wird nun in der Menüleiste am oberen Bildschirmrand angezeigt – und nicht in seiner eigenen Leiste unterhalb der Titelleiste.
    - **Ribbon:** Ribbon-Anwender haben nun nicht nur Zugriff auf die Ribbon-Benutzeroberfläche, sondern können bei Bedarf *zusätzlich* das klassische Menü in der Menüleiste verwenden.

**System-Dateidialoge verwenden**

**Nur bei Windows, Mac und Linux:** Diese Option bestimmt, welche Art von Dialogen bei Befehlen, die mit dem Öffnen und Speichern von Dateien zu tun haben, erscheinen sollen:

- **Aus:** Es erscheinen TextMakers eigene Dateidialoge.
- **Ein:** Es erscheinen die Standard-Dateidialoge des Betriebssystems, wie Sie sie von den meisten anderen Applikationen her kennen.

Erstere sind etwas übersichtlicher, letztere bieten mehr Optionen.

**Bildschirmschriftarten glätten**

Wenn Sie diese Option aktivieren, wendet TextMaker eine Technologie an, die die Kanten von Schriften auf dem Bildschirm glättet und so das Schriftbild verbessert – das sogenannte "Antialiasing".
Anpassen von TextMaker

Je nach Betriebssystem stehen unterschiedliche Optionen zur Verfügung.

**Hintergrundfarbe des Programms**

Hier können Sie die Hintergrundfarbe für Dokumentfenster ändern.

**Größe der Benutzeroberfläche**

*Nur bei Mac, Linux und Android:* Diese Schaltfläche öffnet einen Dialog, mit dem Sie die Benutzeroberfläche (Menü, Symbolleisten, Dialoge etc.) des Programms verkleinern oder vergrößern können.

Wählen Sie hier eine kleinere Einstellung, werden alle Bedienelemente verkleinert, was für mehr Übersicht sorgt. Eine größere Einstellung hingegen erhöht die Lesbarkeit.

Die Option **Größe der Dialogelemente** ändert die Größe der Benutzeroberfläche dabei in groben Schritten. Die Option **Anpassung der Schriftgröße** erlaubt zusätzlich etwas "Feintuning" in kleineren Schritten.

Als kleine Hilfe zeigt Ihnen das Feld **Beispiel** an, wie groß beispielsweise ein Kontrollkästchen in einem Dialog nach dem Anwenden Ihrer Änderungen aussehen würde.

**Hinweis:** Bei ungeeigneten Einstellungen kann es passieren, dass die Benutzeroberfläche deutlich zu klein oder zu groß dargestellt wird, insbesondere auf Geräten mit einer relativ niedrigen Auflösung. Falls dies passieren sollte, können Sie jederzeit die Schaltfläche **Zurücksetzen** in der linken unteren Ecke dieses Dialogs betätigen, um zu den Standardeinstellungen zurückzukehren.

**Skalierung von Dokumenten (DPI)**

*Nur bei Mac, Linux und Android:* Sie können das Dokument für eine größere/kleinere Ansicht höher oder niedriger skalieren. Wählen Sie dazu **Benutzerdefiniert** und geben Sie den gewünschten Wert ein.

**Maßeinheit**

*Nur bei Mac, Linux und Android:* Hier können Sie einstellen, welche Maßeinheiten TextMaker standardmäßig verwenden soll: **Metrisch** (Zentimeter) oder **U.S.** (Zoll).

(Unter Windows ist diese Option nicht erforderlich, da das Programm dort automatisch die Einstellung übernimmt, die in den Regions- und Sprachoptionen der Systemsteuerung von Windows gewählt wurde.)

Tipp: Unabhängig von dieser Einstellung können Sie in Dialogen jederzeit Werte in anderen Maßeinheiten eingeben, indem sie hinter dem Wert eine der folgenden Maßeinheiten eintippen:

<table>
<thead>
<tr>
<th>Einheit</th>
<th>Bemerkung</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm</td>
<td>Zentimeter</td>
</tr>
<tr>
<td>in</td>
<td>Inch (Zoll) – 1 in entspricht 2,54 cm.</td>
</tr>
<tr>
<td>pt</td>
<td>Punkt – 72 pt entsprechen 1 in.</td>
</tr>
<tr>
<td>pi</td>
<td>Pica (Zeichen)</td>
</tr>
</tbody>
</table>

Tippen Sie also beispielsweise für den linken Seitenrand "2 in" ein, setzt TextMaker diesen auf 2 Zoll (=5,08 cm).
Ribbon-Animationen verwenden


Einstellungen, Karteikarte Sprache

Auf der Karteikarte Sprache im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie Einstellungen zu den Sprachwerkzeugen von TextMaker vornehmen:

Standardsprache

Hier legen Sie die Standardsprache für Rechtschreibprüfung, Silbentrennung und Thesaurus fest. Öffnen Sie die Liste dazu und wählen Sie die gewünschte Sprache darin aus.

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser Liste gibt:

- "Deutsch (Deutschland)" steht für die neue Rechtschreibung (gemäß der sogenannten "Rechtschreibreform" von 1996 in ihrer letzten Überarbeitung von 2006).
- "Deutsch (Deutschland, alt)" steht hingegen für die alte Rechtschreibung.

Entprechendes gilt für "Deutsch (Österreich)" und "Deutsch (Schweiz)".

Tipp: Falls Sie in einem Dokument mehrere Sprachen gleichzeitig verwenden wollen, können Sie mit dem Menübefehl Format > Zeichen beliebige Textabschnitte in einer anderen Sprache formatieren.

Ausführlichere Informationen zu diesem Thema finden Sie im Abschnitt Sprache einstellen.

Rechtschreibprüfung

Hier können Sie Einstellungen zur Rechtschreibprüfung vornehmen:

- Rechtschreibprüfung im Hintergrund verwenden


- Farbe

  Hier können Sie die Farbe der roten Unterstreichungen ändern, mit der die "Rechtschreibprüfung im Hintergrund" falsch geschriebene Wörter kennzeichnet.

- Alte Schreibweisen blau unterstreichen:

  Wenn diese Option aktiviert ist, unterstreicht die Rechtschreibprüfung im Hintergrund außerdem alle Wörter mit einer blauen Wellenlinie, die der alten deutschen Rechtschreibung entsprechen, nach der
neuen Rechtschreibung (gemäß der sogenannten "Rechtschreibreform" von 1996) jedoch anderes ge-
schrieben werden sollen. Siehe auch Abschnitt Umsetzung auf die neue deutsche Rechtschreibung.

| Hinweis: Diese Option wird nur bei Text in der Sprache "Deutsch (Deutschland)", "Deutsch (Öster-
reich)" oder "Deutsch (Schweiz)" aktiv. |

**Für deutschsprachige Rechtschreibprüfung den Duden-Korrektor verwenden**


Wenn Sie diese Option aktivieren, wird für die Rechtschreibprüfung nicht mehr das in TextMaker inte-
grierte Modul, sondern das Rechtschreibmodul des Duden-Korrektors verwendet (und natürlich auch

| Hinweis: Der Duden-Korrektor wird nur bei Text in der Sprache "Deutsch (Deutschland, Österreich, 
Schweiz etc.)" aktiv. |

**Ignoriere Wörter, die mit einer Zahl beginnen**

Wenn Sie diese Option aktivieren, ignoriert die Rechtschreibprüfung alle Wörter, die mit einer Zahl be-
ginnen (zum Beispiel "1980er").

**Hunspell-Wörterbücher**

Neben seinen eigenen Wörterbüchern unterstützt SoftMaker Office auch die Verwendung von Hunspell-
Wörterbüchern. Diese sind als kostenlose Downloads erhältlich. Sie wurden größtenteils von engagierten
Anwendern und nicht-kommerziellen Einrichtungen erstellt.

Mit der Schaltfläche Hunspell-Wörterbücher können Sie heruntergeladene Hunspell-Wörterbücher in-
stallieren und außerdem einstellen, für welche Sprachen Hunspell-Wörterbücher verwendet werden sol-
len.

Siehe dazu Abschnitt Installieren zusätzlicher Wörterbücher.

**Silbentrennung**

Hier können Sie Einstellungen zur Silbentrennung vornehmen:

**Automatische Silbentrennung verwenden**

Entspricht dem Menübefehl Weiteres > Automatische Silbentrennung.

Die Silbentrennung erfolgt normalerweise vollautomatisch während des Tippens. Wenn Sie diese Option
allerdings ausschalten, werden im aktuellen Dokument keine automatischen Silbentrennungen mehr vor-
genommen und alle bestehenden Trennungen entfernt. Siehe auch Abschnitt Silbentrennung.

| Hinweis: Im Gegensatz zu allen anderen Optionen auf dieser Karteikarte ist dies keine globale Einstel-
lung, sondern eine Dokumentoption. TextMaker merkt sich den Zustand dieser Einstellung also pro
Dokument. |

**Für deutschsprachige Silbentrennung den Duden-Korrektor verwenden**

Wenn Sie diese Option aktivieren, wird für die Silbentrennung nicht mehr das in TextMaker integrierte Modul, sondern das Silbentrennmodul des Duden-Korrektors verwendet. Siehe auch Abschnitt Duden-Silbentrennung verwenden.

**Hinweis:** Der Duden-Korrektor wird nur bei Text in der Sprache "Deutsch (Deutschland, Österreich, Schweiz etc.)" aktiv.

**Grammatikprüfung**

Hier können Sie Einstellungen zur Grammatikprüfung vornehmen:

- **Duden-Korrektor-Grammatikprüfung verwenden**

  **Hinweis:** Dieses Feature ist nur in SoftMaker Office Professional enthalten.


  **Hinweis:** Der Duden-Korrektor wird nur bei Text in der Sprache "Deutsch (Deutschland, Österreich, Schweiz etc.)" aktiv.

- **Farbe**

  Hier können Sie die Farbe der grünen Unterstreichungen ändern, mit der die Grammatikprüfung falsch geschriebene Wörter oder Satzteile kennzeichnet.

**Duden-Korrektor-Optionen**

**Hinweis:** Dieses Feature ist nur in SoftMaker Office Professional enthalten.


**Weitere Optionen**

Diese Schaltfläche ruft einen zusätzlichen Dialog mit erweiterten Optionen für die Sprachwerkzeuge auf:

- **Rechtschreibprüfung – Farbe**

  Hier können Sie die Farbe der roten Unterstreichungen ändern, mit der die "Rechtschreibprüfung im Hintergrund" falsch geschriebene Wörter kennzeichnet.

- **Grammatikprüfung – Farbe**

  Hier können Sie die Farbe der grünen Unterstreichungen ändern, mit der die Grammatikprüfung Fehler kennzeichnet.
Einstellungen, Karteikarte Dateien

Auf der Karteikarte **Dateien** im Dialogfenster des Menübefehls **Weitere > Einstellungen** können Sie Einstellungen zum Öffnen und Speichern von Dateien vornehmen:

**Vorlagenpfad**

Hier lässt sich der Ordner einstellen, in dem sich die Dokumentvorlagen für neue TextMaker-Dokumente befinden. Der Dialog, der beim Aufruf des Menübefehls **Datei > Neu** erscheint, um Sie eine Dokumentvorlage auszuwählen zu lassen, zeigt alle Vorlagen an, die sich in diesem Ordner befinden.

*Hinweis:* Normalerweise sollten Sie diese Einstellung nicht verändern. Ändern Sie diese nur, wenn Sie den Vorlagenordner tatsächlich an einen anderen Ort verschoben haben.

**Standard-Dateiformat**

Hier können Sie das Dateiformat wählen, in dem TextMaker neu angelegte Dokumente standardmäßig speichert soll.

Wenn Sie ein Dokument mit dem Menübefehl **Datei > Neu** neu anlegen und es dann zum ersten Mal abspeichern, schlägt Ihnen der Speicherdialog als Vorgabe stets das hier eingestellte Dateiformat vor.


*Wichtig:* Beachten Sie, dass die anderen hier angebotenen Formate nicht alle Features von TextMaker kennen. Wenn Sie also ein mit TextMaker erstelltes Dokument beispielsweise im Word-Format speichern, können unter Umständen Formatierungen oder Funktionen verloren gehen. Es empfiehlt sich daher, hier die Standardeinstellung "TextMaker" zu verwenden.

**Rubrik Speichern**

In der Rubrik **Speichern** können Sie Einstellungen zum Speichern von Dokumenten vornehmen:

- **Backupdateien erzeugen**
  
  *Nur bei Android:* Ist diese Option aktiviert, wird bei jedem Speichern eines Dokuments automatisch eine Sicherungskopie mit der vorherigen Fassung des Dokuments angelegt. (Namenserweiterung: .bak.)

  (Bei SoftMaker Office für Windows, Mac und Linux gibt es umfassendere Optionen für Sicherungskopien, siehe Rubrik **Sicherungskopien** weiter unten).

- **Beim Speichern nach Dokumentinfo fragen**

  Schalten Sie diese Option ein, erscheint beim ersten Speichern eines neuen Dokuments automatisch das Dialogfenster zum Eintragen der Dokumentinfos (siehe Abschnitt **Dokumentinfos**).

- **Automatische Wiederherstellung: Zustand sichern alle ... Minuten**

  Wenn diese Option aktiviert ist, macht TextMaker im eingetragenen Zeitabstand (1-100 Minuten) automatisch eine temporäre Sicherungskopie von jedem momentan geöffneten Dokument.
Hinweis: Diese temporären Sicherungskopien funktionieren völlig unabhängig von den regulären Sicherungskopien, die Sie in der Rubrik **Sicherungskopien** auf dieser Karteikarte konfigurieren können (siehe unten).

Wenn TextMaker korrekt beendet wird, löscht er diese temporären Sicherungskopien wieder. Wird er jedoch nicht korrekt beendet (zum Beispiel aufgrund eines Absturzes), erkennt TextMaker dies beim nächsten Programmstart. Er öffnet dann (nach Rückfrage) die temporären Sicherungskopien aller Dokumente, die bei dem Absturz geöffnet waren und noch nicht gespeicherte Änderungen enthielten.

Überprüfen Sie nun bei jedem der wiederhergestellten Dokumente, ob möglicherweise einige Ihrer zuletzt gemachten Änderungen verlorengegangen sind, und speichern Sie das Dokument dann.

- **Beim Speichern im Textformat Warnung anzeigen**

Ist diese Option aktiviert, wird beim Speichern eines Dokuments im reinen Textformat eine Warnung ausgegeben, die Sie darin erinnern soll, dass hierbei sämtliche Objekte und Formatierungen verloren gehen.

### Rubrik Öffnen

In der Rubrik **Öffnen** können Sie Einstellungen zum Öffnen von Dokumenten vornehmen:

- **Beim Öffnen eines Dokuments zur letzten Editierposition springen**

Ist diese Option aktiviert, setzt TextMaker die Schreibmarke nach dem Öffnen eines Dokuments automatisch wieder an die Position, an der sich diese beim letzten Speichern des Dokuments befand.

Hinweis: Dies funktioniert nur mit Dokumenten in folgenden Formaten: TextMaker (.tmd oder .tmdx) und Microsoft Word (.doc oder .docx).

- **Einträge im Datei-Menü**

Im Menü **Datei** zeigt TextMaker eine Liste der zuletzt von Ihnen geöffneten Dateien an. Wählen Sie einen dieser Einträge, wird die entsprechende Datei sofort geöffnet. Hier lässt sich einstellen, wie viele Dateien dort angezeigt werden sollen.

### Rubrik Sicherungskopien

*Hinweis:* Dieses Feature ist in der Android-Version nicht verfügbar. Unter Android werden lediglich einfache Sicherungskopien unterstützt (über die weiter oben beschriebene Option **Backupdateien erzeugen**).

Hier können Sie festlegen, ob das Programm beim Speichern von Dokumenten automatisch eine Sicherungskopie mit der vorherigen Version des Dokuments anlegen soll.

Die aufklappbare Liste in dieser Rubrik bietet hierfür folgende Optionen zur Wahl:

- **Keine Sicherungskopien**

Wenn Sie diese Option wählen, werden keine Sicherungskopien beim Speichern von Dokumenten angelegt. (Nicht empfohlen.)

- **Einfache Sicherungskopien**

Hier wird pro Dokument genau eine Sicherungskopie angelegt. Diese enthält die vorherige Version des Dokuments. Sie hat die Namenserweiterung .bak und befindet sich im gleichen Ordner wie das Dokument selbst.
Fortgeschrittene Sicherungskopien


Zusätzliche Optionen:

**Verzeichnis für Sicherungskopien:** Hier können Sie den Pfad für den Backup-Ordner ändern, in dem alle Sicherungskopien abgelegt werden.

**Anzahl der Sicherungskopien pro Dokument:** Hier können Sie bestimmen, wie viele Sicherungskopien (= Generationen) maximal pro Dokument aufgehoben werden sollen.

**Schaltfläche "Bereinigen":** Bietet die folgenden zwei Befehle zum Löschen von Sicherungskopien:

- **Verwaiste Sicherungskopien löschen** entfernt alle Sicherungskopien, bei denen das zugehörige Originaldokument nicht mehr existiert.
- **Alle Sicherungskopien löschen** entfernt sämtliche Sicherungskopien im Verzeichnis für Sicherungskopien.

Ausführliche Informationen zum Verwenden von Sicherungskopien finden Sie im Abschnitt Sicherungskopien.

---

**Einstellungen, Karteikarte System**

Auf der Karteikarte System im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie folgende System-Einstellungen vornehmen:

**Grafiken im Speicher komprimieren**


In der Regel sollten Sie diese Option eingeschaltet lassen.

**Hinweis:** Eine Änderung an dieser Einstellung wird erst wirksam, wenn Sie das Programm beenden und neu starten.

**Internen Grafikcache begrenzen**

TextMaker besitzt einen Zwischenspeicher, der die Anzeige von Grafiken in Dokumenten erheblich beschleunigt. Ist diese Option aktiviert, begrenzt TextMaker diesen Zwischenspeicher auf maximal 20% des Arbeitsspeichers.

In der Regel sollten Sie diese Option eingeschaltet lassen.

Wenn Sie häufig Dokumente mit vielen hochauflösenden Bildern verwenden, können Sie diese Option testshalber deaktivieren. Die Anzeige von Grafiken ist dann möglicherweise flüssiger, allerdings kann es dabei passieren, dass TextMaker einen Großteil des verfügbaren Arbeitsspeichers für sich beansprucht.
**Kantenglättung von Grafiken**


**Nach Produktaktualisierungen suchen**


Hinweis: Das Prüfen auf Aktualisierungen funktioniert nur, wenn Ihr Gerät auf das Internet zugreifen kann.

Sie können die automatische Überprüfung auch abschalten (nicht empfohlen), indem Sie den Eintrag *Nie* auswählen. Das Prüfen auf Aktualisierungen kann dann nur noch manuell (über die Schaltfläche *Jetzt prüfen*) durchgeführt werden.


**Android**: Bei Applikationen, die vom Google Play Store aus installiert wurden, benachrichtigt Sie Ihr Gerät automatisch über Updates (sofern dies nicht in den Einstellungen des Play Store deaktiviert wurde).

**Dateierweiterungen verknüpfen**


**Tastatur automatisch ein-/ausblenden**

*Nur bei Android*: Ist diese Option aktiviert, wird die Bildschirmtastatur automatisch geöffnet, wenn Sie etwas eingeben können (wenn Sie also beispielsweise in das Dokument hinein tippen oder in einem Dialog in ein Eingabefeld tippen).

**Tastatur/layout automatisch anpassen**


**OpenGL-Bibliothek verwenden**

**Hinweis:** Auf Systemen mit einer stark veralteten oder fehlerhaften OpenGL-Installation kann es dabei zu Darstellungsfehlern innerhalb der Applikation kommen. Dies hängt von Ihrer individuellen Systemkonfiguration und insbesondere dem verwendeten Grafiktreiber ab. In so einem Fall sollten Sie die Option deaktivieren und die Applikation neu starten.

Außerdem: Wenn das Programm beim Starten Probleme mit der installierten OpenGL-Bibliothek erkennt, schaltet es diese Option automatisch ab.

**SHM-Erweiterungen verwenden**

*Nur bei Linux:* Diese Option ist nur verfügbar, wenn die Option *OpenGL-Bibliothek verwenden* deaktiviert wurde (nicht empfohlen).

Wenn die SHM-Erweiterungen eingeschaltet sind, verwendet das Programm Shared Memory-Speicher (sofern verfügbar), was die Bildschirmausgabe beschleunigen kann.

**XIM verwenden**

*Nur bei Linux:* Ist diese Option aktiviert, unterstützt TextMaker das Zusammensetzen von Akzentzeichen (à, ô, é etc.) mit Hilfe von "XIM".

Auf einer deutschen Tastatur kann dann beispielsweise das Zeichen "ö" erzeugt werden, indem Sie erst die Taste ^ und danach die Taste O betätigen.

Schalten Sie die Option aus, ist das Zusammensetzen von Zeichen auf diese Weise nicht mehr möglich.

**Hinweis:** Auf manchen Systemen gibt es kleine Eingabeverzögerungen beim schnellen Tippen von Text, wenn diese Option aktiviert ist.

**Verborgene Dateien und Ordner anzeigen**

*Nur bei Mac, Linux:* Ist diese Option aktiviert, werden in Dateidialogen (z.B. dem des Menübefehls Datei > Öffnen) auch verborgene Dateien und Ordner angezeigt.

**Mausrad**

*Nur bei Mac, Linux:* Wenn Ihre Maus mit einem Mausrad ausgestattet ist, können Sie hier einstellen, wie weit beim Verwenden des Mausrads geblättert werden soll: seitenweise (also eine komplette Bildschirmseite) oder nur eine bestimmte Anzahl an Zeilen.

**Externe Programme**

*Nur bei Mac, Linux:* Diese Schaltfläche öffnet einen Dialog, in dem Sie die externen Programme festlegen können, die bei bestimmten Ereignissen automatisch gestartet werden. Der Eintrag *PDF-Betrachter* bestimmt beispielsweise, welche Applikation nach dem Erzeugen einer PDF-Datei automatisch aufgerufen wird, um das Ergebnis darin anzuzeigen.

**Hinweis:** Sie müssen diese Felder nicht ausfüllen. Bei allen Feldern, die Sie leer lassen, wird automatisch das im System festgelegte Standardprogramm für diese Aktion verwendet. Nehmen Sie in diesem Dialog nur dann Änderungen vor, wenn Sie möchten, dass nicht das Standardprogramm aufgerufen wird, sondern ein *anderes* Programm. Tragen Sie dazu einfach den Dateinamen der ausführbaren Datei ein (inklusive Pfad, falls nötig).
**Zusätzliche Schriftenpfade**

**Nur bei Mac, Linux und Android:** Hier können Sie Pfade für zusätzliche Schriftarten angeben, die TextMaker verwenden soll. Tragen Sie dazu das Unterverzeichnis ein, in dem sich die Schriftdateien befinden. Falls Sie mehrere Verzeichnisse eingeben möchten, trennen Sie diese durch einen Doppelpunkt.

TextMaker kann diese Schriftarten dann zusätzlich zu den in Ihrem System verfügbaren Schriften verwenden.

**Hinweis:** Änderungen an dieser Einstellung werden erst wirksam, wenn Sie das Programm beenden und neu starten.

---

**Einstellungen, Karteikarte Schriften**

Auf der Karteikarte **Schriften** im Dialogfenster des Menübefehls **Weiteres > Einstellungen** können Sie festlegen, welche Schriften in Schriftenlisten (z.B. der Schriftenliste im Dialogfenster des Menübefehls **Format > Zeichen**) angezeigt werden sollen.

Die Karteikarte präsentiert dazu eine Liste aller Schriften, die auf Ihrem System installiert sind. Um darin eine Schrift zu aktivieren oder zu deaktivieren, klicken Sie auf das Kästchen vor dem Namen der Schriftart. Alle Schriften, bei denen Sie das Häkchen entfernen, werden nicht mehr in Schriftenlisten angezeigt.

Hintergrund: Unter den Schriftarten, die auf Ihrem System standardmäßig installiert sind, befinden sich einige Schriften, die Sie vermutlich nie benötigen – weil diese beispielsweise ausschließlich Schriftzeichen für eine Sprache enthalten, die Sie nicht verwenden. Wenn Sie möchten, können Sie solche Schriften wie oben beschrieben ausblenden.

**Schriftenfilterung des Betriebssystems verwenden**

**Nur unter Windows:** Windows-Anwender finden auf dieser Karteikarte außerdem eine Option namens **Schriftenfilterung des Betriebssystems verwenden**. Wenn diese eingeschaltet ist, verbirgt Windows in Schriftenlisten automatisch **alle** Schriften, die ausschließlich fremdsprachige Schriftzeichen enthalten.

---

**Dokumenteigenschaften ändern**

Über den Menübefehl **Datei > Eigenschaften** können Sie Einstellungen ändern, die nur das aktuelle Dokument betreffen und mit diesem gespeichert werden. Man nennt diese Einstellungen **Dokumenteigenschaften**.

Die verfügbaren Dokumenteigenschaften sind nach Themen geordnet auf mehrere Karteikarten verteilt. Klicken Sie beispielsweise auf den Karteikartenreiter **Infos**, können Sie die Dokumentinfos bearbeiten.

Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren Dokumenteigenschaften.
Dokumenteigenschaften, Karteikarte Infos

Auf der Karteikarte Infos im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie die Dokumentinfos für das aktuelle Dokument eintragen.

In den Dokumentinfos lassen sich erläuternde Angaben zum aktuellen Dokument machen (Thema, Autor, Schlüsselwörter etc.), nach denen mit dem Dateimanager auch gesucht werden kann.

Informationen hierzu finden Sie im Abschnitt Dokumentinfos.

Dokumenteigenschaften, Karteikarte Ansicht

Auf der Karteikarte Ansicht im Dialogfenster des Menübefehls Datei > Eigenschaften lassen sich Einstellungen zum Erscheinungsbild des Dokuments auf dem Bildschirm machen.

Nur Feldnamen anzeigen

Bestimmt, ob bei Feldern (Datum, Seitennummer etc.) das Ergebnis oder der Feldname in geschweiften Klammern angezeigt werden soll. Normalerweise möchten Sie das Ergebnis sehen, lassen die Option also ausgeschaltet (siehe auch Kapitel Felder).

Standardmäßig ist diese Option ausgeschaltet.

Textmarken anzeigen

Mit dem Menübefehl Einfügen > Textmarke können Sie ein Dokument mit "Lesezeichen" versehen (siehe Abschnitt Textmarken).


Standardmäßig ist diese Option ausgeschaltet.

Felder schattieren

Aktivieren Sie diese Option, werden alle mit dem Menübefehl Einfügen > Feld in das Dokument eingefügtten Felder (Datum, Seitennummer etc.) grau hinterlegt, damit Sie besser erkennen können, an welchen Stellen des Dokuments sich Felder befinden.

Standardmäßig ist diese Option ausgeschaltet.

Datensatz anzeigen

Diese Option ist nur verfügbar, wenn Sie dem aktuellen Dokument mit dem Menübefehl Weiteres > Datenbank zuordnen eine Datenbank zugewiesen haben.

Schalten Sie diese Option ein, wird bei allen Datenbankfeldern im Dokument nicht mehr der Feldname, sondern der Feldinhalt aus der Datenbank angezeigt. Rechts neben dieser Option können Sie die Satznummer
Anpassen von TextMaker

des anzuzeigenden Datensatzes eintragen. Tragen Sie beispielsweise "10" ein, wird der zehnte Datensatz angezeigt.

Dies ist eine nützliche Hilfe, um vor dem Ausdrucken eines Serienbriefs überprüfen zu können, wie dieser mit ausgefüllten Serienbrieffeldern aussieht (siehe auch Kapitel Serienbriefe).
Standardmäßig ist diese Option ausgeschaltet.

Rubrik Objekte

Wie im Abschnitt Verbergen von Objekten beschrieben, können Objekte auf dem Bildschirm und/oder im Ausdruck unsichtbar gemacht werden.

Mit Hilfe dieser beiden Optionen können Sie solche Objekte trotzdem wieder sichtbar machen:

- **Nicht sichtbare Objekte anzeigen**: Wenn Sie diese Option aktivieren, erscheinen auch solche Objekte wieder auf dem Bildschirm, bei denen die Objekteigenschaft Sichtbar deaktiviert wurde.
- **Nicht zu druckende Objekte drucken**: Wenn Sie diese Option aktivieren, werden auch solche Objekte wieder ausgedruckt, bei denen die Objekteigenschaft Drucken deaktiviert wurde.

Standardmäßig sind beide Optionen ausgeschaltet.

Rubrik Verborgener Text

Neben Objekten lässt sich auch Text verbergen (siehe Abschnitt Verbergen von Text).

Die Optionen Verborgenen Text anzeigen und Verborgenen Text drucken bestimmen, ob als verborgen formatierter Text auf dem Bildschirm beziehungsweise im Ausdruck erscheinen sollen.

Standardmäßig ist die Option Verborgenen Text anzeigen eingeschaltet und die Option Verborgenen Text drucken ausgeschaltet. Verborgener Text ist also auf dem Bildschirm zu sehen, er erscheint aber im Ausdruck nicht.

Schalten Sie beispielsweise Verborgenen Text drucken ein, wird beim Drucken auch verborgener Text ausgegeben.

Seitenhintergrund drucken

Diese Option bestimmt, ob ein mit dem Menübefehl Datei > Seitenhintergrund eingerichteter Seitenhintergrund auch in Ausdrucken wiedergegeben werden soll. Standardmäßig ist die Option ausgeschaltet; der Hintergrund erscheint also nur auf dem Bildschirm.


Siehe auch Abschnitt Seitenhintergrund ändern.

Rubrik Bilder und OLE-Objekte

Bei der Standardeinstellung Bilder anzeigen werden alle im Text vorkommenden Grafiken und OLE-Objekte auf dem Bildschirm angezeigt.

Wählen Sie hingegen die Option Platzhalter anzeigen, wird stattdessen nur ein graues Kästchen angezeigt. Vorteil: Der Bildschirmaufbau beim Blättern durch ein Dokument mit vielen Grafiken wird dadurch beschleunigt.
Rubrik Sperren

Mit diesen Optionen können Sie alle Objekte auf der Masterseite und alle Hilfslinien "sperren" und somit gegen unbeabsichtigtes Verschieben sichern:

- **Objekte auf der Masterseite**: Aktivieren Sie diese Option, können alle Objekte, die auf der Masterseite eingefügt wurden, nur noch in der Masterseitenansicht verschoben werden (siehe auch Abschnitt Masterseiten).

- **Hilfslinien**: Aktivieren Sie diese Option, lassen sich Hilfslinien nicht mehr mit der Maus verschieben, sondern nur noch über den Dialog des Menübefehls **Objekt > Gitter und Hilfslinien** bearbeiten (siehe auch Abschnitt Hilfslinien verwenden).

Standardmäßig sind beide Optionen ausgeschaltet.

Rubrik Ansicht formatiert für:

**Hinweis**: Diese Option ist nur in TextMaker für Windows vorhanden.

Hier sollte normalerweise stets die Standardeinstellung **Druckerunabhängige Formatierung** gewählt werden. Die alternative Option ist lediglich aus Gründen der Kompatibilität mit älteren Dokumenten noch vorhanden.

Folgende Optionen sind verfügbar:


- **Druckerausgabe**: Hier wird zum Formatieren des Dokuments die Auflösung des aktuell gewählten Druckers verwendet. Beim Wechseln auf einen anderen Drucker kann dies dazu führen, dass sich im Dokument Zeilenenumbrüche und dadurch sogar Seitenenumbrüche ändern.

Dezimaltrenner

Hier können Sie festlegen, welches Zeichen als Dezimaltrenner verwendet werden soll.

Diese Einstellung betrifft ausschließlich das Verhalten von **Dezimaltabulatoren**. Ändern Sie das Trennzeichen beispielsweise von Komma auf Punkt, werden bei der Verwendung von Dezimaltabulatoren Zahlen nicht am Komma, sondern am Punkt ausgerichtet.

Schaltfläche "Kompatibilität"


In der Rubrik **Layout ist kompatibel mit** wird das Dateiformat angezeigt, auf das Sie in TextMaker zugriffen haben. Gleichzeitig können Sie hier unter verschiedenen Dateiformaten auswählen, bei denen die Einstellungen zur optimalen Kompatibilität bereits vorgegeben sind.
Dokumenteigenschaften, Karteikarte Farben

Auf der Karteikarte **Farben** im Dialogfenster des Menübefehls **Datei > Eigenschaften** können Sie die Farbpalette des aktuellen Dokuments bearbeiten.

Wenn Sie eine Farbenliste – zum Beispiel die Farbenliste in der Formatleiste – öffnen, sehen Sie nur einen kleinen Ausschnitt aus den bis zu 16 Millionen verfügbaren Farben. Man nennt diesen Ausschnitt die **Farbpalette** des Dokuments.

Diese Farbpalette kann jederzeit von Ihnen modifiziert werden. Sie können neue Farben hinzufügen und von Ihnen hinzugefügte Farben abändern. Die ersten 24 Farben in der Farbpalette sind allerdings Standardfarben, die sich nicht verändern lassen.

**Wichtig:** Änderungen an der Farbpalette werden *im Dokument* gespeichert. Sie können also zu jedem Dokument eine eigene Farbpalette zusammenstellen.

### Hinzufügen einer Farbe

Um der Farbpalette des aktuellen Dokuments eine Farbe hinzuzufügen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Datei > Eigenschaften** auf und wechseln Sie auf die Karteikarte **Farben**.
   
   **Tipp:** Alternativ können Sie diesen Dialog von jedem beliebigen Dialogfenster aus aufrufen, das eine Farbenliste enthält. Wählen Sie dazu in der Farbenliste den Eintrag **Andere...** am Ende der Liste.

2. Stellen Sie die gewünschte Farbe ein (siehe Abschnitt "Bedienung der Kontrollen zum Einstellen von Farben" weiter unten).

3. Klicken Sie auf die Schaltfläche **Neu**.

4. Geben Sie der neuen Farbe einen beliebigen Namen und bestätigen Sie mit **OK**.

5. Verlassen Sie den Dialog mit **OK**.

TextMaker fügt die neue Farbe nun der Farbpalette des Dokuments hinzu. Die Farbe ist ab sofort in allen Dialogfenstern verfügbar, in denen eine Farbe ausgewählt werden kann.

### Ändern einer Farbe

**Hinweis:** Sie können nur Farben ändern, die von Ihnen hinzugefügt wurden. Die ersten 24 Farben der Farbpalette sind Standardfarben, die sich nicht verändern lassen.

Um eine Farbe zu ändern, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Datei > Eigenschaften** auf und wechseln Sie auf die Karteikarte **Farben**.
   
   **Oder:** Alternativ können Sie auch den Eintrag **Andere...** in einer beliebigen Farbenliste verwenden, um diesen Dialog aufzurufen.

2. Wählen Sie die zu verändernde Farbe in der Liste **Farbpalette**.

3. Nehmen Sie die gewünschten Änderungen vor (siehe Abschnitt "Bedienung der Kontrollen zum Einstellen von Farben" weiter unten).
4. Klicken Sie auf Ändern.

Die Farbe wurde nun für das aktuelle Dokument verändert.

**Löschen oder Umbenennen einer Farbe**

Sie können selbstdefinierte Farben jederzeit löschen oder ihren Namen ändern. Rufen Sie dazu den Farbendialog auf, selektieren Sie eine Farbe in der Liste Farbpalette und betätigen Sie die Schaltfläche Löschen beziehungsweise Umbenennen.

**Bedienung der Kontrollen zum Einstellen von Farben**

Die Kontrollen im obigen Dialog lassen Sie Farben auf vielfältige Arten einstellen. Alle Wege führen zum gleichen Ergebnis – wählen Sie einfach die Methode, die Ihnen am meisten zusagt:

- **Verwenden des Farbfeldes und Helligkeitsreglers**


  Um eine Farbe einzustellen, klicken Sie zunächst in dem großen Farbfeld auf die gewünschte Farbe. Dann klicken Sie in dem Helligkeitsregler auf die gewünschte Helligkeit.

- **Verwenden der Regler für Ton, Sättigung und Helligkeit**

  Alternativ können Sie Farben mit den darunter befindlichen Reglern Ton (=Farbton), Sätt (=Sättigung) und Hell (=Helligkeit) einstellen. Zulässig sind Werte zwischen 0 und 240.

- **Verwenden der Regler für Rot, Grün und Blau**

  Farben lassen sich alternativ auch über ihre Rot-, Grün- und Blauanteile einstellen. Dazu dienen die Regler Rot, Grün und Blau. Zulässig sind Werte zwischen 0 und 255.

- **Eintippen des Hexcodes für eine Farbe**

  Sie können eine Farbe auch durch Eintippen ihres Hexcodes in das Eingabefeld mit dem Doppelkreuz # spezifizieren.

  Solche Hexcodes sind beispielsweise im HTML-Code von Webseiten gebräuchlich. Sie setzen sich aus drei zweistelligen hexadezimalen Werten für die Farben Rot, Grün und Blau zusammen (RRGGBB). 00FF00 steht beispielsweise für reines Grün.

---

**Dokumenteigenschaften, Karteikarte Statistik**

Auf der Karteikarte Statistik im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie statistische Informationen über das aktuelle Dokument abrufen (Zahl der Zeichen, Zahl der Sätze, durchschnittliche Wortlänge usw.).

**Tipp:** Wenn Sie vor dem Aufruf dieser Funktion einen Textabschnitt markieren, wird nur dieser berücksichtigt, ansonsten wird das gesamte Dokument ausgewertet.

Die einzelnen Angaben sind selbsterklärend, lediglich der Unterschied zwischen den ersten beiden Optionen bedarf einer Erläuterung:
- **Bei Anzahl Zeichen** werden nur die *sichtbaren* Zeichen gezählt.
- **Bei Anzahl Anschläge** gelten zusätzlich alle Leerzeichen (Leertaste, Tabulatortaste) als jeweils ein Anschlag.

Der Satz "Dies ist ein Test" hat dementprechend 14 Zeichen beziehungsweise 17 Anschläge (da er drei Leerzeichen enthält).

**Tipp: Verwenden der Statistikleiste**

Wenn Sie obige Statistikfunktionen regelmäßig benötigen, können Sie auch die *Statistikleiste* aktivieren, die diese Informationen permanent auf dem Bildschirm anzeigt.

![Statistikleiste](image)

Um diese Leiste ein- oder auszublenden, klicken Sie mit der rechten Maustaste auf eine beliebige Symbolleiste, worauf ein Menü aller verfügbaren Symbolleisten erscheint. Wählen Sie darin den Eintrag *Statistik*. Öffnen Sie dann die aufklappbare Liste in dieser Leiste und wählen Sie, welche Information angezeigt werden soll (Zeichen, Wörter, Sätze etc.).

**Hinweis:** Die Statistikleiste wird nur aktualisiert, wenn Sie darin die Schaltfläche mit den roten Pfeilen anklicken.

---

**Dokumenteigenschaften, Karteikarte Schutz**

Auf der Karteikarte *Schutz* im Dialogfenster des Menübefehls *Datei > Eigenschaften* können Sie das aktuelle Dokument mit einem *Dokumentschutz* versehen.

Öffnen beziehungsweise Speichern eines geschützten Dokuments ist nur nach Eingabe des korrekten Kennworts möglich. Dokumente mit Leseschutz werden dabei zusätzlich verschlüsselt, damit sie auch mit anderen Programmen nicht eingesehen werden können.

Informationen hierzu finden Sie im Kapitel [Dokumentschutz](#).

---

**Dokumenteigenschaften, Karteikarte Formular**


Wenn der Formularmodus aktiviert wurde, lassen sich nur noch Formularobjekte (Textfelder, Kontrollkästchen, AuswahlListen etc.) ausfüllen. Der Rest des Dokuments kann nicht mehr verändert werden.

**Hinweis:** Wenn Sie ein Dokument im Formularmodus speichern, wird es auch wieder im Formularmodus geöffnet.
Über die Option **Formularmodus aktiv** können Sie den Formularmodus aktivieren beziehungsweise deaktivieren.

**Tipp:** Hierzu können Sie auch den Menübefehl **Ansicht > Formularmodus** verwenden.

Wenn Sie den Formularmodus aktivieren und zusätzlich ein **Kennwort zum Deaktivieren** angeben, erscheint beim Versuch, den Formularmodus wieder zu deaktivieren, eine Kennwortabfrage. Der Formularmodus kann nur dann verlassen werden, wenn der Anwender das korrekte Kennwort eingibt.

**Wichtig:** Wenn Sie ein Dokument mit Kennwort im Formularmodus speichern und dann das Kennwort vergessen, haben Sie keine Möglichkeit mehr, den Formularmodus zu verlassen. Merken Sie sich das Kennwort also gut oder notieren Sie es an geeigneter Stelle!

Ausführliche Informationen zum Arbeiten mit Formularen finden Sie im Kapitel **Formulare**.

**Formularfelder schattieren**

Weiterhin finden Sie auf dieser Karteikarte eine Option namens **Formularfelder schattieren**. Wird sie aktiviert, werden alle Formularobjekte (Textfelder, Kontrollkästchen, Auswahllisten etc.) im Text mit einer hellgrauen Schattierung hervorgehoben. Dadurch heben sich diese besser vom Rest des Formulars ab.

---

**Dokumenteigenschaften, Karteikarte Überarbeiten**

Auf der Karteikarte **Überarbeiten** im Dialogfenster des Menübefehls **Datei > Eigenschaften** können Sie Einstellungen zu den Funktionen zum Kommentieren und Überarbeiten von Dokumenten vornehmen.

Informationen zu diesen Einstellungen finden Sie in den folgenden Abschnitten:

- [Einstellungen zu Kommentaren](#)
- [Einstellungen zur Funktion Änderungen verfolgen](#)

Allgemeine Informationen zum Kommentieren und Überarbeiten von Dokumenten sind im Kapitel **Überarbeiten von Dokumenten** verfügbar.

---

**Dokumenteigenschaften, Karteikarte Schriften**

Auf der Karteikarte **Schriften** im Dialogfenster des Menübefehls **Datei > Eigenschaften** wird eine Liste aller im aktuellen Dokument verwendeten Schriftarten angezeigt.

Die Liste ist aufgeteilt nach Schriften, die auf dem aktuell verwendeten Gerät verfügbar sind, und solchen, die nicht verfügbar (sprich: installiert) sind.
**Bildschirmdarstellung ändern**

In diesem Abschnitt erfahren Sie, wie Sie die Darstellung des Dokuments auf dem Bildschirm anpassen können. Die meisten dazu benötigten Befehle finden Sie im Menü **Ansicht**.

Das Menü **Ansicht** enthält folgende Befehle:

<table>
<thead>
<tr>
<th>Menübefehl</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normal</strong></td>
<td>Schaltet die Dokumentansicht in die <em>Normalansicht</em> um. Das ist die Ansicht, in der Sie üblicherweise mit TextMaker arbeiten.</td>
</tr>
<tr>
<td><strong>Konzept</strong></td>
<td>Schaltet in die <em>Konzeptansicht</em> um. Diese stellt das Dokument in einer stark vereinfachten Ansicht dar, die sich optimal zum Lesen des reinen Textes im Dokument eignet. Das Dokument wird dabei nicht mehr in Form von Einzelseiten dargestellt, sondern als langer, durchgehender Text. Außerdem werden die Zeilen des Textes automatisch neu umbrochen – und zwar auf die volle Breite des Dokumentfensters. (Dieses Verhalten können Sie auf Wunsch deaktivieren, indem Sie die Option <em>Zeilen am Fensterrand umbrechen</em> auf der Karteikarte <em>Anzeige</em> in den Einstellungen ausschalten.)</td>
</tr>
<tr>
<td><strong>Masterseiten</strong></td>
<td>Schaltet in die <em>Masterseitenansicht</em> um. Darin können Sie ausschließlich die <em>Masterseite(n)</em> des Dokuments bearbeiten. Objekte, die sich auf der Masterseite befinden, werden auf jeder Seite des Dokuments gedruckt. Siehe Abschnitt <strong>Masterseiten</strong>.</td>
</tr>
<tr>
<td><strong>Gliederung</strong></td>
<td>Schaltet in die <em>Gliederungsansicht</em> um. Darin lässt sich die Gliederung des Dokuments bearbeiten. Sie können Text zu einer Überschrift &quot;ernennen&quot; und vorhandene Überschriften höher- oder tieferstufen. Siehe Abschnitt <strong>Gliederungen</strong>.</td>
</tr>
<tr>
<td><strong>Originalgröße etc.</strong></td>
<td>Mit den Menübefehlen <strong>Ansicht &gt; Originalgröße</strong> bis <strong>Ansicht &gt; Vergrößerungsstufe</strong> können Sie die Vergrößerungsstufe bestimmen, in der das Dokument angezeigt wird. Siehe Abschnitt <strong>Vergrößerungsstufe ändern</strong>.</td>
</tr>
<tr>
<td><strong>Objektmodus</strong></td>
<td>Schaltet den <em>Objektmodus</em> ein/aus. Im Objektmodus ist keine Textbearbeitung mehr möglich, dafür lassen sich Objekte (Grafiken, Rahmen etc.) komfortabler bearbeiten. Siehe Abschnitt <strong>Der Objektmodus</strong>.</td>
</tr>
<tr>
<td><strong>Formularmodus</strong></td>
<td>Schaltet den <em>Formularmodus</em> ein/aus. Im Formularmodus lassen sich nur noch Formularobjekte (z.B. Textfelder, Kontrollkästchen, Auswahllisten) ausfüllen. Der Rest des Dokuments kann nicht mehr verändert werden. Siehe Kapitel <strong>Formulare</strong>.</td>
</tr>
<tr>
<td><strong>Symbolleisten</strong></td>
<td>Öffnet ein Dialogfenster, mit dem Sie Symbolleisten ein-/ausblenden, positionieren und bearbeiten können. Siehe Abschnitt <strong>Symbolleisten anpassen</strong>.</td>
</tr>
<tr>
<td><strong>Vollbild</strong></td>
<td>Mit diesem Befehl können Sie in die <em>Vollbildansicht</em> wechseln, in der das Programm den gesamten Bildschirm zur Darstellung des Dokuments nutzt. Siehe Abschnitt <strong>Vollbildansicht</strong>.</td>
</tr>
</tbody>
</table>
Anpassen von TextMaker

Linealleiste
Schaltet die Linealleiste ein-/aus. Siehe Abschnitt Dokument.

Seitenleiste
Schaltet die Seitenleiste ein-/aus. Mit dieser können Sie unter anderem im Dokument navigieren. Siehe Abschnitt Dokument.

Weitere Einstellungen zur Bildschirmdarstellung können über die folgenden Befehle vorgenommen werden:

- Mit dem Menübefehl Weitere > Einstellungen lassen sich Grundeinstellungen vornehmen, die für alle Dokumente gelten (siehe Abschnitt Einstellungen, Karteikarte Ansicht).
- Mit dem Menübefehl Datei > Eigenschaften lassen sich Einstellungen vornehmen, die nur für das momentan geöffnete Dokument gelten (siehe Abschnitt Dokumenteigenschaften, Karteikarte Ansicht).

Vergrößerungsstufe ändern

Bei TextMaker haben Sie vielfältige Möglichkeiten, festzulegen, in welcher Vergrößerungsstufe ein Dokument auf dem Bildschirm dargestellt werden soll.

Verwenden Sie dafür die folgenden Befehle des Menüs Ansicht:

<table>
<thead>
<tr>
<th>Menübefehl</th>
<th>Funktion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Originalgröße</td>
<td>Anzeige mit einer Vergrößerungsstufe von 100%. Dies ist die Standardeinstellung.</td>
</tr>
<tr>
<td>Textbreite</td>
<td>Stellt die Vergrößerungsstufe automatisch so ein, dass der Textbereich des Dokuments der Breite nach genau in das Dokumentfenster passt (ohne Kommentare und Textrahmen).</td>
</tr>
<tr>
<td>Seitenbreite</td>
<td>Stellt die Vergrößerungsstufe automatisch so ein, dass die Seite der Breite nach genau in das Dokumentfenster passt (einschließlich Kommentaren und Textrahmen).</td>
</tr>
<tr>
<td>Ganze Seite</td>
<td>Zeigt eine ganze Seite des Dokuments auf einmal an.</td>
</tr>
<tr>
<td>Zwei ganze Seiten</td>
<td>Zeigt zwei ganze Seiten nebeneinander an.</td>
</tr>
<tr>
<td>Lupe</td>
<td>Aktiviert die Lupe. Ziehen Sie anschließend mit der Maus einen Rahmen um einen beliebigen Ausschnitt des Dokuments, um diesen zu vergrößern.</td>
</tr>
<tr>
<td>Vergrößerungsstufe</td>
<td>Lässt Sie die Vergrößerungsstufe aus einer Liste auswählen. Sie können auch einen Wert von Hand eingeben (z.B. &quot;125&quot; für eine Vergrößerungsstufe von 125%).</td>
</tr>
</tbody>
</table>

Tipp: Verwenden des Zoomreglers

Sie können die Vergrößerungsstufe auch mit dem Zoomregler in der rechten unteren Bildschirmecke ändern.

Ziehen Sie dazu entweder an dem Schieber in der Mitte, oder klicken Sie auf das Minus- oder Plussymbol, um die Vergrößerungsstufe zu verändern.

Tipp: Wenn Sie auf die Prozentangabe rechts neben dem Zoomregler klicken, öffnet sich der Dialog des oben erwähnten Befehls Ansicht > Vergrößerungsstufe.
Vollbildansicht

Mit dem Menübefehl **Ansicht > Vollbild** können Sie in die **Vollbildansicht** schalten, in der das Programm den gesamten Bildschirm zur Darstellung des Dokuments nutzt. TextMaker vergrößert dazu sein Programmfenster auf die volle Bildschirmgröße und blendet sämtliche Symbolleisten aus.

Um diesen Ansichtsmodus wieder zu verlassen, drücken Sie die Taste **Esc** oder rufen den Menübefehl **Ansicht > Vollbild** noch einmal auf.

**Verwenden der Symbolleiste der Vollbildansicht**

Wenn Sie den Vollbildmodus aktivieren, erscheint eine zusätzliche Symbolleiste auf dem Bildschirm.

Diese hat folgende Funktionen (von links nach rechts):

- Menüleiste ein-/ausblenden
- Seitenleiste ein-/ausblenden
- Modus "Blatt verschieben" aktivieren/deaktivieren
  
  Wenn Sie den Modus "Blatt verschieben" aktivieren, können Sie das Dokument mit der Maus verschieben. Klicken Sie dazu in das Dokument und ziehen Sie es bei weiterhin gedrückter Maustaste in die gewünschte Richtung.

  Hinweis: Das Anklicken von Text, um die Schreibmarke zu setzen, sowie das Selektieren von Text oder Objekten ist in diesem Modus nicht mehr möglich.

  Um den Modus "Blatt verschieben" wieder zu verlassen, klicken Sie dieses Symbol noch einmal an.

- Die Schaltfläche **Schließen** beendet den Vollbildmodus.

Symbolleisten anpassen

*Nur bei "klassischen Menüs und Symbolleisten":* Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit *klassischen Menüs und Symbolleisten* bedienen möchten. (Informationen zum Anpassen des *Ribbons* finden Sie im Abschnitt *Ribbon (Menüband) anpassen*.)

**Tipp:** Die Benutzeroberfläche lässt sich jederzeit zwischen *Ribbon* und *klassischen Menüs mit Symbolleisten* umschalten. Rufen Sie dazu im Menü den Befehl **Weiteres > Einstellungen** auf (beziehungsweise im Ribbon den Befehl **Datei > Einstellungen**). Wechseln Sie in dem Dialog auf die Karteikarte **Ausschneiden** und klicken Sie darin auf die Schaltfläche **Benutzeroberfläche**. Es erscheint ein weiterer Dialog, in dem Sie die gewünschte Art von Benutzeroberfläche wählen können.
In diesem Abschnitt erfahren Sie, wie Sie die Symbolleisten (Funktionsleiste, Formatleiste etc.) mit dem Menübefehl **Ansicht > Symbolleisten** konfigurieren und mit **Weiteres > Anpassen** nach Ihren Wünschen anpassen können.

Eine Symbolleiste (hier: die Funktionsleiste)

 Folgende Themen werden darin behandelt:

- **Symbolleisten anzeigen/verbergen**
- **Symbolleisten auf dem Bildschirm positionieren**
- **Symbolleisten verwalten** (Symbolleisten erstellen, löschen, umbenennen, zurücksetzen)
- **Symbole einer Symbolleiste anpassen** (Symbole hinzufügen, entfernen, verschieben)
- **Verwenden des Symbolleisten-Menüs** (für besonders schnellen Zugriff auf obige Funktionen)

Informationen dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

---

**Symbolleisten anzeigen/verbergen**

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt **Ribbon (Menüband) anpassen**.)

Sie können die verfügbaren Symbolleisten jederzeit ein- oder ausschalten, um diese sichtbar zu machen beziehungsweise zu verbergen.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl **Ansicht > Symbolleisten** auf.
3. Verlassen Sie das Dialogfenster mit **Schließen**.

Die entsprechende Symbolleiste wurde nun ein-beziehungsweise ausgeschaltet.

_Tipp:_ Hierfür gibt es eine Abkürzung: Wenn Sie mit der rechten Maustaste auf eine beliebige Symbolleiste klicken, erscheint ein Menü mit einer Liste aller verfügbaren Symbolleisten. Klicken Sie einen dieser Menüeinträge an, wird die entsprechende Leiste ein- beziehungsweise ausgeschaltet.

---

**Sichtbar in Modus**

Manche Symbolleisten werden nur in bestimmten Situationen angezeigt. Zum Beispiel erscheint die Grafikleiste nur dann, wenn Sie ein Bild selektieren.

Zuständig hierfür ist die Option **Sichtbar in Modus**, die bestimmt, wann eine Symbolleiste sichtbar sein soll. Einige Beispiele:
Anpassen von TextMaker

<table>
<thead>
<tr>
<th>Option</th>
<th>Erläuterung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alle</td>
<td>Die gewählte Symbolleiste ist <em>immer</em> sichtbar (sofern sie natürlich nicht ausgeschaltet wurde).</td>
</tr>
<tr>
<td>Editiermodus</td>
<td>Die Leiste ist nur im normalen <em>Editiermodus</em> sichtbar, nicht jedoch im Objektmodus (siehe auch Abschnitt Der Objektmodus). Beispiel: Formatleiste</td>
</tr>
<tr>
<td>Objekt</td>
<td>Die Leiste ist nur im <em>Objektmodus</em> sichtbar, nicht jedoch im normalen Editiermodus (siehe auch Abschnitt Der Objektmodus). Beispiel: Objektleiste</td>
</tr>
<tr>
<td>Gliederung</td>
<td>Die Symbolleiste ist nur in der <em>Gliederungsansicht</em> sichtbar (siehe auch Abschnitt Gliederungsansicht verwenden). Beispiel: Gliederungsleiste</td>
</tr>
<tr>
<td>Datenbank</td>
<td>Die Symbolleiste ist nur im Datenbankmodul sichtbar. Beispiel: Datenbankleiste</td>
</tr>
<tr>
<td>Grafik</td>
<td>Die Symbolleiste erscheint nur, wenn im Dokument eine Grafik selektiert wird. Beispiel: Grafikleiste</td>
</tr>
<tr>
<td>Kopfzeile/Fußzeile</td>
<td>Die Symbolleiste erscheint nur, wenn sich die Schreibmarke in einer Kopfzeile oder Fußzeile befindet.</td>
</tr>
</tbody>
</table>

Um diese Einstellung für eine der Symbolleisten zu ändern, rufen Sie den Menübefehl *Ansicht > Symbolleisten* auf, selektieren die Leiste in der Liste *Symbolleisten* und wählen die gewünschte Option bei *Sichtbar in Modus*.

**Hinweis:** Es ist normalerweise nicht empfehlenswert, diese Einstellung bei den Standard-Symbolleisten (Funktionsleiste, Formatleiste etc.) zu ändern. Diese Option ist in erster Linie für selbsterstellte Symbolleisten gedacht.

### Symbolleisten auf dem Bildschirm positionieren

*Nur bei "klassischen Menüs und Symbolleisten"*: Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menüband) anpassen.)

Sie können jede einzelne Symbolleiste nach Belieben auf dem Bildschirm positionieren. Verwenden Sie dazu eines der folgenden Verfahren:

**Ändern der Position mit dem Befehl Ansicht > Symbolleisten**

Sie können die Position einer Symbolleiste jederzeit mit dem Menübefehl *Ansicht > Symbolleisten* ändern. Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl *Ansicht > Symbolleisten* auf.
2. Selektieren Sie die gewünschte Symbolleiste per Mausklick in der Liste.
3. Wählen Sie bei *Position*, wo die Symbolleiste platziert werden soll.
Hinweis: Wenn Sie die Option Frei wählen, werden die Symbole der Symbolleiste in einem Fenster angezeigt, das wie ein Programmfenster frei bewegt, vergrößert und verkleinert werden kann.

Ändern der Position mit der Maus

Manche Symbolleisten lassen sich außerdem mit der Maus verschieben. Gehen Sie dazu wie folgt vor:

1. Zeigen Sie mit der Maus auf einen leer Bereich der Symbolleiste.
2. Drücken Sie die linke Maustaste und halten Sie diese gedrückt.
3. Ziehen Sie die Symbolleiste bei weiterhin gedrückter Maustaste an die gewünschte Position.
4. Lassen Sie die Maustaste los, um die Symbolleiste dort abzusetzen.


Beim Verschieben ist übrigens eine Positionierhilfe aktiv: Wenn Sie die Symbolleiste in die Nähe einer der Kanten des Programmfensters ziehen, springt diese automatisch auf die entsprechende Kante. Lassen Sie die Leiste beispielsweise an der oberen Kante los, entspricht dies dem Wählen der Position Oben im Dialogfenster des Menübefehls Ansicht > Symbolleisten.

Symbolleisten verwalten

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menüband) anpassen.)

Sie können jederzeit neue Symbolleisten erstellen und vorhandene Leisten löschen, umbenennen etc. Verwenden Sie hierzu die Schaltflächen im Dialogfenster des Menübefehls Ansicht > Symbolleisten.

Neue Symbolleiste erstellen

Das Programm lässt Sie jederzeit eigene Symbolleisten erstellen.

Benötigen Sie beispielsweise häufig die Befehle des Menüs Fenster, die in der Standard-Funktionsleiste nicht vorhanden sind, wäre es überlegenswert, sich für diese eine eigene Symbolleiste anzulegen.

Folgendermaßen erstellen Sie eine neue Symbolleiste:

1. Betätigen Sie die Schaltfläche Neu (im Dialogfenster des Menübefehls Ansicht > Symbolleisten).
2. Es erscheint ein Dialogfenster, in das Sie einen Namen für die neue Leiste eingeben – zum Beispiel "Meine Symbolleiste". Bestätigen Sie dann mit OK.
**Symbole einer Symbolleiste anpassen**

Mit der Schaltfläche **Anpassen** können Sie die Symbole auf Symbolleisten bearbeiten. Informationen hierzu finden Sie im nächsten Abschnitt.

**Symbolleiste löschen**

Mit der Schaltfläche **Löschen** entfernen Sie eine selbsterstellte Symbolleiste:

1. Selektieren Sie die zu löschende Symbolleiste in der Liste.
2. Betätigen Sie die Schaltfläche **Löschene**.

Hinweis: Sie können nur selbsterstellte Symbolleisten löschen. Die Standard-Symbolleisten (Funktionsleiste, Formatleiste etc.) lassen sich nicht entfernen.

Sie können eine Standard-Symbolleiste jedoch jederzeit ausschalten, wenn Sie sie nicht benötigen (siehe Abschnitt **Symbolleisten anzeigen/verbergen**).

**Symbolleiste umbenennen**

Mit der Schaltfläche **Umbenennen** geben Sie einer selbsterstellten Symbolleiste einen anderen Namen:

1. Selektieren Sie die gewünschte Symbolleiste in der Liste.
2. Betätigen Sie die Schaltfläche **Umbenennen**.
3. Tippen Sie den neuen Namen ein und bestätigen Sie mit **OK**.

Hinweis: Sie können nur selbsterstellte Symbolleisten umbenennen. Die Standard-Symbolleisten (Funktionsleiste, Formatleiste etc.) lassen sich nicht umbenennen.

**Symbolleisten zurücksetzen**

Mit der Schaltfläche **Zurücksetzen** machen Sie alle Änderungen an einer der Standard-Symbolleisten rückgängig:

1. Selektieren Sie die gewünschte Symbolleiste in der Liste.
2. Betätigen Sie die Schaltfläche **Zurücksetzen**.

Nun enthält die Symbolleiste wieder die Standard-Symbole. Außerdem wurden die Optionen **Sichtbar in Modus...** und **Position** auf die Standardeinstellung zurückgesetzt.

Hinweis: Dieser Befehl ist nur auf die Standard-Symbolleisten (Funktionsleiste, Formatleiste etc.) anwendbar, nicht jedoch auf selbsterstellte Symbolleisten.

**Alle Symbolleisten zurücksetzen**

Mit der Schaltfläche **Alle zurücksetzen** machen Sie alle Änderungen an allen Standard-Symbolleisten rückgängig.

Hinweis: Dieser Befehl wirkt sich nur auf die Standard-Symbolleisten aus. Selbsterstellte Symbolleisten bleiben unverändert erhalten.
**Symbole einer Symbolleiste anpassen**

*Nur bei "klassischen Menüs und Symbolleisten":* Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menüband) anpassen.)

Der Menübefehl Weiteres > Anpassen erlaubt es Ihnen, die Symbole auf einer Symbolleiste nach Ihren Wünschen anzupassen. Sie können unter anderem Symbole hinzufügen und vorhandene Symbole entfernen oder verschieben.

Gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Weiteres > Anpassen auf.
2. Verwenden Sie eines der unten beschriebenen Verfahren, um Symbole hinzuzufügen, zu entfernen, zu verschieben etc.

*Tipp:* Dieser Befehl lässt sich auch durch einen Doppelklick auf einen leer Bereich in einer beliebigen Symbolleiste aufrufen.

Beim Aufruf des Befehls erscheint ein Dialogfenster.

Dieses Dialogfenster enthält zwei Listen:

- **Linke Liste: alle verfügbaren Befehle**
  
  Die linke Liste zeigt sämtliche im Programm verfügbaren Befehle an.

  Tipp: Über die Option Kategorien (oberhalb der linken Liste) können Sie die Liste nach einer bestimmten Kategorie filtern lassen (zum Beispiel alle Kommandos der Kategorie "Datei").

  Außerdem können Sie in das Feld Schnellsuche etwas eintippen, um die Liste danach durchsuchen zu lassen.

- **Rechte Liste: Symbole der momentan ausgewählten Symbolleiste**
  
  Die rechte Liste zeigt die Symbole an, die sich in der momentan ausgewählten Symbolleiste befinden.

  Welche Symbolleiste hier angezeigt werden soll, lässt sich über die aufklappbare Liste Anpassen (oberhalb der rechten Liste) festlegen.

In dem Dialog lassen sich folgende Aktionen durchführen:

**Hinzufügen eines Symbols**

Um ein Symbol zu einer bestimmten Symbolleiste hinzuzufügen, führen Sie im Dialogfenster des Befehls Weiteres > Anpassen folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen (oberhalb der rechten Liste) die Symbolleiste, zu der Sie ein Symbol hinzufügen möchten.

   Die rechte Liste zeigt nun alle Symbole an, die sich momentan in der gewählten Symbolleiste befinden.
2. Optional: Selektieren Sie in der *rechten* Liste das Symbol, hinter dem das neue Symbol eingefügt werden soll.


4. Klicken Sie auf die Schaltfläche >> (zwischen den Listen).

Das Symbol wird der Symbolleiste nun hinzugefügt.


---

### Entfernen eines Symbols

Um ein Symbol aus einer Symbolleiste zu entfernen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste *Anpassen* (oberhalb der rechten Liste) die gewünschte Symbolleiste.

2. Selektieren Sie in der rechten Liste das zu entfernende Symbol.


Das Symbol wird nun aus der Symbolleiste entfernt.

_Tipp:_ Alternativ können Sie ein Symbol auch folgendermaßen aus einer Symbolleiste entfernen: Rufen Sie den Befehl *Weiteres > Anpassen* auf. Ziehen Sie dann das Symbol einfach mit der Maus aus der Symbolleiste nach unten heraus (in der Symbolleiste selbst, nicht im Dialog!).

---

### Verschieben eines Symbols

Um ein Symbol in einer Symbolleiste zu verschieben, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste *Anpassen* die gewünschte Symbolleiste.

2. Selektieren Sie in der rechten Liste das zu verschiebende Symbol.

3. Verwenden Sie die Schaltflächen mit dem Pfeil nach oben beziehungsweise unten (links neben der rechten Liste), um das Symbol innerhalb der Symbolleiste zu verschieben.

_Hinweis:_ Wenn Sie ein Symbol auf eine **andere** Symbolleiste verschieben möchten, müssen Sie dieses erst aus seiner bisherigen Symbolleiste entfernen und es dann der anderen Symbolleiste hinzufügen.

_Tipp 1:_ Alternativ können Sie ein Symbol auch folgendermaßen verschieben: Rufen Sie den Befehl *Weiteres > Anpassen* auf. Ziehen Sie das Symbol dann direkt in der Symbolleiste mit der Maus an die gewünschte Position (in der Symbolleiste selbst, nicht im Dialog!). Bei dieser Methode können Sie ein Symbol übrigens auch direkt von einer Symbolleiste in eine andere verschieben.

_Tipp 2:_ Das Verschieben von Symbolen funktioniert übrigens auch, wenn dieser Dialog *nicht* geöffnet ist: Wenn Sie nämlich die Taste **Alt** gedrückt halten und dann auf ein Symbol in einer Symbolleiste klicken, können Sie dieses (bei weiterhin gedrückter Maustaste) nach Belieben verschieben.
**Einfügen einer Trennlinie (Separator)**

Um in einer Symbolleiste eine Trennlinie vor einem Symbol einzufügen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste **Anpassen** die gewünschte Symbolleiste.
2. Selecctieren Sie in der rechten Liste das Symbol, vor dem die Trennlinie eingefügt werden soll.
3. Klicken Sie auf die Schaltfläche **Neuer Trenner** (unterhalb der rechten Liste).

Die Trennlinie wird nun eingefügt.

*Tipp:* Alternativ können Sie auch folgende Vorgehensweise verwenden: Rufen Sie den Befehl **Weiteres > Anpassen** auf. Um nun eine Trennlinie links von einem Symbol in einer beliebigen Symbolleiste einzufügen, ziehen Sie dieses Symbol einfach mit der Maus einige Millimeter nach rechts (in der Symbolleiste selbst, nicht im Dialog!).

**Entfernen einer Trennlinie**

Um eine Trennlinie aus einer Symbolleiste zu entfernen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste **Anpassen** die gewünschte Symbolleiste.
2. Selecctieren Sie in der rechten Liste die zu entfernende Trennlinie.

Die Trennlinie wird nun aus der Symbolleiste entfernt.

*Tipp:* Alternativ können Sie auch folgende Vorgehensweise verwenden: Rufen Sie den Befehl **Weiteres > Anpassen** auf. Wenn Sie nun (in der Symbolleiste selbst, nicht im Dialog!) ein Symbol, das sich rechts von einer Trennlinie befindet, an das Symbol links davon heranziehen, wird diese Trennlinie entfernt.

**Zuweisen von Tastenkürzeln**

Wenn Sie in dem Dialog die Schaltfläche **Tastenkürzel** anklicken, erweitert sich der Dialog um eine zusätzliche Sektion namens **Tastenkürzel**, die zum Bearbeiten von Tastenkürzeln für Befehle verwendet werden kann.

Kurzfassung: Sie können hier einem beliebigen Befehl ein Tastenkürzel Ihrer Wahl zuweisen: Selektieren Sie den Befehl dazu in einer der beiden Listen, klicken Sie in das Feld **Bitte Tastenkürzel drücken** und bestätigen Sie dann die Tastenkombination, mit der Sie diesen Befehl künftig aufrufen möchten.

Ausführliche Informationen dazu finden Sie im Abschnitt **Tastenkürzel anpassen**.

**Verwalten von Symbolleisten**

Das Dialogfenster des Befehls **Weiteres > Anpassen** verfügt außerdem über Schaltflächen zum Verwalten von Symbolleisten:

- **Neu**

  Legt eine neue, leere Symbolleiste an.
Umbenennen
Benennt die in der Liste **Anpassen** gewählte Symbolleiste um (nur bei selbsterstellten Symbolleisten möglich).

Zurücksetzen
Setzt die in der Liste **Anpassen** gewählte Symbolleiste wieder auf ihren Auslieferungszustand zurück.

Löschen
Löscht die in der Liste **Anpassen** gewählte Symbolleiste (nur bei selbsterstellten Symbolleisten möglich).

Alle zurücksetzen (unterhalb der rechten Liste)
Setzt alle Symbolleisten wieder auf ihren Auslieferungszustand zurück.

Weitere Möglichkeiten zum Verwalten und Konfigurieren von Symbolleisten bietet der Menübefehl **Ansicht > Symbolleisten** (siehe Abschnitt **Symbolleisten verwalten**).

---

**Verwenden des Symbolleisten-Menüs**

*Nur bei "klassischen Menüs und Symbolleisten":* Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit **klassischen Menüs und Symbolleisten** bedienen möchten. (Informationen zum Anpassen des **Ribbons** finden Sie im Abschnitt **Ribbon (Menüband) anpassen**.)

Einige Symbolleisten enden mit einem doppelten Pfeil » nach rechts, wie in folgender Abbildung zu sehen:

![Symbolleisten-Menü](image)

Wenn Sie diesen Doppelpfeil anklicken, öffnet sich das **Symbolleisten-Menü** für diese Leiste.

Dieses Menü ermöglicht schnellen Zugriff auf alle Befehle zum Arbeiten mit Symbolleisten, die in den vorherigen Abschnitten beschrieben wurden. Im Einzelnen gibt es im Symbolleisten-Menü folgende Befehle:

- **Schaltflächen hinzufügen/entfernen**

  (Dieser Befehl soll nur zum schnellen Ein- oder Ausschalten von Symbolen dienen. Wie Sie die Symbole auf einer Leiste individuell konfigurieren, ist im Abschnitt **Symbole einer Symbolleiste anpassen** beschrieben.)

- **Position**
  Mit diesem Befehl können Sie die Position der Symbolleiste ändern. Verfügbare Optionen: oben, unten, links, rechts oder frei (in einem kleinen Fenster, dessen Position und Größe sich mit der Maus beliebig ändern lassen).

- **Symbolleisten**
  Ruft den Menübefehl **Ansicht > Symbolleisten** auf, mit dem Sie Symbolleisten ein-/ausschalten, konfigurieren und verwalten können.
Anpassen von TextMaker

Siehe Abschnitt Symbolleisten anpassen.

- **Anpassen**
  
  Ruft den Menübefehl Weiteres > Anpassen auf, mit dem Sie die Symbole einer Symbolleiste bearbeiten können (Symbole hinzufügen, entfernen, verschieben etc.).

  Siehe Abschnitt Symbole einer Symbolleiste anpassen.

- **Diese Symbolleiste zurücksetzen**
  

---

**Ribbon (Menüband) anpassen**

*Nur bei "Ribbons":* Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)


In diesem Abschnitt erfahren Sie, wie Sie das Ribbon (Menüband) konfigurieren und um zusätzliche Symbole erweitern können.

Das "Ribbon" (Ausschnitt) und die Schnellzugriffsleiste (unten)

Folgende Themen werden darin behandelt:

- Ribbon anzeigen/verbergen
- Position der Schnellzugriffsleiste ändern
- Symbole im Ribbon anpassen
- Symbole der Schnellzugriffsleiste anpassen

Informationen dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.
Anpassen von TextMaker

Ribbon anzeigen/verbergen

**Nur bei "Ribbons":** Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)

Normalerweise ist das Ribbon-Menüband immer vollständig zu sehen:

Sie können das Ribbon aber jederzeit ausblenden, indem Sie es minimieren. Dies ist hilfreich, wenn Sie auf dem Bildschirm möglichst viel Platz für die Anzeige des Dokuments erhalten möchten.

Gehen Sie wie folgt vor:

1. Klicken Sie im Ribbon auf das Symbol **Anpassen** in der Karteikarte **Datei**.
2. Es öffnet sich ein Menü. Darin finden Sie eine Option namens **Minimiertes Ribbon**, die sich durch Anklicken ein- beziehungsweise ausschalten lässt. (Ein Häkchen erscheint vor der Option, wenn sie derzeit eingeschaltet ist.)

Wenn Sie diese Option einschalten, wird das Ribbon minimiert dargestellt. Es sind dann nur noch seine Karteikartenreiter zu sehen.

**Tipp:** Sie können alternativ auch das Symbol in der rechten oberen Ecke des Programmfensters anklicken, um das Ribbon zu minimieren. Wenn Sie das Symbol erneut anklicken, wird das Minimieren wieder aufgehoben.

Darüber hinaus können Sie die Tastenkombination **Strg+F1** (beim Mac: **Cmd+F1**) verwenden, um das Minimieren ein-/auszuschalten.

**Arbeiten mit einem minimierten Ribbon**

Folgendermaßen arbeiten Sie mit einem minimierten Ribbon:
Wenn Sie einen der Karteikartenreiter des minimierten Ribbons anklicken, wird das Ribbon *vorübergehend* wieder vollständig sichtbar und zeigt die entsprechende Karteikarte an. Sobald Sie darin aber ein Kommando auslösen (also z.B. das Symbol für einen Befehl anklicken), wird das Ribbon automatisch wieder minimiert.

Wenn Sie auf einen der Karteikartenreiter *doppelt* klicken, wird das Ribbon *dauerhaft* wieder sichtbar, das Minimieren wird also aufgehoben.

Wie oben bereits als Tipp erwähnt, können Sie außerdem das Symbol ☀ in der rechten oberen Ecke des Programmfensters verwenden, um das Minimieren des Ribbons ein-/auszuschalten.

---

**Position der Schnellzugriffsleiste ändern**

*Nur bei "Ribbons":* Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt [Symbolleisten anpassen](#).) Unter dem Ribbon wird die Schnellzugriffsleiste angezeigt. Diese bietet eine Auswahl an besonders häufig benötigten Befehlen.

Das "Ribbon" (Ausschnitt) und die Schnellzugriffsleiste (unten)

Die Schnellzugriffsleiste kann sich wahlweise den Platz mit den Registerkarten für Dokumente teilen – oder in seiner eigenen Leiste untergebracht sein. Um dies zu ändern, gehen Sie folgendermaßen vor:

1. Klicken Sie im Ribbon auf das Symbol *Anpassen* in der Karteikarte *Datei*.
2. Es öffnet sich ein Menü, das einen der folgenden beiden Befehle enthält:

   **Schnellzugriffsleiste als separate Leiste anzeigen:** Standardmäßig wird die Schnellzugriffsleiste in der Leiste angezeigt, in der sich auch die Registerkarten für Dokumente befinden. Wenn Sie diesen Befehl aufrufen, wandert die Schnellzugriffsleiste stattdessen in seine eigene Leiste.

   **Schnellzugriffsleiste links der Dokumentregisterkarten anzeigen:** Dieser Befehl macht genau das Gegenteil: Wenn die Schnellzugriffsleiste derzeit als separate Symbolleiste angezeigt wird, bewirkt das Aufrufen dieses Befehls, dass die Schnellzugriffsleiste nun wieder in die Leiste mit den Registerkarten für Dokumente befördert wird.
Symbole im Ribbon anpassen

Nur bei "Ribbons": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)

Der Ribbonbefehl Datei > Anpassen > Ribbon anpassen ermöglicht es Ihnen, das Ribbon in einem gewissen Rahmen anzupassen. In erster Linie soll dieser Befehl dazu dienen, dem Ribbon zusätzliche Symbole, Sektionen oder gar komplette Karteikarten hinzuzufügen.


Gehen Sie zum Anpassen des Ribbons wie folgt vor:
1. Rufen Sie im Ribbon den Befehl Datei > Anpassen > Ribbon anpassen auf.
2. Verwenden Sie eines der unten beschriebenen Verfahren, um die Symbole auf einer Karteikarte des Ribbons zu bearbeiten.

Tipp: Dieser Befehl lässt sich auch durch einen Doppelklick auf einen beliebigen leer Bereich innerhalb des Ribbons aufrufen.

Beim Aufruf des Befehls erscheint ein Dialogfenster.

Dieses Dialogfenster enthält zwei Listen:

- **Linke Liste: alle verfügbaren Befehle**

  Die linke Liste zeigt sämtliche im Programm verfügbaren Befehle an.

  Tipp: Über die Option Kategorien (oberhalb der linken Liste) können Sie die Liste nach einer bestimmten Kategorie filtern lassen (zum Beispiel alle Kommandos der Kategorie "Datei").

  Außerdem können Sie in das Feld Schnellsuche etwas eintippen, um die Liste danach durchsuchen zu lassen.

- **Rechte Liste: Symbole der momentan ausgewählten Karteikarte des Ribbons**

  Die rechte Liste zeigt die Symbole an, die sich in der ausgewählten Karteikarte des Ribbons befinden.

  Welche Karteikarte hier angezeigt werden soll, lässt sich über die aufklappbare Liste Anpassen (oberhalb der rechten Liste) festlegen.

In dem Dialog lassen sich folgende Aktionen durchführen:
Hinzufügen eines Symbols

_Hinweis:_ Sie können Symbole nur in selbst hinzugefügten Sektionen (oder komplett neuen Karteikarten) hinzufügen. Das Einfügen eines Symbols innerhalb der vorgegebenen Sektionen ist nicht möglich.

Um ein Symbol zu einer bestimmten Karteikarte des Ribbons hinzuzufügen, führen Sie im Dialogfenster des Ribbonbefehls **Datei > Anpassen > Ribbon anpassen** folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste **Anpassen** (oberhalb der rechten Liste) die Karteikarte, zu der Sie ein Symbol hinzufügen möchten. Die rechte Liste zeigt nun alle Symbole an, die sich momentan auf dieser Karteikarte befinden.
2. Selektieren Sie in der **linken** Liste das Symbol, das Sie hinzufügen möchten.

Das Symbol wird der Karteikarte nun hinzugefügt. Falls nötig, legt das Programm dazu automatisch eine neue Sektion am Ende der Karteikarte an.

Entfernen eines Symbols

_Hinweis:_ Sie können nur selbst hinzugefügte Symbole entfernen. Das Löschen eines der vorgegebenen Symbole ist nicht möglich.

Um eines der von Ihnen hinzugefügten Symbole von einer Karteikarte zu entfernen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste **Anpassen** die Karteikarte, auf der sich das Symbol befindet.
2. Selektieren Sie in der rechten Liste das zu entfernende Symbol.

Das Symbol wird nun von der Karteikarte entfernt.

Verschieben eines Symbols

_Hinweis:_ Sie können nur selbst hinzugefügte Symbole verschieben. Das Ändern der Position eines der vorgegebenen Symbole ist nicht möglich.

Um ein Symbol in einer Karteikarte zu verschieben, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste **Anpassen** die Karteikarte, auf der sich das Symbol befindet.
2. Selektieren Sie in der rechten Liste das zu verschiebende Symbol.
3. Verwenden Sie die Schaltflächen mit dem Pfeil nach oben beziehungsweise unten (links neben der rechten Liste), um das Symbol innerhalb der Karteikarte zu verschieben.

_Hinweis:_ Wenn Sie ein Symbol auf eine _andere_ Karteikarte verschieben möchten, müssen Sie dieses erst aus seiner bisherigen Karteikarte entfernen und es dann der anderen Karteikarte hinzufügen.
**Hinzufügen einer neuen Sektion**

_Hinweis:_ Neue Sektionen lassen sich nur _hinter_ den vorgegebenen Sektionen hinzufügen. Das Einfügen einer selbsterstellten Sektion zwischen den vorgegebenen Sektionen ist nicht möglich.

Um einer Karteikarte eine neue Sektion (einen neuen Abschnitt) hinzuzufügen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste _Anpassen_ die gewünschte Karteikarte.
2. Klicken Sie auf die Schaltfläche _Neue Sektion_ (unterhalb der rechten Liste).

Die neue Sektion wird nun (am Ende der Karteikarte) angelegt.

**Umbenennen einer Sektion**

_Hinweis:_ Nur selbsterstellte Sektionen lassen sich umbenennen. Das Umbenennen einer der vorgegebenen Sektionen ist nicht möglich.

Um eine selbsterstellte Sektion in einer Karteikarte umzubenennen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste _Anpassen_ die gewünschte Karteikarte.
2. Selektieren Sie in der rechten Liste die gewünschte Sektion.
4. Tippen Sie den neuen Namen ein und bestätigen Sie ihn.

Die Sektion wird nun entsprechend umbenannt.

**Entfernen einer Sektion**

_Hinweis:_ Nur selbsterstellte Sektionen lassen sich entfernen. Das Löschen einer der vorgegebenen Sektionen ist nicht möglich.

Um eine selbsterstellte Sektion von einer Karteikarte zu entfernen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste _Anpassen_ die gewünschte Karteikarte.
2. Selektieren Sie in der rechten Liste die gewünschte Sektion.

Die Sektion wird nun aus der Karteikarte entfernt.

**Zuweisen von Tastenkürzeln**

Wenn Sie in dem Dialog die Schaltfläche _Tastenkürzel_ anklicken, erweitert sich der Dialog um eine zusätzliche Sektion namens _Tastenkürzel_, die zum Bearbeiten von Tastenkürzeln verwendet werden kann.
Kurzfassung: Sie können darin einem beliebigen Befehl ein Tastenkürzel Ihrer Wahl zuweisen: Selektieren Sie den Befehl dazu in einer der beiden Listen, klicken Sie in das Feld **Bitte Tastenkürzel drücken** und betätigen Sie dann die Tastenkombination, mit der Sie diesen Befehl künftig aufrufen möchten.

Ausführliche Informationen dazu finden Sie im Abschnitt **Tastenkürzel anpassen**.

Verwalten der Karteikarten des Ribbons

Das Dialogfenster dieses Befehls verfügt außerdem über Schaltflächen zum Verwalten der Karteikarten des Ribbons:

- **Neu**
  Legt eine neue, leere Karteikarte an.

- **Umbenennen**
  Benennt die in der Liste **Anpassen** gewählte Karteikarte um (nur bei selbsterstellten Karteikarten möglich).

- **Zurücksetzen**
  Setzt die in der Liste **Anpassen** gewählte Karteikarte wieder auf ihren Auslieferungszustand zurück.

- **Löschen**
  Löscht die in der Liste **Anpassen** gewählte Karteikarte (nur bei selbsterstellten Karteikarten möglich).

- **Alle zurücksetzen** (unterhalb der rechten Liste)
  Setzt alle Karteikarten wieder auf den Auslieferungszustand zurück.

Symbole der Schnellzugriffsleiste anpassen

**Nur bei "Ribbons":** Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm mit dem **Ribbon** (Menüband) bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt **Symbolleisten anpassen**.)

Unter dem Ribbon wird die **Schnellzugriffsleiste** angezeigt. Diese bietet eine Auswahl an besonders häufig benötigten Befehlen.

Wenn Sie möchten, können Sie die Symbole auf der Schnellzugriffsleiste jederzeit anpassen, also beispielsweise Symbole hinzufügen, entfernen, verschieben etc.
Rufen Sie dazu im Ribbon den Befehl **Datei > Anpassen > Schnellzugriffsleiste anpassen** auf. Es erscheint daraufhin ein Dialog zum Anpassen von Symbolleisten, in dem Sie die gewünschten Änderungen vornehmen können.

Die Schnellzugriffsleiste verhält sich dabei exakt wie eine klassische Symbolleiste. Zum Anpassen ihrer Symbole können Sie also genau so vorgehen, wie es im Abschnitt **Symbole einer Symbolleiste anpassen** beschrieben ist. Alle dort gemachten Erläuterungen treffen auch auf die Schnellzugriffsleiste zu – bis auf den Abschnitt "Verwalten von Symbolleisten".

### Benutzerdefinierte Symbole erstellen

Sie können jederzeit **benutzerdefinierte Symbole** anlegen und diese dann einer Symbolleiste oder dem Ribbon hinzufügen. Mit solchen Symbolen lassen sich beliebige Programme starten.

Um ein benutzerdefiniertes Symbol anzulegen – zum Beispiel eines zum Starten des Windows-Editors –, gehen Sie folgendermaßen vor:

1. Rufen Sie im Menü beziehungsweise im Ribbon den folgenden Befehl auf:
   - Menü: **Weiteres > Anpassen**
   - Ribbon: **Datei > Anpassen > Ribbon anpassen**
2. Wählen Sie in der aufklappbaren Liste **Kategorien** den Eintrag **Benutzer**.
3. Wählen Sie eines der Symbole in der Liste **Befehle**.
4. Klicken Sie auf die Schaltfläche **Bearbeiten** unter der Liste. Er erscheint daraufhin ein weiteres Dialogfenster.
5. Tragen Sie in dem neuen Dialogfenster bei **Beschreibung** eine kurze Beschreibung für das zu startende Programm ein – zum Beispiel "Windows-Editor".
6. Bei **Befehlszeile** geben Sie den vollständigen Pfad und Dateinamen des zu startenden Programms an – zum Beispiel `c:\windows\notepad.exe`.
7. **Optional**: Falls Sie möchten, dass für das Programm ein anderes Symbol als sein Standardsymbol angezeigt werden soll, tragen Sie bei **Symboldatei** den Pfad und Dateinamen der gewünschten Symboldatei ein.
   - Beachten Sie dabei, dass Symbole in Symbolleisten etwas kleiner sind als die üblichen Windows-Symbole.

Sobald Sie mit **OK** bestätigen, wird das benutzerdefinierte Symbol angelegt.

Falls Sie das benutzerdefinierte Symbol nun gleich einer Symbolleiste beziehungsweise dem Ribbon hinzufügen möchten, gehen Sie vor wie in den folgenden Abschnitten beschrieben:

- Symbolleisten: Abschnitt **Symbole einer Symbolleiste anpassen**
- Ribbon: Abschnitt **Symbole im Ribbon anpassen**
**Tastenkürzel anpassen**

Die in einem Programm am häufigsten benötigten Befehle können auch über *Tastenkürzel* aufgerufen werden. So lässt sich der Befehl zum Speichern des aktuellen Dokuments beispielsweise blitzschnell mit der Tastenkombination Strg+S ausführen.

Die vorgegebenen Tastenkürzel lassen sich im Dialogfenster des Menübefehls *Weiteres > Anpassen* jederzeit anpassen. Sie können beliebigen Befehlen ein Tastenkürzel zuordnen und vorhandene Tastenkürzel ändern oder entfernen.

Gehen Sie dazu folgendermaßen vor:

**Tastenkürzel hinzufügen**

Um einem Befehl ein Tastenkürzel zuzuweisen, führen Sie folgende Schritte durch:

1. Rufen Sie im Menü beziehungsweise im Ribbon den folgenden Befehl auf:
   - Menü: *Weiteres > Anpassen*
   - Ribbon: *Datei > Anpassen > Ribbon anpassen*
2. Klicken Sie auf die Schaltfläche *Tastenkürzel*.
   Der Dialog erweitert sich nun um eine zusätzliche Sektion namens *Tastenkürzel*, die zum Bearbeiten von Tastenkürzeln verwendet werden kann.
   - Die *rechte* Liste zeigt nur die Symbole an, die sich in der momentan ausgewählten Symbolleiste beziehungsweise Ribbon-Karteikarte befinden.
4. Nachdem Sie den gewünschten Befehl ausgewählt haben, klicken Sie in das Eingabefeld *Bitte Tastenkürzel drücken* und betätigen die Tastenkombination, die Sie dem Befehl geben möchten.
   - Tipp: Falls Sie sich dabei vertippen, können Sie das eingegebene Tastenkürzel mit der *Rücktaste* wieder löschen.
6. Verlassen Sie den Dialog mit *Schließen*.

Der gewählte Befehl kann von nun an mit der angegebenen Tastenkombination aufgerufen werden.

**Tastenkürzel bearbeiten (entfernen, ändern etc.)**

Sie können außerdem die vorhandenen Tastenkürzel für Befehle jederzeit bearbeiten, also Kürzel beispielsweise löschen oder ändern. Gehen Sie wie folgt vor:

1. Rufen Sie den folgenden Befehl im Menü oder im Ribbon auf:
Menü: Weiteres > Anpassen
Ribbon: Datei > Anpassen > Ribbon anpassen

2. Klicken Sie auf die Schaltfläche Tastenkürzel.

Der Dialog erweitert sich nun um eine zusätzliche Sektion namens Tastenkürzel, die zum Bearbeiten von Tastenkürzeln verwendet werden kann.

3. Wählen Sie wahlweise in der linken oder rechten Liste den Befehl, dessen Tastenkürzel Sie bearbeiten möchten.

4. Führen Sie in der Sektion Tastenkürzel eine der folgenden Aktionen durch:

   **Tastenkürzel entfernen:** Die Liste Aktuelle Tastenkürzel zeigt alle Tastenkürzel an, die dem ausgewählten Befehl derzeit zugewiesen sind. Um ein Kürzel zu entfernen, selektieren Sie es in dieser Liste und klicken auf Entfernen.

   **Tastenkürzel ändern:** Um das Tastenkürzel für einen Befehl abzuändern, entfernen Sie dieses erst (wie gerade beschrieben) und weisen ihm dann ein neues Kürzel zu (wie am Anfang dieses Abschnitts beschrieben).

   **Tastenkürzel zurücksetzen:** Um alle Tastenkürzel für das komplette Programm auf die Vorgaben zurückzusetzen, klicken Sie auf die Schaltfläche Alle Tastenkürzel zurücksetzen und bestätigen die Sicherheitsabfrage. Sämtliche Änderungen, die Sie an Tastenkürzeln vorgenommen haben, werden dann verworfen.

   **Liste aller Tastenkürzel ansehen:** Wenn Sie die Schaltfläche Exportieren anklicken, erscheint eine Tabelle mit allen momentan zugewiesenen Tastenkürzeln. Mit den Schaltflächen neben der Tabelle können Sie diese unter anderem in die Zwischenablage kopieren.

5. Verlassen Sie den Dialog mit Schließen.

**Verfügbare Tastenkürzel**

Beachten Sie, dass nicht alle Tastenkombinationen, die Sie auf Ihrer Tastatur erzeugen können, auch für Tastenkürzel erlaubt sind.

In der Regel sollten Sie für Tastenkürzel Buchstabentasten, Zahlentasten oder Funktionstasten verwenden und diese mit den Tasten Strg, Alt und/oder der Umschalttaste kombinieren.

Sie können ganz einfach überprüfen, ob die von Ihnen gewünschte Tastenkombination zulässig ist: Betätigen Sie diese Tastenkombination im Feld Bitte Tastenkürzel drücken des oben beschriebene Dialogs. Wenn sie nicht erscheint, ist sie nicht zulässig.

Einige Beispiele für gültige Tastenkürzel:
Anpassen von TextMaker

- Strg+A
- Alt+A (Tastenkombinationen mit der Alt-Taste sind allerdings nicht zu empfehlen – Alt+A ist beispielsweise für den Aufruf des Menüs Ansicht zuständig!)
- Strg+Alt+A
- Strg+Umschalt+A
- Strg+Alt+Umschalt+A
- Strg+F2
- etc.

Hinweis: Buchstaben allein sind natürlich nicht zulässig. Sie können also nicht A oder Umschalt+A als Tastenkürzel verwenden.

Tastenkürzel bereits belegt: Wenn Sie ein Tastenkürzel drücken, das bereits vergeben ist, wird unter dem Eingabefeld angezeigt, womit dieses Kürzel momentan belegt ist. Sie sollten dann die Rücktaste betätigen, um das Tastenkürzel wieder zu löschen und ein anderes Tastenkürzel nehmen. Andernfalls überschreiben Sie die bisherige Zuordnung dieses Kürzels.


Gitter verwenden

Das Gitter ist eine Positionierhilfe für Rahmen und Zeichnungen. Wenn es aktiviert ist, lassen sich solche Objekte mit der Maus nicht mehr frei verschieben, sondern sie springen von einem Gitterpunkt zum nächsten. Ähnliches passiert beim Ändern der Größe eines Objekts mit der Maus.

Aktivieren der Funktion "Auf Gitter springen"

Um die Funktion "Auf Gitter springen" ein- oder auszuschalten, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Objekt > Gitter und Hilfslinien auf.
2. Wechseln Sie auf die Karteikarte Gitter.
3. Schalten Sie die Option Auf Gitter springen ein oder aus.

Wenn Sie das Gitter aktivieren und dann beispielsweise versuchen, einen Grafikrahmen durch Ziehen mit der Maus zu verschieben, lässt sich dieser nicht mehr frei bewegen, sondern springt von Gitterpunkt zu Gitterpunkt.

Schalten Sie das Gitter hingegen aus, lassen sich Rahmen und Zeichnungen mit der Maus wieder völlig frei verschieben.

Gitter temporär deaktivieren: Wenn die Option Auf Gitter springen eingeschaltet ist, können Sie diese jederzeit temporär deaktivieren, indem Sie beim Verschieben eines Objekts mit der Maus die Taste Alt drücken und gedrückt halten.
Anpassen von TextMaker

**Gitterabstand ändern**

Sie können den Abstand zwischen zwei Gitterpunkten auf einen beliebigen Wert einstellen.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl **Objekt > Gitter und Hilfslinien** auf.
2. Wechseln Sie auf die Karteikarte **Gitter**.
3. Tragen Sie in der Rubrik **Gitterabstand** die gewünschten Werte ein.

**Gitter anzeigen lassen**

Normalerweise ist das Gitter nicht sichtbar. Wenn Sie möchten, dass es auf dem Bildschirm angezeigt wird, schalten Sie im obigen Dialogfenster die Option **Gitter anzeigen** ein.

Hinweis: Das Gitter erscheint nur auf dem Bildschirm, nicht im Ausdruck.

---

**Hilfslinien verwenden**

Neben dem im vorherigen Abschnitt besprochenen Gitter gibt es noch eine weitere Positionierungshilfe für Rahmen und Zeichnungen: **Hilfslinien**.

Sie können horizontale und vertikale Hilfslinien einrichten. Sobald Sie beim Verschieben von Rahmen und Zeichnungen mit der Maus in die Nähe einer Hilfslinie kommen, springt das Objekt automatisch darauf – als ob die Hilfslinie magnetisch wäre. Ähnliches passiert beim Ändern der Größe eines Objekts mit der Maus.

**Aktivieren der Funktion "Auf Hilfslinien springen"**

Um die Funktion "Auf Hilfslinien springen" ein- oder auszuschalten, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl **Objekt > Gitter und Hilfslinien** auf.
2. Wechseln Sie auf die Karteikarte **Hilfslinien**.
3. Schalten Sie die Option **Auf Hilfslinien springen** ein oder aus.

Hinweis: Auch wenn diese Option ausgeschaltet ist, können Sie Hilfslinien trotzdem noch anzeigen lassen und sogar verändern (allerdings haben die Hilfslinien beim Verschieben von Objekten natürlich keine Wir- kung mehr).

**Hilfslinien temporär deaktivieren:** Wenn die Option **Auf Hilfslinien springen** eingeschaltet ist, können Sie diese jederzeit temporär deaktivieren, indem Sie beim Verschieben eines Objekts mit der Maus die Taste **Alt** drücken und gedrückt halten.

**Hilfslinien anzeigen**

Über die Option **Hilfslinien anzeigen** in obigem Dialogfenster können Sie bestimmen, ob Hilfslinien auf dem Bildschirm angezeigt werden sollen.
Diese Option ist standardmäßig eingeschaltet.

Hinweis: Wenn Sie die Option **Hilfslinien anzeigen** ausschalten, die Option **Auf Hilfslinien springen** jedoch einschalten, werden die Hilfslinien zwar unsichtbar, behalten aber weiterhin ihre Funktion.

Hilfslinien erscheinen nur auf dem Bildschirm, nicht im Ausdruck.

**Hilfslinien dialoggesteuert hinzufügen**

Um eine neue Hilfslinie einzurichten, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl **Objekt > Gitter und Hilfslinien** auf.
2. Wechseln Sie auf die Karteikarte **Hilfslinien**.
3. Tragen Sie bei **Horizontal** beziehungsweise **Vertikal** ein, wo die Hilfslinie gesetzt werden soll.
4. Betätigen Sie die Schaltfläche **Hinzufügen**.

**Hilfslinien mit der Maus hinzufügen**

Alternativ lassen sich Hilfslinien auch mit der Maus hinzufügen:

1. Klicken Sie auf das Symbol in der Formatleiste oder rufen Sie den Menübefehl **Ansicht > Objektmodus** auf, um den Objektmodus zu aktivieren.
2. Nun können Sie vertikale Hilfslinien aus dem vertikalen Lineal und horizontale Hilfslinien aus dem horizontalen Lineal "herausziehen". Klicken Sie dazu mit der Maus in eines dieser Lineale und ziehen Sie die Maus bei gedrückter Maustaste in den Textbereich. Lassen Sie die Maustaste an der Stelle los, an der die Linie positioniert werden soll.
3. Klicken Sie abschließend erneut auf das Symbol oder rufen den Menübefehl **Ansicht > Objektmodus** auf, um den Objektmodus wieder zu verlassen.

**Hilfslinien verschieben und löschen**

Das Verschieben und Löschen von Hilfslinien kann wie folgt durchgeführt werden:

**Tastatur:** Rufen Sie den Menübefehl **Objekt > Gitter und Hilfslinien** auf. Um eine Hilfslinie zu entfernen, selektieren Sie diese in der Liste und betätigen die Schaltfläche **Löschen**. Um eine Hilfslinie zu verschieben, löschen Sie diese und setzen eine neue Hilfslinie an der gewünschten Position.

**Maus:** Im Objektmodus lassen sich Hilfslinien mit der Maus einfach greifen und an eine andere Position ziehen. Und: Schieben Sie eine Hilfslinie in das horizontale beziehungsweise vertikale Lineal hinein, wird sie gelöscht. Das Gleiche passiert, wenn Sie während des Verschiebens die Taste **Entf** drücken.

**Hilfslinien sperren**

Damit Hilfslinien nicht versehentlich mit der Maus verschoben werden können, lassen sich diese "sperren".

Um dies zu erreichen, schalten Sie die Option **Hilfslinien sperren** im Dialogfenster des Menübefehls **Objekt > Gitter und Hilfslinien** ein.
Anpassen von TextMaker

(Alternativ können Sie auch den Menübefehl **Datei > Eigenschaften** aufrufen, auf die Karteikarte **Ansicht** wechseln und in der Rubrik **Sperren** die Option **Hilfslinien** einschalten. Diese tut genau das Gleiche.)

Hilfslinien können nun nicht mehr mit der Maus verschoben werden. Ihre Position lässt sich nur noch über das Dialogfenster des Menübefehls **Objekt > Gitter und Hilfslinien** ändern.

**Verwenden der Funktion "Auf Seitenränder springen"**

Wenn im Dialogfenster des Menübefehls **Objekt > Gitter und Hilfslinien** die Option **Auf Seitenränder springen** aktiviert ist, verhalten sich die vier Seitenränder des Dokuments genau wie Hilfslinien.

Tipp: Falls die Seitenränder nicht angezeigt werden sollten, rufen Sie den Menübefehl **Weiteres > Einstellungen** auf, wechseln auf die Karteikarte **Ansicht** und schalten dort die Option **Seitenränder** ein.

**Verwenden der Funktion "An anderen Objekten ausrichten"**

Wenn im Dialogfenster des Menübefehls **Objekt > Gitter und Hilfslinien** die Option **An anderen Objekten ausrichten** eingeschaltet ist, erzeugt das Programm automatisch "magische" Hilfslinien für die Kanten von jedem Objekt auf der aktuellen Seite. Diese erleichtern das bündige und gleichmäßige Platzieren von Objekten erheblich.


Einige Beispiele für solche Hilfslinien:

- Ziehen Sie ein Objekt an eine Position, an der seine linke Kante ungefähr bündig mit einem vorhandenen Objekt ist, erscheint eine Hilfslinie, die für die linke Kante des anderen Objekts steht. Lassen Sie Ihr Objekt darauf springen, wird es exakt linksbündig zu dem vorhandenen Objekt ausgerichtet.
- Entsprechendes gilt auch für die rechte Kante von Objekten.
- Ziehen Sie ein Objekt an eine Position, an der es ungefähr zentriert zu einem vorhandenen Objekt ist, erscheint eine Hilfslinie, die für das Zentrum des vorhandenen Objekts steht. Lassen Sie Ihr Objekt darauf springen, wird es exakt zentriert zu dem vorhandenen Objekt ausgerichtet.
- Ziehen Sie ein Objekt unter zwei andere Objekte, erscheint außerdem eine horizontale Hilfslinie genau dort, wo dieses dritte Objekt den gleichen Abstand wie die beiden anderen Objekte zueinander hätte. (Die drei Objekte wären dann also gleichmäßig verteilt.)

All dies funktioniert in beide Richtungen (horizontal und vertikal) – es wird also beispielsweise auch für die obere und untere Kante jedes Objekts eine automatische Hilfslinie generiert.

**Toleranz von Hilfslinien ändern**

Standardmäßig springt der Mauszeiger beim Verschieben von Rahmen und Zeichnungen automatisch auf eine Hilfslinie, wenn er 8 oder weniger Pixel (Bildpunkte) von dieser entfernt ist. Diese Toleranz können Sie jederzeit ändern. Erhöhten Sie die Toleranz beispielsweise auf "20", springt der Mauszeiger bereits auf die Hilfslinie, wenn er 20 oder weniger Pixel weit entfernt ist.

Um die Toleranz zu ändern, rufen Sie den Menübefehl **Objekt > Gitter und Hilfslinien** auf und tragen bei der Option **Toleranz** auf der Karteikarte **Hilfslinien** den gewünschten Wert in Pixeln ein.
Installieren zusätzlicher Wörterbücher

Sie können bei Bedarf weitere Wörterbücher für die Rechtschreibprüfung installieren. Wie das geht, ist in den nachfolgenden Abschnitten beschrieben:

- **Installieren zusätzlicher SoftMaker-Wörterbücher**

  In diesem Abschnitt erfahren Sie, wie Sie momentan nicht installierte SoftMaker-Wörterbücher nachinstallieren.


- **Installieren von Hunspell-Wörterbüchern**


- **Wählen eines anderen Wörterbuchs für eine Sprache**

  Wenn Sie für eine Sprache mehrere Wörterbücher installiert haben (z.B. eines von SoftMaker und eines von Hunspell), können Sie außerdem festlegen, welches dieser Wörterbücher verwendet werden soll. Dieser Abschnitt verrät, wie Sie dazu vorgehen.

  Alle Details zu diesen Themen finden Sie auf nächsten Seiten.

---

**Installieren zusätzlicher SoftMaker-Wörterbücher**

SoftMaker Office wird mit hochwertigen Wörterbüchern für zahlreiche Sprachen ausgeliefert. In diesem Abschnitt erfahren Sie, wie Sie Wörterbücher, die momentan nicht installiert sind, nachinstallieren können:

**Windows, Mac und Linux**


**Android**


Gehen Sie dazu wie folgt vor:

2. Rufen Sie darin den Menübefehl Weiteres > Einstellungen auf und wechseln Sie auf die Karteikarte Sprache.
3. Tippen Sie auf die Schaltfläche Wörterbücher hinzufügen.
4. Es erscheint ein Dialog mit einer Liste aller verfügbaren Sprachen. Um eine Sprache herunterzuladen, tippen Sie auf das Download-Symbol **rechts** von ihr.


---

**Installieren von Hunspell-Wörterbüchern**


**Hunspell**-Wörterbücher gibt es für sehr viele Sprachen. Falls Sie also für eine Sprache kein Wörterbuch in SoftMaker Office finden, lohnt es sich nachzusehen, ob ein Hunspell-Wörterbuch dafür existiert.

Eine Liste aller für SoftMaker Office verfügbaren Hunspell-Wörterbücher finden Sie im Bereich "Downloads" auf unserer Website [www.softmaker.de](http://www.softmaker.de). Dort können Sie die Wörterbücher auch kostenlos herunterladen.

Um ein Hunspell-Wörterbuch herunterzuladen und zu installieren, gehen Sie folgendermaßen vor:

1. Gehen Sie mit Ihrem Webbrowser auf unsere Website [www.softmaker.de](http://www.softmaker.de)
2. Wählen Sie im Menü der Webseite "Downloads" aus, und klicken Sie dann auf "Wörterbücher".
5. Rufen Sie darin den Menübefehl **Weiteres > Einstellungen** auf und wechseln Sie auf die Karteikarte **Sprache**.
6. Klicken Sie auf die Schaltfläche **Hunspell-Wörterbücher**.
7. Es erscheint ein Dialog mit einer Liste aller installierten Sprachen/Wörterbücher. Klicken Sie darin auf die Schaltfläche **Hunspell-Wörterbuch hinzufügen**.
9. Wählen Sie die Wörterbuchdatei in der Dateiliste aus und klicken Sie auf **Öffnen**.


---

**Wählen eines anderen Wörterbuchs für eine Sprache**

Wenn Sie für eine Sprache **mehrere** Wörterbücher installiert haben (zum Beispiel ein SoftMaker-Wörterbuch und ein Hunspell-Wörterbuch), können Sie jederzeit wählen, welches dieser Wörterbücher für diese Sprache verwendet werden soll. Gehen Sie dazu wie folgt vor:
1. Rufen Sie den Menübefehl **Weiteres > Einstellungen** auf und wechseln Sie auf die Karteikarte **Sprache**.

2. Klicken Sie auf die Schaltfläche **Hunspell-Wörterbücher**.

   Es erscheint ein Dialog mit einer Liste aller installierten Sprachen. Rechts wird angezeigt, welche Art von Wörterbuch die jeweilige Sprache momentan verwendet.

3. Wählen Sie in dieser Liste die gewünschte **Sprache** aus.

4. Wählen Sie dann in der aufklappbaren Liste **Wörterbuch** aus, welches Wörterbuch für die selektierte Sprache verwendet werden soll.

   Folgende Einträge stehen zur Wahl:
   - **SoftMaker**: Das bei SoftMaker Office mitgelieferte Wörterbuch.
   - **Hunspell**: Ein Hunspell-Wörterbuch (kostenlos herunterladbares, freies Wörterbuch, siehe vorheriger Abschnitt).
   - **Duden**: Das offizielle Duden-Wörterbuch (nur in **SoftMaker Office Professional** enthalten, nur für Deutsch verfügbar). Siehe unten.

5. Bestätigen Sie mit **OK**. Die Rechtschreibprüfung wird von nun an für diese Sprache das gewählte Wörterbuch verwenden.

**Für deutschnsprachige Rechtschreibprüfung den Duden-Korrektor verwenden**

Für Anwender von **SoftMaker Office Professional** (erhältlich für Windows, Mac und Linux) ist außerdem noch eine zusätzliche Option verfügbar:

Wenn Sie in obigem Dialog die Option **Für deutschsprachige Rechtschreibprüfung den Duden-Korrektor verwenden** einschalten, wird das Wörterbuch für alle Varianten der Sprache Deutsch (Deutschland, Österreich, Schweiz usw.) auf das entsprechende Duden-Wörterbuch gesetzt.

Die aufklappbare Liste **Wörterbuch** ist dann für alle diese Sprachen deaktiviert.

Diese Option entspricht übrigens der gleichnamigen Option im Hauptdialog des Menübefehls **Weiteres > Einstellungen**, Karteikarte **Sprache**.
Anhang

Im Anhang des Handbuchs finden Sie folgende Informationen:

- **Menübefehle und entsprechende Ribbonbefehle**
  
  In diesem Abschnitt finden Sie eine Tabelle aller Menübefehle und dem jeweils entsprechenden Befehl im Ribbon (Menüband).

- **Tastenbelegung**
  
  Dieser Abschnitt enthält Tabellen mit den wichtigsten Tastenkürzeln, die Sie im Programm verwenden können.

---

**Menübefehle und entsprechende Ribbonbefehle**

In diesem Abschnitt finden Sie eine Tabelle aller Menübefehle und dem jeweils entsprechenden Befehl im Ribbon (Menüband).

*Tipp:* Sie können die Benutzeroberfläche jederzeit zwischen Ribbon und klassischen Menüs mit Symbolleisten umschalten. Rufen Sie dazu im Menü den Befehl **Weiteres > Einstellungen** auf (beziehungsweise im Ribbon den Befehl **Datei > Einstellungen**). Wechseln Sie in dem Dialog auf die Karteikarte **Anzeige** und klicken Sie darin auf die Schaltfläche **Benutzeroberfläche**. Es erscheint ein weiterer Dialog, in dem Sie die gewünschte Art von Benutzeroberfläche wählen können.

Die nachfolgende Tabelle enthält folgende Spalten:

- **Linke Spalte: Menübefehl**
  
  Die linke Spalte listet alle Menübefehle im Programm, geordnet nach der Reihenfolge im Hauptmenü.

- **Rechte Spalte: entsprechender Befehl im Ribbon**
  
  In der rechten Spalte finden Sie jeweils den entsprechenden Befehl im Ribbon – in folgendem Format:

  **Karteikarte > Sektion > Befehl**

  Beispiel:

  Der Ribbonbefehl **Datei > Dokument > Speichern** ist auf dem Ribbon also wie folgt zu finden: Karteikarte **Datei**, Sektion **Dokument**, Symbol **Speichern**.

  Bei manchen Befehlen ist zusätzlich noch ein vierter Eintrag angehängt. Hier befindet sich der entsprechende Befehl in der Liste, die sich öffnet, wenn Sie auf das angegebene Symbol (oder das Pfeilehen rechts davon) klicken.

Hier also die angekündigte Tabelle:
<table>
<thead>
<tr>
<th>Menü</th>
<th>Ribbon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datei &gt; Neu</td>
<td>Datei &gt; Datei &gt; Neu &gt;&gt; Weitere</td>
</tr>
<tr>
<td>Datei &gt; Öffnen</td>
<td>Datei &gt; Datei &gt; Öffnen</td>
</tr>
<tr>
<td>Datei &gt; Schließen</td>
<td>Datei &gt; Datei &gt; Schließen</td>
</tr>
<tr>
<td>Datei &gt; Speichern</td>
<td>Datei &gt; Dokument &gt; Speichern</td>
</tr>
<tr>
<td>Datei &gt; Speichern unter</td>
<td>Datei &gt; Dokument &gt; Speichern unter</td>
</tr>
<tr>
<td>Datei &gt; Alles speichern</td>
<td>Datei &gt; Dokument &gt; Alles speichern</td>
</tr>
<tr>
<td>Datei &gt; Zurück zu vorheriger Version</td>
<td>Datei &gt; Dateiverwaltung &gt; Versionen</td>
</tr>
<tr>
<td>Datei &gt; Holen</td>
<td>Einfügen &gt; Objekte &gt; Grafik &gt;&gt; Von Scanner</td>
</tr>
<tr>
<td>Datei &gt; Quelle wählen</td>
<td>Einfügen &gt; Objekte &gt; Grafik &gt;&gt; Quelle wählen</td>
</tr>
<tr>
<td>Datei &gt; Eigenschaften</td>
<td>Datei &gt; Dateiverwaltung &gt; Eigenschaften</td>
</tr>
<tr>
<td>Datei &gt; Dateimanager</td>
<td>Datei &gt; Dateiverwaltung &gt; Dateimanager</td>
</tr>
<tr>
<td>Datei &gt; Seite einrichten</td>
<td>Layout &gt; Seite einrichten</td>
</tr>
<tr>
<td>Datei &gt; Druckvorschau</td>
<td>Datei &gt; Drucken &gt; Druckvorschau</td>
</tr>
<tr>
<td>Datei &gt; Drucken</td>
<td>Datei &gt; Drucken &gt; Drucken</td>
</tr>
<tr>
<td>Datei &gt; Serienbriefdruck</td>
<td>Datei &gt; Drucken &gt; Serienbrief</td>
</tr>
<tr>
<td>Datei &gt; Als PDF-Dokument exportieren</td>
<td>Datei &gt; Dokument &gt; PDF-Export</td>
</tr>
<tr>
<td>Datei &gt; Als EPUB-Dokument exportieren</td>
<td>Datei &gt; Dokument &gt; EPUB-Export</td>
</tr>
<tr>
<td>Datei &gt; Versenden</td>
<td>Datei &gt; Dokument &gt; Versenden</td>
</tr>
<tr>
<td>Bearbeiten &gt; Rückgängig</td>
<td>Schnellzugriffsleiste &gt; Rückgängig</td>
</tr>
<tr>
<td>Bearbeiten &gt; Wiederherstellen</td>
<td>Schnellzugriffsleiste &gt; Wiederherstellen</td>
</tr>
<tr>
<td>Menü</td>
<td>Ribbon</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ausschneiden</td>
<td>Start &gt; Bearbeiten &gt; Ausschneiden</td>
</tr>
<tr>
<td>Bearbeiten &gt; Kopieren</td>
<td>Start &gt; Bearbeiten &gt; Kopieren</td>
</tr>
<tr>
<td>Bearbeiten &gt; Einfügen</td>
<td>Start &gt; Bearbeiten &gt; Einfügen</td>
</tr>
<tr>
<td>Bearbeiten &gt; Inhalte einfügen</td>
<td>Start &gt; Bearbeiten &gt; Einfügen &gt;&gt; Inhalte einfügen</td>
</tr>
<tr>
<td>Bearbeiten &gt; Duplizieren</td>
<td>Layout &gt; Objekte &gt; Duplizieren</td>
</tr>
<tr>
<td>Bearbeiten &gt; Alles markieren</td>
<td>Start &gt; Auswahl &gt; Alles markieren</td>
</tr>
<tr>
<td>Bearbeiten &gt; Suchen</td>
<td>Start &gt; Suchen &gt; Suchen</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ersetzen</td>
<td>Start &gt; Suchen &gt; Ersetzen</td>
</tr>
<tr>
<td>Bearbeiten &gt; Suchen wiederholen</td>
<td>Start &gt; Suchen &gt; Weitersuchen</td>
</tr>
<tr>
<td>Bearbeiten &gt; Gehe zu</td>
<td>Start &gt; Suchen &gt; Gehe zu</td>
</tr>
<tr>
<td>Bearbeiten &gt; Sortieren</td>
<td>Start &gt; Absatz &gt; Text/Tabelle sortieren</td>
</tr>
<tr>
<td>Bearbeiten &gt; Verknüpfung</td>
<td>OLE-Objekt &gt; OLE &gt; Verknüpfung bearbeiten</td>
</tr>
<tr>
<td>Bearbeiten &gt; OLE-Objekt</td>
<td>OLE-Objekt &gt; OLE &gt; OLE-Objekt</td>
</tr>
<tr>
<td>Ansicht &gt; Fingereingabemodus</td>
<td>Schnellzugriffsleiste &gt; Fingereingabemodus</td>
</tr>
<tr>
<td>Ansicht &gt; Normal</td>
<td>Ansicht &gt; Ansichten &gt; Normal</td>
</tr>
<tr>
<td>Ansicht &gt; Konzept</td>
<td>Ansicht &gt; Ansichten &gt; Konzept</td>
</tr>
<tr>
<td>Ansicht &gt; Masterseiten</td>
<td>Ansicht &gt; Ansichten &gt; Masterseiten</td>
</tr>
<tr>
<td>Ansicht &gt; Gliederung</td>
<td>Ansicht &gt; Ansichten &gt; Gliederung</td>
</tr>
<tr>
<td>Ansicht &gt; Originalgröße</td>
<td>Ansicht &gt; Zoom &gt; Originalgröße</td>
</tr>
<tr>
<td>Ansicht &gt; Textbreite</td>
<td>Ansicht &gt; Zoom &gt; Textbreite</td>
</tr>
<tr>
<td>Anhang</td>
<td>489</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Menü</strong></td>
<td><strong>Ribbon</strong></td>
</tr>
<tr>
<td>[Ansicht &gt; Seitenbreite]</td>
<td>Ansicht &gt; Zoom &gt; Seitenbreite</td>
</tr>
<tr>
<td>[Ansicht &gt; Ganze Seite]</td>
<td>Ansicht &gt; Zoom &gt; Ganze Seite</td>
</tr>
<tr>
<td>[Ansicht &gt; Zwei ganze Seiten]</td>
<td>Ansicht &gt; Zoom &gt; Zwei Seiten</td>
</tr>
<tr>
<td>[Ansicht &gt; Lupe]</td>
<td>Ansicht &gt; Zoom &gt; Lupe</td>
</tr>
<tr>
<td>[Ansicht &gt; Vergrößerungsstufe]</td>
<td>Ansicht &gt; Zoom &gt; Vergrößerungsstufe</td>
</tr>
<tr>
<td>[Ansicht &gt; Objektmodus]</td>
<td>Ansicht &gt; Modus &gt; Objektmodus</td>
</tr>
<tr>
<td>[Ansicht &gt; Formularmodus]</td>
<td>Ansicht &gt; Formular &gt; Formularmodus</td>
</tr>
<tr>
<td>[Ansicht &gt; Vollbild]</td>
<td>Ansicht &gt; Fenster &gt; Vollbildmodus</td>
</tr>
<tr>
<td>[Ansicht &gt; Linealleiste]</td>
<td>Ansicht &gt; Ansicht &gt; Linealleiste</td>
</tr>
<tr>
<td>[Ansicht &gt; Seitenleiste]</td>
<td>Ansicht &gt; Fenster &gt; Seitenleiste</td>
</tr>
<tr>
<td>[Format &gt; Zeichen]</td>
<td>Start &gt; Zeichen</td>
</tr>
<tr>
<td>[Format &gt; Standard]</td>
<td>Start &gt; Zeichen &gt; Standard</td>
</tr>
<tr>
<td>[Format &gt; Absatz]</td>
<td>Start &gt; Absatz</td>
</tr>
<tr>
<td>[Format &gt; Tabulator]</td>
<td>Layout &gt; Absatz &gt; Tabulatoren</td>
</tr>
<tr>
<td>[Format &gt; Bullets und Nummerierungen]</td>
<td>Start &gt; Absatz</td>
</tr>
<tr>
<td>[Format &gt; Umrandung]</td>
<td>Start &gt; Absatz &gt; Umrandung</td>
</tr>
<tr>
<td>[Format &gt; Schattierung]</td>
<td>Start &gt; Absatz &gt; Schattierung</td>
</tr>
<tr>
<td>[Format &gt; Initialen]</td>
<td>Layout &gt; Absatz &gt; Initialen</td>
</tr>
<tr>
<td>[Format &gt; Hyperlink]</td>
<td>Einfügen &gt; Verknüpfungen &gt; Hyperlink</td>
</tr>
<tr>
<td>[Format &gt; Format übertragen]</td>
<td>Start &gt; Bearbeiten &gt; Format übertragen</td>
</tr>
<tr>
<td>[Format &gt; Bereich]</td>
<td>Layout &gt; Bereich &gt; Spalten</td>
</tr>
<tr>
<td>Menü</td>
<td>Ribbon</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Format &gt; Kapitel</td>
<td>Layout &gt; Kapitel &gt; Kapitel</td>
</tr>
<tr>
<td>Format &gt; Seitenhintergrund</td>
<td>Layout &gt; Bereich &gt; Hintergrund</td>
</tr>
<tr>
<td>Format &gt; Zeichenvorlage</td>
<td>Seitenleiste &gt; Karteikarte &quot;Zeichenvorlage&quot;</td>
</tr>
<tr>
<td>Format &gt; Absatzvorlage</td>
<td>Start &gt; Vorlagen</td>
</tr>
<tr>
<td>Format &gt; Vorlagenmanager</td>
<td>Seitenleiste &gt; Karteikarte &quot;Absatzvorlage&quot; &gt; Schaltfläche &quot;Verwalten&quot;</td>
</tr>
<tr>
<td>Einfügen &gt; Datum/Uhrzeit</td>
<td>Einfügen &gt; Text &gt; Datum / Uhrzeit</td>
</tr>
<tr>
<td>Einfügen &gt; Feld</td>
<td>Einfügen &gt; Text &gt; Feld</td>
</tr>
<tr>
<td>Einfügen &gt; Berechnung</td>
<td>Einfügen &gt; Text &gt; Feld &gt;&gt; Berechnung</td>
</tr>
<tr>
<td>Einfügen &gt; Beschriftung</td>
<td>Verweise &gt; Beschriftungen &gt; Beschriftung einfügen</td>
</tr>
<tr>
<td>Einfügen &gt; Sonderzeichen</td>
<td>Einfügen &gt; Text &gt; Sonderzeichen</td>
</tr>
<tr>
<td>Einfügen &gt; Dokument</td>
<td>Einfügen &gt; Text &gt; Dokument</td>
</tr>
<tr>
<td>Einfügen &gt; Liste/Aufkleber</td>
<td>Sendungen &gt; Erstellen &gt; Liste / Aufkleber</td>
</tr>
<tr>
<td>Einfügen &gt; Briefumschlag</td>
<td>Sendungen &gt; Erstellen &gt; Umschlag</td>
</tr>
<tr>
<td>Einfügen &gt; Textbaustein</td>
<td>Einfügen &gt; Text &gt; Textbaustein</td>
</tr>
<tr>
<td>Einfügen &gt; Textmarke</td>
<td>Einfügen &gt; Verknüpfungen &gt; Textmarke</td>
</tr>
<tr>
<td>Einfügen &gt; Querverweis</td>
<td>Einfügen &gt; Verknüpfungen &gt; Querverweis</td>
</tr>
<tr>
<td>Einfügen &gt; Kopfzeile</td>
<td>Einfügen &gt; Kopf- und Fußzeilen &gt; Kopfzeile</td>
</tr>
<tr>
<td>Einfügen &gt; Fußzeile</td>
<td>Einfügen &gt; Kopf- und Fußzeilen &gt; Fußzeile</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Fußnote einfügen</td>
<td>Einfügen &gt; Kopf- und Fußzeilen &gt; Fußnote</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Fußnote bearbeiten</td>
<td>Einfügen &gt; Kopf- und Fußzeilen &gt; Fußnote &gt;&gt; Nummerierung ändern</td>
</tr>
<tr>
<td><strong>Menü</strong></td>
<td><strong>Ribbon</strong></td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Fußnotenzeichen</td>
<td>Einfügen &gt; Kopf- und Fußzeilen &gt; Fußnote &gt;&gt; Fußnoten-</td>
</tr>
<tr>
<td></td>
<td>marke eingefügen</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Gehe zur Fußnote</td>
<td>Verweise &gt; Fußnoten &gt; Zur Fußnote gehen</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Gehe zu Fußnotenreferenz</td>
<td>Verweise &gt; Fußnoten &gt; Zur Referenz gehen</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Optionen</td>
<td>Einfügen &gt; Kopf- und Fußzeilen &gt; Fußnote &gt;&gt; Fußnoten-</td>
</tr>
<tr>
<td></td>
<td>optionen</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Zeilenumbruch</td>
<td>Einfügen &gt; Umbrüche &gt; Umbruch &gt;&gt; Zeilenumbruch</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Spaltenumbruch</td>
<td>Einfügen &gt; Umbrüche &gt; Umbruch &gt;&gt; Spaltenumbruch</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Seitenumbruch</td>
<td>Einfügen &gt; Umbrüche &gt; Umbruch &gt;&gt; Seitenumbruch</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Bereichsumbruch</td>
<td>Einfügen &gt; Umbrüche &gt; Umbruch &gt;&gt; Bereichsumbruch</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Kapitelumbruch</td>
<td>Einfügen &gt; Umbrüche &gt; Umbruch &gt;&gt; Kapitelumbruch</td>
</tr>
<tr>
<td>Objekt &gt; Neuer Textrahmen</td>
<td>Einfügen &gt; Objekte &gt; Textrahmen</td>
</tr>
<tr>
<td>Objekt &gt; Neue Grafik</td>
<td>Einfügen &gt; Objekte &gt; Grafik</td>
</tr>
<tr>
<td>Objekt &gt; Neuer Grafikrahmen</td>
<td>Einfügen &gt; Objekte &gt; Grafik</td>
</tr>
<tr>
<td>Objekt &gt; Neues Diagramm</td>
<td>Einfügen &gt; Objekte &gt; Diagrammrahren</td>
</tr>
<tr>
<td>Objekt &gt; Neuer Diagrammrahren</td>
<td>Einfügen &gt; Objekte &gt; Diagrammrahren</td>
</tr>
<tr>
<td>Objekt &gt; Neues OLE-Objekt</td>
<td>Einfügen &gt; Objekte &gt; OLE-Objektrahmen</td>
</tr>
<tr>
<td>Objekt &gt; Neuer OLE-Objektrahmen</td>
<td>Einfügen &gt; Objekte &gt; OLE-Objektrahmen</td>
</tr>
<tr>
<td>Objekt &gt; Neues Formularobjekt &gt; Textfeld</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Textfeld</td>
</tr>
<tr>
<td>Objekt &gt; Neues Formularobjekt &gt; Kontrollkästchen</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Kontrollkäst-</td>
</tr>
<tr>
<td></td>
<td>chen</td>
</tr>
<tr>
<td>Objekt &gt; Neues Formularobjekt &gt; Auswahlliste</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Auswahlliste</td>
</tr>
<tr>
<td>Objekt &gt; Neues Formularobjekt &gt; Kontrollkästchenrahmen</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Kontrollkäst-</td>
</tr>
<tr>
<td></td>
<td>chenrahmen</td>
</tr>
<tr>
<td><strong>Menü</strong></td>
<td><strong>Ribbon</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Objekt &gt; Neues Formularobjekt &gt; Auswahllistenrahmen</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Auswahllistenrahmen</td>
</tr>
<tr>
<td>Objekt &gt; Neues Formularobjekt &gt; Bezeichnung</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Bezeichnung</td>
</tr>
<tr>
<td>Objekt &gt; Neues Formularobjekt &gt; Gruppenfeld</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Gruppenfeld</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Linie</td>
<td>Einfügen &gt; Objekte &gt; Linien</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Kurve</td>
<td>Einfügen &gt; Objekte &gt; Linien</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Freihandform</td>
<td>Einfügen &gt; Objekte &gt; Linien</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Rechteck</td>
<td>Einfügen &gt; Objekte &gt; Autoform</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Abgerundetes Rechteck</td>
<td>Einfügen &gt; Objekte &gt; Autoform</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Ellipse/Kreis</td>
<td>Einfügen &gt; Objekte &gt; Autoform</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Gerade Verbindung</td>
<td>Einfügen &gt; Objekte &gt; Linien</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Gewinkelte Verbindung</td>
<td>Einfügen &gt; Objekte &gt; Linien</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; Gekrümme Verbindung</td>
<td>Einfügen &gt; Objekte &gt; Linien</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; TextArt</td>
<td>Einfügen &gt; Objekte &gt; TextArt-Objekt</td>
</tr>
<tr>
<td>Objekt &gt; Neue Zeichnung &gt; AutoFormen</td>
<td>Einfügen &gt; Objekte &gt; AutoForm</td>
</tr>
<tr>
<td>Objekt &gt; Gitter und Hilfslinien</td>
<td>Layout &gt; Position &gt; Gitter und Hilfslinien</td>
</tr>
<tr>
<td>Objekt &gt; Gruppieren</td>
<td>Layout &gt; Objekte &gt; Gruppieren</td>
</tr>
<tr>
<td>Objekt &gt; Reihenfolge &gt; In den Vordergrund</td>
<td>Layout &gt; Position &gt; In den Vordergrund</td>
</tr>
<tr>
<td>Objekt &gt; Reihenfolge &gt; In den Hintergrund</td>
<td>Layout &gt; Position &gt; In den Hintergrund</td>
</tr>
<tr>
<td>Objekt &gt; Reihenfolge &gt; Eine Ebene nach vorne</td>
<td>Layout &gt; Position &gt; In den Vordergrund &gt;&gt; Eine Ebene nach vorne</td>
</tr>
<tr>
<td>Menü</td>
<td>Ribbon</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Objekt &gt; Reihenfolge &gt; Eine Ebene nach hinten</td>
<td>Layout &gt; Position &gt; In den Hintergrund &gt;&gt; Eine Ebene nach hinten</td>
</tr>
<tr>
<td>Objekt &gt; Reihenfolge &gt; In Objekträumen umwandeln</td>
<td>Objekt &gt; Objekte &gt; Konvertieren</td>
</tr>
<tr>
<td>Objekt &gt; Reihenfolge &gt; In eingebettetes Objekt umwandeln</td>
<td>Objekt &gt; Objekte &gt; Konvertieren</td>
</tr>
<tr>
<td>Objekt &gt; Tab-Reihenfolge</td>
<td>Einfügen &gt; Objekte &gt; Formularobjekt &gt;&gt; Tab-Reihenfolge</td>
</tr>
<tr>
<td>Objekt &gt; Drehen oder Kippen &gt; Horizontal kippen</td>
<td>Layout &gt; Position &gt; Objekt drehen &gt;&gt; Horizontal kippen</td>
</tr>
<tr>
<td>Objekt &gt; Drehen oder Kippen &gt; Vertikal kippen</td>
<td>Layout &gt; Position &gt; Objekt drehen &gt;&gt; Vertikal kippen</td>
</tr>
<tr>
<td>Objekt &gt; Drehen oder Kippen &gt; 90° gegen den Uhrzeigersinn drehen</td>
<td>Layout &gt; Position &gt; Objekt drehen &gt;&gt; 90° gegen den Uhrzeigersinn drehen</td>
</tr>
<tr>
<td>Objekt &gt; Drehen oder Kippen &gt; 90° im Uhrzeigersinn drehen</td>
<td>Layout &gt; Position &gt; Objekt drehen &gt;&gt; 90° im Uhrzeigersinn drehen</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Linksbündig</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Linksbündig</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Horizontal zentrieren</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Horizontal zentrieren</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Rechtsbündig</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Rechtsbündig</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Oben ausrichten</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Oben ausrichten</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Vertikal zentrieren</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Vertikal zentrieren</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Unten ausrichten</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Unten ausrichten</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Horizontal verteilen</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Horizontal verteilen</td>
</tr>
<tr>
<td>Objekt &gt; Ausrichten oder verteilen &gt; Vertikal verteilen</td>
<td>Layout &gt; Position &gt; Objekte ausrichten &gt;&gt; Vertikal verteilen</td>
</tr>
<tr>
<td>Objekt &gt; Diagramm &gt; Daten bearbeiten</td>
<td>Diagramm &gt; Daten &gt; Daten bearbeiten</td>
</tr>
<tr>
<td>Objekt &gt; Diagramm &gt; Eigenschaften des Elements</td>
<td>Diagramm &gt; Diagrammelemente &gt; Element bearbeiten</td>
</tr>
<tr>
<td>Menü</td>
<td>Ribbon</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Objekt &gt; Eigenschaften</td>
<td>Objekt &gt; Format &gt; AutoForm-Vorlagen &gt;&gt; Weitere</td>
</tr>
<tr>
<td>Tabelle &gt; Neue Tabelle</td>
<td>Einfügen &gt; Tabelle &gt; Tabelle</td>
</tr>
<tr>
<td>Tabelle &gt; Tabelleneigenschaften</td>
<td>Tabelle &gt; Tabelle &gt; Eigenschaften</td>
</tr>
<tr>
<td>Tabelle &gt; Zeileneigenschaften</td>
<td>Tabelle &gt; Tabelle &gt; Eigenschaften &gt;&gt; Zeileneigenschaften</td>
</tr>
<tr>
<td>Tabelle &gt; Zelleneigenschaften</td>
<td>Tabelle &gt; Tabelle &gt; Eigenschaften &gt;&gt; Zelleneigenschaften</td>
</tr>
<tr>
<td>Tabelle &gt; Tabellenvorlage</td>
<td>Tabelle &gt; Vorlage &gt; Tabellenvorlage</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen einfügen &gt; Zeile oberhalb einfügen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen einfügen &gt;&gt; Zeile oberhalb einfügen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen einfügen &gt; Zeile unterhalb einfügen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen einfügen &gt;&gt; Zeile unterhalb einfügen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen einfügen &gt; Spalte links einfügen</td>
<td>Tabelle &gt; Zellen &gt; Spalten einfügen &gt;&gt; Spalte links einfügen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen einfügen &gt; Spalte rechts einfügen</td>
<td>Tabelle &gt; Zellen &gt; Spalten einfügen &gt;&gt; Spalte rechts einfügen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen einfügen &gt; Zellen einfügen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen einfügen &gt;&gt; Zellen einfügen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen löschen &gt; Zeilen löschen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen löschen &gt;&gt; Zeilen löschen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen löschen &gt; Spalten löschen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen löschen &gt;&gt; Spalten löschen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen löschen &gt; Tabelle löschen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen löschen &gt;&gt; Tabelle löschen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen löschen &gt; Zellen löschen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen löschen &gt;&gt; Zellen löschen</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen verbinden</td>
<td>Tabelle &gt; Verbinden und teilen &gt; Zellen verbinden</td>
</tr>
<tr>
<td>Tabelle &gt; Zellen teilen</td>
<td>Tabelle &gt; Verbinden und teilen &gt; Zellen teilen</td>
</tr>
<tr>
<td>Tabelle &gt; Tabelle teilen</td>
<td>Tabelle &gt; Verbinden und teilen &gt; Tabelle teilen</td>
</tr>
<tr>
<td>Tabelle &gt; Markieren &gt; Tabelle</td>
<td>Tabelle &gt; Tabelle &gt; Markieren</td>
</tr>
<tr>
<td>Tabelle &gt; Markieren &gt; Zeile</td>
<td>Tabelle &gt; Tabelle &gt; Markieren &gt;&gt; Zeilen markieren</td>
</tr>
<tr>
<td>Menü</td>
<td>Ribbon</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Tabelle &gt; Markieren &gt; Spalte</td>
<td>Tabelle &gt; Tabelle &gt; Markieren &gt;&gt; Spalten markieren</td>
</tr>
<tr>
<td>Tabelle &gt; Markieren &gt; Zelle</td>
<td>Tabelle &gt; Tabelle &gt; Markieren &gt;&gt; Aktuelle Zelle markieren</td>
</tr>
<tr>
<td>Tabelle &gt; Zeilen verteilen</td>
<td>Tabelle &gt; Zellen &gt; Zeilen verteilen</td>
</tr>
<tr>
<td>Tabelle &gt; Spalten verteilen</td>
<td>Tabelle &gt; Zellen &gt; Spalten verteilen</td>
</tr>
<tr>
<td>Tabelle &gt; Tabelle in Text umwandeln</td>
<td>Tabelle &gt; Daten &gt; Tabelle in Text umwandeln</td>
</tr>
<tr>
<td>Tabelle &gt; Text in Tabelle umwandeln</td>
<td>Einfügen &gt; Tabelle &gt; Tabelle &gt;&gt; Text in Tabelle umwandeln</td>
</tr>
<tr>
<td>Tabelle &gt; Tabelle sortieren</td>
<td>Tabelle &gt; Daten &gt; Tabelle sortieren</td>
</tr>
<tr>
<td>Table &gt; Select &gt; Column</td>
<td>Table &gt; Table &gt; Select &gt;&gt; Select columns</td>
</tr>
<tr>
<td>Table &gt; Select &gt; Cell</td>
<td>Table &gt; Table &gt; Select &gt;&gt; Select current cell</td>
</tr>
<tr>
<td>Weiteres &gt; Datenbank bearbeiten</td>
<td>Sendungen &gt; Datenbank &gt; Datenbank bearbeiten</td>
</tr>
<tr>
<td>Weiteres &gt; Datenbank erzeugen</td>
<td>Sendungen &gt; Datenbank &gt; Neue Datenbank</td>
</tr>
<tr>
<td>Weiteres &gt; Datenbankstruktur ändern</td>
<td>Sendungen &gt; Datenbank &gt; Datenbankstruktur ändern</td>
</tr>
<tr>
<td>Weiteres &gt; Datenbank zuordnen</td>
<td>Sendungen &gt; Empfänger &gt; Datenbank auswählen &gt;&gt; Vorhandene Datenbank verwenden</td>
</tr>
<tr>
<td>Weiteres &gt; Stichwort &gt; Stichwort aufnehmen</td>
<td>Verweise &gt; Index &gt; Stichwort aufnehmen</td>
</tr>
<tr>
<td>Weiteres &gt; Stichwort &gt; Stichwortliste bearbeiten</td>
<td>Verweise &gt; Index &gt; Stichworte bearbeiten</td>
</tr>
<tr>
<td>Weiteres &gt; Stichwort &gt; Stichwortverzeichnis erstellen</td>
<td>Verweise &gt; Index &gt; Erzeugen</td>
</tr>
<tr>
<td>Weiteres &gt; Bibliografie &gt; Eine vorhandene Bibliografiedatenbank zuordnen</td>
<td>Verweise &gt; Bibliografie &gt; Feld einfügen &gt;&gt; Vorhandene Datenbank verwenden</td>
</tr>
<tr>
<td>Weiteres &gt; Bibliografie &gt; Eine neue Bibliografiedatenbank erstellen</td>
<td>Verweise &gt; Bibliografie &gt; Feld einfügen &gt;&gt; Neue Datenbank erzeugen</td>
</tr>
<tr>
<td>Weiteres &gt; Bibliografie &gt; Die Bibliografiedatenbank bearbeiten</td>
<td>Verweise &gt; Bibliografie &gt; Verwalten &gt;&gt; Datenbank bearbeiten</td>
</tr>
<tr>
<td>Weiteres &gt; Bibliografie &gt; Bibliografie-Einstellungen</td>
<td>Verweise &gt; Bibliografie &gt; Verwalten &gt;&gt; Bibliografie-Einstellungen</td>
</tr>
<tr>
<td><strong>Anhang</strong></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Menü</strong></th>
<th><strong>Ribbon</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weiteres &gt; Bibliografie &gt; Bibliografiefeld einfügen</td>
<td>Verweise &gt; Bibliografie &gt; Feld einfügen</td>
</tr>
<tr>
<td>Weiteres &gt; Bibliografie &gt; Bibliografie erstellen</td>
<td>Verweise &gt; Bibliografie &gt; Erzeugen</td>
</tr>
<tr>
<td>Weiteres &gt; Inhaltsverzeichnis erstellen</td>
<td>Verweise &gt; Inhaltsverzeichnis &gt; Erzeugen</td>
</tr>
<tr>
<td>Weiteres &gt; Abbildungsverzeichnis erstellen</td>
<td>Verweise &gt; Beschriftungen &gt; Erzeugen</td>
</tr>
<tr>
<td>Weiteres &gt; Script starten</td>
<td>Datei &gt; Skripte &gt; Script starten</td>
</tr>
<tr>
<td>Weiteres &gt; Script bearbeiten</td>
<td>Datei &gt; Skripte &gt; Script bearbeiten</td>
</tr>
<tr>
<td>Weiteres &gt; Kommentare &gt; Kommentarfeld automatisch anzeigen</td>
<td>Überarbeiten &gt; Kommentare &gt; Kommentarfeld</td>
</tr>
<tr>
<td>Weiteres &gt; Kommentare &gt; Kommentar einfügen</td>
<td>Überarbeiten &gt; Kommentare &gt; Einfügen</td>
</tr>
<tr>
<td>Weiteres &gt; Kommentare &gt; Kommentar bearbeiten</td>
<td>Überarbeiten &gt; Kommentare &gt; Bearbeiten</td>
</tr>
<tr>
<td>Weiteres &gt; Kommentare &gt; Kommentar löschen</td>
<td>Überarbeiten &gt; Kommentare &gt; Löschen</td>
</tr>
<tr>
<td>Weiteres &gt; Kommentare &gt; Vorheriger Kommentar</td>
<td>Überarbeiten &gt; Kommentare &gt; Vorheriger</td>
</tr>
<tr>
<td>Weiteres &gt; Kommentare &gt; Nächster Kommentar</td>
<td>Überarbeiten &gt; Kommentare &gt; Nächster</td>
</tr>
<tr>
<td>Weiteres &gt; Kommentare &gt; Einstellungen</td>
<td>Überarbeiten &gt; Kommentare</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Änderungen verfolgen</td>
<td>Überarbeiten &gt; Änderungen &gt; Änderungen verfolgen</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Änderungen anzeigen</td>
<td>Überarbeiten &gt; Änderungen &gt; Anzeigen</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Vorherige Änderung</td>
<td>Überarbeiten &gt; Änderungen &gt; Vorherige</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Nächste Änderung</td>
<td>Überarbeiten &gt; Änderungen &gt; Nächste</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Übersicht über alle Änderungen</td>
<td>Überarbeiten &gt; Änderungen &gt; Übersicht</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Einstellungen</td>
<td>Überarbeiten &gt; Änderungen</td>
</tr>
<tr>
<td>Weiteres &gt; Rechtschreibprüfung</td>
<td>Überarbeiten &gt; Rechtschreibung &gt; Rechtschreibprüfung</td>
</tr>
<tr>
<td><strong>Menü</strong></td>
<td><strong>Ribbon</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Weiteres &gt; Wörterbücher bearbeiten</td>
<td>Überarbeiten &gt; Rechtschreibung &gt; Rechtschreibprüfung &gt;&gt; Wörterbücher bearbeiten</td>
</tr>
<tr>
<td>Weiteres &gt; Automatische Silbentrennung</td>
<td>Überarbeiten &gt; Rechtschreibung &gt; Silbentrennung &gt; Automatische Silbentrennung</td>
</tr>
<tr>
<td>Weiteres &gt; Thesaurus</td>
<td>Überarbeiten &gt; Wörterbücher &gt; Thesaurus</td>
</tr>
<tr>
<td>Weiteres &gt; Duden</td>
<td>Überarbeiten &gt; Wörterbücher &gt; Duden</td>
</tr>
<tr>
<td>Weiteres &gt; Langenscheidt</td>
<td>Überarbeiten &gt; Wörterbücher &gt; Übersetzung</td>
</tr>
<tr>
<td>Weiteres &gt; Felder aktualisieren</td>
<td>Verweise &gt; Felder &gt; Felder aktualisieren</td>
</tr>
<tr>
<td>Weiteres &gt; Anpassen</td>
<td>Datei &gt; Einstellungen &gt; Anpassen &gt;&gt; Ribbon anpassen</td>
</tr>
<tr>
<td>Weiteres &gt; Einstellungen</td>
<td>Datei &gt; Einstellungen &gt; Einstellungen</td>
</tr>
</tbody>
</table>
Tastenbelegung

Auf den nächsten Seiten finden Sie Tabellen mit den wichtigsten Tastenkürzeln von TextMaker:

- Tastenkürzel in der Windows-Version und der Linux-Version
- Tastenkürzel in der Mac-Version

**Tipp:** Über den Menübefehl *Weiteres > Anpassen* können Sie die vordefinierten Tastenkürzel jederzeit abändern und auch neue Tastenkürzel festlegen (siehe dazu Abschnitt *Tastenkürzel anpassen*).

---

**Tastenkürzel in der Windows-Version und der Linux-Version**

In der **Windows-Version** und der **Linux-Version** gibt es folgende Tastenkürzel:

## Tastenkürzel für Menübefehle

<table>
<thead>
<tr>
<th>Menübefehl</th>
<th>Tastenkürzel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datei &gt; Neu</td>
<td>Strg+N</td>
</tr>
<tr>
<td>Datei &gt; Öffnen</td>
<td>Strg+O</td>
</tr>
<tr>
<td>Datei &gt; Schließen</td>
<td>Strg+F4 oder Strg+W</td>
</tr>
<tr>
<td>Datei &gt; Speichern</td>
<td>Strg+S</td>
</tr>
<tr>
<td>Datei &gt; Dateimanager</td>
<td>F12</td>
</tr>
<tr>
<td>Datei &gt; Drucken</td>
<td>Strg+P</td>
</tr>
<tr>
<td>Datei &gt; Beenden</td>
<td>Alt+F4 oder Strg+Q</td>
</tr>
<tr>
<td>Bearbeiten &gt; Rückgängig</td>
<td>Strg+Z</td>
</tr>
<tr>
<td>Bearbeiten &gt; Wiederherstellen</td>
<td>Strg+Y</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ausschneiden</td>
<td>Strg+X</td>
</tr>
<tr>
<td>Bearbeiten &gt; Kopieren</td>
<td>Strg+C</td>
</tr>
<tr>
<td>Bearbeiten &gt; Einfügen</td>
<td>Strg+V</td>
</tr>
<tr>
<td>Bearbeiten &gt; Inhalte einfügen</td>
<td>Strg+Alt+V</td>
</tr>
<tr>
<td>Bearbeiten &gt; Alles markieren</td>
<td>Strg+A</td>
</tr>
<tr>
<td>Bearbeiten &gt; Suchen</td>
<td>Strg+F</td>
</tr>
<tr>
<td>Menübefehl</td>
<td>Tastenkürzel</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ersetzen</td>
<td>Strg+H</td>
</tr>
<tr>
<td>Bearbeiten &gt; Suchen wiederholen (beziehungsweise Ersetzen wiederholen)</td>
<td>F3</td>
</tr>
<tr>
<td>Bearbeiten &gt; Gehe zu</td>
<td>F5 oder Strg+G</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ausrechnen</td>
<td>F8</td>
</tr>
<tr>
<td>Ansicht &gt; Vollbild</td>
<td>F6</td>
</tr>
<tr>
<td>Format &gt; Standard</td>
<td>Strg+Leertaste</td>
</tr>
</tbody>
</table>

**Zeichenformatierungen:**

- Schriftart in Formatleiste wählen: Strg+D
- Schriftgröße reduzieren: Strg+8
- Schriftgröße erhöhen: Strg+9
- Fettdruck ein/aus: Strg+Umschalt+F oder Strg+B
- Kursivschrift ein/aus: Strg+Umschalt+K oder Strg+I
- Unterstreichen ein/aus: Strg+Umschalt+U oder Strg+U
- Hochstellen: Strg+Umschalt+Plus (Nummernblock)
- Tiefstellen: Strg+Umschalt+Minus (Nummernblock)
- Hoch-/Tiefstellen abschalten: Strg+Umschalt+* (Nummernblock)

**Absatzformatierungen:**

- Linken Einzug vergrößern: Strg+M
- Linken Einzug verkleinern: Strg+Umschalt+M
- Hängenden Einzug vergrößern: Strg+T
- Hängenden Einzug verkleinern: Strg+Umschalt+T
- Einfacher automatischer Zeilenabstand (1 Zeile): Strg+1
- Anderthalbfacher automatischer Zeilenabstand (1,5 Zeilen): Strg+5
- Zweifacher automatischer Zeilenabstand (2 Zeilen): Strg+2
- Ausrichtung: Linksbündig: Strg+L
- Ausrichtung: Zentriert: Strg+E
- Ausrichtung: Rechtsbündig: Strg+R
- Ausrichtung: Blocksatz: Strg+J

**Absatzformatvorlagen:**
## Anhang

<table>
<thead>
<tr>
<th>Menübefehl</th>
<th>Tastenkürzel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absatzvorlage &quot;Normal&quot;</td>
<td>Alt+0</td>
</tr>
<tr>
<td>Absatzvorlage &quot;Überschrift 1&quot;</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Absatzvorlage &quot;Überschrift 2&quot;</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Absatzvorlage &quot;Überschrift 3&quot;</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Format &gt; Hyperlink</td>
<td>Strg+K</td>
</tr>
<tr>
<td>Format &gt; Format übertragen (Schritt kopieren)</td>
<td>Strg+Umschalt+C</td>
</tr>
<tr>
<td>Format &gt; Format übertragen (Schritt einfügen)</td>
<td>Strg+Umschalt+V</td>
</tr>
<tr>
<td>Einfügen &gt; Datum</td>
<td>Strg+. (Punkt)</td>
</tr>
<tr>
<td>Einfügen &gt; Uhrzeit</td>
<td>Strg+Umschalt+. (Punkt)</td>
</tr>
<tr>
<td>Einfügen &gt; Berechnung</td>
<td>F2</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Fußnote einfügen</td>
<td>Strg+Alt+F</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Zeilenumbruch</td>
<td>Umschalt+.</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Seitenumbruch</td>
<td>Strg+.</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Spaltenumbruch</td>
<td>Strg+Umschalt+.</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Änderungen verfolgen</td>
<td>Strg+Umschalt+E</td>
</tr>
<tr>
<td>Weiteres &gt; Rechtschreibprüfung</td>
<td>F7</td>
</tr>
<tr>
<td>Weiteres &gt; Thesaurus</td>
<td>Umschalt+F7</td>
</tr>
<tr>
<td>Weiteres &gt; Duden</td>
<td>Alt+F7</td>
</tr>
<tr>
<td>Weiteres &gt; Langenscheidt</td>
<td>Strg+F7</td>
</tr>
<tr>
<td>Weiteres &gt; Felder aktualisieren</td>
<td>F9</td>
</tr>
</tbody>
</table>

---

### Tastenkürzel für das Editieren von Text

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Tastenkürzel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zum nächsten Formularobjekt (bzw. in Tabellen: zur nächsten Zelle)</td>
<td>Strg+F11</td>
</tr>
<tr>
<td>Zum vorherigen Formularobjekt (bzw. in Tabellen: zur vorherigen Zelle)</td>
<td>Strg+Umschalt+F11</td>
</tr>
<tr>
<td>Zum nächsten Formularobjekt (im Formularmodus)</td>
<td>Tab</td>
</tr>
<tr>
<td>Befehl</td>
<td>Tastenkürzel</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Zum vorherigen Formularobjekt (im Formularmodus)</td>
<td>Umschalt+Tab</td>
</tr>
<tr>
<td>Groß-/Kleinschreibung des selektierten Textes ändern (von &quot;test&quot; zu &quot;TEST&quot;)</td>
<td>Umschalt+F3</td>
</tr>
<tr>
<td>Weiches Trennzeichen einfügen (bedingter Trennstrich)</td>
<td>Strg+Minus</td>
</tr>
<tr>
<td>Geschütztes Trennzeichen einfügen (nicht-trennender Bindestrich)</td>
<td>Strg+Umschalt+Minus</td>
</tr>
<tr>
<td>Kurzen Gedankenstrich einfügen (Halbgeviertstrich –)</td>
<td>Strg+Minus(Nummernblock)</td>
</tr>
<tr>
<td>Langen Gedankenstrich einfügen (Geviertstrich —)</td>
<td>Strg+Alt+Minus(Nummernblock)</td>
</tr>
<tr>
<td>Geschütztes Leerzeichen einfügen (nicht-trennendes Leerzeichen)</td>
<td>Strg+Umschalt+Leertaste</td>
</tr>
<tr>
<td>Hexadezimalen Zeichencode in Unicode-Zeichen wandeln*</td>
<td>Strg+Alt+Umschalt+X</td>
</tr>
</tbody>
</table>


### Weitere nützliche Tastenkürzel

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Tastenkürzel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ribbon ein-/ausblenden</td>
<td>Strg+F1</td>
</tr>
<tr>
<td>Zur nächsten Ribbon-Karte</td>
<td>Strg+F12</td>
</tr>
<tr>
<td>Zur vorherigen Ribbon-Karte</td>
<td>Strg+Umschalt+F12</td>
</tr>
<tr>
<td>Bei geöffneten Dialogen: zur nächsten Karteikarte</td>
<td>Strg+Tab</td>
</tr>
<tr>
<td>Bei geöffneten Dialogen: zur vorherigen Karteikarte</td>
<td>Strg+Umschalt+Tab</td>
</tr>
</tbody>
</table>

### Tastenkürzel in der Mac-Version

*Anmerkung:* Bei den meisten Tastenkürzeln mit der **Cmd**-Taste lässt sich alternativ auch die **Ctrl**-Taste statt der **Cmd**-Taste verwenden. Für das Tastenkürzel **Cmd+S** können Sie also wahlweise auch **Ctrl+S** drücken.

In der **Mac**-Version gibt es folgende Tastenkürzel:
## Tastenkürzel für Menübefehle

<table>
<thead>
<tr>
<th>Menübefehl</th>
<th>Tastenkürzel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datei &gt; Neu</td>
<td>Cmd+N</td>
</tr>
<tr>
<td>Datei &gt; Öffnen</td>
<td>Cmd+O</td>
</tr>
<tr>
<td>Datei &gt; Schließen</td>
<td>Cmd+F4 oder Cmd+W</td>
</tr>
<tr>
<td>Datei &gt; Speichern</td>
<td>Cmd+S</td>
</tr>
<tr>
<td>Datei &gt; Dateimanager</td>
<td>F12</td>
</tr>
<tr>
<td>Datei &gt; Drucken</td>
<td>Cmd+P</td>
</tr>
<tr>
<td>Datei &gt; Beenden</td>
<td>Alt+F4 oder Cmd+Q</td>
</tr>
<tr>
<td>Bearbeiten &gt; Rückgängig</td>
<td>Cmd+Z</td>
</tr>
<tr>
<td>Bearbeiten &gt; Wiederherstellen</td>
<td>Cmd+Y</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ausschneiden</td>
<td>Cmd+X</td>
</tr>
<tr>
<td>Bearbeiten &gt; Kopieren</td>
<td>Cmd+C</td>
</tr>
<tr>
<td>Bearbeiten &gt; Einfügen</td>
<td>Cmd+V</td>
</tr>
<tr>
<td>Bearbeiten &gt; Inhalte einfügen</td>
<td>Cmd+Alt+V</td>
</tr>
<tr>
<td>Bearbeiten &gt; Alles markieren</td>
<td>Cmd+A</td>
</tr>
<tr>
<td>Bearbeiten &gt; Suchen</td>
<td>Cmd+F</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ersetzen</td>
<td>Cmd+H</td>
</tr>
<tr>
<td>Bearbeiten &gt; Suchen wiederholen</td>
<td>F3</td>
</tr>
<tr>
<td>(beziehungsweise Ersetzen wiederholen)</td>
<td></td>
</tr>
<tr>
<td>Bearbeiten &gt; Gehe zu</td>
<td>F5 oder Cmd+G</td>
</tr>
<tr>
<td>Bearbeiten &gt; Ausrechnen</td>
<td>F8</td>
</tr>
<tr>
<td>Ansicht &gt; Vollbild</td>
<td>F6</td>
</tr>
<tr>
<td>Format &gt; Standard</td>
<td>Cmd+Leertaste</td>
</tr>
</tbody>
</table>

### Zeichenformatierungen:

- **Schriftart in Formatleiste wählen**  
  - Cmd+D

- **Schriftgröße reduzieren**  
  - Cmd+8

- **Schriftgröße erhöhen**  
  - Cmd+9

- **Fettdruck ein/aus**  
  - Cmd+Umschalt+F oder Cmd+B

- **Kursivschrift ein/aus**  
  - Cmd+Umschalt+K oder Cmd+I
<table>
<thead>
<tr>
<th>Menübefehl</th>
<th>Tastenkürzel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unterstreichen ein/aus</td>
<td>Cmd+Umschalt+U oder Cmd+U</td>
</tr>
<tr>
<td>Hochstellen</td>
<td>Cmd+Umschalt+Plus (Nummernblock)</td>
</tr>
<tr>
<td>Tiefstellen</td>
<td>Cmd+Umschalt+Minus (Nummernblock)</td>
</tr>
<tr>
<td>Hoch-/Tiefstellen abschalten</td>
<td>Cmd+Umschalt+* (Nummernblock)</td>
</tr>
<tr>
<td><strong>Absatzformatierungen:</strong></td>
<td></td>
</tr>
<tr>
<td>Linken Einzug vergrößern</td>
<td>Cmd+M</td>
</tr>
<tr>
<td>Linken Einzug verkleinern</td>
<td>Cmd+Umschalt+M</td>
</tr>
<tr>
<td>Hängenden Einzug vergrößern</td>
<td>Cmd+T</td>
</tr>
<tr>
<td>Hängenden Einzug verkleinern</td>
<td>Cmd+Umschalt+T</td>
</tr>
<tr>
<td>Einfacher automatischer Zeilenabstand (1 Zeile)</td>
<td>Cmd+1</td>
</tr>
<tr>
<td>Anderthalbfacher automatischer Zeilenabstand (1,5 Zeilen)</td>
<td>Cmd+5</td>
</tr>
<tr>
<td>Zweifacher automatischer Zeilenabstand (2 Zeilen)</td>
<td>Cmd+2</td>
</tr>
<tr>
<td>Ausrichtung: Links bündig</td>
<td>Cmd+L</td>
</tr>
<tr>
<td>Ausrichtung: Zentriert</td>
<td>Cmd+E</td>
</tr>
<tr>
<td>Ausrichtung: Rechtsbündig</td>
<td>Cmd+R</td>
</tr>
<tr>
<td>Ausrichtung: Block satz</td>
<td>Cmd+J</td>
</tr>
<tr>
<td><strong>Absatzformatvorlagen:</strong></td>
<td></td>
</tr>
<tr>
<td>Absatzvorlage &quot;Normal&quot;</td>
<td>Alt+0</td>
</tr>
<tr>
<td>Absatzvorlage &quot;Überschrift 1&quot;</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Absatzvorlage &quot;Überschrift 2&quot;</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Absatzvorlage &quot;Überschrift 3&quot;</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Format &gt; Hyperlink</td>
<td>Cmd+K</td>
</tr>
<tr>
<td>Format &gt; Format übertragen (Schritt kopieren)</td>
<td>Cmd+Umschalt+C</td>
</tr>
<tr>
<td>Format &gt; Format übertragen (Schritt einfügen)</td>
<td>Cmd+Umschalt+V</td>
</tr>
<tr>
<td>Einfügen &gt; Datum</td>
<td>Cmd+. (Punkt)</td>
</tr>
<tr>
<td>Einfügen &gt; Uhrzeit</td>
<td>Cmd+Umschalt+. (Punkt)</td>
</tr>
<tr>
<td>Einfügen &gt; Berechnung</td>
<td>F2</td>
</tr>
<tr>
<td>Einfügen &gt; Fußnote &gt; Fußnote einfügen</td>
<td>Cmd+Alt+F</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Zeilenumbruch</td>
<td>Umschalt+.J</td>
</tr>
<tr>
<td>Menübefehl</td>
<td>Tastenkürzel</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Seitenumbruch</td>
<td>Cmd+.,.</td>
</tr>
<tr>
<td>Einfügen &gt; Umbruch &gt; Spaltenumbruch</td>
<td>Cmd+Umschalt+.,.</td>
</tr>
<tr>
<td>Weiteres &gt; Änderungen &gt; Änderungen verfolgen</td>
<td>Cmd+Umschalt+E</td>
</tr>
<tr>
<td>Weiteres &gt; Rechtschreibprüfung</td>
<td>F7</td>
</tr>
<tr>
<td>Weiteres &gt; Thesaurus</td>
<td>Umschalt+F7</td>
</tr>
<tr>
<td>Weiteres &gt; Duden</td>
<td>Alt+F7</td>
</tr>
<tr>
<td>Weiteres &gt; Langenscheidt</td>
<td>Cmd+F7</td>
</tr>
<tr>
<td>Weiteres &gt; Felder aktualisieren</td>
<td>F9</td>
</tr>
<tr>
<td>Feldnamen anzeigen</td>
<td>Alt+F9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tastenkürzel für das Editieren von Text</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Befehl</strong></td>
<td><strong>Tastenkürzel</strong></td>
</tr>
<tr>
<td>Zum nächsten Formularobjekt (bzw. in Tabellen: zur nächsten Zelle)</td>
<td>Cmd+F11</td>
</tr>
<tr>
<td>Zum vorherigen Formularobjekt (bzw. in Tabellen: zur vorherigen Zelle)</td>
<td>Cmd+Umschalt+F11</td>
</tr>
<tr>
<td>Zum nächsten Formularobjekt (im Formularmodus)</td>
<td>Tab</td>
</tr>
<tr>
<td>Zum vorherigen Formularobjekt (im Formularmodus)</td>
<td>Umschalt+Tab</td>
</tr>
<tr>
<td>Groß-/Kleinschreibung des selektierten Textes ändern (von &quot;test&quot; zu &quot;Test&quot; zu TEST&quot;)</td>
<td>Umschalt+F3</td>
</tr>
<tr>
<td>Weiches Trennzeichen einfügen (bedingter Trennstrich)</td>
<td>Cmd+Minus</td>
</tr>
<tr>
<td>Geschütztes Trennzeichen einfügen (nicht-trennender Bindestrich)</td>
<td>Cmd+Umschalt+Minus</td>
</tr>
<tr>
<td>Kurzen Gedankenstrich einfügen (Halbgerviertstrich –)</td>
<td>Cmd+Minus(Nummernblock)</td>
</tr>
<tr>
<td>Langen Gedankenstrich einfügen (Geviertstrich —)</td>
<td>Cmd+Alt+Minus(Nummernblock)</td>
</tr>
<tr>
<td>Geschütztes Leerzeichen einfügen (nicht-trennendes Leerzeichen)</td>
<td>Cmd+Umschalt+Leertaste</td>
</tr>
<tr>
<td>Hexadezimalen Zeichencode in Unicode-Zeichen wandeln*</td>
<td>Cmd+Alt+Umschalt+X</td>
</tr>
</tbody>
</table>

### Weitere nützliche Tastenkürzel

<table>
<thead>
<tr>
<th>Befehl</th>
<th>Tastenkürzel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ribbon ein-/ausblenden</td>
<td>Cmd+F1</td>
</tr>
<tr>
<td>Zur nächsten Ribbon-Karte</td>
<td>Cmd+F12</td>
</tr>
<tr>
<td>Zur vorherigen Ribbon-Karte</td>
<td>Cmd+Umschalt+F12</td>
</tr>
<tr>
<td>Bei geöffneten Dialogen: zur nächsten Karteikarte</td>
<td>Cmd+Tab</td>
</tr>
<tr>
<td>Bei geöffneten Dialogen: zur vorherigen Karteikarte</td>
<td>Cmd+Umschalt+Tab</td>
</tr>
</tbody>
</table>
3D-Effekt (bei Objekten)  222

A

Abbildungsverzeichnis  355, 358, 364
ABOVE  328
Absatz  65
   - Karteikarte Absatz  41, 66, 67, 69, 71
   - Karteikarte Initialen  78
   - Karteikarte Schattierung  79
   - Karteikarte Tabulatoren  71, 73
   - Karteikarte Textfluss  84, 85, 273
   - Karteikarte Umrandung  80
Absatzausrichtung  41, 70
Absätze zusammenhalten  84
Absatzformatierung
   - Ändern  65
   - Suchen und Ersetzen  132
Absatzmarken anzeigen  431
Absatzvorlagen  112, 114, 115, 117, 119
Absender  137, 433
ABS-Funktion  337
Abstand vom Text (bei Umrundungen)  80
Adressaufkleber  302
Adressdatenbank  289
Adresse  137, 289, 433
Adresse ins Dokument einfügen  298
Adresslisten  302
Aktualisierungen suchen  447
Alles markieren  51
Alles speichern (Datei)  33
Alte Schreibweisen blau unterstreichen  270, 442
An anderen Objekten ausrichten  480
Änderungen am Dokument  381
   - Änderungen anzeigen  382
   - Änderungen verfolgen  382
   - Einstellungen  384
   - Nächste Änderung  382
   - Übersicht über alle Änderungen  382
   - Vorherige Änderung  382
Änderungsdatum  137
Änderungszeit  137
Anführungszeichen, typografische
   - Suchen  130
   - Verwenden  435
Anker (von Objekten)  210, 214
Anpassen
   - Benutzerdefinierte Symbole erstellen  476
   - Symbolleisten anpassen  465
   - Tastenkürzel anpassen  477
Anschläge zählen  455
Ansicht > Fingereingabemodus  438

Ansicht > Formularmodus  246, 261
Ansicht > Ganze Seite  459
Ansicht > Gliederung  342
Ansicht > Konzept  458
Ansicht > Linealleiste  458
Ansicht > Lupe  459
Ansicht > Masterseiten  96, 458
Ansicht > Normal  458
Ansicht > Objektmodus  208
Ansicht > Originalgröße  459
Ansicht > Seitenbreite  459
Ansicht > Seitenleiste  24, 111, 118, 135
Ansicht > Symbolleisten  460
Ansicht > Textbreite  459
Ansicht > Vergrößerungstufe  459
Ansicht > Vollbild  460
Ansicht > Zwei ganze Seiten  459
Ansicht formatiert für...  451
Antialiasing  438
Arabische Schriftzeichen  422, 433
ASC-Funktion  337
Asiatische Schriftzeichen  433
AT-Funktion  337
Auf Seitenränder springen  480
Aufkleber  302
Aufzählung  74, 145, 149
Ausrechnen  333
Ausrichten oder verteilnen (Objekt)  213
Ausrichtung
   - der Seite  88, 99
   - von Absätzen  41
   - von Tabulatoren  71
   - von Text in Textfeldern  253
   - von Text in Textrahmen  230
Ausrichtungstabulatoren  92
Ausschneiden  53
Auswahlliste (Formularobjekt)  248, 256
Auswahllistenrahmen (Formularobjekt)  248, 258
AutoFormat (Tabellenvorlage)  172
AutoFormen
   - Eigenschaften ändern  241
   - Text hinzufügen  241
   - Zeichen  238
Automatische Silbentrennung  273, 442
Automatische Wiederherstellung  445
Auto-Nummer  137
   - Zurücksetzen  156
AVG-Funktion  337

B

BAK-Dateien  412
BasicMaker  426
Bearbeiten > Alles markieren 51
Bearbeiten > Ausschneiden 53
Bearbeiten > Duplizieren 213
Bearbeiten > Einfügen 53
Bearbeiten > Ersetzen 129, 130, 132
Bearbeiten > Ersetzen wiederholen 130
Bearbeiten > Gehe zu 133, 134, 135
Bearbeiten > Gehe zu Hyperlink 389
Bearbeiten > Inhalte einfügen 54
Bearbeiten > Kopieren 53
Bearbeiten > Löschen 53
Bearbeiten > Rückgängig 29
Bearbeiten > Sortieren 177
Bearbeiten > Suchen 128, 130, 132
Bearbeiten > Suchen wiederholen 130
Bearbeiten > Verknüpfungen 201
Bearbeiten > Wiederherstellen 29
Bedingter Text (IF-Funktion) 332
Bedingter Trennstrich 273
Beenden (Datei) 33
BELOW 328
Benutzerdaten 137, 433
Benutzeroberfläche (Ribbon oder Menüs mit Symbolleisten?) 438
Benutzerwörterbücher 272
Berechnung 324, 331
Berechnungen 324
Einfügen 324
Formatieren 331
mit Datenbankfeldern 329
mit Objekten 330
mit Tabellenzellen 328
mit Variablen 325
Runden 331
Bereich (Format) 127
Auto-Nummer zurücksetzen 156
Mehrspaltdruck 124, 127
Zeilenummern anbringen 157
Bereichsumbruch 127, 156, 157
Beschnitt (von Grafiken) 183, 185, 233
Begschriftung 355, 356
Bezeichnungen (Formularelement) 248, 258
Bibliografie 360
Bibliografie erstellen 363, 364
Bibliografiedatenbank bearbeiten 360
Bibliografie-Einstellungen 362
Bibliografiefeld einfügen 362
Neue Bibliografiedatenbank erstellen 360
Vorhandene Bibliografiedatenbank zuordnen 362
Bilder anzeigen 451
Bildschirmtextarten glätten 438
Bindestreich
beschützter (nicht-trennender) 273
weicher (bedingter) 273
Bindestreich, weicher 431
Blockabsatz 41
Briefumschlag einfügen 306
Bullets und Nummerierungen 74, 145, 150, 154, 155, 347
Bundsteg 88

C
CHR-Funktion 337
COUNT-Funktion 337

D
Datei > Alles speichern 33
Datei > Als EPUB-Dokument exportieren 401
Datei > Als PDF-Dokument exportieren 397
Datei > Beenden 33
Datei > Dateimanager 409
Datei > Drucken 32, 394
Datei > Druckvorschau 392
Datei > Eigenschaften 450
Karteikarte Ansicht 451
Karteikarte Farben 454
Karteikarte Formular 456
Karteikarte Infos 408, 451
Karteikarte Schriften 457
Karteikarte Schutz 415, 456
Karteikarte Statistik 455
Karteikarte Überarbeiten 379, 384, 457
Datei > Holen 181
Datei > Neu 29, 120, 122, 298
Datei > Öffnen 31, 122, 418
Datei > Quelle wählen 181
Datei > Schließen 428
Datei > Seite einrichten 88
Datei > Serienbriefdruck 396
Datei > Speichern 33
Datei > Speichern unter 33, 121, 418
Datei > Versenden 404
Datei > Zurück zu vorheriger Version 412
Dateierweiterungen verknüpfen 447
Dateiformate 418
Dateimanager 409
Dateiname 137
Datetyp 418
Datenbank 289, 309
Bedienung 290
Datensatz anhängen 296
Datensatz bearbeiten 296
Datensatz direkt aufrufen 294
Datensatz löschen 296
Datensatz wiederherstellen 296
Datumsmarkierung 309
Datenbank 289, 309
   Durchsuchen 294
   Einem Dokument zuordnen 315
   Einzeladresse ins Dokument einfügen 120, 122, 298
   Formularansicht 293
   Listenansicht 293
   Neue anlegen 309
   Öffnen 290
   Schließen 298
   Selektieren 318
   Serienbriefe 314
   Sortieren 297
   Struktur ändern 311
Datenbank bearbeiten 289
Datenbank erzeugen 290, 309
Datenbank zuordnen 315
Datenbankfeld 137
Datenbankinfos 137
Datenbankstruktur ändern 311
Datensatz anzeigen 451
Datensatznummer 291
Datum 137
Datum/Uhrzeit einfügen 141
Datumsfeld (Datenbank) 309
DAY-Funktion 337
dBase/DOS-Dateiformat (Datenbank) 290, 309
dBase/Unicode-Dateiformat (Datenbank) 290, 309
dBase/Windows-Dateiformat (Datenbank) 290, 309
Design Science 204
Deutsche Übersetzung 285
Dezimaltabulator 71
Dezimaltrenner 451
Diagramme 187
   als Grafik speichern 198
   Bearbeiten 190
   Daten eingeben/bearbeiten 189, 191
   Diagrämmelemente bearbeiten 193
   Eigenschaften ändern 194
   Einfügen 187
   manuell einfügen 189
   über Planmaker einfügen 188
Diagrammleiste 190
Dialogsprache 438
DOC-Dateiformat 418
DOCX-Dateiformat 418
Dokument einfügen 54
Dokument skalieren 438
Dokumenteigenschaften 450
   Karteikarte Ansicht 451
   Karteikarte Farben 454
   Karteikarte Formular 456
   Karteikarte Infos 451
   Karteikarte Schriften 457
   Karteikarte Schutz 456
   Karteikarte Statistik 455
   Karteikarte Überarbeiten 379, 384, 457
Dokumentfenster 427
Dokumentinfos
   als Feld einfügen 137
   Eintragen 408
Dokumentschutz 415
Dokumentstatistik 455
Dokumentvorlagen
   Adresse einfügen lassen 120, 122, 298
   Anwenden 122
   Bearbeiten 122
   Erstellen 121
   Vorlage Normal.tmux 123
Drag and Drop 53
Drehen
   Grafiken 218
   Objekte 212, 218
   Text in AutoFormen 242
   Text in Textrahmen 230
   Zeichnungen 218
Drehen oder Kippen (von Objekten) 212
Druckdatum 137
Drucken 394
   Datei 32, 394
   Serienbriefe 396
Drucken (Objekteigenschaft) 223
Druckvorschau 392
Druckzeit 137
DTON-Funktion 337
Duden 283
Duden-Grammatikprüfung 279
Duden-Korrektor 277, 442
Duden-Korrektor konfigurieren 281
Duden-Rechtschreibprüfung 278
Duden-Silbentrennung 278
Duden-Wörterbücher zum Nachschlagen 283
Duplizieren 213
Durchstreichen 57

E
Echtzeitvorschau 438
Editiermodus 208
Editierposition (zur letzten springen beim Öffnen) 445
Effekte (bei Objekten) 222
Eigenschaften (Menü Datei) 450
   Karteikarte Ansicht 451
   Karteikarte Farben 454
   Karteikarte Formular 456
   Karteikarte Infos 408, 451
   Karteikarte Schriften 457
   Karteikarte Schutz 415, 456
   Karteikarte Statistik 455
   Karteikarte Überarbeiten 379, 384, 457
Eigenschaften (Menü Objekt)
   Allgemeine Eigenschaften 214
Eigenschaften (Menü Objekt)
  Bei Auswahllisten 257
  Bei Auswahllistenrahmen 257
  Bei Bezeichnungen 259
  bei Diagrammen 194
  Bei Fußzeilen 93
  Bei Grafiken 183
  Bei Grafikrahmen 233
  Bei Gruppenfeldern 259
  Bei horizontalen Linien 388
  Bei Kontrollkästchen 255
  Bei Kontrollkästchenrahmen 255
  Bei Kopfzeilen 93
  Bei OLE-Objekten 202
  Bei OLE-Objektrahmen 236
  Bei Tabellen 170
  Bei Textfeldern 253
  Bei Textrahmen 230
  Bei Zeichnungen 241
  Standardeinstellungen ändern 224
Einfügemodus 29
Einfügen 53
Einfügen > Berechnung 324, 331
Einfügen > Beschriftung 356
Einfügen > Briefumschlag 306
Einfügen > Datum/Uhrzeit 141
Einfügen > Dokument 54
Einfügen > Feld 137
Einfügen > Fußnote
  Fußnote bearbeiten 371
  Fußnote einfügen 371
  Fußnotenzeichen 371
  Gehe zu Fußnote 371
  Gehe zu Fußnotenreferenz 371
  Optionen 373
Einfügen > Fußzeile 90
Einfügen > Kopfzeile 90
Einfügen > Liste/Aufkleber 302
Einfügen > Querverweis 366, 367
Einfügen > Sonderzeichen 143
Einfügen > Textbausteine 286, 287, 288
Einfügen > Textmarke 133
Einfügen > Umschreib
  Bereichsumbruch 127, 156, 157
  Kapitelumbruch 97, 98
  Seitenumbruch 87
  Spaltenumbruch 124
  Zeilenumbruch 85
Eingabestelle 27
Einrückung 66
Einstellungen (TextMaker) 430, 431
  Karteikarte Allgemein 433
  Karteikarte Ansicht 431
  Karteikarte Aussehen 438
  Karteikarte Bearbeiten 435
  Karteikarte Dateien 445
  Karteikarte Schriften 450
  Karteikarte Sprache 442
  Karteikarte System 447
Einzüge 66
Ellipsen
  Eigenschaften ändern 241
  Zeichnen 238
E-Mail 404
Endnoten 373
Englische Übersetzung 285
EPUB-Export 401
Ersetzen 129, 130, 132
  Formatierungen 132
  Text 129
Ersetzen wiederholen 130
Erste Zeile (Einzug) 66
Erstelldatum 137
Erstellezeit 137
Ersten Buchstaben eines Satzes groß schreiben 435
Erweiterte Unterstützung für arabischen Text 422, 433
Erweiterte Unterstützung für asiatische Schriften 433
Etiketten 302
Export (eines Fremdformats) 418

F
Farbe
  von Objekten 219
  von Text 59
Farbpalette bearbeiten 454
Farbverlauf (bei Objekten) 219
Feld einfügen 137
Felder aktualisieren 137, 332
Felder schattieren 137, 451
Feldnamen anzeigen 137
Fenster > Alle schließen 428
Fenster > Nebeneinander anzeigen 429
Festabstand 84
Fett 57
Fingereingabemodus 438
Format > Absatz 65
  Karteikarte Absatz 41, 66, 67, 69, 71
  Karteikarte Initialen 78
  Karteikarte Schattierung 79
  Karteikarte Tabulatoren 71, 73
  Karteikarte Textfluss 84, 85, 273
  Karteikarte Umrandung 80
Format > Absatzvorlage 112, 114, 115, 117
Format > Bereich
  Auto-Nummer zurücksetzen 156
  Mehrspaltendruck 124, 127
  Zeilennummern anbringen 157
Format > Bullets und Nummerierungen 74, 145, 150, 154, 155, 347
Format > Format übertragen 61
Format > Hyperlink 389
Format > Hyperlink entfernen 389
Format > Initialen 78
Format > Kapitel 91, 94, 95, 99
Format > Schattierung 79
Format > Seitenhintergrund 102
Format > Standard 63, 109
Format > Tabulator 71, 73
Format > Umrandung 80
Format > Vorlagenmanager 119
Format > Zeichen 56, 57, 59, 60, 62, 63, 64
Format > Zeichenvorlage 105, 107, 108, 110
Format übertragen 61
Formatleiste 22, 41, 57
Formatvorlagen 104, 119
Formeleditor 204
Formeln 334
Formulare 245
   Ausfüllen 246
   Beispiel 250
   Erstellen 248
   Formulare schützen 261
   Inhalt von Formularobjekten schützen 260
Formularleiste 249
Formularmodus 246, 261
Formularobjekte
   Bearbeiten 250
   Einfügen 249
   Inhalt schützen 260
   Verwenden 253
Französische Übersetzung 285
Freihandformen
   Eigenschaften ändern 241
   Zeichnen 238
Fremdformate 418
Füllung (von Objekten) 219
Füllzeichen (für Tabulatoren) 71
Funktionen (in Berechnungen) 337
Funktionsleiste 22
Fußnoten 371
   Fußnote bearbeiten 371
   Fußnote einfügen 371
   Fußnotenzeichen 371
   Gehe zu Fußnote 371
   Gehe zu Fußnotenreferenz 371
   Optionen 373
Fußnotenstrich 373
Fußzeilen 90

G
Ganze Seite (Ansicht) 459
Ganzes Wort markieren 435
Gehe zu 134, 135

H
Handbuch 16
Hilfslinien 431, 480
Hintergrundfarbe der Dokumentseiten 102
   des Programms 438
   von Text 59
Hochformat 88
Hochstellen 60
Holen (Datei) 181
Horizontale Linie 388
   Horizontale Position (von Objekten) 214
   Horizontales Lineal 24, 431
HTML-Dokumente 386
HunsSpell-Wörterbücher 442, 483
Hyperlinks (Verknüpfungen) bei Objekten 223
   im Text 389

Index

Hilfszeichen der Dokumentseiten 438
   Optionen 59
Hyphen (Verknüpfungen) bei Objekten 223
   im Text 389
Index

Hyperlinks entfernen 389

I
IF-Funktion 332, 337
Ignoriere Wörter, die mit einer Zahl beginnen 442
Import (eines Fremdformats) 418
Inhalte einfügen 54
Inhaltsverzeichnis 354
Inhaltsverzeichnis erstellen 354, 364
Initialen 78
Innenränder
von Text in AutoFormen 242
von Textrahmen 230
Installation 17
Android 19
Linux 18
macOS 17
Windows 17
Internen Grafikcache begrenzen 447
Internet
HTML-Dokumente bearbeiten 386
INT-Funktion 337
Italienische Übersetzung 285

K
Kantenglättung von Grafiken 447
 Kapitälchen 57
 Kapitel 91, 94, 95, 99
 Formatierung 98, 99
 Verwenden 97
 Kapitelnummer 99, 137
 Kapitelumbruch 97, 98
 Kein Umbruch im Absatz 84
 Kennwort
 für Dokumente 415
 für Formulare 261
 Kerning 60
 Kippen (von Objekten) 212
 Klassische Menüs und Symbolleisten 438
 Kommentare 376
 Einstellungen 379
 Kommentar bearbeiten 377
 Kommentar einfügen 377
 Kommentar löschen 378
 Kommentarfeld automatisch anzeigen 378, 379
 Nächster Kommentar 379
 Vorheriger Kommentar 379
 Kompatibilität (Dokumentoption) 451
 Komplexe Schriftzeichen 433
 Komprimieren (Datenbanken) 296
 Kontextmenü 21
 Kontrollkästchen 248
 Kontrollkästchenrahmen 248
 Kontrollkästchenrahmen (Formularobjekt) 256
 Kontur (bei Rahmen) 214
 Kontrastsatz 214
 Konzept (Ansicht) 458
 Kopf- und Fußzeilenleiste 90
 Kopfzeilen 90
 Kopieren 53
 Kreise
 Eigenschaften ändern 241
 Zeichnen 238
 Kursiv 57
 Kurven
 Eigenschaften ändern 241
 Zeichnen 238

L
Langenscheidt 285
Langenscheidt-Übersetzungswörterbücher 285
Laufweite 60
Leerzeichen anzeigen 431
Leerzeichen beim Einfügen hinzufügen/löschen 435
Leerzeichen vor Satzzeichen hinzufügen (Französisch) 435
Leerzeichen, geschütztes 84, 322
LEFT 328
LEFT-Funktion 337
LEN-Funktion 337
Letzter Autor 137
Leuchteffekt (bei Objekten) 222
Lineal(leiste (Ansicht) 24, 66, 73, 458
Linien
 Eigenschaften ändern 241
 Zeichnen 238
 zur Umrandung von Absätzen 80
 zur Umrandung von Objekten 220
Linke Alt-Taste für Tastenkürzel verwenden 435
Linken Einzug und Erstzeileneinzug mit Tabulator- und Rückschritt-Taste setzen 435
Links (Verknüpfungen)
 bei Objekten 223
 im Text 389
Linksbündig 41
Liste 74, 145, 149
Liste/Aufkleber einfügen 302
Listen (für Adressen) 302
Literaturverzeichnis 360
Logisches Feld (Datenbank) 309
Löschen 28, 53
LTRIM-Funktion 337
Lupe (Ansicht) 459
Mailen eines Dokuments 404
Markieren
  Objekte 208
  Tabelle 161
  Text 51
Markierung für Textüberlauf 431
Maßeinheit 65, 438
Masterseiten 95
Masterseiten (Ansicht) 96, 458
MathType 204
MAX-Funktion 337
Maximal widerrufbare Aktionen 433
Mehrere Seiten nebeneinander anzeigen 431
Melodiantendruck 124
Memofeld (Datenbank) 309
Menüband 14, 22
Menüleiste 21
Menüs mit Symbolleisten oder Ribbon? 438
Microsoft Word-Dateiformat 418, 445
MIN-Funktion 337
Mittlere Maustaste 435
MONTH-Funktion 337
Muster 79

Namen (von Objekten) 227
Nebeneinander anzeigen (Fenster) 429
Neu (Datei) 29, 120, 122, 298
Neue Diagramme einfügen 189
Neue Diagrammrahmen einfügen 189
Neue Grafik aus der Galerie/Kamera einfügen 182
Neue Grafik einfügen 180
Neue Grafikrahmen aus der Galerie/Kamera einfügen 182
Neue Grafikrahmen einfügen 180, 232
Neue horizontale Linie 388
Neue OLE-Objekte einfügen 199
Neue OLE-Objektrahmen einfügen 236
Neue Tabelle einfügen 160
Neue Textrahmen einfügen 229
Neue Zeichnungen einfügen 238
Neuer Standard (für Dokumentvorlagen) 123
Neues Formularobjekt einfügen 249
  Auswahlliste 256
  Auswahllistenrahmen 258
  Bezeichnung 258
  Gruppenfeld 258
  Kontrollkästchen 255
  Kontrollkästchenrahmen 256
  Textfeld 253

Nichtdruckbare Zeichen anzeigen 431
Nicht-trennender Bindestrich 273
Nicht-trennendes Leerzeichen 84
Normal (Ansicht) 458
Normal.tmw 123
NTOD-Funktion 337
Numerisches Feld (Datenbank) 309
Nummerierung 145
  mit Auto-Nummern 156
  Nummerierungslisten 149
  von Absätzen 145
  von Überschriften 347
Nummerierungsliste 149
Nummernanzeige 433
Nur Feldnamen anzeigen 137, 451

Objekt > Ausrichten oder verteilen 213
Objekt > Diagramm
  Als Grafik speichern 198
  Daten bearbeiten 189, 191
Objekt > Drehen oder Kippen 212
Objekt > Eigenschaften
  Allgemeine Eigenschaften 214
  Bei Auswahllisten 257
  Bei Auswahllistenrahmen 257
  Bei Bezeichnungen 259
  bei Diagrammen 194
  Bei Fußzeilen 93
  Bei Grafiken 183
  Bei Grafikrahmen 233
  Bei Gruppenfeldern 259
  Bei horizontalen Linien 388
  Bei Kontrollkästchen 255
  Bei Kontrollkästchenrahmen 255
  Bei Kopfzeilen 93
  Bei OLE-Objekten 202
  Bei OLE-Objektrahmen 236
  Bei Tabellen 170
  Bei Textfeldern 253
  Bei Textrahmen 230
  Bei Zeichnungen 241
  Standardeinstellungen ändern 224
Objekt > Gitter und Hilfslinien 479, 480
Objekt > Gruppieren 227
Objekt > Gruppierung aufheben 227
Objekt > Neue Grafik 180
Objekt > Neue Grafik aus der Galerie 182
Objekt > Neue Grafik von der Kamera 182
Objekt > Neue horizontale Linie 388
Objekt > Neue Zeichnung 238
Objekt > Neuer Diagrammrahmen 189
Objekt > Neuer Grafikrahmen 180, 232
Objekt > Neuer Grafikrahmen aus der Galerie 182
Objekt > Neuer Grafikrahmen von der Kamera 182
Index

Objekt > Neuer OLE-Objektrahmen  236
Objekt > Neuer Textrahmen  229
Objekt > Neues Diagramm  189
Objekt > Neues Formularobjekt  249
   Auswahlliste  256
   Auswahllistenrahmen  258
   Bezeichnung  258
   Gruppenfeld  258
   Kontrollkästchen  255
   Kontrollkästchenrahmen  256
   Textfeld  253
Objekt > Neues OLE-Objekt  199
Objekt > Reihenfolge  226
Objekt > Tab-Reihenfolge  260
Objekte  206, 207
   Duplizieren  213
   Eigenschaften ändern  214
   Größe ändern  211, 218
   Gruppieren  227
   Konvertieren (Rahmen/eingebettet)  226
   Position ändern  210, 214
   Reihenfolge ändern  226
   Rotieren  212, 218
   Selektieren  208
   Sperren  212
   Verbergen  226
Objektleiste  208
Objektmodus (Ansicht)  208
Öffnen (Datei)  31, 122, 418
OLE-Objekte  199
   Bearbeiten  201
   Eigenschaften ändern  202
   Einfügen  199
   Position und Größe ändern  202
OLE-Objekt-Hilfslinien  431
OLE-Objektrahmen  235
   Eigenschaften ändern  236
   Einfügen  236
Open Document-Dateiformat  445
Open Office-Dateiformat  418
OpenDocument-Dateiformat  418
OpenGL-Bibliothek verwenden  447
Operatoren (bei Berechnungen)  336
Ordinalzahlen hochstellen  435
Originalgröße (Ansicht)  459
OWER-Funktion  337

PROD-Funktion  337
Produktaktualisierungen suchen  447
Professional  14
Punkt (pt)  57, 65

Q
Quelle wählen (Datei)  181
Querformat  88
Querverweise  366, 367
Quickinfos anzeigen  438

R
Rahmen  206, 207
   Ausrichten und verteilen  213
   Einfügen  207
   Größe ändern  211, 218
   Gruppieren  227
   Position ändern  210, 214
   Ränder ändern  211
   Reihenfolge ändern  226
   Selektieren  208
   Umwandeln  226
   Verteilen  213
Rahmen in eingebettetes Objekt umwandeln  226
Rahmen in Objektrahmen umwandeln  226
Rahmen und Zeichnungen direkt einfügen  435
Ränder
   Innenränder von AutoFormen  242
   Innenränder von Textrahmen  230
   Seitenränder  88
   von Objekten  211
Raster  79
Rechenformeln  334
Rechenfunktionen  337
Rechnen im Text  324
Rechtecke
   Eigenschaften ändern  241
   Zeichnen  238
Rechtsbündig  41
Rechtschreibprüfung  266
   Benutzerwörterbücher bearbeiten  272
   im Hintergrund  268, 442
   Nachträglich  266
   Sprache einstellen  264
   Wörterbücher nachinstallieren  483
Rechtschreibreform  269, 442
Redo  29
Registerkarten für Dokumente  23, 427, 428
Reihenfolge (von Objekten)  226
Ribbon  14, 22, 438
   Anpassen  469
   Liste aller Menübefehle und Ribbonbefehle  486
Ribbon oder Menüs mit Symbolleisten?  438
S

Satznummer 291
Scannen 181
Schatten (bei Objekten) 221
Schattierung 79
Schließen (Datei) 428
Schnellwahlpfade 405
Schnellzugriffsleiste 22, 438, 471, 475
Schreibmarke 27
Schreibrichtung 422, 423, 424
Schriftart 57
Schriftenliste mit echten Schriften 438
Schriftfarbe 59
Schriftgröße 57
Schusterjungen vermeiden 84
Schützen
   Dokumente 415
   Formulare 261
   Inhalt von Formularobjekten 260
   Text 63
Script bearbeiten 426
Script starten 426
Scripts 426
Seite einrichten 88
Seitenausrichtung 88
Seitenbreite (Ansicht) 459
Seitenformatierung 87
Seitenhintergrund ändern 102
Seitenhintergrund drucken 451
Seiteneiste (Ansicht) 24, 111, 118, 135
Seitenummer 91, 99, 101
   als Feld einfügen 137
   Statuszeile 25
Seitennäder
   Einstellen 88
   im Dokument anzeigen 431
Seitenumbruch 84, 87
Seitenverhältnis beibehalten 218
Seitenzahl
   als Feld einfügen 137
   des gesamten Dokums (Statuszeile) 25

 eines gewählten Abschnitts (Statuszeile) 25
Selektieren
   Datensätze in der Datenbank 318
   Objekte 208
   Text 51
Sequenznummer (Feld) 137, 356
Serienbrief 314
   Datenbank zuordnen 315
   Datenbankfelder einfügen 316
   Datensätze selektieren 318
   Drucken 396
   Testdatensatz anzeigen lassen 316
   Übungsbrief 317
   Unterdrückung von Leerzeichen 322
Serienbriefdruck 396
Serienbriefleiste 316
SHM-Erweiterungen verwenden 447
Sicherungskopien 412, 445
Sichtbar (Objekteigenschaft) 223
Silbentrennung
   Sprache einstellen 264
   Verwenden 273
   weiches Trennzeichen 273
Skalierung beibehalten 218
SoftMaker 15
SoftMaker Basic 426
SoftMaker Formeleditor 204
SoftMaker Office Professional 14
Sonderzeichen einfügen 143
Sortieren
   Datenbanken 297
   Tabellen 175
   Text 177
Spalten (Mehrspaltendruck) 124
Spaltenumbruch 84, 124
Spanische Übersetzung 285
Speichern - nach Dokumentinfo fragen 445
Speichern (Datei) 33
Speichern im Textformat - Warnung anzeigen 445
Speichern unter 121, 418
Speichern unter (Datei) 33
Sperren
   Hilfslinien 451, 480
   Objekte 212, 223
   Objekte auf der Masterseite 96, 451
Sperren (Objekteigenschaft) 223
Spiegeln (von Objekten) 212
Spiegelungseffekt (bei Objekten) 222
Sprache
   Für die Benutzeroberfläche 438
   Für Rechtschreibung/Silbentrennung 264
SQRT-Funktion 337
Standard (Format) 63, 109
Standardabsatzformat ändern 117
Standard-Dateiformat 445
Standardschrift 64, 109
Standardsprache 264, 442
Standardzeichenformat ändern 64, 109
Statistik 455
Statuszeile 25
anzeigen/verbergen 438
Stichwort
Stichwort aufnehmen 350
Stichwortliste bearbeiten 351
Stichwortverzeichnis erstellen 352, 364
Stichwortverzeichnis 350
STR-Funktion 337
STRING-Funktion 337
StyleRef-Feld 368
SUBSTR-Funktion 337
Suchen 128
Dateien 410
Formatierungen 132
Gehe zu 134
In der Datenbank 294
Text 128
Suchen (erweiterte Suchfunktionen) 130
Suchen und Ersetzen 128
Suchen wiederholen 130
SUM-Funktion 328, 337
System-Dateidialoge verwenden 438
Systemmenüs verwenden 438
Systemvoraussetzungen 16

Tabelle > AutoFormat 172
Tabelle > Markieren 161
Tabelle > Neue Tabelle 160
Tabelle > Spalten verteilen 166
Tabelle > Tabelle in Text umwandeln 173
Tabelle > Tabelle sortieren 175
Tabelle > Tabelle teilen 165
Tabelle > Tabelleneigenschaften 170
Tabelle > Tabellenvorlagen 172
Tabelle > Text in Tabelle umwandeln 174
Tabelle > Zeilen verteilen 166
Tabelle > Zeileneigenschaften 166
Tabelle > Zellen einfügen 162
Tabelle > Zellen löschen 162
Tabelle > Zellen teilen 164
Tabelle > Zellen verbinden 164
Tabelle > Zelleneigenschaften 168
Tabellen 159, 170, 172
Ausfüllen 160
Einfügen 160
Formatieren 165, 166, 168, 170, 172
Verbinden 165
Zellinhalte löschen, kopieren, verschieben 161
Tabellen-Hilfslinien (Einstellungen TextMaker) 431
Tab-Reihenfolge ändern 260
Tabstopp 42
Tabulator 71, 73
Tabulatoren 42
Tabulatoren anzeigen 431
Tastatur automatisch ein-/ausblenden 447
Tastenkürzel
Anpassen 477
für Absatzvorlagen 112, 114
für Sonderzeichen 143
für Zeichenvorlagen 105, 107
Vordefinierte 498
Vordefinierte:Mac 501
Vordefinierte:Windows/Linux 498
Technischer Support 15
Text in Tabelle umwandeln 174
TextArt-Objekte
Eigenschaften ändern 241
Zeichnen 238
Textauszeichnungen 57
Textbausteine 285
Abrufen 287
Anlegen 286
Automatisch ersetzen 435
Bearbeiten 288
Textbreite (Ansicht) 459
Textdatei-Dateiformat 418, 420
Textdatei-Dateiformat (Datenbank) 315
Textfelder 248, 253
Textfluss (bei Rahmen) 214
TextMaker für DOS
Dateiformat 418
TextMaker Professional 14
TextMaker-Dateiformat 418
TextMaker-Tour 34
Textmarken 133, 366, 451
Textmarken anzeigen 133, 451
Textmarker 59
Textrahmen 228, 248
Eigenschaften ändern 230
Einfügen 229
Verbinden 231
Textrahmen-Hilfslinien 431
Tex turbulent 214
Thesaurus 276
Sprache einstellen 264
Index

Thesaurus 276
Verwenden 276
Thunderbird-Adressbuch konvertieren 312
Tiefstellen 60
Titelleiste 20
TMBAK-Dateien 412
TMD-Dateiformat 418
TMDX-Dateiformat 418
Tmw.dbf 291
TODAY-Funktion 337
Transparenz (von Grafiken) 183, 233
Trennen von Wörtern verhindern 84
Trennstrich, weicher 431
Trennzeichen
geschütztes (nicht-trennendes) 273
weiches (bedingtes) 273
TRIM-Funktion 337
TRUNC-Funktion 337
Typografie 84
Typografische Anführungszeichen
Suchen 130
Verwenden 435
 USER-Funktion 337

V
VAL-Funktion 337
VBA 426
Verbergen
Objekte 223, 226
Text 62
Verbindungslinien
Eigenschaften ändern 241
Zeichnen 238
Verborgene Dateien und Ordner anzeigen 447
Verbogerner Text 451
Vergrößerungsstufe (Ansicht) 459
Verknüpfungen (Hyperlinks)
bei Objekten 223
im Text 389
Verknüpfungen (OLE Objekte) 201
Verschlüsselung 415
Versenden eines Dokuments per E-Mail 404
Versionsverwaltung 412
Vertikale Ausrichtung
bei AutoFormen 242
bei Textfeldern 253
bei Textrahmen 230
der Seite 99
Vertikale Position (von Objecten) 214
Vertikales Lineal 431
Verweise 366, 368
Visual Basic 426
Vollbild (Ansicht) 460
Vollbildansicht 460
Von links (Einzug) 66
Von rechts (Einzug) 66
Vorlagen 104
Vorlagenmanager 119
Vorlagenpfad 445
Vorlagenverweis (Feld) 137, 368
Vorschau (auf ein Dokument) 31

W
Warnton bei Meldungen 438
Warnung beim Laden von OLE-Objekten 433
Wasserzeichen 95
Weiche Kanten-Effekt (bei Objekten) 222
Weicher Bindestrich 431
Weicher Trennstrich 431
Weiches Trennzeichen 273
Weiteres > Abbildungsverzeichnis erstellen 358, 364
Weiteres > Änderungen
Änderungen anzeigen 382
Änderungen verfolgen 382
Weiteres > Änderungen 384
Einstellungen 384
Nächste Änderung 382
Übersicht über alle Änderungen 382
Vorherige Änderung 382
Weiteres > Anpassen 476
Benutzerdefinierte Symbole erstellen 476
Symbolleisten anpassen 465
Tastenkürzel anpassen 477
Weiteres > Automatische Silbentrennung 273, 442
Weiteres > Bibliografie 360
Bibliografie erstellen 363, 364
Bibliografiedatenbank bearbeiten 360
Bibliografie-Einstellungen 362
Bibliografiefeld einfügen 362
Neue Bibliografiedatenbank erstellen 360
Vorhandene Bibliografiedatenbank zuordnen 362
Weiteres > Datenbank bearbeiten 289
Weiteres > Datenbank erzeugen 290, 309
Weiteres > Datenbank zuordnen 315
Weiteres > Datenbankstruktur ändern 311
Weiteres > Duden 283
Weiteres > Einstellungen 431
Karteikarte Allgemein 433
Karteikarte Ansicht 431
Karteikarte Aussehen 438
Karteikarte Bearbeiten 435
Karteikarte Dateien 445
Karteikarte Schriften 450
Karteikarte Sprache 442
Karteikarte System 447
Weiteres > Felder aktualisieren 137, 332
Weiteres > Inhaltsverzeichnis erstellen 354, 364
Weiteres > Kommentar 376
Einstellungen 379
Kommentar bearbeiten 377
Kommentar einfügen 377
Kommentar löschen 378
Kommentarfeld automatisch anzeigen 378, 379
Nächster Kommentar 379
Vorheriger Kommentar 379
Weiteres > Langschnitt 285
Weiteres > Rechtschreibprüfung 266
Weiteres > Script bearbeiten 426
Weiteres > Script starten 426
Weiteres > Stichwort 350
Stichwort aufnehmen 350
Stichwortliste bearbeiten 351
Stichwortverzeichnis erstellen 352, 364
Weiteres > Thesaurus 276
Weiteres > Thunderbird-Adressbuch konvertieren 312
Weiteres > Wörterbücher bearbeiten 272
Wiederherstellen (Änderungen) 29
Word-Dateiformat 418, 445
Wörter zählen 455
Wörterbücher bearbeiten 272
Wörterbücher nachinstallieren (für Rechtschreibprüfung) 483
X
XIM verwenden 447
Y
YEAR-Funktion 337
Z
Zeichen (Format) 56, 57, 59, 60, 62, 63, 64
Zeichen zählen 455
Zeichenbreite 60
Zeichenfeld (Datenbank) 309
Zeichenformatierung
Ändern 56
für gesamten Absatz ändern 71
Suchen und Ersetzen 132
Zeichenformatierung auf ganzes Wort anwenden 435
Zeichenvorlage 105, 107, 108, 110, 119
Zeichnungen 238
Eigenschaften ändern 241
Einfügen 238
Gruppieren 227
Rotieren 212, 218
Zeilenumbruch am Fensterrand umbrechen 431
Zeilenumbruch - manuell einfügen 85
Zeilen 137
Zellen (Tabelle) 162
Zellen bearbeiten 162
Zellen löschen 164
Zellen verbinden (Tabelle) 164
Zelleneigenschaften (Tabelle) 168
Zentriert 41
Zoomstufe (Ansicht) 459
Zurück zu vorheriger Version (Datei) 412
Zwei ganze Seiten (Ansicht) 459
Zwei Großbuchstaben am Anfang eines Wortes korrigieren 435